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Overview of AFT Arrow
Welcome to AFT Arrow™ - a visual platform for modeling compressible flow in pipe networks! See what's
new in version 9!
AFT Arrow brings increased productivity to the pipe flow engineer by combining traditional engineering
hydraulic analysis with an intuitive graphical user interface. By implementing a drag-and-drop method of
pipe flow modeling, AFT Arrow simplifies the pipe network modeling process.
AFT Arrow can show both input data and analysis results in visual form, allowing rapid analysis of a
model's validity. Identifying poor assumptions, catching typographical or modeling errors, and rerunning
models are all accelerated because of AFT Arrow's graphical environment.
Whether your pipe system model will be used to evaluate and improve an existing system or to design a
new one, AFT Arrow increases your productivity in the modeling process.

What Can AFT Arrow Do?
AFT Arrow can be used to model a wide variety of compressible flow systems, including:
l

Open and closed (recirculating) systems

l

Network systems that branch or loop, with no limit on the number of loops

l

Pressure driven systems

l

Compressor or fan driven systems, including multiple compressor/fans in parallel or in series

l

Compressor/fans with variable speed, controlled pressure and controlled flow

l

Systems with pressure and/or flow control valves

l

Systems with valves closed and compressor/fans turned off

l

Heat transfer analysis and system energy balance

l

Systems with non-ideal gases

l

Systems that experience sonic choking, including multiple sonic choking points

l

Systems with non-reacting flow stream mixing and user defined mixtures (with optional Chempak)

l

Systems with elevation changes or rotation such as in turbomachinery

l

Multiple design cases in a single model file

l

Cost calculation of compressor and fan energy usage

AFT Arrow provides hundreds of standard loss models for pipe system components, but also allows you
to enter your own loss data. Variable loss models that depend on flow are supported.
AFT Arrow's powerful solution engine is based on standard techniques used for many years in industry.
The Newton-Raphson method is used to solve the fundamental equations of pipe flow that govern mass
and momentum balance. Solutions are obtained by iteration, and matrix methods optimized for speed
are employed to obtain convergence.
AFT Arrow provides two independent solution methods that can be run individually or in combination with
each other to allow flexibility and cross-verification of results. In addition, AFT Arrow offers two lumped
methods which offer improved computation speed with a slight loss in accuracy. Modeling of low to high
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pressure and low to high velocity systems can be performed. Sonic capabilities allow modeling of high
velocity conditions such as in relief systems.
AFT Arrow can model a large range of gas systems including steam, natural gas, air, and chemical and
petrochemical process gases. Support for real gases is offered through several generalized equation of
state models or the optional Chempak add-on.

Where to Start
The best place to start learning about AFT Arrow is to work through our examples and video tutorials
found in the Arrow Learning Resources.

Add-on Module Capabilities
AFT Arrow has two add-on modules which extend AFT Arrow’s extensive modeling capabilities into new
areas.
l

The Goal Seek & Control (GSC) module allows the engineer to perform multi-variable goal seeking and simulate control system functions.

l

The Automated Network Sizing (ANS) module automates the process of sizing pipes and ducts in
a complex network based on required conditions, such as maximum pressure or minimum flow, to
reduce cost or weight.

l

The Extended Time Simulation (XTS) module allows the engineer to model time varying system
behavior.

Who Can Use AFT Arrow
Effective use of AFT Arrow requires a basic understanding of compressible flow theory. Another topic
offers a review of compressible flow theory and gives several references of more detailed information.
AFT Arrow users should have a working knowledge of all the concepts discussed in Review Of Compressible Flow Theory. In some cases it may be advisable that users attend training courses offered by
Applied Flow Technology or AFT Arrow recognized authorities.
In addition to familiarity with compressible flow theory, engineers who use AFT Arrow should be familiar
with standard industry practice in analyzing gas piping systems.

Related Topics
New in Version 9
New in Version 8
New in Version 7
New in Version 6
Arrow Learning Resources
Engineering Assumptions

21
27
31
35
37
38
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Startup Window
FAQ - Frequently Asked Questions

39
41

New in Version 9
Analysis Setup
The Analysis Setup window consolidates windows for System Properties, Solution Control, Activate Modules, Extended Options, Goal Seek & Control Manager, and Transient Control all into one location. This
allows users to activate and enable modules, specify fluids, change solution tolerances or iterations, and
so on, all from a single window. For a list of windows that have merged into the Analysis Setup

Libraries
The database feature interface was completely overhauled to improve workability. The new system is
called the Library Manager and significantly improves the ease and workability for users to browse and
connect input information, now called libraries, into their model.
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Multi-Scenario Graphing
Profile graphs (and Transient Graphs in the XTS module) can now include output from multiple scenarios, making it easy to compare the results along a flow path for different scenarios.

Improved Organization of the Warnings in the Output
An improved display of the warnings and design alerts makes it easier to review and understand information in the following ways:
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l

Critical Warnings, Warnings, and Cautions are color-coded and grouped by type in collapsible sections

l

Design Alerts are now shown on a separate tab in the General Section

l

Double-clicking messages will take user to the related pipe/junction in the Workspace

l

Warnings, Cautions, and Design Alerts are now displayed for all scenarios when using the Multiscenario Output feature

Extended Time Simulation (XTS) Add-on Module
The XTS Module is now available as an add-on module for AFT Arrow. The XTS module allows slow
transients to be modeled such as pressurizing a tank, controlled valve opening/closing, and slow compressor/fan transients. Users can view transient output in the Output window, create transient graphs, or
create transient Visual Reports.
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More Improvements
l

Pipes/Junctions
l

l

l

l

Pipes can be defined as zero-length connectors to connect two junctions which are directly
flanged together

Workspace and Interface
l

Pipes and Junctions can be set the Same as Parent directly from the Workspace

l

Custom Unit names can be defined in the Unit System section of the User Options window

l

Pipe/Junction notes can be searched in Select Special

l

Special Conditions can be directly changed from the toolbar for junctions that have multiple
special condition options

Output and Reporting
l

Show the number of warnings and design alerts in the batch run window

l

Heat Transfer output parameters added to Visual Report

l

Design alerts are grouped together in the General Output section

Miscellaneous
l

SRK and Peng-Robinson equations of state are now available for AFT Standard fluids

l

List Junctions that have Special Conditions change in Solution Progress Window
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l

Silent Batch runs can be enabled to prevent notifications from appearing over other active
windows
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38
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Related Blogs
Introducing the New Arrow XTS Module!

Interface Improvements for Arrow 9
There were many improvements made to the interface in Arrow 9. These changes primarily involve consolidating inputs with the new Analysis Setup window, and updating the functionality of databases, which
have been renamed as libraries.

Analysis Setup Sources in Arrow 9
l

System Properties: The System Properties window has been split up into the Fluid Properties
group and the Environmental Properties group. The System Properties icon is still available
from the Analysis menu and toolbar to directly open the Fluid Properties panel.

l

Solution Control: The Solution Control parameters have primarily moved to the Steady Solution Control group. The Special Controls have moved to the Advanced Parameters panel
under the Miscellaneous group

l

Checklist: The checklist which was shown in the Quick Access Panel has been replaced by the
status icons in the Analysis Setup window. Red exclamation marks denote which inputs are
incomplete

l

List Undefined Objects: The undefined objects list has been moved to the Pipes and Junctions group. The undefined objects list can also still be viewed next to the Workspace by opening
it from the View menu.

l

Cost Settings: Cost calculations were previously enabled from the Analysis menu and defined in
the Cost Settings window. Enabling and defining cost settings has now been moved to the Cost
Settings group

l

Add-on Modules Activation: The activation window for add-on modules has moved to the Modules panel
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l

Goal Seek & Control Manager (GSC Module Only): Settings have been moved to the Goal
Seek and Control group

l

Transient Control (XTS Module Only): Settings have been moved to the Transient Control
group

l

Sizing Summary (ANS Module Only): The Sizing Summary has been added to the Sizing Summary panel in Analysis Setup. The Sizing Summary can also still be viewed from the Sizing window. No other ANS module interface changes have been made.

Database Improvements
l

Databases have been renamed as libraries throughout the interface to better reflect their functionality

l

Connecting, creating, and transferring content between libraries can all be done from the Library
Browser, rather than switching between tabs in the Database Manager to do this

l

Viewing the contents of libraries can also be done directly in the Library Browser, rather than opening
a separate Browse Database Content window

l

Windows to edit and add components to libraries can all be accessed directly from the Library Manager rather than having to navigate solely through the Library menu
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New in Version 8
Scenario Comparison Tool
l

Quickly get a comparison of different scenarios within a model file

l

Useful to double-check input results for old models, or for troubleshooting purposes

l

For a detailed description see Scenario Comparison Tool Overview

Junction- specific Parameters in Visual Report
l

Output such as the compression ratio of a compressor or the Cvof a control valve can now be displayed in theVisual Report
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Notes on Output
l

Notes can be added to any cells in the Output to save observations and comments directly with
the model file

New Workspace Functionality
l

Multi-level Undo - Drawing, arranging and moving objects in the Workspace now allows for multiple levels of undo

l

Workspace Magnifier - The magnifier tool provides an enlarged view of sections of the model to
make it easier to manage and navigate large models
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l

Automatic Junction Rotation - Arrow will automatically rotate junctions to visually align with
neighboring pipes to speed-up model formatting

l

Combine Pipes - a series of pipes and junctions can be combined to simplify a model, with any
losses being imported to the Pipe Fittings and Losses tab

l

Select Shortest Flow Path - The shortest path between two selected junctions can be found
using this feature in the Edit menu

Define Compressors in terms of Compression Ratio
l

The compression ratio at different flow rates can be directly specified in the Compressor Configuration window

Diagnostics Window
l

Provides a list of features and settings which might cause issues as a starting point for model
troubleshooting

l

See the Diagnostics Window topic for more information
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Multi-scenario Compressor/Fan vs. System Curves
l

Compressor/Fan vs System curves from different scenarios can be plotted on the same graph
within AFT Arrow

l

Easily compare changes to compressor/fan operation in different cases

l

For more information see Multi-Scenario Compressor/Fan vs. System Curves Tutorial

More Improvements
l

l

l

l

Overall Performance
l

Improved intelligence on when a model needs to be saved and re-run to preserve the output

l

Faster model loading speed

l

Improved language refresh speed

l

New and updated themes

Workspace
l

The Undefined Objects Panel (launched from clicking "Define Pipes and Junctions" in the
Checklist) remains open when pipes/junctions are being edited

l

Double-clicking a junction allows more than one of that junction to be placed in the Workspace at a time

l

Snapping can be turned off for pipes when the isometric drawing mode is enabled

Output
l

Output parameters can now be filtered/searched for simpler selection

l

The average thermal conductivity used for calculations can be displayed in the Output

Visual Report
l

l

Pipes
l

l

l

Visual Report Control has been redesigned to better filter parameters
Heat tracing now allows the entry of power/length and number of turns to allow Arrow to calculate the heat flux directly

Junctions
l

Updated Tee/Wye Properties window which clarifies the input and automatically defines
the pipe arrangement according to the direction and orientation on the Workspace

l

Built-in K-factors are now included for bends withr/Dbetween 0.5 and 1. SeeBend Loss
Model for more information.

l

Notes can be globally edited for junctions

Design Alerts
l

Design Alerts can be saved to and loaded from a file to quickly apply common Design
Alerts to multiple models

l

Ability to import custom Fittings & Losses from a file
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New Feature Highlight - Scenario Comparison Tool

New in Version 7
New & Improved Microsoft Excel Integration
l

l

Improved keyword based method for importing model changes from an Excel Worksheet
l

Use the included template Worksheet to quickly and easily define model changes

l

Change multiple scenarios at once

l

For a detailed description see Importing From Excel

New feature for directly exporting specified Output data to new or existing Excel Workbooks.
l

Export only the data that is desired - no need to sort through unnecessary data

l

Specify exactly where the data will end up - insert data into a pre-formatted Workbook

l

Automatically export after a model run

l

Export data from multiple scenarios with a batch run

l

For a detailed description see Exporting To Excel
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New Isometric Drawing Mode
l

New Isometric Pipe Drawing Mode
l

Show and Snap to an isometric grid on the Workspace

l

View models in an intuitive "3D" layout, and easily build from existing isometric drawings

NIST REFPROP Fluid Database Now Included
l

Over 150 fluids from the National Institute of Standards and Technology (NIST) Reference Fluid
Thermodynamic and Transport Properties Database (REFPROP) Version 10
l

Select a NIST REFPROP fluid directly in System Properties

l

Use accurate and complete fluid information in your models without the need to locate and
enter fluid properties manually

Improved Compressor/Fan Window
l

l

New Fan Model
l

Clarifies the specification of fans

l

Includes Fan Curve and Sizing options

New Positive Displacement Compressor Model
l

Clarifies the specification of Positive Displacement Compressors
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l

Added Compressor Curve and Sizing Analysis Types to Centrifugal Compressor Model
l

Clarifies required data and model intention

l

For a detailed description see Compressor/Fan Properties Window

New Thermal Models
l

l

Two new Heat Transfer Models for Pipes
l

Convective Heat Transfer With Heat Tracing - model the addition of heat between a pipe
wall and an insulation layer

l

Buried Pipe - model the thermal effects of burying a pipe

Calculate a Forced Convection Coefficient from ambient fluid velocity and temperature with the
Churchill-Bernstein correlation

Improved Startup Window
l

Improvements to the capability and usability of the Startup Window
l

Set modeling preferences including - active modules, working fluid, units, language, 2D or
Isometric drawing mode, and default pipe material

l

Displayed units can now be easily refined by selecting Common Units and Industry-Specific Units

New Integration with Common Piping Layout formats
l

Save modeling time by importing existing Piping Layouts from various neutral file types
l

Import CAESAR II Neutal Files (.cii)

l

Import Piping Component Files (.pcf)

l

Import and Export EPANET Files (.inp)

l

These common file formats are generated from many common engineering programs such
as AutoCAD Plant 3D, SmartPlant, PDS, CadWorx, and many more.
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Updated Standards
l

Output displays Applied Standards - standards that were used in calculation of model results

l

Relief Valve loss can be specified with Designation Size per API 526 - Flanged Steel Pressure
Relief Valves

More Improvements
l

l

l

General
l

Many new default Pipe Materials

l

Control Valve setting for Always Control (Never Fail) can be set to a default to off

l

Increased the loading speed for large models

Workspace
l

The Workspace background color can be changed based on the level of the current scenario - additional levels have been added

l

Annotation background opacity can be changed

l

New keyboard shortcuts to zoom (CTRL + +/-) and pan (CTRL + arrow keys) the Workspace

l

Full Scenario Path Name can be copied to clipboard by right-clicking a scenario

l

Selection box visually indicates the behavior of the selection - select everything intersecting (right to left) or only objects completely inside (left to right)

l

Pipes with Fittings & Losses defined now display a special character next to their number
(default of &)

Output
l

l

l

Design Alerts can be created directly from the Output by right-clicking on a result - immediately select the appropriate object and parameter.

Model Data
l

Quickly locate a specific object on the Workspace by right-clicking the item in Model Data

l

Added additional parameters such as insulation thickness

Visual Report
l

Reworked Display Option controls for Pipes and Junctions in Visual Report Control
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Related Blogs
Iso love the new Pipe Drawing Mode!
Paint a Clear Picture Faster Than Ever with AFT's New Excel Export Manager

New in Version 6
General Interface
l

Improved tab interface and enhance Quick Access Panel functionality

l

Output reports in German and Chinese languages

l

Main menus are translated into available output languages
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Graph Results
l

Multiple Graphs can be added to Graph Folders for easy generation and display

l

Multiple graphs tabs on main Graph tab

l

Multiple Graphs tiled on same Graph Folder tab

l

Easy formatting of titles, axis labels, and plot lines

l

Plot series lines can be turned on/off for quick inspection

l

Graph controls now located on the Quick Access Panel for easy graph definition and changes

Scenario Manager
l

Ability to create child scenarios without results saving duplication and load time

Workspace
l

GIS Shapefiles can be imported to create a model

l

Text Alignment options in annotations

l

Annotations can be layered on the Workspace

Output
l

Results Diagrams which graphically show data for pipe heat transfer and compressors

l

Intermediate Axial Points calculations are shown for all pipes in a collapsible table

l

Default colors for multi-scenario output

Visual Report
l

Automatic Color Map generation

Pipes
l

Design Alerts are specified and named globally and applied to pipes

l

New Design Alerts Available
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Junctions
l

Volumetric flow rate set points can be used for Control Valves

l

Compressor/Fans compression ratio can be set

l

When the speed is set for a Compressor/Fan, both the original and modified curves are shown on
the Compressor/Fan property window

l

Design Alerts can be applied to junctions

l

Forward velocity to close check valves

Related Topics
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Arrow Learning Resources
Engineering Assumptions
Startup Window
FAQ - Frequently Asked Questions

19
21
27
31
37
38
39
41

Arrow Learning Resources
Online Resources
Additional resources can be found in the Learning Center on our website. Resources found there
include:
l

Training Seminar information

l

Free Webinars

l

Flow Expert Package information

l

Case Studies

l

Video Tutorials

l

Tips & Tricks Blogs

l

Quick Start Guides

Online Quick Start Video Tutorial Series
The Quick Start video tutorial series provides a short introduction to the basic features of AFT Arrow and
shows how to build, run, and view output for the model.
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l

Online Quick Start Video Tutorial Series

Beginner: Air Heating System
This is a simple example model which is recommended as a starting point for brand new AFT product
users.
l

Beginner: Air Heating System

Walk Through Examples
This links to a variety of example problems for beginning to advanced users which showcase different
features and applications of AFT Arrow.
l

Walk Though Examples

Module Walk Though Examples
A list of examples using the add-on modules of AFT Arrow to solve a variety of problems.
l

Module Walk Through Examples

Engineering Assumptions
AFT Arrow is based on the following fundamental fluid mechanics assumptions:
l

Compressible flow

l

All gases are superheated

l

Steady-state conditions

l

One-dimensional flow

l

No chemical reactions

l

Supersonic flow does not exist in the system
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FAQ - Frequently Asked Questions

41

Startup Window
The Startup Window is displayed when AFT Arrow is opened. This window allows the user to quickly
access files and resources, as well as define a basic starting point for a new model.
l

l

Open a Model
l

My Files - AFT Arrow keeps a list of recently opened model files. The most recent files can
be opened with a single click here.

l

Other Files - Browse to any other model file, or open the built-in Examples folder.

Start a New Model
l

Activate Modules - Any licensed Module can be activated immediately. Checking these
boxes will search for an available license.

l

Select Working Fluid

l

l

l

I Will Select Fluid Later - No fluid will be defined, one will need to be defined in the
Fluid panel before running the model.

l

Use AFT Standard "Air"

l

Select A Recently Used Fluid - Also requires Temperature.

Modeling Preferences - Displays various settings for the application, such as specifying
the units to use or which grid to use. These options can be modified later. Click the Modify
button to reveal the following settings, as shown in Figure 2. Click the Remember My
Preferences and Hide button to update the modeling preferences for the model and to
update the default settings for the application.
l

Units - US, Metric, or both sets of units with one as default can be displayed. Additionally, the displayed units can further be reduced to only show common units and
those used by a certain industries.

l

Language - Select a language to display Output in.

l

2D or Isometric Workspace - Set up the grid.

l

Pipe Material - Set the pipe material that is initially selected for new pipes.

Resources
l

User Setup - Open the AFT website to view the latest AFT Arrow release, or sign up for
notifications of new releases via email.

l

Quick Start Guides - Open the included PDF of the Quick Start Guide, or a Quick Start
Video. These materials are designed to help get a new user up and running with AFT Arrow
as quickly as possible.

l

Help Files - Open our detailed help file (you are here!) or the collection of worked Example
problems.

l

Video Tutorials - Open the AFT website to our library of instructional videos.
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Figure 1: Startup Window in AFT Arrow

Figure 2: Startup Window showing Modeling Preferences
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FAQ - Frequently Asked Questions
l

How do AFT Arrow's solution methods compare to traditional handbook methods for gas flow?

l

Does AFT Arrow handle sonic choking?

l

How has AFT Arrow been verified?

l

Can AFT Arrow be used to model liquid systems?

l

How does AFT Arrow account for real gas effects?

l

How does AFT Arrow account for heat transfer in pipe systems?

l

Does AFT Arrow account for the heat of compression in a compressor?

l

Does AFT Arrow perform an energy balance across each junction in the model?

l

What is the difference between using a junction to input pressure loss data and the fittings &
losses in pipes?

l

What is the difference between a Tank junction and an Assigned Pressure junction?

l

How does AFT Arrow account for pressure losses at tees and wyes?

l

How do I size a fan or compressor when there are not any flow control valves?

l

How do I size a fan or compressor when there are flow control valves?

l

How do I model a variable speed fan?

l

How do I account for changes to a fan curve based on different operating pressures?

l

How do I find the fan speed to obtain a desired flow or discharge pressure?

l

How do I close a valve, fan or pipe?

l

How do I model the pressure drop across a component when there is only one data point?

l

How do I model a relief valve in a system?

l

How do I model a valve loss given the manufacturer Cv?

l

How do I model choked flow through a valve, orifice or similar element?

l

How do I model a desuperheater in AFT Arrow?

l

How do I show the pipe or junction names on the Workspace?

l

How do I change the display of pipe or junction names on the Workspace after the model has
been built?

l

How do I set my preferred engineering units as defaults?
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l

How do I change the input data for multiple pipes or junctions all at one time?

l

How do I create a gas mixture?

l

How do I model a dynamic mixing process?

l

How do I merge two models together?

l

How do I automatically run multiple models right after each other?

l

How do I enable or disable the Highlight feature in the Pipe and Junction Properties windows?

l

How do I automatically save my results after the model is run?

l

How do I quickly find a particular pipe or junction on the Workspace?

l

How do I change the reference positive flow direction for one or more pipes?

l

How do I access pipe and junction Properties windows from the Model Data window?

l

How do I display only selected pipes or junctions in the output?

l

How do I quickly change the units for an output parameter?

l

How do I model elevation changes in my pipe system?

l

How do I model a rotating pipe system such as might exist in turbomachinery?

l

How do I show data for only selected pipes or junctions in Visual Report?

l

How do I make the Pipe Drawing Tool stay active so that I can continue to draw pipes without having to click it each time?

l

How do I add graphical segments to a pipe so it is not constrained to a single straight line?

l

How do I set up custom libraries on my local PC?

l

How do I set up custom libraries on our local or wide area network?

l

How do I change the icon for a junction in AFT Arrow?

l

Can I customize the junction icons in AFT Arrow?

l

What is the limit to the size of model I can create with AFT Arrow?

l

Can I use special friction equations such as Panhandle and Weymouth?

l

Can AFT Arrow model a turbine in the system?

l

Can AFT Arrow model reacting flows?

l

Can I install AFT Arrow onto a local or wide area network?

How do AFT Arrow's Solution Methods Compare to Traditional Handbook Methods for Gas Flow?
AFT Arrow solves the governing equations of compressible without simplifying assumptions, and is thus
more accurate than traditional handbook methods.
A common equation is the Crane isothermal equation (see Crane, 1988, pp. 1-8). AFT Arrow and equations such as the Crane isothermal equation differ in several respects. First is that the Crane equation
assumes isothermal flow, while AFT Arrow can model isothermal flow or other, more general, boundary
conditions. Second is that the Crane equation solves the entire pipe as one segment. This can be called
a lumped method. It is thus roughly analogous to using AFT Arrow with a single computing section per
pipe. Third, the Crane equation assumes a constant diameter run, whereas AFT Arrow allows you to
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change diameters. Fourth, it is not apparent how to apply the Crane equation to multi-pipe systems,
including pipe networks.
The Crane equation solves the governing mass and momentum equations by making some assumptions. AFT Arrow is solving the same equations, but is not making any assumptions. It marches down
each pipe, taking into account physical property changes and non-linear acceleration effects as it progresses. Thus, AFT Arrow is in general much broader and more accurate than the Crane equation. When
the pipe flow conditions are within the assumptions of the Crane equation, then the Crane equation and
AFT Arrow should agree closely.
Other equations on page 1-8 of Crane, 1988, compare similarly to AFT Arrow. They are all lumped methods with certain assumptions about thermal conditions in the pipe and properties of the gas.
These traditional equations can be used successfully in many engineering applications. They all represent a subset of AFT Arrow’s marching methods, which solve the fundamental equations without limiting assumptions.

Does AFT Arrow Handle Sonic Choking?
AFT Arrow accurately models sonic choking at all three possible geometric conditions. See Sonic Choking for more information.

How Has AFT Arrow Been Verified?
There are several aspects to AFT Arrow verification.
First, AFT Arrow has been compared to published data where it exists. Available published data is usually for a single pipe, which is not very challenging for a network solver. Models, comparisons and explanations for such published predictions are given the Verification folder within AFT Arrow.
Second, it can be verified that the AFT Arrow predictions agree with the fundamental equations for single
pipes and networks.
Third, AFT Arrow offers two independent solution methods, which can be compared against each other.
Fourth, incompressible gas flow predictions for networks show good agreement with incompressible calculation methods such as AFT Arrow.
Finally, AFT Arrow predictions have been compared to test data and other analytical methods on numerous occasions and good agreement has been shown. For example, see Winters, B.A., and T.W. Walters,
"X-34 High Pressure Nitrogen Reaction Control System Design and Analysis".

Can AFT Arrow Be Used to Model Liquid Systems?
No, AFT Arrow cannot model liquid systems. AFT Arrow’s solution methodology is built on a gas equation of state, which is not compatible with liquid flow calculations. AFT Arrow can, however, model incompressible gas flow such as occurs in venting systems and many HVAC systems.
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How Does AFT Arrow Account for Real Gas Effects?
AFT Arrow’s solution methodology is based on the ideal gas equation modified with a compressibility
factor. This compressibility factor can be obtained from an equation of state model or property library.
The effect of the compressibility factor is carried through the fundamental equation derivations, and thus
accounted for directly.

How Does AFT Arrow Account for Heat Transfer in Pipe Systems?
Heat transfer effects show up in several places in AFT Arrow. First, in pipes users may assign a convective coefficient and pipe wall resistance and/or allow AFT Arrow to calculate convective heat transfer
based on standard methods. These heat transfer calculations and the associated physical properties are
determined over each solution section. Thus properties and convective coefficients can and do vary
along the length of the pipe. Second, heat transfer can occur in Heat Exchanger junctions. Here the user
assigns a heat load or chooses a heat transfer model for the heat exchanger. AFT Arrow performs the
appropriate energy balance calculation across the heat exchanger. Third, heat transfer occurs in compressor/fans due to heat of compression.
Finally, at each branching location in the network an energy balance is performed so that energy is balanced from one pipe to the next.

Does AFT Arrow Account for the Heat of Compression in a Compressor?
Yes, AFT Arrow accounts for heat of compression based on the polytropic constant specified by the user
or the compressor/fan efficiency.

Does AFT Arrow Perform an Energy Balance Across Each Junction in the
Model?
Yes, every junction except for heat exchanger and compressor/fans is assumed to have a constant stagnation enthalpy (no heat or work transferred to/from the fluid). The static (thermodynamic) enthalpy can
and does change based on the energy equation.

What Is the Difference Between Using a Junction to Input Pressure Loss Data
and the Fittings & Losses in Pipes?
A junction has several advantages. First, solutions are given at all junctions, so the user can check the
results at the junction. In contrast, Fittings & Losses are lumped into the pipe and it is not possible to give
results at the loss. Second, many junctions (such as valves) have the ability to specify a CdA for sonic
choking calculations. No such ability exists for Fittings & Losses; thus, sonic choking is always ignored
for Fittings & Losses. Third, when using a junction the location in the pipe system of the pressure loss is
specified. In other words, the upstream and downstream pipe lengths are specified. Since the location of

- 44 -

Overview of AFT Arrow

the junction loss along a pipe can affect how much pressure is lost, the junction loss calculation is more
accurate than the pipe fitting loss. A short explanation of this is that the pressure loss due to a K factor
depends on the velocity squared. Typically, the velocity of the gas will change along the pipe, so the pressure drop of the K factor loss will depend on the local velocity. In the case of pipe fitting loss, it assumed
to act like a friction factor and be evenly distributed along the pipe.
The pipe fitting approach has the advantage of being able to specify multiple losses quickly and easily,
and not cluttering up the model Workspace with numerous junctions.

What Is the Difference Between a Tank Junction and an Assigned Pressure
Junction?
There is an overlap in capability between the Tank junction and an Assigned Pressure junction and frequently they are interchangeable. Here are the differences. The Tank junction input pressure and temperature always corresponds to stagnation properties. In the Assigned Pressure junction, they can
correspond to either static (with one connecting pipe) or stagnation properties (with one or more pipes).
The ability to represent static conditions is the reason the Assigned Pressure can connect only to one
pipe when using the static option. Static conditions have a flow velocity associated with them and multiple pipes would have multiple velocities. If the stagnation option is used in the Assigned Pressure junction, it will behave identically to a Tank junction. Finally, the Tank junction can act as the reference
pressure for a closed system, while the Assigned Pressure cannot.

How Does AFT Arrow Account for Pressure Losses at Tees and Wyes?
AFT Arrow uses models developed under incompressible flow conditions to calculate losses at tees and
wyes. The methods, which come from Idelchik, take into account losses that depend on the flow split,
area change and angle of the branch pipe. These loss models may not be accurate for some systems.

How Do I Size a Fan or Compressor When There Are Not Any Flow Control
Valves?
See Size a Compressor or Fan.

How Do I Size a Fan or Compressor When There Are Flow Control Valves?
See Size a Compressor or Fan with a Flow Control Valve.

How Do I Model a Variable Speed Fan?
Enter the fan data as a polynomial in the Compressor/Fan Properties window and then set the fan speed
directly. No entry is assumed to be 100% speed. If you enter something other than 100%, AFT Arrow
uses the affinity laws to adjust the curve.
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How Do I Account for Changes to a Fan Curve Based on Different Operating
Pressures?
If performance data is entered as head rise, no density correction is necessary. If entered in terms of
pressure, enter the fan data as a polynomial in the Compressor/Fan Properties window, select the option
to modify the curve for density difference, and then set the basis density for the curve (usually atmospheric density for the gas). AFT Arrow will modify the fan curve based on the operating density.

How Do I Find the Fan Speed to Obtain a Desired Flow or Discharge Pressure?
Enter the fan data as a polynomial in the Compressor/Fan Properties window and set the desired flow or
discharge pressure on the “Variable Speed” tab. AFT Arrow will calculate the fan speed required to produce the flow or pressure conditions specified and display the speed in the Compressor/Fan Summary
report.

How Do I Close a Valve, Fan or Pipe?
Select the pipe or junction you want to close and choose Special Condition from the Edit menu. By
default, AFT Arrow will display a red “X” next to the pipe or junction label on the Workspace. It will also
redraw your Workspace and show the closed sections of the model with dashed lines for the pipes and
dashed outlines for each junction.
Some special condition settings do not close the junction but have different purposes. For example, the
normal condition for a relief valve is to be closed, so its special condition causes it to be open.

How Do I Model the Pressure Drop Across a Component When There Is Only
One Data Point?
See Using Manufacturer Pressure Drop Data.

How Do I Model a Relief Valve in a System?
You can model a relief valve using either a Relief Valve junction or a regular Valve junction. The Relief
Valve junction is always closed when you run the model (unless you set its Special Condition), and AFT
Arrow will run the Solver to determine if sufficient pressure exists to crack it. If so, it will run the Solver
again with the relief valve open.
If you know the condition you are modeling will crack the relief valve, it is more efficient to just use a regular valve junction. In this case, AFT Arrow assumes the valve is open from the start, and does not have
to go through the extra step of solving the network to check for sufficient system pressure to crack it.
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How Do I Model a Valve Loss Given the Manufacturer Cv?
AFT Arrow supports the ANSI/ISA-75.01.01-2012 definition of valve Cv for gas flow. This can be
modeled in valve junctions, relief valves, check valves, or control valves.

How Do I Model Choked Flow Through a Valve, Orifice or Similar Element?
You must specify the CdA for Choking on the junction loss model tab. AFT Arrow uses this as the base
area for sonic calculations. If modeling the subsonic loss as Cv, you can account for choking by specifying Xt.

How Do I Model a Desuperheater in AFT Arrow?
You can use a Branch junction to model a desuperheater. Enter an inflow (source flow) at the branch and
specify the enthalpy of the source. AFT Arrow will perform an energy balance using this enthalpy, and
assume the discharge is still superheated, but at the new lower energy level.

How Do I Show the Pipe or Junction Names on the Workspace?
Open the pipe or junction Properties window, click the Optional tab, and check or clear the check boxes
for showing the number or name. This will affect the current pipe or junction. You can set the default behavior in the Workspace Preferences area available on the User Options window.

How Do I Change the Display of Pipe or Junction Names on the Workspace
After the Model Has Been Built?
You can use the Global Edit windows to change the current model settings for all pipes or junctions or
only selected ones. See the Global Pipe Edit or Global Junction Edit window for more information.

How Do I Set My Preferred Engineering Units as Defaults?
From the Tools menu, select User Options. Then select Preferred Units under Unit System. Drop down
the list of units for each Unit Family to select the Preferred Unit. At this point, the preferred unit applies
only to the current model. To make this the default for all models, click the Save as New User Defaults
button at the bottom.

- 47 -

Overview of AFT Arrow

How Do I Change the Input Data for Multiple Pipes or Junctions All at One
Time?
The Global Pipe Edit and Global Junction Edit windows offer tremendous power and flexibility in changing all or parts of your model input all at once.

How Do I Create a Gas Mixture?
You can create gas mixtures with the NIST REFPROP fluid library or the optional Chempak fluid library
add-on. The AFT Standard gas library does not support mixing. To create a mixture, open the Fluid Properties panel in the Analysis Setup window, choose the NIST REFPROP or Chempak library, and then
click the “Create New Mixture and Add…” button. Here you can specify the mixture components and percentages.

How Do I Model a Dynamic Mixing Process?
You can model dynamic gas mixtures with the included NIST REFPROP library or the optional Chempak
add-on. The AFT Standard gas library does not support mixing. To model dynamic mixing, open the Fluid
Properties panel in the Analysis Setup window, choose the NIST REFPROP or Chempak library, and
then choose the gases in the list and add them to the model. You can add any number of gases, and also
create gas mixtures and add them.
Once the desired gases are added to the model, they can be assigned to different source junctions such
as Tanks, Assigned Pressures and Assigned Flows. AFT Arrow applies the gas or gas mixture to the
junction’s connecting pipes. It then solves the network, carrying the gas composition to each section of
the model in accordance with species mass conservation. As the solution progresses, the mass flows will
adjust as they approach convergence and AFT Arrow updates the concentration balance for each iteration based on the current global mass balance.

How Do I Merge Two Models Together?
Use the Merge feature on the File menu to merge models together.

How Do I Automatically Run Multiple Models Right After Each Other?
Multiple models can be run sequentially using the Batch Run feature.
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How Do I Enable or Disable the Highlight Feature in the Pipe and Junction Properties Windows?
There are three ways to enable or disable the Highlight feature. The first is toggling the option on the view
menu. The second is pressing the F2 function key while in a Pipe and Junction Properties window. The
third is double-clicking the anywhere in the Pipe and Junction Properties window.

How Do I Automatically Save My Results After The Model Is Run?
Open the Output Control window from the Analysis menu, change to the Format & Action folder, and
choose to select the Transfer Results to Initial When Done, Transfer Valve States When Done, and Save
Model When Results are Transferred options.

How Do I Quickly Find a Particular Pipe or Junction on the Workspace?
Use the Find feature to quickly find a pipe or junction.

How Do I Change The Reference Positive Flow Direction for One or More Pipes?
Select the pipe or pipes and choose the Reverse Direction feature on the Arrange menu.

How Do I Access Pipe and Junction Properties Windows from the Model Data
Window?
In the Model Data tabular displays, double-click the far-left column where the pipe or junction number is
located and the appropriate Properties window will be opened.

How Do I Display Only Selected Pipes or Junctions in the Output?
Open the Output Control window from the Analysis menu, change to the Show Selected Pipes/Junctions
folder, and select the pipes and or junctions you want to display.

How Do I Quickly Change the Units for an Output Parameter?
Whereas the Output Control window allows you specify units for all parameters, when in the Output window viewing results you can quickly change the units for parameters in the tabular displays by doubleclicking the column header.
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How Do I Model Elevation Changes in my pipe system?
Set the elevations in the elevation fields for each junction. Pipes are assumed to be linear between junctions. If you need to model a system other than a stationary earth-based system, the gravitational acceleration can be changed in the Environmental Properties panel.

How Do I Model a Rotating Pipe System Such as Might Exist in Turbomachinery?
Specify the rotational speed in the Environmental Properties panel. The zero datum is the rotational
centerline. Elevation input in Junction windows take on the alternate meaning of distance to rotational
centerline. See Rotating Systems for more information.

How Do I Show Data for Only Selected Pipes or Junctions in Visual Report?
Open the Visual Report Control window, change to the Show Selected Pipes/Junctions folder, and use
the provided features to specify which pipes and junctions should display data and which should not.

How Do I Make the Pipe Drawing Tool Stay Active so That I Can Continue to
Draw Pipes Without Having to Click It Each Time?
If you hold down the CTRL key when completing the pipe drawing (just before releasing the mouse button), the Pipe Drawing tool remains active, and you can draw a series of pipes without returning to the
Toolbox each time.
If you double-click the Pipe Drawing tool it remains active until you click it again a single time. This allows
you to draw a series of pipes without returning to the Toolbox each time.

How Do I Add Graphical Segments to a Pipe so It Is Not Constrained to a Single
Straight Line?
Use the Segment Pipe tools found on the Arrange Menu.

How Do I Set Up Custom Libraries on My Local PC?
See Library Browser.
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How Do I Set Up Custom Libraries on Our Local or Wide Area Network?
See Network Library Overview.

How Do I Change the Icon for a Junction in AFT Arrow?
Open the Junction Properties window, click the Optional tab, and then click the Change Icon button.

Can I Customize the Junction Icons in AFT Arrow?
No, AFT Arrow icons are in a resource file that cannot be edited by the user. This capability is planned for
a future release.

What Is the Limit to the Size of Model I Can Create with AFT Arrow?
There are no theoretical limits to model size, but there are a few practical limits. First, AFT Arrow accepts
pipe and junction ID numbers up to 99,999. This limits the model size to 99,999 pipes and 99,999 junctions. Before you reach that limit, however, you will likely encounter a limitation of your available RAM to
hold all of the solver parameters. To determine how much RAM you need, add up the number of
branches and tees in the model. Take the square of this number. Then multiply it by 32 to get the amount
of RAM that must be available. For example, with 1,000 branches and tees, the square is 1 million, and
after multiplying by 32 you need 32 million bytes of RAM (i.e., 32 MB).

Can I Use Special Friction Equations such as Panhandle and Weymouth?
Yes, either Panhandle or Weymouth can be specified by selecting them in the Pipe Properties window.

Can AFT Arrow Model a Turbine in the System?
AFT Arrow can approximate a turbine using a heat exchanger junction. By assigning pressure drop and
heat rate data, the discharge conditions of a turbine can be modeled.

Can AFT Arrow Model Reacting Flows?
No, AFT Arrow models only non-reacting flows.
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Can I Install AFT Arrow onto a Local or Wide Area Network?
Yes, AFT Arrow can run off the network or local PC. When installed on a network, the number of concurrent users is limited to the number of licenses purchased.
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Fundamental Modeling Concepts
This section focuses on the critical concepts and theories that comprise the model building process in
AFT Arrow. Topics include discussions on the role of pipe and junction objects, descriptions of how
boundary conditions and flow direction are specified, and instructions on how to model closed systems.
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Pipes and Junctions
AFT Arrow employs two fundamental pipe system constructs: pipes and junctions.
Pipes are conduits for steady-state, compressible, one-dimensional gas flow. The flow rate through the
entire length of the pipe is always constant. Pressure drop due to friction occurs in pipes. Heat transfer
may or may not occur depending on the type of model you select.
Junctions are connector points for pipes and are elements at which flow balances are made. Some junction types can only connect to one pipe; others can connect with up to twenty-five.
In addition to balancing flow and energy, junctions also influence the flow or pressure behavior of the system. For example, a tank junction applies a constant pressure at a location, and the flow there is free to
adjust in whatever manner is consistent with the governing equations. In contrast, an assigned flow junction applies a known flow rate at its location, allowing the pressure to adjust to that level dictated by the
governing equations. The various junction types allow you to specify special kinds of irrecoverable pressure losses for gas behavior. In some cases you can specify special kinds of thermal behavior.
Junctions communicate with each other through the pipes connecting them. Each pipe must be connected to two junctions. There are no exceptions to this rule.
A pipe differs from a junction in that it has a reference positive flow direction. To say a pipe has a flow rate
of 1 lbm/sec is meaningless unless the flow direction is specified.
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In general, you do not need to specify the actual flow direction in a pipe, because AFT Arrow sorts out the
true physical flow directions of the system you define. For example, if you specify the reference positive
flow direction from left to right, and the solution is in fact the opposite direction, then that information will
be presented in the output as a negative flow rate. Inlet and outlet conditions correspond to the reference
positive flow direction, not the actual flow direction.
However, it is important to specify the proper flow direction for pipes which connect to junctions such as
compressor/fans or valves. AFT Arrow uses the flow direction of the pipes to determine in which direction to increase or reduce pressure.
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Convention for Positive Flow Direction
Reference Positive Flow Direction
Next to each pipe's ID number is an arrow that indicates the reference positive flow direction for the pipe.
AFT Arrow assigns a flow direction corresponding to the direction in which the pipe is drawn. You can
reverse the reference positive flow direction by choosing Reverse Direction from the Edit menu or selecting the reverse direction button on the Toolbar.
The reference positive flow direction is used for reference purposes only and need not be the actual flow
direction. If the reference positive direction is the opposite of that obtained by the Solver, the output will
show the flow rate as a negative number.

Convention for Flowing Entering and Exiting
Many of the junction types permit gas flow to come into or pass out of the system in a prescribed manner.
The most obvious of these is the tank junction. Tanks maintain a constant pressure and temperature at a
node, and the flow adjusts according to the governing equations. While in principle the gas is stored or
removed from the tank, AFT Arrow considers the gas as coming into or going out of the system. The
stored tank fluid is not part of the system.
The convention for defining inward or outward flow for the system or any AFT Arrow object is that flow in
is positive (that is, the object/system gains the flow) and flow out is negative (the object/system loses the
flow).
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Features for Modeling Irrecoverable Losses
AFT Arrow works almost exclusively with the concept of the loss factor, also known as K-factor or resistance factor. In some Properties windows, other popular methods for specifying loss information are
provided where they are consistent with the loss factor method. For example, you will find Cd (discharge
coefficients) for orifices.
No provision has been made for the equivalent length approach to solving pressure drop problems.
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Philosophy of Computer Modeling
Some might say that a “good” computer model is one that accurately predicts the response of a system;
but this is only partly true. The practicing engineer generally must weigh the accuracy of the model
against the risk, schedule, and/or budget involved. Through experience, an engineer learns where to
focus resources and when an answer is good enough to base important decisions on.
Although AFT Arrow is designed to speed up the modeling process, it should never be used as a “black
box.” Your model input and output should always be carefully reviewed.
To make the most effective use of AFT Arrow, you should follow these guidelines:
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l

Be aware of what AFT Arrow can and cannot do and the assumptions it makes.

l

Learn and use the tools in AFT Arrow that are appropriate for the specific analysis you want to perform. Detailed and accurate answers demand detailed and accurate input. Quick and dirty
answers require less detailed input.

l

Learn and use the tools in AFT Arrow that allow you to process information in the formats that
mean the most to you. Because pipe flow applications vary so much within different industries,
AFT Arrow is customizable for the way you want to do your pipe flow work. Understanding the
tools will help you gain greater conceptual control over your pipe flow analyses and reduce modeling errors.

l

Check your input data. Use the features available in AFT Arrow to review your results for input
errors. Pay attention to the information in the output. Don't neglect warnings in the output. Perform
hand analysis checks of results.

l

Bound your problem. Instead of trying to calculate the exact resistance in a network, or the right
loss factor for an orifice, use your judgment, guided by data, on how much variation might occur.
By running your model at the upper and lower limits, you can obtain answers, for example, on the
maximum and minimum possible pressure drops in the system. If the results at the maximum and
minimum are acceptable, your analysis is probably finished. If they are not acceptable, you can further refine the input model.

l

Recognize whether your problem is one of maximization or minimization. That is, recognize
whether the design goal is to minimize the flow rate, for example, or maximize the flow rate. Then
make your assumptions conservative enough to provide high confidence that your design requirements are being satisfied.
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Role of Pressure Junctions and How They Work
Role of Pressure Junctions
In modeling a generalized pipe network, it is possible to construct models that do not have a unique solution. A common occurrence of this is when a model contains one or more sections which are completely
bounded by known flow rates.
The simplest example is the system shown in Figure 1. In AFT Arrow terms, the system has two assigned
flow junctions.
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Figure 1: Model with two assigned flows. This model does not have a unique solution

Obviously, the flow in the pipe is known. But what is the pressure at the inlet? At the outlet? It cannot be
determined because there is no reference pressure. The reference pressure is that pressure from which
other pressures in the system are derived. There can be one or more reference pressures, but there
always has to be at least one.
The model in Figure 1 can be built with AFT Arrow and if you try and run this model, AFT Arrow will inform
you that it cannot run it because of the lack of a reference pressure (Figure 2). In AFT Arrow there are
several junctions that can act as a reference pressure: the tank, assigned pressure, relief valve junctions
which are open to external pressure, pressure control valves, orifice (with the exit orifice option) and
valves (with the exit valve option).
When you try and run a model that has one or more sections completely bounded by known flows (or
Flow Control Valves or Compressor/Fans operating in fixed flow mode), the Need Reference Pressure
window (shown below) is displayed. This window informs you which junctions bound the sections where
a reference pressure is needed to obtain a unique solution.
In multi-pipe systems there are a host of other possibilities that present themselves. All other configuration possibilities which lack a reference pressure ultimately boil down to the same problem that exists in Figure 1.
See Role of Pressure Junctions - Detailed Discussion for more information.

Figure 2: AFT Arrow message when you try to run a model without sufficient reference pressures
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How Pressure Junctions Work
Pressure junctions (e.g., Tanks or Assigned Pressures) in AFT Arrow are an infinite source or sink of
fluid. This means that they can draw or discharge as much fluid as is necessary to maintain the specified
pressure. Some engineers have difficulty grasping this concept, and misuse pressure junctions in AFT
Arrow. This section offers a physical example of how pressure junctions work to clarify for those having
difficulty with the concept.
Consider the physical system shown in Figure 3. This system compresses air from a low pressure supply
tank to a high pressure discharge tank.

Figure 3: Physical compressor system to transfer air from low pressure tank (J1) to high pressure discharge
tank (J2)

An engineer is tasked with sizing the compressor for this system. The engineer has an idea of the discharge pressure needed for the compressor, and so builds an AFT Arrow model as shown in Figure 4.
The Figure 4 model is attempting to represent the physical system in Figure 3, but it in fact represents the
physical system in Figure 5.

Figure 4: Model to size compressor attempting to represent system in Figure 3, but actually represents the
system in Figure 5
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Figure 5: Physical system represented by model in Figure 4

Why? Because the tank junction (J4), which is an infinite source of fluid, has been located between the
compressor (J3) and the discharge tank (J2). The J4 tank isolates the supply tank and compressor (J1
and J3) from the discharge tank (J2). The J4 tank is very much like placing the atmosphere between the
supply and discharge piping.
If the engineer changes the pressure in J4, it is like changing the atmospheric pressure. It will change the
flow rate in the pipes, but no matter how high the pressure of J4, it does not change the fact that the compression system is isolated from the discharge tank. The flow rate in the piping from J4 to J2 is entirely
dependent on the difference in pressures between J2 and J4, and is not influenced by the J3 compressor
in any way.
How then should the physical system in Figure 3 be modeled? It should be modeled as shown in Figure
6.

Figure 6: Proper model of physical system shown in Figure 3

If the goal is to size the compressor at J3, the model in Figure 6 can be used with the compressor
modeled as a fixed flow compressor.
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Open vs. Closed Systems
Model a Closed Loop System
A closed circulating system can easily be modeled with AFT Arrow by locating a Tank junction anywhere
in the system and setting the pressure to the known pressure at that point. Inflow and outflow pipes will
then need to be connected. The Tank junction merely acts as a "reference pressure" against which all
other pressures in the system are compared. Because there are no other inlets or outlets to the system,
then whatever is delivered by the Tank junction to the system will also be received from the other pipes,
thus achieving a net zero outflow rate for the system.
When using a Tank junction to model a closed system, you should select the Balance Energy in Tank
option, which will allow the tank temperature to vary and be calculated in a manner consistent with the
overall energy balance.

Balancing Mass
In order to model a closed system, only one pressure junction is used in the model. Typically this would
be a Tank junction . Pressure type junctions are an infinite source of fluid and do not balance flow. How
then can one be used to flow in a closed system?
To answer this question, it is worth considering how AFT Arrow views a closed system model. AFT Arrow
does not directly model closed systems, and in fact does not even realize a closed system is being
modeled.
Consider the system shown in Figure 1. This is an open system. Fluid is taken from J1 and delivered to
J4 and J5. Because AFT Arrow's solution engine solves for a mass balance in the system, all flow out of
J1 must be delivered to J4 and J5. Because the flow is steady-state, no fluid can be stored in the system;
what goes in must go out.

Figure 1: Open system - Flow out of J1 equals the sum of J4 and J5

Now consider the systems in Figure 2. The first system appears to be closed, while the second appears
to be open. If the same boundary condition (i.e., pressure, temperature and surface elevation) is used for
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J1, J11 and J12 in the second system, to AFT Arrow it will appear as an identical system to the first system. The reason is that AFT Arrow takes the first system and applies the J1 tank pressure as a boundary
condition to pipes P4, P9 and P10. The second system uses three tanks to apply boundary conditions to
P4, P9 and P10. But if the tanks all have the same pressure, temperature and elevation, the boundary
conditions are the same as J1 in the first system. Thus the same boundary condition is used for P4, P9
and P10 in both models, and they appear identical to AFT Arrow.
But how is the flow balanced at J1 in the first system? Looking at the first system, one sees that to obtain
a system mass balance, whatever flows into P10 must come back through P4 and P9. Because there is
overall system mass balance by the solver, it will give the appearance of a balanced flow at the pressure
junction J1. If there is only one boundary (i.e., junction) where flow can enter or leave the pipe system,
then no flow will enter or leave because there isn't anywhere for it to go. Thus the net flow rate will be
zero at J1 (i.e., it will be balanced). But recognize that AFT Arrow is not applying a mass balance to J1 directly. It is merely the result of an overall system mass balance.

Figure 2: The first system is closed, and the second open. In both systems the flow into P10 is the same as
sum of P4 and P9. If the second system has the same conditions at J1, J11 and J12, the two systems will
appear identical to AFT Arrow.

Balancing Energy
Here the thermal aspects of open and closed systems are discussed. If you have not read and grasped
the discussion on mass balance in closed systems, please read that section before this one.
Consider the system shown in Figure 1. We know that the flows are balanced at J1, but how can the
energy be balanced? For example, assume the user sets a temperature of 100° F at J1. This temperature will be the inlet pipe stagnation temperature for all pipes that flow out of J1. In this case, the 100°
F will apply only to pipe P10.
The pipes flowing into the tank (P4 and P9) will have their own temperatures that are obtained by balancing energy along their individual flow paths. This will include heat exchanger input and heat transfer
to or from pipes, as well as any heat of compression effects in the compressor.
The only way to obtain an overall system energy balance is for the J1 tank temperature to adjust to the
mixture temperature (mixture stagnation enthalpy, to be more precise) of all inflowing pipes. This is the
function of the “Balance Energy At Tank” feature in the Tank junction . The junction temperature (input as
maybe 100° F) is allowed to “float” and find its own equilibrium. Each iteration the floating tank temperature is passed into pipe P10 until convergence. When passed into P10, this will affect the return temperatures of P4 and P9. There is a unique “mixture temperature” (or mixture stagnation enthalpy) that will
yield an energy balance at J1. This will be the temperature/enthalpy from Equation 49 in the Network
Implementation topic.
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Figure 3: Example of balancing energy in a closed system
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Curve Fitting
There are many places in AFT Arrow where the user is asked to define how a property changes in relation to another. Some examples are:
l

Fan Curves

l

Junction Resistance Curves

l

Custom Fluids

l

Pipe Physical Properties

These properties are entered in a table format, relating one particular property to several others. For
example, see the below definition of a custom fluid:
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Figure 1: Custom Fluid Definition

There are several parameters that control the behavior of the fluid and they are entered as they relate to
temperature.
However, it is important to recognize that these values in particular are not directly used in the solution.
Instead, the data is used to create a best-fit curve. This curve is then used in the solution process. This is
an important step to take because there must be a continuous relationship between the independent variable (e.g. temperature) and the dependent variable (e.g. density). Even if the final solution was close to
one of the defined points, the solver needs continuous data to proceed.
There are some options for how the data is curve fit. First, there are two Curve Fit Types:
l

Polynomial - The data is best fit to a polynomial of order 0,1,2,3, or 4. Note that a 0th order polynomial is a constant value, and a 1st order is a linear fit.

l

Interpolated X-Y Data - The data has a linear interpolation drawn between every data point.

One of the critical items to note with any curve fit is that you may not be operating close to one of your
defined points if the data does not conform well to a polynomial relationship. For example, the below fluid
(a liquid) has a rapidly decaying viscosity that does not follow a polynomial relationship. Fitting the data to
the standard 2nd order polynomial results in the following:
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Figure 2: Using a Polynomial Curve Fit on Non-Polynomial Data

The viscosity relationship in the model will use the blue curve, and not the user-defined black points.
Depending on the operating range of the system, this may significantly impact the results! For this data in
particular, using the Interpolated X-Y Data option may be a better choice.
After data has been curve fit, the constants for the resulting curve are displayed in the lower right of the
associated window. For example, in Figure 1 above there are a, b, and c constants shown for the Density
(Rho) curve fit. These values use a base unit, which is not necessarily the unit the user has defined for
that parameter.
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Stagnation vs. Static Pressure Boundaries
With two exceptions (to be discussed), all pressure-type boundary conditions in AFT Arrow are stagnation. This works very well for things such as large storage tanks or atmospheric boundaries, where the
volume associated with a pressure is large and will not change (significantly) with time. These boundaries have no velocity associated with them, and using stagnation pressure is thus appropriate. These
boundary conditions are most clearly rendered in AFT Arrow by use of a Tank junction.
For simplicity, we will discuss this in terms of an incompressible flow example. Consider the reservoir and
connected pipe in Figure 1. When the liquid in a reservoir flows into connecting pipes, the static pressure
immediately drops due to the increase in velocity.
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It is tempting to say that because there is no velocity in the reservoir, then it does not matter whether the
reservoir boundary pressure is considered as a static or stagnation pressure because they are equal.
This is a misconception. The pressure boundary condition in an AFT Arrow model is applied at the exit of
the junction, not within the junction itself. Inside the reservoir, the static and stagnation pressures are the
same, but they are not the same at the exit - they differ by the amount of the dynamic pressure.
Note: An incompressible liquid flow example is given because it is easier to discuss, but the principles
apply similarly to compressible flow.

Figure 1: Reservoir with one connecting pipe (incompressible flow)

The appropriateness of either stagnation or static pressure as a boundary condition depends on whether
there is a velocity associated with the pressure that is specified. Is the pressure in a vessel or large (lower
velocity) header, or is it in a pipe somewhere in the middle of a system? If the first, stagnation is more
appropriate; if the second, static.
Pressure boundary conditions with no velocity are more common across all piping industries, and are
usually appropriate. However, this is not always the case.

When to Use Static Pressure
Now let's consider the application of a true static pressure boundary condition. A static boundary condition has a unique velocity associated with it. The Bernoulli equation, which in this integrated form
applies only to incompressible flow, is given by:

From this equation it can be seen that application of the static pressure is not sufficient to specify location
1. The velocity and elevation is also required. Note that though the equation above is only applicable for
incompressible flow, the general concept is applicable for compressible flow.
In AFT Arrow, elevation data is entered for junctions. The pipes adopt the elevation of the junction to
which they are connected.
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But where does the velocity information in the Bernoulli equation come from? One might respond that it
can be obtained from the flow rate. But this raises another question: what if the flow rate isn’t known? Put
another way, what if the flow rate is what we are solving for?
Because the stagnation pressure combines the static pressure with the velocity information (in the form
of Mach number, see Stagnation Pressure definition), when the user supplies a stagnation pressure
boundary condition AFT Arrow can avoid the need for an associated velocity condition at location 1. A
stagnation pressure boundary can thus be supplied to multiple pipes that might have different velocities.
That is why the same Tank junction can connect with multiple pipes.
However, if the user specifies a static pressure as the boundary condition, a unique velocity (or Mach
number) must be supplied. Thus it is only possible to connect a static pressure to a single pipe with a
unique velocity.
Important: A static pressure boundary has a unique velocity (and Mach number) associated with it,
and can thus connect to only one pipe.
Where would one find a static pressure boundary? The best example is when the boundary condition is
inside a pipe. A pipe system model can start and end anywhere it is convenient for the user. It may be
convenient to not start the model at the physical boundary (such as a tank) but at a particular location in
the pipe system. This could be, for example, at the location of a pressure measurement. Or it could be at
the boundary of the pipe system for which your company is responsible, with another company responsible for what is on the other side of that boundary.
If one needs to model such a situation, the Assigned Pressure junction allows one to model either a static
or stagnation pressure. The default stagnation pressure allows connection of up to 25 pipes. If static pressure is chosen, only one connecting pipe is allowed.

Static Pressure at Pressure Control Valves
Another example of static pressure is at pressure control valves. For pressure control valves (i.e., PRV’s
and PSV’s) the default control pressure is static pressure. The reason is that the measured pressure that
provides feedback to the controller will typically be a static pressure measurement. You have the option
of modeling pressure control valves as either static or stagnation pressure.
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Analysis Setup Overview
Analysis Setup contains all of the settings which the user must define to run the model, including fluid
properties, pipe and junction status, environmental properties, and other related options. Launch Analysis Setup from either the toolbar or the Analysis menu.
The controls in Analysis Setup are divided into different groups in the navigation pane on the left of the
window (Figure 1). Each group has one or multiple items. Clicking on an item opens the panel for that
item.
A group is not fully defined until each item in that group is defined. Each group will have either a green
check mark, indicating that all required items have been defined, or a red exclamation point, indicating
that some or all of the required inputs are missing. Note that some groups will have a green checkmark
by default, indicating that the required inputs have default settings already applied, or all inputs for that
group are optional. Groups that are undefined will change to a green check mark when the required
inputs for that group are entered, and the user navigates to a different panel. Note that none of the
changes will be applied to the model until OK is selected. Clicking Cancel will discard all changes made
in the window.
The groups in Analysis Setup are
l

Modules Group

l

Fluid Properties Group

l

Pipes and Junctions Group

l

Goal Seek and Control Group - (GSC Module only)

l

Steady Solution Control Group

l

Environmental Properties Group

l

Cost Settings Group

l

Automatic Sizing Group - (ANS Module only)

l

Miscellaneous Group
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Figure 1: Default state of Analysis Setup in a new blank model

Related Examples
Beginner: Air Heating System

702

Modules Group
AFT Arrow has several optional add-on modules which extend its modeling capabilities into other areas.
The modules allow multivariable goal seeking and control simulation, time varying simulation, and full
system sizing. The Modules panel within the Modules Group in Analysis Setup allows you to activate and
enable any of the add-on modules. An additional license to the base AFT Arrow license is required to use
a module. These modules include:
l

GSC (Goal Seek & Control) - Identifies input parameters that yield desired output values and simulates control functions.

l

XTS (Extended Time Simulation) - Models dynamic system behavior and how critical system parameters vary over time.

l

ANS (Automated Network Sizing) - Evaluates the complex interaction of system variables to
reveal combinations of cost savings.

Related Topics
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Analysis Setup Overview
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Modules Panel
The Modules panel allows users to activate and enable the optional add-on modules.
Activating a module checks out a license seat for the module.
Enabling a module turns on all functionality for the module. By default activating a module will also automatically enable the module for use. Disabling a module keeps the license seat checked out but the module calculations are not applied to the model. Disabling a module may be desired for various reasons, as
is discussed further for each module below.
Note: A module specific license is required to activate the GSC, XTS, or ANS add-on modules.

Figure 1: The default state of the Modules panel

GSC (Goal Seek & Control)
Activate the Goal Seek & Control module by checking the box next to Activate GSC. Once activated,
enable it by selecting Use or disable it by selecting Ignore. When the GSC module is activated, the Goal
Seek and Control Group appears in the Analysis Setup window. The Goal Seek and Control group has
three items: Variables, Goals, and Numerical Controls.
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The GSC module can be enabled before or after a model is built. Pre-existing models built with the base
AFT Arrow application can have the GSC module activated.
Setting the GSC module to Ignore causes the GSC module to function like the base AFT Arrow application. One difference is that users are still able to enter goal seeking data with this data retained in the
model. If the model is opened in the base AFT Arrow application, this data will be lost. Table 1 relates the
differences between using AFT Arrow without the GSC module activated, using it with the GSC module
activated but disabled (Ignore mode), and using it with the GSC module activated and enabled.
The GSC module can also be toggled between Use and Ignore from the Analysis menu in the Goal Seek
& Control option as shown in Figure 2. Use this feature to quickly toggle the GSC module between Use
and Ignore without opening the Modules panel in Analysis Setup.

Table 1: AFT Arrow feature accessibility based on the GSC module activation and enablement

GSC Activated

GSC Not Activated

GSC Disabled

GSC Enabled

Goal Seek and Control Group in Analysis Setup

Not Visible

Visible

Visible

Goal Seek and Control in Analysis menu

Not Visible

Visible

Visible

Goal Seek and Control tab in General Section of
Model Data window

Not Visible

Visible

Visible

GSC Variables and GSC Goals tabs in General
Section of Output window

Not Visible

Not Visible

Visible

Features

Figure 2: Select Use from the Goal Seek & Control option in the Analysis menu to perform goal seeking when
running the model

XTS (Extended Time Simulation)
Activate the Extended Time Simulation module by checking the box next to Activate XTS. Once activated, enable it by selecting Transient or disable it by selecting Steady Only. When the XTS module is
activated, the Transient Control group appears in the Analysis Setup. The Transient Control group has
one item: Simulation Duration.
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Activating the XTS module can be done before or after a model is built. If activated after, then additional
input will be required for transient junctions. Pre-existing models built with the base AFT Arrow application can have the XTS module activated.
Transient modeling can be turned off at any time by selecting Steady Only. The Steady Only mode
causes the XTS module to function like standard steady-state AFT Arrow. One difference is that users
can still enter transient data and this data is retained in the model. If the model is opened in standard AFT
Arrow, this data will be lost. Additionally, the Transient Control group and Simulation Duration panel are
still accessible. Table 4 relates the differences between not using XTS and using it in Steady Only mode.
The XTS module can be toggled between Steady Only and Transient from the Analysis menu in the Time
Simulation option as shown in Figure 4. Use this feature to quickly toggle the XTS module between
Steady Only and Transient without opening the Modules panel in Analysis Setup.

Table 4: AFT Arrow feature accessibility based on the XTS module activation and enablement

XTS Activated

XTS Not Activated

XTS Disabled

XTS Enabled

Transient Control Group in Analysis Setup

Not Visible

Visible

Visible

Time Simulation in Analysis Menu

Not Visible

Visible

Visible

Transient tab in junction properties windows

Not Visible

Visible

Visible

Transient Pipe and Jct tabs in Output

Not Visible

Not Visible

Visible

Transient tab in junction section of Model Data

Not Visible

Visible

Visible

Time control slider and buttons in Output

Not Visible

Not Visible

Visible

Time control slider and buttons in Visual Report

Not Visible

Not Visible

Visible

Transient tab on Select Graph Data

Not Visible

Not Visible

Visible

Animation controls in Graph Results

Not Visible

Not Visible

Visible

Features

Figure 4: Transient mode is enabled from the Analysis menu
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ANS (Automated Network Sizing)
Activate the Automated Network Sizing module by checking the box next to Activate ANS. Once activated, enable it by selecting Network or disable it by selecting Not Used. When the ANS module is activated, the Automatic Sizing group appears in the Analysis Setup. The Automatic Sizing group has one
item: Sizing Summary. Additionally, the Sizing Window becomes available when ANS is activated.
Activating the ANS module can be done before or after a model is built. If activated after, then additional
sizing data will be required to run the model. Pre-existing models built with the base AFT Arrow application can have the ANS module activated.
ANS can be disabled at any time by selecting Not Used from the same menu. The Not Used mode
causes the ANS module to function like the base AFT Arrow application. However, all ANS data and settings in the model will still be retained. If the model is opened in the base AFT Arrow application, this data
will be lost. The purpose of Not Used mode is that it allows ANS to be quickly turned off and on without
having to change data in the Sizing Objective.
The ANS module can be toggled between Network and Not Used from the Analysis menu in the Automated Sizing option as shown in Figure 5. Use this feature to quickly toggle the ANS module between
Network and Not Used without opening the Modules panel in Analysis Setup.

Figure 5: Enabling Automated Sizing from the Analysis menu

Related Topics
Modules Group
Add-on Modules

68
541

Fluid Properties Group
The Fluid Properties group in Analysis Setup gives you control over the fluid properties that influence
your pipe system analysis. There is only one item in the Fluid Properties Group, the Fluid panel.

Related Topics
Fluid Panel
Creating Gas Mixtures

73
77

- 72 -

Fundamental Modeling Concepts

Equation of State Models
Enthalpy Models
Fluid Accuracy Settings
Analysis Setup Overview
Modules Group
Pipes and Junctions Group
Goal Seek and Control Group
Steady Solution Control Group
Environmental Properties Group
Cost Settings Group
Automatic Sizing Group
Miscellaneous Group

79
84
86
67
68
87
90
100
136
138
141
142

Related Blogs
Get More Flexible With Your Fluids

Fluid Panel
The Fluid panel controls the properties of the fluid in the model. A default fluid is not selected - one must
be defined to run any simulation.
The first selection that must be made is what Fluids Library to use, if any. The available Fluid Libraries
are:
l

AFT Standard - An included library that offers 28 common fluids to the user. Saturation line
included for Arrow releases after May 11, 2022.

l

ASME Steam Tables - Data from the 1997 ASME Steam Tables. Saturation line data is included.

l

NIST REFPROP - Data compiled by the National Institute of Standards and Technology (NIST)
using thermophysical property models for a wide variety of fluids. Fluid mixtures are supported
with this library. Saturation line data is included.

l

Chempak Fluid - A large library of fluids with detailed property information, including data not
found in the AFT Standard fluids such as saturation lines. User defined mixtures of these fluids
can be defined.

After selecting a library, the Fluids Available in Library list is populated. One of the fluids can be selected
and used with the Add To Model button.

AFT Standard Library
The AFT Standard Library offers six equation of state models and three enthalpy models. These models
account for both temperature and pressure dependence on density and enthalpy.
The three transport properties (specific heat, dynamic viscosity, and thermal conductivity) are based on
polynomial curve fits which are functions of temperature only. The assumption that these properties are
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only functions of temperatures is generally a good assumption at low pressure. However, at high pressures (especially above the Critical Pressure), this assumption starts to break down.
To add a fluid into your model, select it from the list at the top and choose the Add to Model button. The
fluid will appear in the lower list of Fluids in Current Model. You can have only one AFT Standard fluid in
your model, as there is no mixing support for Standard fluids.

Figure 1: The Fluid panel with AFT Standard fluids shown

ASME Steam Tables Library
The ASME Steam Tables Library offers users access to steam properties obtained from the IAPWS
Industrial Formulation 1997 for the Thermodynamic Properties of Water and Steam (ISPWS-IF97), (see
ASME Press in References). This library is selected by choosing the option ASME Steam Tables at the
top of the Fluid panel. After this selection has been made, "ASME ’97 Steam" is displayed in the Fluids in
Current Model area at the bottom of the Fluid panel.
Detailed fluid properties information from SteamCalc can be calculated using the AFT SteamCalc
Viewer, which can be accessed from Tools > Fluid Property Viewers > SteamCalc. The SteamCalc
Viewer will be launched as a separate application, which can then be used to calculate fluid properties at
various conditions.
For more information on AFT SteamCalc Viewer see the SteamCalc Help File.
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Figure 2: The Fluid panel with ASME Steam Tables selected

NIST REFPROP Library
The NIST REFPROP Version 10 library is included as part of the Arrow installation. This fluid property
database is compiled by the National Institute of Standards and Technology (NIST), and is generally
based on the Helmhotz Free Energy Equation of State.
A NIST REFPROP fluid can be added to the model in the Fluid panel by selecting the NIST REFPROP
radio button.
Add a fluid from the list by selecting it and clicking Add to Model.
The NIST REFPROP library allows for the calculation of gas mixtures, as well as dynamic mixing in the
model. Saturation line data is also available.
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Figure 3: The Fluid panel with NIST REFPROP fluids shown

Chempak Library
The optional Chempak library offers approximately 600 fluids to the user. In addition, it offers non-reacting mixture calculations and the ability to calculate dynamic mixing.
A Chempak fluid is added the same way as an AFT Standard fluid is added. To add a Chempak fluid,
select Chempak Fluid at the top of the Fluid panel. From here, select the appropriate fluid from the fluid
list and click the Add to Model button. After a fluid is added to the model, it will appear in the lower list
under Fluids in Current Model.
The equation of state is that of Wu & Stiel which is an extension of Lee Kesler to cover polars as well as
non-polars. Properties are derived by interpolation between a Simple Fluid (mainly Argon), a Reference
Fluid (mainly Octane) and a Polar Fluid (Water) using Acentric Factor and Stiel Y Factor as interpolating
variables. These compound parameters (OM, the Acentric Factor and YFACT the Stiel Y Factor) are
derived from the compound vapor pressure curve. For more information see the Chempak Technical
Information topic.
Detailed fluid properties information from Chempak can be calculated using the AFT Chempak Viewer,
which can be accessed from Tools > Fluid Property Viewers > Chempak. The Chempak Viewer will be
launched as a separate application, which can then be used to calculate fluid properties at various conditions. A Chempak Data license is required to use the Chempak viewer.
For more information on AFT Chempak Viewer see the Chempak Viewer Help File.

- 76 -

Fundamental Modeling Concepts

Figure 3: The Fluid panel with Chempak fluids shown

Related Topics
Fluid Properties Group
Creating Gas Mixtures
Equation of State Models
Enthalpy Models
Fluid Accuracy Settings
Chempak temperature and/or pressure is out of range for the following
Temperature at pipe X inlet/outlet is above/below max/min fluid temperature range
Fluid is no longer in the vapor phase because the fluid temperature/pressure is...

72
77
79
84
86
668
674
670

Related Blogs
Get the Most Out of AFT's Fluid Property Viewers
Get More Flexible With Your Fluids

Creating Gas Mixtures
You have the option of creating a mixture of fluids with NIST REFPROP and Chempak.
To create a mixture, first select Chempak or NIST REFPROP in the Fluid panel. Once this has been
selected, the option to Create New Mixture and Add... button becomes available. Select this button, then
locate and highlight the first fluid in the mixture you wish to specify. Enter the mass or mole fraction of the
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fluid in the mixture, and click Add Fluid to Mixture. Repeat this process for all fluids in the mixture as
shown in Figure 1.
Note: The fraction basis of all mixtures is either mass or mole, and it is specified on the Fluid panel
itself. If you would like to change the fraction basis for the mixture (from mass to mole or from
mole to mass), click on the desired fraction basis located Next to the Fluids in Current Model list.
The mixtures you create here are referred to as static mixtures because you are specifying the composition before the model is run. Any of these gases or mixtures shown as Fluids in Current Model can be
assigned to boundary junctions such as Tanks or Assigned Flows.
Assigning different fluids or mixtures to different junctions will (usually) result in mixing flow streams
where the composition will change. The relative percentage of gases in the mixed composition depends
on the flow solution. Hence, these mixture compositions change as the simulation converges on a flow
balance. For this reason these mixtures are called dynamic mixtures.
Note: The NIST REFPROP fluid library is not able to calculate the mixing parameters for most mixtures containing steam.

Figure 1: The Create Mixture window (opened from the Fluid panel) allows you to create predefined mixtures
for the model. This example shows a mixture of oxygen and nitrogen.
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Related Topics
Fluid Properties Group
Fluid Panel
Equation of State Models
Enthalpy Models
Fluid Accuracy Settings

72
73
79
84
86

Related Examples
Hydrocarbon Relief System

768

Related Blogs
Get More Flexible With Your Fluids

Equation of State Models
AFT Arrow uses the Ideal Gas model with a corrected compressibility factor, Z, to model AFT Standard
fluids. The Z-factor can be calculated by numerous correlations. Arrow offers 6 options: Constant Z, Ideal
Gas, Peng-Robinson, Redlich-Kwong, Soave Redlich-Kwong, and Three-Parameter.
The Ideal Gas option leaves the Z-factor defined at 1, meaning the fluid is modeled as an Ideal Gas. The
Constant Z option allows the user to specify a value for Z which Arrow then uses for all property calculations. The other Equation of State options are discussed in turn below.

Equations of State Nomenclature
There are a few characterizing fluid properties that are common to all of the Equations of state below.
The reduced temperature (Tr) and reduced pressure (Pr) are the ratios of the thermodynamic properties to the critical properties. For example,

is the definition of the reduced pressure. The reduced temperature could be written similarly.
ω is the acentric factor, for which values can be found in chemical engineering data books. It is a correction factor that can be set to zero if you cannot find data for the fluid. However, accuracy will be
reduced.
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Redlich-Kwong
The Redlich-Kwong Equation of State is given by the following cubic equation.

where

And Pc and Tc are the critical pressure and temperature, respectively. V is the molar volume.
An alternative form of the Redlich-Kwong equation can be obtained by multiplying the Redlich-Kwong
equation by V/RT.

where

Elimination of the "a" and "b" terms gives
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where Tr and Pr are the reduced temperature and reduced pressure.

Soave-Redlich-Kwong (SRK)
Soave proposed a modified version of the Redlich-Kwong method as follows

where

where Tr is the reduced temperature, and ω is the acentric factor.
The SRK equation can also be written as in terms of Z as

where
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The largest root of Z for the cubic equation is the compressibility factor for the vapor form of the fluid.

Peng-Robinson
The Peng-Robinson Equation of State uses a similar form to the Redlich-Kwong equation of state cubic
equation. The Peng-Robinson cubic equation is given as follows

where

And Pc and Tc are the critical pressure and temperature, respectively, V is the molar volume, Tr is the
reduced temperature and ω is the acentric factor.
The above equation for pressure can be rewritten as

where
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The largest root of Z for the above equation is the compressibility factor of the vapor form of the fluid.

Three-parameter
Arrow implements a Three-Parameter Equation of State derived by Pitzer for the second coefficient in
the Virial Equation of State. The Three-Parameter model as used by Arrow is taken from page 102 of
Smith, van Ness, and Abbott and shown below.

where Z is the compressibility factor, and Pr and Tr are the reduced pressure and temperature, respectively.
The constants B0 and B1 are given by the following

and ω is the acentric factor.

Related Topics
Fluid Properties Group
Fluid Panel

72
73
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Creating Gas Mixtures
Enthalpy Models
Fluid Accuracy Settings

77
84
86

Enthalpy Models
For superheated gases, enthalpy is a function of both temperature and pressure:

However, enthalpy is more strongly a function of temperature, and thus you will frequently see the
approximation as follows:

where the specific heat at constant pressure is used as a proportionality constant. For processes that are
not at constant pressure, the above approximation starts to lose accuracy.
AFT Arrow offers three ways to calculate the enthalpy. Below is a description of each.

Reference Enthalpy
The Reference Enthalpy Method uses the following equation to calculate enthalpy

The reference enthalpy and temperature is entered in the fluid library, and should be for a state that is as
near as possible to the operating conditions of your model. As seen from the equation, the pressure
dependence of enthalpy is ignored. In many cases, this assumption is acceptable.

Generalized Enthalpy
The Generalized Enthalpy Method is an extension of the Reference Enthalpy Method. The Generalized
Enthalpy, similar to the Three-Parameter Method, uses critical property data to calculate a Residual
Enthalpy. The method is shown below.

where:
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B0 and B1 are as given previously, and:

Table Lookup Enthalpy
The third method of obtaining enthalpy data is by using AFT Arrow's two-dimensional table. In this
method, a sequence of polynomial curve fits as a function of temperature are used. Each step in the
sequence is for a different pressure.

With this method, enthalpies would be obtained by interpolating the polynomials between 25 and 50 psia
at a given temperature. Up to 10 pressure table entries can be used. If the pressure is outside the table
range, the enthalpy is extrapolated.

Related Topics
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Fluid Properties Group
Fluid Panel
Creating Gas Mixtures
Equation of State Models
Fluid Accuracy Settings

72
73
77
79
86

Fluid Accuracy Settings
Several advanced settings are available to fine-tune the accuracy of the fluid properties for the Arrow simulation. These options can be enabled from Tools -> User Options by going to the Show options under
General (global).
Once enabled the Fluid Accuracy settings are located on the Fluid panel below the Fluids Available in
Library area (Figure 1).

Figure 1: Fluid panel in Analysis Setup with the Fluid Accuracy Settings enabled

State Properties
This option is applicable to only to Chempak fluids.
The State Properties option influences the number of elements used in curve fits for calculating property
data. You will usually want to start with standard accuracy, and use high accuracy for final runs, depending on the importance and run time for the model. The high accuracy option will increase run time by
about a factor of two.
When performing interpolations for properties, a 4 point or 16 point interpolation scheme can be used.
The 4 point scheme implemented in AFT Arrow is the Standard Accuracy option. The 16 point scheme is
the high accuracy option. Use of the High accuracy option will roughly double the run times for models.
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Sonic Velocity
This option is applicable to only to Chempak fluids.
The standard accuracy sonic velocity option will usually be acceptable. The standard option uses Equation 87 for all sonic velocity calculations. The high accuracy option uses Equation 84, calculating the
derivative using a numerical difference (also called perturbation derivative) along the isentropes. This is
time consuming, and can cause models to run ten times as long. You should not use this option unless
you have reason to believe Equation 87 has unacceptable accuracy as evidenced from the output values
of sonic velocity.

Specific Heat Ratio
This option is applicable to all of the fluid libraries.
There is a choice of standard or high accuracy for the specific heat ratio. The standard accuracy uses
Equation 80 for gamma (γ). The high accuracy uses Equation 81. The standard accuracy will usually be
suitable, but for completeness you may want to use the high accuracy in your final runs and see if the results change.
The high accuracy option should not have a significant affect on run time (at most 10%). However, it can
result in convergence problems.

Related Topics
Fluid Properties Group
Fluid Panel
Creating Gas Mixtures
Equation of State Models
Enthalpy Models

72
73
77
79
84

Pipes and Junctions Group
The Pipes and Junctions Group in Analysis Setup has one item: the Pipes and Junctions panel. When
the Pipes and Junctions group has a green checkmark next to its name, all pipes and junctions are fully
defined. When a red exclamation point is next to its name, there is at least one pipe or junction that is
undefined. The model cannot run until all pipes and junctions are defined.

Related Topics
Analysis Setup Overview
Modules Group
Fluid Properties Group
Goal Seek and Control Group
Steady Solution Control Group

67
68
72
90
100
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Environmental Properties Group
Cost Settings Group
Automatic Sizing Group
Miscellaneous Group
Pipes and Junctions Panel

136
138
141
142
88

Pipes and Junctions Panel
The Pipes and Junctions panel within Analysis Setup displays the status of pipes and junctions within the
model.

Figure 1: Default state of the Pipes and Junctions panel

This panel is made up of three sections:
l

Undefined Pipes

l

Undefined Junctions

l

Undefined Properties

The Undefined Pipes and Undefined Junctions sections displays the number and name of all pipes and
junctions, respectively, that are not fully defined. If all pipes and junctions in the model are fully defined,
the messages "All Pipes Are Defined" and "All Junctions Are Defined" will be displayed. Clicking on the
undefined pipe or junction will display the undefined properties in the list below, as shown in Figure 2. All
undefined data for all objects can be saved to the file or copied to the clipboard. Any undefined object's
Properties window can be launched by double-clicking the object's name in the list to finish defining the
object.
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Figure 2: Pipes and Junctions panel with one pipe undefined and undefined properties displayed

Transient Control Group
(XTS Module Only) The Transient Control Group in Analysis Setup has one item: the Simulation Duration panel. The Transient Control Group will have a green checkmark next to its name when the XTS
module is disabled (Steady Only mode) or when all required fields in the Simulation Duration panel are
defined. The model cannot run until the Transient Control Group has a green checkmark.

Related Topics
XTS - Extended Time Simulation

637

Related Examples
Air Receiver Tank - XTS

958

Simulation Duration Panel
(XTS Module Only) When the XTS module is activated, the Transient Control Group appears in Analysis
Setup. Whether the XTS module is enabled (Transient mode) or disabled (Steady Only mode), the Simulation Duration panel can be opened and modified.
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Figure 1: Simulation Duration panel fully defined with example values

The transient simulation is controlled by information the user enters in the Simulation Duration panel of
the Transient Control group of the Analysis Setup window. This panel is used to specify the start and stop
time of the transient simulation, the size of the time step, and the frequency of the data saved to the transient output file.

Related Topics
XTS - Extended Time Simulation

637

Related Examples
Air Receiver Tank - XTS

958

Goal Seek and Control Group
(GSC Module Only) The GSC module is controlled through the Goal Seek and Control items in the Analysis Setup window. In these panels, the user specifies all of the system variables, as well as the desired
goals. As the user adds variables and goals to the model, AFT Arrow will display a symbol beside the
pipes and junctions that have variables or goals applied to them. The default is a V for variables, and a G
for goals. The goal symbol is not displayed next to objects that are part of a group goal.
The Goal Seek and Control Group has three panels:
Variables panel - Allows users to define and apply variables to be used for the GSC run.
Goals panel - Allows users to define and apply goals to be used for the GSC run.
Numerical Controls panel - Allows GSC search engine parameters to be adjusted for troubleshooting
purposes.
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Related Topics
Analysis Setup Overview
Modules Group
Fluid Properties Group
Pipes and Junctions Group
Steady Solution Control Group
Environmental Properties Group
Cost Settings Group
Automatic Sizing Group
Miscellaneous Group
GSC - Goal Seek & Control
Variables Panel
Goals Panel
Numerical Controls Panel

67
68
72
87
100
136
138
141
142
541
91
95
100

Related Examples
Beginner: Heat Transfer in a Pipe - GSC
Steam Relief System - GSC
Natural Gas Burner - GSC
Compressed Air System - GSC
Process Steam System - GSC

820
829
833
839
846

Variables Panel
(GSC Module Only) The Variables panel is where variables are defined and applied for use with the
GSC module (Figure 1). Variables are input parameters that the GSC module will change to achieve the
user's desired goals. Generally, there must be one variable applied for each goal that is applied.

Types of Variables
All variables are junction parameters. The variables that are available for each junction type are shown in
Table 1. There are over 30 types of variables.
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Figure 1: GSC Variables are input parameters to be automatically varied

Types of Variables
All variables are junction or pipe parameters. The variables that are available for each object type are
shown in Table 1. There are over 30 types of variables.
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Table 1: List of object types with available variables

Creating and Deleting Variables
To create a variable, click the New Variable button on the Variables panel (Figure 1). This will insert a
new item into the variable list. After the variable has been added, the variable data is defined by entering
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the necessary data in each of the data columns.
Variables may also be added by duplicating an existing variable, then modifying the data for the new variable. To duplicate a variable, select the variable to be duplicated from the variable list, and click the
Duplicate Variable button.
To delete a variable, select the variable by clicking on the appropriate row in the variable list. After selecting the variable to be deleted, click the Delete Variable button. If you want to delete all of the variables in
the list, click the Delete All Variables button.

Defining Variables
For each variable the following settings can be defined:
l

Object type - The Object Type defines whether the variable applies to a pipe or a junction.

l

Junction type - The Junction Type column is used to define the type of junction to which the variable is being applied.

l

Object number and name - The specific junction to vary is selected in the Junction Number and
Name column. The list will only display junctions of the type selected in the Junction Type column.

l

Variable parameter - Each junction type has a specific set of parameters that are available as
variables (Table 1). The list will only display parameters that are available for the junction type
selected in the Junction Type column.

l

Linking variables - The Link To column is used to force a variable on multiple junctions of the
same type to solve to the same value.
An example where this would be desirable would be when using flow setpoint as a variable
for several control valves in parallel. It is often desirable to solve for a condition where the
setpoint is the same for all of the valves. This can be accomplished by using variable linking. A setpoint variable would be defined for each of the control valves. Then, one of the
control valves would be selected as the basis object, which just means no linking is specified for this control valve. The other control valves would be linked to the basis object by
selecting the basis control valve from the list in the Link To column.

l

Variable bounds - During a goal search, the GSC module will modify the values for the defined
variables. Sometimes it is helpful to specify upper and lower bounds for variables to provide
logical extremes during the goal search. Some examples of logical bounds that can be applied
would be lower and upper bounds on valve open percentage of 0% and 100%, respectively.
Note that bounds can have engineering units, but these units are not displayed. It is
assumed the units are the same as the junction input parameter Properties Window.

Organizing Content
The lower left corner of the panel features options for rearranging and selecting variables and goals. All
will select all available variable or goals. None will deselect all variables or goals. Invert will invert which
variables and goals are selected. There are also options to show all variables or goals and to show only
the applied variables or goals. The goals and variables can also be reordered using the turquoise arrows
to change their position.
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The Same As Parent button allows the variables, goals, numerical control, or all of the parameters (in
regards to the Goal Seek and Control Group) of the parent scenario to be copied down to the child scenario.

Reviewing Pipe/Junction Data
Data for the selected objects in the Variables panel can be reviewed and edited without having to close
the Analysis Setup window.
l

Reviewing object input data - If you would like to see the input data for the junction selected as
a variable, press the right mouse button on the far left column in the Variables table. The inspection window will display, showing you the input data.

l

Editing object input data - Similar to the inspection feature just described, you can open the
Pipe or Junction Properties window by double-clicking the far left column in the Variables table.
From there you can change any data desired.

Applying Variables
Once a variable has been created, the user must specify if a variable is to be used when the GSC module is run. To apply a variable, select the checkbox in the Apply column.
Using the Apply feature allows the user to define multiple variables that can be used in alternate cases or
analyses. Any of the variables that are not being used for a particular analysis can remain in the list for
later use. Click the Apply checkbox for the variables that are to be used in the current analysis.

Related Topics
GSC - Goal Seek & Control
Goal Seek and Control Group
Goals Panel
Numerical Controls Panel

541
90
95
100

Related Examples
Beginner: Heat Transfer in a Pipe - GSC
Compressed Air System - GSC
Process Steam System - GSC

820
839
846

Goals Panel
(GSC Module Only) The Goals panel is where goals are defined and applied for use with the GSC module (Figure 1). Goals are output values you would like to achieve. The GSC module adjusts the applied
variables until the applied goals are met. Generally there should be one goal applied for each applied variable.
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Figure 1: GSC Goals are output parameters to be achieved by changing the variables

Types of Goals
The GSC module offers over 150 goals applied to pipes, junctions or groups of pipes and/or junctions.
Table 1 lists all of the types of goals.
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Table 1: List of object types with available goals

Creating and Deleting Goals
To create a goal, click the New Goal button on the Goals tab. This will insert a new item into the goals list.
After the goal has been added, the goal data is defined by entering the necessary data in each of the
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data columns.
Goals may also be added by duplicating an existing goal, then modifying the data for the new goal. To
duplicate a goal, select the goal to be duplicated from the goal list, and click the Duplicate Goal button.
To delete a goal, select the goal by clicking on the appropriate row in the goal list. After selecting the goal
to be deleted, click the Delete Goal button. If you want to delete all of the goals in the list, click the Delete
All Goals button.

Defining Goals
For each goal the following settings can be defined:
l

Goal Type - Select the type of goal to be used from the following:
l

Point Goal - A point goal is specified when the desired goal can be specified at a specific
object location in the model.

l

Differential Goal - A differential goal is used when the goal value is actually determined
by the difference in values between two specific object locations. An example of a differential goal might be the pressure difference between two locations in the model.

l

Group Goal - A Group goal is used when a goal is to be applied to a group of objects at
the same time. In order to use a Group goal, all of the objects must be added to a Group by
using the Groups command on the Edit menu.

l

Object Type - Select the type of object to which the goal is to be applied. See the section below
for further description of the object types.

l

Goal Parameter - Select the type of goal to be applied to the selected object, such as pressure,
flow rate, or temperature.

l

Criteria - Specify the criteria which is to be met for the specified goal parameter, such as equals,
greater than or equal, or less than or equal.

l

Goal Value/Units - Specify the value and units for the goal parameter.

l

Object ID - Specify the pipe, junction, or group name to which the goal applies.

l

Object Location - Specify, as appropriate, whether the goal applies to the inlet or outlet of the
selected object or group.

Organizing Content
The lower left corner of the panel features options for rearranging and selecting variables and goals. All
will select all available variable or goals. None will deselect all variables or goals. Invert will invert which
variables and goals are selected. There are also options to show all variables or goals and to show only
the applied variables or goals. The goals and variables can also be reordered using the turquoise arrows
to change their position.
The Same As Parent button allows the variables, goals, numerical control, or all of the parameters (in
regards to the Goal Seek and Control Group) of the parent scenario to be copied down to the child scenario.
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Object Types
For Point and Differential goal types, the object type indicates whether the goal is to be applied to a
pipe or a junction object. If the goal is to be applied to a junction, the type of junction is selected from the
list.
For the Group goal type, the user must select between a Group Max/Min or a Group Sum object type.
A Group Max/Min goal allows a single goal to be applied to a group of objects. The GSC module
applies a Group Max/Min goal by ensuring the final goal value is either greater than or equal to (a Min
goal) or less then or equal to (a Max goal) the specified value for each object in the group. For example, a
Group Max/Min goal can be applied to ensure a minimum flow rate out of each spray discharge nozzle in
a group of nozzles. Group Max/Min goals only work for groups where all group members are of the same
type (i.e., all pipes or all valve junctions).
A Group Sum goal is used to set the sum of the goal parameter for all the members in a group to a specified value. For example, the Group Sum goal can be applied to set the sum of the volumetric flow rates
through all of the nozzles in a group of spray discharge nozzles to a particular value. Groups used in
Group Sum goals can consist of pipes and/or junctions, with junctions of different type.

Applying Goals
Once a goal has been created, the user must specify if a goal is to be used when GSC is run. To apply a
goal, select the checkbox in the Apply column.
Using the Apply feature allows the user to define multiple goals that can be used in alternate cases or
analyses. Any of the goals that are not being used for a particular analysis can remain in the list for later
use. Click the Apply checkbox for the goals that are to be used in the current analysis.

Reviewing Pipe/Junction Data
Data for the selected objects in the Goals panel can be reviewed and edited without having to close the
Analysis Setup window.
l

Reviewing object input data - If you would like to see the input data for the junction selected as
a goal, press the right mouse button on the far left column in the Goals table. The inspection window will display, showing you the input data. This feature does not work for group goals.

l

Editing object input data - Similar to the inspection feature just described, you can open the
Pipe or Junction Properties Window by double-clicking the far left column in the Goals table. From
there you can change any data desired. This feature does not work for group goals.

Related Topics
GSC - Goal Seek & Control
Goal Seek and Control Group

541
90
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Variables Panel
Numerical Controls Panel
GSC Goal may not be valid
When Goals Cannot Be Achieved

91
100
670
547

Related Examples
Beginner: Heat Transfer in a Pipe - GSC
Compressed Air System - GSC
Process Steam System - GSC

820
839
846

Numerical Controls Panel
(GSC Module Only)
Numerical control of the GSC search engine parameters can be adjusted on the Numerical Control tab.
It is recommended the user avoid changing these parameters unless the user understands their purpose
or it has been recommended by AFT technical support.

Related Topics
GSC - Goal Seek & Control
Goal Seek and Control Group
Variables Panel
Goals Panel

541
90
91
95

Steady Solution Control Group
The user has control over a number of parameters that influence numerical convergence.
Note: These values should only be changed by experienced users or under advisement by AFT Support. Poorly defined Solution Control settings can cause the model to converge on an
incorrect solution without warning messages.
l

Solution Method panel - The calculation method can be defined on this panel.

l

Tolerance panel - The iterative tolerances that define convergence can be defined on this panel.

l

Iterations panel - Additional iteration controls that can affect whether or not a model converges, or
how quickly it will converge, can be defined here. Most settings on this panel will not affect the final
result.

l

Pressure and Temperature Limits panel - Options to limit the pressure and/or temperature results
in the solver.

Related Topics
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Analysis Setup Overview
Modules Group
Fluid Properties Group
Pipes and Junctions Group
Goal Seek and Control Group
Environmental Properties Group
Cost Settings Group
Automatic Sizing Group
Miscellaneous Group
Tolerance Panel
Iterations Panel
Pressure and Temperature Limits Panel
Solution Method Panel

67
68
72
87
90
136
138
141
142
130
133
135
101

Related Examples
Process Steam System

761

Related Blogs
Having model convergence problems? Start here!

Solution Method Panel
The Solution Method panel defines the calculation method and relevant parameters for the calculation
(Figure 1). This panel is defined by default and typically should not be changed unless problems are
encountered when running the model.
The Method Type can be set as Recommended or User Specified. The Recommended option (Length
March With March Number Limits) is sufficient for most models. If desired the User Specified option can
be selected to choose a different Method Type as are described below in the Solution Method Overview
section below. Choosing User Specified also allows the march method increments to be changed.
A few other settings are defined by default for the user including the Length March Increment and
Mach Number Increment settings. See the Marching Methods discussion below for more information
on these parameters.
Lastly the "First Use Lumped Adiabatic..." option is available for all method types except the Lumped
methods. This option solves the entire system with the Lumped Adiabatic method, and applies the results
of that solution as a starting point to the marching method selected. This can help with convergence for
some models. The results will be the same as using only the marching method. See the Lumped Methods section below for more information on Lumped Adiabatic.
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Figure 1: Default settings on the Solution Method panel

Solution Method Overview
AFT Arrow provides several solution methods for compressible pipe flow. Each method has certain
advantages, and applicability to certain types of systems. While each option should theoretically come to
a similar solution, there will be differences in the results between the methods. The magnitude of this difference depends heavily on the particular system being analyzed. All of the methods apply the same fundamental equations in differing ways.
l

Length March - All of the fundamental equations are applied at fixed length increments - axial
points - down a pipe. This method provides good accuracy if changes in Mach Number are small.
It is the least sensitive to initial conditions.

l

Length March With Mach Number Limits - This hybrid method starts with the Length March
method, and dynamically switches to the Mach Number March method if the change in Mach Number between steps is large. This ensures excessive changes in Mach Number across computing
sections are avoided.

l

Mach Number March - The fundamental equations are still applied at axial points down the pipe,
but in this case the distance between the points is fixed by a Mach Number increment. This
method is more accurate when there are large changes in Mach Number, often occurring when
the Mach Number is high and when the flow is sonically choked.

l

Mach Number March With Length Limits - This hybrid method begins with the Mach Number
March method, switching to Length March if the distance between axial points is too large. This
helps ensure accuracy when the changes in Mach Number are small.

l

Lumped Adiabatic - This method ignores all heat transfer and elevation changes. For some
applications these effects are minimal, and simplifying the calculations this way greatly reduces
the required solution time and likelihood of convergence.

l

Lumped Isothermal - This method further simplifies the fundamental equations by assuming
pipes are a fixed temperature throughout and again ignoring elevation.
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Marching Methods
The marching methods provide the most accurate solutions. AFT Arrow "marches" down a pipe in the
model, solving the fundamental equations along the way.
Dividing the pipe into smaller segments is important for compressible flow because the fluid properties
change throughout the pipe. Each segment considers the flow properties constant and applies the fundamental equations. This represents a discretization of the continuously changing flow parameters necessary for an iterative Solver such as AFT Arrow. This discretization introduces a certain amount of
error into the solution, which is closely related to how many segments are present, as well as how much
the flow properties change over a single segment.
When dividing the pipes into segments, axial points are created along the pipe, at the ends of every segment. The results at each axial point can be viewed in the output.
l

Length March - This method divides pipes into segments based on length. The segment length
can be defined in two ways - either by dividing every pipe into a certain number of segments (Initial Number of Segments per Pipe setting), or dividing all pipes into equal-length segments
(Segment Length setting). This method has the advantages that it is conceptually easier to understand and ensures some minimum number of segments in every pipe. Axial points are also often
located at convenient locations. However, at high Mach Numbers, the large change in flow properties over a segment makes this method less accurate. For a detailed mathematical description
of this method see Length March Method - Detailed Discussion.

l

Mach Number March - Unlike the Length March, Mach Number March determines the locations
of the axial points dynamically based on the flow solution. There is no easy way to tell where the
axial points will be without completing the solution. This method is superior when analyzing high
Mach Number flows, as the flow properties tend to change dramatically over short distances.
Effectively, this method adds axial points as necessary where the flow properties are changing
rapidly. The disadvantage of this method is that the minimum number of sections cannot be
enforced - if the Mach Number in a single pipe changes less than the increment specified, the
entire pipe will be represented with a single segment. This is not necessarily inaccurate, but it is
generally preferable to have more than one segment per pipe. For a detailed mathematical
description of this method see Mach Number March Method - Detailed Discussion.

Hybrid Marching Methods
AFT Arrow offers hybrid marching methods to get the best of both marching methods in one solution.
These methods dynamically switch from Length to Mach Number March or vice-versa during the solution.
This dynamic switch allows the user to ensure that a certain minimum number of segments is present in
each pipe, and that the flow properties do not change significantly over the segment.
l

Length March With Mach Number Limits (AFT Arrow default) - The default solution method
begins the march down the pipe with equal length segments. If the Mach Number over any certain
segment is detected to increase more than the specified limit, the march continues over the rest of
the pipe at equal Mach Number increments. It is often the case that flow velocity in a pipe is
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relatively low and constant in the first few segments of the pipe, but increases dramatically
towards the exit. This method captures this behavior.
l

Mach Number March With Length Limits - Very similar to the default method, this hybrid
method begins with a Mach Number march, but if it is detected that the length to the next axial
point is too far due to relatively constant velocity, additional axial points are forced into the pipe via
the length limit. This helps ensure all pipes have some minimum number of sections.

The figure below shows an example of a pipe solved with Length March With Mach Number Limits. During the solution, the solver determined that taking an additional 10 foot step from point 6 (60 feet) to point
7 (70 feet) would violate the Mach Number limit of 0.01. Therefore, the march was adjusted (starting at
point 6) to increment in Mach Number steps of 0.01.

Figure 1: Length March dynamically switching to Mach Number March

Lumped Methods
For faster - but less accurate - computation, AFT Arrow offers two of the traditional lumped methods.
These methods divide all pipes into 10 segments, but the method solves the entire pipe in a single computation. Certain assumptions simplify the fundamental equations allowing a much faster solution at the
cost of accuracy.
l

Lumped Adiabatic - This method treats every pipe as adiabatic, disallowing heat transfer into or
out of the pipe. If heat transfer is defined in the model, the definition is retained for convenience
but is not applied during the solution. In addition, this model cannot accurately model body forces
so therefore does not account for elevation changes or rotating systems. In many gas systems
these assumptions are reasonable and the results from Lumped Adiabatic acceptable. For a
detailed mathematical description of this method see Lumped Adiabatic Method - Detailed Discussion.

l

Lumped Isothermal - Similarly, this method treats all pipes as a constant temperature. Again,
elevations are ignored. Note that heat transfer is applied to pipes (heat in or out) to meet the isothermal conditions. For a detailed mathematical description of this method see Lumped Isothermal Method - Detailed Discussion.
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l

Use Pipe Isothermal Temperatures When Available Instead of This Value - If Isothermal models have been defined for individual pipes, that temperature will be applied to
that pipe instead of the global temperature defined in the Solution Method panel.

Comparing Marching Methods to Traditional Methods
There exist in industry practice a number of traditional methods and equations for calculating compressible flow in pipes.
A common equation is the Crane isothermal equation (see Crane, 1988, pp. 1-8). AFT Arrow and equations such as the Crane isothermal equation differ in several respects. First is that the Crane equation
assumes isothermal flow, while AFT Arrow can model isothermal flow or other, more general, boundary
conditions. Second is that the Crane equation solves the entire pipe as one segment. This can be called
a lumped method. It is thus roughly analogous to using AFT Arrow with a single computing section per
pipe. Third, the Crane equation assumes a constant diameter run, whereas AFT Arrow allows you to
change diameters. Fourth, it is not apparent how to apply the Crane equation to multi-pipe systems,
including pipe networks.
The Crane equation solves the governing mass and momentum equations by making some assumptions. AFT Arrow is solving the same equations, but is not making any assumptions. It marches down
each pipe, taking into account physical property changes and non-linear acceleration effects as it progresses. Thus, AFT Arrow is in general much broader and more accurate than the Crane equation. When
the pipe flow conditions are within the assumptions of the Crane equation, then the Crane equation and
AFT Arrow should agree closely.
Other equations on page 1-8 of Crane, 1988, compare similarly to AFT Arrow. They are all lumped methods with certain assumptions about thermal conditions in the pipe and properties of the gas.
These traditional equations can be used successfully in many engineering applications. They all represent a subset of AFT Arrow’s marching methods, which solve the fundamental equations without limiting assumptions.

Related Topics
Steady Solution Control Group
Tolerance Panel
Iterations Panel
Pressure and Temperature Limits Panel

100
130
133
135

Related Examples
Process Steam System

761

Related Blogs
Having model convergence problems? Start here!
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Length March Method - Detailed Discussion
The Length March Solution Method is described in detail below.
The stagnation pressure is given by the following:

(22)

By differentiating Equation 22 the following is obtained:

(23)

Now take Equation 23 and use it to replace the pressure term in Equation 10 to obtain:

(24)

The first two terms on the right hand side of Equation 24 relate to the stagnation temperature (Equation
15) as follows:

Making this substitution, and also using Equation 14
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(25)

Integrating Equation 25 yields:

(26)

And with algebra the Length March equation (Equation 27) is obtained:

(27)

Example
Some examples are given here to clarify how the Mach Number March and Length March methods solve
the governing equations.

Figure 1: Marching equations are applied at successive computing sections along the pipe. Conditions at location 1 are known, and at location 2 are being solved using one of the marching equations.

Both of these methods are referred to as marching methods. What does this mean? Figure 1 shows a
representation of a computing section in a pipe. In this example, all parameters at Location 1 are known,
and it is desired to calculate conditions at location 2 which is always downstream of location 1.
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Whether we are applying the Length March or the Mach Number March (Equation 21, 37 or 41), at location 1 we know these primary parameters:

Because we know the parameters above, we also know:

Let's consider the Length March method first because it is easier to grasp. Using the Length March equation, we know three things about location 2. First, we know the length step, as this is specified by the
user. We also know that the mass flow rate is constant. Lastly, we know the heat transfer relationship specified by the user and can use this to determine a thermodynamic parameter.
For instance, if the pipe is modeled as adiabatic (q = 0), we can determine the stagnation enthalpy at location 2 using the following assumptions.
If there is no elevation change, then:

and according to the Energy equation:

Even if there is elevation change, we know what it is and can just add that into the energy equation and
calculate ho,2 explicitly.
If the pipe is isothermal, then:

If there is convective heat transfer or known heat flux, we can solve Equation 36 or 40 for To,2 which
allows us to calculate ho,2 and we are at the same point as with adiabatic.
Thus, if any boundary condition other than isothermal is specified, the following is known at location 2:

or, if isothermal, the following is known at location 2:
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With one thermodynamic parameter known at location 2, we guess at the stagnation pressure solution to
the Length March equation. This in effect gives us two known thermodynamic parameters, from which all
the other parameters can be determined through state relationships. This requires significant iteration for
each computing step.
For each pipe in the system, the marching is initiated at the pipe inlet where conditions are known. The
known inlet conditions reflect the current solution state at the junction upstream of the pipe. This is location 1. Based on the user specified length step, the distance to location 2 is specified. The method just
described is used to converge on the conditions at location 2. Once this convergence occurs, the previous location 2 becomes location 1 and a new location 2 is determined based on the step size. The
marching continues to the end of the pipe.
If the user specifies an absolute length size (say 10 foot sections), a step may go past the end of the pipe.
This will occur for any pipe that is shorter than 10 feet. For a longer pipe of say 12 feet, the first computing
length will be 10 feet, while the second will be 2 feet.
It should be understood that in the Length March method, computing sections are equidistant along a
pipe, aside from possible roundoff at the end.
Note: The process of converging on location 2 while marching down a pipe is referred to as a local iteration. It is local in that it does relate to what is happening in any other part of the model. AFT
Arrow also has global iterations, which relates to iterations made on the entire system in trying
to obtain complete system convergence. You can specify iteration limits for each type of convergence in the Iterations panel.

Example Application
Consider the model in Figure 2. This model is of an air system modeled as a real gas using RedlichKwong and Generalized enthalpy. The Solution Method panel specifies Length March method with 10
segments per pipe. Results using the Length March method are shown in Figure 3.
There are several items worth noting in Figure 3.
1.

Note that the second column shows the x location for each computation step. Point 1 will be
identical to the pipe's inlet values. For this model, there were 10 steps along a 100 foot pipe, thus
each step is equally 10 feet long.

2.

Notice how the velocity and Mach number increase along the pipe length.

3.

Notice how the static temperature drops. This is due to cooling of the gas as it expands with pressure drop.

4.

Notice that the stagnation enthalpy is constant in accordance with adiabatic flow.

5.

Notice how the static enthalpy drops along the pipe length. This shows that the flow is not
isenthalpic.

6.

Notice how the stagnation temperature drops slightly. This is a result of real gas effects. A perfect
gas will have constant stagnation temperature and enthalpy in adiabatic flow with constant elevation.

These results can be viewed graphically by changing to the Graph Results window and selecting to
graph a profile along a flow path.
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Figure 2: Model of an air system dropping from 40 to 30 psia

Figure 3: Axial Points (available in the Output window) for model in Figure 2 using Length March method

Length March Method Verification
The axial points shown Figure 3 can be used to verify that the fundamental equations are being solved
accurately. Figure 4 shows the relevant verification parameters for a pipe carrying air from a tank at 40
psia and 100 deg. F to another tank at 30 psia. The pipe is vertical, 100 feet long, and 4 inches in diameter with a roughness of 0.001 inches, and is adiabatic. The high pressure tank is the top tank.
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Figure 4: Axial Points for AFT Arrow model Verify_Governing_Equations.aro using the Length March method

The model, Verify_Governing_Equations.aro, is shown in Figure 5 can be obtained from AFT upon
request (support@aft.com). Also included is an Output Control data configuration file called Verify_
Governing_Equations_1.dat that can be used to configure any model to that shown in Figure 1.
The Figure 4 results were obtained using the Length March method with 10 pipe segments. The results
can be copied to the clipboard and pasted into a spreadsheet as shown in Table 1. Once in the spreadsheet, additional calculations can be performed. Table 1 shows these calculations and a balance verification using all terms in the momentum equation (Equation 2), continuity equation (Equation 1), and
energy equation (Equation 30). Along with the previous files, this spreadsheet is included upon request
and is named Verify_Governing_Equations_Length.xls.
There are several terms in Table 1 that require clarification. Using coordinates as shown previously in Figures 1 of Fundamental Equations and Figure 1, density and velocity can be represented as follows:
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Figure 5: AFT Arrow model solved in Figure 1 and verified in Table 1. Fluid is air. File is Verify_Governing_
Equations.aro.

And using these terms, the four momentum equation terms from Table 1 are defined as:

dP Total:

dP Fric. (Friction):
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dP Accel (Acceleration):

dP Grav. (Gravity):

(53)

Table 1: Verification showing how AFT Arrow Length March method predictions satisfy momentum, mass
and energy balance equations. Taken from spreadsheet Verify_Governing_Equations_Length.xls.

There is another term that is not relevant in this model and is thus not shown in Table 1. This term
accounts for additional minor losses in the form of K factors, and is a modified form of the dP Acceleration
term:

dP Component:

The four terms in Equations 53 in Table 1 are added together for each computing section. If the
momentum equation is being satisfied, the four terms should sum to zero (or a very small number). They
do, as shown in Table 1 in the column titled Balance (psi).
Note that AFT Arrow does not solve Equation 49. Rather, when using the Length March method, AFT
Arrow solves Equation 27, which contains (more accurate) logarithmic terms. Equation 27 is a more complex form of the momentum equation. The arithmetically averaged terms in Equations 49 and Table 1 are
approximations which show that the momentum equation is being satisfied.
Table 1 has another column titled Balance (lbm/sec) which shows that the continuity equation (Equation
1) is also satisfied. This is calculated in Table 1 as follows:
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While not shown here, it was shown earlier in Figure 3 how AFT Arrow maintains constant stagnation
enthalpy for adiabatic flow with zero elevation change. According to the energy equation (Equation 30),
when the elevation changes, the stagnation enthalpy is not constant in adiabatic flow. The energy balance is calculated as follows:

In the Energy Balance column, Table 1 shows how this equation is satisfied. If heat transfer is applied, it
is a simple matter to extend the spreadsheet behind Table 1 to verify that energy is balanced.
The individual terms in Equations 49 are also available for output in AFT Arrow. The contributions to pressure drop can be reviewed individually, and can also be used for further verification. Figure 6 shows the
axial points again for Verify_Governing_Equations.aro, but now these pressure drop contributions are
shown. The Output Control data configuration file used to obtain the Figure 6 format is Verify_Governing_Equations_2.dat.

Figure 6: Axial Points for Verify_Governing_Equations.aro showing the individual pressure drop contributions

The Pipe Results table shows the total pressure drop contributions for each pipe when appropriate parameters are selected for display. See Figure 7.
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Figure 7: Pipe Results table shows total pressure drop contributions as defined in Equation 49

Related Topics
Solution Method Panel
Nomenclature

101
474

Mach Number March Method - Detailed Discussion
The Mach Number March Solution Method is described in detail below.
Modify Equation 2 by substituting Equations 3 and 5 and eliminating density,

(6)

By definition of Mach number for a real gas

(7)

and from basic calculus the following relationship holds:

(8)

Differentiating Equation 7 (and using Equation 8) results in,
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(9)

Now, substitute Equation 7 and 9 into Equation 6 and eliminate the velocity

(10)

Differentiating the equation of state, Equation 5 yields

(11)

Replace velocity by Mach number by substituting Equation 9 into Equation 11 to obtain

(12)

Eliminate pressure from Equation 10 using Equation 12 to obtain:

(13)

From the definition of stagnation temperature

(14)

Differentiating the preceding yields
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(15)

Replace static temperature in Equation 13 with stagnation by using Equation 14 and Equation 15 to
obtain:

Collecting terms and simplifying yields:

(16)

Rearrange Equation 16 to obtain
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(17)

Four useful parameters that simplify notation are:

(18)

Using the four new parameters in Equation 18 simplifies to

- 118 -

Fundamental Modeling Concepts

(19)

Integrating Equation 19 yields

(20)

Equation 20 can be solved for x2:

(21)

where the bars over certain parameters indicate that the average value over the computing section is
used.
Equation 21 is the Mach Number March equation. The Mach Number March is a variable step size
method. As shown in Equation 21, the distance is the parameter being calculated.

Modifications for Heat Transfer
In order to model heat transfer effects it is convenient in some cases to modify the previous equations.
The energy equation has the form:

(28)

The definition of stagnation enthalpy is

(29)
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which, when substituted into Equation 28, yields:

(30)

In most applications, the elevation term, gz, is very small and is neglected. This term will only become significant over pipes that have large elevation changes such as pipelines that go over mountains or down
mineshafts, or in rapidly rotating systems.
With elevation neglected, it is not uncommon for engineers to conclude that adiabatic flow is isenthalpic
(constant static enthalpy). It’s not. Rather, the stagnation enthalpy is constant in adiabatic flow.

Convective Heat Transfer
In pipe convective heat transfer, it is convenient to use the change in stagnation temperature rather than
stagnation enthalpy by introducing the following approximation

(31)

When heat transfer occurs, the effect of elevation change on the energy balance is small and is neglected. Substituting Equation 31 into Equation 30 yields

(32)

The heat transfer due to convection is given by the following:

(33)

where:
U = Overall heat transfer coefficient
Ph = Heated perimeter
The heated perimeter will frequently equal the wetted perimeter, which is the internal pipe circumference.
It can change if part of the pipe is insulated (it will be less than the wetted perimeter) or there are fins on
the pipe (it will be greater than the wetted perimeter).
Equating Equation 32 and 33 yields

(34)

- 120 -

Fundamental Modeling Concepts

Rearranging Equation 34 yields:

(35)

Integrating Equation 35 yields

(36)

This relationship for stagnation temperature can be substituted into Equation 20 to obtain:

(37)

In convective applications which use the Mach Number March method, the advantage of Equation 37
over Equation 21 is that the stagnation temperature change is proportional to the distance step dx (as
shown in Equation 35), for which we are solving. Equation 37 couples the effects of friction and heat
transfer, and provides more reliable convergence, especially in convection heating.

Constant Heat Flux
The constant heat flux boundary condition on a pipe results in a modified form of Equation 32

(38)

The stagnation temperature change is thus:

(39)
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Integrating Equation 39 yields:

(40)

Substituting this into Equation 20 yields:

(41)

Example
Some examples are given here to clarify how the Mach Number March and Length March methods solve
the governing equations.

Figure 1: Marching equations are applied at successive computing sections along the pipe. Conditions at location 1 are known, and at location 2 are being solved using one of the marching equations.

Both of these methods are referred to as marching methods. What does this mean? Figure 1 shows a representation of a computing section in a pipe. In this example, all parameters at Location 1 are known, and
it is desired to calculate conditions at location 2 which is always downstream of location 1.
Whether we are applying the Length March or the Mach Number March (Equation 21, 37 or 41), at location 1 we know these primary parameters:

Because we know the parameters above, we also know:
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Let’s turn our attention to the Mach Number March method. Depending on the heat transfer model, AFT
Arrow will solve either Equation 21, 37 or 41. The most general of these is Equation 21, so in the following discussion it will be referred to as the Mach Number March equation, with the understanding that
Equation 21 encompasses Equations 37 and 41.
Similar to the Length March method, it is desired to solve for conditions at location 2 based on known conditions at location 1 (see Figure 2). However, here the length step itself is not known. In fact, as shown in
Equation 21 it is the computing length (i.e., Δx) for which we are solving. What is the reason for trying to
solve for Dx rather than just specifying it? This question will be answered shortly. Before that, let’s understand better what is happening when Equation 21 is applied.
The knowns at location 1 are the same as before, namely:

with the other derived knowns easily obtainable:

In the Mach Number March method, our step size is dictated by increments of Mach number. We thus
take the Mach number at location 1 (M1) and add to it an increment. Since the maximum Mach number in
the pipe systems modeled in AFT Arrow is 1, the step size should be far smaller. The default step size is
0.01. Using the default, we know the Mach number at location 2:

where ΔM is the Mach number increment. As before, we know the mass flow rate at location 2 (it's the
same the same as location 1), and we also have similar heat transfer relationships as discussed in the
Length March method example previously.
Specifically, if the pipe is adiabatic, we know the following at location 2:

or, if isothermal, the following is known at location 2:
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and if the pipe has a convective or heat flux boundary condition,

However, in the convective and heat flux cases, we cannot definitely say what ho,2, is because the
amount of stagnation enthalpy change depends on the length step, for which we are solving. This
requires additional iteration.
Similar to the Length March method, the Mach Number March method requires significant iteration for
each computing step. Again, known inlet conditions become the first location 1, and once location 2 is
solved, it becomes location 1 and the marching continues to the end of the pipe.
Since we are solving for Δx, it is entirely possible that the distance step will extend beyond the pipe
length. This will occur for any pipe that has an end-to-end Mach number change of less than ΔM. It will
always occur for the final computing section of each pipe that does not reach choking. In such a case, the
method reverts to the Length March method to compute conditions at the pipe exit.
It should be clearly understood that in the Mach Number March method, computing sections are not
equidistant along a pipe. In fact, as the gas accelerates along the pipe, the Mach number increases more
and more rapidly. This results in shorter and shorter computing section lengths as shown in the following
application.

Example Application
Consider once again the model in Figure 2. All conditions are the same as in the previous Length March
method application, except for the solution method. If we solve this model using the Mach Number March
method, with a Mach number increment of 0.01, the results in Figure 3 are obtained.
There are several items to note about Figure 3. First, note how the Mach number increases down the
length of the pipe. At the inlet, the Mach number is 0.2604 (this is not specified, but determined as part of
the solution for flow rate). Each computing point increases the Mach number by DM , which is 0.01. This
is what the Mach Number March method is, a method which marches in Mach number increments. With
the step size dependent on the Mach number change, the number of calculation points in a pipe cannot
be controlled. The 10 points shown in Figure 3 were chosen by AFT Arrow, not the user.
Second, note the x locations of computing points. These numbers are not whole numbers, and as the
end of the pipe is approached the distance between each computing section and the previous one
becomes smaller and smaller. This is a result of the gas acceleration. At higher Mach numbers this
becomes even more pronounced.
Figure 4 shows how the Mach number increases along the pipe length. The curve's upward curvature
shows the acceleration effect. Figure 5 shows the relative computing section distances.
Third, notice this adiabatic flow case has constant stagnation enthalpy, but not constant static enthalpy.
This is similar to the Length March method.
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Last, notice how the mass flow rate is (in this case) the same as the Length March method results shown
in Figure 3 of Length March Method Example (4.884 lbm/sec). Since both methods solve the same governing equations, one would expect the results to be comparable. However, the two methods will not
always agree. Each method has strengths and weaknesses, and results can differ somewhat when the
flow conditions favor one of the methods.
Is there any way to check that the results offer valid solutions of mass balance (Equation 1), momentum
balance (Equation 2) and energy balance (Equation 30)? There is. An example is given in the Mach Number March Verification section below.

Figure 2: Model of an air system dropping from 40 to 30 psia

Figure 3: Axial Points (available in the Output window) for model in Figure 2 using Mach Number March
method
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Figure 4: The Mach number increases with length in this plot of the Figure 3 results

Figure 5: Relative pipe section locations for Figure 3 results. Notice how computing sections get closer as a
result of gas acceleration as the end of the pipe is approached.

Mach Number March Method Verification
By changing the solution method for Verify_Governing_Equations.aro in Figure 5 of the Length March
Verification to the Mach Number March method, the verification process described in the previous section for the Length March method can be repeated. This is shown in Figure 6 and Table 1.
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Figure 6: Axial Points for AFT Arrow model Verify_Governing_Equations.aro using the Mach Number March
method

Table 1: Verification showing how AFT Arrow Mach Number March method predictions satisfy momentum,
mass and energy balance equations. Taken from spreadsheet Verify_Governing_Equations_Mach.xls.

Related Topics
Solution Method Panel
Nomenclature

101
474

Lumped Adiabatic Method - Detailed Discussion
When this Solution Method is used, all heat transfer data entered for individual pipes is neglected. The
other pipe data is left as entered by the user in case the user switches back to one of the marching
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methods.
Elevation data is also ignored by the Solver. The output will still show the elevation as entered by the
user. Since elevation effects are usually not very important in gas systems, neglecting elevation changes
is frequently an acceptable approximation. One application where this is definitely not the case is in Rotating Systems.
An analytical solution to Equations 1, 2 and 5 for adiabatic flow neglecting elevation changes is given by
the following (e.g., see Saad, 1993, page 209):

(42)

This equation is valid for real gases as long as the following approximation is accepted:

using a suitably averaged value of cp. Integrating from 0 to L obtains:

(43)

Equation 43 is then solved for each pipe, using an average value of friction factor and g for each pipe.
The solution of Equation 43 typically is iterative where the unknown is M2.

Related Topics
Solution Method Panel
Nomenclature

101
474

Related Examples
Process Steam System

761

Lumped Isothermal Method - Detailed Discussion
When this Solution Method is used, all heat transfer data entered for individual pipes is neglected unless
the user has specified in the Solution Method panel that individual pipe temperatures should be used.
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The other pipe data is left as entered by the user in case the user switches back to one of the marching
methods.
Elevation data is also ignored by the Solver. The output will still show the elevation as entered by the
user. Since elevation effects are usually not very important in gas systems, neglecting elevation changes
is frequently an acceptable approximation. One application where this is definitely not the case is in Rotating Systems.
Another special case of flow in pipes is that of isothermal flow. In isothermal flow, the gas static temperature remains constant. The tendency is for gas to cool as it flows along a pipe. For the temperature to
remain constant, an inflow of heat is required.
When the temperature remains constant, it removes one of the unknowns from Equations 1, 2 and 5.
From Equation 5, the density becomes directly proportional to pressure, and an analytical solution can be
obtained if elevation changes are neglected (e.g., see Saad, 1993, pp. 264-269):

(44)

where the T subscript on L emphasizes isothermal. Integrating from point 0 to L,

(45)

Isothermal flow behavior results in a different relationship for sonic choking as compared to adiabatic
flow. In fact, to truly maintain isothermal flow up to the sonic point requires an infinite amount of heat
transfer. This results in the strange but mathematically correct conclusion that sonic choking occurs at a
Mach number less than 1 for isothermal flow. Sonic choking will occur at 1/sqrt(gamma) for isothermal
flow, where gamma is the isentropic expansion coefficient (Saad, 1993, pp. 267). Practically speaking,
isothermal flow will not remain isothermal at high velocities.
Similar to the Lumped Adiabatic method, Equation 45 is solved for each pipe, using an average value of
friction factor and g for each pipe. The solution of Equation 45 typically is iterative where the unknown is
M2.
When the user chooses the Lumped Isothermal method, an isothermal temperature is required in the
Solution Method panel. This temperature is used for all pipes unless directed otherwise by the user.

Related Topics
Solution Method Panel
Nomenclature

101
474

- 129 -

Fundamental Modeling Concepts

Tolerance Panel
The iterative tolerances that define convergence are defined on the Tolerance panel in Analysis Setup,
shown in Figure 1. These values can be modified for Pressure Tolerance, Flow Rate Tolerance, Temperature Tolerance, and Concentration Tolerance (if dynamic mixing occurs).

Figure 1: Tolerance panel in Analysis Setup

An iterative approach is used to obtain pipe flow solutions. When approaching any analysis iteratively, a
stopping point must be defined. The simplest approach is to stop after a certain number of iterations.
However, this either results in uncertain results because the result is still changing, or wasted processing
time because there are too many iterations.
A solution is to use iterative tolerance. This tolerance is related to the change between iterations. When
this change is smaller than the iterative tolerance, the solution is said to be converged.

Tolerance and Solution Accuracy
Iterative tolerance does not have any relationship to an engineering tolerance.
An engineering tolerance is a familiar term to most engineers - it is a permissible limit in variation of a
parameter. A simple example is the length of a steel bar - an engineer might specify that this length must
be 3 ± 0.01 meters. A steel bar manufactured by this specification is known to be within the engineering
tolerance of the "true" or desired length. In other words, engineering tolerance describes an accuracy.
Iterative tolerances do not directly describe an accuracy. Convergence only means that the change
between iterations was within the specified limit.
With sound iterative methods, and an appropriately specified iterative tolerance, the iterative solution will
be close to the "true" solution. However, even with good settings, the iterative tolerance does not define
how close the results are to the "true" solution.
If there is concern that the results may not be close enough to the "true" answer, the tolerances could be
lowered and the results compared. If the results do not change appreciably, an appropriate tolerance
was likely selected.
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Avoiding False Convergence
It is important to keep the tolerance at least one order of magnitude smaller (two orders or more is recommended) than the relaxation. A false convergence can occur when the change from the old value to the
new value is small enough to be within the tolerance because it is restricted by the relaxation.

Absolute Tolerance
Absolute tolerance looks at the absolute change in quantity of a given parameter. If the change is smaller
than the directly specified value, the parameter is considered converged.
This approach works equally well for both small and very large values, making iterative solvers more
likely to find convergence. However, specifying an appropriate absolute tolerance requires some knowledge of the true solution. The tolerance should be set 3 or 4 orders of magnitude below the solution, if
there are near zero flows in the system this will require a very low tolerance.

Relative Tolerance
Relative tolerance checks the relative change of a given parameter. Each change is divided by the number itself, giving a change proportional to the magnitude.
This approach does not require any knowledge about the true solution, and for that reason is the default
method.
Table 1 shows the difference between relative and absolute change while iterating. Notice that the absolute change has units, while relative change does not.
Convergence criteria can also be based on either (or both) absolute or relative change. Table 1 shows
how this is applied.
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Table 1: Example of four tolerance methods for a mass flow rate example. Absolute tolerance = 0.0005 lbm/s,
Relative tolerance = 0.0001

Iteration
#

Mass
Flow
Rate
(lbm/sec)

Relative
Change

Absolute
Change
(lbm/sec)

1

20.0000

-

-

-

-

-

-

2

12.0000

0.666667

8.000000

NO

NO

NO

NO

3

14.0000

0.142857

2.000000

NO

NO

NO

NO

4

13.5000

0.037037

0.500000

NO

NO

NO

NO

5

13.6000

0.007353

0.100000

NO

NO

NO

NO

6

13.5900

0.000736

0.010000

NO

NO

NO

NO

7

13.5913

0.000096

0.000130

NO

YES

YES

NO

8

13.5907

0.000044

0.000600

NO

YES

YES

NO

9

13.5909

0.000015

0.000200

YES

YES

YES

YES

Meets Abs. Meets Rel.
Tolerance? Tolerance?

Meets Abs. Meets Abs.
OR Rel.
AND Rel.
Tolerance? Tolerance?

Exhaustive Tolerance
AFT Arrow finds a solution for all junction pressures when Exhaustive Tolerance is enabled.
Disabling this option will only check junction pressures that are in the solution matrix. Only junctions that
contain a split in flow are included in the matrix. Both options should come to a reasonably similar converged result, but the more rigorous approach of checking all junctions is selected by default.

Related Topics
Steady Solution Control Group
Iterations Panel
Pressure and Temperature Limits Panel
Solution Method Panel
Try Absolute Tolerance
Energy at Junction X may not be balanced
Flow at Junction X may not be balanced
Related Blogs
Having model convergence problems? Start here!
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Iterations Panel
Relaxation, iteration limits, and matrix method settings are defined on the Iterations panel in Analysis
Setup. Most settings on this panel will not affect the final result. The default state of the Iterations panel is
shown in Figure 1.

Figure 1: Iterations panel in Analysis Setup

Relaxation
Relaxation slows iterative progress toward a solution reducing the destabilizing effect of non-linear systems.
l

Automatic - Implements an adaptive relaxation scheme that reduces the relaxation dynamically
in response to highly non-linear features of the problem.

l

Fixed - Allows for user specified Flow Rate and Pressure Relaxation

When applied to the flow solution, relaxation r is used as follows:

A relaxation of 1 is the same as no relaxation. Each iteration's prediction is used directly in the next iteration.
A relaxation of 0 is not allowed, as this would prevent the parameter from changing.
l

Flow Rate Relaxation - For highly non-linear systems, a flow rate relaxation of 0.1 is advised.
Experience shows that using flow rate relaxation factors between 0.5 and 1 has limited usefulness. If a flow rate relaxation of 1 does not work, you should generally try flow rate relaxation
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parameters between 0.1 and 0.5. In more extreme cases, a flow rate relaxation factor smaller than
0.1 may be required.
l

Pressure Relaxation - Because of the nature of the matrix solver, experience indicates that if
pressure relaxation is used, it should always be set to 0.5 or 1 to maintain stability.

l

Resistance Relaxation - Typically should be left at 1. In some cases with very long pipelines,
reducing the value as low as 0.1 can improve convergence.

Iteration Limit
l

Global Iterations - 50000 by default, sufficient for the vast majority of models. Most models converge in a relatively small number of iterations. This limit does not directly affect the solution.

l

Iteration Span for AutoDetect - If the Solver detects that no meaningful progress has been
made to convergence within this many iterations, relaxation is automatically lowered. This also
automatically adjusts tolerance.

l

Local Iterations - The maximum number of local iterations allowed before allowing the Solver to
continue without local convergence. See Local Iteration Control below for details.

Iteration History
Iteration History shows a history of which pipe or junction is most out of tolerance, which is helpful for
troubleshooting. After enabling Iteration History on the Iterations panel in Analysis Setup, the Iteration
History can be viewed from the Solution Progress window by pausing the calculation and selecting the
Other Actions button.

Matrix Method
Network analysis requires solving complex matrices potentially thousands of times. Different methods
may solve faster or slower, but have no bearing on results. The default method of Gaussian Elimination is
very robust and usually provides the fastest convergence. The available Matrix Methods are:
l

Gaussian Elimination

l

Gaussian Elimination With Pivoting

l

LU Decomposition

Local Iteration Control
In AFT Arrow, properties such as density, specific heat, and viscosity will vary over an interval. Calculations done on such an interval should use average values for the interval. However, the average values cannot be directly calculated without knowing the values at both the beginning and ending of the
interval. Because the parameters at the end of the interval are not known initially, the local properties
must be solved for iteratively.
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In certain models, these local iterations may not converge. The Local Iterations limit provides a means
to allow the Solver to continue if this occurs.
If the Local Iteration limit is reached, the Solver will continue with the global solution using the non-converged local solution. This does not affect the final results unless it occurs on the final global pass
through the Solver. If a local iteration problem does occur on the final pass, the solution is retried. A Max
Number of Retires After Incomplete Local Convergence will be carried out to attempt to solve the
problem. If the retries are not successful, the results will be presented as converged along with a warning
including information on the amount out of tolerance.
A default Factor on Allowable Tolerance Violation of 50 is specified here. Local iterations within this
factor of the built-in tolerance values are deemed adequately acceptable. Setting this value to 1 will show
a warning for any tolerance violation.

Related Topics
Steady Solution Control Group
Tolerance Panel
Pressure and Temperature Limits Panel
Solution Method Panel
Lower the Flow Rate Relaxation
Review the Iteration History
Solution Progress Window

100
130
135
101
686
689
305

Related Blogs
Having model convergence problems? Start here!

Pressure and Temperature Limits Panel
If the maximum and minimum temperatures or pressures in a system are known, these can be entered
here. If limits are present, the Solver will not allow solutions outside of these bounds.
This is most useful when operating near the edge of available physical property data. During iteration, the
Solver may attempt to extrapolate past the available data, returning an error. Limiting the allowable range
can keep the search within the proper bounds.
Note: This setting can affect results. It is critical that the limits are appropriately selected to not artificially constrict the solution.

Related Topics
Steady Solution Control Group
Tolerance Panel
Iterations Panel
Solution Method Panel

100
130
133
101
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Environmental Properties Group
The Environmental Properties Group in Analysis Setup has one item: Environmental Properties panel.
By default, the Environmental Properties Group is fully defined and will have a green checkmark next to
its name.

Related Topics
Analysis Setup Overview
Modules Group
Fluid Properties Group
Pipes and Junctions Group
Goal Seek and Control Group
Steady Solution Control Group
Cost Settings Group
Automatic Sizing Group
Miscellaneous Group
Environmental Properties Panel

67
68
72
87
90
100
138
141
142
136

Environmental Properties Panel
The Environmental Properties panel, shown in Figure 1, controls the atmospheric pressure, acceleration
properties, standard conditions, and transition Reynolds number used to model the system.

Figure 1: Environmental Properties panel in the Analysis Setup window
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Atmospheric Pressure
AFT Arrow uses a default atmospheric pressure of 1 standard earth atmosphere, or 14.696 psia. This
pressure is also used to convert absolute pressures to gauge pressures. Keep in mind that atmospheric
pressure varies with altitude. A project at Sea Level should not have the same atmospheric pressure as a
project at 8500 feet.

Acceleration Properties
The default for gravitational acceleration is 1 standard earth gravitational acceleration, or 32.174
feet/sec2. You can change this to a multiple of standard earth accelerations (that is, number of g's)
according to the design environment for your system. In principle, the body force on a fluid system does
not have to be due to gravity.
You also can specify a rotational acceleration such as might be experienced in turbomachinery. You are
prompted to enter a rotation rate in rpm (revolutions per minute). In this case, AFT Arrow interprets the
junction elevation data as distance from the rotation centerline, and uses a varying acceleration body
force on each individual pipe as determined by the laws of rotational dynamics.
Each individual pipe computing section will use the acceleration based on the arithmetic average over its
length. You cannot specify both gravitational and rotational accelerations at the same time.

Standard Conditions (STP)
The standard temperature and pressure (STP) are used for defining common usage flow rate units including standard cubic feet per minute (scfm).
AFT Arrow uses a default standard pressure of 14.696 psia. This value is used consistently across
industry, and the user likely will not need to change it. AFT Arrow uses a default standard temperature of
60 deg. F. This value changes across industries, and the user may wish to change it.
Another common usage flow rate is normal flow rate units. The definition of normal uses the same standard pressure as above, but 32 deg. F (0 deg. C) for temperature. The normal pressure and temperature
can not be changed by the user.

Transition Reynolds Numbers
AFT Arrow allows you to modify the transition Reynolds numbers. The default values are Reynolds number less than 2300 is laminar and greater than 4000 is turbulent. In the transition zone a linear interpolation is assumed. This applies for friction factors and convection heat transfer.

Related Topics
Environmental Properties Group

136
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Cost Settings Group
The Cost Settings Group in Analysis Setup has one item: the Cost Settings panel. This group is always
present regardless of whether or not cost calculation is enabled. When all fields are defined, the Cost Settings Group will have a green checkmark next to its name.

Related Topics
Analysis Setup Overview
Modules Group
Fluid Properties Group
Pipes and Junctions Group
Goal Seek and Control Group
Steady Solution Control Group
Environmental Properties Group
Automatic Sizing Group
Miscellaneous Group
Cost Settings Panel
Cost Calculation

67
68
72
87
90
100
136
141
142
138
428

Related Examples
Compressed Air System - Cost
Process Steam System - Cost

794
803

Cost Settings Panel
Note: This topic does not apply for the ANS module. To set up cost calculations with ANS, see the
Assign Cost Libraries topic.
The Cost Settings panel must be defined in order to run a model. By default, cost calculation is not
enabled and no further input is required to define the panel.
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Figure 1: The Cost Settings panel

Enable Cost Calculation
Enable Cost Calculations from the Cost Settings panel in Analysis Setup. The following options are available:
l

Do Not Calculate - Selected by default.

l

Compressor/Fan Energy Only - Only calculate the costs associated with the power consumption of compressors. The energy cost and system life must be entered in the Cost Settings
panel.

l

Calculate - Enable full calculation of costs. In addition to defining Cost Settings, Cost Libraries
must be defined to use this feature.

Including Objects in Cost Report
Workspace objects must be included in the Cost Report to have their cost calculated. This allows only
analyzing the cost of certain parts of the model - useful if only one compressor is being replaced, or if an
expansion to an existing system is being considered. To include the objects in the Cost Report simply
select Include Cost in Report on the object's Cost tab, as shown in Figure 2. Finer detail in how the Cost
is included can be set by clicking the Cost Application button.
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Figure 2: Include Cost in Report

Energy Cost
Energy cost data can be specified though an energy cost library, or by directly entering an energy cost on
the Cost Settings window. Using an energy cost library allows you to specify multiple energy costs, such
as energy costs at both peak and off-peak rates.

Cost Definitions
The Cost Definitions section allows you to specify the type of costs to be determined. Check the boxes
next to the items that are of interest. The options are:
l

Material

l

Installation

l

Maintenance

l

Operation/Energy

Cost Time Period
The system lifetime to be applied for the cost calculations is specified in the Cost Time Period section.
You can also specify interest and inflation rates to be applied to the cost calculations.
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The System Life affects all recurring costs. It can also affect non-recurring costs if the Service Duration is
used.
See Cost Libraries for detailed discussions regarding recurring and non-recurring costs.

Related Topics
Cost Settings Group
Cost Calculation

138
428

Related Examples
Compressed Air System - Cost
Process Steam System - Cost

794
803

Automatic Sizing Group
(ANS Module Only) The Automatic Sizing group in Analysis Setup only appears when the ANS Module
is activated from the Modules panel. The Automatic Sizing group has one panel: the Sizing Summary
panel.

Related Topics
Analysis Setup Overview
Modules Group
Fluid Properties Group
Pipes and Junctions Group
Goal Seek and Control Group
Steady Solution Control Group
Environmental Properties Group
Cost Settings Group
Miscellaneous Group
ANS - Automated Network Sizing
Sizing Summary Panel

67
68
72
87
90
100
136
138
142
552
141

Sizing Summary Panel
The Sizing Summary panel in Analysis Setup displays the Sizing Summary when the ANS module is active. The Sizing Summary can also be viewed in the Sizing Window.
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Figure 1: Sizing Summary panel with all tree nodes expanded

Related Topics
ANS - Automated Network Sizing
Automatic Sizing Group

552
141

Miscellaneous Group
The Miscellaneous group contains settings that are used infrequently. By default, the Miscellaneous
Group is fully defined, with a green checkmark next to its name, without any additional input from the
user.
The Miscellaneous group has two panels:
l

Heat Transfer Sectioning panel - Contains advanced settings for heat transfer calculations for
troubleshooting purposes

l

Advanced Parameters panel - Contains advanced parameters that can be used for troubleshooting purposes

Related Topics
Analysis Setup Overview
Modules Group
Fluid Properties Group
Pipes and Junctions Group
Goal Seek and Control Group
Steady Solution Control Group
Environmental Properties Group

67
68
72
87
90
100
136
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Cost Settings Group
Automatic Sizing Group
Heat Transfer Sectioning Panel
Advanced Parameters Panel

138
141
143
143

Heat Transfer Sectioning Panel
The number of thermal sections that are used to calculate heat transfer in Heat Exchangers can be modified here.
Because the amount of heat transfer is dependent on the temperature difference at any given point, an
overall average would not give an accurate estimate. Sectioning heat transfer components increases the
accuracy of the calculation due to the changing thermal profile. Very large thermal changes may require
additional sections.

Figure 1: Default state of the Heat Transfer Sectioning panel

Related Topics
Miscellaneous Group
Advanced Parameters Panel

142
143

Advanced Parameters Panel
The Advanced Parameters panel, shown in Figure 1, of Analysis Setup offers various settings intended
only for troubleshooting purposes.
These parameters should not be changed under normal circumstances and will significantly impact results.
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Figure 1: Default state of the Advanced Parameters panel

Related Topics
Miscellaneous Group
Heat Transfer Sectioning Panel
Global energy balance disabled by user in Advanced Parameters panel
Global mass balance disabled by user in Advanced Parameters panel
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Working with Pipe and Junction Objects
This section focuses on interactions with the Pipe and Junction objects in the AFT Arrow workspace. Topics include how to create pipes and junction objects, how to alter junctions already on the workspace, and
how to ensure the inputs for objects are both correct and complete.

Contents
Selecting and Finding Objects

145

Pipe Drawing Modes

150

Selecting and Finding Objects
AFT Arrow has a number of methods to assist in selecting multiple objects at once as well as finding
objects for recall later. The contents of this section can be broken down into the two categories shown
below. Follow the links to learn more.
l

l

Methods for selecting objects
l

Select Flow Path

l

Select Special

l

Groups

Methods for finding objects
l

Workspace Find

l

Workspace Search

l

Find from Model Data or Output

l

Jump Feature

l

Bookmarks

Related Topics
Working with Pipe and Junction Objects
Pipe Drawing Modes
Global Edit
Selecting Objects
Finding Workspace Objects
Groups
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Working with Pipe and Junction Objects

Selecting Objects
A single left click on any object will select that object.
Selecting multiple objects can be accomplished by:
l

Holding the shift or control key and left clicking on objects

l

Dragging the cursor over the objects, creating a selection area.
l

Dragging left-to-right creates a selection area that will only select objects entirely bounded
by the area.

l

Dragging right-to-left creates a selection area that selects any objects completely or partially inside the area.

l

Using Select All from the Edit Menu, right-clicking on Workspace to open context menu, or keyboard shortcut (Ctrl-A)

l

Using Select Last Selection from the Edit Menu or with F12 to reselect the previously selected
objects

l

Using Select Flow Path

l

Using Select Special

l

By selecting a Group

Select Flow Path
A flow path is a sequence of pipes and junctions where there is no branching or flow sources or sinks.
The pipes and/or junctions in a flow path may all be easily selected using the Select Flow Path item on
the Edit menu, Toolbar or the right-click context menu.
If a junction is selected which has multiple flow paths attached to it (e.g., a branch with 3 or more pipes)
then objects in each of the connected flow paths will be selected. This feature is very useful in duplicating
or deleting sequences of pipes and junctions. It can also be used to quickly define groups for graphing or
for selected Output or Model Data listings.

Select Special
Select Special is a tool for selecting or deselecting objects based on certain criteria. It can be opened
from all windows/menus that give you the option to choose what pipes and/or junctions are selected.
These windows/menus include the Output Control window, the Model Data window, the Visual Report
Control window, the Select Graph Data window, the Edit menu, right clicking on the Workspace, or pressing F6 on the keyboard.
Once Select Special is open, all pipe names and numbers and junction names and numbers are shown
in numerical order under Pipe Selections and Junction Selections, respectively. At the top of the Select
Special window is the Selection Type option. This option allows you to choose what criteria you would
like to use to select certain pipes and junctions. You can choose from the following criteria to select certain pipes and/or junctions.
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l

Selected on Workspace

l

Closed in Model

l

Special Conditions Set

l

Number Range

l

Junction Type

l

Pipe Input Parameters

l

Zero-length Connectors

l

Notes

l

Undefined Objects

l

User-Colored Pipes

l

Transient Data Exists (XTS only)

l

Groups

l

Used as Goal or Variable

l

Pipe Output Properties (Only available when output is available)

l

Junction Output Properties (Only available when output is available)

Choosing certain Selection Types will prompt a second or sometimes third option below the Selection
Type to allow you to further specify the type of pipe or junction you want. For example, selecting Junction
Type in the Selection Type box will prompt the Junction Type box to appear. The Junction Type box will
allow you to specify what type of junctions you would like to select.
By default, the Selection Type is Selected on Workspace and any pipes or junctions selected on the
Workspace are selected in the Select Special window with a black check mark next to the box corresponding to the pipe or junction.
Once you have fully specified the Selection Type, you must click Select Pipes and/or Select Junctions to
automatically select the corresponding objects.
The selected pipes and junctions under Pipe Selections and Junction Selections do not automatically
become unselected when you switch from one Selection Type to another. Therefore, you must first
choose Deselect Pipes and/or Deselect Junctions located above the Pipe Selections and Junction Selections boxes, respectively. For example, if you select all of the pipes on the Workspace prior to opening
the Select Special window, all of the pipes will be selected in the Select Special window when you open
it. If you then choose Junction Type as the Selection Type and then specify All Junctions as the Junction
Type, all junctions will be selected under Junction Selections, but all pipes previously selected will also
remain selected. In this example, if you would like only junctions to be selected with none of the selected
pipes on the Workspace to be selected in the Select Special window, first click the Deselect Pipes button,
which is located above the Pipe Selections list.
Options to select all pipes/junctions, to deselect all pipes/junctions, and to invert the selected pipes/junctions are located below both Pipe Selections and Junction Selections boxes. Inverting the pipes/junctions deselects all currently selected pipes/junctions and selects all currently deselected pipes/junctions.
This feature is helpful if you want to select all pipes/junctions that DO NOT fit a certain criteria. For
example, if you want to select all open objects in the model, you could specify Closed in Model in the
Selection Type box, then click Select Pipes and Select Junctions. All pipes and junctions that are closed
in the model will be selected. Because you want to select all open pipes and junctions in the model but
only the closed pipes and junctions are selected, you would simply click Invert below both the Pipe Selec-
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tions and Junction Selections lists to deselect all closed pipes and junctions and select all open pipes
and junctions.

Related Topics
Selecting and Finding Objects
Finding Workspace Objects
Groups

145
148
149

Finding Workspace Objects
Workspace Find
The Find window utility helps you find a particular pipe or junction by its ID number and name. The Find
utility becomes more useful for large models.
You can access the Find utility by selecting Find on the View menu, by clicking the binocular button on
the Toolbar, or by pressing the CTRL+ F keys on the keyboard. After you double click on the pipe or junction you are searching for in the Find utility or when you click the Find button, the Workspace is moved so
that the pipe or junction is located near the center of the screen. Additionally, the pipe or junction you are
searching for is selected in the Selected Items color specified in the User Options window in the Tools
menu. By default, this color is red.

Workspace Search
The Search window utility helps you search for a particular pipe or junction by its ID number, name, or
notes you have inputted in the properties window. The Search utility becomes more useful for models
that expand over multiple Workspace pages.
You can access the Search on the Common Toolbar. The search feature will list all objects related to
your search term beneath itself in a list of search results. You can hover over each search results to see a
preview of input and output (if the model has been run). Clicking on or pressing enter while the object is
highlighted in the search results will select the object in the workspace and center the focus of the workspace on the object.

Find From Model Data or Output
Objects can be quickly located on the Workspace by right-clicking on a cell in Model Data or row header
in Output and selecting "Find on Workspace..." the view will change to show the Workspace, with the
object of interest selected.
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Jump Feature
By clicking the Jump button in a Properties Window, you can move directly to the Properties Window of
another a pipe or junction that you specify.
The Jump button is located in the upper right corner of the Properties Window.

Bookmarks
Use the Bookmark tools on the View menu to set Bookmarks and to display different bookmarked pipes
or junctions.
Bookmarks can be added on the Workspace in relation to individual pipes or junctions. You can quickly
navigate around the Workspace by moving from Bookmark to Bookmark.

Related Topics
Selecting and Finding Objects
Selecting Objects
Groups

145
146
149

Groups
Groups of pipes and junctions can be named for later recall. This is done using the Group tools on the
Edit menu. The easiest way to create a named Group is as follows:
1.

First select the the pipes and junctions you want in the group

2.

Choose Groups -> Create from the Edit menu or Toolbar.

3.

You will be prompted for a name for the group. Enter a meaningful name and click OK.

4.

The Group Manager then opens. The selection of pipes and junctions in the Group will match
those currently selected on the Workspace. If you want to modify the selections once more, you
can do it here.

You can include Subgroups inside of your Groups. Subgroups are existing Groups. If a Group contains
one or more Subgroups and the Group is selected on the Workspace, then all pipes and junctions in the
Group and Subgroup(s) will be selected. Additionally, if you include a Subgroup in your Group and then
later change the contents of the Subgroup, the Group that contains the Subgroup will also be changed.
After you have created a Group, you can then quickly reselect that Group of pipes or junctions on the
Workspace by choosing Group -> Select from the Edit menu or Toolbar and choosing the name of the
Group.
The Group Manager can be opened by choosing Group -> Manager from the Edit menu or Toolbar. The
Group Manager allows you to modify, create, delete or rename Groups.
Another place that Groups can be selected from is in the Select Special window.
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Related Topics
Selecting and Finding Objects
Selecting Objects
Finding Workspace Objects

145
146
148

Related Examples
Natural Gas Burner - GSC
Process Steam System - GSC

833
846

Pipe Drawing Modes
AFT Arrow has 3 different pipe drawing modes. These pipe drawing modes are
l

2D Freeform

l

2D Orthogonal

l

Isometric

This section will discuss the features of each drawing mode as well as how to adjust the pipe presentation in each including Snap to Grid.

Related Topics
Working with Pipe and Junction Objects
Selecting and Finding Objects
Global Edit
Snap to Grid
2D Freeform Grid
2D Orthogonal
Isometric

145
145
159
151
151
152
154

Related Examples
Compressed Air System

748

Related Blogs
Iso love the new Pipe Drawing Mode!
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Snap to Grid
Toggled from Arrange > Snap to Grid.
All junctions, pipe endpoints, and pipe segments will be snapped to the grid intersection points when
Snap to Grid is on. Turning Snap to Grid on in an existing model will optionally attempt to move all existing junctions to the grid points.

Related Topics
Pipe Drawing Modes
2D Freeform Grid
2D Orthogonal
Isometric

150
151
152
154

2D Freeform Grid
The standard grid in AFT Arrow, enabled by default in the Arrange > Pipe Drawing Mode menu.
This Pipe Drawing Mode allows placing pipes or junctions anywhere on the Workspace, with pipes at any
angle.

Figure 1: 2D Freeform with Snap to Grid off
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Figure 2: 2D Freeform with Snap to Grid on

Related Topics
Pipe Drawing Modes
Snap to Grid
2D Orthogonal
Isometric

150
151
152
154

2D Orthogonal
The 2D Orthogonal Pipe Drawing Mode forces all pipes drawn in the model to be either horizontal or vertical. This is enabled in the Arrange > Pipe Drawing Mode menu.
In 2D Orthogonal mode, segments are automatically inserted into pipes to enforce drawing only along
the horizontal and vertical.
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Figure 1: Model in 2D Orthogonal mode with Snap to Grid on

Tips for Using the Orthogonal Drawing Feature
Orthogonal drawing can create some confusion for the user because segments from different pipes may
overlap each other and hence become indistinguishable.
l

Use the Add/Remove Segments button to add new segments

l

Use a fine grid and snap to grid features

l

If you have a junction with several connecting pipes that interfere, enlarge the junction to 150% or
200% of normal size

Related Topics
Pipe Drawing Modes
Snap to Grid
2D Freeform Grid
Isometric

150
151
151
154
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Isometric
Enabling Isometric
AFT Arrow allows the user to place pipe or junction objects anywhere in the Workspace.
In order to make building clean looking models easier, objects are snapped to the 2D Freeform grid by
default. However, it may be convenient or desired to demonstrate the three dimensional nature of a system. A typical 2D grid has two sets of gridlines representing the x and y axes. An isometric grid has three
sets of gridlines that are offset by 60°, representing the x, y, and z axes.
Enable the isometric grid by selecting Pipe Drawing Mode -> Isometric from the Arrange menu. There will
be a prompt about converting non-isometric pipes - this is a required step, but may result in some unintended object placement. It is best practice to set the grid type before building a model and retain that
type of grid if possible. It is also very helpful to show the Grid (Arrange -> Show Grid) when building an
isometric model.

Figure 1: 2D (left) and isometric (right) grids

Drawing Pipes
When drawing on the isometric grid, pipes are automatically segmented to lie on the gridlines as shown
below. Dragging one of the handles on the pipe shows a preview line of where the pipe will be placed if
adjustment needs to be made.
The placement of the preview line can be cycled through all possibilities by pressing the arrow keys or by
scrolling the mouse scroll wheel.
Holding the alt key while dragging a pipe endpoint will automatically add a new segment to the pipe - the
placement of the line can be controlled with the arrow keys or scroll wheel as before.
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Figure 2: Automatic layout of isometric pipes

The default action is for pipes in the workspace to snap to the isometric gridlines. However, if desired, a
given pipe can be set to not snap to the grid by clicking Edit -> No Snapping for Pipe or by right-clicking a
selected pipe and clicking the No Snapping for Pipe option.

Placing Junctions
Placing junctions onto the Workspace follows the usual rules - however, the visual appearance of the
icon is more complex than in an orthogonal grid. When icons are added after pipes are placed, AFT
Arrow will rotate the icon automatically following the workspace arrangement. When pipes are connected
to icons already placed in the workspace, right-click and select Auto-rotate Icon to adjust the icon. For
manual control of icon appearance, right-click and select Customize Icon to choose the desired appearance.
Note: It may be easiest to make use of the Rotate button in the Customize Icon window to find the
appropriate icon. With many possibilities to choose from finding the proper rotation can be difficult.
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Figure 3: Icon rotations in isometric space

Related Topics
Pipe Drawing Modes
Snap to Grid
2D Freeform Grid
2D Orthogonal

150
151
151
152

Related Examples
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Compressed Air System

748

Related Blogs
Iso love the new Pipe Drawing Mode!
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Global Edit
AFT Arrow has the powerful capability to apply input parameters across a wide range of objects. This can
be done for pipes by using the Global Pipe Edit or across junctions of the same type by using the Global
Junction Edit.

Related Blogs
Mass Modify your Model with Global Edit

Global Pipe Editing
The Global Pipe Edit window allows you to edit data for multiple pipes at the same time. A Guide is available at the top of the Global Edit window to walk you through the global edit process.
Here is how you use it:
1.

Open the Global Pipe Edit window from the Edit menu.

2.

Select the pipes you want to edit from the Pipe list on the left. (If pipes were selected in the Workspace, they will be automatically selected here)

3.

Click the Select Pipe Data button. This will open the Pipe Properties window in which you can
enter the data you want to change on each of the selected pipes. Alternatively, if you want to copy
the data from an existing pipe, you can choose "Existing Pipe", then select the desired pipe number and skip to step 5.

4.

Enter the pipe data you want to change and click the OK button in the Pipe Properties window.

5.

The Global Pipe Edit window now lists the parameters to change in a list on the right. Select the
parameters you want to change.

6.

Click the Apply Selections button.

Note: You cannot change some data, like the pipe ID number, using this global method.
Note: There is no undo for global pipe editing. Therefore, you cannot cancel your changes once you
have exited the Global Edit window. However, hitting Cancel on the Global Edit window will
undo any changes that were just applied.

Related Topics
Global Edit
Global Junction Editing

159
160

Related Blogs
Mass Modify your Model with Global Edit
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Global Junction Editing
The Global Junction Edit window allows you to edit data for multiple junctions at the same time. A Guide
is available at the top of the Global Edit window to walk you through the global edit process, or the instructions are provided below in this topic.
Junction data falls into the following two broad categories:
l

Common Data - data that applies to all junctions regardless of junction type; examples include
elevation and initial pressure data.

l

Junction Specific Data - data that applies only to certain junctions; examples include pump curves
and number of heat exchanger tubes.

To open the Global Junction Edit window, browse to the Global Junction Edit option on the Edit menu.
From there, choose the category of junction you want to edit. The available categories include those junctions selected on the Workspace, any junction type used in the model, and common junction data. Global
Junction Edit can also be launched by right-clicking on the Workspace.
Note: There is no undo for global junction editing. Therefore, you cannot revert your changes once
you have exited the Global Edit window. However, hitting Cancel on the Global Edit window will
undo any changes that were just applied.

Editing Common Junction Data
You can open the Global Junction Edit window for common data editing in two ways. First, you can
choose Common Data from the Global Junction Edit menu selection on the Edit menu, or you can
choose one of the other specific junction types on the menu and then choose the Common option for the
Junction Template in the upper left.
Here is how to globally edit junction common data:
1.

Open the Global Junction Edit window.

2.

Select the Common option for Junction Template in the upper left.

3.

Select the junctions you want to edit from the Junction list on the left. Note that all junctions in the
model are shown, no matter what the junction type.

4.

Click the Select Common Junction Data button. This will open the Common Junction Data Edit
window in which you can enter the data you want to change on each of the selected junctions.

5.

Enter the junction data you want to change and click the OK button in the Junction Properties Window.

6.

The Global Junction Edit window now lists the parameters to change in a list on the right. Select
the parameters you want to change.

7.

Click the Apply Selections button.

Note: You cannot change some data, like the junction ID number, using this global method.
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Editing Specific Junction Data
You can open the Global Junction Edit window for specific data editing in two ways. First, you can choose
the junction type from the Global Junction Edit menu selection on the Edit menu, or you can choose Common Data on the menu and then choose the desired junction template, or Existing Junction data for the
desired junction type.
Here is how to globally edit specific types of junctions:
1.

Open the Global Junction Edit window.

2.

Select the Junction Template option in the upper left. Alternatively, if you want to copy the data
from an existing junction, you can choose "Existing Junction", then select the desired junction
number and skip to step 6.

3.

Select the type of junction you want to edit in the dropdown list in the upper left. Here Spray Discharge is selected.

4.

Click the Select Spray Discharge Data button (the button name will change based on the type of
junction selected). This will open the appropriate junction Properties Window, in this case the
Spray Discharge Properties Window.

5.

Enter the junction data you want to change and click the OK button in the Spray Discharge Properties Window (or whatever window type is displayed).

6.

The Global Junction Edit window now lists the parameters to change in a list on the right. Select
the parameters you want to change.

7.

Select the junctions you want to edit from the Junction list on the left. Note that only junctions of
type selected in the upper left are shown (Spray Discharge junctions in this case).

8.

Click the Apply Selections button.

Related Topics
Global Edit
Global Pipe Editing

159
159

Related Examples
Refinery Relief System

775

Related Blogs
Mass Modify your Model with Global Edit

Toolbox
The bundle of tools at the left of the Workspace window that allow you to create or select pipes and junctions. The toolbox can be docked to the left, right, or floated within the workspace by clicking on the
arrows on the top of the toolbox.
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Figure 1: Toolbox items

Related Topics
Creating Pipes - the Pipe Drawing Tool
Creating Junctions
Keyboard Shortcuts for Workspace

162
166
313

Creating Pipes - the Pipe Drawing Tool
The tool in the upper left corner of the Toolbox is the Pipe Drawing tool. With this tool you can draw new
pipes on the Workspace, starting and ending at any desired location.
To draw a pipe, click the Pipe Drawing tool. The mouse pointer will change to a crosshair when you move
it over the Workspace. Position the cursor at the pipe’s starting point, hold down the left mouse button
while dragging the cursor to the pipe end point, then release the mouse button.
To draw multiple pipes, double click the Pipe Drawing tool. This will keep the tool engaged until you click
the Pipe Drawing tool again or press the escape key.
The length of the line on the Workspace has no relationship to the physical length of the pipe. The Workspace pipe is merely an abstract representation of a pipe, however, each pipe drawn must have a visible
length on the Workspace. If the pipe drawn does not have a visible length, AFT Arrow eliminates the line
immediately after you release the mouse.
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When a single pipe is selected, two black squares (or more if the pipe is segmented), called handles,
appear. When the cursor is placed over a pipe handle it changes to a crosshair and the pipe handle can
be moved or stretched by dragging with the left mouse button.
Another way to create new pipes is to duplicate existing pipes with the Duplicate or the Copy and Paste
features found on the Edit menu. When a new pipe is derived from a previous pipe, the new pipe retains
the input associated with the original pipe.
Each pipe must be connected to two junctions. There are no exceptions to this rule.

Pipe ID Numbers
When a new pipe is created, it is assigned a default ID number. When the pipe is displayed on the Workspace, the ID number is preceded by the letter "P" to indicate that it is for a pipe. An arrow near the ID
number indicates the reference flow direction for the pipe. From the Pipe Properties Window, you can
change the ID number to any desired number greater than zero and up to 99,999, but the number must
be unique to the pipe and cannot be replicated in any other pipes on the Workspace. The pipe number
does remain with the pipe in child scenarios in the Scenario Manager. The reference positive flow direction can be reversed by choosing Reverse Direction from the Edit menu or by selecting the reverse direction button on the Toolbar.
Tip: The pipe or junction ID number text can be dragged to a new location to improve visibility. The
new location is saved with the model. If you want the text of one or more pipes and/or junctions
returned to the default location, select those pipes/junctions on the Workspace and choose
Reset Label Locations from the Arrange menu. From this box, click the Reset Labels For Currently Selected Pipes and Junctions. If you want all pipe and junction text returned to the default
locations, choose Reset Label Locations from the Reset Label Locations box on the Arrange
menu.

Pipe Segments
A pipe can be segmented or "bent" into numerous sections. This only affects the visual representation
and does not affect the calculated results. It does not add an "elbow" to the model or the resulting pressure drop effects of an elbow. This feature is useful in graphically bending the pipe around another part of
the model or graphically showing that there are embedded elbows as fittings & losses.
You can add a segment to a pipe in several ways. The easiest way to add a pipe segment is to first select
the pipe, then click on the +/- image on the Add/Remove Segment icon from the Toolbar. A segment will
automatically be added. One or more segments can be added by clicking on the down-facing arrow on
the Add/Remove Segment icon from the Toolbar, and then choosing the number of segments to be
added. Alternatively, you can first select the pipe, then select Pipe Segments in the Arrange menu. A
dropdown list will appear that allows you to choose Add a Segment or Add Multiple Segments.
The easiest way to remove a segment is to first select the pipe, then click on the down-facing arrow on
the Add/Remove Segment icon from the Toolbar. A drop down list will appear that will allow you to
choose Remove Segment. If you wish to remove all segments, click Remove All Segments. Alternatively,
you can first select the pipe from which you want to delete one or more segments, then select Pipe Segments in the Arrange menu. A dropdown list will appear that allows you to remove one or all segments by
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clicking on either Remove Segment if you want to remove one segment, or by clicking on Remove All
Segments if you want to delete all segments.

Keyboard Shortucts
See the Keyboard Shortcuts for Workspace topic for more information on additional Pipe Drawing Tool
shortcuts.

Related Topics
Toolbox
Creating Junctions
Keyboard Shortcuts for Workspace
Pipes
Join or Split Pipes
Connecting Objects
Moving Objects
Editing Objects
Defining Objects
Highlight Required Input
Inspecting Objects
Notes
Status
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Related Examples
Beginner: Air Heating System

702

Join or Split Pipes
When pipes are present in the Workspace, users can both combine and split up pipes. This can be done
either to clean up the model visually or to further manipulate the model.

Join Pipes
When multiple pipes are placed in the workspace separated by junctions without having other flowpaths
splitting off, those pipes and intermediate junctions can be combined into a single pipe. The new pipe will
have any losses associated with the intermediate junctions entered as additional Fittings & Losses.
The pipes being combined must have the same material, size, type, and friction model to be combined. In
addition the pipes must be pointing in the same direction.
Joining pipes may cause some junction data to be lost such as special conditions, loss factors for reverse
flow, and ignored transients.
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To join pipes and junctions in the model, select the "Join Pipes/Junctions" option from the Edit menu. The
Join Pipes window will be shown with more information on pipes that can be combined in the model. The
behavior of the Join Pipes form will vary depending on if junctions are selected on the Workspace when
the Join Pipes/Junctions option is selected.
Note: For maintenance releases prior to August 2022 the Join Pipes/Junctions window did not exist.
Instead pipes and junctions selected in the Workspace would be joined automatically when the
"Join Selected Pipes/Junctions option was selected in the Edit menu.
l

If junctions are selected on the Workspace, the Join Pipes form will open with only the selected
junctions shown in the window.

l

If no junctions are selected on the Workspace, the Join Pipes form will open with all junctions that
can be combined shown in the window. Any junctions that can be combined and won't cause a
loss in data at that junction will be selected automatically.

Once the Join Pipe/Junctions window is opened the selections can be modified before joining the pipes.
The options below the table can be enabled/disabled in order to filter the shown junctions based on if
they are selected on the workspace, if they will loose data when combined, or if they can't be combined.
If any junctions are selected that would loose data when combined, an additional button will appear near
the bottom of the window that allows junctions that would have data loss to be deselected. It is recommended to select this button before joining the pipes/junctions unless you are certain the lost data is no
longer required.
To join the pipes at the junctions selected in the Join Pipes/Junctions window, click the Join Selected
Junction(s) button at the bottom of the window.

Split Pipes
An existing pipe in the workspace can be split into multiple pipes by holding the Shift key while placing a
junction on the pipe. This will split the pipe in two and insert the selected junction at the specified length.
Any fittings and losses defined in the pipe can be placed in either of the split pipe segments.

Related Topics
Pipes
Creating Pipes - the Pipe Drawing Tool
Connecting Objects
Moving Objects
Editing Objects
Defining Objects
Highlight Required Input
Inspecting Objects
Notes
Status
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Creating Junctions
Below the pipe drawing and the annotation tools on the Toolbox are junctions, which allow you to model
a large variety of pipe system components. To add a junction to a model, drag the desired icon from the
Toolbox and drop it anywhere on the Workspace.
To add multiple of the same junctions to a model, double click the desired icon and click the workspace to
add the icon to the desired location. The selected junction icon will remain engaged until you click the
junction icon again or press the escape key.
As you move the mouse pointer over the Toolbox, a tooltip identifies the type of junction under the mouse
pointer.
When you duplicate a junction using the Duplicate, Copy, or Paste features on the Edit menu, the new
junction retains the input associated with the original junction.

Junction ID Numbers
Junctions are shown on the Workspace with default ID numbers, which you can change in the Junction
Properties Window. The letter "J" precedes the ID number to signify that it is for a junction. From the junction's Properties window, you can change the ID number to any desired number greater than zero and up
to 99,999, but the number must be unique to the junction and cannot be replicated in any other junctions
on the Workspace. The junction number remains with the junction in descendant scenarios as long as
the junction type is not changed.
Identical ID numbers can be assigned to both a pipe and a junction because the "P" or "J" will distinguish
the two.
Unlike pipes, junctions do not have reference positive flow directions. Junctions for which the flow direction is important (such as control valves) derive the flow direction from the flow direction of the connecting pipes.

Related Topics
Toolbox
Creating Pipes - the Pipe Drawing Tool
Keyboard Shortcuts for Workspace

161
162
313

Related Examples
Beginner: Air Heating System

702

Connecting Objects
During construction of a new model, objects can be placed anywhere on the Workspace. In order to
assemble a model that is ready to submit to the Solver, you must connect the objects properly.
Remember that connectivity only exists between junctions and pipes. There are no junctions that connect to junctions, and no pipes that connect to pipes.
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However it is possible to represent two junctions that are directly connected, such as two components
that are welded together by using a pipe with the Model As Zero-Length Connector option.
AFT Arrow will attempt to automatically connect pipes and junctions when they are moved. This eliminates unnecessary opening of the pipe and junction properties windows. If Arrow cannot make the connection automatically, then the following three steps may be required to establish a connection between
a junction and a pipe:
1.

Graphically connect the objects on the Workspace. The pipe endpoint must terminate within the
boundaries of a junction icon.

2.

After the pipe is graphically connected to two junctions, double-click the pipe to open its Properties
window, then click OK to accept the connected junctions as determined by AFT Arrow. It is most
efficient to do this when you are entering the pipe's data in its Properties window.

3.

Open the Properties window of the corresponding junction and accept the pipe connectivity
determination. You can do this as you enter the junction's data in its Properties window.

If the model seems to not be connected properly, you can also use the Extended Model Check feature on
the View menu.
When you accept AFT Arrow's connectivity interpretation, the connection advances from a graphical connection to a model connection.
The model connectivity you establish on the Workspace is retained only as long as you maintain the
graphical objects in their current visual relationship to each other. If you move a pipe or a junction and
break the graphical connection, AFT Arrow disconnects the two objects. However, if you move a group of
connected objects, their model connectivity is maintained.

Related Topics
Pipes
Creating Pipes - the Pipe Drawing Tool
Join or Split Pipes
Moving Objects
Editing Objects
Defining Objects
Highlight Required Input
Inspecting Objects
Notes
Status
Junctions
Morphing Junctions
Moving Pipe and Junction Labels
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Moving Objects
Objects on the Workspace can be moved individually or as groups. Clicking a Workspace object selects
it. Pipe objects change color when selected. Junction objects are outlined in red when selected. These
colors are configurable in the Workspace section of User Options (Tools menu) .
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To move an object, select the object, drag it within the Workspace, and drop it in the desired location.
When an object is dragged beyond the existing Workspace area, the Workspace is expanded accordingly.
A pipe object can be stretched by grabbing the handles (small red squares) at the pipe endpoints and
moving an endpoint to a new location. To make these handles visible, select the pipe you want to move.
There are numerous ways to select a group of objects for movement or other operations.
To prevent accidental movement of objects on the Workspace, lock the objects. A lock symbol appears
next to locked pipes or junctions when an attempt is made to move the pipe or junction. The Lock feature
is accessed from the Arrange Menu or the lock button on the Toolbar. To lock an object on the Workspace, select it and then activate the Lock feature either from the Arrange menu or from the lock button
on the Toolbar. If you would like to lock multiple objects at the same time, ensure that all of the objects
are selected prior to activating the Lock feature.

Related Topics
Pipes
Creating Pipes - the Pipe Drawing Tool
Join or Split Pipes
Connecting Objects
Editing Objects
Defining Objects
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Inspecting Objects
Notes
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Moving Pipe and Junction Labels
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Editing Objects
The pipes and junctions you place on the Workspace can be edited with the editing commands from the
Edit menu or the Toolbar. Objects can be cut, copied, pasted, duplicated, and deleted. These operations
can be performed on individual objects or on groups. The Edit menu provides multiple levels of undo for
each editing operation. Alternately, you can use the Undo button on the Toolbar.
The Copy Graphics feature on the Edit menu will copy the specified Workspace objects to the Windows
clipboard. This image can then be pasted into other Windows applications.

Related Topics
Pipes
Creating Pipes - the Pipe Drawing Tool
Join or Split Pipes

177
162
164
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Connecting Objects
Moving Objects
Defining Objects
Highlight Required Input
Inspecting Objects
Notes
Status
Junctions
Morphing Junctions
Moving Pipe and Junction Labels
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Morphing Junctions
Occasionally you may want to change a junction’s type in your model. You can do this by morphing the
old junction into a new one.
If you hold down the CTRL key and select a junction from the Toolbox and drop it onto an existing Workspace junction, the old junction will morph into the new one. The junction type will change to the new junction type, and data that can be kept will be copied into the new junction.

Related Topics
Junctions
Connecting Objects
Moving Objects
Editing Objects
Defining Objects
Highlight Required Input
Inspecting Objects
Notes
Status
Moving Pipe and Junction Labels
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Defining Objects
To specify the required property data for an object, open its Properties window. This can be done in six
ways:
l

Double-click the object on the Workspace

l

Select the object (by clicking on it once, or using the Selection Box) and press Enter

l

Select the object and click the Open Pipe/Jct Window icon on the Workspace Toolbar

l

Double-click the left column of the appropriate table in the Model Data window (where the object
ID number is shown)
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l

Jump from another Properties window

l

Double-click the connected pipe or junction number in a Properties window

Parameters that functionally describe the pipe or junction are entered in the Properties window. Some
parameters in the Properties windows are required and others are optional. The optional parameters
offer you added control over your model and the ability to obtain specialized information.
The highlight feature shows the required input in pipes and junctions.

Undefined Objects Window
You can open the Undefined Objects window to view all undefined objects and the undefined properties.
This is available on the View menu.

Use Status Feature
Each pipe and junction Properties window has a Status tab. The Status tab shows what required information for the pipe or junction is missing.

Satisfying Connectivity Requirements
In addition to entering the required information for each object in the model, you must satisfy these connectivity requirements:
l

You must accept the connectivity information shown in each object's Properties window

l

Each junction must have the appropriate number of pipes connected to it. For example, a venturi
must have exactly two connecting pipes, whereas a reservoir may have one to twenty-five connecting pipes.

l

Pipes must always be connected to two junctions, one at each pipe endpoint.

Should you ever delete any of the required information in the Properties window or move a connected
object from its connection, the object's status reverts to undefined.
For example, say you place a compressor/fan on the Workspace. A compressor/fan requires inlet and
outlet piping. AFT Arrow reflects this by requiring each compressor/fan to be assigned an upstream pipe
and a downstream pipe. Entering only the compressor/fan constants and setting an elevation is necessary but not sufficient information to define the compressor/fan according to AFT Arrow's requirements. Once you have entered the compressor/fan data and properly connected it, the compressor/fan is
defined.

Show Object Status
The Show Object Status feature helps you identify which objects on the Workspace are defined and
which are not. This feature can be toggled on and off by selecting it from the View menu or by clicking the
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floodlight button on the Toolbar.
Turning Show Object Status on displays the undefined junction and pipe ID numbers in the Undefined
Color, which is red by default. The color can be changed through the User Options window on the Tools
menu. Show Object Status helps you rapidly assess where your model requires additional information.
Leaving Show Object Status always toggled on is not recommended for large models, as it will slow the
Workspace graphics response. When this feature is on, every Workspace graphical operation you perform must be accompanied by a check of all pipe and junction connections. This check takes time, and
could degrade your graphics performance.

Related Topics
Pipes
Creating Pipes - the Pipe Drawing Tool
Join or Split Pipes
Connecting Objects
Moving Objects
Editing Objects
Highlight Required Input
Inspecting Objects
Notes
Status
Junctions
Morphing Junctions
Moving Pipe and Junction Labels

177
162
164
166
167
168
171
172
174
174
206
169
175

Related Examples
Beginner: Air Heating System

702

Highlight Required Input
The highlight feature functions to identify required input data for the Properties Window for each pipe and
junction. You can toggle the highlight feature on and off in the following ways:
l

l

From the Properties Window
l

Double-click anywhere in the Properties Window

l

Press the F2 function key

From the View Menu
l

Toggle the Highlight in Pipe and Jct Windows to Off

The highlighting feature may be especially useful when you are first learning to use AFT Arrow or when
you are having difficulty obtaining a defined object status.
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Related Topics
Pipes
Creating Pipes - the Pipe Drawing Tool
Join or Split Pipes
Connecting Objects
Moving Objects
Editing Objects
Defining Objects
Inspecting Objects
Notes
Status
Junctions
Morphing Junctions
Moving Pipe and Junction Labels

177
162
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168
169
172
174
174
206
169
175

Inspecting Objects
The Inspection feature is a time saving feature for reviewing the data associated with a Workspace
object. Inspection displays the data for an object in read-only format (see Figure 1).
To inspect an object, position the mouse pointer on the object and hold down the right mouse button.
Inspecting is quicker than opening the Properties Window if you want to look at an object's input data but
not edit it.
The Inspection feature is also available in each Properties Window. This is useful if you want to check the
input data of objects connected to the one you are working on.
For example, when working in an Orifice Properties window, you may wish to quickly check the upstream
and downstream pipe diameters previously defined. Holding down the right mouse button on each connected pipe ID number will show you that pipe's primary input parameters.
The Inspection feature works similarly in Pipe Properties windows when you inspect connected junctions. Judicious inspecting can save you time when assembling or debugging a model.
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Figure 1: Inspecting from the Workspace with right mouse button

Related Topics
Pipes
Creating Pipes - the Pipe Drawing Tool
Join or Split Pipes
Connecting Objects
Moving Objects
Editing Objects
Defining Objects
Highlight Required Input
Notes
Status
Junctions
Morphing Junctions
Moving Pipe and Junction Labels

177
162
164
166
167
168
169
171
174
174
206
169
175

Related Blogs
AFT Responds to 2020 Customer Survey Feedback
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Notes
Each object can have notes associated with it. This is useful for listing assumptions, reference documents, drawings, measurements, etc.

Related Topics
Pipes
Creating Pipes - the Pipe Drawing Tool
Join or Split Pipes
Connecting Objects
Moving Objects
Editing Objects
Defining Objects
Highlight Required Input
Inspecting Objects
Status
Junctions
Morphing Junctions
Moving Pipe and Junction Labels

177
162
164
166
167
168
169
171
172
174
206
169
175

Status
The status tab lists all undefined parameters that are required to define the pipe or junction.

Related Topics
Pipes
Creating Pipes - the Pipe Drawing Tool
Join or Split Pipes
Connecting Objects
Moving Objects
Editing Objects
Defining Objects
Highlight Required Input
Inspecting Objects
Notes
Junctions
Morphing Junctions
Moving Pipe and Junction Labels

177
162
164
166
167
168
169
171
172
174
206
169
175
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Workspace Pan
The user can use Workspace Pan mode to move around, or pan, the model. If the Workspace has been
enlarged beyond the default one screen size (Workspace scrollbars will be visible), then the Workspace
can be panned by activating Workspace Pan mode. There are several ways to activate Workspace Pan
Mode:
l

Click the Workspace Pan button (represented with a hand icon) on the toolbar

l

Select the Workspace Pan option in the View menu

l

If your mouse has a center button (a scroll wheel), hold the scroll wheel button down

l

Hold CTRL and use the arrow keys

Once in pan mode, the cursor will change to an open hand that can be used to grab and move a point in
the Workspace. The Workspace can be panned by holding down the left mouse button (if the Workspace
Pan mode has been activated using the Workspace Pan button on the toolbar or the Workspace Pan
option has been selected in the View menu) and moving the mouse in the desired direction, or by holding
down the mouse scroll wheel (if using the scroll wheel to keep Workspace Pan mode activated) and moving the mouse in the desired direction.
To switch off the pan mode, click the mouse scroll wheel or the Workspace Pan button on the toolbar a
second time. If Workspace Pan mode is maintained using the mouse scroll wheel, it will automatically
turn off once you release the mouse scroll bar.

Related Topics
Moving Pipe and Junction Labels

175

Related Blogs
AFT Responds to 2020 Customer Survey Feedback

Moving Pipe and Junction Labels
Each pipe and junction on the Workspace also displays text (or label) referring to the number and/or
name of the object. This label can be dragged to improve model aesthetics. AFT Arrow keeps track of the
relative location of the label to the object so that if the object is moved, the label moves with it.

Returning Label to Default Location
To return the label to its default location, you can:
l

Right-click the label for an individual object and choose Reset Label Location

l

Use Arrange -> Reset Label Locations and respond to the dialog

- 175 -

Global Edit

Related Topics
Junctions
Connecting Objects
Moving Objects
Editing Objects
Morphing Junctions
Defining Objects
Highlight Required Input
Inspecting Objects
Notes
Status
Workspace Pan

206
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174
174
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Special Conditions
Some junctions have Special Conditions that alter the normal state of the junction. For example, a valve
can be closed, a compressor/fan turned off, or a relief valve opened. Pipes can also be set closed which
will effectively close the pipe to flow at both ends.
The special conditions are set in one of three ways:
l

By selecting the junction(s) or pipe(s) on the Workspace and choosing Special Conditions from
the Edit Menu

l

By selecting the junction(s) or pipe(s) on the Workspace and clicking the Special Condition icon
on the Toolbar

l

By opening the junction’s or pipe’s Properties window and clicking the appropriate condition on
the Optional tab

The pipes or junctions that have special conditions set are shown using a special symbol before the ID
number (an “X” by default). This symbol can be customized in the Tools/User Options window.
When the special condition results in a section of the model being closed or “turned off”, the pipes which
will have zero flow are displayed as dotted lines. This indicates visually that they are cut off from flow; the
junctions are outlined with a dotted line. The default dotted line can be changed in the Tools/User
Options window.
The user can specify Special Conditions for Control Valves to be either closed or fully open. Similarly
compressor/fans can be turned off and either allow flow through or stop the flow.

Related Topics
Optional Input for Junctions
Optional Input for Pipes
Turn Off Parts of the Model

213
201
690
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Pipes
This section focuses on specifying and modifying the Pipe object in the AFT Arrow Workspace. Topics
include an overview of the Pipe Properties window, how to input pipe specification data, a description of
the methodology used for heat exchange within pipes for AFT Arrow, and how to insert fittings and losses
within the pipes.

Contents
Pipe Properties Window

177

Common Pipe Input Parameters

178

Pipe Model

179

Fittings & Losses

181

Heat Transfer in Pipes Overview

183

Insulation for Pipes

200

Optional Input for Pipes

201

Add/Remove Pipe Segment

202

Reverse Direction

203

Pressure Drop in Pipes Detailed Discussion

203

Pipe Properties Window
Each pipe on the Workspace has engineering information associated with it. Each pipe must have an ID
number, a length, a diameter, a roughness specification, heat transfer conditions, and two connecting
junctions. If the pipe is not purely cylindrical, additional geometry information is also required.

Related Topics
Pipes
Common Pipe Input Parameters
Pipe Model
Fittings & Losses
Heat Transfer in Pipes Overview

177
178
179
181
183
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Insulation for Pipes
Optional Input for Pipes
Add/Remove Pipe Segment
Reverse Direction
Pressure Drop in Pipes Detailed Discussion
Pipe X length is shorter than the elevation change

200
201
202
203
203
675

Common Pipe Input Parameters
The common input parameters are located above the tabs in the Pipe Properties window.

Number
Every pipe must have a unique ID number. When new pipes are created, a pipe number is automatically
allocated.
The pipe number can be changed by the user to any unique value greater than zero and less than
100,000. Pipe numbers are only identifiers and have no affect on the model behavior.

Name
A name can be assigned to each pipe for reference purposes. The default name is simply “Pipe.” Names
do not need to be unique. The name can be shown on the Workspace, in the Visual Report and in the Output window.

Copy Data From Pipe...
The Copy Data From Pipe dropdown list allows you to copy all or some of an existing pipe’s properties to
the current pipe. Selecting an existing pipe will prompt the user on what parameters should be changed.
The Copy Previous button functions similarly, copying parameters from the previously edited pipe.
In child scenarios, Copy Data From Pipe lists "Parent Pipe Data," allowing the user to copy all or some
parameters from the parent pipe.

Connected Junctions
All pipe objects have a reference positive direction, as indicated on the Workspace by an arrow in the center of the pipe. The upstream and downstream junctions are identified with this direction. The connected
junctions area displays these junctions. Every pipe must be connected to two junctions in order to be
completely defined.

Related Topics
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Pipes
Pipe Properties Window
Pipe Model
Fittings & Losses
Heat Transfer in Pipes Overview
Insulation for Pipes
Optional Input for Pipes
Add/Remove Pipe Segment
Reverse Direction
Pressure Drop in Pipes Detailed Discussion

177
177
179
181
183
200
201
202
203
203

Pipe Model
Size
The size section of the Pipe Model tab specifies the pipe geometry.
l

l

l

Pipe Material
l

User Specified - If selected, the geometry of the pipe must be directly specified.

l

Library Material - Many common pipe materials are included in the standard pipe material
library. These and any other accessible library materials can be selected. When a library
material is selected, the parameters defining the geometry cannot be modified.

Pipe Geometry - Several pipe geometries can be modeled. The critical value for flow calculations
is hydraulic diameter, based on cross-sectional area Ac and wetted perimeter Pw:

l

Cylindrical Annulus - Flow in an annulus or "ring" pattern. This requires both an outer and
inner diameter to calculate hydraulic diameter.

l

Cylindrical Pipe (default) - A typical pipe. The hydraulic diameter and inner diameter are
identical

l

Helical Tube - Requires hydraulic diameter and coil diameter. Specification of this geometry affects the friction model pressure loss.

l

Noncylindrical Pipe - Requires flow area (cross-sectional area) and wetted perimeter to
calculate hydraulic diameter.

l

Rectangular Duct - Requires width and height to calculate hydraulic diameter.

Size - Select from a list of defined nominal sizes for the selected Pipe Material. Only available for
library materials.
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l

Type - Select from a list of defined types (classes/schedules) for the selected Pipe Material. Only
available for library materials.

l

Geometric Specification - Several required fields that change depending on the selected Pipe
Geometry. Only editable for User Specified Pipe Material.

l

ID Reduction (Scaling) - Reduction in hydraulic diameter due to scaling can be accounted for by
entering a percent reduction in this field. Zero represents no reduction.

Length
The Length of the pipe between the two connecting junctions. This length has no relationship to the
visual length of pipe drawn on the Workspace.
Model As Zero-length Connector can be checked to use the pipe to represent a lossless connection
between two junctions, such as for two components that are directly welded together.

Friction Model
Multiple friction data sets can be compiled for each library pipe material. These different data sets are
then made available in the Data Set drop down list. For AFT standard materials, the friction data set is
generally "Standard."
The Friction Model can be modified for any individual pipe, and the default friction model can be set in
Parameter Options. The Friction Model for a library material can be modified by selecting the User Specified radio button in Data Set, and must be directly specified for User Specified materials.
l

Absolute roughness (default) - Absolute average roughness height. Values of pipe roughness
can be found in many pipe handbooks or from manufacturer's data.

l

Relative roughness - Relative roughness is the absolute roughness divided by the pipe diameter.

l

Hydraulically smooth - Hydraulically smooth implies that roughness is negligible. This is not the
same as frictionless.

l

Explicit Friction Factor - Friction factor for the pipe, you can enter the value explicitly.

l

Frictionless - For troubleshooting purposes, it is occasionally useful to model a pipe as having no
friction. There are limitations to where such a pipe can be located in your model.

l

Weymouth equation - A model for natural gas pipelines under fully turbulent flow, using pipe diameter to characterize pressure loss.

l

Panhandle equation - A model for natural gas pipelines, using Reynold's Number to characterize pressure loss.

For detailed information on how these Friction Models are defined, see Pressure Drop in Pipes - Detailed
Discussion.

Related Topics
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Pipes
Pipe Properties Window
Common Pipe Input Parameters
Fittings & Losses
Heat Transfer in Pipes Overview
Insulation for Pipes
Optional Input for Pipes
Add/Remove Pipe Segment
Reverse Direction
Pressure Drop in Pipes Detailed Discussion

177
177
178
181
183
200
201
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203

Fittings & Losses
Fittings & Losses allows the user to define additional losses directly in a pipe. This is useful to account for
pressure losses without modeling large numbers of elbows or similar fittings.
To specify library losses, click Specify Fittings & Losses to open the Pipe Fittings & Losses window. An
additional K Factor loss can also be user specified.

Pipe Fittings & Losses
The Fittings & Losses library contains many standard loss values. Because many of these values are
dependent on pipe diameter, a pipe diameter must be specified to open the Pipe Fittings & Losses window.
Losses are divided into several categories represented by tabs. To add fittings to the pipe, select the
type, and adjust the quantity column next to the desired fitting.
After accepting the changes by clicking OK, a summary of the pipe's Fittings & Losses will be displayed
in the pipe's properties window.
Note: Area Change fittings do not change the size of the pipe, they only represent the loss factor
based on the pipe diameter and the area ratio of the loss. When including area changes, notice
the illustration of how the loss is defined, where Apipe is the area of the pipe and As is the area of
the loss. These area changes are useful to model fittings between a pipe and another junction
like a compressor/fan or heat exchanger.
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Figure 1: Pipe Fittings & Losses

Fittings & Losses Workspace Symbol
When a pipe has any loss value assigned through the Fittings & Losses tab, a symbol (default of &) is
added before the pipe number.

Favorite Fittings & Losses
In the Pipe Fittings & Loses window, there is a column labeled Favorite for each of the loss types. Check
the box for favorite to add it to the list of favorite fittings and losses. On the left side of the window there
are several options to filter the list. For example, one may only want to see Crane fittings. In which case,
Crane should be checked, and all others unchecked on the left hand side of the window. If a list of only
favorite fittings is desired, check the box to "Show Favorites Only".

Related Topics
Pipes
Pipe Properties Window
Common Pipe Input Parameters
Pipe Model

177
177
178
179
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Heat Transfer in Pipes Overview
Each pipe responds thermally to the environment outside of the pipe. AFT Arrow offers several models
that allow you to model the heat transfer characteristics of a pipe:
l

Adiabatic (Perfectly Insulated) - An adiabatic pipe is one that has perfect insulation and thus no
heat transfer takes place. This model differs from Isothermal in that the temperature into the pipe
is taken from the upstream junction. This is the default model. Insulation data can be entered but
is not used for thermal purposes.

l

Isothermal - The Isothermal model maintains the pipe at the specified temperature. Insulation data
can be entered but is not used for thermal purposes.

l

Convective Heat Transfer - This model allows you to specify heat transfer data for the internal
fluid, pipe wall, three layers of insulation and external convection.

l

Convective Heat Transfer and Heat Flux - This model allows you to model convective heat transfer while also specifying a constant heat flux.

l

Convective Heat Transfer with Heat Tracing - This represents adding some type of heating layer
onto the pipe's outer surface. The amount of heating may be entered as a constant heat flux or by
providing information on the power and number of wire turns. Insulation layers can then be added
on top of the heat tracing (heat flux source).

l

Constant Heat Flux - The constant heat flux model is useful in cases where the temperature difference between the fluid and the ambient environment is extremely large or in cases where a
large radiant heat flux exists. Insulation data can be entered but is not used for thermal purposes.

l

Constant Heat Rate – This model allows you to specify a constant heat rate into or out of the pipe.

l

Buried Pipe - This model allows you to specify that the pipe is buried in a thermally conductive
medium.

Note that similar to flow rate definition, heat flow is positive when flowing into the pipe, and negative when
flowing out.

Viewing Calculated Thermal Results in Output
A table is displayed in the Output window Pipe area showing the temperature distribution in the pipe and
insulation.
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Figure 1: Thermal Data table in Output window Pipe area shows temperature distribution in pipe

Clicking the button next to Show brings up a Results Diagram for that particular pipe:

Figure 2: Pipe Heat Transfer Results Diagram

Related Examples
Control Valve

734

Related Topics
Pipes
Pipe Properties Window

177
177
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Constant Heat Transfer
There are 4 thermal models for pipes in AFT Arrow which fix the thermal behavior of the pipe to some constant value
l

Adiabatic (Perfectly Insulated) - The heat transfer between the pipe and the environment is
fixed to zero. The entire length of the pipe will have a stagnation enthalpy equal to that of the
upstream junction. The actual fluid temperature depends on the system.

l

Isothermal - The fluid temperature is set to a specified value. Heat transfer is still modeled in this
case - instead of varying the fluid temperature, the heat rate into or out of the pipe is found that satisfies the isothermal constraint.

l

Constant Heat Flux - A constant heat flux (heat rate per area) is applied to the pipe. Positive values indicate heat entering the pipe. Flux is often a more readily available and flexible value for
some conditions, such as radiation heat transfer. For this model, the heat flux is applied to the
area defined by the ID of the pipe. To model a heat flux underneath insulation, use the Convective
Heat Transfer with Heat Tracing model.

l

Constant Heat Rate - It may also be known that a certain pipe transfers (or needs to transfer) a
specific heat rate, regardless of the size of the pipe. This model allows the specification of a constant energy per time into or out of the pipe.

The above models follow a common format on the Pipe's Heat Transfer tab, as shown below. There is
only one required value input unless insulation is added. One layer of insulation (external or internal) can
be added, with conductivity values from a library or User Specified in this window.

Figure 1: Constant Heat Flux
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Related Topics
Heat Transfer in Pipes Overview
Convective Heat Transfer
Buried Pipe Heat Transfer
Heat Transfer In Pipes - Detailed Discussion
Heat Tracing Flux Based On Wire Turns And Length.html
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Related Blogs
Let the Heat Flow: Modeling Heat Transfer in Pipes in AFT Fathom and AFT Arrow

Convective Heat Transfer
There are 3 convective based models for pipe heat transfer:
l

Convective Heat Transfer - Represents a pipe thermally affected solely by convection.

l

Convective Heat Transfer and Heat Flux - Behaves the same as the Convective Heat Transfer
model, but also includes the effect of an external heat flux such as radiation.

l

Convective Heat Transfer with Heat Tracing - Similar to the Convective Heat Transfer and
Heat Flux model, but instead of applying the flux on the outermost surface of the pipe/insulation,
the flux can be applied directly to the pipe. As the name suggests, this represents a device such
as a heated wire. If the flux is not known directly, it is easy to determine based on Wire Turns and
Length.

Defining the Convective Model
When one of the convective heat transfer models is selected, there are a number of items that must be
defined:
l

Resistance Geometry - Radial or Linear

l

Number of Insulation Layers - There can be up to three layers of insulation defined, in any combination of internal or external.

l

External Heat Flux - Only available if Convective Heat Transfer and Heat Flux is selected. A constant flux applied to the outermost layer of resistance.

l

Heat Tracing on Pipe (Flux) - Only available if Convective Heat Transfer with Heat Tracing is
selected. A constant flux is applied at the outer wall of the pipe.

l

Ambient Conditions - The temperature and velocity of the fluid around the pipe. The fluid can be
either air or water. These values are used for calculating the convection coefficient if correlation is
selected as the convection Data Source. This correlation can be used for pipes over which boundary layers develop freely, free of constraints imposed by other surfaces. All of the external fluid
properties are evaluated at the film temperature using data from NIST REFPROP.
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l

Resistance Table - The table at the bottom of the window defines all of the resistance layers used
in the thermal model.
l

l

Rows
l

Units - This special row defines the units of any value in the column below a cell.

l

Fluid Internal - The fluid itself has a convection coefficient that affects the transfer
of energy to the pipe wall. By default, the Gnielinski Correlation is used to determine
this value. Alternatively, the Dittus-Boelter Correlation can be used, or a User Specified value can be entered.

l

Pipe Wall - The wall of the pipe has a thermal conductivity that affects the heat transfer. The built-in pipe materials have thermal conductivity values defined, and this
value is automatically selected. If a User Specified pipe is used, the conductivity will
need to be entered.

l

Insulation - There can be several insulation rows, depending on the selection of
Number of Insulation Layers. The Insulation can be selected from the Insulation library, in which case the conductivity is read from the library. User Specified insulation
requires this value to be defined.

l

External - Convection occurring external to the pipe and any insulation layers. By
default the Convection Coefficient is calculated with the Churchill-Bernstein Correlation. The Correlation can also be set to Free-Horizontal or Free-Vertical which
requires only an ambient temperature, and no fluid velocity. The Free Horizontal and
Free Vertical orientations are in reference to the orientation of the pipes. If the convection coefficient is known, a value can be entered by the user.

Columns
l

Apply - This can allow enabling/disabling of including certain layers in the calculation. This is useful for comparing states or scenarios without redefining the
thermal model.

l

Conductivity/Convection Data Source - Specifies from where relevant information is attained. This can be a Library, Correlation, or User Specified.

l

Conductivity - Applies to the Pipe Wall and Insulation. If Data Source is a Library,
the particular insulation must be selected. If User Specified, the conductivity must be
entered. Note that obtaining the thermal conductivity from an insulation or pipe
material library permits temperature dependent thermal conductivity to be
employed. With this option, AFT Arrow dynamically selects the insulation thermal
conductivity during model solving based on the local temperatures that exist. Conversely, user specified values are always constant.

l

Thickness - Applies to Pipe Wall and Insulation. If a Library is used for the Pipe
Material, this value is automatically populated. All insulation layers require a thickness.

l

HT Area Ratio - This represents any "extra" heat transfer area that may exist. For
example, if the pipe has cooling fins this ratio would be larger than one.

l

Convection Coefficient - Applies to Fluid Internal and External. Both values can be
either Correlation or User Specified.
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Figure 1: Convective Heat Transfer Layout

Modeling a Constant Wall Temperature
Assign an ambient temperature and disable the External Resistance by unchecking the box in the Apply
column. This will force the outside wall of the pipe to be equal to the ambient temperature. Note that this
differs from isothermal in that the fluid temperature can still change - only the outside wall of the pipe has
a fixed temperature.

Related Topics
Heat Transfer in Pipes Overview
Constant Heat Transfer
Buried Pipe Heat Transfer
Heat Transfer In Pipes - Detailed Discussion
Heat Tracing Flux Based On Wire Turns And Length.html
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Related Examples
Control Valve
Natural Gas Burner
Compressed Air System
Process Steam System
Air Blower Sizing
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Related Blogs
Let the Heat Flow: Modeling Heat Transfer in Pipes in AFT Fathom and AFT Arrow

Buried Pipe Heat Transfer
Buried Pipe Heat Transfer follows a form very similar to the Convective Heat Transfer models.

Figure 1: Buried Pipe Window

The differences between convective heat transfer and buried pipe heat transfer are:
l

The Ambient Conditions are now the Soil Surface Temperature and Buried Pipe Depth. Specifically, the Soil Surface Temperature asks for the temperature of the soil at the ground surface
(as opposed to the ambient air temperature), while the Buried Pipe Depth asks for the distance
between the ground surface and pipe centerline.

l

The External Resistance Type is replaced with Soil. This requires a User Specified value of conductivity for the soil

Related Topics
Heat Transfer in Pipes Overview
Constant Heat Transfer
Convective Heat Transfer
Heat Transfer In Pipes - Detailed Discussion
Heat Tracing Flux Based On Wire Turns And Length.html

183
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186
193
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Heat Tracing Flux Based On Wire Turns And Length.html
The Convective Heat Transfer with Heat Tracing model requires the user enter additional information to
represent the thermal effect of a heat tracing.
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Arrow allows users the ability to model Heat Tracing by either entering the heat flux directly, or by providing information on the number of turns and power per unit length of wire, which Arrow will use to determine the heat flux as described below.

Figure 1: Pipe Properties window with the Conv. Heat Transfer with Heat Tracing model enabled

Power and Turns - Detailed Discussion
When you select the option to model Heat Tracing based off a heated wire, Arrow models that heat flux
based on the theory described below.

Figure 2: Wire tracing geometry
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Length of Wire
First, it may be necessary to determine the length of the wire itself, based on a number of turns.
l

N - total number of turns on the pipe

l

n - number of turns per unit length

l

LPipe - total length of the pipe

l

r - external radius of the pipe

l

LWire - length of the wire

l

LTurn - length of one wire turn

The above figure shows a pipe with heat tracing that has been "split open" and laid into a flat rectangle to
make these equations more intuitive.
The total turns and turns per length are related by the pipe length:

Each turn of the wire creates a right triangle on the "flattened" pipe, so we can find the length of each segment by the Pythagorean theorem.

The total length of the wire is related to the number of turns and the segment length.

Incorporating this relationship and rearranging:

Using the number of turns per unit length:

or:
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Flux of Wire
With the length of the wire found, the flux based on power per length can be found.
l

PTotal - total power usage of the wire, along the entire pipe length

l

p - power per unit length

l

Q'' - heat flux

l

A - area heat flux is applied to

The heat flux is defined as the heat delivered per area. Here, we assume that the "total power" used by
the heat trace is equivalent to the total heat delivered. Therefore:

The total power is equal to the power per length times the length, and area is related to pipe geometry:

Substituting in for LWire:

Simplifying:
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Heat Transfer In Pipes - Detailed Discussion

Figure 1 - Diagram of a pipe with Heat Tracing and Insulation

There are many possible combinations of heat transfer that can be defined in AFT Arrow. In any of these
models there are various heat flows that can be considered.
Figure 1 shows the heat rates for one of the more complex cases – convective heating with a heat trace
on the outer face of the pipe wall. Because this is a steady-state problem, any control volume that is
drawn around sub-sections or the entire section must have entering heat equal to leaving heat.
Balancing these heat rates and temperatures via iterative methods allows AFT Arrow to come to a
unique solution.

Heat Rates
As a hydraulic solver, the primary heat rate of interest is
heat to the fluid has the effect of raising its temperature.
We can derive an expression for
specific quantities (per unit mass)

, the heat added to the fluid itself. Adding

with the first law of thermodynamics. For convenience, we use
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The energy e is composed of internal energy u and kinetic energy V2/2. Note that the gravity term gz is
neglected from this equation to simplify the derivation.

The work done by the fluid is comprised of pressure work pv and shaft work wshaft

Combining and rearranging

Using the definition of enthalpy

In this analysis, we consider that the velocity through the control volume remains constant. In reality,
changing temperature will cause the density of the fluid to change, and thus the velocity. For this reason,
pipes in AFT Arrow are thermally sectioned. This means that certain properties are considered constant
throughout the section as an approximation – having several sections in a pipe helps increase the accuracy of this approximation.
There is also no shaft work being done on the fluid.

We further assume that this can be treated thermodynamically as a constant pressure process. That is,
cp is constant in the thermal section, like density. With this assumption we can use the relationship
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To find that

Rather than using specific quantities, it is useful to relate heat rate and mass flow. Multiply both sides by
ṁ

The other heat rates in the system can be related to

and other user defined values like

or

by examining various control volumes and surfaces:

We now have a system of equations that allow us to determine all the heat rates in the system given a
mass flow (determined from a mass balance), a specific heat (defined versus temperature) and a change
in temperature. However, we do not know what this change in temperature is. To find it, we need to relate
the surface temperatures to the heat rates.

Surface Temperatures and Resistance
Thermal resistances are useful because they directly relate the heat rate between two points with the
temperature between those points.

The value of resistance depends on the mechanism of heat transfer
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For conduction, the area and thus resistance changes with increasing r, so an integration must be done

These resistances can all be calculated with user-defined data. AFT Arrow helps simplify this by offering
several correlations that can be used to determine the heat transfer coefficients in the above equations
from more readily available parameters.
With resistances and
, all the surface temperatures can be determined. By bounding the system
with a given Tambient we can work outside in to find the required Tfluid to obtain those heat rates.
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If the result for Tfluid matches the values used for ΔTfluid used for determining
, the correct solution
has been found. If they are different, ΔTfluid needs to be adjusted and the process repeated until reaching
a stable solution.

Overall Heat Transfer
Wherever there are sequential thermal losses, it is convenient to combine these losses. This is straightforward:

Additionally, an overall heat transfer coefficient U can be defined which behaves similarly to h or k

Using the heat rate and resistance relationship, as well as the fact the heat transfer is into the fluid

Transforming the equation into a differential form on radius and length
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Rearranging and integrating

We arrive at an expression relating the temperature change along the pipe and temperature change
through the pipe:

Correlations
Thermal resistances depend on the conduction and convection coefficients k and h which can be directly
specified or calculated via a correlation.
The convection coefficient for internal fluid convection can be calculated with the Gnielinski Correlation
or the Dittus-Boelter Correlation which can be seen in Incropera. These correlations determine the Nusselt number of the fluid – a ratio of convective to conductive heat transfer. Conductive properties are
required input – with a Nusselt number and conductivity defined, the convection coefficient can be calculated.

These correlations also make use of the Prandtl number, a ratio of viscous diffusion to thermal diffusion.
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Gnielinski

Dittus-Boelter

External convection behavior differs from the above. AFT Arrow provides the Churchill-Bernstein correlation for determining a convection coefficient from ambient temperature and fluid velocity. This correlation can be used for pipes over which boundary layers develop freely, free of constraints imposed by
other surfaces. All of the external fluid properties are evaluated at the film temperature.

Buried Pipe Heat Transfer
Buried Pipe heat transfer is modeled by solving directly for the thermal resistance of the soil layer. AFT
Arrow uses a model developed by Eckert and Drake to directly calculate the thermal resistance of soil on
top of a pipe for use in the overall thermal resistance network:

In this model, z is the distance between the ground surface and the pipe center-line, while r is the outside
radius of the pipe.

Related Topics
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Heat Tracing Flux Based On Wire Turns And Length.html
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Related Blogs
Let the Heat Flow: Modeling Heat Transfer in Pipes in AFT Fathom and AFT Arrow

Insulation for Pipes
Insulation data can be entered on the Heat Transfer tab of a pipe. The insulation data is only included in
the heat transfer calculations if a convective heat transfer model is entered. It may be entered for other
heat transfer models, but will only be used for cost calculations.
See Heat Transfer in Pipes for more details.

Related Topics
Pipes
Pipe Properties Window
Common Pipe Input Parameters
Pipe Model
Fittings & Losses
Heat Transfer in Pipes Overview
Optional Input for Pipes
Add/Remove Pipe Segment
Reverse Direction
Pressure Drop in Pipes Detailed Discussion
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Related Examples
Control Valve
Process Steam System

734
761

Related Blogs
Let the Heat Flow: Modeling Heat Transfer in Pipes in AFT Fathom and AFT Arrow
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Optional Input for Pipes
Initial Flow Guess
The Initial Flow Guess for a pipe can be specified. An appropriate initial guess can decrease the number
of iterations required to arrive at a converged solution.
The Solver generates initial guesses on its own, which is usually sufficient to produce a converged solution. If this is not the case, user defined guesses can help obtain a solution.

Parallel Pipes
A single pipe object can be specified as a number of parallel pipes. When multiple pipes are defined, the
parameters in the pipe properties window represent only one of the parallel pipes.

Display on Workspace
By default, only the pipe number is displayed on the Workspace. In addition to this, the pipe name, nominal size, and type/schedule can be displayed.

Design Factors
A design factor can be used to add safety margins into the hydraulic analysis. For pipes, three design
factors exist:
l

Pipe Friction: friction factor is multiplied by the design factor assigned to the pipe.

l

Pipe Fittings & Losses: total loss factor (K-factor) is multiplied by the design factor assigned to
the pipe.

l

Pipe Heat Transfer: the thermal resistance for each heat transfer layer is divided by the design
factor assigned to the pipe.

Special Condition
The Special Condition for the pipe can be set to None or Closed. Setting this to closed prevents flow
through the pipe, like closing a valve. A symbol (default of "X") will be placed before the pipe label and the
pipe will appear dashed, indicating that it is closed.

Pipe Line Size and Color
Each pipe may have its line size and color changed from the defaults configured in Parameter Options.
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Related Topics
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Optional Input for Junctions
Turn Off Parts of the Model
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Pipe Properties Window
Common Pipe Input Parameters
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Add/Remove Pipe Segment
Visual segments can be added to pipes.
To add or remove segments, use the Arrange > Pipe Segments submenu. These options are also available on the Workspace Toolbar.
Note: These segments are useful for creating a clear layout of the system, but have no impact on the
solution - a visual "bend" is not the same as adding a Bend junction. See discussion in Creating
Pipes - the Pipe Drawing Tool for more information.

Related Topics
Pipes
Pipe Properties Window
Common Pipe Input Parameters
Pipe Model
Fittings & Losses
Heat Transfer in Pipes Overview
Insulation for Pipes
Optional Input for Pipes
Reverse Direction
Pressure Drop in Pipes Detailed Discussion
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Reverse Direction
Next to each pipe's ID number is an arrow that indicates the reference positive flow direction for the pipe.
AFT Arrow assigns a flow direction corresponding to the direction in which the pipe is drawn. You can
reverse the reference positive flow direction by choosing Reverse Direction from the Edit menu or selecting the reverse direction button on the Toolbar.
The reference positive flow direction is used for reference purposes only and need not be the actual flow
direction. If the reference positive direction is the opposite of that obtained by the Solver, the output will
show the flow rate as a negative number.

Related Topics
Pipes
Pipe Properties Window
Common Pipe Input Parameters
Pipe Model
Fittings & Losses
Heat Transfer in Pipes Overview
Insulation for Pipes
Optional Input for Pipes
Add/Remove Pipe Segment
Pressure Drop in Pipes Detailed Discussion
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Pressure Drop in Pipes Detailed Discussion
Depending on the pipe friction model selected, the calculation of pressure drop in a pipe differs.

Darcy-Weisbach Loss Model
Note: The pressure drop for compressible flow depends on several equations, as discussed in
Review of Compressible Flow Theory. The effect of pipe friction is taken into account as part of
the full compressible method. The Darcy-Weisbach pressure loss equation for incompressible
flow is shown below for simplicity.
AFT Arrow utilizes the Darcy-Weisbach loss model to relate the Darcy Friction Factor, the pipe geometry,
fluid density, and fluid velocity to pressure drop in the pipe. The Darcy Friction Factor differs from the Fanning Friction Factor by a factor of 4.

This model requires the calculation of a friction factor, accomplished by various methods as described
below.
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l

Roughness-Based Methods - This method calculates the friction factor based on the roughness
of the pipe wall. Different equations are used based on flow regime - laminar flow uses the standard laminar relationship, while turbulent flow uses the implicit Colebrook-White equation. In the
transition range between laminar and turbulent flow, a linearly interpolated value is used. The
default transition Reynold's Numbers can be modified in the Environmental Properties panel.

l

Absolute Roughness (default) - The absolute average roughness height ε is specified directly.

l

Relative Roughness - The roughness is specified as a ratio ε/D.

l

Hydraulically Smooth - The ratio ε/D is set equal to zero.

l

Explicit Friction Factor - The friction factor to be used in the Darcy-Weisbach equation is specified directly.

l

- A model for natural gas pipelines under fully turbulent flow, using pipe diameter to characterize
pressure loss. The full form of the Weymouth equation relates flow to pressure drop, specific gravity, pipe length, and temperature. Crane (page 1-8) presents an equivalent form using friction
factor:

Note: Crane indicates that this friction factor is "identical to the Moody friction factor in the fully turbulent range for 10-inch I.D. pipe only. Weymouth friction factors are greater than Moody factors
for sizes less than 20-inch, and smaller for sizes larger than 20-inch."
l

Panhandle Equation - A model for natural gas pipelines, using Reynolds Number to characterize
pressure loss. Valid for pipes 6 to 24 inch diameter, Reynolds Numbers 5E6 to 14E6 and specific
gravity of 0.6. The full form relates flow to a flow efficiency factor, diameter, pressure drop, and
pipe length. Similar to the Weymouth model, Crane (page 1-8) presents an equivalent form using
friction factor:
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Note: Crane indicates: "In the flow range to which the Panhandle formula is limited, this results in friction factors that are lower than those obtained from either the Moody data or the Weymouth friction formula."

Frictionless
The pipe will not have any pressure drop across it. This is inherently unrealistic behavior, but can be useful for troubleshooting purposes.

Helical Tubes
For helical tubes the pressure drop is modified from the equivalent "straight pipe" pressure drop via the
following relationship (Ito 1959):

Design Factors
In each pipe you can specify a Design Factor for the pipe friction. This is a multiplier that is applied to the
friction factor calculated with the preceding methods.

Related Topics
Pipes
Pipe Properties Window
Common Pipe Input Parameters
Pipe Model
Fittings & Losses
Heat Transfer in Pipes Overview
Insulation for Pipes
Optional Input for Pipes
Add/Remove Pipe Segment
Reverse Direction

177
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179
181
183
200
201
202
203
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This section focuses on the Junctions in the AFT Arrow workspace as well as the theories that govern the
junctions. Topics included discuss the types of junctions that AFT Arrow provides, the required inputs for
each junction, and theory topics that indicate how the inputs to the junction are used.

Contents
General Junction Information
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Junction Loss Models
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General Junction Information
The different types of junctions on the Toolbox offer a great degree of freedom in assembling a pipe network model. While there is some redundancy in capabilities between the junctions, each of the junctions
offers specialized features to allow you to prepare a good conceptual model of the physical system of
interest. Table 1 compares the features of the junction types.
There is a junction properties window for each junction type. Each junction Properties window falls into
one of two basic window formats, depending on the number of connecting pipes allowed for that junction
type.
Note: AFT Arrow does not prevent negative flow through junctions. Should this occur, AFT Arrow will
use the same loss factor or pressure drop data referenced to the defined upstream pipe, just as
in forward flow. Because it is possible that the loss factor or pressure drop data would not be the
same for both flow directions, the flow solution could be misleading. For this reason it is important that you either properly define the pipe flow directions for junctions or pay close attention to
the flow directions that result. Should negative flow occur in any junction, AFT Arrow will give a
caution in the output.
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Table 1: Comparison of junction capabilities

Junction Type

Connecting
Pipes

Special Conditions

CdA

Custom Library

Window
Format

Area Change

2

Yes

Yes

1

Assigned Flow

1

Yes

1

Assigned Pressure*

1/1-25

Yes

Yes

1

Bend/Elbow

2

Yes

Yes

1

Branch

2-25

Yes

Yes

2

Check Valve

2

Yes

Yes

1

Compressor/Fan

2

Yes

Yes

1

Control Valve

2

Yes

Yes

1

Dead End

1

General Component

2

Yes

Heat Exchanger

2

Yes

Orifice

1-2

Relief Valve

1-2

Screen

2

Separator

2

Yes

Spray Discharge

1-4

Yes

Tank

1-25

Tee/Wye**

3

Valve

1-2

Venturi

2

Yes

Yes

1

Yes

Yes

Yes

1

Yes

1

Yes

Yes

1

Yes

Yes

1

Yes

Yes

1

Yes

1

Yes

1

Yes

2

Yes

2**
Yes

Yes

Yes

1

Yes

Yes

1

*Assigned Pressure Junction connects to only one pipe for static pressure, and up to 25 for stagnation
**Tee/Wye junction has a unique format closer to Format #2
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Two Window Formats
Format #1: Junctions with One or Two Connecting Pipes
The first basic window format is for junction types that allow only one or two connecting pipes (see Figure
1). While junctions do not have an explicitly defined flow direction like pipes do, typically those with two
pipes or less adopt a direction from the connecting pipes. For these junction types, upstream and downstream pipes are recognized by AFT Arrow based on the reference positive flow direction of the connecting pipes. The upstream and downstream pipes are displayed separately near the top of the window.
In this first basic window type, it is generally important to have the pipes' reference positive flow directions specified in the physically correct directions. A good example of this is a Compressor/Fan junction which will add pressure to the system in the direction of positive flow through the connecting pipes.
The Compressor/Fan junction interprets where to add the pressure based on the directions of the connecting pipes.
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Figure 1: Properties window format #1 (fixed connecting pipe display)

Format #2: Junctions with More Than Two Connecting Pipes
The second basic window format for junction Properties windows is for junctions that allow more than two
connecting pipes (see Figure 2). These junctions typically allow up to twenty-five connecting pipes;
except for the Tee/Wye junction, which allows only three.
Because the number of pipes connected to a junction may vary, the second basic format uses a table
sized according to the number of connecting pipes.
An example of this second window format is the Branch Properties window, shown in Figure 2, which has
three connecting pipes. To determine AFT Arrow's interpretation of the model connectivity for this
second window format, you can review the contents of the table areas.
K-factors in the first column will be applied for flow into the pipe and out of the junction, while K-factors in
the second column will be applied for flow out of the pipe and into the junction.
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Figure 2: Properties window format #2 (pipes displayed in a table)

Related Topics
General Junction Information
Common Junction Input Parameters
Optional Input for Junctions
Specifying Losses
Convention for Specifying Base Area
Reference Density
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Common Junction Input Parameters
Number
Every junction must have a unique ID number. When new junctions are created, a junction number is
automatically allocated.
The junction number can be changed by the user to any unique value greater than zero and less than
100,000. Junction numbers are only identifiers and have no effect on the model behavior.

Name
A name can be assigned to each pipe for reference purposes. Names do not need to be unique. The
name can be shown on the Workspace, in the Visual Report and in the Output window.

- 211 -

Junctions

Library List
A list of all available custom components. It displays components from any connected library.
Selecting a component from this list automatically retrieves the junction settings and populates the properties window. Changing the input manually will deselect the component in the list.

Copy Data From Junction
The Copy Data From Junction dropdown list allows you to copy all or some of an existing junctions’s properties to the current junction. Selecting an existing junction will prompt the user on what parameters
should be changed.
In child scenarios, Copy Data From Junction lists "Parent Junction Data," allowing the user to copy all or
some parameters from the parent junction.

Pipe Connectivity
The connected pipes are displayed. This is helpful to determine potential connection issues and easily
identify which pipes are upstream and downstream of the junction.

Elevation
Every junction must have an elevation reference. This value is the centerline elevation of the connected
pipe(s).
Junction elevations are used to account for pressure changes due to gravity, allowing calculation of absolute pressures in pipes.
A default elevation can be specified in Parameter Options, automatically setting new junctions to the specified elevation.
Note: Junction elevation takes on a modified meaning for rotating systems. In rotating systems, the
elevation is the distance from the centerline of rotation. This distance is used with the rotational
velocity specified in the Environmental Properties panel to determine rotational acceleration for
the pipe.

Jump Feature
Quickly move to the next junction. See Jump Feature.

Related Topics
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Optional Input for Junctions
Initial Guesses
A user defined initial guess can be entered for pressure (or head) and temperature for most junctions.
This is only an initial guess for the Solver - the solution will vary from this value, and the value has no
effect on the end solution.
A good initial guess can be helpful to decrease the number of Solver iterations required.

Display on Workspace
By default, only the junction number is displayed on the Workspace. In addition to this, the junction name
can be displayed.

Special Conditions
The Special Condition can be changed for some junctions. For example, a valve can be set to closed, preventing all flow. A symbol (default of "X") will be placed before the junction label indicating that a special
condition is applied.

Design Factor
A design factor can be used to add safety margins into the analysis. For junctions, three types of design
factors exist:
l

Compressor/Fan Junctions: head rise at the compressor/fan is multiplied by the design factor
assigned to the compressor/fan.

l

Heat Exchanger Junctions: total rate of heat transfer is multiplied by the Heat Transfer design
factor assigned to the heat exchanger. The total loss factor is multiplied by the Friction Loss
design factor assigned to the heat exchanger.

l

All other junctions: total loss factor is multiplied by the design factor assigned to the junction.

- 213 -

Junctions

Note: The design factor for compressors/fans has the opposite effect on a system that the design
factor for other junction types has. A design factor of 1.1 for junctions with a pressure loss will
give an extra 10% pressure drop at that junction, adding resistance to the system. A design
factor of 1.1 for the compressor/fan junction will give an extra 10% pressure rise, effectively modeling the compressor/fan as having extra capacity than expected. To add a 10% safety margin
to the compressor junction, a design factor of 0.9 should be used.

Workspace Icon
You may want to change the icon to better represent a specific junction type. This is accomplished by
clicking the Change Icon button. The size of the junction can also be changed here.

Related Topics
Special Conditions
Optional Input for Pipes
Turn Off Parts of the Model
General Junction Information
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Specifying Losses
Convention for Specifying Base Area
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Specifying Losses
Local losses can be specified in two ways. The most flexible way of including a loss factor in an AFT
Arrow model is to associate it with a junction specifically defined for that type of loss. This allows you to
define a loss as a function of a flow parameter such as Reynolds number or volumetric flow rate, or as a
function of the area change ratio between the upstream and downstream pipes. This method results in
the greatest clarity.
Secondly, you can include loss factors with pipes. When you specify Fittings & Losses in the Pipe Properties Window, the loss is assumed to be distributed evenly along the pipe length, much like friction
losses. For this reason a pipe-associated loss factor is referred to as a distributed loss. The losses at
junctions, on the other hand, are point losses.
It should be noted that for compressible flow, the location of a fitting/loss along a pipe will change the
pressure drop due to that fitting/loss. This is because the velocity along a pipe changes for compressible
flow. For this reason, the recommended method for representing losses is to define them in a junction.

Related Topics
General Junction Information

207
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Convention for Specifying Base Area
Loss factors are area dependent. When specifying a loss factor at a junction, the base area is of critical
importance. By default AFT Arrow adheres to the following convention: whenever it makes sense physically, the base area is always the upstream pipe flow area. However, this can be modified by the user. In
most junction Properties windows, the base area can be specified as the upstream pipe, downstream
pipe, user specified area or diameter.
However, some junction types, especially those that allow three or more connecting pipes, specify loss
factors based on each connecting pipe flow area, whether upstream or downstream. An example of this
is a wye in which each of the connecting pipes has a different diameter. The idea of specifying a loss
factor based on upstream flow area loses meaning because there may be more than one upstream pipe.
In these cases the loss factor is referenced to the base area of the actual downstream pipe(s) where it
connects to the junction. The types of junctions that do not always follow the upstream pipe area convention are Tee/Wye, Branch, Tank, Assigned Pressure, and Assigned Flow. Other exceptions are
Valves and Relief Valves specified as exit valves, and Orifice specified as an exit.

Related Topics
General Junction Information
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Common Junction Input Parameters
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Specifying Losses
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Reference Density
A relationship can be drawn for many components between flow energy and flow rate. This can be a
decrease (e.g., a loss across a valve) or increase in energy (e.g. energy added by a compressor). The
specific parameter used to represent flow energy can vary depending on application. It can be given in
terms of pressure change or head change, and there is a critical difference between the two.
Consider a centifugal turbomachine (a pump or radial compressor): Kinetic energy is imparted to the fluid
by accelerating it along the radius of the impeller. If the rate of rotation is held constant, a denser fluid will
have more energy imparted to it than a lighter weight fluid. This would give rise to higher pressures. In
other words, the pressure change depends on the density of the fluid.
Sometimes curves are provided in terms of head. This is convenient because head is a unit of specific
energy - or energy per weight. Therefore, it does not vary with fluid density like pressure does. The head
added to a fluid by a pump or compressor at a fixed speed, for example, will be the same for fluids of different densities.
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However, head relationships are not always available or meaningful. If a pressure vs flow relationship
is used, a reference density must be specified. This is the fluid density used during testing and creation
of the curve.

Figure 1: Visual comparison of Pressure Loss Curves for differing densities. Head curves would be identical
for this component.

Note: Incompressible liquids are used in the example in Figure 1, but the principles apply similarly to
compressible flow.

Affected Parameters
There are several parameters that are affected by the density of the fluid:
l

Pressure - As discussed above

l

Mass Flow - The mass term contains information about the density of the fluid

l

Power - More power is demanded by a compressor to meet the head curve for a denser fluid.
While head is independent of density and therefore often reported by manufacturers, power is not
independent of density. Therefore, a proper specification sheet that includes power must also
include the reference fluid density.

Accounting for Reference Density
Compressors and any Resistance Curve allow for the specification of a reference density if one of the
above parameters is selected. The selection appears below the curve fit area as shown in figure 2.
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Figure 2: Reference Density Selection

There are two options:
l

No Correction (default) - This selection assumes that the component was tested with the fluid
defined in the Fluid panel.

l

User Specified - This directly specifies the reference density. If the fluid in the Fluid panel differs,
the entered curve will be corrected.
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Junction Loss Models
There are several common loss models offered to represent the frictional pressure loss at junctions in
Arrow. See the topics below for information on common subsonic loss models. Loss models that are
unique to individual junctions are described in separate topics, refer to the specific junction properties
window topics for more information.
If sonic choking occurs a different sonic loss calculation method is used. See below for a summary of the
differences.

Subsonic vs Sonic Losses
There are two separate pressure loss mechanisms when gas flows through a restriction, expansion, or
end point.
l

Subsonic losses are standard "form" losses and are dependent on the geometry of the restriction, expansion, or end point. This is the common K-factor, discharge coefficient for subsonic flow,
or one of the other loss models discussed in the Junctions section.

l

Sonic losses result when sonic choking occurs. Sonic losses are dependent on the minimum
effective flow area and are unrelated to the K-factor. This is the CdA for sonic choking.

- 217 -

Junctions

The two loss mechanisms cannot occur simultaneously in nature or in AFT Arrow. If one mechanism
occurs during the solution, the input data for the other mechanism is ignored by AFT Arrow.
It is also important to note that sonic choking at a restriction cannot be calculated if the CdA for Sonic
Choking is not entered. Thus, Arrow will always use subsonic loss calculations if no CdA for Sonic Choking has been entered, even if the actual system would experience choked flow at that restriction.
Note: The CdA for sonic choking may be different from the subsonic CdA loss model option in Arrow.
The discharge coefficient can vary at different pressure ratios due to the vena contracta moving
closer to or farther from the orifice restriction. For the highest accuracy the CdA used for subsonic and sonic losses should be tested and entered separately. See the "Modeling Choked
Flow Through an Orifice" white paper on AFT's website for more information.

Related Topics
K Factor Loss Model
Cv/Kv and Xt Loss Model
Resistance Curve Loss Model

218
220
221

K Factor Loss Model
AFT Arrow models component losses according to the following equation:

where K is commonly referred to as the loss factor. Note that for calculation purposes this pressure loss
is a stagnation pressure loss.
Table 1 lists the sources for the loss models used in AFT Arrow. The losses implemented directly in the
code were chosen on the basis of ease of use. Many loss factor types are functions of the flow, and thus
too general to be easily incorporated.

- 218 -

Junctions

Table 1: Loss model references

Crane (1988) offers good general purpose correlations for modeling irrecoverable losses in pipe systems. A well prepared pipe flow analyst would be advised to have copies of all of these references.
Another lesser known source of loss factor information is Idelchik's Handbook of Hydraulic Resistance
(Idelchik 2007). This reference is indispensable for the engineer who must make detailed hydraulic
assessments of pipe systems in which so-called minor losses play a significant roll. The reference is voluminous in scope and full of tables, charts and equations for calculating loss factors for almost any pipe
arrangement.
Miller's Internal Flow Systems (Miller 1990) is another reference offering good general purpose hydraulic
data.

K Factor Data in Compressible Flow
Most handbook K-factor data is based on incompressible flow tests or theory. Applying standard K
factors to compressible flow components carries some uncertainty. There are not any universally accepted methods available to determine K-factors for truly compressible flow except in very specific situations.
Arrow offers common handbook values for K-factors, and you should use caution in how you apply the
data. Also recognize that when you use the “Fittings & Losses” in pipes, computationally these K-factors
are spread out along the whole pipe as distributed losses. In compressible flow, the location of a fitting
along a pipe will affect the actual pressure loss since velocity is not constant along a pipe. The Fittings &
Losses do not account for this.

Related Topics
Junction Loss Models
Cv/Kv and Xt Loss Model
Resistance Curve Loss Model

217
220
221
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Cv/Kv and Xt Loss Model
AFT Arrow allows the user to enter valve coefficient data in terms of Kv or Cv. Conversions are handled
seamlessly in the background. Kv is the metric equivalent to Cv.
The valve Cv loss model type is unique in that this loss model can be used as part of both the subsonic
and sonic loss calculations across the valve.

Subsonic Loss
The relationship between valve Cv, Xt, and flow is provided by ANSI/ISA-75.01.01-2012 standard as follows:

Where C is the flow coefficient (Cv or Kv) and N is a numerical constant found in Table 1 of the ANSI
standard referenced above. The units for the flow, pressure and density will be based off of the numerical
constant chosen.
Fp is a correction factor for piping geometry. This correction will be treated as 1 unless the Valve ID has
been entered by the user.
Xsizing is the ratio of the pressure drop across the valve to the inlet pressure of the valve for subsonic
flow:

Y is the expansion factor, which accounts for the change in density as the gas passes through the vena
contracta, and is calculated as follows:

Where Xt is the pressure ratio, X, when the valve has just begun to choke.

Sonic Loss
If choked flow occurs across the valve, then the mass flow equation above is still used. However, the Xsizing is now equivalent to Xt, which is the pressure ratio when the valve first begins to choke.
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Estimated Cv/Kv in Output
In the Output window the estimated Cv /Kv can be displayed if the Cv /Kv was not defined by the user.
The estimated Cv /Kv value is calculated using the mass flow rate equation shown above, with Xsizing
estimated as follows

Related Topics
Junction Loss Models
K Factor Loss Model
Resistance Curve Loss Model
Valve
Valve Modeling Closures with K Factors

217
218
221
280
282

Related Blogs
Making Sense of xT - Valve Loss in Compressible Flow

Resistance Curve Loss Model
The resistance curve loss model is available in many of the junctions in Arrow. It is useful when measured flow vs loss data is available for a component.
It is not uncommon to obtain from an equipment manufacturer a single data point. For example, the data
might be 3 psi pressure drop at 1 lbm/sec. Along with this data point, another always comes along for
free. The second data point is zero pressure drop at zero flow.
The pressure drop characteristics of most equipment follows the square law. As the flow rate increases,
the pressure increases with the square of the flow rate.
Therefore, in our example, an increase in the flow rate to 2 lbm/sec would result in a pressure drop of 12
psi. Although this may not be exactly correct, it is much better than assuming a flat 3 psi drop for all flow
rates, which we know for certain is not correct.
The Fill As Quadratic button found in the Curve Fit window can be used to create a quadratic curve out
of a single data point as was shown in the below example. To do this, just enter the single data point in
the table, click the Fill As Quadratic, then click Generate curve Fit to finish creating the curve.
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Table 1: Example data points for pressure drop modeling using manufacturer data

Data Point

Flow Rate
(lbm/sec)

Pressure
Drop
(psid)

Comment

1

0

0

Always valid
for passive
equipment

2

1

3

Given by manufacturer

12

Extrapolated
assuming
square law

3

2

Related Topics
Junction Loss Models
K Factor Loss Model
Cv/Kv and Xt Loss Model
Troubleshooting Resistance Curves

217
218
220
683

Related Examples
Natural Gas Burner
Compressed Air System

741
748

Area Change
The Area Change junction type must always have two connecting pipes. This junction type allows you to
model the irrecoverable loss that occurs at the area transition between two pipes, whether expansion or
contraction.
The Area Change Properties window follows the first of the two basic Properties window formats, displaying the connecting pipes in a fixed format. A flow direction through the junction is adopted from the
defined directions of the two connecting pipes.
The Area Change Properties window offers two standard types of area change losses: the Conical Transition and the Abrupt Transition.
The critical parameter that influences the magnitude of the area change loss is the area ratio between
upstream and downstream pipes. Until you have input the information for the upstream and downstream
pipes that allow for flow area determination, the standard Area Change junction loss factor is not calculated. For conical transition geometries you also need to specify the conical angle.
If the standard loss factors provided are inadequate for your application, you may specify your own custom loss factor referenced to the upstream pipe flow area.
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Note: It is possible to have a vena contracta through a physical area change. If high velocities are possible, the Mach number may reach sonic conditions and the flow will choke. That is the purpose
of the optional CdA input parameter. The minimum possible sonic flow area is entered as the
CdA and if sonic conditions are reached AFT Arrow will solve the system on a choked flow
basis.

Related Topics
Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model
Area Change Loss Model
Subsonic vs. Sonic Pressure Losses

206
207
217
218
223
501

Area Change Loss Model
Two standard area change loss geometries are available: the conical transition and the abrupt transition.
The conical expansion correlation (Crane 1988, A-26) is:

The conical contraction correlation (Crane 1988, A-26) is:
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The abrupt expansion correlation (Idelchik 2007, 246) is:

The abrupt contraction correlation (Idelchik 2007, 254) is:

Note: While a 180 degree conical transition is the same as an abrupt transition, Crane's conical contraction equation gives a different result at 180 degrees compared to Idelchik's abrupt contraction equation. Therefore, it is up to the user to determine which one to use.
All K factor equations are provided here in terms of the upstream pipe. The K factor in terms of the downstream pipe can be found as follows:
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Related Topics
K Factor Loss Model
Area Change
Subsonic vs. Sonic Pressure Losses

218
222
501

Assigned Flow
The Assigned Flow junction type allows you to connect one pipe and to input a known flow rate entering
or leaving at a particular location in your system. An irrecoverable loss can also be included.
The Assigned Flow Properties window follows the first of the two basic Properties window formats, displaying the connecting pipe information in a fixed format. Depending on whether you specify the junction
as an inflow or outflow type, the required connecting pipe (upstream/inlet or downstream/outlet) will be
enabled while the other pipe is disabled. Note that if the flow is specified as Inflow (to the system) then
the reference positive flow direction of the connected pipe must be away from the junction (i.e., the junction is upstream of the pipe).
The Assigned Flow junction will automatically switch the inflow/outflow parameter based on the reference flow direction of the connected pipe.
The Assigned Flow junction type allows you to specify positive flow rates as mass flow rates. Negative
flow rates are not accepted. If, for example, you have an outflow type junction and your system is physically flowing in, you cannot assign a negative flow rate to the junction. You must reverse the connecting
pipe flow direction to be consistent with the actual direction and change from an outflow type to an inflow
type.

Special Conditions
You can set a Special Condition for an Assigned Flow junction, which will turn the flow off and make it act
like a Dead End.

Loss Factor
On the Optional tab, a loss factor can be entered to account for losses due to fittings or components at
the entry/exit to the connected pipe.
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Transient
(XTS Module Only) On the Transient tab, a flowrate transient can be entered. For more information on
transient data, including event transients, see Junction Transient Data.

Related Topics
Junctions
General Junction Information
Junction Loss Models

206
207
217

Assigned Pressure
The Assigned Pressure junction allows for the specification of a fixed boundary pressure and temperature.
This junction is very similar to the Tank in that it fixes a pressure at a boundary. However, the Assigned
Pressure allows the definition of either a static or stagnation pressure boundary, whereas Tanks are
always stagnation pressure. Typically, any pressure gauge on a pipe will be reporting static pressure - it
is important to select static pressure if this is the actual boundary in the real system. A Tank would be
inappropriate to represent such a piping connection with non-zero flow.
If stagnation is selected, the Assigned Pressure accepts the connection of up to twenty-five pipes. Static
selection limits the connection to one pipe.
There is also the option to Balance Energy in the junction - this adjusts the temperature in order to make
incoming and outgoing energy balance. This option is only appropriate for closed loop systems, read
more here: Open vs Closed Systems - Balancing Energy.

CdA for Sonic Choking
An optional input in the Assigned Pressure window is the CdA. This parameter describes the effective
area restriction for the purpose of calculating sonic choking. This is useful if you are using the assigned
pressure junction as a vent to atmosphere and a restriction exists at the pipe exit. If sonic choking occurs
at the vent exit, the CdA will be the limiting area for flow. The CdA will only apply when there is one connecting pipe.

Loss Factor
On the Loss Coefficients tab, loss factors can be entered to account for losses due to fittings or components at the entry/exit to each of the connected pipes.
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Transient
(XTS Module Only) On the Transient tab, a pressure transient can be entered. For more information on
transient data, including event transients, see Junction Transient Data.

Related Topics
Junctions
General Junction Information
Junction Loss Models
Subsonic vs. Sonic Pressure Losses

206
207
217
501

Bend
The Bend junction type must always have two connecting pipes. This junction type allows you to model
the irrecoverable loss that occurs when the flow direction changes through a bend or elbow.
The Bend Properties window follows the first of the two basic Properties window formats, displaying the
connecting pipes in a fixed format. A flow direction through the junction is adopted from the defined directions of the two connecting pipes.
The Bend Properties Window offers three standard types of bend losses: the Smooth Bend, the Standard
Elbow (the standard short radius threaded elbow), and the Mitre Bend. The window shows a schematic
of the selected geometry. Until you have input the information for the upstream pipe that allows flow area
determination, the standard Bend junction loss factor is not calculated. For smooth radius bends, you
also need to specify r/D, which is the radius of curvature over the pipe diameter. At r/D less than one the
Reynolds number must be known to calculate the loss factor, and therefore cannot be displayed until output is available.
For bends that are not at a 90-degree angle, you can enter the angle and the standard loss factor will be
calculated.
If the standard loss factors provided are inadequate for your application, you may specify a custom loss
factor referenced to the upstream pipe flow area.
Note: In principle, the upstream and downstream pipe diameters should be the same. However, the
Bend junction only uses the reference area specified under Basis Area for Loss Model, even if
the physical flow is in the opposite direction. If you are working with a user-specified loss, your
geometry may have different diameter pipes connecting to the elbow. In this case, you would
purposely define different upstream and downstream pipe areas. However, you would still want
to be careful that the custom loss factor you assign is referenced to the correct area that is specified in Basis Area for Loss Model.

CdA for Sonic Choking
As the fluid goes around the bend, it can separate from the wall. This results in a reduced physical flow
area. When assessing sonic choking, it is this reduced area that is important. That is the purpose of the
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optional CdA input parameter. The minimum possible flow area is entered as the CdA and if sonic conditions are reached AFT Arrow will solve the system on a choked flow basis.

Related Topics
Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model
Bend Loss Model
Subsonic vs. Sonic Pressure Losses

206
207
217
218
228
501

Bend Loss Model
90 degree bends
The three Bend loss correlations are all for turbulent Reynolds numbers (Crane 1988, A-29).
The K-factors for a smooth flanged bend with r/D ≥ 1 are provided in Table 1.

Table 1: K-factors for 90 degree smooth flanged bends

The standard threaded elbow is given by:

where fT is the turbulent friction factor given in Table 2.

- 228 -

Junctions

Table 2: Pipe friction factors used for Crane formulas

The Mitre bend is given by:

Non-90 degree bends
The two non-90 degree bend loss correlations are for turbulent Reynolds numbers (Crane 1988, A-29).
A smooth flanged bend with r/D ≥ 1 is given by:

where n is the number of 90 degree bends, K is the loss factor for one 90 degree bend (Table 1), and fT is
given by Table 2.
The Mitre bend is given by Table 3.
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Table 3: K values for Mitre bends

Smooth Flanged Bends, r/D < 1
The smooth, flanged bend with r/D < 1 loss factor uses a correlation applicable for turbulent Reynolds
numbers (Miller 1990, 209)
The loss coefficient is calculated based on Miller's class 2 bend model, which is sufficient for general
design purposes, and is given by

C0 and Cf are assumed to be 1 for class 2 bends. Kb* is given by the nomograph on page 207 of Miller.
For r/D > 0.7 or Kb* < 0.4, CRe is given by Miller Figure 9.3. Otherwise, CRe is given by the equation
below.

where the CRe for r/D = 1 is also found from Miller Figure 9.3.

Related Topics
K Factor Loss Model
Bend
Subsonic vs. Sonic Pressure Losses

218
227
501

- 230 -

Junctions

Branch
The Branch junction allows up to twenty-five connecting pipes. The Branch junction is the most flexible
junction type for building network models that have flow splits. Other significant features are the ability to
impose a flow source or sink at the junction and the ability to specify separate loss factors for each connecting pipe. The Branch junction must have at least two connecting pipes.
The Branch Properties Window follows the second of the two basic Properties window formats.
A table on the Loss Coefficients folder tab displays the connecting pipe information. This table grows in
size to accommodate up to twenty-five connecting pipes. For each connecting pipe, the pipe table lists
the reference flow direction and up to two loss factors. The first loss factor is for physical flow out of the
branch and into the pipe. The second is for physical flow into the branch and out of the pipe. The loss
factors can be specified independently or left as zero.
The Branch junction also offers you the option of specifying a flow source or sink at the junction in the
Optional tab. According to AFT Arrow's convention, a source of flow into the system is defined as positive, while a consumption of flow with flow out of the system (a sink) is defined as negative. Along with
the flow rate you must specify the fluid and temperature or enthalpy. A branch junction can be used to
model a desuperheater using the enthalpy input.

Related Topics
Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model

206
207
217
218

Related Examples
Beginner: Air Heating System

702

Check Valve
The Check Valve junction type requires two connecting pipes. This junction type allows you to model
valves that prevent reverse flow.
The Check Valve Properties window follows the first of the two basic Properties window formats, displaying the connecting pipes in a fixed format. The Check Valve junction does not have an explicit flow
direction, but adopts a flow direction from the connecting pipes.
AFT Arrow assumes that the check valve is initially open. If the flow solution indicates that forward flow
will not occur, AFT Arrow closes the valve and solves the flow distribution again.
Note: If the check valve closes during the simulation, it will not re-open. If there is an unsteady situation in which the check valve would continuously open and close, there may be unexpected results. It is good practice to close check valves with a Special Condition if it is known that they will
be closed. This event can be seen in the Solution Progress window as Re-running Solver
because one or more special junction states changed...
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A check valve Special Condition can be either open or closed.

Specifying Losses
You specify the losses for the Check Valve on the Loss Model tab in the Properties window. The Check
Valve junction allows the Cv or Kv to be specified for pressure loss calculation. The Cv/Kv is defined
according to the ANSI/ISA standard as described in the Kv and Cv Loss Model topic. The valve Xt data is
also required when using Cv/Kv. When Cv/Kv is selected, data for FL and FD can optionally be entered
for valves with low Reynolds numbers to calculated correction factors. If the valve diameter is entered,
AFT Arrow will automatically calculate correction factors for cases where pipe diameter differs from the
valve.
When you select Resistance Curve, the Check Valve Properties window makes additional features available. Using these new features you can input Check Valve loss factors or pressure drops that vary with
flow. To enter these factors, you can fit a curve to available data, or use interpolated x-y data. You can
choose any of the optional flow and pressure parameters provided; you can also specify the most convenient units.

CdA for Sonic Choking
An optional input in the Check Valve Properties window is the CdA. This parameter describes the effective area restriction in the valve for the purpose of calculating sonic choking. In most cases, information on
the CdA must be obtained from the manufacturer or from test data. Note that the CdA input field is disabled if Cv or Kv loss is used, as the Xt value is used for sonic choking calculations in that case.

Related Topics
Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model
Check Valve closed at Junction X
Cv/Kv and Xt Loss Model
Subsonic vs. Sonic Pressure Losses

206
207
217
218
674
220
501

Control Valve
Control Valve junctions are always internal to the system, with two connecting pipes. This junction type
allows modeling of valves that offer special pressure or flow control characteristics at a location in the
pipe system.
The Control Valve Properties window follows the first of the two basic Properties window formats, displaying the connecting pipes in a fixed format. The Control Valve junction does not have an explicit flow
direction, but adopts a flow direction from the connecting pipes.
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Control Valve Types
You can model four types of control valves: Pressure Reducing Valves (PRV’s), Pressure Sustaining
Valves (PSV’s), Flow Control Valves (FCV’s), and Pressure Drop Control Valves (PDCV’s). Loss information for a control valve is not required, because control valves are dynamic devices that change their
geometry in response to the pipe system behavior. The loss that results is that required to maintain the
control parameter. You can, however, specify the full open loss. This is the loss that will occur should the
valve fail to a full open state.
l

A PRV is a device that controls the pressure in a pipe system. The PRV maintains a constant control pressure downstream of the junction as long as the upstream pressure exceeds the control
pressure. If the upstream pressure is lower than the control pressure, the ability to control pressure is lost.

l

A PSV is similar to a PRV in that it controls pressure in a pipe system. While the PRV maintains a
constant downstream pressure, the PSV maintains a constant upstream pressure. If the downstream pressure rises higher than the control pressure, the ability to control pressure is lost.

l

An FCV is a device that maintains a constant flow rate in a pipe system. By setting the junction to
an FCV type and entering a flow rate, the junction will limit the flow through the connecting pipes
to be equal to the control flow rate. The FCV can lose its ability to control flow when the pressure
drop across it becomes zero or backward flow begins.

l

A PDCV is a device that maintains a constant (stagnation) pressure drop. For this option, the
valve is never allowed to not meet its setpoint. An indicator that an unrealistic pressure drop has
been demanded is a failure to obtain a converged solution.

PRV/PSV Static vs. Stagnation Pressure
The control pressure for a PRV or PSV can be either static or stagnation. The default selection is static,
as this is the most frequent application in industry.

Action If Setpoint Not Achievable
l

Always Control (Never Fail) - It is possible that a control valve cannot achieve a given set point.
By default this option is on - to change this, uncheck the box and click Set as Default. For additional information, see Control Valve Setpoint Not Achievable.

l

Use Default Actions - The behavior of the control valve when it cannot meet its setpoint can be
modified by unchecking this option. The default behaviors represent the normal behaviors for the
standard valve types.

Special Conditions
Control valves have two special conditions. To open fully and not control, or to close.

- 233 -

Junctions

Open Percentage Table
The Optional tab allows data to be entered for special control valve characteristics. Specifically, the valve
Cv/Kv, xt, and Flow Area can be specified vs. the Open Percentage of the valve. This data does not affect
AFT Arrow’s flow solution, but will affect the reported Cv/Kv. The Valve Summary (in the Output window)
always displays the valve Cv, and if data is specified for open percentage and flow area it will also display
open percentage and flow area at the operating point.
If open percentage data is not specified, then a Cv/Kv value will be estimated for the control valve.

Transient
(XTS Module Only) On the Transient tab, a control setpoint transient can be entered. For more information on transient data, including event transients, see Junction Transient Data.

Related Topics
Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model
Control Valve Setpoint Not Achievable
FCV at Junction X could not control flow
FCV/PRV/PSV Could Not Control Pressure - Pressure Was Added to Achieve Control
Flow/Pressure...
PRV at Junction X could not control pressure
PSV at Junction X could not control pressure
Cv/Kv and Xt Loss Model
Control valve open percentage outside valid range of 0-100%
Subsonic vs. Sonic Pressure Losses

206
207
217
218
235
669
664
673
673
220
669
501

Related Examples
Control Valve

734

Related Blogs
Get in Control with Control Valves
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Control Valve Setpoint Not Achievable
It is possible that the control valve cannot achieve the specified control setpoint. There are several
actions the valve can take in such cases. By default, the Always Control (Never Fail) feature is selected.
This option is physically unrealistic but useful for modeling purposes. The reason this option is physically
unrealistic is that the valve can add pressure to maintain control, thus acting like a compressor. If this
occurs, the user is clearly warned in the output. The Always Control option is useful because it gives a
clear indication to the user of how far away the valve is from being able to control.

Flow Control Valves
For flow control valves, other options for valves which cannot achieve control are to have the valve Open
Fully or Close. By default the valve fully opens. Once the control valve loses control, whether open or
closed, AFT Arrow will solve the model again.

Pressure Control Valves
Pressure control valves are more complicated. These valves have two potential actions when control cannot be achieved. The first action is when the control cannot be achieved due to insufficient upstream pressure. The second is due to excessive downstream pressure. The default behavior for pressure reducing
valves is to Open Fully due to insufficient upstream pressure, and close due to excessive downstream
pressure. The defaults for pressure sustaining valves are the opposite. You can override the default
behavior by clearing the Use Default Actions selection and specifying the desired actions.
AFT Arrow will determine if the valve can maintain control based on the Loss When Fully Open value. If
this fully-open pressure drop is greater than the pressure drop which balances the system, the control
valve can't achieve its setpoint. In other words, the control valve can’t open wide enough (becoming less
restrictive) to achieve control, and will revert to using the Loss When Fully Open specified by the user. If
you enter data in the Open Percentage table on the Optional tab, you can select to have the data taken
directly from the table for the 100% open case. You can also choose to not have any losses associated
with the valve in the full-open state by selecting None.

Related Topics
Control Valve
FCV at Junction X could not control flow
FCV/PRV/PSV Could Not Control Pressure - Pressure Was Added to Achieve Control
Flow/Pressure...
PRV at Junction X could not control pressure
PSV at Junction X could not control pressure
Cv/Kv and Xt Loss Model
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Compressors & Fans
The Compressor/Fan junction allows you to model the pressure added to a system by a compressor or
fan. Because all turbomachines are different, AFT Arrow does not provide any standard types. Pressure
and flow data that describes the turbomachine must be obtained from the manufacturer or from test data.
To reduce repeated data entry, frequently-used compressors/fans can be added to the Component library.

Common Input Information
Like all junctions, Compressor/Fan junctions require a junction number, junction name, and inlet and outlet elevations. Similar to other junctions, they can have Design Alerts and Notes applied to them. They
require two connecting pipes. Note that the direction of the connected pipes defines what side of the junction is suction and which is discharge.

Compressor/Fan Model
This tab requires the selection and definition of what the junction represents. There are three models
available, which are shown in Figure 1.
l

Centrifugal - Represents a typical centrifugal compressor in which a pressure rise is achieved by
adding kinetic energy to the superheated gas flow. Arrow can help to size a compressor using the
Sizing option. Once a compressor curve is attained, the compressor can be modeled by entering
the curve into the Compressor Curve under the Compressor Model section.

l

Positive Displacement - Represents a steady state approximation of a positive displacement
device. The flow is fixed to a constant value, and whatever pressure is necessary to obtain that
flow will be supplied.

l

Fan - Represents a typical fan in which a large amount of gas is generally moved with a lower
increase in pressure than a compressor. As with the centrifugal compressor, Arrow can help to
size a fan using the Sizing option. Once a fan curve is attained, the fan can be modeled by entering the curve into the Fan Curve under the Fan Model section. The Fan model will always be
treated as adiabatic. For non-adiabatic behavior the centrifugal compressor option should be
chosen.

Figure 1: Compressor/Fan junction available models
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Variable Speed
This tab allows the speed of the turbomachine to vary either by a fixed amount, or dynamically. These
options are only available when a compressor or fan is specified with a curve.
l

Fixed Speed (%) - Directly modifies the fan or compressor curve according to the Affinity Laws.
The entered curve is always assumed to be the 100% speed curve.

l

Controlled Compressor/Fan (Variable Speed) - Dynamically change the speed of the turbomachine to meet a specified control setpoint. Instead of allowing the flow or pressure to vary
with a fixed speed, the speed of the compressor/fan (and thus Compressor/Fan Curve, according
to the Affinity Laws) varies to meet a fixed flow or pressure. If modeling a suction or discharge
pressure, control can optionally be enforced only if the value is above/below the setpoint.

Compression Process Thermodynamics
Depending on the compression process, significant thermal effects can occur. Fans create a pressure
rise that is typically so low that the temperature is not noticeably affected, and this is why the fan will
always be treated as adiabatic in Arrow. The large pressure rise in compressors, however, leads to significant temperature changes. See the Centrifugal Compressor topic for details on the available methods
for calculating this.

Optional
There are several optional parameters that can be defined for a compressor/fan. Some of these are available to most junctions such as Initial Guesses, Display on Workspace, Design Factor, and Workspace
Icon.
Also present are several compressor/fan junction specific options:
l

Special Condition
l

None - The compressor/fan operates normally.

l

Compressor/Fan Off No Flow - The compressor/fan is shut off and blocked. This is
identical to a closed valve.

l

Compressor/Fan Off With Flow Through - The compressor/fan is shut off but allows flow
to continue through. This is identical to a lossless connection.

l

Number of Compressor/Fans at This Location - Several compressor/fans can be represented
by one Compressor/Fan junction. This simplifies the model by reducing the number of pipes and
junctions present, as well as automatically calculating the resulting composite Compressor/Fan
curve. When this option is selected the compressor summary will show the total flow/pressure
added from the combined compressors/fans.

l

Additional Efficiency Data - Power and efficiency information for each stage in a VFD-MotorCompressor/Fan assembly.
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Related Topics
Junctions
General Junction Information
Junction Loss Models
Centrifugal Compressor
Fans
Compressor/Fan Efficiency Data
Compression Ratio Reference Inlet Conditions
Multiple Configurations
Compressor/Fan Sizing
Positive Displacement Compressor
Compressor/Fan Configuration
Affinity Laws
Junction X Had Reverse Flow - Compressor/Fan Pressure Could Not Be Predicted
Junction X Exceeded Runout Flow Rate…
Junction X Compressor/Fan Added Negative Pressure
Poor Compressor/Fan Curve Fits

206
207
217
238
242
256
248
248
253
254
243
258
665
671
670
682

Related Examples
Beginner: Air Heating System
Compressed Air System
Compressed Air System - Cost

702
748
794

Related Blogs
Modeling Fans, Blowers and Compressors - Oh My!

Centrifugal Compressor
Analysis Type
This topic pertains to the Centrifugal Compressor Curve Analysis option which represents the real behavior of a centrifugal compressor or fan. For Sizing Analyses, see Compressor/Fan Sizing.

Centrifugal Compressor Curve
The right hand side of the tab displays the defined curve(s) for the compressor.
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To enter curves, click Enter Curve Data. Once this data has been defined, previews of the applied curves
can be seen on the right hand side of the Compressor Model tab. Note that only one curve can be
entered unless different configurations under the Multiple Configurations tab have been specified.
Note: AFT Arrow does not have a means to account for stall or surge lines for the compressor. Therefore, it is possible that Arrow will allow the compressor to operate at unrealistic conditions. It is
advised that the user check the results to ensure that the compressor did not reach the surge or
stall lines during the run, design alerts can be useful to assist with this.

Added Pressure
If the compressor curve is entered using pressure rise information as opposed to a head rise, the pressure rise will need to be specified as either a stagnation or static pressure. This specification is performed
on the Compressor Model tab under the Centrifugal compressor specification. Note that mechanical
energy rises are typically entered in Arrow as pressure rises instead of head rises because the usefulness of the head term in variable-density systems is diminished.

Compression Process Thermodynamics
Depending on the compression process, significant thermal effects can occur. Fans and blowers create a
pressure rise that is typically so low that the temperature is not noticeably affected, which is why Arrow
treats the Fan model as adiabatic, but the large pressure rise in compressors leads to significant temperature changes. This is also known as the heat of compression, and in Arrow, it can be accounted for in
a compressor in multiple ways:
l

Adiabatic - The compressor is treated as adiabatic and 100% efficient. The compressor efficiency
is treated as an isentropic efficiency, so 100% efficiency in this case means the compressor operation is isentropic. If the compression process is adiabatic, the temperature rise is given by the following isentropic relationship:

Note that these pressures and temperatures are static and not stagnation. Gamma (g) is the specific heat
ratio.
l

Polytropic - If there is incidental heat loss to ambient, or if the compressor is actively cooled, the
process will not be adiabatic. In this case the process is referred to as polytropic, and the temperature rise is given by the following:
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where n is the polytropic exponent. If n is equal to γ, it is adiabatic. Typically, n is greater than γ for compressors.
l

Determine From Efficiency Data - If efficiency data is entered as optional data in the Compressor curve, this option can be selected and the thermal effects of the compressor due to compression heating will be calculated. The efficiency data will be applied as isentropic efficiency,
which is defined as the ideal work for an isentropic process over the actual work.

Check Valve at Discharge (No Backflow Allowed)
If this option is checked when modeling a centrifugal compressor with a compressor curve, a check valve
that can be considered part of the compressor itself is assumed to exist. This will never allow backflow at
the compressor junction. If a check valve closes as part of the steady-state simulation, Arrow will perform
recalculations under the assumption that the compressor's check valve is closed. Note that a steady
check valve position must be attained in order for Arrow to apply its steady-state calculations.
l

Forward Velocity to Close - The flow velocity, in the forward direction, that causes the check
valve to close, preventing any further flow. A negative value in this field indicates that a reverse
flow below the specified value will be permitted through the compressor before it closes.

l

Delta Head to Re-Open - The differential head or pressure (upstream minus downstream)
required to re-open the check valve.
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Figure 1: Compressor model with a centrifugal compressor curve defined
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Fans
Analysis Type
This topic pertains to the Fan Curve Analysis option which represents the real behavior of a fan. For Sizing Analyses, see Compressor/Fan Sizing.

Fan Curve
To enter curves, click Enter Curve Data. Once this data has been defined, previews of the applied curves
can be seen on the right hand side of the Fan Model tab. Note that only one fan curve can be entered
unless different configurations under the Multiple Configurations tab have been specified.

Figure 1: Fan model with a fan curve defined
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The fan specification differs from the compressor specification in that all pressure values entered in the
curve are assumed to be a static pressure, and the ability to change this to a stagnation pressure is not
available. This simplification exists because fans generally add significantly less pressure to the fluids
than compressors, and the overwhelming majority of fan vendor curves are created using static pressures. If it is necessary to define a stagnation pressure in a fan curve, users should define this junction as
a compressor and specify Stagnation pressure under the Added Pressure section.
In addition, the heat added by the fan is considered negligible, thus the fan will always be treated as adiabatic with 100% isentropic efficiency.
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Compressor/Fan Configuration
The compressor/fan configuration window is used to define the specific operation of a centrifugal compressor or fan modeled with a curve. It is opened by selecting the Enter Curve Data button from the Compressor/Fan Properties window when a centrifugal compressor or fan is specified.

Figure 1: Enter Curve Data
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Configuration Method
By default, a compressor/fan curve is defined using the Simple configuration. This means that the user
inputs only one compressor/fan curve for the junction.
If the Configuration Method is changed to Multiple, additional input becomes available on the right of the
configuration window. This allows defining different curves to represent the behavior of the compressor/fan at different speeds or impeller diameters. See a detailed description in Compressor/Fan Multiple Configuration. This feature is especially useful when multiple curves for a given compressor/fan
junction must be evaluated as it prevents the user from having to delete and enter curve data.

Figure 2: Compressor/Fan Configuration Method

Compressor/Fan Data
The first tab of the compressor/fan configuration controls the turbomachine's most basic behavior - the
compressor/fan curves.
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Figure 3: Compressor/Fan Data

A compressor/fan can have two types of curves defined:
l

Flow vs. Head/Pressure/Compression Ratio - Required. This is what is commonly referred to
as the "compressor/fan curve" and defines how much pressure the turbomachine can add to a
fluid at any given flowrate.

l

Flow vs. Efficiency/Power - Optional. Data entered in this column allows for quick assessment
of power used at the operating point and the proximity to Best Efficiency Point (BEP). This data
can also be used to determine the compression heating effects for a centrifugal compressor.

After entering the raw values into the table, the data needs to be curve fit.
If Mass Flow, Pressure, or Power are used in the curve definitions, Reference Density becomes an additional required input.
If the Compression ratio is used for the curve definition, the Reference Inlet Conditions are an additional
required input.
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Configuration Data
This tab controls some additional behavior or input for a compressor/fan junction modeled with a curve.
Entering or changing values on this tab is optional.

Figure 4: Configuration Data for Compressor

l

Best Efficiency Point (BEP) - The Best Efficiency Point (BEP) by default is calculated from the
entered efficiency or power curve. This is generally the preferred option as it best relates to the
true meaning of BEP. A User Specified value can be entered if no efficiency or power curve is
available, or if it is desired to force the BEP to a certain flow.

l

End Of Curve Flow Rate (optional) - This value is used to create a warning in the output if it is
exceeded. It does not affect the solution - the model will behave identically regardless of how this
value is defined.

l

Preferred Operating Region (POR - Compressor Only) - % of BEP values falling outside of
the defined range will generate a warning in the model output. This range can be defined by the
user.
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l

Allowable Operating Region (AOR - Compressor Only) - Similarly, this flow range creates a
warning in the output when the user specified flow range is not adhered to.

Graphs
The following tabs display the curves that have been fit to the given data. If multiple curves are defined,
the Composite Graph tab becomes available. The other graph tabs show the individual curves, along
with points representing the raw data. It is a good idea to check these graphs to confirm the curve fit is
reasonable for any potential operating region.

Figure 5: Composite Graph

Related Topics
Compressors & Fans
Centrifugal Compressor
Fans
Compressor/Fan Efficiency Data

236
238
242
256

- 247 -

Junctions

Compression Ratio Reference Inlet Conditions
Multiple Configurations
Compressor/Fan Sizing
Positive Displacement Compressor
Affinity Laws
Poor Compressor/Fan Curve Fits

248
248
253
254
258
682

Related Examples
Compressed Air System

748

Related Blogs
Modeling Fans, Blowers and Compressors - Oh My!

Compression Ratio Reference Inlet Conditions
When a Compression Ratio curve is entered, the Reference Inlet Conditions are needed for Arrow Solver
to convert the Compression Ratio curve from the curve created at the reference conditions (by the
vendor) to a curve applicable at the piping system’s operating conditions. The Reference Inlet Conditions
are the conditions measured at the inlet of the compressor when the Compression Ratio curve is
developed by the curve vendor.
The Reference Inlet Conditions are air at ISO conditions (14.7 psia & 59 deg. F) by default. However, the
Reference Inlet Pressure & Temperature can be changed. Currently, air is the only option for the Reference Fluid.
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Multiple Configurations
A single compressor/fan junction can contain information for multiple compressor/fan configurations impeller trims and operating speeds. This is useful to compare different variations of a compressor/fan
without needing to redefine a new compressor/fan junction for every case. The configuration of the compressor/fan can easily be changed without losing any information.
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Defining Multiple Configurations
When opening the Compressor/Fan Configuration, change the Configuration Method from Simple to Multiple. When doing so, an additional user input panel appears on the right hand side of the window.

Figure 1: Multiple Configuration Method Selected

In order to make use of the Multiple Configurations feature, an RPM and Impeller Diameter under Configuration Information should be filled in. A Description can optionally be added. After modifying any
information that affects the definition of this configuration, the Update Configuration Now box turns yellow:
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Figure 2: Update Configuration

Clicking Update Configuration Now adds the configuration to the Compressor/Fan Configurations listed
in the top-right.
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Figure 3: Current Compressor Configurations

To create an additional configuration, click Create.

Figure 4: Creating a new Configuration
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The compressor/fan curves must be created and curve fit just as is done with a compressor/fan in which
only a single configuration has been specified. After completing this and clicking Update Configuration
Now, the new configuration will be created and shown in the Compressor/Fan Configurations area. Configurations can be edited by selecting them in this area.

Figure 5: Editing a Configuration

Now that multiple configurations are available, they can be selected on the Compressor or Fan Model
tab.

Figure 6: Selection of a Configuration
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Compressor/Fan Sizing
The Compressor/Fan Properties window offers the option of Sizing a compressor/fan. By entering either
a volumetric or mass flow rate, the total developed pressure is calculated and displayed in the Compressor/Fan section of the Output Window. By assigning a flow to a compressor/fan, determining the
compressor/fan size requirements is straightforward.
To size a compressor/fan, first specify if the junction is a centrifugal compressor or fan and then select
the Sizing option for the Compressor/Fan Model.
Specify the parameter that should be used for the sizing. The parameters include:
l

Volumetric Flow Rate - Fix the volumetric flow rate through the compressor/fan.

l

Mass Flow Rate - Fix the mass flow rate through the compressor/fan.

l

Head Rise - Fix the head rise through the compressor/fan. Note that the density used when fixing
the head rise through a compressor/fan is that of the fluid at the suction of the turbomachine.

l

Pressure Rise - Fix the pressure rise through the compressor/fan.

l

Compression Ratio - This option is only available for compressors, and it allows you to fix the
compression ratio of the compressor. This ratio is important because it directly affects the efficiency of the compressor, and it is calculated using the equation:

Problems with Compressor/Fan Sizing and Using a Flow Control Valve
Using the Sizing feature on a Compressor/Fan Properties Window with a Flow Control Valve (which also
fixes flow rate) downstream of the compressor/fan junction results in a Reference Pressure error - the
system no longer has a unique solution. Read more about this in Role of Pressure Junctions - Detailed
Discussion.

Related Topics
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Positive Displacement Compressor
Positive Displacement compressors/blowers can be considered to provide a fixed flow for steady state
analysis. The positive displacement compressor/blower allows for a fixed flow to be defined in a straightforward manner.
To model a positive displacement compressor/blower, select the Positive Displacement option on the
Compressor Model tab of the Compressor/Fan Properties window.

Parameter
l

Volumetric Flow Rate - Fix the volumetric flow rate through the compressor/blower.

l

Mass Flow Rate - Fix the mass flow rate through the compressor/blower.

Fixed Condition
l

Fixed Flowrate - The value and unit of the fixed flow amount.

l

Nominal Efficiency - A fixed efficiency, useful to calculate power requirements.
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Figure 1: Positive Displacement Compressor/Blower Model
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Compressor/Fan Efficiency Data
Note: All efficiency data in the Compressor junction is treated as an isentropic efficiency.

Best Efficiency Point (BEP)
By defining a power or efficiency curve, the Best Efficiency Point of the compressor/fan can be found.
Optionally, the calculated value can be overridden with a user-defined value on the Configuration Data
tab on the Compressor/Fan Configuration window. It is generally desirable to operate compressors/fans
as close to the BEP as possible. The Compressor/Fan Summary can display what the BEP is, as well as
how far off (in % of BEP) of BEP the compressor/fan is operating in the model.

Nominal Efficiency
When modeling a fixed flow or fixed rise compressor/fan, you can optionally input a nominal efficiency as
an approximation. This can be useful for sizing or design purposes, although more precise efficiency
data should be entered when modeling a compressor/fan curve.

Power and Efficiency Calculations
Various stages of power or efficiency data relating to a compressor assembly can be added to a compressor junction.
The most basic value that can be accounted for is the compressor efficiency or power curve. This curve,
entered in Compressor Configuration when the Centrifugal Compressor model is chosen is used to
determine the power/efficiency being delivered to the compressor itself - the Shaft Power.
AFT Arrow uses the compressor curve with the system configuration to determine the total pressure rise
(Δp = p2 - p1) and flow (Q) through the compressor. The isentropic power used at the compressor/fan
can be calculated using the stagnation pressure values, volumetric flow, and isentropic expansion coefficient (k) as given by the following equation from Perry, 10-39 (1997):

Where power is in hp, flow is in ft3/min, and pressure is in psia. Alternate forms of the above equation can
be found in Perry.
Note: In Arrow's interface gamma (γ) is used to represent the isentropic expansion coefficient instead
of k.
With a compressor power or efficiency curve, the missing value can be calculated with the curve value at
the given flow:
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Note the compressor efficiency value used here is the isentropic efficiency.
On a compressor's optional tab, further efficiency information can be defined:

Figure 1: Additional Efficiency Data

Entries in this table must come in pairs - both Power and Efficiency values must be present for a calculation to take place, but only one pair is required. That is, only Motor data or only VFD data can be
entered in addition to filling out all four columns.
Motor Power in this instance refers to the output power of the motor - the Shaft Power calculated previously, delivered to the compressor. Because the Shaft Power is already known, the Motor efficiency
can be looked up from this table. Motor Input Power can then be calculated:

VFD Power is used in a similar fashion. The VFD Power in Figure 1 refers to the Output power of the
VFD, which is identical to the Motor Input power. Because Motor Input Power was calculated, VFD efficiency can be looked up in the table, and VFD Input Power calculated with:

This power is considered the Overall Power, viewable in the Compressor Summary along with all of the
other above values. Whenever an efficiency value is left undefined, it is assumed to be 1 (perfectly efficient).
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Affinity Laws
Compared to compressors, it is more common for fans or blowers to operate with variable speeds
(adjustable in the Variable Speed tab in the Compressor/Fan Properties window). Affinity laws (also
called homologous laws) allow an estimation of the compressor/fan performance at speeds other than
the design speed.
Before discussing the affinity laws, it should be noted that the affinity laws are an approximation. In many
cases, compressor/fan manufacturers will have performance data for a number of speeds. These data
should be used if available. When not available, the affinity laws can be used with an understanding that
an approximation is being made. The affinity laws are known to have much lower accuracy for compressors and blowers than for fans.
Compressor/fan curves can generally be curve fit to a polynomial:

The appropriate affinity law is then applied to the compressor/fan curve, and a speed ratio, denoted with
the symbol s, that meets the user's specification on the Variable Speed tab on the Compressor/Fan Properties window is determined. The affinity laws are shown below.

Affinity Laws
For the following ratios, subscript 1 represents the parameter from the defined curve (assumed to be at
100% speed). Subscript 2 represents the given parameter at the desired operating speed N2.
l

Flow rate -
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l

Compressor/Fan head -

l

Compressor/Fan Power consumption -

l

Efficiency -
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Dead End
The Dead End junction must always have one connecting pipe. This junction type is one way to define
flow in a pipe as truly zero. Use of this junction allows AFT Arrow the liberty of skipping the flow solution,
since the flow is known to be zero.
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The Dead End Properties window follows the first of the two basic Properties window formats, displaying
the connecting pipes in a fixed format. The only required information is the connecting pipe and the elevation.

Related Topics
Junctions
General Junction Information
Junction Loss Models
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217

General Component
The General Component junction type is internal to the system and requires two connecting pipes. This
junction type allows you to model the irrecoverable loss that occurs through equipment that may not be
explicitly represented on the Toolbox and to specify loss factors as a function of a flow parameter.
The General Component Properties window follows the first of the two basic Properties window formats,
displaying the connecting pipes in a fixed format. The flow direction through the junction is determined by
the defined directions of the connecting pipes.
Subsonic losses in the General Component junction can be represented using a K factor or by entering a
resistance curve. When you select Resistance Curve, the General Component Properties window makes
additional features available. You can specify polynomial constants, fit a curve to available data, or use
interpolated x-y data.

CdA for Sonic Choking
An optional input is the CdA for Sonic Choking. This parameter describes the effective area restriction for
the purpose of calculating sonic choking. In most cases, information on the CdA must be obtained from
manufacturer or test data.

Related Topics
Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model
Resistance Curve Loss Model
Troubleshooting Resistance Curves
Subsonic vs. Sonic Pressure Losses
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Heat Exchanger
The Heat Exchanger junction type is internal to the system and requires two connecting pipes. This junction type allows you to model the irrecoverable loss that occurs through heat exchanger equipment. You
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also have the ability to specify loss factors as a function of a flow parameter.
The Heat Exchanger Properties window follows the first of the two basic Properties window formats, displaying the connecting pipes in a fixed format. The flow direction through the junction is determined by
the defined directions of the connecting pipes.
Subsonic losses in the Heat Exchanger junction can be represented using a K factor or by entering a resistance curve. When you select Resistance Curve, the Heat Exchanger Properties window makes additional features available. Using these new features you can input heat exchanger loss factors or pressure
drops that vary with flow. To enter these factors, you can specify polynomial constants, fit a curve to available data, or use interpolated x-y data.

Heat Transfer
On the Thermal Data tab you can select from twelve different heat exchanger models.
Note that similar to flow rate definition, heat flow is positive when flowing into the system, and negative
when flowing out.
When modeling convective heat exchangers (such as parallel or counterflow) two heat exchanger junctions can be linked thermally. This thermal link allows the two heat exchanger junctions to represent two
sides of the same heat exchanger. This capability can also be used to model heat transfer between loops
with different gases.

Special Conditions
The Special Condition for a Heat Exchanger junction functions differently than other junctions. Here you
can turn off the heat transfer for the heat exchanger.

Related Topics
Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model
Resistance Curve Loss Model
Troubleshooting Resistance Curves
Heat Exchanger Heat Transfer
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Heat Exchanger Heat Transfer
There are twelve different heat exchanger models available in AFT Arrow.
l

l

NTU-Effectiveness Models
l

Counter-Flow

l

Cross Flow, Both Fluids Unmixed

l

Cross Flow, Secondary Fluid Mixed

l

Cross Flow, System Fluid Mixed

l

Parallel

l

Shell & Tube, 1 Shell Pass, Mult. of 2 Tube Passes

Directly specified thermal property
l

Controlled Downstream Temperature

l

Controlled Downstream Temperature (Stagnation)

l

Enthalpy Stagnation Rise

l

Specified Heat Rate In Constant

l

Specified Heat Rate In vs. Flow

l

Temperature Stagnation Rise

Figure 1: Heat Exchanger Thermal Data

All of the NTU-Effectiveness models require the same 5 parameters as input (shown in Figure 1), but calculate the resulting heat transfer slightly differently. The direct specification models only require that the
associated property be entered.
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Thermal results are displayed along with pressure results in the Heat Exchanger Summary in the output,
as well as information on secondary fluid conditions and log mean temperature difference.

NTU-Effectiveness Method
The NTU-Effectiveness method is used when the fluid inlet and outlet temperatures for the heat
exchanger are not known.
To start, the NTU-Effectiveness method requires that the maximum possible heat transfer be found. Theoretically, the maximum heat transfer would occur in a counterflow heat exchanger of an infinite length. In
this scenario, the maximum possible temperature difference is the difference between the inlet temperature of the hot fluid and the inlet temperature of the cold fluid:

The minimum heat capacity rate can then be found by multiplying the mass flow rate by the specific heat
for the hot fluid and the cold fluid:

The fluid with the higher heat capacity rate changes temperature more quickly along the length of the
heat exchanger, but the fluid with the lower heat capacity rate actually sees the maximum possible temperature change. Based on this, the maximum heat transfer between the two fluids in the theoretical heat
exchanger is the minimum heat capacity rate multiplied by the maximum temperature difference:

The effectiveness of a heat exchanger is the ratio between the actual heat transfer rate and the maximum possible heat transfer rate:

If the effectiveness and the inlet conditions are known, the amount of heat transferred between the two
fluids can be calculated without knowing anything about either fluid’s outlet temperature:
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The key to the NTU method becomes calculating the effectiveness, which is a function of the heat capacity ratio, C, and the number of transfer units, NTU:

Each heat exchanger configuration has a unique relation used to calculate the effectiveness. These
become the fundamental equations for the six thermal models that use the NTU method:
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Thermal Link
When modeling convective heat exchangers (such as parallel or counterflow) two heat exchanger junctions can be linked thermally.
A thermal link is when two heat exchanger junctions, which are hydraulically isolated, can exchange heat
with each other. Typical use is when the two heat exchangers represent two sides of the same physical
heat exchanger. When thermal linking is specified in a heat exchanger Specifications window, the user
must specify the heat transfer area and overall convection coefficient. AFT Arrow will force the two heat
exchanger junctions to use the same value.

Related Topics
Heat Exchanger
Thermal Link
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Orifice
The Orifice junction type requires two connecting pipes, unless you specify it as an exit orifice, in which
case only one connecting pipe is allowed. This junction type allows you to model the irrecoverable loss
that occurs through a plate-type flow restriction. It also allows you to specify loss factors as a function of a
flow parameter and an orifice loss for pipes with an area change.
The Orifice Properties window follows the first of the two basic Properties window formats, displaying the
connecting pipes in a fixed format. The Orifice junction does not have an explicit flow direction, but
adopts a flow direction from the connecting pipes.
Orifices that are located at exit points are specified as exit orifices. These orifices require an associated
back pressure definition. Exit orifices can only be connected to a single upstream pipe. To specify an exit
orifice, select the Exit Orifice checkbox on the Loss Model tab. Then specify the exit pressure and temperature.

Orifice Types
AFT Arrow provides two standard orifice types: sharp-edged and rounded. These loss factors are calculated based on correlations. In addition to the standard orifices that AFT Arrow provides, you can enter
your own custom orifice loss factor that is consistent with the application.
For convenience, you can specify constant loss characteristics of an orifice as a discharge coefficient
(Cd) or as a loss factor (K). The standard orifice geometries include a functional dependence on the
upstream and downstream pipe areas, which may be different.
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When you select Resistance Curve, the Orifice Properties window makes additional features available.
Using these new features you can input Orifice loss factors or pressure drops that vary with flow. To enter
these factors, you can fit a curve to available data, or use interpolated x-y data. You can choose any of
the optional flow and pressure parameters provided; you can also specify the most convenient units.

CdA for Sonic Choking
An optional input in the Orifice Properties window is the CdA for Sonic Choking. This parameter
describes the effective area restriction in the orifice for the purpose of calculating sonic choking. In most
cases, information on the CdA must be obtained from handbook or test data.
Note: The CdA for sonic choking may be different from the subsonic CdA loss model option in Arrow.
The discharge coefficient can vary at different pressure ratios due to the vena contracta moving
closer to or farther from the orifice restriction. For the highest accuracy the CdA used for subsonic and sonic losses should be tested and entered separately. See the "Modeling Choked
Flow Through an Orifice" white paper on AFT's website for more information.

Related Topics
Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model
Orifice Loss Model
Subsonic vs. Sonic Pressure Losses
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Flow Through an Orifice
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Orifice Loss Model
Sharp-Edged Orifice with Different Upstream and Downstream Diameters
The orifice loss factors are all for turbulent Reynolds numbers. The sharp-edged orifice shown in Figure
1, is given by the following (Idelchik 2007, 259):
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Figure 1: Sharp-edged orifice (in this case Aup = Adown)

Round-Edged Orifice with Different Upstream and Downstream Diameters
When the upstream and downstream pipe diameters are different for a round-edged orifice as shown in
Figure 2, the round-edged orifice equation for different pipe areas is used and is given by the following
(Idelchik 2007, 258)

where

Figure 2: Round-edged orifice with different upstream and downstream pipe areas
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Round-Edged Orifice with Identical Upstream and Downstream Diameters
When the upstream and downstream pipe diameters are the same for a round-edged orifice as shown in
Figure 3, the round-edged orifice equation for the same pipe areas is used and is given by the following (Idelchik 2007,262)

where

Figure 3: Round-edged orifice with the same upstream and downstream pipe areas

For other orifice configurations, see Chapter 4 of Idelchik's Handbook of Hydraulic Resistance (2007).

Orifice Discharge Coefficient
An alternate method of modeling subsonic pressure loss uses the discharge coefficient. To model this,
choose User Specified loss option and the Cd option for Loss Model.
When solving the system, AFT Arrow creates a subsonic CdA for the orifice and solves the pressure drop
by iterating the following equation for pressure drop for a given mass flow rate (Keenan 1941, 317):

where up and down subscripts refer to conditions upstream and downstream of the orifice. In this implementation, the pressures and temperature are static, but the velocity (i.e., Mach number) in the pipe is
low compared to the orifice. Therefore, stagnation pressures and temperatures are used. Note that R in
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this equation is the specific gas constant, which is equivalent to the universal gas constant divided by the
molecular weight of the gas in the system.

Related Topics
K Factor Loss Model
Orifice
Subsonic vs. Sonic Pressure Losses

218
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Relief Valve
The Relief Valve junction allows users to model a valve that opens at a specified pressure in the system.
Depending on how the relief valve operates, that pressure could either be the pressure at the relief valve
inlet or the pressure at some remote point in the system. The differences between those valves are discussed below.
The Relief Valve Properties window follows the first of the two basic Properties Window formats, displaying the connected pipes in a fixed format. The Relief Valve junction adopts a flow direction from the
connecting pipes.
There are three types of relief valves available:
l

Internal Relief Valve: contains two connecting pipes and relieves into the downstream pipe. This
type of relief valve acts like a regular valve that is closed until the specified pressure is reached.

l

Exit Valve: contains one connecting pipe and relieves to an external ambient pressure when the
specified pressure is reached.

l

Inline Exit: contains two connecting pipes and relieves to an external ambient pressure when a
specified pressure is reached. This type of relief valve acts as a lossless connection when closed
and allows flow between the connecting pipes.

Opening and Closing Profiles
The Relief Valve junction has several methods by which the valve can open and close. These options
are:
l

Instant: the relief valve opens fully or closes fully from one time step to the next as the opening or
closing conditions are met.

l

Pressure: the valve passively opens or closes according to a Cv vs. Pressure profile as the opening or closing conditions are met. The Cv vs. Pressure profiles are based on the Valve Setpoints
and the data entered in the Loss Model tab. Maximum Cv vs. Time rate limits can be applied.

l

Never: the valve never closes. This method cannot be applied to the valve opening.

Balanced vs Unbalanced Valves
Relief valves can either be hydraulically balanced (constant backpressure) or non-hydraulically balanced. This characteristic of the valve is determined by how the dome of the relief valve is pressurized.
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For an unbalanced valve, the dome of the valve is pressurized via the fluid downstream of the valve.
Since the downstream pressure can change during the transient, the valve position is based on a pressure differential between the upstream and downstream pipes rather than based solely on the upstream
pressure.
For the balanced valve, the dome of the valve is pressurized to a constant pressure, often by attaching
some type of bellows device. With this system, the valve position is based only on the actual upstream
pressure.

Valve Setpoints
The valve setpoints determine when the relief valve will open and when it will be closed. These setpoints
can be defined using either pressure or head.
There are four possible valve setpoints the user needs to define:
l

Exit Pressure: the ambient pressure downstream of the relief valve for the Exit or Inline Exit valve
types. This pressure will only be used to determine when the valve opens and closes when the
relief valve is unbalanced.

l

Overpressure: the upstream pressure at which the valve is fully open. This input is only needed
when the valve opens or closes based on pressure.

l

Set Pressure: the upstream pressure at which the valve opens. This input must be specified for
all valve profiles and is replaced by the High Pressure Setpoints when Remote Sensing is
enabled.

l

Blowdown Pressure: the upstream pressure at which the valve is fully closed. All options for
valve opening and closing require this input, with the exception of the Never profile. If the relief
valve closes at the same pressure where it opens, the Set Pressure and the Blowdown Pressure
should be set to the same value.

Remote Sensing
The Relief Valve junction gives users the ability to model Remote Sensing Relief valves. This option is
available anytime the valve operates as a pressure/pressure valve.
A Remote Sensing Relief Valve is a relief valve that opens based on the pressure at a specified location
in the system other than the upstream side of the valve. In a transient system, this design allows the relief
valve to be more responsive to surge events by opening the valve before the pressure surge arrives at
the valve itself. In a steady state system, this design allows the valve to open at some remote pressure
while the degree to which the relief valve is open is determined by the pressure at the valve.

Loss Model
The Relief Valve loss information is entered on the Loss Model tab. The available options change
depending on how the valve opening and closing are defined. For all options, the Base Area for Loss
Model can be specified, with the upstream pipe being used by default.
The following loss model options are available depending on which profiles are selected:
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l

l

Instant Profiles
l

Cv (ANSI/ISA): the relief valve instantly changes from closed to a fixed Cv.

l

Kv (Constant): the relief valve instantly changes from closed to a fixed Kv.

l

CdA (Constant): the relief valve instantly changes from closed to a fixed CdA. This CdA is
defined as the product of an Orifice Effective Area (A) and a Discharge Coefficient (Cd).
l

The Orifice Effective Area can come from an API 526 letter designation or it can be
User Specified.

l

The Discharge Coefficient must always be specified by the user. The value is typically specified by the manufacturer.

l

K-Factor: the relief valve instantly changes from closed to a fixed K-Factor.

l

Resistance curve: the relief valve instantly changes from closed to a resistance curve.

Pressure Profiles
l

Cv (Variable): the relief valve moves between the closed and open states with the Cv varying between 0 and the Fully Open Cv value.

l

Kv (Variable): the relief valve moves between the closed and open states with the Kv varying between 0 and the Fully Open Kv value.

The Variable Data option for the Relief Valve Loss Model allows users to model the valve losses based
on where the valve is between fully open and fully closed. The Linear based on setpoints option has
Impulse determine those losses solely based on the setpoints the user has specified. If the user knows
enough about the valve to describe a detailed loss profile, they can select the Non-linear option. The first
data point must have a loss value of 0 at the Blowdown pressure. The final data point must have a loss
value equal to the Fully Open loss value, at the Overpressure. The entered data is interpolated during the
transient simulation.

CdA for Sonic Choking
An optional input in the Relief Valve Properties Window is CdA (for sonic choking - optional). This parameter describes the effective area restriction in the orifice for the purpose of calculating sonic choking. In
most cases, information on the CdA must be obtained from handbook or test data.
Note: The CdA for sonic choking may be different from the subsonic CdA loss model option in Arrow.
The discharge coefficient can vary at different pressure ratios due to the vena contracta moving
closer to or farther from the orifice restriction. For the highest accuracy the CdA used for subsonic and sonic losses should be tested and entered separately. See the "Modeling Choked
Flow Through an Orifice" white paper on AFT's website for more information.

Special Conditions
The relief valve has two Special Conditions:
l

Failed Open: the valve is forced to remain open regardless of pressure conditions.

l

Ignore Relief Valve: the valve is forced to remain closed regardless of pressure conditions.
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For more information see Special Conditions.

Related Topics
Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model
Resistance Curve Loss Model
Troubleshooting Resistance Curves
Unique Solution Not Possible - Relief Valve Cycles
Cv/Kv and Xt Loss Model
Subsonic vs. Sonic Pressure Losses

206
207
217
218
221
683
674
220
501

Screen
The Screen junction type requires two connecting pipes. This junction type allows you to model the irrecoverable loss that occurs through a screen, mesh, or filter flow restriction. It also allows you to specify
loss factors as a function of a flow parameter.
The Screen Properties window follows the first of the two basic Properties window formats, displaying the
connecting pipes in a fixed format. The Screen junction does not have an explicit flow direction; it adopts
a flow direction from the connecting pipes.
AFT Arrow provides four standard screen types for your use: sharp-edged perforated plate, round-edged
perforated plate, circular wire screen, and silk thread screen. The loss factors for these screens are taken
from handbook values. In addition to the standard screens that AFT Arrow provides, you may enter your
own custom screen loss factor that is consistent with the application.
When you select Resistance Curve, the Screen Properties window makes additional features available.
Using these new features you can input Screen loss factors or pressure drops that vary with flow. To
enter these factors, you can fit a curve to available data, or use interpolated x-y data. You can choose
any of the optional flow and pressure parameters provided; you can also specify the most convenient
units.
When a variable loss is specified, AFT Arrow modifies the loss factor in the Solver to agree with the solution. You can choose any of the optional flow and pressure parameters provided, and you can specify the
most convenient units.

CdA for Sonic Choking
An optional input in the Screen Properties window is the CdA. This parameter describes the effective
area restriction in the screen for the purpose of calculating sonic choking. In most cases, information on
the CdA must be obtained from the vendor or test data.

Related Topics
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Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model
Resistance Curve Loss Model
Troubleshooting Resistance Curves
Screen Loss Model
Subsonic vs. Sonic Pressure Losses
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Screen Loss Model
The screen loss factors have much in common with orifice loss factors. In fact, the sharp-edged perforated plate and round-edged perforated plate screen losses are the same as for orifices with similar
area ratios and equal upstream and downstream areas. Refer to the orifice loss factor equations for
these relationships. The relationships are good for screen area Reynolds numbers above 100,000.
The circular metal wire screen, shown in Figure 1, is given by the following equation for screen area
Reynolds numbers above 1000 (Idelchik 2007, 598):

Figure 1: Circular metal wire screen

The silk thread screen, shown in Figure 2, is given by the following equation for screen area Reynolds
numbers above 500 (Idelchik 2007, 598):

For other screen configurations, see Chapter 8 of Idelchik's Handbook of Hydraulic Resistance (2007).
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Figure 2: Silk thread screen

Related Topics
K Factor Loss Model
Screen
Subsonic vs. Sonic Pressure Losses

218
272
501

Separator
The Separator junction type requires two connecting pipes. This junction type allows you to separate fluids out of a mixture.
The Separator Properties window follows the first of the two basic Properties window formats, displaying
the connecting pipes in a fixed format. A flow direction through the junction is adopted from the defined
directions of the connecting pipes. Separator junctions are internal to the system, with two connecting
pipes.
Either the Chempak or NIST REFPROP fluid library must be used to create a mixture for the Separator
junction to be used. These fluid libraries can be specified on the Fluid panel. Units for the amount of
gasses separated are listed below the table.

Special Conditions
The Special Condition for a Separator stops the separation, making it act like a branch junction.

Related Topics
Junctions
General Junction Information
Junction Loss Models
Separator junction X is trying to remove Y of Z but only A is entering junction
Separator junction X is trying to remove Y but none is entering junction
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Spray Discharge
The Spray Discharge junction must have at least one connecting pipe, and it allows up to four. This junction offers a flexible way of modeling a flow exiting the system through a nozzle or spray device.
The Spray Discharge Properties window follows the second of the two basic Properties window formats.
A table displays the connecting pipe information. The pipe table grows in size to accommodate up to four
connecting pipes.
The exit pressure to which the Spray Discharge junction discharges must be entered, as well as the temperature in case of inflow.
Two geometries can be modeled. The first is a normal, one hole spray, where the discharge flow area of
the hole is entered. The second is a sparger which, in principle, works in the same way as a spray. For
the sparger, the flow area of a single hole and the number of holes are entered. This assumes that the
holes are hydraulically close in proximity and are the same area.
For each connecting pipe, the pipe table on the Pipe Losses tab lists the reference flow direction and up
to two loss factors. The first loss factor is for physical flow out of the pipe and into the junction, the second
is for physical flow into the pipe and out of the junction. The loss factors can be specified independently
or left as zero. To edit within the pipe table, click in the appropriate column and row.

Loss Model
The discharge coefficient for the junction is entered in the appropriate box. The physical area of the exit
flow can also be entered. These two parameters are used to calculate the discharge flow rate, which
depends on the difference between the internal pressure in the system and the specified exit pressure.
If you select a Resistance Curve, the Spray Discharge Properties window makes additional features
available. Using these new features you can input the spray pressure drop that varies with flow. To enter
these factors, you can specify polynomial constants, fit a curve to available data, or use interpolated x-y
data.
When a variable loss is specified, AFT Arrow modifies the loss factor in the solver to agree with the solution. You can choose any of the optional flow and pressure parameters provided, and you can specify the
most convenient units.

CdA for Sonic Choking
An optional input in the Spray Discharge Properties window is the CdA. This parameter describes the
effective area restriction in the spray for the purpose of calculating sonic choking.
Note: The CdA for sonic choking may be different from the subsonic CdA loss model option in Arrow.
The discharge coefficient can vary at different pressure ratios due to the vena contracta moving
closer to or farther from the orifice restriction. For the highest accuracy the CdA used for subsonic and sonic losses should be tested and entered separately. See the "Modeling Choked
Flow Through an Orifice" white paper on AFT's website for more information.
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Special Conditions
The Special Condition for a spray discharge always closes it.

Related Topics
Junctions
General Junction Information
Junction Loss Models
Resistance Curve Loss Model
Troubleshooting Resistance Curves
Subsonic vs. Sonic Pressure Losses

206
207
217
221
683
501

Tank
The Tank junction type allows you to connect up to twenty-five pipes. One connecting pipe is required.
The Tank junction is convenient for specifying a fixed pressure in your system.
A Tank junction applies a defined pressure and temperature at the junction location in the model. When
solving a pipe flow system, a Tank causes the rest of the system to distribute the flow in a manner consistent with the defined pressure.
The Tank Properties window follows the second of the two basic Properties window formats. A table on
the Loss Coefficients folder tab displays the connecting pipe information. This table grows to accommodate up to twenty-five pipes. After you add a fifth connecting pipe, a scroll bar appears, allowing you to
review and enter loss factors for all pipes in the table.
The pipe table displays the reference positive flow direction of each connecting pipe. To enter loss
factors, select the cell in the table and edit the value. Each pipe can use a different loss model or custom
value.

Energy Balance
For an open system, most users desire that the temperature remains fixed, like the pressure does.
However, for closed, recirculating systems, you will usually want the temperature to vary. See Open vs.
Closed Systems - Balancing Energy for detailed discussion.

Related Topics
Junctions
General Junction Information
Junction Loss Models

206
207
217
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Tee/Wye
The Tee/Wye junction type requires three connecting pipes.

Loss Model
There are two Loss Models available for Tee/Wye junctions: Simple and Detailed. If you choose the
Simple type of Tee/Wye, no loss factors will be calculated. This is equivalent to a branch with no loss
factors entered for the connecting pipes. In some systems, the losses associated with a Tee/Wye are
small compared to the overall loss in the system. To avoid unnecessary calculations, you should choose
the Simple type of Tee/Wye unless you need the actual losses.
If the Detailed loss model is chosen, additional features will become available to define the arrangement
of the pipes connected to the tee/wye, as well as information on the tee/wye geometry. By default, Arrow
will automatically define the straight and branch run pipes based off of the arrangement in the Workspace. If Arrow cannot determine an arrangement, the user will be required to define the pipe arrangement in the Tee/Wye Properties window. The arrangement defined in this window will affect the
calculated loss factors.
The Detailed type of Tee/Wye will calculate the loss factors as they depend on the flow split as well as the
geometry. Because of the dependence on the flow split, loss factors usually cannot be calculated before
performing an analysis. AFT Arrow incorporates four models to calculate tee and wye loss factors during
the actual solution. These calculations account for the developed flow pattern, requiring additional iteration. See Tee/Wye Loss Model and Tee/Wye Junction Complexity for a detailed discussion of Detailed
Tees.
If you have specific loss factors that you want to use for a Tee/Wye junction, you should use a branch
junction instead.

Related Topics
Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model
Tee/Wye Junction Complexity
Tee/Wye Loss Model

206
207
217
218
685
278

Related Blogs
Having model convergence problems? Start here!
Give me some details about Detailed Tees!
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Tee/Wye Loss Model
Note: These correlations were developed for incompressible flow. K-Factors generally give good results when used in compressible flow, but there is uncertainty in this application. See the K
Factor Loss Model topic for more discussion.
The loss factors calculated for tee and wye junctions involve complicated correlations that depend on the
flow split, the ratio of flow areas, and the angle of the connecting pipes. The models used by AFT Arrow
are taken mostly from Chapter 7 of Idelchik's Handbook of Hydraulic Resistance (Idelchik 2007). The
equations will not be shown in this topic, but the references are given in the table below.
All tees and wyes have either diverging or converging flow streams. Two sets of equations are required
for each configuration.
In the following discussion, the parameter Kc,s represents the loss factor based on the combined flow,
stream flow area, and velocity for the side branch. Similarly, Kc,st is for the straight-through pipe (the run).
Figure 1 depicts the nomenclature. K-factor subscripts refer to base area reference and location in the
Tee. For example, Kc,s represents the K-factor for the side branch (s) referenced to the combined (c)
pipe flow area.

Figure 1: Idelchik’s nomenclature for diverging and converging flow through Tee/Wye junction

In the AFT Arrow Tee/Wye window, a simpler and more general nomenclature is used. AFT Arrow refers
to the a, b and c pipes. This allows AFT Arrow to cover all the possibilities in Table 3 without specifying
exactly which pipe is combined flow pipe. In some cases, you may not know all the flow directions in a
system, and might not be able to specify which is the combined flow pipe.
AFT Arrow’s input method allows you to specify which pipe is the branch pipe. Idelchik calls this the "s"
pipe for "side branch". AFT Arrow calls it the c pipe. If the tee angle is 90 degrees, it is not important
which pipe you call the a pipe and which the b pipe. The distinction between a and b takes on more
importance for non-90 degree pipes. In this case, AFT Arrow allows you to specify the angle of the
branch pipe.
For tees/wyes the correlations used to calculate loss assume that the angle between the side branch and
straight through flow pipes (labeled as As and Ast in Figure 2 above) can be at maximum 90 degrees. If
the angle entered in the tee/wye junction exceeds 90 degrees between the side branch and straight
through flow pipe, then the loss factor will be assumed to be equivalent to the loss with a 90 degree
angle.

- 278 -

Junctions

Figure 2 shows the Tee/Wye Properties window, with the Arrangement information at the bottom of the
window. The a angle itself is specified on the Tee/Wye Model tab, where there are other options for how
to model the tee.

Figure 2: Tee/Wye Properties window allows you to specify the a, b and c pipes. The c pipe is always the
branch pipe. This general method means you do not need to know the flow direction ahead of time.
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Table 3: References for Tee/Wye junction correlations

Related Topics
K Factor Loss Model
Tee/Wye
Tee/Wye Junction Complexity

218
277
685

Related Blogs
Give me some details about Detailed Tees!

Valve
The Valve junction type requires two connecting pipes, unless you specify it as an exit valve, in which
case only one connecting pipe is allowed. This junction type allows you to model the irrecoverable loss
that occurs through a flow control component. You also have the ability to specify loss factors as a function of a flow parameter.
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The Valve Properties window follows the first of the two basic Properties window formats, displaying the
connecting pipes in a fixed format. A flow direction through the junction is adopted from the defined directions of the connecting pipes.

Valve Data Source and Loss Model
In order to completely define a valve junction, you must specify the valve data source by clicking on the
appropriate radio button under Valve Data Source. For this data source, you can use handbook data
from the Arrow library by clicking the radio button next to Handbook Data and then specifying what type
of valve you are modeling to use a loss factor from handbook data, or you can choose User Specified and
separately input the valve loss information.
Standard valve loss models are used from Idelchik, Miller and Crane.

Loss Model
The valve loss model can be defined using one of four different valve parameters. These four parameters
include specifying the valve: Cv, Kv, K factor, or resistance curve.
The Cv is defined according to the ANSI/ISA-75.01.01-2012 standard. The valve Xt data is also required
when using Cv. When Cv is selected, data for FL and FD can optionally be entered for valves with low
Reynolds numbers to calculated correction factors. If the valve diameter is entered, AFT Arrow will automatically calculate correction factors for cases where pipe diameter differs from the valve.
A special reduced port configuration can be specified by selecting User Specified under Valve Data
Source, and then checking the box next to Reduced Port Losses in the center of the window under the
Loss Model tab. Once this section has been enabled, you will need to specify the valve type and complete any required input for the specified valve.
If select to model the valve loss with a Resistance Curve, the Valve Properties window makes additional
features available. Use these features to input the pressure drop versus flow data by specifying polynomial constants, fitting a curve to available data, or using interpolated x-y data.

CdA for Sonic Choking
An optional input in the Valve Properties window is the CdA for Sonic Choking. This parameter describes
the effective area restriction in the valve for the purpose of calculating sonic choking. In most cases,
information on the CdA must be obtained from the manufacturer or test data.

Exit Valves
Valves that are used as exit flow control mechanisms are specified as exit valves. These valves require
an associated back pressure definition. Exit valves can only be connected to a single upstream pipe. To
specify an exit valve, check the Exit Valve check box, located at the bottom of the Loss Model tab. After
this box is checked, you will be required to input the exit pressure and temperature.
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Open Percentage Data
You can optionally input Cv and Xt vs. open percentage on the Optional tab. If you complete this table,
AFT Arrow will calculate the valve Cv. A graph of the open percentage, Cv, and flow area data can be displayed by clicking on the Show Graph... button to the right of the Open Percentage Data table.

Special Conditions
The Special Condition for a valve always closes it.

Related Topics
Junctions
General Junction Information
Junction Loss Models
K Factor Loss Model
Valve Modeling Closures with K Factors
Cv/Kv and Xt Loss Model
Subsonic vs. Sonic Pressure Losses

206
207
217
218
282
220
501

Related Examples
Compressed Air System

748

Related Blogs
Making Sense of xT - Valve Loss in Compressible Flow

Valve Modeling Closures with K Factors
A closed valve would have an infinite K-factor. Since it is impractical to enter infinity in such cases, AFT
Arrow uses the convention of K = -1 (negative one) to represent a closed valve.

Related Topics
K Factor Loss Model
Valve
Cv/Kv and Xt Loss Model

218
280
220
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Venturi
The Venturi junction type requires two connecting pipes. This junction type allows you to model the irrecoverable loss that occurs through a venturi area change, which is frequently used in conjunction with
pressure taps in flow measurement devices. It also allows you to specify loss factors as a function of a
flow parameter.
The Venturi Properties window follows the first of the two basic Properties window formats, displaying the
connecting pipes in a fixed format. The Venturi junction does not have an explicit flow direction, but
adopts a flow direction from the connecting pipes.

Loss Models
AFT Arrow does not provide any standard venturi loss models. Venturi flow characteristics vary from
vendor to vendor, so it is difficult to find generally applicable models. You must enter your own custom
venturi loss factor that is consistent with the application. This information should be obtained from the
manufacturer or from test data.
For convenience, you can specify constant loss characteristics of a venturi as a discharge coefficient
(Cd) or as a loss factor (K).
If you would like to model the pressure loss through the Venturi as varying with the flow rate, select the
radio button next to Resistance Curve under the Loss Model tab of the Venturi Properties window. Once
Resistance Curve is selected, additional features appear that allow you to input pressure drops versus
flow data. To enter this data, you can specify polynomial constants, fit a curve to available data, or use
interpolated x-y data.
When a variable loss is specified, AFT Arrow modifies the loss factor in the Solver to agree with the solution. You can choose any of the optional flow and pressure parameters provided, along with the most convenient units.

CdA for Sonic Choking
An optional input in the Venturi Properties window is the CdA for sonic choking. This parameter describes
the effective area restriction in the venturi for the purpose of calculating sonic choking. In most cases,
information on the CdA must be obtained from test or manufacturer data.
Note: The CdA for sonic choking may be different from the subsonic CdA loss model option in Arrow.
The discharge coefficient can vary at different pressure ratios due to the vena contracta moving
closer to or farther from the orifice restriction. For the highest accuracy the CdA used for subsonic and sonic losses should be tested and entered separately. See the "Modeling Choked
Flow Through an Orifice" white paper on AFT's website for more information.

Related Topics
Junctions
General Junction Information

206
207
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Junction Loss Models
K Factor Loss Model
Resistance Curve Loss Model
Troubleshooting Resistance Curves
Subsonic vs. Sonic Pressure Losses

217
218
221
683
501
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Interface and User Options
This section focuses on the how the items within AFT Arrow's various menus and tabs can be used to
customize the user's experience within the software. Topics discussed include the options present in
each of the AFT Arrow drop-down menus, the tools available in the five Primary Window tabs, and
descriptions of the customizable parameters in the User Options menu.

Contents
Menus and Toolbars

285

Print Preview

297

Primary Window Overview

298

Status Bar

298

Quick Access Panel

299

Model Status Light

305

Solution Progress Window

305

Workspace Window

306

Model Data Window

317

Output Window

322

Graph Results Window

334

Visual Report Window

357

User Options Window

364

Menus and Toolbars
Many of the actions required to set up an AFT Arrow model can be completed from the various menus located at the top of the AFT Arrow window. Additionally, these menus can provide helpful features such as
saving, importing and exporting files, and accessing various help documents such as the product help
files and examples. These menus include
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l

The File menu

l

The Edit menu

l

The Analysis menu

l

The Tools menu

l

The Library menu

l

The Arrange menu

l

The Window menu

l

The Help menu

This topic also gives a high level overview of Toolbars, including the Main Toolbar as well as each
Primary Windows toolbar.

File Menu
l

New - Opens new model.

l

Open - Calls Open file common dialog window so pre-existing model can be selected for opening.

l

Save - Saves input model to disk using current model file name.

l

Save As - Opens Save As common dialog so you can specify a file name to save model to disk.

l

Save Graph As - (Graph Results Only) - Opens Save Graph As common dialog so user can specify a file name to save graph as a graphics image file to disk.

l

Save Graph Data As - (Graph Results Only) - Opens Save Graph Data As common dialog so
user can specify a file name to save graph x-y data to text file on disk.

l

Import Graph Data - (Graph Results Only) - Allows for data as .txt and .dat to be imported for creating graphs

l

Export Model Data - (Model Data Only) - Opens formatting window and Save As dialog where
you can specify data from the Model Data window to be saved to a delimited file appropriate for
spreadsheet use. Available in Model Data window.

l

Export Output - (Output Only) - Opens formatting window and Save As dialog where you can specify data from the Output window to be saved to a delimited file appropriate for spreadsheet use.

l

Import Excel Change Data - (Workspace and Model Data Only) - Imports data from Excel file
which modifies certain input data.

l

Excel Export Manager - Opens the Excel Export Manager.

l

Merge - (Workspace Only) - Opens a Merge dialog where you can specify another model file to
merge into the current model.

l

Print Preview - Opens Print Preview which allows you to specify special formatting for printed
graphics and text, as well as preview printed content before sending it to the printer.

l

Start Batch Run - The Start Batch Run button on the File Menu opens a Batch Run dialog where
you can select a different scenarios or models and initiates a process whereby Arrow runs the multiple scenarios/models automatically.

l

Load Background Picture - (Workspace Only) - Loads a background picture into the Workspace. Formats supported include bitmap, windows metafile, enhanced metafile, JPEG, GIF and
RLE. Available in Workspace window.

l

Import Piping Layout From
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l

l

Piping Component File (.pcf) - Import a Piping Component File

l

CAESAR II Neutral File (.cii) - Import a CAESAR II Neutral File

l

GIS Shapefile (.shp) - Allows for Importing GIS Shapefile (geospatial maps) as .shp file.

l

EPANET File (.inp) - Import an EPANET File

Export Piping Layout To
l

l

EPANET File (.inp) - Export an EPANET File

Exit - Exits AFT Arrow.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
Menus and Toolbars
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Edit Menu
l

Undo - (Workspace Only) - Undoes the previous workspace manipulation action. Arrow will keep
track of a historical list of changes, and users can revert the workspace back to any of those previous states.

l

Redo - (Workspace Only) - Reverts the workspace following Undo actions. Arrow will keep track
of undo actions, and users can redo any changes that have been undone.

l

Cut - (Workspace Only) - Cuts the selected pipes and junctions on the Workspace and places
them on the clipboard.

l

Copy - (Workspace, Model Data, and Graph Results Only) - Copies the selected contents to the
clipboard.

l

Copy X-Y Data - (Graph Results Only) - Copies numerical data from graph to the Windows clipboard. Available in the Graph Results window.

l

Copy Graphics - (Workspace and Visual Report Only) - Copies selected Workspace or Visual
Report content to the Windows clipboard. Formats supported include bitmap, windows metafile,
and enhanced metafile.

l

Paste - (Workspace Only) - Pastes clipboard pipes and junction contents (from previous cut or
copy operation) into the Workspace model. New paste preview mode allows the pasted pipes and
junctions to be moved and specifically placed where desired and will indicate interference with
other junction by changing color. A green box indicates that there is no interference and a red box
indicates that the junctions will be overlapping and are not in a proper location. Available in the
Workspace window.

l

Delete - (Workspace Only) - Deletes the selected pipes and junctions on the Workspace.

l

Duplicate - (Workspace Only) - Duplicates the selected pipes and junctions on the Workspace.
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l

Duplicate Special - (Workspace Only) - Opens Duplicate Special dialog window where you can
specify the increment by which all pipes and junction numbers will be increased when the model is
duplicated, the creation of a new group from the duplicated objects, and whether to hide the duplicated objects in the output.

l

Select All - (Workspace Only) - Selects all pipes and junctions on the Workspace.

l

Select Last Selection - (Workspace Only) - The most recent pipes and/or junctions selected may
be reselected by selecting Select Last Selection from the Edit menu.

l

Select Special - (Workspace Only) - Opens Select Special window where group of pipes and
junctions can be built up.

l

Select Flow Path - (Workspace Only) - Selects the sequence of pipes and/or junctions in the flow
path connected to the selected pipe(s) on the Workspace.

l

Select Shortest Path - (Workspace Only) - The shortest flow path between two junctions can be
found and selected by Arrow. To enable this option, two junctions must be selected in the Workspace which Arrow will find a path between.

l

Customize Icon - (Workspace Only) - Allows user to change junction icon color, orientation, and
icon image

l

Special Conditions - (Workspace Only) - Sets or clears Special Conditions for selected pipes
and junctions on the Workspace.

l

Groups - (Workspace Only) - Allows you to create and manage groups of pipes and junctions.

l

Renumber - (Workspace Only) - Allows renumbering pipes and junctions on the Workspace
using one of the Renumbering methods.

l

Join Selected Pipes/Jcts - (Workspace Only) - A continuous series of connected pipes and junctions can be combined into a single pipe object to simplify the Workspace. See Combining and
Splitting Pipes.

l

Global Pipe Edit - (Workspace and Model Data Only) - Opens Global Pipe Edit window where
editing of multiple pipes can be performed.

l

Global Junction Edit - (Workspace and Model Data Only) - Opens Global Junction Edit window
where editing of multiple junctions can be performed.

l

Delete Annotation - (Visual Report Only) - Deletes the selected pipes and junctions on the Visual
Report.

l

Create Annotation - (Visual Report Only) - Allows you to create an annotation on the Visual
Report window.

l

Transfer Results to Initial Guesses - (Output Only) - Copies solution results into initial guesses
for pipes and junctions.

l

Make Selection Same As Parent - (Workspace Only) - Replaces all input data for the selected
pipes/junctions with data from the pipes/junctions in the current scenario's parent.

l

Clear Initial Guesses - Clears all initial guesses in pipes and junctions.

Related Topics
Workspace Window
Model Data Window

306
317
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Output Window
Graph Results Window
Visual Report Window
Menus and Toolbars

322
334
357
285

Related Blogs
AFT Responds to 2020 Customer Survey Feedback

View Menu
l

Last View - (Workspace Only) - Switches to the most recent Workspace view. The view is
changed by scrolling, zooming or using the Workspace Find. The Last View in the View Menu will
take you back to the previous view of the Workspace. You can toggle between two views by continuously clicking Last View.

l

Select Objects - (Workspace Only) - Changes cursor to selection tool to select junctions, pipes,
etc.

l

Overview Map - (Workspace Only) - Opens overview map in the Quick Access Panel.

l

Workspace Pan - (Workspace Only) - Changes cursor to pan tool to move around workspace.

l

Show Magnifier - (Workspace Only) - Turns on the Magnifier tool in the Workspace

l

Show Object Status - (Workspace Only) - Toggles Show Object Status, which checks status of
all pipes and junctions in model.

l

List Undefined Objects - (Workspace Only) - Opens Undefined Objects Window which displays
undefined pipes and junctions and their properties.

l

Extended Model Check - Performs and exhaustive check of model consistency and completeness.

l

Highlight in Pipe and Jct Windows - (Workspace Only) - Toggles Highlight Feature for pipe
and junction Properties Windows.

l

Color Common Size Groups - (Workspace with ANS Module Only) - Colors the pipes assigned
to the selected Common Size Group(s) in the Workspace.

l

Color Design Requirements - (Workspace with ANS Module Only) - Colors the pipes assigned
to the selected Design Requirement in the Workspace.

l

Bookmarks - (Workspace Only) - Allows creation and management of bookmarks.

l

Find - (Workspace Only) - Opens window whereby specific pipes and junctions can be found.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window

306
317
322
334
357
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Menus and Toolbars

285

Analysis Menu
Analysis Setup - Opens the Analysis Setup window.
Time Simulation (XTS Module Only) - Allows selection of either a steady-state run or a transient run.
Goal Seek & Control (GSC Module Only) - Allows selection of whether to use the Goal Seek & Control
parameters in the current run.
Automated Sizing (ANS Module Only) - Allows selection of whether to use Network Sizing calculations
in the current run.
System Properties - Opens the Fluid panel in the Analysis Setup window.
Transient Control (XTS Module Only) - Opens the Simulation Duration panel.
Run Model - When the model is complete (as determined by the Checklist), the Run Model selection
sends the model to the Solver for solution.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
Menus and Toolbars

306
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357
285

Tools Menu
l

Scenario Manager - Opens the Scenario Manager window.

l

Last Scenario - This allows you to toggle between two scenarios by loading the most recently
loaded scenario. To do this, load one scenario using the Scenario Manager or the Quick Access
Panel, then load the other. Use the Last Scenario in the Tools Menu to then toggle between the
two scenarios by continuously clicking Last Scenario.

l

Generate Disconnected Scenario - (Output Only) - Generates a scenario which is no longer
connected into the Scenario Manager hierarchy and thus does not inherit changes from parents.

l

Scenario Comparison Tool - (Workspace Only) - This option opens the Modify Comparison window, allowing users to compare differences between any two or more scenarios in a model.

l

Output Control - Opens the Output Control Window.

l

Output Print Content - (Output Only) - Prints content from Output Window.

l

Output Language - Selects language for display of output results.

l

Model Data Control - (Model Data Only) - Opens Model Data Control Window.

l

Model Data Print Content - (Model Data Only) - Prints content from Model Data Window.
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l

Select Graph Parameters - (Graph Results Only) - Opens window to allow user to select which
parameters to graph.

l

Quick Graph Formatting - (Graph Results Only) - Opens window to allow user to change quick
graph title and axis names, fonts, and scale values.

l

Graph Options - (Graph Results Only) - Allows user to adjust various graph options

l

Visual Report Control - (Visual Report Only) - Opens Visual Report Control window.

l

Design Alerts - Opens the Design Alerts window.

l

Cost Application Manager - Opens Cost Application Manager window. Cost data can be applied
to all pipes and junctions.

l

Cost Summary - Opens Cost Summary Window.

l

Annotation Manager - (Workspace and Visual Report Only) - The Annotation Manager, available on the Tools menu, allows you to specify whether an annotation will be shown or hidden, and
in which scenarios it should appear.

l

Fluid Property Viewers - Gives options to open either the SteamCalc Viewer or Chempak
Viewer.

l

Activate Modules - Opens Activate Modules window where optional modules can be activated or
deactivated.

l

eLicense Information - Visible if AFT Arrow was opened using an eLicense - shows general
information about the eLicense.

l

Keep Network eLicense Checked Out - If a network eLicense is used, it can be kept Checked
Out to this machine. This will prevent it from being lost when going offline, and prevent it from
being accessible by other users. The license will be good for the Checkout Period - generally one
week.

l

Model Diagnostics - Opens the Model Diagnostics window, which provides troubleshooting
information.

l

User Options - Opens User Options Window.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
Menus and Toolbars

306
317
322
334
357
285

Related Blogs
Get the Most Out of AFT's Fluid Property Viewers
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Library Menu
l

Add Junction to Library - (Workspace Only) -Prompts you to enter the name to be used in the
Junction Library for the currently selected junction. After naming, adds junction to the library.

l

Edit Junctions - Opens Edit Junctions window where you can delete or rename entries in the
Junction Library.

l

Edit Fluids- Opens Edit Fluids window where you can add, delete, modify or review custom
fluids.

l

Edit Pipe Materials - Opens Edit Pipe Materials window where you can add, delete, modify or
review custom pipe materials.

l

Edit Insulations - Opens Edit Insulations window where you can add, delete, modify or review
custom insulations.

l

Edit Fittings & Losses - Opens Edit Fittings & Losses window where you can add, delete,
modify or review custom pipe fittings and losses.

l

Cost Library - Opens the Edit Cost Library window where you can add, edit, or review cost libraries.

l

Energy Cost Library - Opens the Energy Cost Library window to input time varying energy costs.

l

Library Manager - Opens the Library Manager window.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
Menus and Toolbars
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334
357
285

Arrange Menu
l

Primary Windows - Allows you to configure the Primary windows in two panes in a horizontal or
vertical orientation. The primary windows can be further rearranged by dragging the tabs into the
center of the screen and adjusted by moving the tab into the desired position in the docking guide
(see Figure 1).
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Figure 1: The Docking Guide can be used to view multiple primary window tabs at the same time

l

Sort Table By - (Output Only) - Allows user to order tables in order of any variable and in ascending or descending order. Available in the Output window.

l

Rotate Icon Right or Left - (Workspace Only) - Rotates icons for all selected junctions on the
Workspace. Available in the Workspace window.

l

Auto-rotate Icon - (Workspace Only) - Rotates the selected icon(s) to align with the connected
pipes if possible. Available in the Workspace window.

l

Rotate Selection Right or Left - (Workspace Only) - Rotates selected pipes and junctions as a
group. Available in the Workspace window.

l

Align - (Workspace Only) - Aligns selected pipes and/or junctions on the Workspace. You can
choose to align pipes and junctions, just pipes, or just junctions horizontally or vertically on the
workspace. Available in the Workspace window.

l

Pipe Drawing Mode - (Workspace Only) - Select the type of grid layout that the model will use.
l

2D Freeform - Junctions can be placed anywhere on the Workspace.

l

2D Orthogonal - Toggles orthogonal drawing capability on the Workspace. This toggle is a
shortcut to enabling the feature in the User Options window. See Orthogonal Drawing Overview for more information.

l

Isometric - Uses an isometric grid.

l

Snap to Grid - (Workspace Only) - Toggles Snap to Grid feature on the Workspace. When ON, all
Workspace pipes, junctions and annotations snap to a grid specified in the User Options window.
Available in the Workspace window.

l

Show Grid - (Workspace Only) - Toggles Show Grid feature on the Workspace. Shows or hides
grid that is specified in User Options window. Available in the Workspace window.

l

Make Selected Pipes and Jcts Orthogonal - (Workspace Only) - Makes all selected pipes and
pipes connected to selected junctions on the Workspace orthogonal. Available in the Workspace
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window.
l

Flip Vertex - (Workspace Only) - Available when orthogonal drawing is enabled. This will flip the
vertex of all selected pipes on the Workspace. Available in the Workspace window.

l

Scale/Flip Workspace - (Workspace Only) - Scales (shrinks or expands) or flips either selected
or all pipes and junctions on the Workspace. Available in the Workspace window.

l

Set Pipe and Junction Locations to Parent - (Workspace Only) - Sets locations of pipe and
junction labels to the same position as the parent scenario. Available in the Workspace window.

l

Reset Label Locations - (Workspace Only) - Sets locations of pipe and junction labels to their
default locations. Available in the Workspace window.

l

Disable Pipes Snapping to Isometric Grid - (Workspace Only) - Toggles Snap to Grid feature
on the Workspace for the selected pipe. When Snap to Grid is disabled for that pipe, the pipe end
point no longer snaps to grid points and pipe segments do not follow the Isometric lines. Available
in the Workspace window.

l

Add/Remove Segments - (Workspace Only) - Allows user to Add Segment (split single into two
pipes), Add Segment at Right Angle, Add Multiple Segments, Remove Segment, or Remove all
Segments. Available in the Workspace window.

l

Lock Object - (Workspace Only) - Locks selected pipes and junctions on the Workspace so they
cannot be moved. A lock symbol appears next to locked pipes or junctions when an attempt is
made to move the pipe or junction. Available in the Workspace window.

l

Reverse Direction - (Workspace Only) - Reverses the reference positive flow direction of all
selected pipes on the Workspace. Available in the Workspace window.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
Menus and Toolbars
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357
285

Related Blogs
AFT Responds to 2020 Customer Survey Feedback

Window Menu
l

Workspace - Makes the Workspace window active.

l

Sizing - (ANS Module Only) - Makes the Sizing window active.

l

Model Data - Makes the Model Data window active.

l

Output - Makes the Output window active.

l

Graph Results - Makes the Graph Results window active.
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l

Visual Report - Makes the Visual Report window active.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
Menus and Toolbars

306
317
322
334
357
285

Help Menu
l

Help File - Opens help site home page

l

Use Offline Help - Indicates that the PDF help file will be used instead of the Online AFT Help File
when the help buttons in topics are clicked. Note that the PDF help file must be downloaded from
the PDF Downloads page on the online help site prior to using this option.

l

Quick Start Guide - Opens quick start guide on aft.com

l

Quick Start Video - Opens ~15 minute quick start video on aft.com in English or metric units

l

Optimization Assistant - (ANS Module Only) - Opens the Optimization Assistant to help identify
input that will potentially effect the sizing results. Also appears if problems are identified when the
model is run.

l

Keyboard Shortcuts - Opens keyboard shortcut help page

l

Show Examples - Opens help system with links to various example problems

l

Video Tutorials - Opens video tutorials on aft.com in English or metric units and English or Spanish language

l

Technical Seminars - Opens information on training courses on aft.com

l

Flow Expert Package - Opens information on aft.com for individualized help from AFT engineers
for training, modeling, consulting, and more

l

Online Learning Center - Opens learning center on AFT website with links to resources such as
blogs, video tutorials, webinars, etc.

l

AFT Home Page - Opens home page on aft.com

l

AFT Blog - Opens blog on aft.com

l

Send Email to Support - Links to AFT support in your default email program

l

Latest Release - Opens page on aft.com to download the newest AFT Arrow release

l

AFT Notifications - Opens page on aft.com where you can sign up for email notifications for new
software updates and releases

l

About AFT Arrow - Opens window in AFT Arrow with information on current AFT Arrow version,
license number, etc.

Related Topics
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Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
Menus and Toolbars

306
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Toolbars
The Toolbars offer quick access to the features used most frequently in AFT Arrow. Figure 1 shows the
Toolbars. There are actually six Toolbars in all. One is the Common Toolbar, and it is always shown. Its
features are common to all five Primary Windows. In addition, there is one Toolbar for each Primary Window, offering features appropriate for work in that window. You only see two Toolbars at a time in AFT
Arrow. The function of each icon in a given Toolbar appears when you pass the mouse over the icon button without clicking on the button. Each of the functions on the Toolbar is also available through the menu
system.

Figure 1: Common Toolbar

Figure 2: Workspace Toolbar

Figure 3: Model Data Toolbar

Figure 4: Output Toolbar

Figure 5: Graph Results Toolbar
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Figure 6: Visual Report Toolbar

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
Menus and Toolbars
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Print Preview
The Print Preview window allows you to access special print features such as Print Preview and Fit to
One Page. It is accessed from the File menu or Toolbar.
The Print Preview window also offers you a preview of the print content and format for all Primary Windows. By clicking the Print Preview button you can review your printed material at several zoom states.
Individual pages can be printed.
The Fit To Page(s) feature causes the graphic image generated from the Workspace or Visual Report
windows to be compressed onto the specified number of pages. This is a convenient feature for creating
reports of your model. AFT Arrow supports whatever printer page sizes are supported by your printer, so
use of legal paper or larger may allow you to get more visible details. The graphics can also be centered
vertically and/or horizontally. You also can fit your content onto multiple pages.
The Page Setup option in the Print Preview window allows you to set the page orientation, paper size/type, and margins.
Additional special printing features affect the Workspace and Visual Report. The Selected on Workspace
option works with Workspace printing by selectively printing the pipes and junctions currently selected on
the Workspace.
By default, AFT Arrow prints the junction icons for the Workspace and Visual Report with the same colors
as displayed on the screen. It also prints the background color as the same color as your Workspace or
Visual Report background. You can specify that the entire printout be black and white by adjusting the
printer preferences in the Print window.
If you added a background picture from the File Menu, you can include this picture in the printout.
Finally, if you have a grid displayed on the Workspace or Visual Report, the grid will be included in the
printout.
Page options allow the use of a company logo, user comments, titles, and different options for borders.

Related Topics
Interface and User Options

285
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Related Blogs
Quick Guide to Custom Output

Primary Window Overview
AFT Arrow has five Primary Windows. The Primary Windows are tabbed and can be pulled out of the
main window onto separate screens. The Primary Windows are permanent in that you work in one of
these windows at all times. The Primary Windows work together to provide tools for entering model input,
analyzing results for accuracy, and preparing results for documentation.
l

The Workspace window allows you to build the model visually and see the model layout.

l

The Model Data window is the text-based complement to the Workspace window. The Model Data
window shows input data in text form. This window works hand-in-hand with the Workspace window to provide exceptional flexibility in manipulating data.

l

The Output window displays the results of the analysis in text form and lets you produce attractive,
effectively organized printed output.

l

The Visual Report window merges the output data with the pipe system layout from the Workspace to present a unique perspective of the results. This window also allows customized layout
of the information for documentation and presentation purposes. An alternate use for the Visual
Report window is to show textual input data combined with the input schematic.

l

The Graph Results window provides full-featured Windows plotting capability. Here results can be
viewed in a variety of ways for evaluating system performance or identifying important trends. The
Graph Results window also allows graph customization.

You can change between the five Primary Windows by selecting them from the Window menu, the Toolbar, or by clicking the appropriate icons within the AFT Arrow window.
If the ANS module is activated, an additional primary window called the Sizing window will be available,
which allows sizing information to be configured.

Related Topics
Interface and User Options

285

Status Bar
AFT Arrow's Status Bar displays contextual information about the current scenario or operation.
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Figure 1: Current scenario displayed in the Status Bar

The Status Bar indicates the status of certain operations - for example, when opening a model the progress of loading the pipes, junctions, and scenarios is displayed.

Figure 2: Status Bar displaying progress when opening a model

Related Topics
Interface and User Options

285

Quick Access Panel
The Quick Access Panel, as shown in Figure 1, contains several useful features. The Quick Access
Panel allows you to easily manage your scenarios, navigate very large models, activate modules, monitor the status of the Checklist, and view the input properties and output results for a pipe or junction.
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Figure 1: The Quick Access Panel

By clicking on the "Scenario" tab in Figure 2 below, you have the full scenario customization ability as you
would with the Scenario Manager. You can create child scenarios, expand or collapse various families of
scenarios, and utilize the many other Scenario Manager features here as well.

Figure 2: The Scenario Manager
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When a model is very large in size, it can be troublesome to have to constantly drag the model around on
the Workspace to get to a specific area of the model you want to view. By clicking on the "Workspace
Overview Map" button in the red box in Figure 3, you will bring up a map that is a bird's eye view of the
model. Drag the small square in the Workspace Overview Map over various parts of the model, then
zoom in and out of the model. You can also click the "Fit" button to see the full model zoomed out on the
Workspace. You can also zoom in and out using the mouse wheel.

Figure 3: Workspace Overview Map

Clicking the Modules button in the bottom right of the Quick Access Panel brings you to the Modules
panel in the Analysis Setup window to activate or deactivate add-on modules.
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Figure 4: Activating the Modules from the Quick Access Panel

In the bottom far right of the Quick Access Panel in Figure 5 is the Status Light. Clicking on the status
light will open Analysis Setup. When each item in the Analysis Setup window is fully defined, it will have
a green check mark icon. When all necessary items in the Analysis Setup window are completed, the
Status Light will turn from red to green.

Figure 5: The Status Light

As seen in Figure 1, there is a "Properties" tab in the Quick Access Panel. When pipes and junctions are
drawn on the Workspace, you can quickly view the Pipe or Junction Properties by first, selecting a pipe or
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junction on the Workspace, then clicking on "Properties" tab. This will display the Object Property data
as well as any Output data if the model has been run. Figure 6 below shows an example of what the
Properties tab would look like when clicking on a pipe on the Workspace after it has been defined and output was created.

Figure 6: Viewing the Pipe (or Junction) Properties and Output Data from the Quick Access Panel

Minimizing the Quick Access Panel
By default, AFT Arrow opens with the Quick Access Panel automatically expanded. The Quick Access
Panel can be easily collapsed and pinned to the side of the Workspace to allow for a larger usage area of
the Workspace. Figure 7 shows the AFT Arrow window with the Quick Access Panel initially expanded.
By clicking on the thumbtack pin button highlighted with the red box, the Quick Access Panel will then
become collapsed as shown in Figure 8. After the Quick Access Panel is collapsed, it can be temporarily
expanded again simply by hovering over the "Scenario" sidebar with the mouse.
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Figure 7: The Workspace with the Quick Access Panel Expanded
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Figure 8: The Workspace with the Quick Access Panel collapsed

Related Topics
Interface and User Options

285

Model Status Light
The light at the right of the Status Bar located at the bottom of the AFT Arrow window, which indicates
whether or not the model is ready to run.
Clicking on the Model Status Light will show the Analysis Setup window.

Related Topics
Interface and User Options

285

Solution Progress Window
Solution Progress indicates the current state of the solution iterations.
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The most out of tolerance junction or pipe is listed for the appropriate tolerances, along with general
information about the solution method and related settings.
Note: Both absolute and relative criteria are always displayed. This can be helpful for selecting the
appropriate tolerance criteria on difficult to converge models.
The area in the bottom of the window will give important feedback on the model solution. It is important
not to dismiss messages in this area, as they could have an impact on results.
When the model solution is converged, options to view Output, Graph Results, and Visual Report
become available.
Pausing the iterations allows the modification of certain Steady Solution Control parameters during the
run, as well as viewing the iteration history. These options are available under Other Actions.

Related Topics
Interface and User Options
Iterations Panel
Review the Iteration History

285
133
689

Workspace Window
The Workspace window is the sole area where you specify the model layout and connectivity. The Workspace window has two separate functional areas: the Toolbox on the far left and the Workspace itself
encompassing the rest of the screen (see Figure 1).

Figure 1: The Workspace window is where you assemble your model
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Display and Printing Features
The Workspace image can be:
l

Copied to the clipboard

l

Saved to a picture file

l

Saved directly to an Adobe PDF file

l

Sent to the printer

The Print Preview window allows the above outputs to be applied to all or selected Workspace objects.

Related Topics
Interface and User Options
Menus and Toolbars
Merging Models
Renumbering Workspace Objects
Scale/Flip Workspace Description
Magnifier Tool
Annotations
Extended Model Check
Keyboard Shortcuts for Workspace
Undefined Objects Window
Raw Data Changes
Duplicate Special
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315
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311

Merging Models
Two models can be merged together using the Merge command on the File menu. Here’s how:
1.

Open the first model

2.

Choose Merge on the File menu

3.

From the file list, select the model to be merged

If there are duplicate numbers, the objects in the second model will be changed. The second model will
be selected (highlighted) so that you can move it into position (be careful not to click off the selected portions or the second model may be deselected).
Tip: To move a selected group of objects, use a junction icon, instead of a pipe, to drag the group.
This will avoid missing the pipe and clicking on an empty area of the Workspace which will
deselect your group.
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Merging Models with Multiple Scenarios
If the model you are merging from has multiple scenarios, only the base scenario can be merged. If you
want to merge one of the children of that model, do the following:
1.

Open the model which you want to merge.

2.

In the Scenario Manager select the child scenario you want to merge.

3.

Right-click the selected scenario and choose the Save Scenario to File Without Children.

4.

Enter a name and click OK. This process creates a new model with the desired scenario as the
base scenario.

5.

Open the original model and merge in the new model file created in Step 4.

Related Topics
Workspace Window
Renumbering Workspace Objects
Scale/Flip Workspace Description
Magnifier Tool
Annotations
Extended Model Check
Keyboard Shortcuts for Workspace
Undefined Objects Window
Raw Data Changes
Duplicate Special
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Renumbering Workspace Objects
Objects on the Workspace can be renumbered by choosing Renumber from the Edit menu. There are
several ways that Renumbering can proceed.

Renumber Wizard
The Renumber Wizard allows you to renumber pipes and/or junctions by simply clicking on them on the
Workspace. Normal Workspace functions are suspended when the Renumber Wizard is active. The
Renumber Wizard is activated on the Edit menu.
When the Renumber Wizard is active the settings can be modified in the Quick Access Panel. Click Done
Renumbering in the Quick Access Panel to finish renumbering and exit the wizard.

Renumber Automatic
Selected pipes and/or junctions can be renumbered starting at the lowest selected number or at a specified number. If a pipe or junction which is not selected to be renumbered already has the next number in
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sequence, it will only be changed if the Force Sequential checkbox is checked.
Arrow will start at the beginning of the flow path containing the lowest numbered selected pipe and will
attempt to march down the pipes in the direction of flow. It is recommended that renumbering be performed after the model has been completed so that the junctions and pipes are completely connected.
Tip: If you want certain sections of the model to be numbered in sequence, then use the Renumber
feature on the selected sections only. It is also preferable in the case of large or complicated
models to renumber small sections at a time.

Renumber Increment
Renumber Increment is on the Edit menu and allows you to increment or decrement all selected pipes
and junctions by a specified value.

Related Topics
Workspace Window
Merging Models
Scale/Flip Workspace Description
Magnifier Tool
Annotations
Extended Model Check
Keyboard Shortcuts for Workspace
Undefined Objects Window
Raw Data Changes
Duplicate Special
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Scale/Flip Workspace Description
The Workspace can be scaled horizontally and/or vertically by choosing Scale/Flip Workspace on the
Arrange menu. Scaling will move the junctions and will stretch or shrink the pipes so that the area the
model covers is changed by the percentage specified.
Flipping the Workspace horizontally and/or vertically will move the pipes and junctions to their mirror
image locations. This is useful when you are building a system which has symmetrical or mirrored sections. For example, you could select the section, duplicate it, and then flip it horizontally, vertically, or
both, with Scale/Flip Selected Objects Only checked.

Related Topics
Workspace Window
Merging Models
Renumbering Workspace Objects
Magnifier Tool

306
307
308
310
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Annotations
Extended Model Check
Keyboard Shortcuts for Workspace
Undefined Objects Window
Raw Data Changes
Duplicate Special

311
312
313
315
316
311

Magnifier Tool
The Magnifier tool can be used to provide a magnified view of any area on the Workspace. This is useful
for navigating and viewing details of a large model without needing to zoom in on that area. The Magnifier
tool can be accessed from the Workspace Toolbar, as can be seen in Figure 1 below. The magnifier tool
can be enabled/disabled by clicking the button on the Toolbar.
There are several options available to adjust the Magnifier view:
l

Zoom Level - Adjusts the level of magnification used

l

Magnifier Size - Adjusts the size of the magnifier circle

Figure 1: Magnifier tool on the Toolbar

The Magnifier tool can also be used in the Visual Report window.

Related Topics
Workspace Window
Merging Models
Renumbering Workspace Objects
Scale/Flip Workspace Description
Annotations
Extended Model Check
Keyboard Shortcuts for Workspace
Undefined Objects Window
Raw Data Changes
Duplicate Special

306
307
308
309
311
312
313
315
316
311
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Annotations
The Toolbox tool to the right of the Pipe Drawing Tool is the Annotation Tool. With this tool, you can draw
a box that will contain an Annotation displayed on the Workspace.
The Annotation Tool allows you to create a text message, show an outline around the message, insert
pictures in the message box, and draw lines with pointers to certain areas of the model. Different style,
color and font options are provided.
Annotations can be "attached" to the Workspace, a pipe, or a junction. When attached to the Workspace,
the annotation always remains in the same location until you move it. When attached to a pipe or junction, the annotation will move when the pipe or junction is moved. The Scenario Options tab allows you to
specify in which scenarios the annotation appears.
Annotations can be layered to be either "Always in Front" or "Always in Back".
Annotations print out with the model.
Annotations can be displayed or hidden among different scenarios using the Annotation Manager from
the Tools Menu.

Related Topics
Workspace Window
Merging Models
Renumbering Workspace Objects
Scale/Flip Workspace Description
Magnifier Tool
Extended Model Check
Keyboard Shortcuts for Workspace
Undefined Objects Window
Raw Data Changes
Duplicate Special

306
307
308
309
310
312
313
315
316
311

Duplicate Special
Duplicate Special allows the model to be copy & pasted, while simultaneously applying other helpful settings as explained below. Additional options will be available when the ANS module is activated.
l

Increment All Pipe and Junction Numbers By - Adds the specified number to all pipe/junction
numbers for the created object duplicates. Useful for maintaining consistent numbering

l

Create Group - Adds the duplicates to a group.

l

Hide in Output - Automatically hides the pipe and junction duplicates in the Output window so
only the original pipes and junctions will be seen.

l

Make Dependent Design Case - (ANS Only) - Sets the duplicate objects as a Dependent
Design Case of the duplicated model.

l

Keep Common Size Groups - (ANS Only) - Only available if "Make Dependent Design Case" is
checked. This adds the duplicate objects to the same Common Size Groups that the original
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objects were included in.
l

Clear Design Requirements - (ANS Only) - This clears all Design Requirements from the newly
created objects.

Related Topics
Workspace Window
Merging Models
Renumbering Workspace Objects
Scale/Flip Workspace Description
Magnifier Tool
Annotations
Extended Model Check
Keyboard Shortcuts for Workspace
Undefined Objects Window
Raw Data Changes

306
307
308
309
310
311
312
313
315
316

Extended Model Check
The connections and settings of each pipe and junction are exhaustively checked using the Extended
Model Check item on the View menu. This is also helpful if the model seems to not be connected correctly.

Related Topics
Workspace Window
Merging Models
Renumbering Workspace Objects
Scale/Flip Workspace Description
Magnifier Tool
Annotations
Keyboard Shortcuts for Workspace
Undefined Objects Window
Raw Data Changes
Duplicate Special

306
307
308
309
310
311
313
315
316
311
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Keyboard Shortcuts for Workspace
Selection Box
l

Select all objects completely inside box by dragging cursor from left to right

l

Select all object completely or partially inside box by dragging cursor from right to left

Pipe Drawing Tool
l

If you double-click the pipe drawing tool, it will allow you to draw multiple pipes at a time. Clicking
Esc or clicking the pipe drawing tool again will deactivate the tool.

l

When orthogonal drawing is off and you hold down the SHIFT key while drawing pipes on the
Workspace, you can draw pipes that are perfectly horizontal or vertical. When the orthogonal
drawing is on and you hold down the SHIFT key down while drawing new pipes on the Workspace
the pipe vertex will flip. If you move an existing pipe and hold the shift key while selecting a handle
at one of the pipe endpoints a new vertex will be inserted at that point endpoint.

l

To add pipe segments, use CTRL+SHIFT+Y

l

To remove all pipe segments, use CTRL+SHIFT+N

Junctions
l

If you double-click any junction in the Toolbox, you will be able to place multiple of that junction on
the Workspace by clicking the Workspace where you would like to place each junction. Clicking
Esc or clicking the junction icon in the Toolbox again will deactivate the tool.

l

If you hold down CTRL key and select a junction from the Toolbox and drop it onto an existing
Workspace junction, the old junction will "morph" into the new one. The junction type will change
to the new junction type, and data that can be kept will be copied into the new junction.

l

If you hold down the CTRL key then drag a junction on the Workspace which has pipes connected
to it, the junction will move but the pipes will not move with it

l

If you hold down the SHIFT key while selecting a junction from the Toolbox and then drop the junction onto an existing pipe, the pipe will split into two pipes. You will specify the length of the first
pipe and the second pipe will be automatically set to the remaining length from the original pipe.
Thus the sum of the two pipe lengths will equal the length of the original pipe. You can also choose
which pipe contains any Fittings & Losses that were specified within the original pipe.
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Figure 1: Split pipe keyboard shortcut

Pipe and junction Properties Window
l

When in a pipe or junction Properties Window you can toggle the highlight feature by pressing the
F2 function key. You can also toggle this from the View menu.

l

When in a Pipe Properties Window, if you press the F5 function key, you will jump to the next
highest numbered pipe. If you press the CTRL key while pressing the F5 function key, you will
jump to the next lowest numbered pipe. The F5 function key also behaves this way for junction
Properties Windows.

Pan and Zoom
l

The Workspace position can be moved with CTRL + arrow keys.

l

The Zoom level can be adjusted with CTRL + (+/-)

l

The Zoom level can be reset to default with CTRL + 0

l

Mouses with scroll wheels can be used to zoom by scrolling, or to pan by clicking and holding the
scroll wheel

Switching Primary Windows
l

Go to the Workspace window using CTRL + W

l

Go to the Model Data window using CTRL + M

l

Go to the Output window using CTRL + U

l

Go to the Graph Results window using CTRL + G
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l

Go to the Visual Report window using CTRL + I

l

When ANS is active, go to the Sizing window using CTRL + N

Other
Many commands use common windows shortcuts. Some of the most common are listed here:
l

Run the model: CTRL + R

l

Save the model: CTRL + S

l

Open a file: CTRL + O

l

Undo the last action: CTRL + Z

l

Cut: CTRL + X

l

Copy: CTRL + C

l

Paste: CTRL + V

l

Other available shortcuts can be seen listed by their command on the menus

Related Topics
Toolbox
Creating Pipes - the Pipe Drawing Tool
Creating Junctions
Workspace Window
Merging Models
Renumbering Workspace Objects
Scale/Flip Workspace Description
Magnifier Tool
Annotations
Extended Model Check
Undefined Objects Window
Raw Data Changes
Duplicate Special

161
162
166
306
307
308
309
310
311
312
315
316
311

Undefined Objects Window
This window is launched by clicking the "Define All Pipes and Junctions" item in the Analysis Setup window when there are undefined objects in the model.
This window displays all undefined pipes or junctions in the model. Clicking on the undefined object will
display the undefined properties in the list below. All undefined data for all objects can be saved to the file
or copied to the clipboard.
Any undefined object's Properties window can be launched by double-clicking the object's name in the
list to finish defining the object.
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Related Topics
Workspace Window
Merging Models
Renumbering Workspace Objects
Scale/Flip Workspace Description
Magnifier Tool
Annotations
Extended Model Check
Keyboard Shortcuts for Workspace
Raw Data Changes
Duplicate Special

306
307
308
309
310
311
312
313
316
311

Raw Data Changes
When other objects in the model use the same base raw data as the current object and the data is
changed, you can decide whether to use the new data on the other model objects.
This frequently happens when you have multiple junctions based on the same x-y data for pump curves
or junctions resistance curves, and later change that x-y data. The question is whether you want to have
only the current junction you are working on updated, or all junctions that use that same base data.

Figure 1: Raw Data Change Options

Related Topics
Workspace Window
Merging Models
Renumbering Workspace Objects

306
307
308
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Scale/Flip Workspace Description
Magnifier Tool
Annotations
Extended Model Check
Keyboard Shortcuts for Workspace
Undefined Objects Window
Duplicate Special

309
310
311
312
313
315
311

Model Data Window
The Model Data window offers a text-based perspective on all engineering information in the pipe flow
model. This window is useful for obtaining a global view of the model and rapidly checking the input.
The Model Data window does not offer any tools to build or add to a model; all model assembly must happen in the Workspace.
The Model Data window allows you to manipulate existing elements from the Workspace. Therefore, a
complete model can be assembled in the Workspace window without ever opening the Model Data window. In fact, for small models this may be the preferred approach.
General, Pipe, and Junction section display sizes can be changed by the user by clicking and dragging
the bars between each section to resize them. Each section can also be hidden by clicking the arrow in
the upper left of each section.
You can use the zoom feature in the lower right hand corner of the Model Data window to resize the text
displayed on screen.

Figure 1: The Model Data window displays input in text form
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Editing Features
The Pipe table allows display of all input data for all pipes in the model. Details of Fittings & Losses are
displayed in the Pipe Loss Data table, accessed with an adjacent tab. The Pipe Loss Data table displays
all fittings with K-factors grouped into columns.
The other display tab in the pipe area is the Pipe Detail Summary, which assembles a list of details about
each pipe in another format useful to some engineers.
The junction data area is below the pipe data area. Here the junction data is separated into tables for
each junction type. Click the tabs to see the data for any type of junction.
To edit information in the Model Data window, you can open the Properties Window for the pipe or junction. This can be done by double-clicking the far left column where the pipe or junction ID numbers are
shown. Alternatively, you can use the Global Edit windows opened from the Edit menu.
l

GSC Module tables - When using the GSC Module, if GSC data has been entered in the Goal
Seek and Control Manager, the variable and goal data will be displayed in the General section in a
"Goal Seek & Control" table.

l

XTS Module tab - When using the XTS Module, if transient events have been defined for any
junction, the Initiation of Event settings and raw transient data will be listed for each transient
event in the Junction section in a Transient Data tab.

Display and Printing Features
Model Data Control lets you specify the combination of pipe, junction, and general information you want
to see in the Model Data Window.
The Print Content window lets you specify the content to include in the printed Model Data report and
select the font to be used for printing. This window is opened from the View menu (or Toolbar).
The Model Data window contents can be:
l

Copied to the clipboard

l

Saved to a formatted text file

l

Exported to a delimited file suitable for direct importing into spreadsheet software

l

Saved directly to an Adobe PDF file

l

Sent to the printer

Related Topics
Interface and User Options
Menus and Toolbars
Model Data Control
Bill of Materials

285
285
319
321
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Related Examples
Beginner: Air Heating System

702

Related Blogs
Having model convergence problems? Start here!

Model Data Control
The Model Data Control window allows you to customize what data to show for pipes and for each junction type (see Figure 1). You can also specify which pipes and junctions to show in the Show Selected
Pipes/Junctions tab. The window can be opened from the Tools menu (or Toolbar).

Pipe Data Display
The data to be shown for pipes is selected on the left side of the Model Data Control window. Only the
items with check marks will be shown in the Model Data window. All pipes shown will report the selected
items.

Junction Data Display
The data to be shown for the junctions is selected on the right side of the Model Data Control window.
The data is grouped by junction type. However, some data is general and applied to each of the junction
types. Select the junction type from the list and then select the data for that junction type. Each type also
includes the general data which may be selected/deselected.
You can select/deselect the general data for all junction types simultaneously by clicking Set Common.
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Figure 1: The Model Data Control window allows selection of the parameters to show in the Model Data window

Show Selected Pipes and Junctions
Specific pipes and junctions can be shown in Model Data. Click the Show Selected Pipes/Jct tab, then
click the items in the lists to select the pipe(s) and junction(s) to be shown.

Other Data
It is possible to specify whether junction curve data is to be displayed with the Model Data, whether to display Design Alerts, and whether to include a Bill of Materials.

Scenario Format
A powerful Model Data feature when using scenarios is to show all direct ancestor data in the Model Data
window along with data from the current scenario. The Scenario Format features allow you to do this, and
to highlight where data changes occur. Note that the scenario name is appended to the pipe and junction
number in the left columns. This tab only appears when multiple scenarios exist.
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Library Connections
In the lower left of the Model Data Control window there is a Library checkbox. If this box is checked, your
Model Data Control parameters are setup as determined by the library to which you are connected. This
is referred to as an active library. To make it inactive, uncheck the box or change one of the Model Data
Control settings controlled by the library.
If the check box is unchecked, but enabled, you are connected to a library but the settings are not being
passed to the Model Data Control window. The library is thus inactive. To make it active, check the box
then click the OK button.
If the check box is disabled, there is no connected library.

Related Topics
Model Data Window
Bill of Materials

317
321

Bill of Materials
A bill of materials is a summary of all materials, components, and fittings that have been specified for a
project.
A bill of materials can be added to the Model Data Summary section by opening Model Data Control, and
checking "Include Bill of Materials" on the Other tab.
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Figure 1: Include Bill of Materials

Related Topics
Model Data Window
Model Data Control

317
319

Output Window
The Output window is the primary vehicle for communicating the results of an analysis in text form (see
Figure 1). The Output window follows the same general window organization as the Model Data window.
When a model is run, the Solution Progress window appears. After the solution is obtained, you can view
the results in the Output window by clicking the View Output button.
If the information in the Output window is not in the desired format, you can choose Output Control from
the Tools menu (or Toolbar) to modify the format. Output Control lets you specify the parameters, their
units, and the order of their display in the Output window.
Data in the Output window can be copied to the clipboard, saved to a text file, exported to a file in a
format for direct importing into a Windows spreadsheet package, saved directly to an Adobe PDF file, or
sent to the printer. The printed output follows the same flexible, organized, and accessible format as the
Output window itself.
The Print Content window available on the Tools menu (or Toolbar) lets you specify the content to
include in the printed Output report and select the font to be used.
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The Sort window opened from the Arrange menu (or Toolbar) offers the ability to sort the Pipe Results or
Junction Results tables according to the values in any of the columns.
The Transfer Results to Initial Guesses feature on the Edit menu (and Toolbar) sets all pipe and junction
initial flows and pressures equal to the converged results, which causes future runs to converge much
faster.
You can view the input data for individual pipes or junctions directly from the Output window in one of two
ways. First, if you press the right mouse button down on the pipe or junction number in the far left column
of the table, you will see the Inspection window. Second, if you double-click the pipe or junction number,
you will open the properties window in read-only form where you can review input in detail.
General, Pipe, and Junction section display sizes can be changed by the user by clicking and dragging
the bars between each section to resize them. Each section can also be hidden by clicking the arrow in
the upper left of each section.
You can use the zoom feature in the lower right hand corner of the Output window to resize the text displayed on screen.

Figure 1: The Output Window

Right-click Context Menu Actions
There are several options available when right-clicking on a cell, row header, column header, or entire
table in the Output window:
l

Column Header
l

Change Units - Quickly redisplay the selected column in a different unit.

l

Sort - Sort the table in Ascending or Descending order on the selected column.
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l

l

l

l

Add "Parameter" for all Table Objects to Excel Export Manager - Add this column to the
Excel Export Manager.

l

Open Excel Export Manager - Directly open the Excel Export Manager.

l

Copy Selected Cell Data - Copies all of the values in the column to the clipboard.

Row Header
l

Add all Object Parameters to Excel Export Manager - Add this row to the Excel Export
Manager.

l

Open Excel Export Manager - Directly open the Excel Export Manager.

l

Find on Workspace - Quickly locate an object on the Workspace.

l

Copy Selected Cell Data - Copies all of the values in the row to the clipboard.

l

Open Properties Window - Opens the properties window for the associated pipe or junction.

Table (upper left cell)
l

Add Object Table to Excel Export Manager - Add the entire table to the Excel Export Manager.

l

Open Excel Export Manager - Directly open the Excel Export Manager.

l

Copy Selected Cell Data - Copies all of the values in the table to the clipboard.

Cell
l

Add Object "Parameter" to Excel Export Manager - Add this cell to the Excel Export Manager.

l

Open Excel Export Manager - Directly open the Excel Export Manager.

l

Add Note - A text note can be added to any Output cell. Cells with notes will be marked
with a red triangle in the top corner. Hovering over a cell with a note allows the note to be
viewed, or edited by clicking in the note.

l

Create Design Alert - Create a Design Alert related to the selected object and value.

l

Copy Selected Cell Data - Copies the value of the cell to the clipboard.

Output Window Updates
Whenever you change the model input, all output windows are erased. This prevents you from changing
your input, forgetting to rerun it, and mistaking the previous Output window for the current model's results.

Results Diagrams
Results diagrams are available for both compressor/fan results (see Figure 2) and pipe heat transfer results(see Figure 3). These diagrams allow you display the information in a more intuitive manner, copy the
image of the diagram to your clipboard, or print the diagram. The option to show the results diagram can
be found in the compressor/fan summary tab for compressors/fans or the heat transfer tab for pipes with
heat transfer.
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Figure 2: Compressor/Fan Results Diagrams
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Figure 3: Pipe Heat Transfer Results Diagram

Printing and Exporting
Data in the Output window can be:
l

Copied to the clipboard

l

Saved to a formatted text file

l

Exported to a delimited file suitable for direct importing into spreadsheet software

l

Saved directly to an Adobe PDF file

l

Sent to the printer

The printed and Adobe PDF output follows the same flexible, organized, and accessible format as the
Output window itself.

Related Topics
Interface and User Options
Menus and Toolbars
Output Control
Output Parameters

285
285
327
333
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Applied Standards
Use the Output Window Sort Feature

334
684

Related Examples
Beginner: Air Heating System

702

Output Control
The Output Control window (see Figure 1) allows you to customize the parameters shown on the Output
window. The control features are grouped on numerous tabs.

Figure 1: The Output Control window selects parameters for the Output window. Here the Pipe parameters
are shown. The Junction and other parameters function the same.

Display Parameters
The Display Parameters tab controls the parameters to be shown for the pipes, junctions and summary
reports. The output type is selected from the group of buttons at the top. For each output type, the list on
the left side shows all available parameters for the selected report. For the pipe and junction output, this
list can be viewed in alphabetized or categorized mode, which makes it easier to find a parameter. It is
also possible to search the available parameters using the Filter box above the list.
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Choose a parameter to be shown by selecting it on the left-hand list and clicking the Add button, or
double-clicking the parameter name. The selected item will appear in the list on the right either at the bottom or at the previously selected location. The list on the right shows the order of the parameters to be
displayed in the output and the units (if any) in which to display the results.
You can change the order of the output by selecting a parameter on the right-hand list, then clicking the
Reorder scroll bar on the far right or by clicking and dragging the row using the handle on the left. The list
will be reordered accordingly. The output is presented from left to right in the order defined in this list.
The units used for a parameter can be changed by selecting the parameter then choosing the desired
units from the adjacent dropdown list. By selecting the units of interest, you can obtain your results in
whatever units you find most convenient and meaningful. This means that you can enter all your input
parameters in one set of units (or a variety of units, for that matter), and have all your output parameters
in a completely different set of units.
To set selected units for both pipes, junctions and summary reports to the preferred units (set in the User
Options window), click the Use Preferred Units button. If you change the units of a parameter and you
would like that unit to be used for all similar parameters in the list or entire output, select the Same Units
button.
You will note that some output parameters do not offer the ability to specify output units. These parameters either do not have units associated with them (such as Reynolds Number or friction factor), or are
in fact echoes of input parameters (such as Pipe Nominal Size).
Several Special Summary Reports can be displayed in the Output window. These include the following:
l

Compressor/Fan Summary

l

Valve Summary

l

Heat Exchanger Summary

l

Tank Summary

l

Pipe Heat Transfer Output

l

Cost Report

In addition if the ANS module is active the Pipe Sizing tab will be available, as well as Design Requirements and Library tabs for each pipe/junction which has design requirements or libraries assigned to
them.

General
The General Section is the text area located at the top of the Output window. The project title, reference
information and solution balance display are controlled here.
You can enter a descriptive Analysis Title which will be used in the Model Data, Output and Visual Report
windows. A title is required and can have up to 100 characters.
You can keep a lengthy explanation or any other documentation about your model in the Reference
Information section. Names of projects, individuals, and assumptions can all be kept with the model. This
information can then be included in your reports to improve tracking.
There is an option "Show Solution Balance Summary" that is defaulted to off. This option toggles the display of a general output tab showing the total flow entering and exiting each junction, as well as the sum
of those flows. This can be helpful in verifying the results as well as in some troubleshooting cases.
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Format & Action
The results can be automatically sent to the printer or saved to a file when the model has reached convergence. Additionally, the results can be automatically saved as initial conditions when the model is run.
By saving the results, the iteration time for AFT Arrow to arrive at a converged solution is reduced. The initial guess can also be transferred manually by Selecting the Transfer Results to Initial from the Edit
menu. The model can also be automatically saved after the initial conditions are transferred. The valve
state (open, closed or failed) can also be saved along with the initial conditions.
When enabled, the Wrap Table Column headers option makes the output tables wrap the column headers an extra line if the header is wider than usual.
There are four formatting methods for the pipe and junction output data:
l

Always Align Decimal Point on Output - allows magnitude of the data to be easily compared
as the data is read down the column. However, a number whose magnitude is small may force larger numbers to show many digits. For example, assume that the minimum number of digits is set
to four, and there are two output values: 1234.5 and .09876. These two values will be displayed in
the output as:
l
l

l

l

0.09876

Show Only Number of Digits (not aligned) - forces the data to use exactly the number of digits
specified, which may result in the decimal point location changing from value to value. Using this
method with the above example and four digits, the output will be displayed as:
l

1235

l

9.876E-02

Align Only When Max/Min < Limit- aligns the data on the decimal point only if the maximum
value in the column divided by the minimum value is less than a limiting order of magnitude that
you set. If this ratio is greater than the limit, then each value in the column will be exactly the number of digits specified. Using the above example with a limit set to 4 then 1234.5/.09876 = 12500
or an order of magnitude of 5. This is greater than the limit. The entire column will not be aligned
and will be displayed as:
l
l

l

1234.50000

1235
9.876E-02

Use Exponential When Max/Min>Limit - similar to the above method except that if the ratio is
greater than the limit then the entire column will be shown in exponential format. Using the above
example, the column would be shown as
l

1.235E+03

l

9.876E-02

These formatting options are for the entire Output window; however, the last two are calculated and
applied on a column basis. In other words, if you choose the third option one column may be aligned but
another may not be.
The output can be forced to always display in exponential notation by choosing the checkbox.
Options to adjust the colors for the headers and design alert highlighting are also available.
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Cost Report Formatting
The Cost Report monetary numerical format can be specified.

Show Pipes/Jcts
You can choose which pipes and junctions are to be displayed in the Output window. Clicking a selected
item in the list on the Show Pipes/Jcts folder tab will deselect it. Clicking a deselected item will select it.
This feature is especially useful when you are interested only in a certain area of the model.
You can quickly define the output you want by doing the following:
1.

Select the pipes and junctions on the Workspace

2.

Open the Output Control window and select the Show Pipes/Jcts tab

3.

Click the Workspace button for both the pipes and junctions

4.

Click the Show button

Junction Deltas
You can have AFT Arrow calculate the difference between two junctions for a particular parameter.
These results are displayed in the General Section. A list of Junction Deltas is created by selecting the
upstream and downstream junctions, the parameter and units of interest, then adding it to the list by clicking the Add >> button. Some parameters will require that either the inlet or outlet value for the junction be
specified. The list will contain the parameter symbol and the two junction numbers with "in" or "out" in parentheses. Different parameters can be used for each item in the list so you can, for example, choose
pressure difference between junctions 2 and 10 and also temperature difference between junctions 45
and 16.

Multi-Scenario
You can view output from multiple scenarios concurrently in the Output window. To do this, select the
Multi-Scenario tab. This tab is only visible when at least one child scenario exists. From this tab, choose
which scenarios you would like to view concurrently by clicking on the Select Scenarios button located at
the bottom right of the Scenario Order and Colors box under the Multi-Scenario tab. The color of each
scenario is automatically generated and can be regenerated by selecting "Reset All Colors". You can
manually select the background color for the Output data of a given scenario by clicking on the ... button
located in the row corresponding to the scenario.
You can also order the scenarios to appear in the Output window according to your preferences. To do
this, arrange the scenarios in the order you would like them to appear by using the turquoise arrows at
the bottom left corner of the Scenario Order and Colors box. Then, select how you would like the data to
be displayed by clicking the appropriate choice under the Display Current Scenario section. Figure 2
shows the Output window with multiple scenarios displayed.
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Figure 1: Output Control window selections for multi-scenario output

Figure 2: Output window with multiple scenarios displayed
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Library Connections
In the lower left of the Output Control window there is a Library checkbox. If this box is checked, your Output Control parameters are setup as determined by the library to which you are connected. This is
referred to as an active library. To make it inactive, uncheck the box or change one of the Output Control
settings controlled by the library.
If the check box is unchecked, but enabled, you are connected to a library but the settings are not being
passed to the Output Control window. The library is thus inactive. To make it active, check the box then
click the OK button.
If the check box is disabled, there is no connected library.

Command Buttons
There are eight buttons at the bottom of the Output Control window. Arrow has built-in default parameters, units and settings which you can choose by clicking the Arrow Default button. You can also
develop your own settings, tailored to your project or industry, and have these used by default (instead of
Arrow’s defaults). To make your own default, first select the output parameters, units and settings you
would like to use then click the Set As Default button. Your settings will be saved and will be used each
time any new project is initiated. If you make changes to the settings, and want to get back to your
defaults, click the User Default button. The saved settings are updated only when you click Set As
Default.
You can save the output settings (except for the selected pipes/junctions and junction deltas) to a file by
pressing the Save Control Format button and entering a file name. These settings are loaded again by
pressing the Load Control Format button and choosing the file name. For example, you may have a final
report format that is always desired. You can load this format before generating final results. If you have
another format you use for reviewing model accuracy, you may want a larger number of parameters in
the output.
The format files you create can be placed on a network for sharing among a group or company, allowing
standardized reporting.
If you have made changes you don’t want to keep, click the Cancel button. Click OK to use the setting
you have specified.

Related Topics
Output Window
Output Parameters
Applied Standards
Use the Output Window Sort Feature
Note No Scenarios have been set in the Multi-Scenario Output display
Related Examples
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Related Blogs
Quick Guide to Custom Output
AFT Responds to 2020 Customer Survey Feedback

Output Parameters
A variety of parameters are available to display in the Output window depending on the junctions and
loss models used in the model.
A description of each parameter may be seen by double-clicking the header in the Output Window table,
and is also displayed below the Output Parameters table when that parameter is selected in the Output
Control window (Figure 1).
Additional information can be found below for some of the output parameters.

Figure 1: A description is provided at the bottom of Output Control for the selected parameter

Cv Est./Kv Est.
The estimated Cv is only displayed when the valve does not have a defined Cv loss value. The estimated
Cv/Kv loss coefficient is estimated using the sizing equations from the ANSI/ISA-75.01.01-2012 standard, as are discussed in the Valve Kv and Cv Flow Coefficients topic.

Equivalent Orifice Area/Diameter
The Equivalent Orifice Area and Equivalent Orifice Diameter is calculated using the sharp-edged orifice
loss model with an assumed discharge coefficient of 0.6. The equivalent orifice calculations assume that
flow is choked at the orifice.

Mass Flow Rate Net At Junction
Displays the total mass flow rate exiting the system through the junction, which is useful to display the
flow exiting through junctions such as a spray discharge. In other words, the Mass Flow Rate Net At Junction is equal to the flow rate into the junction from the pipes minus the flow rate out of the junction into the
pipes.
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Mass Flow Rate Through Junction
Displays the total mass flow rate through the junction for junctions connected to only two pipes. If the junction is connected to more than two pipes this parameter will be displayed as N/A. When more than two
pipes are connected the user should refer to the output for the pipes connected to the junction in order to
view the flow rate through the pipes. The user can add the "Mass Flow Rate Net At Junction" to view flow
exiting the system rather than flowing out of the junction into a pipe.

Related Topics
Output Window
Output Control
Applied Standards
Use the Output Window Sort Feature

322
327
334
684

Applied Standards
When an applicable standard is used in a calculation, an additional tab appears in the general area of the
Output Window. This tab indicates what standard(s) were used for what calculations in the model.

Related Topics
Output Window
Output Control
Output Parameters
Use the Output Window Sort Feature

322
327
333
684

Graph Results Window
The Graph Results window, shown in Figure 1, allows you to generate high quality printed graphs.
The Graphing panel offers several types of standard graphs for compressor/fan vs. system, profile, and
transient (XTS Module Only) information. Users can also control graph content to plot information for
multiple parameters, pipes, paths, or scenarios simultaneously.
Results can be graphed as linear or log versus linear.
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Figure 1: The Graph Results window offers full-featured plot generation

The Graphing panel lets you control the content of the graph and offers several types of standard graphs.

Graph List Manager
Allows the user to create, update, and even replace unique graphs that can be regenerated with new
data. Multiple graphs can be displayed at the same time and organized into separate Folders. The
default folder is named “My Graphs” and more folders can be created using the “New Folder…” icon on
the Graph List Manager Toolbar or by right clicking on “My Graphs” and selecting “New Folder…”
Once a folder is created and selected, a Graph can be added to its list by selecting the “Add Graph to
List” icon found on the Graph Results Toolbar. This can also be done by right-clicking anywhere on the
graph. Once Graphs are in a Folder individual Graphs can be generated in unique tabs or each Graph in
a Folder can be displayed in a single tab by right clicking on the Folder and selecting “Load Current
Folder Graphs in New Tabs” or “Load Current Folder Graphs in Same Tabs”. These options are available
in the Graph List Manager toolbar as well. Other options that can be found by right clicking on a Folder or
Graph in the Graph List Manager or on the toolbar are:
l

Load Graph Item in Current Tab – Regenerates the graph in the currently active tab.

l

Load Graph Item in New Tab – Creates a new tab and regenerates the graph there.

l

Load Folder items - Regenerates all the Graphs in a Folder in separate tabs, in the same tab
side by side, or in the same tab as stacked graphs, depending on the selection.

l

Keep Folder Display Layout - Saves the current layout when multiple graphs are loaded on the
same tab.

l

Reset Folder Display Layout - Resets the Graph List Folder to the default layout when multiple
graphs are loaded on the same tab.

l

Close Open Folder Items - Closes any graphs that were opened from the current folder.

l

Delete Folder Items - Deletes all graphs in the current folder.

l

Print Preview All Graphs in Folder - Displays a print preview of all items in the current folder.
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l

Move Graph Item Up – Moves the selected Item up one level.

l

Move Graph Item Down - Moves the selected Item down one level.

l

Rename Graph Item - Changes the name of the Item.

l

Duplicate Graph Item – Creates a copy of the selected Item with a new name.

l

New Folder – Creates a new Folder where more Graphs can be saved to.

l

Delete Graph Item – Removes Item from the Graph List Manager.

l

Move Graph Item To Folder – Moves the selected Item to a previously existing Folder or a new
Folder.

Graph Results Toolbar
The Graph Results Toolbar also has many options that are available right clicking on the Graph Results
space at any point. These options are:
l

Select Graph Parameters – Select the type of Graph to create and its parameters.

l

Add Graph To List – Saves the Graph to the currently active list allowing it to be regenerated in
the future.

l

Update Current Graph In List – Saves any changes to the current graph that have been made.
(e.g. Changing the Graph Title or Line Style). Note that it is preferred to use the Replace Graph in
List option if changes to the parameters or objects/paths being shown have been made.

l

Replace Graph In List – Replaces the outlined and current Graph with the Graph in the Graph
List that has a gray background

l

Copy Graph Image – Copies a .jpeg of the Graph to the clipboard

l

Copy X-Y Data – Copies the X-Y used by the Graph to the clipboard

l

Show Data – Displays the X-Y data used to generate the graph in a column to the right of the
graph
l

Right-clicking on the x-y data set provides further options to find the maximum or minimum
in the data set, create an annotation on the graph for a data point, or to copy an individual
data point

l

Create Annotation – Add an annotation to the graph that can be formatted and saved to be
reloaded with the Graph in the future.

l

Show Legend – Toggles the legend off and on.

l

Show Check Boxes in Legend – Adds a check box in the legend that allows the user to selectively turn off and on certain curves in a Graph without having to recreate a new Graph.

l

Show Cross Hair – Displays and cross hair that shows the cursors X-Y values along the X and Y
axis. This also displays the nearest data point X-Y values in a tooltip. If this feature is used at the
same time as "Show Data" the Cross Hair will focus on that highlighted data point and display its
values in a tooltip. The user can also change what data point is highlighted with the arrow keys
and the Cross Hair and tooltip will move to that datapoint.

l

Show Range Finder – Adds a toolbar at the bottom of the graph that displays the entire X axis,
but allows the user to zoom in to a specific range by clicking and dragging the handles on either
side of the range finder.
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l

Show Junction Locations – Add a vertical line with the number of the junction labeled at the location of the junction along the flow length.

l

Zoom to 100% - Resets the focus of the graph to 100%

l

Format – Allows the user to change the Graph’s format. Including
l

Header, Axis, and Legend names and fonts.

l

X and Y scaling

l

Line color and thickness

Graph Outline Colors
The active graph will always have an outline which indicates what state it is in.
l

Orange – Graph not added to list

l

Dark Green – Graph added to list

l

Light Green – Graph added to list, but changes have occurred. These can be saved and make
they graph dark green by selecting “Update Current Graph in List” on the toolbar.

Graph Tab Icons
Each Graph Type has a specific color associated with it. This color will display in the box on the tab for
the Graph. The colors are below:
l

Green – Compressor/Fan vs. System

l

Profile – Purple

l

Blank Graph – Gray

These tabs also display if the Graph in the tab is not saved or has been changed from the original Graph
List item by showing a small yellow square over the tab's icon. If the current graph has been saved, there
will be no yellow square.

Graph Tab Actions
l

New Tab – Creates a blank tab in which a new type of Graph can be generate and added to the
Graph List Manager

l

Tab Actions
l

Close Active Tab

l

Close All Tabs

l

Close All But The Active Tab

l

Two Vertical Tab Groups

l

Two Horizontal Tab Groups
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l

l

Reset to Single Tab Group

l

Tabs on…. – Selects the location of tabs (defaults to the bottom of the Graph)

Graph Tab Selection – Selects a Graph for the Graphs currently in the tabs based on name.

Cross-Plotting Features
The graphical data can be exported to a file for later import as a cross plot against results for a different
model. For example, let's say you would like to see the effect on the system pipe pressure drop when you
change a valve loss factor. You could run the Solver for one value of K and export the results to a file.
Then you could rerun the Solver for a new value of K and import the results from the previous case for
cross plotting. These features are accessed using the Save Graph Data and Import Graph Data items on
the Graph Results File menu.
The Graph Results window is always erased when you make changes to model input. Rerun the model
to graph the new results.

Figure 2: The Select Graph Parameters window controls the Graph Results window

- 338 -

Interface and User Options

Figure 3: Multiple paths can be cross-plotted using predefined groups

Printing and Exporting
The Graph Results image can be:
l

Copied to the clipboard

l

Saved to a picture file

l

Saved directly to an Adobe PDF file

l

Sent to the printer

The x-y data in the Graph Results graph can be:
l

Copied to the clipboard

l

Exported directly to Excel using the Excel Export Manager

l

Exported to a delimited file suitable for direct importing into spreadsheet software

Related Topics
Interface and User Options

285
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Related Blogs
Quick Guide to Custom Output

Quick Graph Formatting Window
The Quick Graph Formatting window is accessed by clicking the Formatting button in the Quick Access
Panel, or from the Tools menu.
The Quick Graph Formatting window allows you to customize the plot by giving you control over the
many aspects including:
l

Axis titles and font sizes

l

Legend text and font size

l

Line thicknesses and basic color sets

l

Axis min and max values

Changes can be undone by using the Reset button at the bottom of the window, or can be returned to the
default formatting by using the Arrow Default or User Default buttons at the bottom of the window.

Related Topics
Graph Results Window
Graph Types
Compressor Fan vs. System Curve Methods
Basic Graph Tutuorial
Multi Scenario Compressor Fan Vs. System Curves Tutorial
XTS Quick Graph
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Graph Types
AFT Arrow offers several types of graphs to help users better understand and interpret their data. Each
type of graph is given a brief description below.

Compressor/Fan vs. System Curve
This graphing option allows you to plot a Compressor/Fan curve versus a system curve for a single Compressor/Fan or group of Compressor/Fans.
Note: The Compressor/Fan Curve vs. System Curve is only available if there is a Compressor/Fan in
the model
You can create Compressor/Fan vs. system curves for complex parallel flow networks. Composite Compressor/Fan curves for Compressor/Fans in parallel or in series can also be also generated. If you create
a composite Compressor/Fan curve, you can also show single Compressor/Fan curves on the same
graph. If efficiency data exists you can cross-plot the efficiency curve.
If POR or AOR have been defined in Compressor/Fan Configuration, these items can be displayed on
the Compressor/Fan vs. System graph.
Compressor/Fan vs. System curves can be displayed in two ways when parallel Compressor/Fans are
selected. The first method is the “traditional” method, used primarily in earlier versions of AFT Arrow. The
second method is called the “enhanced” method which attempts to determine the flow split on the Compressor/Fans and adjust the system curve accordingly. It also attempts to create a better composite
curve when parallel Compressor/Fans are dissimilar. For more information see Compressor/Fan vs. System Curve Methods.
Compressor/Fan vs. System curves for different scenarios can be plotted together on one graph by
adding individual curves to a Multi-Scenario Compressor/Fan Vs. System Folder, then loading them
together in a single Multi-Scenario graph. For detailed information on how to do this see Multi-Scenario
Compressor/Fan vs. System Curves Tutorial.

Profile
This graph category will allow you to plot the selected parameter(s) along a flow path. In order to generate this graph, the specified pipes in the Select Graph Parameters window that comprise the path must
form a single, continuous path. If they do not, an error message will appear and inform you which pipes
are preventing the path from being continuous. The independent variable in these graphs is the length
along the pipe(s).
A path of pipes can be specified in one of two ways. First, the user can select the pipes in the displayed
list. Additionally, you can select the path on the workspace, and then use the Workspace button on the
Select Graph Parameters window to automatically select all pipes currently selected on the Workspace.
These methods permit that only a single path to be specified.
A profile graph can also be generated directly by selecting a single, continuous flow path in the Workspace, then right-clicking the Workspace and choosing the desired parameter under "Generate Profile
Graph."
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One or more flow paths can be specified using groups. Only those groups that consist of a continuous
pipe sequence will be displayed as an option in the Select Graph Parameters window.

Multi-Scenario Graphing Features
Starting with Arrow 9, users can plot information from multiple scenarios in the same graph for profile
plots (or Transient plots with the XTS Module). Note Multi-Scenario Compressor vs System curves are
generated using a different method.
In the Select Graph Parameters window, the Multi-Scenario button allows users to select the scenarios in
the model they wish to plot for a particular graph. The same pipe layout must exist for all scenarios being
plotted in a graph. Design alerts cannot be included in multi-scenario plots.
The active scenario must be included in a multi-scenario graph. When creating a new graph, users are
not able to deselect the current scenario. When a user loads a saved Graph List Item that does not
include the active scenario, Arrow will add the active scenario into the Graph List Item, but will not save
the active scenario into it.
Scenarios can be selected using the Multi-scenario... button as shown in Figure 1 below.

Figure 1: Graph Parameters window showing Multi-scenario selection options

Related Topics
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Graph Results Window
Quick Graph Formatting Window
Compressor Fan vs. System Curve Methods
Basic Graph Tutuorial
Multi Scenario Compressor Fan Vs. System Curves Tutorial
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Compressor Fan vs. System Curve Methods
When plotting compressor/fan and system curves with two or more parallel compressors/fans, AFT
Arrow offers two methods: Enhanced and Traditional.
It should be understood by the engineer that it is not possible to create an unambiguous composite compressor/fan and system curve for parallel compressor/fan systems. The reasons why are discussed here.
First, let's discuss the pressure curve. A composite compressor/fan curve shows a single pressure curve
with values at particular flow rates. However, when there are parallel compressors/fans with unequal
pressure curves or even equal pressure curves with unequal flow distribution, it is not clear what flow rate
to use in the composite pressure curve. Further, with unequal flow distribution, different pressures for
each parallel compressor/fan can result. But the composite pressure curve shows only a single pressure
for any given flow. What pressure is this? The maximum, minimum, arithmetic average, flow rate
weighted average, or some other value? A composite curve has uncertainty over what is meant by the
composite flow rate and composite pressure.
Composite system curves have similar issues to composite pressure curves. The entire system performance is boiled down to a single pressure vs. flow rate curve. What flow rate is being referred to and
what pressure is being referred to which goes with a given flow rate?
AFT Arrow attempts to create as meaningful and helpful composite compressor/fan and system curves
as possible, but the fact remains that the curves AFT Arrow creates are ambiguous because of the
nature of composite pressure vs.system curves.

Enhanced
The "enhanced" method was introduced in AFT Arrow 4.
For composite pressure curves, it assumes that the parallel compressor/fan pressure curves are added
to the right with respect to flow rate. No attempt is made to apportion flow splits among the compressor/fan curves. With the pressure curves added to the right, there is a unique pressure value for
every flow rate. In reality, the parallel compressors/fans may not work this way, depending on the flow
split among the compressors/fans, whether or not the pressure curves are identical, and whether there
are check valves at each compressor/fan discharge. This is, however, a reasonable approximation and
represents the historical way that parallel compressor/fan pressure curves are added together.
No matter what method is used for creating a composite system curve, composite system curves are created by fixing some flow rate to each compressor/fan and then determining the required pressure from
the compressor/fan to deliver the assumed flow rate.
The enhanced system curve takes the flow split at the operating point and assumes that the flow split
remains the same at all flow rates. It collects the required pressure for each compressor at each flow rate
and then averages these pressures together arithmetically.
If the compressor/fan pressure curves are identical and the flow split among compressors/fans is proportional, this method will give the same results as the Traditional method.
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Traditional
The "traditional" method was used in AFT Arrow 2.0 and 3.0. The traditional method assumes that the
flow splits equally among all compressors/fans at all flow rates, regardless of whether compressor/fan
curves are identical or not.
The composite pressure curve is created by taking the composite flow rate, splitting it equally among
each compressor/fan, obtaining the pressure for each compressor/fan at the split flow rate, and then taking the arithmetic average of the compressor/fan pressures.
The composite system curve is obtained by taking the composite flow rate, splitting it equally among
each compressor/fan, running the system model with these flow rates, and then taking the arithmetic
average of the required pressures for each compressor/fan.

Related Topics
Graph Results Window
Quick Graph Formatting Window
Graph Types
Basic Graph Tutuorial
Multi Scenario Compressor Fan Vs. System Curves Tutorial
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Basic Graph Tutuorial
Generating Graphs is a powerful tool for analysis. AFT Arrow has special tools to allow the user to create
Graphs that have the ability to be regenerated even if the output data has changed due to model
changes. Below are step by step instructions about how to make and manage graphs from one of the
example models.
Create and run a fully defined model. For this example the “Compressed Air System.aro” model was
used. The file should be at this location by default C:\AFT Products\AFT Arrow 9\Examples\US - Compressed Air System.aro. The scenario was Base Scenario/Hot Case. It is recommended to copy this file
to your desktop and work this tutorial from the copied file as to not save over your example files.
To skip to different sections of this tutorial, use the links below:
l

Compressor/Fan vs. System Curves and Saving Graphs

l

Profile Graphs

l

Displaying multiple graphs simultaneously

l

Creating graphs from Workspace
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Compressor/Fan vs. System Curves and Saving Graphs (return to top)

Figure 1: Fully defined model that can generate output and graphs

Go to the Graph Results Primary Window and determine what type of Graph you want to generate. The
first Graph created in this example will be a Compressor/Fan vs. System Curve. The Compressor/Fan
vs. System Curve is one of several different types of Graphs that can be made. This Graph is created by
first selecting the Compressor/Fan vs. System Curve tab and selecting the desired parameters (for the
example the defaults have not been altered) in the Parameters area. After the parameters have been
selected, click Generate, and you will see the graph on the left.
Note that the Graph Guide, accessed by clicking on the "What Would You Like to Do?" icon on the upper
right of the graph, will guide you through the process of creating a graph.
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Figure 2: Graph Results Primary Window

The Graph has been created, but has not yet been added to the list under “My Graphs”. To add this
Graph to the list, first select the “Add Graph to List” icon on the Graph Results toolbar. Name the Graph
“Compressor vs. System Curve” (this option and many others can be accessed by right-clicking on the
Graph at any time).

Figure 3: Compressor/Fan vs. System Curve
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The Graph has now been added to the list and will be easily regenerated with the same format if the output changes. The name of the added Graph can be seen in the Graph List Manager. The border of the
Graph has also changed to dark green along with borders of the parameters and the name of the Graph
in the Graph List Manager. This indicates that that Graph has been added to the list, current, and that the
displayed parameters are the ones used to generate the Graph.

Figure 4: Compressor vs. System Curve added to the list under "My Graphs"

Formatting options are available by selecting “Formatting” above the different graph types. When formatting changes occur, the border of a Graph will change from dark green to light green. This indicates that a
change has been made to a graph in the graph list. Another indicator that the Graph is not updated is the
small yellow square over the icon on the tab. In this example, the title has been changed from “Compressor/Fan Curve vs. System Curve for Compressor/Fan 2” to a shorter title of “Compressor vs. System
Curve” (this was done by right-clicking on the title and changing the text). These changes are not saved
to the Graph unless “Update Current Graph in List” is selected.
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Figure 5: Compressor vs. System Curve with formatting changes

After selecting “Update Current Graph in List” the border has changed back to dark green and the yellow
square has disappeared. This indicates that this is the current formatting of this graph, and that regenerating this graph will generate the same graph (according to the current model output).

Figure 6: Compressor vs. System Curve with updated formatting changes
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Profile Graphs (return to top)
The next step in the example is to make a new Graph in a separate tab. This is done by selecting the
“New Tab” icon in the lower left. This Graph will be a “Profile” Graph that displays Stagnation Pressure
along the length of the flow path from the Tank to Tool #4. Select pipes 1,2,3,4,5, and 9 or highlight the
flow path on the Workspace and change the parameter to “Pressure Stagnation” with units of length in
feet and units of pressure in psia.

Figure 7: Generating a Profile plot with Pressure Stagnation

This Graph shows the pressure rise caused by the compressor that is very close to the tank and then a
decline in pressure that results from major losses caused by friction in the pipeline. This Graph can also
be added to “My Graphs” by selecting “Add Graph to List” on the toolbar. Name it “Stagnation Pressure
Profile”.
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Figure 8: Pressure Stagnation vs. Flow Length

The Graph is now under “My Graphs” and the two Graphs can be switched quickly between by either
selecting the Graph from the list, by clicking on the corresponding tab, or using Graph Tab Selection.

Figure 9: Stagnation Pressure Profile added to the list under "My Graphs"
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Displaying Multiple Graphs Simultaneously (return to top)
It is now possible to close the Graphs and regenerate them either in their own tabs or all graphs in a
folder in the same tab. To test this out close both Graph tabs and then select the “My Graphs” folder. The
option to “Load Folder Items" in "Separate Tabs” and “Same Tab” are now available on the toolbar. For
this example select “Load Folder Items” and then "Same Tab".

Figure 10: Both Graphs loaded into the same tab

It is also possible to create more Graph Folders other than “My Graphs”. The saved Graphs can then be
organized into different folders that can independently be generated into their own tabs or a whole folder
of Graphs can be generated into one tab.

Creating Graphs from the Workspace (return to top)
Note that some graphs can also be generated directly from the Workspace after running the model. To
generate the Pressure Stagnation vs. Flow Length graph from the Workspace, select the flow path on the
Workspace (you can select multiple pipes by holding the SHIFT button on the keyboard while selecting
each pipe). Then, right click on the Workspace and select the Generate Profile Graph option, then
choose Pressure Stagnation (see Figure 11).
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Figure 11: Several graphs can be generated directly from the Workspace

Related Topics
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Multi Scenario Compressor Fan Vs. System Curves Tutorial
When a model file has multiple scenarios that have compressors/fans in them, a graph containing multiple compressor/fan curves and/or system curves can be generated for the purpose of comparison. To
create a multi-scenario compressor/fan vs. system curve graph, two options are available:
l

Standard Method: Save compressor/fan vs system curve graphs for each individual scenario to
be included in the graph. This allows the user to define settings such as the flow range for the compressor/fan vs system curve on an individual scenario basis, but is more time consuming.

l

Batch Run Method: Create a template compressor/fan vs system curve graph, then set up a
batch run to automatically generate the compressor/fan vs system curves for all scenarios to be
included in the graph. This allows for a faster process.
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Standard Method
1.

In the Graph List Manager select "New Folder". Provide a name for the folder, and check the box
to "Make Multi-Scenario Compressor/Fan Vs. System Folder", as is shown in Figure 1. This folder
will be used to save the curves from the individual scenarios that will be included in the multi-scenario graph.

Figure 1: Creating a Multi-Scenario Compressor/Fan Vs. System Folder

2.

Load the first scenario you want to add to the graph, and run the scenario so that Output is
present. Generate a Compressor/Fan vs. System Curve for the scenario.

3.

Add the Compressor/Fan vs. System Curve to the Multi-Scenario Compressor/Fan Vs. System
Folder. This can be done by selecting the Multi-Scenario folder in the Graph List Manager, then
clicking the Add Graph to List button, and naming the graph. The graph should now be shown subordinate to the folder, with the scenario name listed next to it in red, as is shown below.

Figure 2: The name of the scenario that each Compressor/Fan vs. System Curve was created in is displayed
in the Graph List Manager

4.

Repeat steps 2 and 3 for all scenarios that will be included in the graph.

5.

When all of the individual Compressor/Fan vs. System curves have been added to the folder,
right-click on the folder name and choose "Load Multi-Scenario Graph," as is shown in Figure 3.

- 353 -

Interface and User Options

Figure 3: A Multi-Scenario Graph can be loaded from a Multi-Scenario graph folder

6.

In the Multiple Scenario Graph Selection window select which curves you would like to include in
the graph, then choose Generate Graph as is shown in Figure 4.

Figure 4: Multiple Scenario Graph Selection

7.

The selected curves will now be displayed on a single graph, as is shown in Figure 5.
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Figure 5: Multi-Scenario Compressor/Fan vs. System curve

Batch Run Method
To speed up the process outlined above when making Multi-Scenario Compressor/Fan vs. System
curves for more than a handful of scenarios, the Batch Run tool can be used. Follow the steps below to
create the curves.
1.

In one of the scenarios being included in the Multi-Scenario Compressor/Fan vs. System curve,
generate a single scenario Compressor/Fan vs. System curve and save it as a standard Graph
List item. This curve will be used as a template for all the other scenarios, and should be for a compressor/fan common to all scenarios.

2.

Launch the Batch Run window found in the File menu. Select the option to have the Batch Runs
create Multi Scenario Compressor/Fan vs. System curves, and select the template Compressor/Fan vs. System curve as shown in Figure 6. If you have multiple templates, all options will
be shown for selection.
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Figure 6: Multi-scenario batch run option enabled in the Batch Run window

3.

Add the desired scenarios to run to the list and start the run.

4.

Once the run is complete, navigate to the Graph Results tab. In the Graph List Manager, there will
be a Multi-Scenario Compressor/Fan System Curve folder named with the date and time of the
run. Follow steps 5 and 6 above to load the graph results.

Related Topics
Graph Results Window
Quick Graph Formatting Window
Graph Types
Compressor Fan vs. System Curve Methods
Basic Graph Tutuorial
Related Blogs
Getting there is graph the fun! - Multi-Scenario Pump vs. System Curves
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Visual Report Window
The Visual Report will help you visualize the model data and flow solution in relationship to the model layout. The Visual Report window displays the pipe system layout from the Workspace window with information in text form (see Figure 1). Additionally, magnitudes of parameters may also be shown with color
variations.
The values to be shown may come from the input data (when in input mode) or the Output results. You
can change between these by selecting the option at the top of the Visual Report Control window.
In the Visual Report window, the positions of the junctions and pipes are fixed based on their locations on
the Workspace. While the pipe system layout cannot be edited in the Visual Report window, the integrated text results for each pipe or junction can be rearranged by dragging and dropping to improve the
final appearance of the window
The contents of the Visual Report window can be:
l

Copied to the clipboard

l

Saved to a picture file

l

Saved directly to an Adobe PDF file

l

Sent to the printer

The controls in the lower-right corner allow you to zoom in and out, as well fit the image to the size of the
screen. The printed size is consistent with the zoom state. That is, if you zoom out to 50%, the Visual
Report screen prints at 50% of its normal size.
The Visual Report window is always erased when you make changes to model input. If viewing output
results, rerun the model to view the new results.

Figure 1: Visual Report window integrates input data and output results with model layout
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Related Topics
Interface and User Options
Menus and Toolbars
Visual Report Control
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Related Examples
Beginner: Air Heating System

702

Related Blogs
Quick Guide to Custom Output
AFT Responds to 2020 Customer Survey Feedback

Visual Report Control
The Visual Report Control window (Figure 1) lets you control the content and appearance of the Visual
Report window. You can also save custom Visual Report window layouts to disk for later recall, so you
don't have to reformat this window repeatedly.
When the Visual Report window is opened and no output results are currently displayed, Visual Report
Control will be in the Input Display Mode. If output results are displayed, it will be opened in the Output
Display Mode. Parameters available for display vary depending upon the mode, i.e. input or output.
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Figure 1: The Visual Report Control window allows you to configure the Visual Report display

Display Parameters
The parameters to be shown in the Visual Report window are selected from the Display Parameters
folder tab. The left list selects the pipe parameters and the right list selects the junction parameters. The
junction parameters list is sorted into common junction parameters, and specific junction parameters
lists. Individual headers can be collapsed to make this list easier to navigate. Parameters selected under
a specific junction type will only be displayed for junctions of that type.
The filter buttons at the top of the window can be set to show only the parameters you have selected in
the Output Control window, or all output parameters. You can select more than one parameter; however,
the Visual Report window may get crowded if too many are selected.

General Display
The General Display tab allows you to configure several items.
The title, defined in Output Control, and filename can be shown or not shown depending on your preference.

- 359 -

Interface and User Options

The units for all parameters can be shown in a legend instead of next to the parameter value. This will
reduce the amount of text and crowding shown in the Visual Report window. The legend can be moved to
any location in the Visual Report window. If this option is chosen while in input only mode, all values will
be converted to a consistent set of units.
You can change various font sizes by clicking the Change button beside any one of the three types of
text-containing categories (Data/Text, Title, and Legend) under the Fonts header and choosing the font,
font style, and font size desired.
Tip: The font and font size in the Visual Report can also be changed outside of the General Display in
Visual Report Control by clicking on the Fonts button and the Font Size Up or Font Size Down
buttons, respectively, on the Toolbar.
The number of digits to show in the numerical display can be configured using the provided drop-down
list.
Normally on the Workspace, closed objects are displayed using special graphics (dashed lines, X’s,
etc.). The number of a junction which has special conditions set, by default, has an X preceding the J
(e.g. XJ56). If you want these symbols to be used in the Visual Report window also, choose the Show
Closed Symbols checkbox. Normally, pipes in closed sections are shown as dashed lines, and junctions
outlined with a dashed line. If you want these symbols to be used in the Visual Report window also,
choose the Use Closed Object Style checkbox.

Show Selected Pipes/Junctions
You can choose what you would like to show in the Visual Report window on an individual pipe and junction basis. This display customization feature is useful for large models where only some of the data
points are of interest.
Each pipe and junction is listed in their respective Display Options frames. Every object can display four
pieces of information on the Visual Report - Number, Name, Data, and the Object itself. The display of
these items is indicated by the existence of a checkmark in the corresponding box. To toggle the display
of a particular item for a particular object, simply click the checkbox.
To restore the settings to what is shown in the Workspace and the data, click the Reset to Workspace
Defaults button.
Multiple objects can have items toggled on or off at once by selecting the desired objects with the leftmost checkboxes and clicking the corresponding checkbox at the top of each column. Multiple objects
can also be selected with the standard selection buttons at the bottom of these panels.
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Figure 2: Show Selected Pipes/Junctions

Color Map
The Color Map feature allows you to visualize magnitudes of various parameters by coloring the pipes.
There is one Color Map for the output mode and another for the input only mode. A Color Map is useful to
show graphically where, for example, high velocities or reverse flows are located or to visualize the pipe
diameters or lengths in a model.
To create a Color Map, first choose a parameter and units for which all pipes will be categorized. Then
choose a color, select the operator (i.e. >, >=, =, <=, <) and enter a value, then press Add to Map. Values
may be categorized on an absolute value basis by selecting this option.
The order of entry is not important. Arrow will sort the entries first by value and then by the operator, with
the > being above the <. The pipes will be colored using the first match found in the map, starting from the
top of the map. If no match is found, the pipe will be the Workspace pipe color. Be careful to avoid overlapping operators and values. If, for example, the map defined four colors using the following inequalities,
1.

=60

2.

<60

3.

>=20

4.

<20
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then there is no way colors 3 and 4 will be used because any pipe less than 20 is also less than 60. Since
<60 is before <20 in the map, the pipe will be colored using 2.
To avoid overlapping colors, only use less than (<) as the last entry. A better map would be to use
1.

>=60

2.

>=20

3.

<20

You can choose to categorize the pipes based on their absolute values by choosing the Display Absolute
Value checkbox. To delete a map value, click the color you want to delete then click the Remove Setting
button.
Instead of coloring the pipes, you could choose to color just the pipe numbers. This is done by choosing
the Color Pipe Labels and clearing the Color Pipes checkboxes in the Color Options area. You could also
apply the colorization to both. Choose the Print Black & White checkbox if you don’t have a color printer.
The pipes will be printed in black.
The color map values can be displayed in a legend by checking the Display in Legend checkbox. The
color map will appear in the legend after the pipe and junction units, if that option was selected. The
legend may be dragged and dropped to any location in the Visual Report window.

Auto Color Map
An automatic color map can be generated for you by selecting "Auto Color Map". This feature will generate a color map using greater than (>) conditions to divide the difference between your max and min
value into the number of conditions. These conditions will have their own unique color that is automatically set on a rainbow spectrum. These colors can be manually changed by selecting the "..." button.

Saving Visual Report Layouts
The parameters and text locations for the Visual Report are automatically saved with the model. The
Visual Report Layout can be adjusted and saved or individual scenarios.
It is also possible to save the settings for use with a different model. To save your preferred layouts to an
AFT Arrow visual layout file, click the Save Options button and assign a file name. The default file extension is .fvs. Later you can load your customized layouts for rapid preparation of the Visual Report window.

Related Topics
Visual Report Window

357

Related Examples
Beginner: Air Heating System

702
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User Options Window
AFT Arrow provides an array of User Options in a single window that can be found in the Tools menu.
The General section of the User Options window provides the following options:
l

Choose to show the Startup Options window at startup

l

Choose to show the Tip of the Day feature

l

Enable orthogonal drawing tips

l

Enable Confirm Before Clearing Results

l

Enable highlighting for required fields in the Properties windows, and choose the highlight color

l

Options for opening models with scenarios

l

Set a visual theme for the interface

l

Select a location for the Scenario Manager

l

Choose the number of data points to show in input tables

l

Setting parameters for "button flashing" for curve fit buttons on junction Properties windows

User Option Defaults
There are five buttons at the bottom of the User Options window. Arrow has built-in default parameters,
units and settings which you can choose by clicking the Reset to Arrow Defaults button. You can also
develop your own settings, tailored to your project or industry, and have these used by default (instead of
Arrow’s defaults). To make your own default, first select the parameters, units and settings you would like
to use then click the Save As New User Defaults button. Your settings will be saved and will be used
each time any new project is initiated. If you make changes to the settings, and want to get back to your
defaults, click the Load User Defaults button. The default settings are updated only when you click Set As
New User Defaults.
If you have made changes which you don’t want to keep, click the Cancel button. Click Save and Close to
use the settings you have defined.

Related Topics
Interface and User Options
Unit System
Workspace
Parameters
Files
Sizing Preferences
Output Language
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370
371
373
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Unit System
You can set the units you prefer to use in AFT Arrow in the Unit System section. Once selected as the preferred units, these units appear as the default units in all instances in which empty fields exist in the
model input. Any model input existing prior to changing the Preferred Units will maintain the units used
when the data was input, regardless of changes made to unit preferences. After saving your preferred
units, a window appears asking if you would like the output parameters to be displayed in your preferred
units. Choose Yes if you do want the output parameters to be displayed in the preferred units, or No if you
want the output parameters to be displayed in the units used prior to making changes to the preferred
Units.

Preferred Units
To customize the units used by AFT Arrow, first select Preferred Units under the Unit System section in
the User Options window under the Tools menu.
AFT Arrow allows you to specify certain units from a large selection to be displayed in the main interface.
The primary selection is the Unit System:
l

US - Only US units will be available

l

Metric - Only Metric units will be available

l

Both with US Defaults - All Units will be available, but US units will be chosen by default

l

Both with Metric Defaults - All Units will be available, but Metric units will be chosen by default

Additionally, a filter can be applied to limit the selection:
l

All Units - all units for the Unit System will be displayed

l

Common Only - only "common" units will be displayed

l

Common Plus Selected Industries - Units particular to certain industries can be included with
the common units

If the selection has been limited to Common Only, there may units common for certain industries no
longer present. The Additional Units for Industry section allows the user to append additional sets of units
to the Common unit set. For example, barrels/day is a common unit in the petroleum industry but not
many others. Checking the Petroleum box adds these units to the main interface.
Preferred Units allows fine grain control over what unit in the above selection is displayed as the default
when defining model input. For example, it may be desired to have a particular parameter such as pipe
diameter default to inches, while keeping other parameters metric. This area allows the user to define
such defaults.

Show/Hide Unit Items
For additional control of the available units, select Show/Hide Unit Items under the Unit System section.
From here, you can select which units for each Unit Family Type you would like to be available for the
model input and output by checking the box next to each unit you would like to be used. Removing units
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that you do not wish to use as input or view as output can simplify your modeling and reduce errors associated with incorrect units.

Edit Custom Unit Names
A custom unit name can be assigned to display different names in the interface for units. For example
"feet/min2" could be changed to display as "ft/min2."
To assign a custom unit name choose the appropriate Unit Type from the drop-down and enter the Custom Unit Name in the table.
To speed up the process of entering custom unit names the units can be exported to csv and re-imported
as follows:
1.

Click "Save Units to CSV" and save the file where it will be easy to locate

2.

Open the CSV file in a spreadsheet editing software like Excel, and fill in the desired custom unit
names in the Custom Name column

3.

Save the CSV file

4.

In the User Options window click "Load Units from CSV" and select the edited CSV file

Note: To use units with superscripts, make sure the csv file is saved with UTF-8 encoding. This can be
done in Excel by choosing save as and selecting "CSV UTF-8" as the file type.

Related Topics
User Options Window
Workspace
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Workspace
In the Workspace section, you can change the symbols used, text content, and location of the text on the
Workspace. Note that all display changes are made only for the user's convenience/preference and do
not affect the model calculations. Additionally, many display options available in the User Options window are also available in individual pipes and junctions.
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Grid
A traditional 2-D grid or an Isometric grid can be displayed on the workspace for modeling convenience
based on the Pipe Drawing Mode that is selected. The number of lines in the grid can be adjusted to create a grid that is fine, medium or coarse. The grid can be hidden or shown by checking or unchecking the
Show Grid box accordingly. If the grid is shown, the grid line pattern can be solid or dashed. The pipes
and junctions can also be snapped to the grid, which moves junctions and pipe end points to the closest
intersection of grid lines.
The Pipe Drawing Mode and the toggle to Show Grid can also be found on the Arrange menu.

Pipes
The display of pipe lines, closed pipes, pipe endpoints, and pipe direction arrows can be adjusted according to your preferences here.
Pipe line thickness can be adjusted from 1 to 10 pixels by selecting the desired pixel value in the box next
to Pipe Line Thickness (pixels). You may choose to show all pipes as having the same thickness, or you
can vary the thickness with an increasing pipe diameter. If varying the thickness according to the pipe diameter, you can allow Arrow to vary the thickness in a gradual fashion with larger diameters shown as having increasingly larger thicknesses, or you can customize two diameters between which the thickness will
vary. In the latter case, any pipes with diameters below this minimum value will have the pipe thickness of
the minimum diameter pipe, and any pipes with diameters above this maximum value will have the pipe
thickness of the maximum diameter pipe. To customize the pipe thickness variation, input the minimum
and maximum diameter between which you wish the pipe thickness to vary, as well as the pipe thickness
that will represent the minimum diameter pipe and the pipe thickness that will represent the maximum diameter pipe. The pipe thickness will vary in a linear fashion between the two diameters specified.
You can close a pipe using the Special Conditions feature which closes the pipe to flow at both ends.
From the User Options window, you can select how you would like a closed pipe to be displayed in the
workspace. The options include a solid line, dashed line, a dotted line, and dashed-dotted combinations.
When building a model, Arrow automatically adjusts pipe endpoints to the centers of junctions for user
convenience. If you would like to disable this feature, uncheck the box next to Automatically Adjust Pipe
Endpoints to Junction Centers in the Pipes window.
The Pipes window in User Options also allows you to adjust the display of flow direction arrows on the
pipes. Under the Pipe Direction Arrows section of the Pipes window, you can select the size of arrow you
would like to be displayed as a percentage of the pipe thickness. Additionally, you can opt to not show a
pipe direction arrow by checking the option Do Not Show Arrow.
Note: The pipe direction arrow is used as a reference direction for flow and does not change direction
on the workspace if the calculated flow is in the opposite direction indicated by the arrow.
Instead, the flow is reported as a negative flow in the output.
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Junctions
The junction icon style displayed on the Workspace can be chosen in Junctions underneath the Workspace section in the User Options window. The two available icon styles include classic icons and transparent icon. Classic icons are the icons used in earlier versions of Arrow ending at Version 4 in which
each junction is surrounded by a box, and transparent icons are updated icons not surrounded by boxes.
You can also select the icon size and label location for junctions. To adjust the size, click on the box
below Icon Size in the Junctions window and choose the percentage of the default size that you would
like the junction icons to be sized. For the junction label location, you can select from any of the eight locations shown in the window by clicking on the selection circle that corresponds to the desired location.
Note: Junction and pipe labels can be moved individually on the Workspace by using the mouse to
drag and drop the label according to your preferences.
The final option in the Junctions window of the User Options is to enable or disable a dotted outline
around a closed junction. If this option is enabled, a dotted box will appear around the junction. If this
option is disabled, no dotted box will appear.

Labels
Display settings for pipe and junction labels on the Workspace can be customized under Labels in the
Workspace section of the User Options window. When a pipe or junction is inserted onto the Workspace,
the next whole number available at the increment specified in this window is automatically assigned to
the new pipe and/or junction. Arrow's default is to increment pipe and junction numbers by one. Therefore, the first pipe you place on the Workspace will automatically be labeled as Pipe 1 (P1 for brevity), the
second will automatically be labeled P2, etc. Junctions are labeled in a similar fashion with a "J" in front of
the number to indicate it is a junction. However, if you choose a different increment in the User Options
window for pipes and/or junctions, the automatic numbering will increment pipes and/or junctions according to the specified number. You can renumber any pipe or junction individually as long as the number is
not already used in any scenario of the model. If a number at the increment is already in use, Arrow will
skip to the next available whole number. Pipe and Junction label numbers are limited to integers between
0 and 99,999.
Note: A unique label must exist for each pipe and junction on the Workspace. Therefore, there cannot
be more than one P1 in the model, but a P1 and J1 can exist simultaneously because the leading letter is different.
Additionally in this section in the User Options window, you can select if you would like the pipe and/or
junction numbers only to be displayed, if you would like the names only to be displayed, or if you would
like both the name and number to be displayed. To choose which display option you would like, select the
radio button next to the desired display option under Pipe/Junction Default Display.

- 368 -

Interface and User Options

Note: If you would like a pipe and/or junction display label type to vary from the default option selected
in Labels in the User Options window, you may choose the display label type for individual pipes
and junctions in the Optional tab of the individual pipe or junction properties window under Display on Workspace.
You can also choose whether the pipe and junction labels should be moveable at all times, or if they
should only be moveable when the user is holding down the shift key. Select which option you prefer by
clicking on the radio button next to your preference. Restricting the movement of labels can be especially
helpful to users with complicated or dense models, as it is possible to inadvertently grab a label when
attempting to reposition or select an icon on the Workspace.

Colors and Fonts
The Colors and Fonts window located under the Workspace section in the User Options window allows
you to change the colors of the following parameters seen on the Workspace:
l

Pipe and Junction Symbols

l

Junction Numbers

l

Pipe Numbers

l

Pipes

l

Selected Items

l

Undefined Numbers

l

Workspace Background Base Scenario

l

Workspace Background Children

l

Workspace Background Grandchildren

l

Workspace Background 3rd Generation

l

Workspace Background 4th Generation +

l

Grid

The currently selected color for each parameter is shown to the right of the parameter. To change the
color for any parameter, either select the box containing the parameter's color and then click on the Set
Color box under the list, double click on the box containing the color you would like to change, or click the
"..." button next to the color of the parameter you would like to change. A color window pops up that
allows you to choose from 48 basic colors, or to create a custom color by clicking anywhere in the color
box and adjusting the slider at the right of the box to create the color of your choice. If you would like to
save the custom color for use in other areas of the model, click on any empty box underneath Custom colors: and then click on the Add to Custom Colors box below the color box. When finished with selecting a
color, click OK on the bottom left of the Color window.
If you would like the background color of the children and grandchildren scenarios to maintain the same
color as the base scenario, click on the Set All Background Colors to Base Color button under the Parameter/Color list.
You may also choose to change the font of all junction and pipe names and numbers by clicking on the
Change Font button to the right of the Font for Junction and Pipe Numbers on the Colors and Fonts box
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in the Workspace section. A preview of the current font is given underneath the Font for Junction and
Pipe Numbers title.

Other
Symbols representing pipe or junction special conditions and inflow or outflow are listed in the Other window under the Workspace section in the User Options window. These symbols can be changed or disabled by the user. To change a symbol, click on the box containing the symbol you want to change, and
type in the new symbol.
If you choose to include a background picture in your model, you can adjust the picture size in this section, as well. To scale a background picture, enter a Scale Multiplier in the box underneath Background
Picture Scaling.

Related Topics
User Options Window
Unit System
Parameters
Files
Sizing Preferences
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Parameters
The Parameters section of the User Options window allows you to specify some default parameters and
model input when a new pipe or junction is added to the Workspace. Changing any of the parameters in
this window adjusts the specified default pipe and/or junction input parameters and/or values to simplify
the modeling process and to prevent the user from having to enter repetitive data.

Pipes and Junctions
Pipe and Junctions, located within the Parameters section of the User Options window, allows you to specify default pipe and junction input information.
Under the Default Pipe Data box in this window, you can enable or disable the option Use Most Recent
Pipe Size Data. If you enable Use Most Recent Pipe Size Data, the pipe property windows of new pipes
added to the Workspace will automatically contain pipe diameter, material, and friction information from
the most recently entered pipe. This prevents you from having to re-enter the pipe diameter, material,
and friction model information in the case that several pipes require this same input. Disabling this feature leaves the pipe diameter, material, and friction model for each new pipe added to the Workspace as
the default specified in the User Options window.
The Default Junction Elevation box allows you to select the default junction elevation you would like for
all new junctions added to the Workspace. If you select Unspecified in this box, the junction elevation
field in the Junction Properties window remains empty until you specify each junction elevation individually. If you select Use Most Recent, the junction elevation of a new junction added to the Workspace
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is shown as the elevation of the most recently specified junction. If you select Specified, you are able to
input an elevation of your choice that will automatically be input into each new junction that is added to
the Workspace.
The Default Control Valve Failure option allows you to choose the default behavior if a control valve is calculated to have failed. This option can be changed on an individual basis in the Control Valve Properties
window. See Control Valve Failure for more information.
The Default Design Factors box allows you to add a default Design Factor to each pipe and junction
shown in the list on the Pipes and Junctions window. Setting a default design factor for pipes and junctions can be especially useful when applying safety factors on given equipment.
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Files
The Files section of the User Options window allows you to specify file locations for saving models, library folders, user settings, and model backup files. You can also customize the model backup file settings here.

File Locations
Under File Locations in the Files section of the User Options window, you have the option to select the
default folder in which to save your model. If a default model folder is specified, this location will be the
default location to save the model. To specify the default location, click Add below the Default Model
Folder box and browse to the location you want to set as the default folder. Once you have selected the
folder, click OK. The location of the default model folder will then show in the Default Model Folder box.
You can add more than one default folder, but only the folder selected in blue will be the active default
folder.
To specify locations for Arrow to search for Library files, click Add under the Library Search Locations
box. Browse to the file location that contains the library, select the location, and click OK. You can add
multiple folders to be searched. To add additional folders, repeat the process for each folder.
The User File consists of all saved settings and preferences. In order to backup these user settings in a
*.ini file, click Add under User Backup Locations. Browse to the file location in which you would like to
save these settings. Once you have selected the desired file location, click OK. Note that the User File
can be saved in multiple locations. To add additional locations, repeat the process for each folder that
you would like to save the settings.
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Backup Settings
A backup file is a copy of a previously saved version of your *.aro file that can function as a complete,
standalone model. These files are used as a safety measure to provide you with one or more previous
versions of the model in the case that the current model is deleted or damaged.
To customize the amount of backup files (i.e. the number of previously saved versions of the model) and
the frequency that the model is saved, open the Backup Settings window, which is located under the
Files section of the User Options window.
From the Backup Settings window, choose the total number of backup files you want to save by clicking
on the dropdown box next to Number of Backup Files Created and specify the total number of files. After
the model has been saved initially, subsequent instances of saving the model will create a new backup
file each instance until the number of backup files saved equals the number of backup files specified in
Backup Settings. The most recent backup file will always contain the file extension *.bak001. The file
extension of earlier versions is numbered in chronological order with earlier versions receiving larger
numbers in the file extension. Therefore, given any model file, the backup file with a file extension of
*.bak002 will always contain the model file saved after (more recently than) the backup file containing the
file extension of *.bak003. Likewise, for the same model, the backup file with the file extension of
*.bak003 will always contain the model file saved after (more recently than) the backup file containing the
file extension of *.bak004. This extension naming convention applies to any number of backup files.
If you want Arrow to automatically save the model file periodically when the file is open, tick the box next
to Automatically Save Model and select the frequency in the dropdown box.
If you need to use a backup file as a standalone model, add the extension .aro to the backup file (the file
name should now appear as *.bak00x.aro), and open the file in Arrow.
You can opt to save no backup files by choosing "0" in the Number of Backup Files Created box.

Encoding
The File Encoding option can be set to "Unicode" in order to use characters outside of the standard english keyboard such as diacritics, cyrillic, etc for text fields such as the pipe/junction name, notes, etc.
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Sizing Preferences
The Sizing Preferences section provides options to customize the colors used in the Sizing window, set
the location of the Sizing Navigation Panel, and enable options for creating continuous/discrete candidate sets.
Note: This section of User Options will only be shown if the ANS module is activated in Arrow.

Color Options
The "Sizing Option" parameter colors affect the background colors used for the corresponding columns
in the "Options to Minimize Monetary Cost" table on the Sizing Objective panel and the "Sizing and Cost
Options" table on the Size/Cost Assignments panel.
The assigned background colors will also change the background of the Sizing Level status button in the
Sizing Navigation Panel.
The "Common Size Group" parameter colors affect the background colors used in the "Pipe Grouping"
table on the Size/Cost Assignments panel, as well as the headers used in the "Assign Candidate Sets to
Pipes" section on the Candidate Sets panel and the "Assign Design Requirements to Pipes" section on
the Design Requirements panel.

Sizing Navigation Panel Preferences
This section allows the user to set the default location for the Sizing Navigation Panel. By default the Sizing Navigation Panel will be located at the bottom of the Sizing window.

Sizing Panel Preferences
This section provides users with the option to show the discrete/continuous option on the Candidate Sets
panel. By default this option will be hidden and all Candidate Sets will be defined as discrete.
In general the continuous candidate set option should only be used if the Sizing Type is set to Continuous, and discrete sizing does not need to be performed for the pipes.
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Output Language
The language for the output (i.e. the Output Window, Graph and Visual Report) can be changed by selecting Output Language from the Tools Menu. The translated phrases will be displayed on the screen and
on the printed page. Currently the English, French, Spanish, German, and Chinese languages are supported.
A blank file called LANGUAGE.DAT is provided so that the user can customize a personal language.
The file contains phrases in groups. After each phrase, the alternate or translated phrase must be
entered. The standard or English phrase must not be changed in any way. If Arrow does not find a translated phrase then the standard (English) one will be used. It is recommended that this file be copied to
another name before it is edited. To use this custom file you must first edit the ARROW8.INI file located
in the local user directory. Add the line ‘User Language File = drive:fullpath\filename’. It should look
something like the following:
[Language Preferences]
Output Language = 0
User Language File = C:\AFT Products\AFT Arrow 9\newlang.dat
The name of the language will now be added to the bottom of the menu list where you can choose it as
the default. There can be only one custom language file.

Related Topics
User Options Window
Unit System
Workspace
Parameters
Files
Sizing Preferences

364
365
366
370
371
373

- 374 -

Interface and User Options

File Import and Export
This section focuses on the various file types that can be imported and exported from AFT Arrow. Topics
included discuss importing piping layouts from various sources, importing and exporting between
AFT products, and importing and exporting data with Excel.

Contents
Importing Piping Component Files

375

Importing CAESAR II Neutral Files

378

Importing GIS Shapefiles

381

Importing and Exporting EPANET Files

383

Importing and Exporting from Other AFT Products

386

Exporting to Excel

387

Importing from Excel

392

Related Blogs
Meet the Import Piping Layout Wizard
Now it’s Super Easy! Changing Input Data in AFT Models using Excel Change Data
That was EASY! Quickly Change Pipe and Junction Input Data into AFT models using Excel Change
Data

Importing Piping Component Files
AFT Arrow includes the ability to import Piping Component Files (.pcf), which can be generated by a wide
range of software, and provide a quick way to get started with the hydraulic modeling portion of a project.
Files can be imported into existing models.
Selecting File > Import Piping Layout From > Piping Component File (.pcf) brings up the Import Piping
Layout Wizard in the Quick Access Panel, as shown below in Figure 1.
The Import Piping Layout Wizard is organized into sections that help guide the import process:
l

Folder Browser - After browsing to a folder, all .pcf files within the folder will be listed here. Simply clicking a file in the list will show a preview of the import in the Workspace. The location of the
preview can be moved by dragging the icon in the upper-left of the selection area.
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l

l

Object List - When a file is selected, the objects to be created will be listed here. Each individual
object can be reassigned to a certain Junction, if the automatic assignment is not correct. For
example, the originating software may have only had a "valve" while this could be a Relief Valve or
a Control Valve. Changing the AFT Object type will change the preview in the Workspace. Rightclicking on an object shows a menu for converting object types.
l

Property Window - This button opens an additional panel that shows the raw properties
for the currently selected object.

l

Link Materials - Opens the File Object Link window, where the Materials Codes from the
pcf file can be associated with a pipe material, size, and type in the AFT Pipe Material library. The selection from the AFT Pipe Material library will overwrite any diameter information from the pcf file. Selections made for a pcf material will be applied to all pipes that
reference that pcf material. Pipes associated with each material can be seen by clicking the
arrow on the left expand the group (Figure 2).

l

Show Ignored Objects - Certain types of objects are ignored on import - these can be
objects such as flanges, or additional file components such as materials or bolt specifications.

Options
l

Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and longest pipe
in the list of pipes to be imported.

l

Ignore Pipes of Length Less Than - Do not import pipes shorter than this amount.

l

Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this diameter.

l

Ignored Pipes - How many pipes will be ignored based on the above settings. Ignoring
pipes can be helpful in keeping a model clean and free of unnecessary components. For
example, a pipe stress software may require many short pipe segments in between welds
or flanges. However, these types of connections are almost always ignored for hydraulic
analysis. By ignoring short pipes, the amount of "import clean up" required can be reduced.

l

Preferred Scale - The wizard will Auto Scale the import by default. If a different scale is
desired, this option can be disabled and a custom scale entered.

l

Show Pipes in Preview - Display the pipes in the Workspace preview.

l

Show Junctions in Preview - Display the junctions in the Workspace preview.

l

Combine Pipes When Possible - It is required that all pipes in the Workspace be connected by two junctions. However, this is not a requirement in all software. Therefore, some
.pcf files may be generated with several pipes "end to end." If the pipes were imported this
way, junctions would need to be added, or the pipes would need to be manually combined,
before the model could be solved.

l

Import Bends as Pipes - Pipe bends can be considered as junctions or simply a visual
change in direction of the pipe. This is identical to using segments to show piping layout.
Note that these bends are visual only and have no losses associated with them - to account
for losses, either junctions or fittings & losses must be used. This option is helpful to reduce
unnecessary model clutter.

l

Ignore Fitting Lengths - Neglects additional length added to pipes that accounts for the
equivalent length of fittings and losses, and is not actually part of the physical pipe length.

l

Import Data to Pipe or Junction Notes Field - Add the raw data from the originating file
to the Notes tab of the corresponding object.
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Figure 1: Piping Component File Import

- 377 -

Interface and User Options

Figure 2: File Object Link window for Piping Component File Import
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Importing CAESAR II Neutral Files
AFT Arrow includes the ability to import CAESAR II Neutral Files (.cii), providing a quick way to get started with the hydraulic modeling portion of a project. Files can be imported into existing models.
Selecting File > Import Piping Layout From > CAESAR II Neutral Files (.cii) brings up the Import Piping
Layout Wizard in the Quick Access Panel, as shown below in Figure 1.
The Import Piping Layout Wizard is organized into sections that help guide the import process:
l

Folder Browser - After browsing to a folder, all .cii files within the folder will be listed here. Simply
clicking a file in the list will show a preview of the import in the Workspace. The location of the preview can be moved by dragging the icon in the upper-left of the selection area.

l

Object List - When a file is selected, the objects to be created will be listed here. Each individual
object can be reassigned to a certain Junction, if the automatic assignment is not correct. For
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example, the originating software may have only had a "valve" while this could be a Relief Valve or
a Control Valve. Changing the AFT Object type will change the preview in the Workspace. Rightclicking on an object shows a menu for converting object types.

l

l

Property Window - This button opens an additional panel that shows the raw properties
for the currently selected object.

l

Link Materials - Opens the File Object Link window, where the pipes can be associated
with a pipe material, size, and type in the AFT Pipe Material library. The selection from the
AFT Pipe Material library will overwrite any diameter information from the CII file, and will
be applied to all of the pipes.

l

CAESAR II Info - Detailed information from the neutral file can be viewed for objects in the
neutral file, including information on physical properties, allowable stresses, 3-dimensional
orientation, etc. for the imported objects.

Options
l

Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and longest pipe
in the list of pipes to be imported.

l

Ignore Pipes of Length Less Than - Do not import pipes shorter than this amount.

l

Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this diameter.

l

Ignored Pipes - How many pipes will be ignored based on the above settings. Ignoring
pipes can be helpful in keeping a model clean and free of unnecessary components. For
example, a pipe stress software may require many short pipe segments in between welds
or flanges. However, these types of connections are almost always ignored for hydraulic
analysis. By ignoring short pipes, the amount of "import clean up" required can be reduced.

l

Preferred Scale - The wizard will Auto Scale the import by default. If a different scale is
desired, this option can be disabled and a custom scale entered.

l

Show Pipes in Preview - Display the pipes in the Workspace preview.

l

Show Junctions in Preview - Display the junctions in the Workspace preview.

l

Show Labels In Preview - Show the corresponding label from the .cii file in the Workspace preview. This is only shown in the preview and will not be imported into the model
itself.

l

Combine Pipes When Possible - It is required that all pipes in the Workspace be connected by two junctions. However, this is not a requirement in all software. Therefore, some
.cii files may be generated with several pipes "end to end." If the pipes were imported this
way, either junctions would need to be added, or the pipes would need to be manually combined, before the model could be solved.

l

Import Bends as Pipes - Pipe bends can be considered as junctions or simply a visual
change in direction of the pipe. This is identical to using segments to show piping layout.
Note that these bends are visual only and have no losses associated with them - to account
for losses, either junctions or fittings & losses must be used. This option is helpful to reduce
unnecessary model clutter.

l

Ignore Fitting Lengths - Neglects additional length added to pipes that accounts for the
equivalent length of fittings and losses, and is not actually part of the physical pipe length.

l

Import Data to Pipe or Junction Notes Field - Add the raw data from the originating file
to the Notes tab of the corresponding object.
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Figure 1: CAESAR II Neutral File Import
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Importing GIS Shapefiles
Import GIS Shapefile
GIS Shapefiles that adhere to the ESRI standard can be imported into AFT Arrow for ease of model creation. These files have the extension .shp, but there are two other supporting file types that need to be in
the same folder as the .shp in order for the import to work correctly. These are .shx and .dbf file types.
The option is located under File > Import Model > GIS Shapefile (SHP). This opens the "Select GIS Files
to Import" window that allows the importing of one line .shp that is of pipes and multiple point .shp files for
branches, valves, compressors/fans, and tanks. Once the .shp files have been added to this window the
object type, scaling, and mapping can be selected.

Object Type
Any .shp files that are of lines are automatically set to the object type of "Pipes". Only one .shp file containing lines can be imported at a time. Any .shp file that is of points can be set to Branches, Valves, Compressors/Fans, or Tanks.

Scaling (Grid Points/Units)
Scaling only applies when no length is mapped to the AFT "length" field or when no length data exists in
the shapefile. Scaling does not alter the Workpace layout or visual length of the pipe. It only adjusts the
pipe length property that is calculated by the coordinates being imported from the shapefile.
The default scaling is 1 grid point to 1 foot. This can be adjusted by selecting the "..." button in the Scaling
column. This button opens a new window in which a new scale is applied to the automatic calculation of
the pipe length property. This window does not change the visual length of the pipe drawn on the workspace. This window also allows the viewing of the coordinates of specific points and parts of different
shapes within the shapefile.
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Select Mapping
The Data Mapping window allows the user to select what data fields have relevant data for AFT Arrow to
import.
l

l

l

l

l

Pipes can map:
l

Labels - Names

l

Length - Mapping this field will utilize included user shapefile data and override the automatic calculation of pipe length. The scaling window settings will have no effect when this
field is mapped.

l

Friction - Absolute Roughness, Relative Roughness, Explicit Friction Factor, Weymouth,
and Panhandle friction models are available.

l

Inner Diameter

Branches can map:
l

Labels - Names

l

Elevation

Compressors/Fans can map:
l

Labels - Names

l

Elevation

l

Assigned Flow - Imports as a Fixed Flowrate compressor/fan

Tanks can map:
l

Labels - Names

l

Elevation

Valves can map:
l

Labels - Names

l

Elevation
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Importing and Exporting EPANET Files
AFT Arrow includes the ability to import and export EPANET Files (*.INP). EPANET is public domain
modeling software developed by the US Environmental Protection Agency. Many different applications
support the file format, so it can therefore provide a quick way to get started with the hydraulic modeling
portion of a project.

Importing EPANET Files
Selecting File > Import Piping Layout From > EPANET File (.inp) brings up the Import Piping Layout Wizard in the Quick Access Panel, as shown below in Figure 1. Note that importing from EPANET requires
that the Workspace be empty.
The Import Piping Layout Wizard is organized into sections that help guide the import process:
l

Folder Browser - After browsing to a folder, all .inp files within the folder will be listed here. Simply clicking a file in the list will show a preview of the import in the Workspace. The location of the
preview can be moved by dragging the icon in the upper-left of the selection area.

l

Object List - When a file is selected, the objects to be created will be listed here. Each individual
object can be reassigned to a certain Junction, if the automatic assignment is not correct. For
example, the originating software may have only had a "valve" while this could be a Relief Valve or
a Control Valve. Changing the AFT Object type will change the preview in the Workspace. Clicking on an object in the workspace highlights it in the wizard.

l

l

Property Window - This button opens an additional panel that shows the raw properties
for the currently selected object.

l

Link Materials - Opens the File Object Link window, where the pipes can be associated
with a pipe material, size, and type in the AFT Pipe Material library. The selection from the
AFT Pipe Material library will overwrite any diameter information from the EPANET file, and
will be applied to all of the pipes.

Options
l

Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and longest pipe
in the list of pipes to be imported.

l

Ignore Pipes of Length Less Than - Do not import pipes shorter than this amount.

l

Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this diameter.

l

Ignored Pipes - How many pipes will be ignored based on the above settings. Ignoring
pipes can be helpful in keeping a model clean and free of unnecessary components. For
example, a pipe stress software may require many short pipe segments in between welds
or flanges. However, these types of connections are almost always ignored for hydraulic
analysis. By ignoring short pipes, the amount of "import clean up" required can be reduced.
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l

Preferred Scale - The wizard will Auto Scale the import by default. If a different scale is
desired, this option can be disabled and a custom scale entered.

l

Show Pipes in Preview - Display the pipes in the Workspace preview.

l

Show Junctions in Preview - Display the junctions in the Workspace preview.

l

Import Data to Notes Field - Add the raw data from the originating file to the Notes tab of
the corresponding object.

l

Auto-Zoom Preview - This option can be enabled to automatically zoom out so that the
whole model can be seen in the workspace, which can be convenient for large systems.
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Figure 1: EPANET Import Dialog
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Exporting EPANET Files
AFT models can be exported to an EPANET file by using the File -> Export Piping Layout To -> EPANET
File (.inp)... option from the Workspace window. The EPANET Export window shown in Figure 2 below
allows the user to specify the desired destination to export the file to.

Figure 2: EPANET Export Dialog
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Importing and Exporting from Other AFT Products
Models made in other AFT products such as AFT Fathom can be opened directly in AFT Arrow and vice
versa. This can be a useful starting point when it is desired to perform additional analysis on a model that
has already been built in another AFT product, such as if it is desired to perform heat transfer calculations
for a gas model originally built in Fathom.
To convert a model from one AFT product to another just browse to the model you would like to convert
and open it in the software you are converting the model to. This can be done by changing the file extension selected to "All", as is shown below in Figure 1, or to ".xtr" for xStream models.
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When the model is opened in AFT Arrow a backup copy of the original model will be created from which
the original model can be restored if needed. See the Backup Settings explanation for more information
on backup files.
The conversion process will automatically change junction types not included in AFT Arrow to either a
General Component or Branch junction. Be aware that some features available for use in other AFT
products are not available for use in AFT Arrow. If a junction is defined using a feature not available in
AFT Arrow, the non-applicable information will be removed, and the user may be required to input additional information to fully define the model. It is advised to fully review the model after import.

Figure 1: File extensions options for Open File window
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Exporting to Excel
AFT Arrow includes a powerful ability to export any Output data to any specific cell(s) in an Excel spreadsheet. Specific values from the model can be exported, as well as columns, rows, or entire output tables
as defined in Output Control. These items are controlled with the Excel Export Manager, available from
the File menu.
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Figure 1: The Excel Export Manager

Adding Items to the Excel Export Manager
Data from the Output can be added to the Excel Export by clicking New, or by selecting an existing item
and clicking Duplicate. Items can also be created directly from the Output Window by right-clicking on a
cell or header.

Figure 2: Adding items directly from the Output

Each row in the Excel Export Manager corresponds to a cell, column, row, or table of data to be added to
the spreadsheet. Each column helps define what data will be transferred where. The grid below the
entries shows a preview of where the data will be added to help prevent intersecting data by showing
where there are overlapping regions. Note that graph items can vary in size and do not show a complete
region here.
l

Apply to Export - Items can be optionally included or excluded from the export.

l

Export Type - What type of data is being exported. This affects other settings, and will affect how
much room is required on the target Excel sheet.
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l

l

Single Value - The value of a single parameter for a single pipe or junction object.

l

Column - Values of a single parameter for all of the displayed objects.

l

Row - Values of all displayed parameters for a single object.

l

Table - Values of all displayed parameters for all displayed objects.

l

Graph - The graph points from a specified Graph List Item.

l

Other - Additional information not available in a standard Output table, such as Fluid definition, Model Title, or Scenario Names.

Source - Where the data is coming from.
l

Pipe - From the Pipe section of the output.

l

Junction - From the Junction section of the output.

l

General Output Summary - From one of the available output Summary sections. For
example, if there is a Compressor/Fan junction in the model, Compressor/Fan Summary is
available.

l

Graph - From a specified Graph List Item.

l

Object - The object in particular that is desired. If Column or Table are selected for Export Type,
this selection will be fixed to ALL.

l

Parameter - The parameter in particular that is desired. If Row, Table or Graph are selected for
Export Type, this selection will be fixed to ALL.

l

Units - The units of the exported value. This is available only for Single Value and Column Export
Types. Some parameters do not have units and this will display N/A.

l

Excel Sheet - Which Excel Sheet to export to. This value can be edited by the user - if it is desired
to export to a named sheet this can be entered here.

l

Excel Starting Cell - The upper-left cell to export the data to.

l

Excel Ending Cell - The automatically calculated lower-right cell of the data, which depends on
the Export Type, export options, and the number of parameters or objects in the model. It is important to recognize that the Excel Starting Cells can be defined in a way that data gets overwritten.
The Ending Cell column is a handy reference to help avoid this.

l

Header - Optionally export the name of the Parameter(s) related to the item.

l

Units - Optionally export the name of the Unit(s) related to the item.

l

Add Excel Comments - Optionally adds an Excel comment to the value cell that contains the
Parameter name and unit.

l

Show Example - Displays an example of how the exported cells will appear.

Figure 3: Example Export
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Figure 4: Result of the above example. Color added for emphasis.

Excel Export Location
After all of the desired data has been added to the Excel Export Manager, the next step is to actually
export the data. There are three options available for the export:
l

Create New Workbook - A new Excel Workbook will be opened with the exported data.

l

Previously Saved Workbook - Browse to a Workbook saved to file. The Workbook will be
opened and the modifications made to the sheets as specified.

l

Currently Opened Workbook - Select a Workbook that is currently open in Excel. The already
open Workbook will be modified.

Note: The Excel Export Manager does not save Excel files for non-batch run exports. Any changes
made need to be manually saved by the user in Excel.
There are two options available for exporting:
l

Clear Sheet Data - All of the existing data on the sheets specified in the Excel Sheet column will
be cleared. This is especially useful for setting up a new export when many changes are being
made.

l

Automatically Export After Running Model - After the model is run, the Export will be carried
out automatically, per the settings defined by the user in the Excel Export Manager.

Advanced Options
Items can be added directly from the Output instead of adding custom items with the New button. There
are two behavioral options that can be modified for this action:
l

Open Excel Export Manager - If enabled, the Excel Export Manager will be opened every time
an item is added from the Output. This is useful for double checking the setup.

l

For Existing Items l

Add New Item - The item selected will be added to the Excel Export Manager even if it
already exists.
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l

l

Select Existing - If the item already exists, do not add a duplicate item and instead select
the existing item.

l

Ask - If the item already exists, prompt the user on the action to take.

Create an Export Guide - When exporting, an Export Guide can optionally be included in the
export. The Export Guide contains information about the model and the generation of the export,
to help keep the connection between the data and the model clear for future reference.

Exporting Data From Multiple Scenarios
The Excel Export Manager can be employed with Batch Runs with a couple of important distinctions.
First, if multiple sheets are specified in the Excel Export Manager, the only way to export multiple scenarios is to export every scenario to its own Workbook. To keep data from multiple scenarios in one
Workbook, there can only be one sheet specified in the Excel Export Manager.
Second, the Excel File will be saved after each scenario. In normal single-scenario exports the file is
never saved, but in batch mode it is required.
In the Batch Run tool, users are also able to use Excel Export without having to run the scenarios again.
Note that if any of the scenarios in the Batch Run do not have output, the batch Export Only will not
export any data for that scenario, as it will not run those scenarios to get output.

Figure 5: Saving Results From Multiple Scenarios
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Importing from Excel
A Microsoft Excel spreadsheet can be used to make changes to objects in an AFT Arrow model. The values in the Excel file are located in specific locations as described in the Setting Up Excel section.

Setting Up Excel
When reading an Excel file, AFT Arrow will search for a worksheet named "AFT Transfer". There can be
other worksheets in the workbook, but AFT Arrow will only look for a sheet with this name. The file structure looks like the following:

Figure 1: Sample AFT Transfer Excel Sheet

Row 1 and column A are not read by AFT Arrow - these cells can have any value in them, though it is
recommended to enter the values above for the header row.
Each column has certain accepted values, which can depend on the values in neighboring columns.
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Note: A template spreadsheet containing validation rules for the required layout is included in the AFT
Arrow installation. By default the file path is: C:\AFT Products\AFT Arrow\AFT Arrow Excel
Import Workbook.xlsx, or the spreadsheet can be downloaded here.

Apply Column
This column accepts Yes or No. Only changes marked as Yes will be imported into the model.

Object Type
This column must be a junction name or Pipe. Valid choices can be seen below in Table 1.

Object Number
This corresponds to the junction or pipe number.

Parameter
The specific parameter to be changed. These parameters vary based on the Object Name selected.
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Table 1: Object Types, Associated Parameters, and Change Codes

Pipe

Assigned
Flow

Assigned
Pressure

S CdA (for
S Ambient Fluid Velosonic chokcity
ing)

S Design Factor

S CdA

S CdA (for
sonic choking)

S Flow Rate

S Ambient Temperature

S Initial Guess
Pressure

S Design
Factor

S Design
Factor

S Elevation

S Initial Guess
Pressure

S Additional K Factor

S Buried Pipe Depth
S Design Factor Pipe Fittings &
Losses
S Design Factor Pipe Friction
S Design Factor Pipe Heat Transfer
S External Heat
Flux/Tracing Flux

Area
Change

S Design
Factor
S Initial
Guess Pressure
S Initial
Guess Temperature
S Elevation
C Junction
Name

S External Heat Rate

I Sizing/Cost
Setting

S Initial Guess
Flowrate

S User Specified K

S Initial Guess
Temperature

C Junction
Name

S Elevation

S Pressure

C Junction Name

I Sizing/Cost
Setting

I Sizing/Cost Setting
S Temperature
I Special Condition
S Temperature
(Static)

S Inner Diameter (for
unspecified, cylindrical pipes)
S Length
I Nominal Size Increment
C Nominal Size Set
(must match text in
Pipe Property Window)
C Nominal Type Set
(must match text in
Pipe Property Window)
S Noncylindrical
Flow Area
S Noncylindrical Wet-
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Bend

S Initial Guess
Temperature
S Elevation
C Junction
Name
I Sizing/Cost
Setting
S User Specified K
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ted Perimeter
C Pipe Name
S Rectangular Duct
Height
S Rectangular Duct
Width
S Roughness Value
(for unspecified friction models)
S ID Reduction (Scaling)
I Sizing/Cost Setting
S Soil Surface Temperature
I Special Condition
Branch
S Design Factor
S Initial Guess Pressure
S Initial Guess Temperature
S Elevation
C Junction Name

Check
Valve

Compressor/Fan

Control
Valve

S CdA (for
sonic choking)

S Control Setpoint

S Design
Factor

S Delta
Head/Pressure
to Re-Open Combined Check
Valve

S Initial
Guess Pressure

S Design
Factor
S Initial
Guess Pressure

S Design Factor

S Initial
Guess Temperature

I Sizing/Cost Setting
S Source/Sink Flow
S Source/Sink Temperature/Enthalpy
I Special Condition

S Initial
Guess Temperature
S Elevation
S Forward
Velocity to
Close Valve
C Junction
Name
S Loss
Value
I Sizing/Cost
Setting

S Fixed Flow
Rate
S Fixed Speed
(%)

S Elevation
C Junction
Name

S Loss
S Forward Velo- When Full
city to Close
Open
Combined Check
S Setpoint
Valve
S Initial Guess
Pressure
S Initial Guess
Temperature
S Elevation
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I Sizing/Cost
Setting
I Special
Condition
S Xt When

Dead End
S Initial Guess
Pressure
S Initial Guess
Temperature
S Elevation
C Junction
Name
I Sizing/Cost
Setting
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I Special
Condition
S Xt Value

C Junction Name

Fully Open

S Nominal Efficiency
S Polytropic Constant
I Sizing/Cost Setting
I Special Condition

General Component

Heat
Exchanger

S CdA (for sonic
choking)

S Controlled
Outlet Temperature

S Design Factor
S Initial Guess Pressure
S Initial Guess Temperature
S Elevation
C Junction Name

S Design
Factor - Friction Loss

I Special Condition

S Area/Diameter
S Design Factor
S Exit Pressure
S Exit Temperature

S Initial Guess
S Design
Pressure
Factor - Heat
S Initial Guess
Transfer
Temperature
S Heat Flow
Into System S Inlet Elevation

S K Factor
I Sizing/Cost Setting

Orifice

S Initial
Guess Pressure
S Initial
Guess Temperature
S Elevation

Relief
Valve
S Cracking
Pressure
S Design
Factor
S Exit Pressure
S Exit Temperature
S Initial
Guess Pressure

C Junction Name
S Loss Value
S Outlet Elevation

S Initial
Guess Temperature
S Elevation

I Sizing/Cost Set- C Junction
ting
Name
S Loss
Value

S Heat
Transfer
Area

I Sizing/Cost
Setting

C Junction
Name

I Special
Condition

S K Factor
S Overall
Heat Transfer Coefficient
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S Initial Guess
Temperature
S Elevation
C Junction
Name
S K Factor
I Sizing/Cost
Setting
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S Secondary
Fluid Flow
Rate
S Secondary
Fluid Specific Heat
S Secondary
Fluid Inlet
Temperature
I Sizing/Cost
Setting
I Special
Condition
Separator
S Initial Guess Pressure
S Initial Guess Temperature
S Elevation
C Junction Name
I Sizing/Cost Setting

Spray Discharge
S CdA (for
sonic choking)

Tank
S Design Factor
S Elevation
S Fixed/Initial
Volume

S Cd (Discharge Coef- C Junction Name
ficient)
S Pressure
S Design
I Sizing/Cost SetFactor
ting
S Discharge
S Temperature
Flow Area
S Exit Pressure

Tee or
Wye
S Design
Factor
S Initial
Guess Pressure
S Initial
Guess Temperature
S Elevation
C Junction
Name
I Sizing/Cost
Setting

S Exit Temperature

Valve
S CdA (for
sonic choking)
S Design
Factor
S Elevation
S Exit Pressure
S Exit Temperature
S Initial Guess
Pressure
S Initial Guess
Temperature
C
Junction Name

S Initial
Guess Pressure

S Loss Value

S Initial
Guess Temperature

S Open Percentage

S Elevation

I Sizing/Cost
Setting

C Junction
Name

I Special
Condition

I Number of

S Xt Value
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Holes
I Sizing/Cost
Setting
I Special
Condition
Venturi
S Design Factor
S Initial Guess Pressure
S Initial Guess Temperature
S Inlet Elevation
C Junction Name
S Loss Value
S Outlet Elevation
I Sizing/Cost Setting

Change Code
Each Parameter has restrictions on how it can be changed. All of the Parameters are decimal numbers,
integers, or strings.

Table 2: Valid Change Codes for each type of Parameter

Decimal
Integer
Number (S) Number (I)

String (C)

Set equal to
value

Set equal to
value

Set equal
to value

Change by
value (+/-)

Change by
value (+/-)

Add string
to list

Change by
percent (+/-)

Delete
string from
list
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Value
The actual value to change the Parameter to or by.
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For special conditions there are specific values assigned to each special condition option, as are listed in
the table below.

Table 3: Values used to import special conditions

Junction

Special
Condition

Value

Assigned
Flow

None

0

Closed

1

Check
Valve

None

0

Closed

1

Open

2

None

0

Closed

1

Fully
Open No Control

2

General
Component

None

0

Closed

1

Heat
Exchanger

None

0

Ignore
Heat
Transfer

2

Jet Pump

None

0

Closed

1

None

0

Pump
Off No
Flow

1

Control
Valve

Pump

2

Pump
Off With
Flow
Through
Relief

None
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Junction

Special
Condition

Value

Valve

Failed
Open

2
5

Ignore
Relief
Valve
Spray Dis- None
charge
Closed

0

Valve

None

0

Closed

1

None

0

Ignore
Weir

5

Weir

1

Scenario Path Name
The Scenario that the changes are intended to apply to. If no scenario is present, the changes will be
applied to the current scenario.
It is important that the Scenario name is uniquely qualified - if there are multiple scenarios with the same
name, the full Scenario Path Name can be used. Scenario Path Names can easily be copied from AFT
Arrow by right-clicking the scenario name and selecting "Copy Scenario Path Name."

Importing the File
When the sheet has been completely filled out, it can be imported from File > Import Excel Change Data.
When importing the data, the Object Change Log will appear, listing the changes that were made and
any errors that occurred during the import.
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Table 4: Excel Importing Error Messages

Error

Description

Scenario name is
not unique in the
model (use full
scenario path
name)

There are multiple
scenarios with this
name. Use the fully
qualified path
name (e.g. Base
Scenario\US Units\Pump A).

Invalid change
type

The Change Code
is not valid for the
Parameter. For
example, trying to
change a string
type with Change
by Value (+/-).

Invalid parameter
ID

The parameter
given does not
match the object
type (e.g. Length
for a junction).

Invalid parameter
value

The value cannot
be changed
because the value
is not valie. For
example, a pump
speed cannot be
negative.

Object not found

A pipe or junction
with the given ID
was not found.

Parameter conflict

The value cannot
be changed
because it conflicts
with another setting. For example,
the loss value cannot be set when the
junction is using a
resistance curve.

Scenario not
found in the model

No scenario by the
given name was
found in the model.
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Note: In order for the junction to accept the changes, some fields must already contain data. For
example, if the control setpoint for a control valve is being changed, there must already be a setpoint and units entered into the control valve junction object. This is to ensure that the correct
set of units are being used. These values can be set using Global Pipe Edit or Global Junction
Edit to an arbitrary value before the changes are made from Excel.

Related Topics
File Import and Export
Importing Piping Component Files
Importing GIS Shapefiles
Importing CAESAR II Neutral Files
Importing and Exporting EPANET Files
Importing and Exporting from Other AFT Products
Exporting to Excel
Related Blogs
Now it’s Super Easy! Changing Input Data in AFT Models using Excel Change Data
That was EASY! Quickly Change Pipe and Junction Input Data into AFT models using Excel Change
Data
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Design Alerts
Design Alerts are a powerful feature that can help speed up the modeling process and help verify that the
model is behaving as expected. The creation of a Design Alert does not constrain or affect the operation
of the model in any way. However, it automatically creates an output alert any time the design limit is violated. One common use case might be defining a maximum allowable pressure for the pipes in the model.
While the output can be reviewed manually for these violations, this quickly becomes tedious as the
model grows in size. Creating a Design Alert instead allows the engineer to spend less time reviewing
output tables as any violation will be immediately identified.
The Design Alert Manager allows the user to create or modify Design Alerts. It can be accessed from the
Tools Menu or in the Design Alerts tab in pipe and junction properties windows.
Design Alerts can also be created directly from the output, or can be imported/exported to and from other
model files.

Figure 1: Design Alert Manager

Creating and Applying Design Alerts
Click Create New Design Alert to add a new Design Alert to the model. The Design Alert Manager
expands to allow the creation of the new alert.
A Name, Object Type, and at least one Parameter are required. Depending on the Object Type, a different selection of Parameters is available, as shown below. To add a Parameter:
1.

Select the desired parameter

2.

Select whether this is the maximum or minimum allowable value

3.

Enter the value with the appropriate units (if applicable)

4.

Click Add to List.

Several Parameter limits can be added to one Design Alert. For example, an alert can be created that
requires a pressure within a range by adding both the maximum and minimum pressure limits.
To update a Parameter, simply create it again and click Add to List - the old value will be replaced with
the new one.
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Figure 2: Creating a Design Alert

Figure 3: Available Design Alerts

Figure 4: An Existing Design Alert

The Design Alert now exists, but has not yet been applied to any objects in the model. To include objects
in the model, select them in the pane on the right.
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Figure 5: Fully Defined Design Alert

Note that the application of Design Alerts can also be managed for individual objects in their Properties
Window's Design Alerts tab.

Figure 6: Apply Desired Design Alerts to this Object

When running the model, the selected object's output values will be checked against the limits that have
been defined. If any of the Design Alerts are violated, the user will receive a Design Alert warning and the
violating parameters will be highlighted in the output tables.
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Figure 7: Design Alert Violations in Output

Design alerts are visible in every scenario in a model, but can be turned off or on for specific scenarios.
When creating a design alert for the first time it will be active in that scenario and all its child scenarios.
For more information about scenarios, please read the Scenario Manager help topic.

Related Topics
Design Alerts Importing & Exporting
Design Alerts From Output

409
407

Design Alerts From Output
Right-clicking on a cell in the Output Window brings up a context menu. One of these options is Create
Design Alert...
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Figure 1: Output Context Menu

Create Design Alert automatically defines a Design Alert based on the selected value and quantity:

Figure 2: Automatically defined Design Alert

The Design Alert needs to have a name defined to be added. The specific value of the alert can be modified, and whether it is a maximum or minimum can be selected. The associated object is automatically
selected as part of the Design Alert, but this is not required and additional objects can be selected now.
After the Design Alert has been created it can be further modified in the Design Alert Manager.

Related Topics
Design Alerts
Design Alerts Importing & Exporting

404
409
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Design Alerts Importing & Exporting
Design Alerts can be saved to a text file to be imported into other model files. This allows the user to
quickly load commonly used design alerts into multiple model files.

Export a Design Alert
To export a Design Alert:
1.

Fully define a Design Alert for any parameter in the Design Alert Manager. For this example, we
are using a velocity design alert.

2.

From the Other Actions menu select Save, then save the file with a descriptive name.

Figure 2: The save option is selected from the Other Action dropdown. This saves the design alert to be
exported.

Import a Design Alert
1.

Open the Design Alert Manager from the Tools menu.

2.

From the Other Actions menu, select Load, then browse to the saved design alert file.

- 409 -

Design Alerts

Figure 3: The Load option from the Other Actions dropdown menu allows the user to import previously saved
design alerts

3.

The Design Alert should now be added to the Existing Design Alerts list, and can be applied to
objects in the model.

Related Topics
Design Alerts
Design Alerts From Output

404
407
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Scenario Manager (in the Quick Access Panel) is a powerful tool for managing variations of a model,
referred to as scenarios. It allows you to quickly test the same model with selected differences (such as
pump size, pipe diameter, system location, units, etc.) to find the system which works best. The Scenario
Manager allows you to:
l

Create, name and organize scenarios

l

Select the scenario to appear in the Workspace (the ‘current’ scenario)

l

Delete, copy, and rename scenarios

l

Duplicate scenarios and save them as separate models

l

Review the source of a scenario’s specifications

l

Pass changes from a scenario to its variants

l

See what scenarios have output by automatically changing the text color to blue if they have output

All scenarios are saved within the model file.

Scenario
A variant case of a model that is created in the Scenario Manager.

Base Scenario
The Base Scenario is the root scenario at the top of the scenario tree. As the highest level ancestor, it
does not inherit from any other scenario. A new scenario can be inserted above the base scenario, at
which point the new scenario would behave as the base scenario, and the original base scenario would
behave as a child scenario. "Base Scenario" is the default name given in a new, single scenario model.

The Scenario Manager
Illustrated in Figure 1, the top of the Scenario Manager displays the scenario tree, showing the names of
the currently defined scenarios, their relationship to other scenarios and which is the current Workspace
scenario (the current scenario is also identified in AFT Arrow’s Status Bar). At the bottom, there is a place
where you can record notes related to that scenario (the notes also propagate to children).
Those attributes whose value comes from a different scenario are linked, while those values coming from
the selected scenario are not linked. Linked attributes will inherit changes made in the same object and
attribute of the linked ancestor. This inheritance will occur over as many generations as the link exists.
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Figure 1: Scenario Manager in Quick Access Panel

Related Topics
Note No Scenarios have been set in the Multi-Scenario Output display
Creating, Organizing, and Editing Scenarios
Modifying Individual Scenarios
Scenario Inheritance
Running Models in Batch Mode
Open Model Using Last Scenario
Disconnected Scenario
Scenario Comparison Tool Overview

675
412
415
416
419
420
421
421

Related Examples
Compressed Air System
Refinery Relief System

748
775

Creating, Organizing, and Editing Scenarios
Scenarios are referred to as either a parent or child, plus the Base Scenario, which may be thought of as
the root scenario. Upon opening a new model file, only a Base Scenario will be present. To create a new
scenario below the Base Scenario, right-click the Base Scenario and select Create Child.

- 412 -

Scenario Manager Overview

Any scenario can be loaded as the current scenario by double-clicking on it.
Figure 1 illustrates a model with a Base Scenario with three children, ‘2 inch PVC Pipe’, ‘3 inch PVC Pipe’
and ‘4 inch PVC Pipe’, representing three different size pipe runs. Each of these, in turn, has two children, ‘Max Demand’ and ‘Min Demand’, for the two operating cases.

Figure 1: Scenario Manager in Quick Access Panel

‘2 inch PVC Pipe’, ‘3 inch PVC Pipe’ and ‘4 inch PVC Pipe’ were created by first selecting the Base Scenario then clicking on Create Child. ‘Max Demand’ and ‘Min Demand’ were, in turn, created by selecting
each of the above children scenarios for the three different pipe run sizes and then clicking on Create
Child.
Note: Alternatively, one could have made the Base Scenario current, created the ‘2 inch PVC Pipe’
child and then selected it and created the ‘Max Demand’ and ‘Min Demand’ scenarios below it.
Then, with ‘2 inch PVC Pipe’ still selected, clicked Clone With Children twice and renamed the
new clones ‘3 inch PVC Pipe’ and ‘4 inch PVC Pipe’.
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The ‘Max Demand’ and ‘Min Demand’ scenarios may be thought of as grand children of the Base Scenario. This concept of scenario ancestry is helpful in keeping track of the differences and similarities
between scenarios discussed later.
A box with a plus sign next to a scenario indicates it may be expanded to reveal children scenarios while
a box with a minus sign indicates the level is fully expanded with all children scenarios shown, if any. No
box indicates there are no children. Levels may be expanded by clicking on the plus sign and condensed
by clicking on the minus sign.
Right-clicking a scenario provides the following choices:
l

Create Child with No Output - create child scenarios without results saving duplication and load
time

l

Rename - renames the selected scenario

l

Delete Scenario - deletes the selected scenario

l

Delete All Children - deletes all children of the selected scenario

l

Clone Without Children - creates a copy of the selected scenario at the same level (a sibling).
Cloning a scenario prompts the user for a name for the new scenario

l

Clone With Children - creates a copy of the selected along with its children. Cloning a scenario
prompts the user for a name for the new scenario

l

Insert Scenario Above Selected... - creates a new scenario where the selected scenario is and
shifts the selected scenario and its children down a level. This can be used to create a new base
scenario. If this is done the user will be prompted to rename the previous base scenario.

l

Promote - raises a scenario one level, i.e. from a child to a sibling, active only for scenarios more
than one level below the base scenario

l

Copy/Save Scenario Names
l

Copy Scenario Path Name - copy the fully-qualified name of the scenario to the Windows
clipboard ("Base Scenario/Case 1/Child 3")

l

Copy Scenario Path Name With File Name - copy the fully-qualified scenario name
along with the model name ("Model.aro :: Base Scenario/Case 1/Child 3")

l

Save Scenario Names Only to File... - copy all scenario names on separate lines, with
indents to show child/parent relations

l

Save Full Scenario Paths to File... - copy all scenario names on separate lines, with the
full path name used for each scenario

l

Save Scenario to File Without Children - saves the selected to scenario to a separate file
without its children

l

Save Scenario to File With Children - saves the selected scenario and its children to a separate
file

l

Compare to Active Scenario - compares all parameters for all objects between the selected
scenario and active scenario and displays the Comparison Grid showing the results

Scenario Comparison Tool - opens the Scenario Comparison Tool to create a custom scenario comparison
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Note: It is important to remember that AFT Arrow’s Edit menu Undo does not apply to Scenario Manager operations. To undo a Rename scenario operation, you can rename the scenario again to
the old name. To undo a Clone or Save Scenario operation, you can delete the clone or file created. Once a scenario is deleted or promoted, there is no way to un-delete or un-promote the
scenario.

Viewing Scenario Differences
Differences between scenarios can be viewed in two different ways. All data associated with any selection of scenarios can be viewed using the Scenario Comparison tool. Alternatively, a scenario’s data and
that for all of its direct ancestors can be viewed in the Model Data Window. This functionality can be
enabled in the Model Data Control window.
Output from different scenarios can also be displayed in the Output window using Output Control features.

Fast Scenario Changes
AFT Arrow remembers the most recent scenario you had open, and allows you to quickly change back to
that scenario by using the Last Scenario feature. Last Scenario is found on the View menu and Toolbar.

Related Topics
Scenario Manager Overview
Modifying Individual Scenarios
Scenario Inheritance
Running Models in Batch Mode
Open Model Using Last Scenario
Disconnected Scenario
Scenario Comparison Tool Overview

411
415
416
419
420
421
421

Modifying Individual Scenarios
When first created, a scenario is identical to its parent. To modify or run a scenario, it must first be made
the current Workspace scenario by selecting it within the Scenario Manager window, then clicking on the
Load As Current Scenario button. (The name of the current scenario is displayed in both the Scenario
Manager window and in AFT Arrow’s Status Bar.) Once a scenario is the current scenario, changes may
be made to differentiate it from its parent using any of AFT Arrow’s editing tools and functions. When an
attribute is changed within a scenario it breaks the link for this attribute. Subsequent changes in the scenario’s ancestors will no longer affect this attribute.
Properties of a scenario that may differ from its ancestors include:
l

Presence and location of objects -- one may add or delete pipes and junctions within a scenario
and the workspace locations may vary from scenario to scenario
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l

Pipe and junction Properties -- all values set in the Properties windows

l

Fluid Properties -- fluid selected, system data

l

Solution Control -- solution method, tolerances, relaxation

l

Output Control -- Output window content and formatting

l

Cost Settings -- application of cost data

l

Goal Seek & Control (GSC Module Only) -- Application of variables and goals can change
between scenarios. The actual variables and goals are the same in all scenarios.

l

Libraries Manager -- The connected library content can be varied between scenarios

l

Visual Report Control -- Visual Report content and color maps

l

Model Data Control and User Options applies to all scenarios.

l

Sizing Settings (ANS Module Only) - All input in the Sizing window. Candidate Sets and Design
Requirements are the same in all scenarios, but they may be applied differently.

Related Topics
Scenario Manager Overview
Creating, Organizing, and Editing Scenarios
Scenario Inheritance
Running Models in Batch Mode
Open Model Using Last Scenario
Disconnected Scenario
Scenario Comparison Tool Overview

411
412
416
419
420
421
421

Scenario Inheritance
Scenario Manager will pass changes made in a scenario to linked attributes of its descendants, allowing
multiple scenarios to be modified in one operation and maintain similarity between scenarios where
desired.
Any attribute whose value is the same as that of the scenario’s parent is linked to the parent. In turn, if the
parent’s attribute value is the same as that of its parent, then the child’s attribute is linked to its grandparent. This ancestral linking of attributes can exist across any number of generations. A change made to
a scenario will be passed downward to its children, grandchildren, etc., as far as the link exists. Changes
are NOT passed upward from child to parent.
Once an attribute is changed within a scenario, the link is broken to that individual attribute. Subsequent
changes in the scenario’s ancestors, parent, grandparent, etc., will no longer affect that attribute, but all
other attributes within the scenario will remain linked. The Model Data window with Ancestral Data
enabled on the Scenario Format tab shows how the data changes between scenarios.

Scenario logic examples
For many users, it is easiest to grasp Scenario Manager when it is explained how the coding logic is actually implemented. Blank fields for children, grandchildren, etc., mean to look to the parent for the
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data. The Base Scenario never has blank fields (Figure 2). Data only passes downwards, never
upwards.

Table 1: Blank fields for Child #1 and Grandchild #1 mean that the data is to come from the parent. If the Base
scenario data is changed, all descendants are changed.

If a child scenario does not have a blank field, then data for that property is initiated at that scenario level
(see Table 2).

Table 2: Child #1 does not have a blank field, so it’s Diameter would be 2, not 3, as would Grandchild #1

If a scenario is changed, and its child has different data, then the change will not pass downwards (see
Table 3).

Table 3: Changing the Base Scenario Diameter from 3 to 6 would not impact Child #1 or any descendants in
that line. Changing the Length from 25 to 40 would also change the length in Child #1, Grandchild #1, and
any descendants of Grandchild #1.

If a child scenario has data that is different than the parent, its children cannot relink to the parent (see
Table 4).
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Table 4: Even if the Grandchild #1 has the same Diameter as the Base, it is not linked to the Base because it
and its parent are not blank.

If a child scenario’s data, which was previously changed and is thus different from the parent, is changed
back to the same vale as the parent, the inheritance link is re-established (see Table 5). Its descendant’s
link is also re-established.

Table 5: If the Diameter in Child #1 is changed to be the same as the Base, it will be "blanked out" the next
time the scenario is loaded and the link re-established. And so will Grandchild #1, if it’s Diameter is also the
same.

Table 6 shows data for two pipe properties across three scenarios. The data that would be used when
each scenario is loaded is as follows:
l

l

l

Base scenario
l

Diameter = 3

l

Length = 25

l

Changes to Diameter will not pass downwards

l

Changes to Length will affect only Child #1.

Child #1 scenario
l

Diameter = 2

l

Length = 25

l

Changes to Base Diameter will not affect Diameter

l

Changes to Base Length will affect Length

GrandChild #1 scenario
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l

Diameter = 2

l

Length = 15

l

Changes to Base Diameter will not affect Diameter

l

Changes to Child #1 Diameter will affect Diameter

l

Changes to Base Length or Child #1 Length will not affect Length

Table 6: Input data for these properties explained in the text.

Re-Establishing Broken Scenario Links
A link may be re-established by returning the attribute to the same value as that of its parent. This can be
done manually by entering the value or selecting the Copy Data From Pipe list and selecting the Parent
Pipe Data option. Within other data windows, it is done by selecting the Same As Parent option in Analysis Setup, Output Control, Library Manager or Visual Report Control.
Since links are identified by comparing attribute values of pipes or junctions with the same Workspace ID
number, renumbering a scenario will break the links of all pipes and junctions renumbered. Since numbers must be unique, once a link has been broken by renumbering, it may not be re-established.

Related Topics
Scenario Manager Overview
Creating, Organizing, and Editing Scenarios
Modifying Individual Scenarios
Running Models in Batch Mode
Open Model Using Last Scenario
Disconnected Scenario
Scenario Comparison Tool Overview
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Running Models in Batch Mode
AFT Arrow scenarios or models can be run in batch mode, a feature that is especially useful for running a
group of scenarios or models during lunch or overnight.
To run models in batch mode, follow these steps:
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1.

Click "Start Batch Run" on the File menu.

2.

Select the Batch Run Type. This is where you select if you want to run scenarios from the current
model or different model files. If the current model does not have any scenarios, then only the
second option will be available.

3.

If the Batch Run Type is "Scenarios in Current Model", then choose the Add Scenarios button and
select the scenarios you wish to run.

4.

If the Batch Run Type is "Models from Different Files", then the models can be selected individually using the "Add Model Files" button, or loaded from a Batch File (by Choosing the "Load
Existing Batch File" button). A Batch File is a text file listing all models you would like to run. At any
time, a selected model file can be removed by clicking the "Remove Selections". The current list of
models can be saved to a Batch File for use in the future by clicking the "Save List to File" button.

5.

Use the Output Options in the lower left to save the output data to a file and/or send it to a printer
or Adobe PDF file. All reports will use the specified settings.

6.

Alternatively, the option can be chosen to Save Using Excel Export Manager by either saving to
separate sheets, or saving the scenarios to separate workbooks. The Excel Export option can
only be chosen if the batch run type is for Scenarios in Current Model. Additionally, the desired output must first be configured in the Excel Export Manager under the File menu for any data to be
exported.

7.

Check the box to Run Batch in Background if you wish for all selected scenarios to run without
showing the Solution Progress window. AFT Arrow will run the simulations in the background and
will not interrupt any work being done in other programs.

8.

Click the Start Run button to begin the batch run.

AFT Arrow then opens each scenario or model file in sequence, automatically runs each scenario/model
that has a completed Analysis Setup window, and sends results to the specified destination. All pertinent
information that is generated during the batch run (such as error messages) are automatically displayed
when the final scenario/model is finished.
The entire batch run can be canceled at any time by clicking the Cancel button in the Solution Progress
window.
Note: You can view output from multiple scenarios concurrently in the Output window.

Related Topics
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Creating, Organizing, and Editing Scenarios
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Open Model Using Last Scenario
When the model is saved, the current scenario is remembered, and by default, reloaded when the model
is opened again. Your preference of whether to always open the model to the most recent scenario or to
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the base scenario can be specified in the User Options window.

Related Topics
Scenario Manager Overview
Creating, Organizing, and Editing Scenarios
Modifying Individual Scenarios
Scenario Inheritance
Running Models in Batch Mode
Disconnected Scenario
Scenario Comparison Tool Overview
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Disconnected Scenario
A special type of scenario that is no longer connected to the Scenario Manager, created from the Tools
Menu or from the Toolbar in the Output window. A disconnected scenario itself breaks the inheritance of
normal child scenarios so that it is truly standalone scenario. No changes made to any parent scenario
will propagate to this scenario. This is useful to preserve certain settings from a different scenario.
Disconnected Scenarios are denoted with (*).

Related Topics
Scenario Manager Overview
Creating, Organizing, and Editing Scenarios
Modifying Individual Scenarios
Scenario Inheritance
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Scenario Comparison Tool Overview
Scenario Comparison Tool (accessed via the Tools menu) is a powerful tool that allows users to compare
model parameters between scenarios in a given model. It lets users quickly identify differences between
two or more scenarios without needing to search through the model data for each scenario or inspect
each element of the model. This tool can be especially powerful for users reviewing others' models, or for
users returning to models after a period of time. It can also be powerful for troubleshooting purposes. The
Scenario Comparison Tool lets you:
l

Compare any two or more scenarios

l

Compare selected Pipes and Junctions between selected scenarios
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l

Compare selected Pipe and Junction parameters between selected scenarios

l

Compare selected General Properties between selected scenarios

Related Topics
Accessing Scenario Comparison Tool
Modify Comparison
Scenario Comparison Grid
Scenario Manager Overview
Creating, Organizing, and Editing Scenarios
Modifying Individual Scenarios
Scenario Inheritance
Running Models in Batch Mode
Open Model Using Last Scenario
Disconnected Scenario
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Related Blogs
New Feature Highlight - Scenario Comparison Tool

Accessing Scenario Comparison Tool
The Scenario Comparison tool can be accessed from the Scenario Manager, the Workspace, and the
Tools menu.

From the Scenario Manager
To set up a comparison from the Scenario Manager, first select the pipes and junctions to compare in the
workspace. Then, select the desired scenario to compare the current scenario to in the Scenario Manager. Note the current scenario is indicated by the green check-mark symbol. Right-click the desired
scenario, and select Compare Selected Scenarios.... This will bring users to the Scenario Comparison
window and display a grid with the differences between the selected objects in the two scenarios.
To modify the comparison use the Modify Comparison button at the bottom of the window.

From the Workspace
From the workspace, users can quickly select desired pipes and junctions in the scenario and compare
them to those found in any other scenario.
First, select the desired pipe(s) and/or junction(s) in the workspace. Then, right-click the Workspace,
choose Compare Scenarios, and select the desired comparison. This will bring users to the Scenario
Comparison window and display a grid with the differences between the selected objects in the two scenarios.
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To modify the comparison use the Modify Comparison button at the bottom of the window.

From the Tools Menu
From the Tools menu, there are multiple options to generate the Scenario Comparison Grid.
A comparison grid can be directly generated by selecting the desired objects to compare in the Workspace, then selecting the scenarios to be compared from the Compare Scenarios menu option.
Alternatively, the Scenario Comparison Tool menu option can be selected to build a custom scenario
comparison by directly selecting the scenarios, objects, and parameters to be included in the comparison. See Modify Comparison for more information on the available options.
Click the Show Comparison button at the bottom of the window to view the comparison. To make additional changes, use the Modify Comparison button at the bottom of the window.

Related Topics
Scenario Comparison Tool Overview
Modify Comparison
Scenario Comparison Grid
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Related Blogs
New Feature Highlight - Scenario Comparison Tool

Modify Comparison
Several Options are available to customize the Scenario Comparison Grid. These options are available
from the Modify Comparison button at the bottom of the scenario comparison report, or by selecting Scenario Comparison Tool from the Tools menu. The Modify Comparison window is shown in Figure 1 below.
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Figure 1: Scenario Comparison window options to Modify Comparison

Select Scenarios to Compare
The Scenario Comparison Tool has four pre-set templates for comparing scenarios, plus the ability to set
up a custom comparison. These are:
l

Parent: This template compares the current scenario with that scenario's parent.

l

Ancestors: This template compares the current scenario with all of that scenario's direct ancestors. This setting would be similar to the comparison available in the Model Data window, though it
does provide a more comprehensive comparison.

l

Siblings: This template compares the current scenario with all of that scenario's siblings.

l

Exhaustive: This template compares all of the scenarios in the model with each other.

l

Custom: This option allows users to compare any two or more scenarios throughout the model.

Select Pipe and Junction Properties
This section sets what parameters will be compared such as length, diameter, roughness, etc.
Users can choose to compare a set of specified properties, or all pipe and junction properties by selecting the desired properties under Select Pipe and Junction Properties. Only properties selected in this section will be considered when the comparison is run.
A helpful option to filter the parameters to be displayed in the comparison is to display the parameters
shown in the Model Data window. This can simplify the comparison, but might hide some differences
between scenarios. Use the Model Data Control window to further define what parameters are shown
with this option.
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Select General Properties
This section sets what General Properties will be compared such as fluid properties, tolerances, etc.
Users can choose to compare all or a select set of general properties for the scenarios including options
that are located in the Analysis Setup window.

Select Pipes and Junctions
This section sets which pipes and junctions will be compared for the model.
Users can choose to compare all objects in the model, or a selected set of pipes and junctions. Users can
manually select the desired objects, select those highlighted in the workspace, or use the Select Special
tool to select desired groups or other sets of objects.

Related Topics
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Accessing Scenario Comparison Tool
Scenario Comparison Grid
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Scenario Comparison Grid
Choosing the Compare Selected Scenarios menu item from the right-click or Tools menu will bring the
user directly to the Scenario Comparison Grid based on any selected Workspace objects and scenarios.
The settings for the scenario comparison can be seen/modified by clicking Modify Comparison at the bottom of the window.
The tabular data from the report can be copied to and pasted to a separate file or worksheet using the
Copy button at the bottom of the window.
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Figure 1: Default Scenario Comparison Grid view

Filtering Options
When a large comparison is run, typically many of the objects/parameters in the model will be unchanged
across scenarios, which may result in a large number of items with no differences. To help condense the
Scenario Comparison Grid, several toggles are available at the top of the Item and Parameter columns
which allow the user to show/hide rows. Switching the toggle to All will show all items or parameters
being compared. If the toggle is set to differences, then only Items/Parameters that have a different value
in at least one scenario will be shown. Thus, if both toggles are set to All, then all parameters will be displayed for all items. If both toggles are set to Differences, then only items that have parameters with different values will be shown, and only the parameters that differ will be displayed.

Color Coding
The cells in the Item and Parameter columns will be colored either yellow or green to indicate whether
that item/parameter has differences between the scenarios being compared. Yellow indicates differences, while green indicates that no differences exist. Parameters will be colored yellow if the value of
that parameter is different in at least one scenario that is being compared. Items will be colored yellow if
at least one parameter that is being compared for that item has a different value in one or more scenarios.
The Highlight Unique Values toggle is used to color the values to visually link identical values. All values
under the currently active scenario will remain grey, while values that have differences will be colored
This is powerful to quickly see differences when more than two scenarios are being compared. If two
scenarios have the same value for a parameter, the values will have the same shading. See Figure 2
below for an example.
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Figure 2: Scenario comparison showing differences only. Each unique value is highlighted with a different
color to indicate which scenarios have differences from the currently active scenario, which is the 3.5 inch
scenario for this example.
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AFT Arrow has the powerful ability to account for both recurring and non-recurring costs in your model.
The most common and easiest to account for recurring cost is Energy Cost. It is often desirable to reduce
the electricity usage of compressors in a system, and AFT Arrow makes measuring this value easy.
In addition to energy usage, AFT Arrow can track other user-defined costs such as maintenance, installation and material cost with a Cost Library.

Cost Calculation Procedure
Depending on what types of costs or what components of a model you wish to include this process may
change.
Note: This process only applies if the ANS module is not enabled. To set up cost calculations with
ANS, see the Assign Cost Libraries topic.
1.

Enable Cost Calculation from the Cost Settings panel in Analysis Setup.

2.

Specify system life and energy cost in Cost Settings.

3.

Junctions or pipes you wish to include in the cost calculation must be added to the Cost Report
with the Cost tab in the object's properties window.

4.

If you are calculating all costs (not just Energy), you will need to create Cost Libraries. To represent more complex Energy Cost, such as varying cost over time, you will need to create an
Energy Cost Library.

5.

Within the Cost Libraries, specific recurring or non-recurring costs will need be defined.

6.

These costs can be further refined to adjust automatically based on diameter, time, power, or Cv
with Scale Tables.

7.

Review the application of costs with the Cost Application Manager and the Cost Summary Window. It is important that the costs are being applied as desired.

8.

Run the model and view the cost totals with the Cost Report.

Related Topics
Cost Settings Group
Cost Settings Panel
Cost Application Manager
Scale Tables
Select Size From
Cost Definitions
Cost Libraries
Cost Summary Window
Cost Report
Custom Monetary Units
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Related Examples
Compressed Air System - Cost
Process Steam System - Cost

794
803

Enabling Cost Calculation
Note: This process only applies if the ANS module is not enabled. To set up cost calculations with
ANS, see the Assign Cost Libraries topic.
Enable Cost Calculations from the Cost Settings panel in Analysis Setup. The following options are available:
l

Do Not Calculate - Selected by default.

l

Compressor/Fan Energy Only - Only calculate the costs associated with the power consumption of compressors. The energy cost and system life must be entered in the Cost Settings
panel.

l

Calculate - Enable full calculation of costs. In addition to defining Cost Settings, Cost Libraries
must be defined to use this feature.

Including Objects in Cost Report
Workspace objects must be included in the Cost Report to have their cost calculated. This allows only
analyzing the cost of certain parts of the model - useful if only one compressor is being replaced, or if an
expansion to an existing system is being considered. To include the objects in the Cost Report simply
select Include Cost in Report on the object's Cost tab, as shown in Figure 2. Finer detail in how the Cost
is included can be set by clicking the Cost Application button.
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Figure 1: Include Cost in Report

Related Examples
Compressed Air System - Cost

794

Energy Cost Library
Allows users to input time varying energy costs. These energy costs can then be assigned to compressor/fans, so that compressor/fan operation/energy costs can be calculated.

Creating an Energy Cost Library
When opening the Energy Cost Library window from the Library menu, you will be greeted with Figure 1.
An Energy Cost Library either needs to be created or opened.
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Figure 1: Energy Cost Library Window

To create a new Energy Cost Library, click the New button. Give the Library a Description and, optionally,
write some notes for it. Select an alternate Monetary Unit if desired.

Figure 2: New Energy Cost Library
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Finally, save the library by clicking Save As. A prompt will appear asking for a name for the *.ecd file. AFT
Arrow will also prompt if the library should be connected and available - typically this is desired so the library can be used in the currently open model.

Defining Energy Costs
Now that an Energy Cost Library exists, some costs should be added to it. Select the Energy Costs tab.

Figure 3: Energy Costs

Select New Cost to add costs to the library. In Figure 3, costs have been added to represent a varying
electricity cost over night and day. If the Cost Time Period exceeds the time defined in the Energy Cost
Library, the pattern will start over at zero. That is, for the above example if the Cost Time Period was one
year the defined 24 hour cost cycle would repeat 365 times.
The Cost Scaling column allows a Scale Table to be applied to a cost, as discussed below.

Scale Tables
You can add a time-based multiplier to an Energy Cost Library on top of the normal Energy Costs if
desired. The Scale Table can be used, for example, to represent the increasing cost of electricity year by
year. See Scale Tables.
For energy cost libraries, the Scale Tables are limited to entering a multiplier over time.
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Library Connection
Creating a new Energy Cost Library will prompt connecting it automatically. If for whatever reason an
existing Library is not connected in can be manually connected with the Library Manager.

Cost Application Manager
Note: This topic does not apply for the ANS module. To set up cost calculations with ANS, see the
Assign Cost Libraries topic.
This Cost Application Manager, accessed from an object's Cost tab, allows the user to do the following:
l

Choose which cost libraries will be applied to each pipe and junction
l

Note that if multiple libraries are applied, costs from ALL of the selected libraries will be
included.

l

Choose when each pipe’s or junction’s life will start and/or end

l

Specify fractional cost multipliers to be applied (for cases such as compressor energy when the
compressor operates only part of the time)

The Cost Application Manager can also be accessed from the Tools menu - in which case it will show
data for all Workspace objects.

Figure 1: Cost Application Manager
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How Duplicate Costs are Handled
To maximize flexibility for the user, multiple cost libraries can be connected to the same engineering library. What happens if there is cost data for the same engineering item in each library? For example,
assume an engineering library, compressor.dat, exists with a specific compressor "Model 100A".
Two cost libraries exist based on compressor.dat:
l

maxcost.cst ("Model 100A" installation cost = $1000)

l

bestcost.cst ("Model 100A" installation cost = $750)

If both of these libraries are connected, and All Connected Libraries are applied to the compressor, AFT
Arrow will interpret the cost for "Model 100A" as the sum of the two: $1750.
There will be occasions you want cost items to be summed, and other cases where you do not. Obviously, if you have two libraries, one that tracks the maximum cost and the other that tracks the "best" cost
of an item, you want to use only one cost at a time and not have the costs summed. This can be accomplished with the Cost Application Manager, by selecting only the desired library to apply.
However, perhaps the two acquisition costs do not represent the same item, but rather represent partial
costs of that item that you want to maintain separately. When managed in this way, you want the costs to
be summed.

Related Topics
Cost Calculation
Scale Tables
Select Size From
Cost Definitions
Cost Libraries
Cost Summary Window
Cost Report
Custom Monetary Units
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Scale Tables
l

Scale tables have a type (time or size) and a format (multiplier or cost). "Size" can refer to diameter, power, or Cv.

l

Diameters can be quickly found and entered using the Select Size From button.

l

The type of scale table defines the parameter that controls the variation in cost. For example,
increasing diameter would generally cause an increase in cost, or energy prices may be projected
to increase or decrease with time.

l

Time type tables only accept the multiplier format.

l

All scale tables require both a cost and a multiplier to determine the final cost value. Multiplier
format tables require a base cost in the cost definition, cost format tables require a base multiplier.
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l

One scale table can be applied to multiple cost items - pipe materials, junctions, or fittings &
losses.

Figure 1: Scale table example of a table of costs (Diameter inches vs U.S. Dollars)

Energy Cost Libraries
Changes in Energy Cost over time can be captured with a scale table. Only time type scale tables can be
applied to an Energy Cost Library.

Cost Libraries
Scale tables are applied in the cost definition area of the Cost Library window. Pipe Materials only accept
time scaling tables for recurring cost (shown in Figure 2)

Figure 2: Time Scaling table applied to recurring cost
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Fittings & losses and junction non-recurring costs can accept size scaling tables. Only one table can be
applied to one cost. The selection of a table of multipliers will require a base cost, and the selection of a
table of costs requires a base multiplier (default of 1). This is demonstrated below.

Figure 3: Applying size tables to fittings & losses

Recurring costs can include both a size scaling table and a time scaling table. This would allow you to
specify one base cost and use scale tables to represent both a range of sizes and an increasing cost over
time, for example. Specifying both types of tables would be useful for a sizing calculation with the ANS
module, where cost is being minimized by varying the size.

Related Topics
Cost Calculation
Cost Application Manager
Select Size From
Cost Definitions
Cost Libraries
Cost Summary Window
Cost Report
Custom Monetary Units
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Related Examples
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Air Distribution, Creating Libraries - ANS
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Select Size From
The Select Size From button opens the Nominal Diameter window, which allows you to quickly obtain the
inner diameter for a nominal size and schedule. The Diameter window is called from the Scale Tables
window.
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Figure 1: Nominal Diameter selection

Selecting a size and clicking OK enters the Inner Diameter into the currently selected Scale Table row.

Related Topics
Cost Calculation
Cost Application Manager
Scale Tables
Cost Definitions
Cost Libraries
Cost Summary Window
Cost Report
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Cost Definitions
Depending on the contents of the associated Engineering Library there are tabs for Pipe Materials, Junctions, and Pipe Fittings & Losses. Each of these tabs serves the same purpose in slightly different ways allowing the definition of costs for a certain component.
First, select a component of a certain type or size in the upper-left of the window. Then, click on the New
Cost button. A new cost item is created in the table below as a new column. Some cells are displayed in
black, which means that are not relevant to the type of entry selected.
Costs can be:
l

Material (NR)

l

Installation (NR)

l

Maintenance (R)

- 437 -

Cost Calculation

where the (NR) and (R) indicate Non-Recurring and Recurring. Non-Recurring Costs are calculated as a
sum total for the model, whereas Recurring costs require a time period and a total system life, as defined
in the Cost Settings panel of Analysis Setup.
These costs are on either a per-item, per-length, or time basis. The costs can further be adjusted with
Scale Tables.

Pipe Materials Costs

Figure 1: Cost Definitions for a Pipe Material

The Pipe Materials tab shows all the pipes in the engineering cost library. Costs can be entered at several levels. You can enter costs at the material level, the nominal size level, and finally at the type (e.g.
schedule) level. Costs entered at the material apply to all pipes nominal sizes and types in that material
type. Costs entered at the nominal size level apply to all schedules within that nominal size. Costs
entered at the type level apply only to that type.
To make this process easier, values can be imported or exported to excel. The easiest way to import cost
data from Excel is to first export the desired pipe Sizes and Types. Only the currently selected Sizes and
Types will be exported (if the Pipe Material is selected, all will be exported) with any currently defined
cost information included.
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Figure 2: Excel Sheet for Importing Cost Definitions

The empty columns for cost per unit length can be filled in where cost data is required - it is not necessary
to supply data for every cost, or for every Size/Type. After saving this sheet, the data can be imported directly with "Import from Excel."
Recurring costs for Pipe Materials can be modified with a Time Scaling Table.

Junctions Costs
Costs can be entered for all junction types.

Figure 3: Cost Definitions for a Bend

Above is an example of entering cost data for a bend junction. Junction costs can also be entered at a
higher level. For example, you can apply a cost to all Smooth Flanged Elbows.
Junction costs can be scaled with a Table of Multipliers, Table of Costs, or a Time Scaling Table.
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The behavior of certain junctions varies slightly:
l

Compressors/Fans - Cost can be entered per item (compressor) or per Power. This will allow an
approximate scaling for the size of the compressor on a more reasonable basis than diameter.

l

Control Valves - Costs can be entered per item or diameter. With a Scale Table, costs can be
scaled based on Cv.

l

Other Junctions - Costs can be entered per item or diameter. Scaling tables can also be used on
a diameter basis.

Pipe Fittings & Losses Costs
Cost specification functions the same as non-compressor junctions, with the exception that fitting & loss
costs can be associated with a particular pipe material and size. Since the pipe fitting & loss engineering
library is included only in the AFT Arrow internal library, cost data for pipe fittings & losses can only be
entered when the cost library is associated with the internal engineering library – unless you add your
own custom fittings & losses to an engineering library. Then cost libraries can be associated with that library as well.

Related Topics
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Cost Application Manager
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Cost Report
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Cost Libraries
AFT Arrow can track user-defined costs such as maintenance, installation and material cost with a Cost
Library.
Note that AFT Arrow is not designed as a cost estimator. Instead, user-defined cost data can be used to
compare different designs to determine which one has a lower cost. Like all parts of the model, the results of a cost calculation depend on how the costs have been defined by the user.
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Relationship to Engineering Libraries
AFT Arrow uses Engineering Libraries to create collections of standardized components.
Cost Libraries must be created based on an engineering library to provide user-defined cost values for
components in the engineering library. There can be multiple cost libraries for each engineering library.
This allows cost data sets to be maintained separately from the engineering data. This can be useful for
maintaining costs in different currencies or differences based on geographical location or times of the
year.

Figure 1: Relationship between Cost and Engineering Libraries

Like Engineering Libraries, Cost Libraries must be connected to be used. See Library Browser for information on how to connect libraries. Newly created cost libraries are connected automatically.

Edit Cost Library Window
The Edit Cost Library window is opened from the Library menu. This window allows you to create a cost
library for items that are in a specific engineering library. Costs can be entered for pipes, junctions, and
pipe fittings & losses.
On the General tab, a cost library can be created with the New button, or an existing library can be
accessed with one of the Open buttons.
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Figure 2: General tab of Cost Library Window

Clicking New brings up the following window:
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Figure 3: Select Library Window

All Cost Libraries need to be associated with an Engineering Library. After selecting a library, the Edit
Cost Library Window will change to allow you to enter information into the newly created Cost Library.
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Figure 4: Cost Library Window - New Library

A Description is required for all Cost Libraries, which is displayed as the library's name in the Library Manager. Multipliers can be set for all items in the cost library using the Multipliers on Cost Items table. Notes
are optional.

Cost Definitions
Depending on the contents of the associated Engineering Library there are tabs for Pipe Materials, Junctions, and Pipe Fittings & Losses. Each of these tabs serves the same purpose in slightly different ways allowing the definition of costs for a certain component. See Cost Definitions for a detailed explanation.

Summary
The summary tab allows for an easy way to quickly review what has been defined in a cost library. This is
different than the Cost Summary Window, as this summary is a listing of all items defined as costs,
whereas the Cost Summary Window lists objects in the model with costs applied to them.
The costs are grouped by type, and only defined costs are shown. An example of defined costs on a Pipe
Materials library is shown below.
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Figure 5: Cost Summary
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Cost Summary Window
Note: This topic does not apply for the ANS module. To set up cost calculations with ANS, see the
Assign Cost Libraries topic.
The Cost Summary window, opened from the Tools menu shows all connected cost libraries and energy
cost libraries, and which pipes and/or junctions are obtaining costs from each library.
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Figure 1: Cost Summary Window

Related Topics
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Custom Monetary Units
New Monetary Units can be added with the following steps:
1.

Open User Options from the Tools menu

2.

Under Unit Systems, select Show/Hide Unit Items

3.

In the Unit Family Type list box, select Monetary Units

4.

The Custom Units button will appear on the right, select New

5.

Enter the name, description and conversion to U.S. Dollar in the appropriate fields.

6.

Click OK
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The new Monetary units can be specified as your default units and used in Cost Libraries. If you do have
a mixture of cost libraries with different Monetary Units, the conversion factors to U.S. Dollars will need to
be updated before the cost is calculated.

Figure 1: Custom Unit Edit Window
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Cost Report
The Cost Report is a detailed list of all costs for the system displayed on the Cost Report tab in the General section of the Output window. The content of the Cost Report can be customized in the Output Control window on the Display Parameters tab and the Format & Actions tab.
The grand total cost is shown on the top line, with subtotals for each category on the second line. In the
main table area costs for each pipe, junction, and pipe fitting & loss included in the cost calculation are
shown.
Output Control Format & Action allows you to hide items that have zero cost, group costs by pipe, or
show only the subtotals for each category.
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Figure 1: The Cost Report is displayed in the General section of the Output window

Using the Library Sources Tables
AFT Arrow displays the source of all cost data in a run, and you are strongly encouraged to review this
data to verify that the solution was based on the appropriate cost data.
In the Output window, the sources of all cost data are displayed for each pipe and junction in the Library
Sources table. Figure 2 shows the Library Sources for an example case.

Figure 2: Library Sources table for pipes
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Related Topics
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Libraries
One of the more powerful features of AFT Arrow is that it provides extensive customization capabilities.
AFT Arrow provides the tools to build custom libraries for fluid properties, pipe materials, and all junction
types except Dead End and Tee/Wye junctions. AFT Arrow incorporates these libraries internally and
offers them to you through list boxes.
There are three categories of libraries: Local User, External, and AFT Internal.
The Local User Library is located in the ARO_USER9.DAT file in the local user directory, and stores
user-specified data for most component types for local use. It cannot be transferred to other users.
The AFT Internal Library is located in the Arrow9.DAT file in the local user directory and stores AFTprovided libraries, as well as user-specified fittings & losses. It cannot be transferred to other users.
External libraries are created by the user and can contain data for any of the library types. In AFT Arrow
you can create multiple network or local custom libraries using the Library Manager on the Library menu.
External libraries can be shared to multiple users from a network location as is discussed in Creating an
Enterprise-wide Network Library System.

Related Topics
Library Manager
Library Browser
Network Library Overview
Library Verification
Library Locations in General Preferences
Pipe Material Library References
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Related Examples
Air Distribution, Creating Libraries - ANS
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Related Blogs
Databases 101 - Get to Know Them
Databases 201 - Name That Fluids
Databases 301 - Those Are Some Nice Pipes!
Databases 401 - Managing Databases

Library Manager
Accessed from the Library Menu, the Library Manager is a new feature to AFT Arrow 8 and replaces the
Database features used in previous versions. The Library Manager allows you to:
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l

Connect to and disconnect from libraries

l

Create and delete libraries

l

Add content to libraries

l

Review the content of libraries

l

Move contents between libraries

Related Topics
Library Browser
Fluid Library
Pipe Material Library
Junction Library
Insulation Library
Fittings & Losses Library
Libraries
Network Library Overview
Library Verification
Library Locations in General Preferences
Pipe Material Library References
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Related Examples
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Process Steam System - Cost
Air Distribution, Creating Libraries - ANS
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Related Blogs
Databases 101 - Get to Know Them
Databases 201 - Name That Fluids
Databases 301 - Those Are Some Nice Pipes!
Databases 401 - Managing Databases

Library Browser
The first panel of the Library Manager is the Library Browser. Use the Library Browser to create a new library, add an existing library, view contents of an added library, and connect or disconnect libraries to the
model.
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Types of Libraries
There are three types of external libraries in AFT Arrow:
l

Engineering Library - Contain all component types except cost information

l

Energy Cost Library - Contains energy cost data associated with components in existing engineering libraries

l

Cost Library - Contains material, installation, and/or maintenance cost data associated with components in existing engineering libraries

All library types can be reviewed, added to the model, and connected to the model from the Library
Browser. For engineering-type libraries additional actions are available to edit libraries.

Adding and Removing Existing Libraries
To work with a library you must first make it available to AFT Arrow. Referring to Figure 1, clicking on the
Add Existing Library or Add Existing Cost Library button will open a standard file dialog box with which
you may browse to and select a library. A library may be removed from the list of available libraries by
right-clicking on the library and selecting Remove Library from List. A summary of the library contents
can be seen in the section on the right when a library, library section, or component is selected in the list
of available libraries.
The AFT DEFAULT INTERNAL LIBRARY and the AFT ARROW LOCAL USER LIBRARY may not be
removed and will always appear in the list of available libraries. External shared libraries will also always
appear in the available library list.

Figure 1: Library Browser in the Library Manager
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Connecting and Disconnecting Libraries
In order to use the components from a library in the model the library must be connected. A library is connected to the model when it is shown with a check mark in the Library Browser. All libraries are automatically connected when they are first added to the Library Manager.
Sections or components in a library can also be connected/disconnected on an individual basis if the library as a whole is connected.
It may be desired to disconnect a library if you do not want the components from that library to be available for use in the current model, but you do want the library to be available for use in other models.
Clicking on Set As Default will establish the list of connected libraries as the default list, while clicking on
User Default will set the connections to the default list.
AFT Internal Pipe Material libraries can be connected or disconnected as a group from the Other Actions
button under the available libraries list.

Editing Library Contents
Existing content can be moved to/from, copied to/from, or deleted from available libraries in the Library
Browser.
To edit an item right-click on the item in the Library Browser, then click the desired action from the rightclick menu. Note that moving, copying, and deleting can be done to a library as a whole, or can be done
for just a section or single component in a library. Individuals components can also be edited by choosing
Edit Component, which will take you directly to the Edit section for the component type.
Note: Editing Cost libraries must be done separately in the Cost Library or Energy Cost Library windows, accessed from the Library Menu.
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Figure 2: Library contents can be transferred or deleted from the right-click menu

Creating External Libraries
By default library items are stored in the AFT Default Internal Library or Local User Library, both of which
cannot be shared with other users. Library items can be moved or copied to an external library which can
be shared with multiple users.
To create an external library click the Create New Library button underneath the available libraries list.
You will be prompted to provide a name for the file, and a library description (Figure 3). The provided
description will be displayed as the library's name in the Library Manager.
To add content to an external library copy or move content from an existing library as described in the
Editing Library Contents section. Junction components can also be directly added to external libraries as
is described in the Junction Libraries topic.
For more details on creating and sharing external libraries see Creating an Enterprise-wide Network
Library.

Figure 3: After specifying a library file name, you will be prompted for a description which will then appear in
the Library Manager when this library is selected

Related Topics
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Junction Library
Adding Custom Junction Data to the Component Library
To simplify modeling and eliminate repetitive data entry, AFT Arrow allows you to save frequently-used
junction data to a custom library. Once saved, the custom equipment data can be selected from the
Library List in the Properties Window at any later time for immediate recall of the data. Using this tool, you
can easily build your own library of pumps, valves, or other components supplied by specific manufacturers.
To save a custom junction to the library - open the junction Properties Window and enter all required
data. Close the window and choose Add Component to Library from the Library menu. You will be prompted to enter a name for the custom junction. Enter a descriptive name then click OK. If you open the junction again, the custom name will be selected in the Library List.
AFT Arrow accepts custom data for all junction types except Dead End and Tee/Wye junctions.

- 455 -

Libraries

Editing the Component Library
You can delete or rename any existing library component in the Edit Junctions panel of the Library Manager, accessed from the Library menu. To edit an existing library entry, select the item in the list and click
the Edit Data button. This opens the data into a Properties Window where the data can be modified.

Related Topics
Library Manager
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Fluid Library
Pipe Material Library
Insulation Library
Fittings & Losses Library
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Related Examples
Air Distribution, Creating Libraries - ANS

873

Related Blogs
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Databases 401 - Managing Databases

Fluid Library
All non-Chempak and NIST REFPROP fluids used in an AFT Arrow model must be part of the Fluid
Library. You can enter the fluid properties in the Fluid Library using the Edit Fluids panel in the Library
Manager.
You can open the Edit Fluids panel from the Library menu or from the Edit Fluid list button in the Fluid
panel in Analysis Setup. The Edit Fluids panel allows you to review currently defined AFT Standard and
custom fluids, to change the data for custom fluids, and to enter new fluids. All AFT Standard fluid properties are assumed to be a function of temperature.
Once you have entered a custom fluid, it will appear in the Fluids Available in Library list of the Fluid
panel when AFT Standard is selected.
You can add new fluids in the Library Manager Edit Fluids panel by clicking the Add New Fluid button. A
number of fluid properties are required for a compressible flow analysis. There are also several optional
properties. The required properties are dynamic viscosity, specific heat at constant pressure, enthalpy,
and molecular weight. Other entries for critical property data are used for some of the equation of state
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and enthalpy models. A constant compressibility factor can be assigned. The thermal conductivity is
optional if pipe heat transfer is being modeled as adiabatic or isothermal.
Except for the constants and enthalpy, all properties are assumed to be functions of temperature only.
The assumption can break down in systems with very large temperature changes, and should be
checked by the user. These properties are modeled with fourth order polynomials, and features for creating curve fits from raw data are provided.
The enthalpy is a strong function of temperature but a weaker function of pressure. Frequently the pressure dependence of enthalpy can be ignored. The three enthalpy models offered by AFT Arrow allow you
to choose different ways of handling the pressure dependence.
The Add New Fluid/Change Fluid Data windows offer cross-plotting of your custom curves against the
curve fit data points. You can also import data from text files into these windows.

Related Topics
Library Manager
Library Browser
Pipe Material Library
Junction Library
Insulation Library
Fittings & Losses Library
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Related Blogs
Databases 101 - Get to Know Them
Databases 201 - Name That Fluids
Databases 301 - Those Are Some Nice Pipes!
Databases 401 - Managing Databases

Pipe Material Library
Adding Custom Pipe Materials to the Pipe Materials Library
You can open the Edit Pipe Materials panel from the Library Menu. Using this panel, you can easily add
to the user library the geometric information for any pipe material in the length units of your choice. Custom pipe materials can be selected for use in the Pipe Properties Window, minimizing the data entry
required by the user.
Pipe materials typically have a range of nominal sizes and a specific type, class, or schedule that
describes the actual dimension. AFT Arrow works with the inner diameter of the pipe, since that is the
parameter that directly affects the fluid mechanics.
To add custom pipe materials to the user library, choose the entry location you desire in the list on
the left (Pipe Materials, Sizes and Types), then click the New button below. For example, to add an
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entirely new material, click the Pipe Materials item at the top of the list then click the New Material button.
To add a new size for an existing material (say Steel), click Steel in the list then click the New Size button.
To add a new type to the Steel 1 inch size, click 1 inch under the Steel material in the list then click the
New Type button.
When adding a new material, you also will be asked to specify a geometry, enter a nominal size, type of
material, diameter, friction data set, and friction value to define the first data. Optionally you can add in a
wall thickness. From then on you can enter additional nominal sizes and types. The name descriptors
you choose for the material, size, and type are at your discretion. They can contain text mixed with relevant numbers if you desire.
You can also add multiple Friction Data Sets for each pipe material. This allows you to keep, for example,
different friction values that may apply to the same pipe under different conditions. These conditions
could be related to the age of the pipe or the type of fluid being carried. See the Friction Data Sets section
below for more information.
In addition to manual entry of the custom pipe materials, you also can import pipe material data from a
file. When you click the Import From File button, a dialog box will appear explaining the necessary import
file format. By choosing to import from a file, you will be able to have a separate copy of the data for later
access.

Friction Data Sets
Friction Data Sets are pipe friction values for a particular pipe condition.
To create a new Friction Data Set select a Pipe Material, Size, or Schedule to associate the data set with,
then click New Data Set from the Friction Data Set tab on the right (Figure 1). Modify the Friction Data Set
description to provide a name, then enter the Friction Model and Value.
A Friction Data Set can be associated with the entire pipe material, or with specific sizes or types. For
instance, a friction data set associated with Steel (i.e., the top level) might be called "25 year usage" and
have a roughness value of 0.005 inches. This data set is then available to all sizes and types of steel.
However, if "25 year usage" is associated only with the 1 inch of Steel, it will apply only to the pipe schedules that are 1 inch.
You can also associate friction data sets with a specific type (i.e., schedule). For instance, you can make
a "25 year usage" and associate it only with 1 inch schedule 40 Steel pipe and assign its roughness value
as 0.006 inches. Then all Steel pipe would use 0.005 inches for "25 year usage" friction while the different value for 1 inch schedule 40 of 0.006 inches would supersede the value of 0.005 inches associated with all Steel pipe.
Finally, among multiple friction data sets you can specify a default data set.
Multiple friction data sets can be created for each type of pipe material. For example, there may be separate friction data sets for Steel pipe such as: New Pipe, 10 Year Use, 20 Year Use and 30 Year Use.
Typically, the older pipes will have higher friction.
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Figure 1: Friction Data Set tab on the Edit Pipe Materials panel

Insulation Data Sets
Insulation data sets are similar to friction data sets. An insulation data set can be associated with the
entire pipe material, or with specific sizes or types. Insulation data sets are based on insulation data that
has been specified in the Insulation Library. An insulation type must be defined first in the Insulation
Library before it can be used for an Insulation Data Set.
To create an insulation data set select the pipe material, schedule, or type that will be associated with the
data set in the list on the left, then click the Insulation Data Set tab on the right and select the New Data
Set button. Modify the Insulation Data Set description to provide a name, then choose an Insulation
Library from the drop-down and define an Insulation thickness value. Once an insulation Data Set is
defined it can be selected for use in the Pipe Properties window Heat Transfer tab.
As an example, an insulation data set associated with Steel (i.e., the top level) might be based on insulation data in the Insulation Library called "Denver Heating Company K-Series". You might assign it a
thickness of 1 inch and name it "Colorado Standard". Once entered, all steel pipe sizes would have a Colorado Standard insulation data set based on Denver Heating Company K-Series insulation that is one
inch thick.
In practice, different thickness would likely be associated with different pipe sizes. To accomplish this,
you could create insulation data sets for pipe one inch or less, call them "Colorado Standard", and make
them ¼ inch thick. Pipes 1-4 inches could also have "Colorado Standard" sets, but would use ½ inch insulation, and pipes larger than 4 inch could have "Colorado Standard" and be specified as 1 inch thick.
Then in the Pipe Properties Window you can choose "Colorado Standard" insulation, and the appropriate
thickness for the size you have chosen would be used.
Finally, among multiple insulation data sets you can specify a default data set.
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Pipe Thermophysical Properties
The Edit Pipe Materials panel allows you to define thermophysical properties for the pipe. The density of
the pipe can be entered as a constant, and the thermal conductivity as a function of temperature. The
thermal conductivity is used in heat transfer calculations for pipes.
To add thermophysical properties select a Pipe Material to associate the data set with, then click Specify
Properties from the Pipe Thermophysical Properties tab on the right. The Pipe Physical Properties window will be shown where the thermal conductivity data can be entered on the Pipe Material Property
Data tab, and the density can be entered on the Density Data tab. A density calculator is provided to calculate the density using the pipe weight and dimensions.
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Insulation Library
Fittings & Losses Library
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Insulation Library
The Edit Insulations panel is accessed from the Library menu. This panel allows you to view the insulation data provided with AFT Arrow, or to add, edit or delete user defined insulation materials. Insulation
library items are used for heat transfer calculations in pipes.
To add a new insulation material click Add New Insulation, then enter the data in the Insulation Physical
Properties window. The insulation thermal conductivity is entered as a function of temperature, and density as a constant.
Insulation data can be applied directly to pipes, and can also be associated with the Pipe Material Library
as insulation data sets.

Related Topics
Library Manager

450
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Fittings & Losses Library
The Edit Fittings & Losses panel can be accessed from the Library Menu and allows the user to review
the Fittings & Losses data provided by default in Arrow, and to add, edit or delete user defined Fitting &
Losses in the AFT Default Internal Library.
Fittings & Losses can either be added by using the entry form in the window, or by importing a text file as
described below. To enter a new Fitting/Loss item in the Edit Fittings & Losses panel click Create New
Loss Item. Define the applicable category, type, geometry and loss model information then click Accept.
The user-defined item will appear in the Fittings & Losses on the left under the relevant category/type
with the source shown in parentheses as "U".
Custom fittings & losses are saved to the local user library. From there the user can move them to other
libraries (see Library Browser).

Import From File
Fittings & Losses can be imported from a *.CSV type file, which can be created from any spreadsheettype software, such as Excel.
The entries in the file should be in the order as shown in Figure 1, but with no headers in the workbook. If
a header row or a blank row is used, Arrow will present a warning, but give the user the option to still
import the valid rows.

Figure 1: Example of import file setup for a custom elbow/bend. Headers should not be present in the file to
import.

Valid options for each of the columns are listed below, with detailed options given in Table 1.
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l

Category - Must match one of the values from Table 1. "Other" may be used if none of the specific
fitting/loss categories fit.

l

Type - This field is required, any name/value may be entered. Types already existing in the library
are shown in Table 1, and may be used if desired.

l

Sub Type - This field is optional. A sub-type may be chosen from Table 1, or any other name/value may be entered.

l

Geometry - This field is optional. A geometry type from Table 1 must be used if a geometry is
entered. If the Geometry field is left blank, the Geometry Value will be ignored.

l

Geometry Value - This field is only required if a Geometry type has been entered. Any positive
numerical value may be entered.

l

Loss Model - This field is required. The Loss Model must be either "K (constant)" or "K / fT
(Crane)".

l

Loss Value - This field is required. Any positive numerical value may be entered for the loss
value.

l

Reference/Notes - This field is optional. Any information may be entered here as needed.
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Table 1: Valid Entries for each field. The Geometry Value and Loss Value fields will accept any numerical
entry. The Reference/Notes field will accept any entry.

Category

Type

Sub Type

Standard
Threaded

General

Mitre

General

Smooth
Flanged

r/D=1

Geometry

Loss Model

r/D=1.5
r/D=2
r/D=3
r/D=4

Elbow/Bend

Angle
(degrees)
K (constant)

r/D=6

Pipe Size (nominal)

r/D=8

None

k / fT (Crane)

r/D=10
r/D=12
r/D=14
r/D=16
r/D=20

Angle

Type 1
Type 2
Direct flow
General

Ball
Valve

Butterfly

None
Plane disk AR=0.92
Plane disk
t/D=0.1
t/D=0.15
t/D=0.2
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Angle
(degrees)
Open Percentage

K (constant)

L/D

k / fT (Crane)

Pipe Size (nominal)
None
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t/D=0.25
t/D=0.3
t/D=0.35
Type A
Type B
Type C
Cylindrical

General
Rect. Tube

Gate

Wedge/Plug
Wedge
Disk w/o recess
Disk with recess
Disk
Wedge - Full
Open 10 deg.
Wedge - Full
Open 20 deg.
Sluice

Globe

Disk with recess
90 degree wall
45 degree wall
Standard 45
deg. wall

Plug
Poppet

Standard 90
deg. wall
Standard
Y Type
Straight-way

Three-way

W/D=.035
W/D=.07
No Seat Width
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Through flow
Branch flow
Swing

90 deg. seat
45 deg. seat

Lift

90 deg. wall
45 deg. wall

Check Valve
Tilting disc

General

Stop-check

Globe 90 deg.

Angle
(degrees)
None

K (constant)
k / fT (Crane)

Globe 45 deg.
Globe thru flow
Sharp

None

Area Ratio

K (constant)

Long

None

None

k / fT (Crane)

Entrance

Sharp

Orifice

Reentrant
Entrance/Exit

Rounded Flush
Exit

None

Diff Flowmtr

Orifice Plate

R/D
None

Nozzle
Venturi 7 deg.
Venturi 3 deg.
Dall Tube

Other

Honeycomb
cell

L/D=2

L/D=6
L/D=8
L/D=10
L/D=12
Perforated Plate
Screen

Area Ratio

K (constant)

None

k / fT (Crane)

L/D=4

Circular wire
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Silk thread
Round wire or
netting

Tee

Through flow
(dead branch)
Branch flow
(dead run)
150 lb.

Flange

Steel

None

N/A

300 lb.
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Network Library Overview
Custom libraries contain custom data generated by the user, including fluid properties, pipe materials,
and data for junctions types such as compressors and valves.
All custom data created by the user is kept on the local computer in a file called ARO_USER9.DAT in the
local user directory. This data is not shared and is always available to the local user for access or for editing.
In addition to the local user library, you can create multiple network or local custom libraries. The Library
Manager window on the Library menu simplifies this process. See Creating an Enterprise-wide Network
Library System for details on how to do this.

Related Topics
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Library Manager
Library Browser
Library Verification
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Benefits of Shared Libraries
When the Arrow libraries are placed on a network, powerful data management procedures can be implemented. Specific, quality-checked data can be entered into libraries located on a local or wide area network of PC's. This data is not accessible to the end users through AFT Arrow itself, so it is guarded data.
Once the data is placed on a network, users can connect to the library in the Library Browser. Users can
connect to as many libraries as they want.
If the user connects to a library with these files and selects to be connected to any of these control files,
the model will inherit the control formatting specified in the control files. This means that special report layouts, special graphical representations and colors, and other special controls can be decided upon by
the library constructor, and those control features can be loaded into local models by end users. This is
highly useful for creating customized reports for certain customers or project requirements.
By way of example, assume the Output Control content was specified as coming from the "Colorado
Springs Office Library" library.
If you uncheck the Library checkbox or change certain data in the Output Control window, the library will
remain connected but change to an inactive state. When the library is inactive, none of its data transfers
to the model. To bring the Output Control data back into sync with the connected library, recheck the
Library check box in Output Control.
This entire custom library concept lends itself naturally to the idea of specific project libraries. Each project has differing requirements that depend on the nature of the project and the end customer. Data for
each project can be assembled into separate libraries, allowing faster and more accurate transmission of
the controlled data and desired reporting formats to engineers.
Maintaining a network library allows commonly-used data to be controlled, which may be helpful in
instances where quality control is strict.

Related Topics
Network Library Overview
Creating an Enterprise-Wide Network Library System
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Creating an Enterprise-Wide Network Library System
Overview
Users of AFT Arrow on a network can access common libraries to simplify model verification, improve
analysis and reporting consistency, and eliminate redundant work.
To accomplish this there is some initial setup that must be done. First, the data for components, materials, formats, etc., needs to be created and saved to various data files. Secondly, these files must be
made available to the users of AFT Arrow by creating a file named DATABASE.LIB in the ARROW folder.
Thirdly, the users need to connect to the new libraries listed and select the sections to use. Each of these
broad steps is discussed below. To maintain control and integrity of the data, it would be advised that one
person is given the responsibility to create and maintain the network libraries. The discussion below will
be given from the viewpoint of this person.
Table 1 shows the relationship between Internal Libraries and External Libraries as well as the library file
listing that AFT Arrow uses to find these libraries. An External Library is any library file that is created by
the user and listed in the ARO_DBUSER.LIB residing in the user’s local user directory. The user can
make these available and unavailable, and connect and disconnect from these libraries using Library
Manager. The library files themselves may be located on any local or mapped drive. These library files
are also distinguished by being under the local user’s complete control. External Shared Libraries, on the
other hand, are common to all AFT Arrow users on the network, therefore the local user cannot remove
them from the list of available libraries. However, the user can choose to connect or disconnect from
these libraries using Library Manager. Finally, to complete the discussion, there are two special libraries,
the Default Internal Library and the Local User Library. These files are AFT Arrow Internal Libraries which
cannot be disconnected or made unavailable.

Table 1: A summary of the types of libraries used for the example below. Note the difference between
External and External Shared libraries is just which *.LIB file their file path is listed in.

Library Groups & Filenames

Library Titles

Library Locations

Arrow Internal Libraries
ARROW9.DAT

AFT Default Internal Library

AFT Arrow 9 folder

ARO_USER9.DAT

AFT Arrow Local User Library

AppData folder

Vail Resort Materials

Network Location, with path listed
in DATABASE.LIB

Vail Resort Materials

Network Location, with path listed
in ARO_DBUSER.LIB

External Shared Libraries
(DATABASE.LIB)
VailMaterials.dat
External Libraries (ARO_
DBUSER.LIB)
VailMaterials.dat
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Creating Library Files
The first thing to do is create the files that contain the information to be shared. These files will be referred
to as library files and can contain information about pipe materials, components (e.g. compressors,
valves, etc.), fluids, etc. The following are several ways to create library files:
l

Use the Create New Library button in the Library Manager, as described previously. Data can be
taken from the current model or other libraries.

l

Copy and paste sections from one file into another file using a text editor.

This discussion will focus on the first and second methods. Let’s assume that the person responsible for
the network library has already created a new pipe material. Also, assume that the goal is to create a network-wide library to contain this material.
The information for the material is copied from the Local User Library (ARO_USER9.DAT) to a new file
using the Library Broswer in the Library Manager. For the source library choose Local User Library and
then select Pipe Materials. Then click Create New Library and enter a file name, VailMaterials.dat, for
this example. Enter a description of the library - this description is how AFT Arrow users will refer to the
library and should concisely describe what is in the library (for this example we’ll use "Vail Resort Materials"). Right-click the pipe materials section from the Local User Library and choose Copy Content to
copy the pipe materials to this new library file. The pipe material library file has now been created and is
ready to be used.

Sharing Library Files Using DATABASE.LIB
Now that the library file for the Pipe Materials has been created, it needs to be made available to the
users of AFT Arrow. Depending on the scope of use, library files can be placed into one of two groups. If
the library is to be used locally by one user, it is put in the External Library group. On the other hand, if the
library is to be common among many users and shared over a network it is put into the External Shared
Library group.
Continuing the above example, the goal is to share the library file, so it will need to be an External Shared
Library listed in the DATABASE.LIB file in the Arrow directory on the network. However, since Arrow
does not write directly to the network files for security reasons, it is easiest to temporarily treat these files
as local External Library files which will be listed in the ARO_DBUSER.LIB file located in the local user
directory of the local machine.
It is recommended that External Shared Library files be copied to the network server and placed in a subfolder of the AFT Arrow folder (e.g. AFT Products\AFT Arrow\Libraries). The files may, however, be located anywhere on the network that is accessible to the users. For our example, we are going to put the
pipe material library on the network in a subfolder called Libraries. It is easier to copy the file to the Libraries folder before they are made available in AFT Arrow. This will help establish the correct paths to the
files as the files are made available using the Library Manager.
Once the library file is in the network location, open the Library Manager in AFT Arrow to the Library
Browser. Each of the new library files we have created needs to be added to the Available Libraries list by
clicking Add Existing Library and browsing to the file. Once you click OK, the description of the library you
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just added appears in the Available Libraries list. Once you have added the new library, click Close and
the External Library listing file (ARO_DBUSER.LIB) in your local user directory is automatically updated.
Now we need to discuss how the paths should be setup. When you add a library, AFT Arrow will write the
full path of the library to the External Library listing (ARO_DBUSER.LIB). That means that if you browsed
to the library file using a mapped drive letter then the path will include that drive letter. However, if other
users try to access the libraries but have the AFT Arrow folder mapped to a different drive letter they will
not be able to locate the library files. Other options include using either relative paths or the computer
name in the path (e.g. \\Network Server\Eng Apps\AFT Products\AFT Arrow\Libraries\filename.dat). You
can automatically have AFT Arrow use the computer name when you add the file by choosing Network
Neighborhood, then the computer and then browse to the library file. If you would rather use relative
paths, you can manually edit them in the library listing file. All library files must be relative to the AFT
Arrow folder where the executable is located.
When the pipe materials library was added it became an External Library listed in ARO_DBUSER.LIB.
Now we need to move this listing from the local machine to the AFT Arrow folder on the network so that
all users can access the library files. Once the listing file is moved to the network, it must be renamed
DATABASE.LIB. Once this is done, all users can now access the library file we have created.

Connecting to the External Shared Libraries
Now that the libraries have been placed on the network and made available to all AFT Arrow users, each
user must now connect to the libraries and make the sections active as needed. When a user opens the
Library Manager, the External Shared Libraries are listed in the Library Browser. Make sure the checkbox is checked to make those libraries connected for use. Also ensure that the sections within the library
are checked for use. A library can be connected without having any sections selected and active. Finally,
to have these connections in place every time you start AFT Arrow, click Set As Default. To apply these
settings to a model made previously, open the model, go to Library Manager, click User Default and, if
you have set the default, the connections and setting will now be applied to the model.

Sharing Model Formats/Preferences
Note that the Database Manager used to provide the option to include formats/preference settings such
as the Output Control or Visual Report Control layouts into shared libraries. These type of files can still be
shared, but are no longer shared through the Library Manager. Instead these type of format files must be
loaded directly through their control windows, such as loading the Output Control format being loaded in
the Output Control window.

Related Topics
Network Library Overview
Benefits of Shared Libraries

466
467
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Library Verification
The Library Verification window is displayed when you open a model or new scenario which contains connected library items that have some inconsistency.

1. Library Item Not Found
You may have a library item that is not found in any currently connected library. For example, a compressor may be connected to a library, and derive its data from that library. However, when the model is
loaded, the source library is not available. This could be for several reasons that will be discussed
shortly.
The compressor in the model does in fact have all of the required data needed to run the model. But
when it is not found in the library, you will be offered several options:
l

Disconnect it from the source library – this means that the model will forget the library the compressor came from and make it a standalone compressor not connected to any library.

l

Add it to a library – this means that the compressor can be added to a custom library

l

Leave the library connection – this means that the compressor will remember what library to which
was originally connected and connect to that library again when it is made available to AFT Arrow.
If, however, you try to open the compressor/fan Properties window, AFT Arrow will disconnect the
compressor from the library and warn you.

The compressor might have lost its library connection for one of these reasons:
l

The library is no longer available because it was removed either through the Library Manager or
because your libraries have been changed on the network.

l

The model is being run on a different PC than where it was created, and the original libraries are
no longer available. This could be, for example, because you have moved the model onto a laptop
computer to take it on travel. Or it could happen because the model was developed by another
company which had developed libraries of its own but which are not available to you.

Whatever choice you make, the model will retain all its engineering data and yield the same results as it
did originally.

2. Item in Model is Different from Library
You may have a library item in the model that is connected to an external library, but for some reason the
data is not the same. For example, you may have a fan curve for the Rocky Mountain Fan Company's
Model 100A in your model, but it does not match the fan curve for this model in your library. Here you
have three choices:
l

Update the items in the model to match the library – this will actually change the model's
input data, and it might yield different results that originally
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l

Update the library (if it is local) to match the model's items – this will change the library, but
will leave the model's input data as it was. It will yield the same results as it did previously.

l

Disconnect it from the source library – this will leave the model as it was, and it will yield the
same results.

The fan in the model might have a different fan curve than the one in the library for one of these reasons:
l

When the model was built, the fan was connected to the Rocky Mountain Fan Company (i.e.,
RMFC) Model 100A. But since that time, the library has changed. Perhaps there was an input
error in the original data, or better data has since become available and the library was updated. If
this were the case, it would be best to update all your fans to the library values.

l

The library may have been changed by an unauthorized individual, and while it was accurate originally, now the data is no longer valid. In this case, it would be best to not update the fan in your
model, and to inquire into the cause of the inaccurate data within your organization.

Related Topics
Libraries
Library Manager
Library Browser
Network Library Overview
Library Locations in General Preferences
Pipe Material Library References

450
450
451
466
472
535

Library Locations in General Preferences
When performing an engineering analysis with or even without cost estimating, there may be many engineering and cost libraries that underlie the model. These libraries need to be connected in the Library Manager in order to be accessible by the model. However, to know what libraries are actually needed, one
needs to first load the model. This creates a dilemma.
To help alleviate the dilemma, users can create "Library Search Locations" in the User Options window.
Figure 1 shows an example. Once specified, you can set these as your default locations by clicking the
Set As Default button. When AFT Arrow tries to open a model that requires certain libraries, and those libraries have not been connected already, AFT Arrow looks for them in the locations specified in the User
Options. In addition, AFT Arrow looks in the model's folder. If AFT Arrow finds the libraries in one of these
locations, it automatically adds it to the list of connected libraries in the Library Manager. If it cannot find a
library, it informs you once the model is loaded.
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Figure 1: Library Search Locations can be defined in the Tools/User Options window
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This section focuses on the fundamental theories that are used in AFT Arrows' solution methodology.
Additionally, this chapter gives information on the source material for the theories used. Topics include
discussions on the theories that comprise the network solution, detailed discussions of compressible flow
theory and its implications, and information on references used in the development of AFT Arrow.

Content
Nomenclature

474

Review of Compressible Flow Theory

477

Compressible Flow Theory in Single Pipes

492

Sonic Choking

500

Role of Pressure Junctions - Detailed Discussion (Long)

510

Chempak Technical Information - Detailed Discussion

521

Stagnation Properties

533

References

534

Pipe Material Library References

535

Nomenclature
a

sonic speed

A

cross-sectional flow area of a pipe

Cd

discharge coefficient

cp

specific heat, constant pressure

cv

specific heat, constant volume

D

diameter of a pipe

e

internal energy

f

friction factor

F

Force

Ff

Parameter in Equation 18
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Fg

Parameter in Equation 18

FTo

Parameter in Equation 18

Fg

Parameter in Equation 18

g

gravitational constant

h

internal convection coefficient

h

enthalpy, static

ho

enthalpy, stagnation

k

thermal conductivity

K

loss factor

L

length of a pipe

ṁ

mass flow rate

M

Mach number

n

constant

Nu

Nusselt number

P

pressure, static

Ph

heater perimeter

Po

pressure, stagnation

Pw

wetted perimeter

Pr

Prandtl number

q

heat rate to a pipe

Q

volumetric flow rate

q''

heat flux

r

radius

r

relaxation

R

gas constant

Re

Reynolds number

s

fan speed

s

entropy

T

temperature, static

To

temperature, stagnation
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U

overall heat transfer coefficient

v

specific volume

V

volume

V

velocity

w

work

x

distance along pipe centerline

z

elevation

Z

compressibility factor

a, m, q

angle

β

diameter ratio

ε

roughness

γ

specific heat ratio

μ

dynamic viscosity

ρ

density

τ

shear stress

ω

rotational velocity

Subscripts
1

location 1 in pipe

2

location 2 in pipe

i

junction at which solution is sought

j

junctions with pipes connecting to junction i

o

stagnation

∞

infinity, far away, ambient
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Review of Compressible Flow Theory
This topic gives an overview of internal compressible flow theory. For a more complete development of
compressible flow theory, please consult one of the many textbooks available [Anderson(1982), Saad
(1993), Shapiro (1953)].

What is Compressible Flow?
Compressible flow is a specialized branch of fluid mechanics that describes the flow of gases. This field
of study is sometimes called gas dynamics.
Compressible flow theory draws heavily from the fields of fluid mechanics and thermodynamics. This
important branch of fluid mechanics has been developed almost completely since the year 1900. Its
development has been largely driven by the extraordinary progress in the applied fields of aerodynamics
and aircraft technology.
The field of compressible flow breaks down naturally into the two related areas of internal and external
flow. Among the important applications of external compressible flow are the design of aircraft and airfoil
design. Among the important applications of internal compressible flow are pipe flow, nozzles and gas turbines. In AFT Arrow, the interest is entirely in internal compressible flow.
The basic feature that distinguishes compressible from incompressible flow is the changing density of the
gas. The density of the gas is related to the temperature and pressure of the gas through an equation of
state. The variable density makes traditional incompressible analysis techniques of limited usefulness,
and in general makes pipe flow analysis much more complicated.
The variable gas density has several important ramifications. First, the velocity of the gas is related to
density through the continuity equation, and thus velocity also becomes a variable even in constant area
pipes. Second, the density dependence on temperature means that the energy equation is coupled to
the equation of state and must be solved simultaneously with the other governing equations. And last,
the velocity of the gas is constrained by the sonic gas speed. Thus, unusual effects like sonic choking
can occur, which further complicates analysis.
It should be noted that not all gas flows see significant compressible flow behavior. In some applications
the gas velocities are low enough or the pressure drops are small enough that compressible effects are
insignificant. In such situations, systems can be modeled with traditional incompressible techniques. AFT
Arrow is capable of modeling any gas flows.

Equation of State
The equation of state relates the density, pressure and temperature of a gas. In principle, knowledge of
any two of these parameters makes it possible to determine the third.
The Ideal Gas equation of state is given by the following
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where is the universal gas constant and
quently combined into a constant Rg

is the molecular weight of the gas. These two terms are fre-

(63)

where Rg is the gas constant for the particular gas. The above equation is known as the ideal gas equation, because it offers an idealized model to relate the pressure, density and temperature of a gas. For
simplicity, the g subscript will be dropped and it is to be understood that R is not the universal constant,
but that for a particular gas.
Experiments have shown that Equation 63 can be applied to a more general selection of gases by introducing the compressibility factor, Z, which compensates for departure from ideal gas behavior.

(64)

There are many methods of determining Z. These methods are found in textbooks and handbooks, each
having strengths and weaknesses.

First Law and Isentropic Relationships
From the First Law of Thermodynamics we know that

(65)

For a reversible process, the work term can be represented by the following

(66)

where v is the gas specific volume (inverse of density). In addition, the incremental addition of heat is
given by

(67)

where s is the entropy. Substituting Equations 66 and 67 into 65 and rearranging yields
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(68)

The enthalpy is related to the internal energy by the following identity

(69)

Differentiating yields

so that Equation 68 becomes

(70)

By using a suitably average specific heat constant, the enthalpy can be related to temperature

(71)

and can be substituted into Equation 70 to obtain

The specific volume is the inverse of density, thus

(72)

To simplify the following concepts, a perfect gas will be assumed and extensions to real gases will be
made without proof. Later applications will describe the effects of real gas behavior in more detail.
For a perfect gas, the third term in Equation 72 can be modified to obtain

(73)
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Integrating Equation 73 results in

(74)

In many applications the local gas flow is isentropic, which causes the left side of Equation 74 to go to
zero yielding

(75)

For an ideal gas it can be shown that

(76)

or rearranging

(77)

where γ is the ratio of specific heats.
For a real gas, Equations 76 and 77 become

(78)

(79)

The ratio of specific heats can also be calculated by

(80)
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The parameter γ is very important in determining the thermodynamics in isentropic processes. When considering a real gas, as the pressure increases Equation 80 takes on a modified form (Bejan, 1988, pp.
178)

(81)

By algebra Equation 75 becomes

(82)

By similar methods it can be shown that

(83)

To summarize, Equations 82 and 83 are isentropic relationships that are valid for real gases if the appropriate value for γ is used.

Sonic Speed and Mach Number
The sonic speed of a gas is the velocity at which disturbances propagate within a gas. Unless a system is
specially designed to produce supersonic flow, the sonic flow speed is the maximum speed at which the
gas can travel.
It can be shown that a sound wave is an isentropic phenomenon involving virtually no energy loss, and
that the speed of sound is given by the following equation (based on mass and momentum conservation)

(84)

where a is the speed of sound and the subscript “s” refers to isentropic conditions. Another more useful
form of Equation 84 is obtained by combining Equations 82 and 83 to relate pressure and density
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(85)

Using Equation 85 in Equation 84 and carrying through the differentiation

or using the ideal gas equation (Equation 63)

(86)

Equation 86 is the classic equation for speed of sound, and since the specific heat ratio varies only
slightly, the speed of sound effectively depends only on temperature.
For real gases, Equation 86 requires using the real gas equation (Equation 64) to obtain

(87)

As an example of sonic velocity, consider air at 70º F (530º R). The specific heat ratio for air is about 1.4,
and assuming ideal gas (Z = 1) then

The relationship between the gas velocity and sonic speed is known as the Mach number.

(88)

The Mach number is a dimensionless quantity that is the most important parameter in compressible fluid
flow. Relating all parameters to the Mach number greatly simplifies compressible flow calculations.
In general, the sonic gas velocity is the maximum that can be attained in a system, thus the largest Mach
number in a pipe system is 1. This is known as sonic flow. Flows less than Mach 1 are referred to as
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subsonic flows. It is in fact possible to attain Mach numbers greater than 1 by using a specially designed
convergent-divergent nozzle. Flows greater than Mach 1 are referred to as supersonic flows. There are
special applications for supersonic flows in internal flow systems, however these applications are not generally of interest to the piping engineer and thus no attempt is made to address supersonic flows in AFT
Arrow. AFT Arrow strictly assumes that Mach 1 is the maximum in the system.

Stagnation Properties in Compressible Flow
In application of Equation 65 to compressible pipe flow, use of the fluid enthalpy simplifies energy balance calculations. The enthalpy is a convenient parameter that combines the internal energy changes
with the work performed by volume changes in the flow. The energy equation is:

(89)

A new parameter called the stagnation enthalpy is introduced which is defined as:

(90)

Introducing Equation 71 into Equation 90 results in

(91)

where To is the stagnation temperature. The stagnation properties are sometimes referred to as "total"
properties. In contrast, the temperature, T is the thermodynamic temperature that we are accustomed to,
and takes on the more descriptive name of static temperature.
Using Equation 79 to replace cp results in

(92)

and using the Mach number, Equation 88, this becomes
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(93)

Equation 93 relates the stagnation and static temperatures through the single flow parameter Mach number and γ, which is frequently constant.
Following from Equation 82 and 83

(94)

(95)

Between pressure, temperature, enthalpy and density, it is easiest to grasp the physical difference
between static and stagnation properties when considering pressure. The classic example is a pitot tube
that is normal to the flow or pointed directly into the flow. Figure 1 depicts the distinction.
The ratio of stagnation to static conditions for pressure and temperature are shown in Figure 2.
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Figure 1: Comparison of static and stagnation pressure measurement at a pitot tube

Figure 2: Variation of stagnation to static temperature ratio and stagnation to static pressure ratio with Mach
number. Gamma = 1.4.
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The stagnation temperature, stagnation enthalpy and stagnation pressure (and to a lesser extent, stagnation density) are of great importance in compressible flow systems. The stagnation property is made
up of the “static” portion (which is the thermodynamic portion) and the “dynamic” portion (due to the fluid
motion). The stagnation property is that property that would exist if the flow was brought to rest. In a fluid
at rest (such as a large tank) the stagnation and static properties are equal.
The stagnation properties take on significance because they combine the effect of fluid velocity. Thus, a
frictionless pipe will have constant stagnation pressures even if the area (and hence velocity) changes.
The stagnation enthalpy will remain constant as long as no heat transfer and no elevation change occurs
(see Equation 89). If the stagnation enthalpy is constant, the stagnation temperature remains constant
insofar as Equation 71 remains valid. Departures from Equation 71 mean that the stagnation temperature can change in an adiabatic pipe, but this change is usually small. For a perfect gas, Equation 71
is always valid and thus stagnation temperature is always constant in adiabatic flow.
The convenience of stagnation properties is that frictional pressure loss and heat transfer calculations
can be performed by using the stagnation property, thus avoiding the need to separately calculate
dynamic (velocity) effects.
Also of importance is the issue of pipe networks. When a branch exists in a compressible flow network, a
change in flow area is almost certain. The change in flow area means a change in velocity, and hence a
change in the static pressure and static temperature. However, the stagnation pressure and temperature
must always match at branching boundaries. The result is that the stagnation pressure and temperature
are the key variables to solve for in a network pipe system.

The Continuity Equation
The continuity equation is the equation that applies the Law of Mass Conservation. For steady flow, the
vector integral form of the continuity equation is given by

(96)

Carrying out the integration of Equation 96 and assuming one-dimensional flow in a pipe results in

(97)

If the pipe is of constant area, Equation 97 can be differentiated to obtain the following

(98)

Equation 98 states that any increase in gas density must be accompanied by a decrease in velocity.
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The Momentum Equation
The momentum equation is an expression of Newton’s Second Law of Motion, which states that the
change in momentum is proportional to the sum of the acting forces, or

(99)

For gas flow in a pipe, the acting forces are the pressure forces and friction forces. Assuming one-dimensional flow in a constant area pipe, the differential form of Equation 99 is

(100)

where τw is the wall shear stress. The wall shear stress can be expressed in terms of a Moody friction
factor, f (one-fourth of the sometimes used Fanning friction factor), and defined as

(101)

Substituting Equation 101 into Equation 100 results in

(102)

Equation 102 relates the change in fluid momentum (the third term) to the pressure forces (first term), friction forces (second term) and body forces (fourth term). The four terms balance to zero.

The Energy Equation
The First Law of Thermodynamics was introduced earlier in Equation 89,
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(89)

or, using the stagnation enthalpy (Equation 90), the energy equation becomes

(103)

In the case of constant elevation, dz is zero and Equation 103 states that any heat transfer in a pipe is
accompanied by a proportional change in stagnation enthalpy. If no heat transfer occurs (adiabatic flow),
the stagnation enthalpy is constant.
For a perfect gas, the enthalpy is related to temperature by Equation 71. In general, enthalpy is a function
of static temperature and pressure

While it is tempting to relate stagnation conditions on a similar basis because of the simplifications that
result, in general only static conditions should be used. Thus

Frictional Effects in Pipes
To clearly understand the effect of friction in a pipe, it is convenient to look at the case of isothermal flow.
The momentum equation, Equation 102, will be used as the starting point. Neglecting gravity effects,

From the continuity equation (98)

Substituting this into the momentum equation
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For ideal gas, isothermal flow,

(104)

Therefore

or using the Mach number

or

(105)

For subsonic flow, the quantity on the right hand side will always be negative. Therefore, dP will always
be negative when there is isothermal flow with friction, which is what one would expect. If dP is negative

then from the equation of state (104)

Therefore, from the continuity equation (98)
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The conclusion therefore is that in isothermal frictional pipe flow, the velocity will always increase along
the pipe. Simply put, the gas will accelerate. It can also be shown that the gas will accelerate if the flow is
adiabatic. This further means that the Mach number will increase along the pipe length, eventually reaching Mach 1 sonic conditions if the pipe is long enough.
Once sonic conditions are reached, no additional acceleration is possible. Thus the flow will experience
sonic choking. When a flow experiences sonic choking, lowering the downstream pressure to increase
the differential pressure will not increase the flow. This phenomenon is frequently encountered in long
gas transfer lines, and is addressed by placing compressors in the pipeline at regular intervals.
It should be noted for completeness that the previous development assumed isothermal flow.
If pipe conditions are such that a gas is cooled along its length, then it is possible to decelerate a compressible flow. The reason decelerating flow can occur when the gas is cooled is seen from the equation
of state. The ideal gas equation, in differential form, is

and eliminating density using the continuity equation

If cooling occurs, then the temperature change is negative, and because the pressure change is also negative, the velocity change can be either negative or positive. Thus, accelerating or decelerating flow is
possible. In most applications, the pressure changes more rapidly than the temperature, making the velocity change positive resulting in accelerating flow.

Isothermal and Adiabatic Flow
Since the majority of gas flow applications operate somewhere between isothermal and adiabatic flow,
these two idealized cases are frequently taken as the extremes to consider. As discussed in the previous
section, this is not strictly true.
The case of adiabatic flow is frequently encountered in short pipelines or in cases where the pipes are
well insulated. When the flow is adiabatic, the static temperature will decrease along the pipe. This can
be seen from Equation 93. For perfect gases, the stagnation temperature is constant in adiabatic flow. As
the Mach number, M, increases, the static temperature must decrease.
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But what happens when the pipe is cooled? When cooled, the stagnation temperature will decrease and
the static temperature will actually decrease more than it would naturally. Thus, we can see that adiabatic
flow cannot always be relied upon to be an extreme case.
The case of isothermal flow is frequently encountered in long gas transfer pipelines. When the flow is isothermal, then by definition the temperature remains constant. This can only occur if the gas is heated
from its tendency to cool down. In a long transfer line exposed to ambient conditions, the tendency is for
the gas pipe material to come to equilibrium with the surroundings, and the gas will tend toward equilibrium with the ambient conditions as well. The gas is heated by the ambient conditions outside the pipe.
In a more general case of gas heating, the heating may be strong enough to actually increase the static
temperature. This means that the isothermal condition is not the extreme limit either. There is, in fact, no
limit to gas heating effects until conditions reach ionization or dissociation.
Figure 3 shows an example of air flow in a pipe where the adiabatic and isothermal flow do not bracket
the range of possible flow conditions.
This discussion points out a frequent misconception among engineers that isothermal and adiabatic flow
are the extreme cases to consider in gas flows. A more accurate statement is that the conditions under
which the majority of gas pipelines operate have heat transfer boundary conditions that maintain the gas
between adiabatic and isothermal behavior. For most practical applications, adiabatic and isothermal
flow can be considered as the extreme cases. But it has been shown that this is not a completely general
rule, and may be incorrect in some applications.
One last comment of practical importance. Whether a pipe operates adiabatically or isothermally or
somewhere in between or outside, the primary impact of these assumptions is on the gas temperature.
Frequently, for analysis simplification purposes, a gas is assumed to operate either adiabatically or isothermally, and the result is that the flow rates and gas pressures in the system do not change significantly
between these two idealized cases. Thus, if the purpose of the analysis is to determine the system flow
rate or flow distribution in a network, the heat transfer assumption used for the pipe will frequently have
only a second order effect on the results.
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Figure 3: Comparison of temperature profiles and flow rate predictions for adiabatic, isothermal, heated and
cooled air flow in a 20 ft. long 1 inch steel pipe. Inlet conditions are 100 psia, 111 °F and outlet pressure is 60
psia. Cooled flow has ambient temperature of 30 °F. Heated flow has ambient temperature of 220 °F. Both
heated and cooled cases have pipe wall and insulation heat transfer coefficients which total to 100 Btu/hr-ft2F. Note how adiabatic and isothermal cases do not bracket conditions. See Walters (2000).
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Compressible Flow Theory in Single Pipes
In order to provide a robust method to solve compressible flow in pipe networks, numerous fundamental
equations must be solved simultaneously. AFT Arrow solves the continuity (i.e., mass balance) equation,
the one-dimensional momentum equation, the energy equation, the equation of state, and the Mach number equation which ties together temperature and velocity.
If you are unfamiliar with the field of compressible flow, it is suggested that you first read the compressible flow review topic and/or consult a textbook for a thorough description of the subject.
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Extension of Single-Pipe Methods to Networks
Methods to solve the single pipe equations are available in the literature (Anderson (1984), Saad (1993),
Shapiro (1953)), but their extension to pipe networks involves significant difficulties. In a network system,
the flow and energy must balance at each branch point. Traditional solution methods in incompressible
flow systems break down because the relationships between pressure and flow cannot be expressed in a
single convenient equation. Thus the calculation speed and reliable convergence benefits of incompressible flow matrix methods are much more difficult to obtain in compressible flow calculations. Heat
transfer and the resulting temperature effects further complicate the analysis.
To address these issues, AFT Arrow incorporates unique methods of relating the various thermodynamic
and fluid dynamic parameters to each other resulting in a solution methodology that is fast and offers
good convergence characteristics. AFT Arrow's methods maintain the integrity of single pipe methods
while preserving the required mass and energy balances at all branch points.
The specific techniques used by AFT Arrow to obtain solutions to the equations of compressible flow are
proprietary and probably of little interest to the user. What the user will be most interested in is what equations are solved (so that results can be cross-checked) and what balances are calculated at branch
points. Therefore, sufficient information is provided to enable users to verify results, while the proprietary
aspects of AFT Arrow's solution methods are not described.
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Fundamental Equations
The continuity equation applied to a constant area pipe yields:

(1)

The one-dimensional momentum equation applied to a constant area pipe yields:

(2)
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Assuming the pipe is straight over the computing section, Figure 1 shows the relationship between dx
and dz:

(3)

Figure 1: Relationship between distance along pipe (dx) and vertical elevation change (dz)

The fourth term on the left of Equation 2 accounts for pressure changes due to body forces. AFT Arrow
models body forces due to gravity and due to rotation. If due to gravity, the default value of g in Equation
2 is the standard earth acceleration (i.e., 32.174 ft/sec2 or 9.81 m/sec2). This can be changed in the
Environmental Properties Panel to any value you wish, which allows for modeling aerospace vehicles or
non-terrestrial systems.
If a rotating system is modeled, the rotations per minute is input in the Environmental Properties Panel.
You cannot model both gravitational and rotational accelerations at the same time. In practice, gas systems that rotate (such as turbomachinery) will be compact enough that elevation affects on pressure will
be negligible.
In rotating systems, the junction elevations become distances from the rotation axis. The acceleration
due to rotation becomes:

(4)

where z is the junction elevation (distance from the axis) and w is the rotational velocity. This term is interchangeable with g in Equation 2, and henceforth g will be used with the understanding that it can refer
either to gravitational or rotational acceleration as in Equation 4.
Also note that in rotating systems, the g level will increase as the distance from the centerline is
increased. For each computing section, AFT Arrow uses the acceleration based on the arithmetic average of z inlet and z outlet.
From the equation of state for a real gas:

(5)
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Continuity Equation at a Branch
By applying the continuity equation at branch i, we loop over all connecting pipes and can say that:

(46)

where ṁij is the flow rate in the pipe connecting junctions i and j.
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Energy Equation at a Branch
By applying the energy equation at a branch i, we loop over all connecting pipes and can say that:

or, in terms of stagnation enthalpy,
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(47)

where h0,ij is the stagnation enthalpy at the connection point of the pipe and junction.
The elevation term shown in Equation 30 drops out because all pipes at the junction connect at the same
elevation.
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Concentration Equation at a Branch
The concentration equation is a special version of the continuity equations. It is needed only when gas
streams of different composition flow into the branch (i.e., a mixing calculation is occurring).
By applying the continuity equation at branch i, we loop over all connecting pipes for each molecular species c and can say that:

(48)
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Network Implementation
To provide converged solutions in the shortest time possible, matrix solution techniques are used. Matrix
techniques allow all pipes to be solved simultaneously, which is faster and offers the best convergence
characteristics.
To obtain a valid solution in a network, the stagnation pressure at each branch point must be equal. Additionally, the mass flow, energy flow, and species concentrations must sum to zero at the branch.
Although the stagnation pressures at the pipe endpoints will equal that at the connecting junction, this is
not true for stagnation enthalpy (and temperature). The stagnation enthalpy at the end of a pipe will be
that enthalpy that results from the heat transfer in the pipe. Once the fluid flows into the junction, the stagnation enthalpy will change to the mixture stagnation enthalpy, or the average stagnation enthalpy of all
inflowing pipes.
If only one pipe flows into the branch, the branch stagnation enthalpy will equal the stagnation enthalpy
coming out of the pipe. But if more than one pipe flows into the branch, the stagnation enthalpy will reach
an averaged condition. It is this averaged stagnation enthalpy that results from mixing two or more
streams at different stagnation enthalpies. This stagnation enthalpy is supplied to all outflowing pipes.
This is depicted in Figure 1 and follows Equation 49.

(49)

where the + superscript indicates the summation applies only to positive inflows into the junction.
The concentration balance at a junction is similar to stagnation enthalpy. The junction concentration itself
will not match the concentrations for the inflowing pipes, but will be a mixture of the incoming flow
streams.
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Figure 1: Flow weighted mixing and energy balance
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Verifying Network Solutions
AFT Arrow uses a modified Newton-Raphson matrix method to obtain a system level balance of mass,
energy and concentration. When the Solver is finished, the continuity, energy, and concentration equations are satisfied at all branching sections. Once solved, AFT Arrow goes back and sums up all mass
flows, energy and concentrations at each branch to verify that these equations are satisfied.
After the Solver converges, AFT Arrow loops over each junction and adds up the inflow and outflow of
mass, energy and concentrations and compares the sum to the solution tolerances. If it appears that any
junction is out of tolerance, a warning is given in the output.
In the Solution Balance Summary table AFT Arrow provides additional information on the balance at
each junction. This table can be displayed by selecting the option in the Output Control window General
Output folder. Figure 1 shows an example of the Solution Balance Summary table.
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Figure 1: Solution Balance Summary table shown in the Output window offers a balance report of all junctions in the window
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Sonic Choking
Sonic choking occurs in a pipe system when at some location the gas attempts to accelerate to a velocity
faster than the local sonic velocity. Being unable to accelerate any further, the gas reaches its maximum
velocity at sonic velocity. Changes to the downstream conditions, such as lowering the pressure, produce no additional flow. In many pipe applications sonic choking is the dominant feature of the system
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behavior.
Predicting the flow rates under such sonic choking conditions can be very difficult depending on where
the choking occurs. AFT Arrow is designed to identify sonic choking and predict the system behavior
under such conditions.

Related Topics
Theory and References
Nomenclature
Review of Compressible Flow Theory
Compressible Flow Theory in Single Pipes
Role of Pressure Junctions - Detailed Discussion (Long)
Chempak Technical Information - Detailed Discussion
Stagnation Properties
References
Pipe Material Library References
Subsonic vs. Sonic Pressure Losses
Sonic Choking Detailed Description
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Related Examples
Flow Through an Orifice
Hydrocarbon Relief System

729
768

Related Blogs
Making Sense of xT – Valve Loss in Compressible Flow

Subsonic vs. Sonic Pressure Losses
There are two separate pressure loss mechanisms when gas flows through a restriction, expansion, or
end point.
l

Subsonic losses are standard "form" losses and are dependent on the geometry of the restriction, expansion, or end point. This is the common K-factor, discharge coefficient for subsonic flow,
or one of the other loss models discussed in the Junctions section.

l

Sonic losses result when sonic choking occurs. Sonic losses are dependent on the minimum
effective flow area and are unrelated to the K-factor. This is the CdA for sonic choking.

The two loss mechanisms cannot occur simultaneously in nature or in AFT Arrow. If one mechanism
occurs during the solution, the input data for the other mechanism is ignored by AFT Arrow.
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It is also important to note that sonic choking at a restriction cannot be calculated if the CdA for Sonic
Choking is not entered. Thus, Arrow will always use subsonic loss calculations if no CdA for Sonic Choking has been entered, even if the actual system would experience choked flow at that restriction.
Note: The CdA for sonic choking may be different from the subsonic CdA loss model option in Arrow.
The discharge coefficient can vary at different pressure ratios due to the vena contracta moving
closer to or farther from the orifice restriction. For the highest accuracy the CdA used for subsonic and sonic losses should be tested and entered separately. See the "Modeling Choked
Flow Through an Orifice" white paper on AFT's website for more information.

Related Topics
Sonic Choking
Sonic Choking Detailed Description
Multiple Choking Points in Single Flow Path
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Related Examples
Flow Through an Orifice
Hydrocarbon Relief System

729
768

Sonic Choking Detailed Description
Sonic choking occurs when some location in the pipeline experiences a local velocity equal to the sonic
velocity of the gas. Sonic choking can occur in three geometric configurations in a pipe system. Figure 1
depicts the three possibilities.
The first case can be called endpoint choking because it occurs at the end of a pipe as it exits into a
large vessel or the atmosphere. In this situation, the gas cannot drop its pressure to match that at the discharge without accelerating to sonic velocity. A choke point forms at the end of the pipe, which results in
a pressure discontinuity across which the discharge pressure condition is met.
The second case can be called expansion choking, and is similar to the first case. Expansion choking
can happen when the flow area of the pipe is increased rapidly. For example, this occurs when the pipe is
expanded from a two inch pipe to a three inch pipe. Another example is when a pipe enters a flow splitter
where the sum of the pipe areas on the splitting side exceeds the pipe area of the supply pipe. A choke
point forms at the end of the supply pipe, and a pressure discontinuity is established.
The third case can be called restriction choking. This can occur when the gas flows through a restriction in the pipe such as an orifice or valve. In such a case the flow area of the gas is reduced, causing a
local increase in velocity which may reach the sonic velocity. A choke point forms at the restriction, with a
pressure discontinuity similar to the first two cases.
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Figure 1: Three configurations which can result in sonic choking. From top to bottom, endpoint choking,
expansion choking, and restriction choking.

Figures 2-4 show example stagnation pressure and Mach number profiles for the three cases. The data
for the cases are: Supply air at 100 psia and 1000° R discharging to 30 psia, with Figure 2) 2 inch pipe
with no restrictions or expansions, Figure 3) 2 inch pipe expanding to 3 inches at the midpoint, Figure 4)
all pipe is 2 inch with orifice at midpoint with 0.6 area ratio. Mach number spikes to 1 at the orifice then
reduces to 0.29 immediately after. For clarity this spike is not shown.

Figure 2: Example stagnation pressure and Mach number profiles for endpoint choking
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Figure 3: Example stagnation pressure and Mach number profiles for expansion choking

Figure 4: Example stagnation pressure and Mach number profiles for restriction choking. Note that the Mach
Number reaches 1 within the restriction at 0.5.

The choked flow rate can be determined from Equation 50 by inserting a Mach number of 1 in Equation
51. These equations can be derived from the continuity equation (Saad, 1993, pp. 97):

(50)

where:
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(51)

In practice it is difficult to apply Equation 50 to choked conditions because the local conditions, Po, and
To, are not known at the point of choking. For instance, to apply these equations to endpoint choking (Figure 1, top), one must calculate the stagnation pressure and temperature at the end of the pipe before the
choke point. The problem is that the stagnation pressure and temperature before the choke point depend
on the flow rate, which is what we are trying to calculate.
The only way to accurately calculate such a problem is to do the following:
1.

Assume a flow rate

2.

March down the pipe

3.

If the Mach number reaches unity before the end of the pipe, lower the assumed flow rate and
repeat steps 1-3 until the Mach number reaches sonic right at the pipe endpoint.

The area, A, in Equation 50 can also be CdA, where the Cd is less than one and accounts for area reductions due to flow separation. This occurs in orifices, valves and other internal restrictions. Note that the
Cd used here is not equivalent to the discharge coefficient used for subsonic flow calculations. See Subsonic vs. Sonic Pressure Losses for more information.
A helpful output parameter in AFT Arrow is the sonic area, which can be compared against actual area to
determine what CdA would cause choking at a restriction:

(52)

A CdA smaller than the sonic area indicates that the flow would be choked. The sonic area is one of the
output parameters.

Sonic Choking Effects
The effect of sonic choking in pipe design or operation is that the maximum physically possible pipe flow
rate has been reached for the supply conditions. Lowering the discharge pressure will not produce more
flow rate. Figure 5 illustrates this by showing the flow rate as a function of discharge pressure in a two
inch pipe carrying air. This pipe does not have any restrictions, and experiences endpoint choking at any
discharge pressure below 63.6 psia.
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Figure 5: Example of dimensionless flow rate vs. dimensionless pressure drop. Sonic choking occurs just
past the dimensionless pressure drop of ~0.5, after which the flow can no longer increase

Some engineers misapply the concept of sonic choking and conclude that the sonic flow rate is the maximum possible through the pipe for all conditions. This is not the case. If the supply conditions can be
increased, the flow rate through the pipe can be increased. In fact, the increased choked flow rate
appears to increase linearly with increased supply pressure. See Figure 6.

Figure 6: Example of increasing choked flow rate with supply pressure

The pressure drop across the choke point in choked flow cannot be calculated directly. Methods such as
"normal shock tables" do not apply. The only way to calculate the pressure drop is to use the choked flow
rate as a new boundary condition on the pipe downstream of the choke point and apply the governing
equations to the remaining pipes. This boundary condition is facilitated by knowing the stagnation
enthalpy change across the choke point is constant.
Finally, a pipe can choke in more than one location. This occurs when the choked flow rate determined
by the first choke point is applied to the pipes downstream of the shock wave and the gas at this flow rate
cannot reach the end of the pipe without experiencing another shock wave. There is no limit to the
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number of choke points in a pipe other than the number of possible geometric configurations it contains
which may cause sonic choking.
The three mechanisms that cause choking can all occur in the same pipeline in any combination and any
order.

See Walters (2000) and Walters and Olsen (1997). for more information.
Related Topics
Sonic Choking
Subsonic vs. Sonic Pressure Losses
Multiple Choking Points in Single Flow Path
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Related Examples
Flow Through an Orifice
Hydrocarbon Relief System
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768

Multiple Choking Points in Single Flow Path
It should be noted that sonic choking can exist in any multiple of the above geometries and at multiple locations in the same pipe system. AFT Arrow’s solution method incorporates this reality. The model shown
in Figure 1 is that of a “triple choke steam flow”, where sonic choking occurs in three places, as indicated
in Figure 1. The pressure drop in the system is as shown in Figure 2. The Mach number as it progresses
down the system is shown in Figure 3.
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Figure 1: Steam flow in a pipe flow path with three choking points. Referred to as a Triple Choke Model.
Solved using Mach March Method. Walters and Olsen (1997).

Figure 2: Stagnation pressure drop in Triple Choke Steam Flow model shown in Figure 1. Walters and Olsen
(1997).
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Figure 3: Mach number profile in Triple Choke Steam Flow model shown in Figure 1

Sonic choking in multiple locations in a flow path can be understood as follows. Recall that the sonic flow
rate will have a unique value, given upstream conditions and the piping losses and thermal environment.
No matter what happens at the exit boundary condition, the flow rate will not increase or change in any
way. However, by changing the upstream conditions, the sonic flow rate can be changed. This is
because the conditions are being changed on the upstream side of the choke point and can thus influence the fluid behavior.
To understand multiple sonic choking, consider the system in Figure 1. By iteration on flow rate it is
determined that sonic choking will exist at the pipe expansion at junction J3. This fixes the flow rate for
the entire system. This flow rate can then be entered as an upstream boundary condition on the remaining pipes. In this way the pressure can be obtained downstream of the choke point by iteration. After
entering the flow rate as an upstream pseudo-boundary condition, it may turn out that sonic choking
occurs again, such as it would for any pipe system with an upstream assigned flow rate. In this system
the flow again chokes at the restricted area of an orifice at J5. Again, the known choked flow rate is used
as a pseudo-boundary condition at the entrance to the pipe downstream of the orifice. Solving this
pseudo system results in a third choking condition at the exit of pipe P5 as it connects to atmospheric
pressure at J6. Choking also occurs as the flow exits the system.
The pseudo system that represents the triple choke system can be depicted as in Figure 4.
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Figure 4: Triple Choke Steam Flow model pseudo system for determining pressure drops at choke points.
Based on model shown in Figure 1. Walters and Olsen (1997).

Related Topics
Sonic Choking
Subsonic vs. Sonic Pressure Losses
Sonic Choking Detailed Description
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Role of Pressure Junctions - Detailed Discussion (Long)
In modeling a generalized pipe network, it is possible to construct models that do not have a unique solution. A common occurrence of this is when a model contains one or more sections which are completely
bounded by known flow rates. A series of examples with accompanying explanation will clarify situations
where this occurs. The length of this topic is proportional to the frequency with which engineers get confused over the issue. It became apparent that an exhaustive, lengthy discussion was necessary for some
engineers. Do not dismiss this topic too quickly because of its length.
Before beginning, it will be helpful to consider an aspect of the philosophy of computer modeling. At the
risk of stating the obvious, it must be recognized by the user that a computer model cannot calculate anything that cannot in principle be calculated by hand. All the computer does is accelerate the calculation
process. Some users expect the model to generate independent information and become frustrated
when the software requests additional information from them. But if the user was doing the calculation by
hand that same information would still be required. The difference is that in the case of the hand calculation, the engineer would be forced to think through why the information is needed.
However, when the engineer interacts with AFT Arrow, they do not need to think at the same depth as in
the hand calculation. So when AFT Arrow asks for the additional information, it is not as apparent why it
is required. This disconnect in thinking can cause frustration for the user. Fully understanding the
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concepts in this topic will greatly reduce the frustration for some users, and will improve the quality of
models for all users.

Examples
The simplest example is the system shown in Figure 1. In AFT Arrow terms, the system has two assigned
flow junctions. Heat transfer has no affect on the point being made here and is therefore ignored in all
examples.

Figure 1: Model with two assigned flows. This model does not have a unique solution.

Obviously, the flow in the pipe is known. But what is the pressure at the inlet? At the outlet? It cannot be
determined because there is no reference pressure. The reference pressure is that pressure from which
other pressures in the system are derived. There can be one or more reference pressures, but there
always has to be at least one.
The model in Figure 1 can be built with AFT Arrow and if you try and run this model, AFT Arrow will inform
you that it cannot run it because of the lack of a reference pressure. In AFT Arrow there are several junctions that can act as a reference pressure: the reservoir, assigned pressure, spray discharge, valve (with
the exit valve option), orifice (with the exit orifice option), and exit type relief valves when open.
There are a couple other things worth noting about Figure 1. First is that the model in Figure 1 has
redundant boundary conditions. When one flow is specified in a single pipe, the other end must have the
same flow. Thus the second known flow does not offer any new information. Because the conditions are
redundant, there is no unique solution to the model in Figure 1. In any AFT Arrow model, there is always
at least one unknown for each junction in the model – either pressure or flow rate. Sometimes there are
two unknowns, such as a Compressor/Fan. It is possible the user may not know either the flow or the
pressure at the compressor/fan. In such cases the user is required to specify the relationship between
flow and pressure. This relationship is called a compressor/fan curve, and by specifying the relationship
between the two, effectively one of the two unknowns can be eliminated. Thus we always end up with
one unknown for each junction.
Second, if the user was allowed to specify two flows as in Figure 1, they could specify each with different
flow rates. Clearly they must have the same flow, so an inconsistency occurs. The basic reason the inconsistency is possible is because Figure 1 does not have a unique solution.
Figure 2 a-c shows three other model configuration possibilities. It is not possible to specify inconsistent
conditions for any of the Figure 2 models, and they always have a unique solution no matter what input is
specified by the user.
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Figure 2a-c: Top two models with one pressure and one assigned flow, bottom model with two pressures. All
of these models have a unique solution.

The four models in Figures 1 and 2 a-c contain all logical possibilities. In all four cases there are four
things we want to know. The pressure and flow at the inlet, and the pressure and flow in the outlet. In
each case we know two of these four. The problem is that in the Figure 1 model the lack of a reference
pressure makes it impossible to determine the inlet and outlet pressures, even though we know the flow.
The three models in Figure 2 a-c all have at least one pressure and thus all four of the desired parameters can be determined. Table 1 summarizes this. Also note in Table 1 that in the Figure 2c case the
flow can be determined, but it is by iteration.

Table 1: Four logical possibilities of boundary conditions for single pipe systems

As we consider multi-pipe systems, there are a host of other possibilities that present themselves. All
other configuration possibilities which lack a reference pressure ultimately boil down to the same problem that exists in Figure 1.
The pipe lengths, diameters and friction factors are not included in the remaining models because they
do not influence the main point of this topic. It is assumed that these parameters can be obtained for each
pipe and the resulting pressure drop calculated with standard relationships.
Consider the model in Figure 3. With three boundaries having a known flow, this clearly has the same
problem as the model in Figure 1. No unique pressures at any location can be calculated.
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A pressure at any one of the three boundaries in Figure 3 would be sufficient to allow a unique solution of
the system. It is also possible that there could be two pressures and one flow, or three pressures. As long
as there is one pressure a unique solution exists.

Figure 3: Three known flows at boundaries lack a reference pressure, similar to the model in Figure 1. This
model does not have a unique solution.

Now consider the models in Figure 4. The Figure 4a model does have one reference pressure, but in this
case there is still a problem. The Flow Control Valve (FCV) is controlling the flow to 1 lbm/s, and the
downstream flow is demanding 1 lbm/s. The section of the system before the FCV can be solved
(because there is a pressure upstream), but the section after the FCV does not have a unique solution.
Why? In order to obtain a unique solution, the pressure drop across the FCV must be known. But any
pressure drop could exist and satisfy the conditions of this model. It is thus not possible to determine the
pressure at the outlet flow demand because it depends on the FCV pressure drop which is not known.
The model in 4b does have a pressure downstream of the FCV, and thus there is a unique pressure drop
across the FCV and a unique solution exists for the model in Figure 4b.
If you input the remaining data for the Figure 4a model and run it in AFT Arrow, you will get the message
shown in Figure 5. AFT Arrow identifies the part(s) of the model where a known pressure is needed.

Figure 4a-b: The model at the top does not have a reference pressure after the Flow Control Valve so the
pressure drop across the FCV cannot be determined. The top model does not have a unique solution. The
bottom model has a pressure upstream and downstream, and a unique solution exists.
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Figure 5: AFT Arrow message when you try to run the model shown in Figure 4a

Sizing Compressors or Fans with Flow Control Valves
An analogous situation to Figure 4a is when the user is trying to size a compressor using the Compressor/Fan with a fixed flow. The Compressor/Fan with a fixed flow is really just a reverse FCV. It controls the flow by adding pressure, rather than reducing it. Figure 6 shows this case and is another
example of a model without a unique solution, requiring more than one pressure junction. If the user
instead entered a compressor or fan curve for this model, it could be solved.

Figure 6: A compressor/fan modeled as a fixed flow behaves identically to the FCV model in Figure 4a, for
which no unique solution exists

Increasing in model complexity, Figure 7 shows some additional examples of models without a unique
solution. In particular, Figure 7b has a compressor/fan with a fixed flow that can add as much pressure as
it wants, and the downstream FCV can then take out as much as it wants. There are an infinite number of
possible solutions.
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While it would be highly unusual for a system to have two FCV’s in series, it is worth considering the
model in Figure 7b further. It is common to have an FCV in series with a compressor/fan. How does one
size the compressor/fan in such a case? There are several ways to do this, one of which is to change the
compressor/fan from a fixed flow to an actual compressor or fan curve. Trying multiple curves will guide
you to the best compressor or fan.
But there is a better way. Consider for a moment the pressure drop across the FCV in Figure 7b. In the
installed system, is any pressure drop acceptable? Usually not. It is typical to have pressure drop limits
based on the system design and the FCV itself. A common requirement is a minimum pressure drop
across the FCV. If no minimum pressure drop exists, let’s say we choose a compressor or fan that results in the pressure drop across the FCV being 0.01 psid. If the system is built and the compressor or fan
slightly underperforms its published curve, the FCV will not be able to control to its flow control point.
Even if the compressor or fan does operate exactly on the published curve, eventually fouling in the pipes
will result in increased pipe resistance (and pressure drop) and again the FCV will not be able to control
to its flow control point.

Figure 7: Neither model above has a unique solution. The top model has two flow control valves in series.
The bottom model has a compressor/fan modeled as a fixed flow in series with an FCV. In both cases either
a third pressure junction is needed between the two middle junctions, or one of the junctions must be
changed from a flow controlling device.

To avoid these kinds of problems in installed systems, a minimum Cv or pressure drop across the FCV is
typically required. This minimum pressure drop provides the key to sizing the compressor/fan in Figure
7b. Rather than model the FCV as a flow control valve, instead model it as a pressure drop control valve
(PDCV) set to the minimum pressure drop requirement. Then a unique solution exists, the model will run
and the compressor/fan can be sized. Once the compressor/fan is sized and an actual curve exists, the
curve can be entered and the valve can be switched back to an FCV. Remember that when we use the
PDCV, we are still getting the flow we want for the true FCV, because the compressor/fan is now providing the control.
Think for a moment what we just did. We went through a thought process that many engineers have gone
through during their hand calculations. Specifically, we size the compressor/fan such that the FCV pressure drop is minimized. If the FCV has a larger pressure drop than the minimum, the compressor/fan
must add more pressure to overcome this excess pressure drop. In short, it must use more energy and is
thus less efficient. Figure 8 depicts this process.
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Figure 8a-c: The model at the top is the same as Figure 7b and does not have a unique solution. To size the
compressor/fan, change the model to the second one shown above, which uses a pressure drop control
valve (PDCV) rather than an FCV. Once the second model is run, the compressor/fan is sized, a curve exists,
and the model at the bottom can be run using an FCV.

Let’s make a slight addition in complexity to the model in Figure 8. In this case we have two flow control
valves in parallel (Figure 9). To size this compressor/fan, we apply the process described in Figure 8. We
choose one of the FCV’s, make it a PDCV, size the compressor/fan, choose a compressor/fan with an
actual curve, enter the curve into the model, and then return the PDCV to an FCV.

Figure 9: A compressor/fan with a fixed flow in series with two parallel FCV’s. The model in its current form
does not have a unique solution. To size the compressor/fan, first change the FCV at J7 to a PDCV.

This brings up the question, which FCV should one choose to turn into a PDCV? When FCV’s are put in
parallel, frequently the pipe design has one of the FCV’s further away from the compressor/fan than the
others. Because of the additional piping leading to this FCV, it will be the weakest link in the chain of parallel FCV’s by virtue of having the lowest pressure drop across it. The most remote FCV should be
chosen as the PDCV. If the most remote FCV is chosen, when the minimum pressure drop required is
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applied to the PDCV all other FCV’s in the parallel system will have greater than the minimum pressure
drop — thus satisfying the pressure drop requirement for those FCV’s as well.
What if you do not know which FCV is the most remote? In this case make your best guess, change it to
a PDCV at the minimum required pressure drop, run the model, then verify whether all other FCV’s
have a pressure drop that meets or exceeds the requirement. If not, then the FCV with the smallest pressure drop as determined by the first run is in reality the weakest FCV. Choose this FCV, change it to a
PDCV, and then change the original PDCV back to an FCV since it is not the weak link. If the pipe system leading to each FCV is truly identical and all FCV’s have identical pressure drops, any of the FCV’s
will serve as the PDCV.
The preceding process can be extended to cases where there are three or more FCV’s in parallel, and
also cases with more than one compressor/fan in parallel supplying the FCV’s.
In Figure 9 the most remote valve is J7, the one on the right. If the minimum pressure drop is 5 psid,
change J7 to a PDCV with a 5 psi drop. This results in the output shown in Figure 10a. Notice how the
pressure drop across the other FCV at J6 is greater than 5 psid because it is closer to the compressor/fan. Also notice how the flow through J7 is still 1 lbm/s even though it is not controlling flow. Once
again, the reason for this is that the compressor/fan is controlling the flow to 2 lbm/s, and with the J6 FCV
controlling to 1 lbm/s, the excess must go through J7. The compressor/fan is thus sized and its pressure
rise is shown in Figure 10b (59.83 psid).

Figure 10a-b: Results from changing J7 in Figure 9 to pressure drop control valve

AFT Arrow results for the model in Figure 9 after J8 has been changed to a PDCV. Top results show
valve summary and bottom results show compressor/fan size.
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Pressure Control Valves
The problem of non-unique solutions can also occur when a Pressure Reducing Valve (PRV) or Pressure
Sustaining Valve (PSV) is used. A PRV is used to control pressure downstream of the valve, while a
PSV controls pressure at the valve inlet. One thing that PRV’s and PSV’s have in common with FCV’s
is that the pressure drop cannot be known ahead of time. The pressure drop depends on the balance of
the pipe system.
Consider the simple system shown in Figure 11. With the pressure controlled downstream of the PRV,
the pressure upstream is not known. Without knowledge of the PRV’s pressure drop, the pressure
upstream of the PRV cannot be determined and thus no unique solution exists.

Figure 11: If a PRV is downstream of a known flow the PRV pressure drop cannot be calculated. This model
does not have a unique solution.

Figure 12 shows the possible cases with PRVs and PSVs, while Table 2 comments on the six cases. In
summary, at least one known pressure is always needed on the side of a pressure control valve opposite
of the controlled side.
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Figure 12a-f: Six possibilities for PRV and PSV configurations. Cases A and E do not have unique solutions.
See Table 2 for comments.

Table 2: Summary of six possibilities for PRV and PSV configurations.

If a compressor/fan is being sized in series with a PRV or PSV, modeling the compressor/fan as a fixed
flow will not permit a unique solution if the compressor/fan is upstream of a PRV or downstream of a
PSV. The reasons for this are the same as those in the previous section on FCV’s.
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In combination with the previous examples, it should be apparent how the non-unique solution problem
can occur in more complicated systems. In all such cases, the reasoning will boil down to the same problems already discussed.

Closing Parts of a System
A model may be built which has sufficient information to obtain a unique solution. Then a user closes a
pipe or junction and all of a sudden the problem of no unique solution occurs. This is shown in Figure 13.
The top model has a unique solution and will run fine. In the bottom model the valve is turned off and the
section of the system downstream of the valve has only known flows. No reference pressure exists in this
section because it is isolated from the known pressures in the section on the left.

Figure 13: Top model has reference pressures at J1 and J2. Bottom model has closed valve at J4 which isolates the J5 and J6 assigned flows. There is no reference pressure for J5 and J6 and no unique solution
exists for the bottom model.

Summary
AFT Arrow models always require one reference pressure, and may require more if the engineer uses
control valves, compressors or fans with fixed flows, or closed pipes or junctions. The actual number of
reference pressures needed depends on the model, but AFT Arrow always checks to be sure sufficient
reference pressures exist and stops to warn the user when they do not.
This capability is a powerful diagnostic feature that will help guide the user in building meaningful models.

Related Topics
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Chempak Technical Information - Detailed Discussion
© Copyright 1998 Madison Technical Software Inc. Used with permission.
Note: The information in this Appendix was taken from Section 8 of the Chempak Operating & Reference Manual, Version 4, Windows Edition, Issue: January 1998. Section numbering was left
unchanged, and some sections that were judged not relevant were not included so the numbering is not sequential. Notation and references in this Appendix apply only to this Appendix,
and are referenced at the end.

8.1 General
This section sets out the data sources, correlations and estimation methods used in the CHEMPAK database. In putting together the database, the methods and sources were selected in the following order of
preference.
· Published experimental data
· Published correlations based on experimental data
· Specific category correlations
· General estimation methods
Madison Technical Software has followed the general recommendations in Reid and in Danner and
Daubert as far as selection of specific category correlations and general estimation methods are concerned. In selecting specific compound data, a combination of sources has been used wherever possible. Important sources of specific compound data used by CHEMPAK are:
· Reid et al
· Perry et al
· J Chem Eng Data
· Daubert & Danner
· ESDU publications
· API Technical Data Book - Petroleum Refining
· International Critical Tables
· CRC Handbook
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· Vargaftik
In many cases, the compound property values are a combination of published data, published correlations and general estimation methods. Several properties in certain compound categories have been
estimated or adjusted by Madison Technical Software. It has been our policy to adopt and maintain a critical approach to available data sources and correlation methods.
The following sections set out details of the correlations and estimation methods used. In certain cases,
the user is directed to the original references, particularly where the method is complex.
Data sources for Aqueous Solutions/Heat Transfer Liquids are published experimental data and correlations based on experimental data.

8.2 Physical Constants
8.2.1 Critical Temperature
The great majority of values are believed to be experimental. Where values had to be estimated, the
Joback method was used.
8.2.2 Critical Pressure
Most of the values are experimental. In cases where experimental data were not available, the critical
pressure was derived from the Joback method.
8.2.3 Critical Volume
A majority of the values are experimental. A great majority of the remaining compounds for which experimental values were not available had accurate boiling-point volumes available from which critical
volume estimates were derived using the Tyn and Calus correlation. For a few substances, estimates of
the critical volume were derived from the Joback method.
8.2.4 Normal Boiling Points
All values are believed to be experimental. In some cases, the values were slightly adjusted for vapor
pressure.
8.2.5 Freezing Points
Where possible, quoted freezing points are experimental. No accurate method of estimation of
compound freezing point is available. In the absence of experimental data, a rough estimate was
derived from the Joback method.
8.2.6 Acentric Factors
The acentric factor is defined as
w = -log10(Pvr at Tr = 0.7) - 1
In all cases the acentric factor was derived from the vapor pressure correlation ( see section 8.8)
8.2.7 Joback Group Contribution Method
The Joback method is used to derive values of Tc, Pc, Vc and Tf where no experimental data or other predictive method was available.
Tc = Tb/(0.584 + 0.965 Sum(Dt) - Sum(Dt)2)
Pc = 1/(0.113 + 0.0032 na - Sum(Dp))2
Vc = 17.5 + Sum(Dv)
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Tf = 122 + Sum(Df)
where na is the number of atoms in the molecule and the D contributions are given by Joback and by
Reid et al (1987). Error magnitudes for the Joback method are as follows:
· Critical Temperature: average error about 1%
· Critical Pressure: average error about 5%
· Critical Volume: average error about 2%
· Freezing Point: average error about 11%
8.2.8 Tyn & Calus Relation
Tyn & Calus showed a close (< 3% error) relation between molar volume at normal boiling point and the
critical molar volume of the form,
Vb = a Vcn
a = 0.285
n = 1.048

8.3 Liquid Specific Volume
Liquid specific volume rises slowly and approximately linearly with rise in temperature to about Tr = 0.8.
At higher temperatures, the values rise more rapidly to the critical point.
Experimental data or correlations derived from experimental data are available for most compounds.
8.3.1 Hankinson-Brobst-Thompson Equation
The saturated specific volume is given by,
Vs/V* = Vr(O)(1 - wsrkVr(1))
Vr(O) = Sum{an(1 - Trn/3)}

0.25 < Tr < 0.95

Vr(1) = Sum{bnTrn/(Tr - 1.00001)}

0.25 < Tr < 1.0

aO = 1
a1 = -1.52816
a2 = 1.43907
a3 = -0.81446
a4 = 0.190454
bO = -0.296123
b1 = 0.386914
b2 = -0.0427258
b3 = -.0480645
V*, wsrk and Tc are tabulated property constants. The user is referred to Hankinson, Thompson and to
Reid et al (1987). Errors are typically about 1% with most being less than 2%.
8.3.2 Rackett Equation
If a reference volume (Vref at Tref) is available then

- 523 -

Theory and References

Zra = (PcVref / RTc)n
n = 1/(1 + (1 - Tref / Tc)m)
m = 2/7 or other empirical constant
The saturated specific volume is given by,
Vs = VrefZrax
with
x = -(1 - Tref / Tc)m + (1 - T/Tc)m
In most cases, an experimental value of reference density was available. Where such a value was not
available, values were derived from the group contribution method of Le Bas or derived from the critical
volume using the Tyn & Calus relation. Tests by Madison Technical Software on over 80 liquids showed
that these two methods were significantly more accurate than the Spencer and Danner method for Zra.
The reader is referred to Reid et al for further details on these methods. With one or more experimental
points, the Rackett equation gives errors of about 1% with most values less than 3%. If the reference
volumes are estimated, typical errors are 3%.
8.3.4 The Effect of Pressure on Liquid Specific Volume
The effect of pressure on liquid specific volume is calculated when
P > Ps + 0.1 Pc
The correction is derived from the equation of state as follows,
VL = VLs - VLs,es + VL,es
VL = specific volume at T and P
VLs = VL at T and Ps from methods of this section
VLs,es = VL at T and Ps from the equation of state
VL,es = VL at T and P from the equation of state
Liquid specific heat can in principle be derived from the equation of state but in practise, direct analytical
or group contributions are preferred where experimental data are not available.

8.4 Liquid Specific Heat
8.4.1 Rowlinson-Bondi Method
(CpL - Cpo)/R = 1.45 + 0.45/X + 0.25w(17.11 + 25.2X0.333/Tr + 1.742/X)
X = 1 - Tr
w = acentric factor
This method is generally applicable to the range from Tf to values approaching Tc. Note that CpL
approaches infinity as T approaches Tc.
Errors are generally less than 5% except in the case of hydrogen-bonding polar compounds (e.g. alcohols) at low temperatures. For these compounds, the Missenard group contribution method is preferred.
8.4.2 Missenard Method
The Missenard group contribution method yields values of coefficients in
CpL = a + bT + cT2
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The accuracy is usually better than 5%. The method cannot deal with double bonds and is not applicable
for Tr > 0.75
a = Sum{an}
b = Sum{bn}
c = Sum{cn}
The group contributions are available in Missenard. See also Reid at al.
8.4.3 The Effect of Pressure on Liquid Specific Heat
As noted above, the equations of state can be employed to estimate liquid specific heat, but the methods
presented in 8.4.1 and 8.4.2 are more reliable. The equations of state however can be used to estimate
the effect of pressure on liquid specific heat.
CpLs = CpL at Ts and Ps determined by the methods of this section.
Cpo = ideal gas specific heat at Ts
CpL = CpL at Ts and P > Ps
The equations of state give estimates of
Ds = (CpLs - Cpo)es at Ts and Ps
D = (CpL - Cpo)es at Ts and P
The corrected value of the liquid specific heat is
CpL = CpLs + D - Ds
The correction is not applied when T is close to Tc

8.5 Liquid Viscosity
Liquid viscosity typically varies in magnitude by a factor of 100 or more between the freezing and critical
temperatures. No generalized method is available to estimate or represent liquid viscosity adequately
over the entire temperature range. Corresponding states methods are applicable above Tr = 0.76. From
the freezing point to the boiling point, the influence of structure is strong.
8.5.1 Method of Van Velzen
The method of Van Velzen et al is a group contribution method of some complexity and range of applicability. It is the most frequently used group contribution method. The accuracy of the estimation averages
about 10% and most estimates are better than 20%. Some of the limitations of the method are:
· Larger errors found with the first members of a homologous series
· Only normal and iso substitutions on alkyl chains can be treated
· Heterocyclic compounds cannot be treated
· Application only in the range Tf to Tb
The method is complex and the reader is directed to the original references for full details.
8.5.2 Method of Morris
The method of Morris is a group contribution method. This method is useful as a comparison and substitute for the Van Velzen method in cases where the Van Velzen method is not applicable. The accuracy
of estimation is of the same order as Van Velzen. The limitations of the method are,
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· The method is less detailed than the Van Velzen method
· Applicable only in the range Tf to Tb
· No explicit treatment for heterocyclics or esters (apart from acetates).
The Morris method takes the following form
ln(v/v*) = 2.3026 J(1/Tr - 1)
J = (0.577 + Sum(Di))0.5
The values of v* are given for various categories of compounds. The constants v* and the group contributions D are given in Morris.
8.5.3 Method of Letsou and Stiel
This is a corresponding states method with applicability over 0.76 < Tr < 1. The method also predicts the
viscosity at the critical point (Tr = 1). The accuracy is normally better than 5% up to Tr = 0.92 with higher
errors encountered as the critical point is approached. Overall this is an excellent estimation method for
high-temperature liquid viscosity. The only serious limitation is the restricted range of applicability.
The form of the relation is
v = (f0 + w.f1)/A
with
w = acentric factor
f0 = a0 + b0Tr + c0Tr2
f1 = a1 + b1Tr + c1Tr2
A = 0.176x106 Tc0.1667/M0.5Pc0.667
a0 = 2.648

a1 = 7.425

b0 = -3.725

b1 = -13.39

c0 = 1.309

c1 = 5.933

In the above relations Pc is in bar and the viscosity is in units of Pa-sec.
8.5.4 Method of Przezdziecki & Sridhar
In this method, the viscosity is related to changes in the specific volume.
v = V0/E(V - V0) centipoise
V = liquid molar volume in cc/mol
E = -1.12 + Vc/D
D = 12.94 + 0.1 M - 0.23 Pc + 0.0424 Tf - 11.58 Tf/Tc
V0 = 0.0085 wTc - 2.02 + Vf / {0.342(Tf / Tc) + 0.894}
with
Tc = critical temperature, K
Pc = critical pressure, bar
Vc = critical volume, cc/mol
M = molecular weight
Tf = freezing point, K
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w = acentric factor
Vf = specific volume at Tf
The authors recommend that the volumes be estimated from the Gunn and Yamada equation. The
reader is referred to Reid for a discussion on this method. The method is less accurate below reduced
temperatures of about 0.55. Errors vary widely but will normally be less than 20% for Tr greater than
0.55.
This method is used in CHEMPAK only where necessary. An error analysis by Reid et al indicates a
higher level of error associated with this method than with the Van Velzen method for instance.
8.5.5 Interpolation and Extrapolation
Two regions are typically covered well by available experimental data, experimental correlations and by
the above relations:
273 < T < 0.6 Tc: this region is normally covered by published data or by one of the methods
8.5.1, 8.5.2, 8.5.4
0.76 Tc < T < Tc: this region is well covered by the method of Letsou and Stiel (section 8.5.3)
This leaves two regions which are often not covered by the above methods
Tf < T < 273: this region may be covered by extrapolation using ln(v) versus 1/T extrapolation.
The error due to the extrapolation in practise will not normally exceed 10% with a possible 20% error in
the immediate vicinity of the freezing point.
0.6 Tc < T < 0.76 Tc: this region may be covered by interpolation between the 273 < T < 0.6 Tc
region and the 0.76 Tc < T < Tc region using ln(v) versus 1/T interpolation. The errors due to interpolation in this case rarely exceed 5%.
8.5.6 The Effect of Pressure on Liquid Viscosity
The method of Lucas is applied:
vL/vsL = (1 + B.FA)/(1 + w.C.F)
vL = viscosity at pressure P
vsL = viscosity at saturation pressure Ps
F = (P - Ps)/Pc
w = acentric factor
A = 0.9991 - 0.0004674/(1.0523/Tr0.03877 - 1.0513)
B = 0.3257/(1.0039 - Tr2.573)0.2906 - 0.2086
C = -0.07921 + 2.1616 Tr - 13.404 Tr2 + 44.1706 Tr3 -84.8291 Tr4 + 96.1209 Tr5 - 59.8127 Tr6
+ 15.6719 Tr7

8.6 Liquid Thermal Conductivity
8.6.1 Method of Latini at al
For specified categories of compounds, the method of Latini et al gives correlations for liquid conductivity
for the range Tr = 0.3 to 0.8
The correlations are in the form
k = A(1 - Tr)0.38/Tr0.167
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A = A0TbnMmTcp
Category

A0

n

m

p

Alkanes

0.0035

1.2 -0.5 -0.167

Alkenes

0.0361

1.2 -1.0 -0.167

Cycloalkanes
Aromatics
Alcohols/Phenols
Acids

0.0310

1.2 -1.0 -0.167

0.0346

1.2 -1.0 -0.167

0.00339
0.00319

1.2 -0.5 -0.167

1.2 -0.5 -0.167

Ketones

0.00383

1.2 -1.0 -0.167

Esters

0.0415

1.2 -1.0 -0.167

Ethers

0.0385

1.2 -1.0 -0.167

Halides

0.494

0.0 -0.5

R20,R21,R22,R23

0.562

0.0 -0.5

0.167
0.167

Errors may be large for Diols and Glycols. The Acids equation is not applicable to Formic acid. The
reader is referred to Reid for a discussion of the method.
8.6.3 Method of Sato-Riedel
This method gives the following relation:
k = (1.11/M0.5)f(Tr)/f(Tbr)
with
f(X) = 3 + 20(1 - X)0.667
This method gives poor results for low molecular weight or branched hydrocarbons. Errors otherwise
are likely to be less than 15%. The method should not be applied for Tr > 0.8
8.6.4 Method of Ely and Hanley
The method of Ely and Hanley has application to the high-temperature liquid region (Tr > 0.8). There are
few data available for high temperature liquid conductivities. The method of Ely and Hanley is probably
the best method available. Error estimates are unknown.
This method is used in CHEMPAK for Tr > 0.8 with caution. It appears to give reasonable results for
non-polar compounds. Errors with polar compounds can be large.
8.6.5 The Effect of Pressure on Liquid Conductivity
The procedure derived from Missenard as presented in Danner and Daubert is employed:
k/ks = 0.98 + 0.0079 PrTr1.4 + 0.63 Tr1.2Pr/(30 + Pr)
k = conductivity at P
ks = conductivity at Ps

8.8 Vapor Pressure
The vapor pressure is expressed in its reduced form
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Pvr = Pv/Pc
Reduced vapor pressure varies from very low values at freezing point to unity at the critical point.
8.8.1 Published Correlations
The experimental correlations are commonly given in the following formats:
Wagner Equation
ln(Pvr) = (aX + bX1.5 + cX3 + dX6)/Tr
with
X = 1 - Tr
FKT Equation
ln(Pv) = a + b/T + cln(T) + dPv /T2
Antoine Equation
ln(Pv) = a + b/(T + c)
8.8.2 Gomez-Thodos Vapor Pressure Equation
Gomez-Nieto and Thodos give the following equation:
ln(Pvr) = B(1/Trm - 1) + G(Tr7 - 1)
G = aH + bB
a = (1 - 1/Tbr)/(Tbr7 - 1)
b = (1 - 1/Tbrm)/(Tbr7 - 1)
H = Tbrln(Pc/Pb)/(1 - Tbr)
For non-polar compounds,
B = -4.267 - 221.79/(H2.5exp(0.038 H2.5)) + 3.8126/exp(2272.33/H3) + D
m = 0.78425 exp(0.089315 H) - 8.5217/exp(0.74826 H)
D=0
except D = 0.41815 for He, 0.19904 for H2, 0.02319 for Ne
For polar non-hydrogen-bonding compounds (e.g. ammonia and acetic acid),
m = 0.466 Tc0.1667
G = 0.08594 exp(0.0007462 Tc)
B = (G - aH)/b
8.8.2 Gomez-Thodos Vapor Pressure Equations
For polar hydrogen-bonding compounds (water, alcohols),
m = 0.0052 M0.29Tc0.72
G = (2.464.M) exp(0.0000098 MTc)
B = (G - aH)/b
The advantages of this method are,
· fit guaranteed at T = Tb and T = Tc
· good performance with polar compounds
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· good performance over Tr = 0.5 to 1
In addition, tests carried out by Madison Technical Software show the clear superiority of this method
especially at low temperatures over the Lee-Kesler method.
8.8.3 Lee-Kesler Vapor Pressure Equation
Lee and Kesler give the following vapor pressure equation:
ln(Pvr) = f(0) + wf(1)
w = acentric factor
f(0) = 5.92714 - 6.09648/Tr - 1.28862 ln(Tr) + 0.169347 Tr6
f(1) = 15.2518 - 15.6875/Tr - 13.4721 ln(Tr) +0.43577 Tr6
The characteristics of this equation are,
· guaranteed fit at Tr = 1 and 0.7
· accurate for non-polar compounds
This equation is used in the Lee-Kesler and Wu & Stiel equations of state.
8.8.4 Interpolation and Extrapolation
In many cases an accurate empirical equation is known which does not extend to the critical point or to
the freezing point. The approach taken here is to fit the Wagner equation by least squares to the empirical equation and use the Wagner equation to extrapolate to the freezing point and to the critical point.
Extrapolation by this method to the critical method is a very accurate procedure. Extrapolation to the
freezing point is less accurate but it does provide reasonable values.
In CHEMPAK, the vapor pressure correlations set out in this section are used to provide the basic data.
Empirical relations are used wherever possible.

8.14 Notation
C Specific Heat
e Expansion Coefficient
h Enthalpy
log Logarithm to base 10
ln Natural Logarithm
m Dipole Moment
M Molecular Weight
P Pressure
R Gas Constant
r Riedel Parameter
s Entropy
T Temperature
v Viscosity
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V Specific Volume
w Acentric Factor
x Mole Fraction
Y Wu & Stiel Polarity Factor
Z Compressibility

Subscripts
b Boiling
c Critical
es Equation of State
f Freezing
ig Ideal Gas
L Liquid
m Mixture
0 Low Pressure
p Constant Pressure
ra Rackett
ref Reference
r Reduced
s Saturated
v Vapor
v Constant Volume
Superscripts
(o) Simple Fluid
(r) Reference Fluid
(p) Polar Fluid
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Stagnation density:

Related Topics
Theory and References
Nomenclature
Review of Compressible Flow Theory

474
474
477

- 533 -

Theory and References

Compressible Flow Theory in Single Pipes
Sonic Choking
Role of Pressure Junctions - Detailed Discussion (Long)
Chempak Technical Information - Detailed Discussion
References
Pipe Material Library References

492
500
510
521
534
535

References
1.

ANSI/API 526 7th Edition - Flanged Steel Pressure-relief Valves, 2017, published by American
Petroleum Institute, 1220 L Street, NW, Washington DC, USA

2.

ANSI/ISA Standard 75.01.01-2012, Industrial-Process Control Valves - Part 2-1: Flow Capacity Sizing equations for fluid flow under installed conditions, 2012, published by International Society
of Automation, Research Triangle Park, North Carolina, USA

3.

Anderson, J.D., Jr., Modern Compressible Flow: With Historical Perspective, McGraw-Hill, New
York, NY, 1982.

4.

ASME Press, ASME International Steam Tables for Industrial Use (CRTD-Vol. 58), published by
the American Society of Mechanical Engineers, Three Park Avenue, New York, NY 10016

5.

Bejan, A., Advanced Engineering Thermodynamics, John Wiley & Sons, New York, NY, 1988.

6.

Çengel Y., Heat and Mass Transfer, A Practical Approach, 3rd Edition, McGraw-Hill, New York,
NY, 2007.

7.

Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410, Crane
Co., Joliet, IL, 1988.

8.

Eckert, E.R.G., and Drake, R., Analysis of Heat and Mass Transfer, McGraw-Hill, New York, NY,
1972.

9.

Idelchik, I. E., Handbook of Hydraulic Resistance, 4th edition, Begell House, Redding, CT, 2007.

10.

Incropera, F.P. et. al, Fundamentals of Heat and Mass Transfer, John Wiley & Sons, NJ 2007

11.

Ingersoll-Dresser Pumps, Cameron Hydraulic Data, Liberty Corner, NJ, 1995.

12.

Ito, H., “Friction factors for pipe flow,”Journal of Basic Engineering, Vol. 81, pp. 123-126, 1959.

13.

Jeppson, R.W., Analysis of Flow in Pipe Networks, Ann Arbor Science Publishers, Ann Arbor, MI,
1976.

14.

Keenan, J.H., Thermodynamics, John Wiley & Sons, Inc., New York, NY, 1941.

15.

Miller, D. S., Internal Flow Systems, 2nd edition, Gulf Publishing Company, Houston, TX, 1990.

16.

Perry, R. H., Green, D. W., Perry's Chemical Engineers' Handbook, 7th Edition, McGraw-Hill, New
York, NY, 1997.

17.

Saad, M.A., Compressible Fluid Flow, 2nd Edition, Prentice-Hall, Englewood Cliffs, NJ, 1993

18.

Shapiro, A.H., The Dynamics and Thermodynamics of Compressible Fluid Flow, 2 vols., Ronald,
New York, NY, 1953.

19.

Smith, J.M., van Ness, H.C., and Abbott, M.M., Introduction to Chemical Engineering Thermodynamics, 6th edition, McGraw-Hill, New York, NY, 2001.

20.

Walters, T.W., "Gas-Flow Calculations: Don't Choke", Chemical Engineering, Chemical Week
Associates, Jan. 2000, pp. 70-76.

21.

Walters, T.W., and J.A. Olsen, "Modeling Highly Compressible Flows in Pipe Networks Using a
Graphical User Interface," ASME International Joint Power Generation Conference, Denver, CO,
1997.

- 534 -

Theory and References

22.

Winters, B.A., and T.W. Walters, "X-34 High Pressure Nitrogen Reaction Control System Design
and Analysis," NASA Thermal Fluid Analysis Workshop, Houston, TX, 1997.

Related Topics
Theory and References
Nomenclature
Review of Compressible Flow Theory
Compressible Flow Theory in Single Pipes
Sonic Choking
Role of Pressure Junctions - Detailed Discussion (Long)
Chempak Technical Information - Detailed Discussion
Stagnation Properties
Pipe Material Library References

474
474
477
492
500
510
521
533
535

Pipe Material Library References
Prior to AFT Arrow 6, pipe material properties were compiled from a variety of unofficial sources. Many of
the original sources are now obsolete. Beginning in AFT Arrow 6, pipe material properties are taken directly from national/international standards such as: ASTM, ANSI, AWWA, and ASME. Several new
material standards are being added. For example: DIN and JIS. With the addition of a significant number
of new pipe material standards, the increased volume and scope necessitate splitting the pipe material
library into several smaller independent libraries. All of the pipe material found in AFT Arrow 5 is still available, but is now called "AFT Customary".
Maintaining several independent pipe libraries facilitates including or excluding specific standards. The
Library Browser can be used to "Connect" or Disconnect" each of the pipe material libraries. A list of available pipe libraries can be found below.
Note that while AFT attempts to provide this standard information to make defining pipe information
easier for the user, the prudent engineer will always verify this information against manufacturer specifications. ASTM and ANSI standards exist for the thickness and diameter specifications for some of
these materials. Furthermore, AFT attempts to source reference information from reputable and authoritative sources. However, data for pipe roughness and thermophysical properties including density,
thermal conductivity, modulus of elasticity, and Poisson's ratio have no single standard to follow. Thus,
the user should always check that the pipe material inputs match the actual pipe material data for their
system.
l

l

Copper Pipe - ASTM l

Source = ASTM B42-10

l

Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2; Perry's chem eng Handbook, 7th ed. Table 10-33

Copper Tubing - ASTM -
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l

l

l

l

l

l

l

Source = ASTM B88-09

l

Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2; Perry's chem eng Handbook, 7th ed. Table 10-31; www.cranecopper.com.au/sizes/astmb88.asp

Ductile Iron - ANSI l

Source = ANSI-AWWA C150-A21.50-08

l

Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2

Fiberglass - Green Thread
l

Source = Fiber Glass Systems product data, http://www.nov.com/Segments/Completion_
and_Production_Solutions/Fiber_Glass_Systems/Chemical_Industrial/Green_
Thread.aspx

l

Additional References = ASTM D2996 - 17

HDPE - AFT Customary l

Source = Applied Flow Technology

l

Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2

PVC - ASTM l

Source = ASTM D1785-06

l

Additional References = Thermal data from: Materials Science and Engineering, Callister,
Table C.4

PVDF - AFT Customary l

Source = George Fischer Engineering handbook page 425

l

Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2

Rectangular Duct - AFT Customary l

l

l

l

Source = Applied Flow Technology

Stainless Steel - ANSI l

Source = ASME-B36_19M_2004

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conduct References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for Type 304

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

l

Poisson's Ration Referenecs = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.2845 Table 28-18 for Type 304 @ 20oC

Stainless Tubing - AFT Customary l

Source = Applied Flow Technology

l

Additional References = Thermal conductivity data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2

Steel - AFT Customary -
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l

l

l

l

Source = Applied Flow Technology

l

Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical
Steel

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for
Wrought Carbon Steel, 0.23 C, 0.635 Mn

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

Steel - ANSI l

Source = ASME B36.10-2004

l

Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical
Steel

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for
Wrought Carbon Steel, 0.23 C, 0.635 Mn

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.2845 Table 28-18 for SA-35P12 @ 20oC

l

Additional References = ANSI 36.10, CRANE Technical Paper 410

Steel - DIN 2391-1 l

Source = DIN 2391-1-1994

l

Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical
Steel

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for
Wrought Carbon Steel, 0.23 C, 0.635 Mn

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.2845 Table 28-18 for SA-35P12 @ 20oC

l

Additional References = ANSI 36.10, CRANE Technical Paper 410

Steel - DIN 2458 l

Source = DIN 2458-1981

l

Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical
Steel

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for
Wrought Carbon Steel, 0.23 C, 0.635 Mn

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.2845 Table 28-18 for SA-35P12 @ 20oC

l

Additional References = ANSI 36.10, CRANE Technical Paper 410
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l

l

l

l

Steel - EN 10216-1 (s1) l

Source = BS EN 10216-1-2002

l

Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical
Steel

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for
Wrought Carbon Steel, 0.23 C, 0.635 Mn

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.2845 Table 28-18 for SA-35P12 @ 20oC

l

Additional References = ANSI 36.10, CRANE Technical Paper 410

Steel - EN 10216-2 (s1) l

Source = BS EN 10216-2-2002

l

Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical
Steel

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for
Wrought Carbon Steel, 0.23 C, 0.635 Mn

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.2845 Table 28-18 for SA-35P12 @ 20oC

l

Additional References = ANSI 36.10, CRANE Technical Paper 410

Steel - EN 10217-1 (s1) l

Source = BS EN 10217-1-2002

l

Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical
Steel

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for
Wrought Carbon Steel, 0.23 C, 0.635 Mn

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.2845 Table 28-18 for SA-35P12 @ 20oC

l

Additional References = ANSI 36.10, CRANE Technical Paper 410

Steel - EN 10217-2 (s1) l

Source = BS EN 10217-2-2002

l

Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical
Steel

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for
Wrought Carbon Steel, 0.23 C, 0.635 Mn
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l

l

l

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.2845 Table 28-18 for SA-35P12 @ 20oC

l

Additional References = ANSI 36.10, CRANE Technical Paper 410

Steel - EN 10217-4 (s1) l

Source = BS EN 10217-4-2002

l

Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical
Steel

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for
Wrought Carbon Steel, 0.23 C, 0.635 Mn

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.2845 Table 28-18 for SA-35P12 @ 20oC

l

Additional References = ANSI 36.10, CRANE Technical Paper 410

Steel - EN 10217-5 (s1) l

Source = BS EN 10217-5-2002

l

Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical
Steel

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for
Wrought Carbon Steel, 0.23 C, 0.635 Mn

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.2845 Table 28-18 for SA-35P12 @ 20oC

l

Additional References = ANSI 36.10, CRANE Technical Paper 410

Steel - EN 10217-6 (s1) l

Source = BS EN 10217-6-2002

l

Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for Comerical
Steel

l

Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table A3.3

l

Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for
Wrought Carbon Steel, 0.23 C, 0.635 Mn

l

Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 1997 p.2845 Table 28-18 for SA-35P12 @ 20oC

l

Additional References = ANSI 36.10, CRANE Technical Paper 410
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Library Browser
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Add-on Modules
AFT Arrow has three optional add-on modules which extends modeling capabilities into other areas. The
modules allow multi-variable goal seeking and control simulation, full system sizing, and time varying simulation. The Modules panel withing the Modules group in the Analysis Setup window allows you to activate and enable any of the three AFT Arrow add-on modules. An additional license to the base AFT Arrow
license is required to use a module. These modules include:
l

GSC (Goal Seek & Control) - Identifies output parameters that yield desired output values and simulations control functions.

l

ANS (Automated Network Sizing) - Evaluates the complex interaction of system variables to
reveal combinations of cost savings.

l

XTS (Extended Time Simulation) - Models dynamic system behavior and how critical system parameters vary over time.

Related Topics
Modules Group
Modules Panel

68
69

GSC - Goal Seek & Control
What is the GSC Module?
An optional add-on module to AFT Arrow which allows users to perform multi-variable goal seeking and
simulate system control functions.
Many engineering modeling tasks involve more than just directly solving a system. In some cases a
manual, “cut and try” method of changing input variables to achieve desired operating results is required.
When a single parameter is being changed, the manual process (while tedious and time consuming) can
be used successfully. However, varying two or more parameters at the same time quickly becomes
impractical.
The GSC module automates the process of changing input variables to achieve desired design goals.
For single variable situations, the GSC module offers the advantage of being much faster than manual
methods. Further, it provides a practical tool for solving cases when there are two or more variables.

How Does the GSC Module Work?
The GSC module employs numerical optimization technology like that used in AFT Mercury™. The
optimization engine employed by the AFT Arrow GSC module uses state-of-the-art optimization technology licensed from Vanderplaats Research and Development, the leading company in optimization
technology. However, rather than minimizing some function value such as system cost or weight, the
GSC module satisfies equality criteria using “goal programming” methods.
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The core hydraulic solution in AFT Arrow is performed by the Hydraulic Solver. In standard AFT Arrow
usage, the Hydraulic Solver is called once to solve a system. The GSC module’s Numerical Optimizer is
used to call the Hydraulic Solver repeatedly, thus solving a series of models with different inputs. The
Numerical Optimizer adjusts the user specified Variables in order force the Hydraulic Solver output values to agree with the user specified Goals. Figure 1 depicts the relationship between the different components.

Figure 1: The GSC module flowchart shows how the Hydraulic Solver is called repeatedly in an iterative loop

Using the GSC Module
After AFT Arrow is loaded, the GSC module can be activated or deactivated for use from the Startup window, Tools menu, or Quick Access Panel. Whether or not GSC is activated impacts the Analysis menu,
Model Data window and Output window.
If the GSC module is active, the user can still run models without goal seeking. This is selected under
Goal Seek & Control on the Analysis menu. Hence there are three possibilities for GSC.
l

GSC is not active

l

GSC is active and goal seeking is ignored

l

GSC is active and goal seeking is performed

Related Topics
Modules Panel
Add-on Modules
ANS - Automated Network Sizing
XTS - Extended Time Simulation
Goal Seek and Control Group
Variables Panel
Goals Panel

69
541
552
637
90
91
95
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Numerical Controls Panel
Goal Seek & Control in Model Data
GSC in Output
GSC in Scenarios
Changing Input Values to GSC Results
Goal Seek and Control Troubleshooting

100
543
545
545
546
547

Related Examples
Beginner: Heat Transfer in a Pipe - GSC
Steam Relief System - GSC
Natural Gas Burner - GSC
Compressed Air System - GSC
Process Steam System - GSC

820
829
833
839
846

Goal Seek & Control in Model Data
When the GSC module is active, the Model Data window displays a list of all variables and goals in the
General section. This is useful for documentation purposes. See Figure 1.
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Figure 1: Model Data window shows the variable and goal input data

Related Topics
GSC - Goal Seek & Control
GSC in Output
GSC in Scenarios
Changing Input Values to GSC Results
Goal Seek and Control Troubleshooting

541
545
545
546
547
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GSC in Output
The results for a Goal Seek & Control run are displayed in the Output window in the general section in
two tables called GSC Variables and GSC Goals (see Figure 1).

Figure 1: Calculated GSC Variables table (top) shows values required to achieve goals. GSC Goals table (bottom) shows user’s goals and actual values achieved (these should match).

Related Topics
Exporting to Excel
Cost Report
Critical Warnings, Warnings, and Cautions
GSC - Goal Seek & Control
Goal Seek & Control in Model Data
GSC in Scenarios
Changing Input Values to GSC Results
Goal Seek and Control Troubleshooting

387
447
663
541
543
545
546
547

Related Examples
Beginner: Heat Transfer in a Pipe - GSC
Compressed Air System - GSC
Process Steam System - GSC
Steam Relief System - GSC

820
839
846
829

GSC in Scenarios
GSC variables and goals will appear in all scenarios. In other words, you cannot create a variable or goal
that will appear in some scenarios and not others. Deleting a variable or goal in one scenario will delete it
in all scenarios. However, the application of variables and goals can differ from scenario to scenario. This
allows you to perform goal seeking with different variables and goals being used in different scenarios.
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Related Topics
GSC - Goal Seek & Control
Goal Seek & Control in Model Data
GSC in Output
Changing Input Values to GSC Results
Goal Seek and Control Troubleshooting

541
543
545
546
547

Changing Input Values to GSC Results
As discussed previously, the Output window GSC Variables tab indicates how the input parameters
must be varied to satisfy the goals. Once you have these results, you may want to keep and use them in
the model. There are two ways to do this: Transferring Results to Initial and generating a Disconnected
Scenario.

Transferring Results to Initial
In general, the Output window supports a feature called "Transfer Results to Initial Guesses". This is
available on the Edit menu. When used without the GSC module, it transfers calculated results for flow,
pressure and temperature to the initial guess values of the pipes and junctions. When used after a GSC
run it gives you three options: to transfer the GSC Variable Data only, transfer the calculated results
only, or transfer both.
If you choose either of the first two options that transfer GSC Variable Data, the junction data on the
Properties window will be changed to the GSC Variable results. This means that one could then choose
to Ignore goal seeking, re-run the model, and obtain the same results as before.

Generating a Disconnected Scenario
After a run is complete, a special type of scenario can be created called a disconnected scenario. A disconnected scenario itself breaks the inheritance of normal child scenarios so that it is truly standalone
scenario. This is ideal for GSC results in that it may not make sense to save the GSC results for future
use if the model can otherwise be changed in arbitrary ways - if the model were changed the GSC results would be invalidated, meaning the user would need to rerun GSC.
For example, assume a GSC run is made to find the valve open position required to achieve a certain
flow. If this result is saved, and then the pipe size is later changed, the valve open position would no
longer supply the desired flow.
Creating a disconnected scenario helps prevent changes to the scenario since disconnected scenarios
cannot be changed by propagated changes from other scenarios.

Related Topics
GSC - Goal Seek & Control

541
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Goal Seek & Control in Model Data
GSC in Output
GSC in Scenarios
Goal Seek and Control Troubleshooting

543
545
545
547

Goal Seek and Control Troubleshooting
l

When Goals Cannot Be Achieved

l

Goal Seek and Control Adjustments

l

What To Do if the Solver Gets Stuck in GSC

l

Goal Seek and Control Inconsistencies

Related Topics
GSC - Goal Seek & Control
Goal Seek & Control in Model Data
GSC in Output
GSC in Scenarios
Changing Input Values to GSC Results

541
543
545
545
546

When Goals Cannot Be Achieved
In some cases the GSC module may not be able to achieve a goal. This can happen for the following
reasons:
l

A goal is not physically realistic

l

A better starting point is needed for the input values assigned as GSC Variables

l

Hydraulic solution tolerances or optimizer numerical parameters require adjustment

In such cases, the goal will not be satisfied in the results. In other words, the Actual Goal Value and User
Goal Value will differ (Figure 1).
In all cases the user will be warned when goals were not met. Figure 1 shows the Output window with
such a warning.
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Figure 1: Warning display in Output window when a goal cannot be met

Physically unrealistic goals
It may be possible that a goal is not achievable because it is not physically possible. For
example, a compressor/fan may be too small to satisfy a flowrate goal at some pipe.
To determine whether a goal is unrealistic, try changing the goal and rerunning the model. If the goal can
be met in some cases and not others, this is an indicator that the original goal was unrealistic.

Better starting point needed
In some cases the goal may be so far away from the original model that the GSC module has difficulty
finding a solution. This is not common, but it is worth trying to adjust the starting point of parameters
which are being varied.

Changing control parameters
The Numerical Optimizer determines goal search directions by approximating a gradient based on perturbed variable values. By default it uses a central difference approximation, but forward difference can
also be used. If the hydraulic solution is not converged to a sufficiently small tolerance, the gradient
approximation will not be sufficiently accurate and hence a good search direction cannot be obtained.
The end result is that the goal seeking fails.
There are two general areas that can be changed in such cases: the hydraulic solution tolerances in the
Tolerance panel, and numerical control parameters in the Numerical Controls panel.
In the next few sections recommendations on how to manually change these parameters will be given.
However, before making a manual change it is definitely worth trying the automated parameter adjustment feature.
Figure 1, bottom picture, shows the warning when a goal is not met, and also shows a recommendation
and suggests pressing the “F2” key. When doing so, a window appears as shown in Figure 2. This
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window will offer up to three options for automatic parameter adjustment. It is typically a good idea to
accept the default changes, click OK, and rerun the model.
The purpose of the Figure 2 window is to simplify for the user making common changes to resolve goal
seeking problems.

Figure 2: When goal seeking fails, pressing the F2 key will show this window which allows the user to automatically implement recommend numerical parameter adjustments

Caution: The user should be very cautious in manually changing parameters in the Tolerance panel
and the Numerical Controls panel. Making changes without a good understanding of the parameters involved can lead to incorrect results.
l

Changing tolerance in Steady Solution Control Group >Tolerance panel- By default AFT
Arrow uses Relative Tolerance criteria set to 0.0001 (see Figure 3). Goal seeking convergence
can sometimes be improved by reducing these values to 0.00001 or 0.000001.

See Tolerance panel for a more in-depth discussion.
l

Changing goal seeking numerical control - Figure 4 shows the Numerical Controls panel in
Analysis Setup. The most useful parameter one can adjust is the Relative Finite Difference Step
Size. Using values between 0.01 and 0.001 are recommended. In some cases using a value as
high as 0.1 may be tried.

l

Changing Multi-Variable Goal Weighting - When two or more variables (and, hence two or
more goals) are applied, the relative influence of each goal is important. By default, the GSC module "normalizes" each goal. This means that the difference between each goal and the current
value is divided through by the goal. A Root Mean Square (RMS) of all normalized values is then
taken, and this function is then driven to zero. The normalization approach tends to work better in
cases where the numerical values of different goals are very different.

There are two other options available. These can be selected on the Numerical Controls panel (Figure 4).
The second option is to not normalize the goals. Each goal is then subtracted from the current value, and
an RMS is taken of the differences. This becomes the function that is driven to zero. This method tends to
work best when the numerical values of the goals are similar in magnitude.
A final option is for the user to input weighting factors. This approach uses the normalized approach
described previously, but multiplies each normalized value by a user specified weighting factor before
performing the RMS. The general approach here is if one or more of the goals is not being reached,
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increase its weighting factor. The weighting factors are entered into a column in the goals table on the
Goals panel. This column will become visible when the third option is chosen.

Figure 3: Reducing tolerance criteria may resolve goal seeking difficulties

Figure 4: Changing certain numerical control parameters in the Numerical Controls panel may resolve goal
seeking difficulties

Related Topics
Goal Seek and Control Troubleshooting

547
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What To Do if the Solver Gets Stuck in GSC
Goal Seek and Control Adjustments
Goal Seek and Control Inconsistencies
GSC Goal may not be valid
Goals Panel

551
551
552
670
95

Goal Seek and Control Adjustments
When a GSC run results in the goals not being met, the user may want to adjust GSC search numerical
control parameters or standard Solution Control parameters. These can be automatically adjusted after a
run if a warning has been displayed and the user is prompted to press the F2 function key. When the user
does this, recommended changes are offered which the user can choose to have automatically applied.
The changes will affect either the Goal Seek and Control Group in Analysis Setup and/or the Steady Solution Control Group.

Related Topics
Goal Seek and Control Troubleshooting
When Goals Cannot Be Achieved
What To Do if the Solver Gets Stuck in GSC
Goal Seek and Control Inconsistencies

547
547
551
552

What To Do if the Solver Gets Stuck in GSC
Figure 1 of the Introduction to the GSC Module depicts the logic of how the Hydraulic Solver and Numerical Optimizer work together. Discussed elsewhere is the issue of physically unrealistic goals. Occasionally the user may have specified a goal which is in fact physically realistic, but in the process of going
from a physically realistic starting point to a similarly physically realistic goal, a physically unrealistic system may be proposed by the Numerical Optimizer. What happens in such cases?
When performing goal seeking with the GSC module, AFT Arrow has been designed to gracefully
handle such cases. One of two things will typically happen:
l

The Hydraulic Solver will experience a computational error

l

The Hydraulic Solver will not be able to converge

In the first case, AFT Arrow does not stop and tell the user of the error, but instead sets an internal flag
that the system used for the particular iteration that caused the error was a poor system and should not
be considered further by the Numerical Optimizer. In other words, it skips the system that caused the
error. This will happen in a way which is transparent to the user and requires no intervention.
The second case is of more interest here. In this case the Hydraulic Solver gets stuck on one of the systems proposed by the Numerical Optimizer and cannot progress. The Hydraulic Solver will continue trying to converge until it reaches the iteration limit. Once it reaches that limit, it will react in a similar way to
the first case above – it will set a flag and skip that system.
However, the default maximum number of iterations is 50,000 (specified in the Iterations panel). It is perfectly fine for one to wait until this limit is reached and allow the AFT Arrow to handle the situation
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automatically, but depending on the size of the model it may take awhile to get to 50,000 iterations. In
such cases it may be desirable to allow AFT Arrow to more quickly conclude the model will not converge
by reducing the maximum iterations to something like 5,000.
Tip: If the Hydraulic Solver appears to get stuck while performing a GSC run, you can pause the
Solver, open the Steady Solution Control group from the Other Actions menu, and reduce the
Maximum Iterations. The default value is 50,000. Depending on the model size, a reduced value
of 5,000 may be appropriate.

Related Topics
Goal Seek and Control Troubleshooting
When Goals Cannot Be Achieved
Goal Seek and Control Adjustments
Goal Seek and Control Inconsistencies

547
547
551
552

Goal Seek and Control Inconsistencies
If an object in the Goal Seek and Control group is defined with a parameter that has not been defined in
that object's property window, an error will appear stating "Junction XX does not have XX parameter
modeled. Cannot use as a GSC variable."
In this case, the user may resolve this inconsistency by either selecting a different parameter for the variable in the Goal Seek and Control group, or by changing the specified junction to be defined using the
specified variable.

Related Topics
Goal Seek and Control Troubleshooting
When Goals Cannot Be Achieved
What To Do if the Solver Gets Stuck in GSC
Goal Seek and Control Adjustments

547
547
551
551

ANS - Automated Network Sizing
What is the Automated Network Sizing (ANS) module?
Sizing a single pipe or a single compressor for minimum cost is relatively straightforward with manual iteration. When considering a network of pipes, the manual approach of selecting cheaper components one
at a time quickly becomes not only impractical, but ineffective. While manual component selection can
certainly reduce cost, it often does not result in a minimized cost.
The path to minimizing cost is often unintuitive. Replacing certain components with more expensive ones
often results in a lower total system cost. Solving such a problem - with dozens or perhaps hundreds of
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variables - cannot reasonably be completed by hand. A computational approach quickly finds ways to
reduce cost that may never be found by other means.
In addition, components cannot be arbitrarily changed without impacting overall operation. Any given system has certain requirements that must be met. Reducing pipe sizes too much, for example, may result in
flow rates that are unacceptably low. There is a balance between reducing cost and providing the desired
operation. The ANS module automates this process, minimizing the cost of complex systems while still
meeting requirements with ease.
Note: ANS is not designed to be a cost estimator. It instead offers an approach for comparing potential designs using cost as a common denominator. The value of ANS is in the minimization of
cost, not the precise estimation of total cost.

Using the ANS Module
The ANS module can be enabled from the Modules panel in Analysis Setup. Activating ANS adds the
Automated Sizing item to the Analysis menu, and enabling ANS affects many areas of the AFT Arrow
interface.
If the ANS module is active, models can still be run without ANS by selecting Analysis > Automated Sizing > Not Used. It is also possible to run models without sizing by selecting Do Not Size in the Sizing
Method panel. These options create three distinct possibilities:
l

ANS is not active - this is standard AFT Arrow mode.

l

ANS is active, but not sizing - the Sizing Window and Sizing panels are visible but will not be
used in simulation.

l

ANS is active and sizing - the Sizing Window and Sizing panels are visible and the settings are
applied during simulation.

Examples
ANS is best understood by sizing a model yourself. We have created several examples to help walk you
through what is required with ANS: ANS Examples.

Related Topics
Modules Panel
Add-on Modules
GSC - Goal Seek & Control
XTS - Extended Time Simulation
Automatic Sizing Group
Sizing Summary Panel
Sizing Fundamentals
Sizing Window
Solution Progress with ANS

69
541
541
637
141
141
554
568
589
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Sizing Results
Workspace Integration
Junction Loss Factors
Improving and Troubleshooting the Sizing Process

591
592
594
594

Related Examples
Beginner: Three Tank Steam System - ANS
Control Valve - ANS
Air Distribution, Creating Libraries - ANS
Air Distribution - ANS
Air Distribution, Multiple Design Cases - ANS
Helium Transfer - ANS
Natural Gas Burner - ANS
Process Steam System - ANS
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888
913
922
932
948

Related Blogs
What is the ANS Module Asking For? Introduction to the Sizing window in the ANS Add-on Module

Sizing Fundamentals
How Does the ANS Module Work?
ANS is built to allow you to approach the automated sizing process in a way appropriate to your system.
You must specify an Objective - minimizing or maximizing a specific system variable. Most commonly, the ultimate Objective is to minimize monetary cost.
The pipes to be sized must be defined - any given pipe may be included or excluded from the automated
sizing process. It may not be desired to automatically size every pipe in the entire system independently.
It is common that groups of pipes - such as those in a header - must be of equal size. This is accomplished by placing them into Common Size Groups - sets of pipes that are automatically sized but
must all be the same size.
The selection of piping is generally restricted to certain materials, sizes, and types independent of fluid
flow concerns. Perhaps certain system piping must be Stainless Steel of any common size, whereas
other piping in the system can be regular Steel, but is limited to three on-hand diameters. These are represented with Candidate Sets - selections of pipe sizes and types that are allowed.
If the only goal is to minimize cost, the answer is trivial - select the smallest pipe sizes available. Clearly,
this is not practical as systems are not built for the sake of being inexpensive, but are meant to accomplish some goal. These goals, such as minimum flows or pressures, are Design Requirements.
Any number of Design Requirements can be specified in a system, controlling the allowed fluid behavior.
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There are several different Sizing Methods available. These methods approach the same Objective in
different ways, with certain methods being more appropriate for certain systems. Agreement between
methods is a strong indication that the ideal sizes have been selected.

Analysis vs. Design
Sizing a system to minimize or maximize a system-wide quantity like monetary cost or pipe weight is a
complex process with many considerations. AFT Arrow is foremost an analysis tool, but the ANS module
is a design tool. While closely related, analysis and design are different in many ways.
Engineering analysis is the process of using accepted calculation methods to predict the behavior of a
given system. Analysis requires the full specification of the system before calculations are made. For
example, fundamental fluid equations can be used to determine the flow in a pipe of a known size.
When a new system is being designed, the pipe size is not known. Instead, it might be desired to find the
size necessary to meet a minimum flow. The engineer can make an educated guess, perform the analysis, modify the size, and repeat the process. The analytical methods are used iteratively to arrive at a
final design.
Even for a simple problem, the iterative Specify Model > Analyze > Investigate Results > Adjust Model
method can be very inefficient. For simple systems, it is often possible to solve for a design variable by
manipulating the fundamental equations. This would allow the process to be completed in one design iteration.
For complex problems direct solutions are impractical or impossible. Instead, the iterative method can be
applied with numerical methods. AFT Arrow already automates the "Specify Model > Analyze" portion of
the process. AFT Arrow ANS further simplifies the process by using intelligent searching algorithms to
automate the "Investigate Results > Adjust Model" steps.
By providing ANS with information on the requirements of a system, it offers a true design-oriented
approach, automating a complex iterative process.

Related Topics
Objective
Design Requirement
Feasible and Infeasible Designs
Active, Inactive, and Violated Design Requirements
Discrete and Continuous Sizing
Multiple Operating Cases
Common Size Group
Initial Costs and Recurring Costs
Candidate Set
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Related Examples
Beginner: Three Tank Steam System - ANS
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Objective
The Objective is the goal of the sizing process - the variable of concern and whether it should be minimized or maximized.
A valid Objective variable must be calculable as a total for any potential system configuration. For
example, a system can be sized to minimize or maximize weight because any pipe has a weight measured in a common unit. However, different pipes may have different pressure ratings - it does not make
sense to maximize or minimize pressure rating as they cannot be added together and retain the same
meaning. Further, the value must be available for all possible configurations - if some pipe sizes are of
unknown weight, the sizing cannot proceed effectively because it is unknown whether choosing that size
is an improvement or not.
The Objective is defined on the Sizing Objective panel.

Conceptual Example
Consider a simple problem - moving fluid from one large tank to another. The pressures in the tanks are
fixed. The fluid must be transferred in a pipe of specialized material, and it is difficult to manufacture this
material in small diameters, making them more expensive. The Objective is to select the cheapest pipe
possible for the task.

Figure 1: Cost for different diameters of specialized piping

Clearly, there is a minimum cost between diameters "4" and "5."
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Figure 2: Locating the Diameter with minimum cost

However, what if we are limited by other requirements? For example, we may have a minimum flow rate.
This is a Design Requirement, and makes the problem more complex.

Related Topics
Sizing Fundamentals
Design Requirement
Feasible and Infeasible Designs
Active, Inactive, and Violated Design Requirements
Discrete and Continuous Sizing
Multiple Operating Cases
Common Size Group
Initial Costs and Recurring Costs
Candidate Set

554
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Related Examples
Beginner: Three Tank Steam System - ANS
Air Distribution - ANS
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Design Requirement
A real system has Design Requirements - specific parameters that must be met, regardless of the
Objective value. Targeting an Objective without any other associated requirements is not meaningful. If
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a system is not attempting to achieve some goal, then the minimum cost is zero as no system is required.
The Objective alone may be "How can I drive my cost to a minimum?" but the question really on the
designer's mind is "How can I drive my cost to a minimum while maintaining desired operation?"
Design Requirements are defined on the Design Requirement panel.
Note: There is a distinction between a boundary and a Design Requirement. Boundaries represent a
physically forced flow or pressure while Design Requirements represent desired behavior.
See Boundaries vs. Design Requirements for further discussion.

Conceptual Example
Continuing with our example, we want to minimize the cost of some pipe. However, there is a minimum
flow rate. This is a Design Requirement and limits the possible solutions. In our example, flow rate follows a predictable relationship with diameter.

Figure 1: Flow Rates for different diameters, showing the minimum required for our pipe

Our pipe has a Design Requirement that flow rate is at least "150", which indicates a minimum diameter
between "6" and "7."
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Figure 2: Minimum diameter indirectly imposed by flow rate requirement

Adding Design Requirements may influence the sizing results as this requirement makes certain solutions Infeasible.

Related Topics
Sizing Fundamentals
Objective
Feasible and Infeasible Designs
Active, Inactive, and Violated Design Requirements
Discrete and Continuous Sizing
Multiple Operating Cases
Common Size Group
Initial Costs and Recurring Costs
Candidate Set
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Related Examples
Beginner: Three Tank Steam System - ANS
Process Steam System - ANS

Feasible and Infeasible Designs
If a system has Design Requirements, there will be designs unable to meet the requirements. These
designs are termed Infeasible - configurations that violate Design Requirements. Likewise, configurations that meet all Design Requirements are Feasible.
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Feasibility can be determined without any knowledge of the Objective. While it is not directly related to
the Objective, feasibility can heavily influence the sizing process. It is typical that the ideal solutions are
infeasible because they do not meet the Design Requirements. Instead, the best solution is where the
Objective is met in the feasible space. Not all Design Requirements will impact the sizing in the same
way.
It is important not to confuse infeasible design with impossible design. A potential design being infeasible
does not mean that the system could not be built as specified. In fact, it is possible that the system could
run quite well. It only means that a specified Design Requirement has been violated.

Conceptual Example
We previously added a Design Requirement to our pipe, which makes certain designs Infeasible. The
minimum flow rate Design Requirement requires a minimum diameter.

Figure 1: Certain diameters are infeasible when a Design Requirement is added

Clearly, our best case minimum cost is now in the Infeasible region. This would still be the cheapest pipe
to select, but would limit flow too much. Instead, we need to find the minimum cost within the feasible
region.
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Figure 2: Minimum Feasible Cost

Because our cost only increases with diameters larger than our minimum, the best case cost is now the
minimum diameter possible due to the flow requirement. This means that the Design Requirement is Active.

Related Topics
Sizing Fundamentals
Objective
Design Requirement
Active, Inactive, and Violated Design Requirements
Discrete and Continuous Sizing
Multiple Operating Cases
Common Size Group
Initial Costs and Recurring Costs
Candidate Set
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Active, Inactive, and Violated Design Requirements
Design Requirements may or may not drive the sizing solution. Design Requirements are Active if
they drive the sizing solution. Design Requirements that have no impact on the sizing solution
are Inactive.
There can easily be Design Requirements that, while important for normal operation, do not drive the sizing solution because violating them would not improve the Objective. These Inactive Design Requirements could be removed entirely without changing the sizing solution.
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It is not always easy to tell what Design Requirements will be Active or Inactive. A better overall solution
can easily often obtained by making a local selection more expensive. This means that Design Requirements that would appear to only affect high-cost options may in fact be Active.
Knowing which Design Requirements are Active or Inactive in a sizing analysis can provide valuable
insight into a design. Perhaps one Design Requirement is significantly increasing the cost of the system,
but is not critical to the operation. In such cases it may be worthwhile to relax the restriction and modify
the Design Requirement for a cheaper solution.
A Design Requirement is Violated if it is not met. During the sizing process it is common that Design
Requirements will be Violated. However, if a solution exists, they should only be Active or Inactive in the
final result.

Conceptual Example
Adding a specific Design Requirement to our pipe changed the sizing solution. What if we had also
added a maximum flow rate, effectively imposing a maximum diameter? It will not impact the sizing solution, despite it being an important consideration for our system. Our original Design Requirement is considered Active, because it is driving the sizing solution, while the second Design Requirement is
considered Inactive. As before, the absolute minimum cost diameter would Violate our minimum flow
requirement, making it infeasible.

Figure 1: Multiple Design Requirements

Piping is generally not available in any requested size, but instead only in selected, Discrete diameters,
which will also affect the sizing solution.

Related Topics
Sizing Fundamentals

554
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Objective
Design Requirement
Feasible and Infeasible Designs
Discrete and Continuous Sizing
Multiple Operating Cases
Common Size Group
Initial Costs and Recurring Costs
Candidate Set
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Discrete and Continuous Sizing
Continuous sizing considers any physical diameter in a given range. The ideal solution of a
Continuous sizing will contain fractional sizes. However, piping is generally only available in Discrete
sizes - a selection of individual, unique diameters.
It is assumed during a Continuous sizing that the Objective value varies linearly between intermediate
sizes. For monetary cost, this is highly unlikely to be the case - custom pipe of unusual diameter would be
very expensive. Continuous sizing is useful because it is generally a far easier problem to mathematically
solve. On its own, it will give the engineer a good idea of what the ideal system and best-case Objective
value looks like. Coupled with a Discrete sizing method, the Continuous sizing result provides an excellent starting point, making the mathematical solution easier.
Continuous sizing methods also generally require less input as they are less restrictive. Starting the sizing process on a Continuous basis is often a good idea at it can reveal potential problems or areas of
improvement earlier in the design process.
The selection between Continuous or Discrete is defined on the Sizing Method panel.

Conceptual Example
Our example has so far been a Continuous sizing problem - we are able to select any size of pipe to drive
the cost to an absolute minimum. However, the piping is only available in Discrete sizes. This fact will
impact the sizing solution and the resulting cost.
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Figure 1: Minimum Feasible Discrete Size

The minimum flow Design Requirement is still considered Active in this case, as it is still driving the sizing
solution.
Note: In our example, the cost of diameter "7" is almost double the cost of diameter "6." In such a
case, it may warrant further investigation into why the minimum flow rate is required. If the minimum flow was imposed as a rule of thumb or for a non-critical reason, it is well worth considering violating this Design Requirement and selecting size "6" for the cost savings.

Related Topics
Sizing Fundamentals
Objective
Design Requirement
Feasible and Infeasible Designs
Active, Inactive, and Violated Design Requirements
Multiple Operating Cases
Common Size Group
Initial Costs and Recurring Costs
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Multiple Operating Cases
Sizing a system has many affects in addition to saving on quantities like weight or monetary cost. The
operating capabilities of the system are impacted by any sizing decision. What may work well for one situation may not work well for another situation. Furthermore, the ideal design for a system that must operate in more than one way may not simply be the ideal design of one of the cases.
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In other words, repeatedly sizing the same system for individual multiple operating cases may not result
in the ideal design.
By sizing multiple operating cases in parallel, it is possible to account for these variations and
still obtain an ideal design in just one sizing simulation. We call these operating cases Dependent Design Cases.
This can be enabled on the Sizing Objective panel, with the Dependent Design Cases panel showing
details on the process and model configuration.

Conceptual Example
Minimizing the size of a pipe with a Design Requirement of a minimum flow is relatively straightforward
when only one situation must be considered.
However, consider if our example had multiple operating, or Dependent Design Cases. For example,
the pressures in the tanks may vary depending on the time of day, the required flow rate may vary with
demand, and the environment may vary which could affect the system through thermal affects.
The minimum pipe size found without considering these situations may violate a Design Requirement
in other cases. Clearly, this cannot be allowed. While some attempt could be made by the engineer to
determine the "most severe" case and size for that case, this is often very difficult and can easily neglect
potential savings. Instead, by leveraging Dependent Designs, we can account for these variations directly in the model.

Related Topics
Sizing Fundamentals
Objective
Design Requirement
Feasible and Infeasible Designs
Active, Inactive, and Violated Design Requirements
Discrete and Continuous Sizing
Common Size Group
Initial Costs and Recurring Costs
Candidate Set
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Related Examples
Air Distribution, Multiple Design Cases - ANS
Helium Transfer - ANS
Natural Gas Burner - ANS

Common Size Group
A Common Size Group is a group of pipes that must be of uniform size.
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There are two reasons to create Common Size Groups:
l

Physical Requirements - All of the pipes in the group must be the same size in the field. For
example, a long header may be drawn on the Workspace as a series of individual pipe objects.
Adding these individual pipes to a Common Size Group forces the entire header to be a common
size. If the pipes were not placed in a Common Size Group, it is likely that different sizes would be
selected for different sections of the header. Requirements based on pipe connections are also
common - it would not be unusual to require equal diameter piping upstream and downstream of a
valve or other junction.

l

Reduction in Complexity - Every additional independently sized pipe increases the difficulty of
the sizing problem. Sizing problems with large numbers of independently sized pipes can take
extremely long to solve, often for relatively little benefit. This is especially true when the resulting
pipe sizes are similar, or when the cost of a particular pipe has minimal impact on the overall cost.
For example, parallel pipes would often be expected to have the same size, and short connector
pipes will likely have no significant bearing on overall cost if there are much longer pipes being
sized. By adding these types of pipes to a Common Size Group, the solution time can be dramatically reduced.

Common Size Groups are defined in the Size/Cost Assignments panel.

Related Topics
Sizing Fundamentals
Objective
Design Requirement
Feasible and Infeasible Designs
Active, Inactive, and Violated Design Requirements
Discrete and Continuous Sizing
Multiple Operating Cases
Initial Costs and Recurring Costs
Candidate Set
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Related Examples
Control Valve - ANS
Air Distribution - ANS
Process Steam System - ANS
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Initial Costs and Recurring Costs
Systems can be sized for a variety of costs. Most notably, there are Initial Costs and Recurring Costs.
The sum of the Initial Costs and Recurring Costs over the expected system lifetime is known as Life
Cycle Cost.
Initial Costs include any one-time cost that is required to get the system in question operational. Most
often, this is a combination of Material and Installation costs.
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Recurring Costs include any cost that accrues over time. This could be fixed costs at regular intervals,
such as the cost of routine Maintenance. It can also be the potentially variable cost of Energy to run compressors.
Note: Costs must be defined in Cost Libraries, which are available as part of the base application.

Figure 1: Components of Life Cycle Cost

Keep in mind when considering what costs to include what your most significant cost is likely to be. Systems are often designed to run for many years. This generally means that the total cost of running the system ends up as much more than the cost of building it. Fully defining the sizing input for minimizing Life
Cycle Cost is more difficult, but often worthwhile. The inclusion of cost components is defined in the Sizing Objective panel.

Figure 2: Potential distribution of costs for a long System Life

Related Topics
Sizing Fundamentals
Objective
Design Requirement
Feasible and Infeasible Designs
Active, Inactive, and Violated Design Requirements
Discrete and Continuous Sizing
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Multiple Operating Cases
Common Size Group
Candidate Set

564
565
568

Related Examples
Air Distribution - ANS
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Candidate Set
A Candidate Set is a set of allowed pipe sizes. All pipes that are being sized must be associated with a
Candidate Set.
The Candidate Set is required for both Discrete and Continuous Sizing. In continuous sizing it is used to
determine a minimum and maximum pipe size. The intermediate sizes are only used if sizing is done on a
discrete basis.
Multiple Candidate Sets can exist, but only one can be applied to any given pipe or Common Size Group.
Candidate Sets, and their assignment to pipes, are defined on the Candidate Sets panel.

Related Topics
Sizing Fundamentals
Objective
Design Requirement
Feasible and Infeasible Designs
Active, Inactive, and Violated Design Requirements
Discrete and Continuous Sizing
Multiple Operating Cases
Common Size Group
Initial Costs and Recurring Costs
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Related Examples
Beginner: Three Tank Steam System - ANS
Process Steam System - ANS

Sizing Window
The Sizing Window is a sixth Primary Window that appears when the ANS module is activated and
enabled.
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Figure 1: The Sizing Window

The Sizing Window contains all of the information required to define a sizing analysis. Other areas of AFT
Arrow interact with the definition of sizing parameters, but ultimately all changes are reflected here. The
Sizing Window is further divided into Sizing panels.

Figure 2: Sizing Navigation

Each Sizing panel serves a certain purpose in the sizing process.
l

Sizing Objective panel - What parameter should be minimized or maximized?

l

Size/Cost Assignments panel - What pipes or junctions should be sized, which should be counted
in the cost total, and how should they be grouped together?

l

Candidate Sets panel - What materials, sizes, and types of pipes can be considered in the sizing
process?

l

Design Requirements panel - What requirements does the system have?

l

Assign Cost Libraries panel - If optimizing on cost, what is the source of the cost data?

l

Sizing Method panel - What type of sizing should be completed and what method should be used?

l

Dependent Design Cases panel - What operational variations must the sizing analysis account
for?

l

Sizing Summary panel - How are the sizing settings currently applied to the system?

Panel Locks
Every Sizing panel can be individually locked to prevent accidental changes.

Figure 3: Locking panels

Related Topics
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Sizing Objective Panel
Size/Cost Assignments Panel
Candidate Sets Panel
Design Requirement Panel
Assign Cost Libraries Panel
Sizing Method Panel
Dependent Design Cases Panel
Sizing Summary Panel
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Related Examples
Beginner: Three Tank Steam System - ANS
Control Valve - ANS
Air Distribution, Creating Libraries - ANS
Air Distribution - ANS
Air Distribution, Multiple Design Cases - ANS
Helium Transfer - ANS
Natural Gas Burner - ANS
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Related Blogs
What is the ANS Module Asking For? Introduction to the Sizing window in the ANS Add-on Module

Sizing Objective Panel
Sizing Options

l

Perform Sizing - The best case selection of pipe sizes will be determined based on the various
Sizing Window settings.

l

Calculate Cost, Do Not Size - Pipe sizes will not change from their initial, user-defined size. The
costs of the system as-defined will be calculated.
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l

Do Not Size - No sizing or cost calculations will be carried out. This is equivalent to temporarily
disabling ANS.

Objective
The Objective is the goal of the automated sizing process. Any of the listed parameters can be minimized
or maximized.
l

Pipe Weight - Calculated using the pipe material density and dimensions from the internal pipe
material library for the pipes being sized.

l

Pipe and Fluid Weight - Calculated using the pipe material density and dimensions from the
internal pipe material library, as well as the fluid density defined in the Fluid panel

l

Flow Volume - The total volume of fluid in the pipes calculated from the inner diameter and geometry defined in the Pipe Properties window.

l

Pipe Inner Surface Area - The internal surface area of the pipes calculated using the inner diameter and geometry defined in the Pipe Properties window.

l

Monetary Cost - The monetary value of the pipes/junctions calculated from the user provided
cost libraries

Minimizing a physical parameter such as weight, volume, or surface area is often a good approximation
of minimizing Initial Cost. These options are also useful in specific cases were monetary cost of the fluid
system is not the primary concern.

Other Options

By default, all sizing panels are locked after a simulation is run. Modifying sizing input will require unlocking the panel.
It is possible to model multiple operating cases simultaneously by enabling Dependent Design Cases.
The Dependent Design Cases panel is hidden unless it is enabled here.

Monetary Cost Options
There are several considerations to be made when considering the total Monetary Cost of a piping network. Is the Initial Cost of the Materials required the only concern? Do Installation Costs have to be
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accounted for? The true cost of a system could be considered its Life Cycle Cost - how much does it cost
not only to build the system, but to run and maintain it? These are all valid approaches to the challenge of
minimizing cost, and each requires different input.

l

Size for Initial Cost - Material and Installation Costs will be used to size the system.

l

Size for Initial Cost, Show Energy Costs - Material and Installation Costs will be used to size
the system. Energy cost does not impact the sizing, but will be displayed. This may be helpful to
determine if it is worthwhile to resize the system considering Recurring Costs.

l

Size for Initial and Recurring Costs - Energy Cost is considered in the sizing, along with Material and Installation Cost.

l

User Specified - Custom sizings are possible by selecting the appropriate radio buttons. For
example, if Installation Costs are not readily available, these can be ignored by changing that row
to Ignore Cost.

Note: The Sizing Level affects the available options. If the overall Sizing Level is "Do Not Size" then no
sizing can take place and this will be reflected by forcing all cost rows to Ignore Cost.
l

Warn When Fittings & Losses Costs are Missing - By default, ANS will warn the user
whenever costs are missing for any Fitting & Loss defined within a sized pipe. For the most accurate solution, these costs should be included, however, they are often small compared to other
costs and this option allows ignoring those warnings.

Recurring Cost Options
If any Recurring Costs is specified to be included in the Cost Report or Sizing, additional input is required.
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l

System Life (For Recurring Costs) - The period for which the Recurring Costs are counted.
Interest and Inflation Rates can optionally be specified.

l

Energy Cost - Only enabled if Energy is included in the Cost Report or Sizing.

l

l

Use Energy Cost Libraries - Use Cost Libraries for energy cost.

l

Use This Energy Cost Information - Specify a monetary cost for energy directly. If this is
specified, Energy Cost Libraries will not be utilized.

Initial Cost Limit - Limits the total amount allowed for Initial Cost. A higher initial cost may result
in a lower Life Cycle cost, but it is sometimes the case that there is an absolute limit on initial
spending.

Related Topics
Sizing Window
Size/Cost Assignments Panel
Candidate Sets Panel
Design Requirement Panel
Assign Cost Libraries Panel
Sizing Method Panel
Dependent Design Cases Panel
Sizing Summary Panel

568
574
577
580
581
583
585
587

Related Examples
Beginner: Three Tank Steam System - ANS
Air Distribution - ANS
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Related Blogs
What is the ANS Module Asking For? Introduction to the Sizing window in the ANS Add-on Module

Size/Cost Assignments Panel
The Size/Cost Assignments panel defines which components are to be included or excluded from sizing
and cost reporting. Buttons across the top of the panel display selections for a specific component type.

Pipes
The options for pipes include including or excluding them from sizing, including or excluding from cost,
including in cost only if size changes, and collecting the pipes into Common Size Groups.
l

Sizing and Cost Options - This section of the table controls sizing and cost calculation.
l

l

l

Automatically Size - If either of these columns are selected, this pipe will be included in
the sizing analysis.
l

Always Include in Cost - The cost of this pipe will always be considered and reported.

l

Include in Cost if Size Changes - The cost of this pipe will effectively be considered zero for the initial size. This is useful for representing existing pipes, while
considering the cost savings that could result from replacing the existing pipe with
one of a more appropriate size.

Do Not Size - If either of these columns are selected, this pipe will not be included in the
sizing analysis.
l

Include in Cost - The pipe will not be considered for sizing, but the cost of the pipe
for the user specified size will be included. This is useful for having a complete picture of the system cost, even if certain pipes must be a given size.

l

Do Not Include in Cost - The pipe will not be sized or included in costs.

Pipe Grouping - Pipes can be placed into Common Size Groups here. You can sort this table by
clicking on the column headers, or by right-clicking on the headers and choosing Organize Grid by
Common Size Group.
l

Not in Group - the pipe is not in a group, and is either not sized, or sized independently
from any other pipe.

l

Common Size Groups - This section is only visible after a Common Size Group is created
with the New button. When a Common Size Group is created, it will create a corresponding
column underneath the Common Size Groups header. Pipes can then be placed into the
Common Size Group by selecting the radio button for the given pipe under the given Common Size Group. Groups can be collected to the top of the table by clicking on their column
headers.
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Note: You can also add Pipes to Common Size Groups directly from the Workspace, and optionally
color the Workspace pipes to indicate which pipes are in what groups.
Pipes can be selected by clicking on the row header, and multiple pipes can be selected by
holding control or shift. With multiple pipes selected, their sizing or cost options can be reassigned
with the buttons near the top of the table. All of the tables displayed in this panel include the selection features available elsewhere in AFT Arrow.

Selected rows can have their settings changed all at once with the buttons just above the table.

Note the indication of the total number of Independent Pipe Sizes in the lower right. This quantity has
important implications on run time and what Search Method will be appropriate for the model
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Compressors/Fans, Control Valves, and Junctions
l

Cost Options - This section of the table controls sizing and cost calculation.
l

Include in Cost Report and Sizing - If a junction is included in the sizing calculation, this
does not mean that the junction itself is modified as pipes are. Instead, this means that the
cost associated with the junction is included in the Objective. This can indirectly affect the
size of the junction as the pipes are sized accordingly around it.

l

Include in Cost Report Only - The junction cost will not be included in the Objective.
However, the cost of the junction will be included in the Cost Report. The sizing of the junction may change as a result of pipe size changes, but the cost impact of this change will not
drive the solution.

l

Do Not Include Cost - Not included in sizing or costs.

Maximum Cost Groups
Compressors/Fans and control valves can optionally be grouped together in maximum cost groups. This
is useful to account for situations where the cost of multiple components is the same, regardless of how
the system operates around them.
For example, it is common to have two identical compressors installed in parallel, with only one operating
and the other functioning as a spare. Clearly, the cost of purchasing and installing two identical compressors will be identical regardless of how they end up being operated. The automated sizing calculation will base the cost of the compressor off its required size to maintain the desired flow. However, in
the case of a spare there is no flow requested, meaning that the ideal size of compressor is "zero" - no
compressor at all! ANS must be told that the spare compressor is the same size as the running compressor. This will force the costs to be the same, accounting for both in the sizing.
In any Maximum Cost Group, the largest cost found during sizing will be applied to all of the junctions in
the group for the given category. There are three categories:
l

Material - The most common grouping - A set of identical junctions will likely cost the same to procure, and therefore should be placed into a Material Maximum Cost Group.

l

Installation - Commonly tied to Material - the junctions are likely to cost the same to install.

l

Maintenance - May or may not be grouped - if all junctions have routine maintenance whether or
not they are used, they should be grouped. If maintenance occurs only when the junction is oper-
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ating for some amount of time, then a spare will have different maintenance costs and they should
not be grouped.

Related Topics
Sizing Window
Sizing Objective Panel
Candidate Sets Panel
Design Requirement Panel
Assign Cost Libraries Panel
Sizing Method Panel
Dependent Design Cases Panel
Sizing Summary Panel
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Related Examples
Beginner: Three Tank Steam System - ANS
Air Distribution - ANS
Related Blogs
What is the ANS Module Asking For? Introduction to the Sizing window in the ANS Add-on Module

Candidate Sets Panel
Candidate Sets are selections of pipe Material, Types, and Sizes that can be considered in the automated sizing process.

Define Candidate Sets
Before it can be applied to any pipes in the model, a Candidate Set must be defined.
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Clicking New will request a name for the new Candidate Set. After entering a name, the Select Pipe
Sizes window will appear. In this window, a Material must be selected, and any number of specific Types
and Sizes can be added for consideration. It would be common to select commercially available Sizes of
a certain Type, but any selection can be made.

Candidate Sets can be saved to and loaded from a file for distribution or use in other models.
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Note: The Candidate Sets defined here are common to all scenarios. They can be applied or not
applied in certain scenarios as needed.

Assign Candidate Sets to Pipes
Every pipe that is being sized must have an associated Candidate Set. As Common Size Groups already
define every pipe within them as the same Size, Candidate Sets are assigned to the entire Common Size
Group. Multiple Common Size Groups or Not in Group pipes can be assigned at once by selecting the
rows and using the Assign To button.

Related Topics
Sizing Window
Sizing Objective Panel
Size/Cost Assignments Panel
Design Requirement Panel
Assign Cost Libraries Panel
Sizing Method Panel
Dependent Design Cases Panel
Sizing Summary Panel
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Related Examples
Beginner: Three Tank Steam System - ANS
Air Distribution - ANS
Related Blogs
What is the ANS Module Asking For? Introduction to the Sizing window in the ANS Add-on Module
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Design Requirement Panel
Design Requirements are of critical importance in a sizing process. Without any Design Requirements,
the system will be sized based on cost alone. This will tend to reduce pipe diameters to the minimum size
allowed by the Candidate Set. In turn, the fluid behavior of the system may become physically untenable
- for example, with extremely high fluid velocities.
Additionally, the very requirements of the system may not be met - certain outflows may require a given
pressure and flow and lowering the pipe size too much may mean these needs cannot be met.
Design Requirements ensure that the selected pipe sizes are the minimum cost considering these limitations - the minimum Feasible cost.

Define Design Requirements
Pipes and Junctions can both have Design Requirements applied to them. The buttons at the top of the
panel can be used to switch between Design Requirements for the pipes/junctions. In both cases, individual Design Requirements are defined with a Name, Parameter, Location, and limiting Value.

Note: The Design Requirements defined here are common to all scenarios. They can be applied or
not applied in certain scenarios as needed.

Assign Design Requirements
Created Design Requirements can be applied to any number of applicable objects, and a single object
can have any number of Design Requirements applied to it. Common Size Groups are indicated here,
and a Design Requirement can be applied to an entire group with ease. If this is not desired, the group
can be expanded and individual selections can be made.
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Related Topics
Sizing Window
Sizing Objective Panel
Size/Cost Assignments Panel
Candidate Sets Panel
Assign Cost Libraries Panel
Sizing Method Panel
Dependent Design Cases Panel
Sizing Summary Panel
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Related Examples
Beginner: Three Tank Steam System - ANS
Air Distribution - ANS
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Related Blogs
What is the ANS Module Asking For? Introduction to the Sizing window in the ANS Add-on Module

Assign Cost Libraries Panel
If Monetary Cost is selected as the Objective, the costs of any components considered in the Objective
must be available.
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Note: For an accurate analysis, costs are required for any component that may be considered in
sizing. This means that it is not sufficient to have cost data only for some pipe sizes, or only for
certain sized junctions. Every pipe Size and Type considered in a given Candidate Set needs to
have cost information for every parameter considered in the Objective.

Cost and Energy Libraries
Libraries are not discussed in detail here. Both Cost and Energy Libraries are available as a part of the
base Application. For a thorough explanation see Cost Overview and the associated topics. The Creating
Libraries for Sizing a System Example is an excellent place to start if you are unfamiliar with Cost Libraries.

Assigning Cost Libraries
Candidate Sets can have any number of Cost Libraries assigned to them. This can be useful as different
sources of costs can be distributed among several libraries. For example, different Sizes of pipes may be
available only from certain manufacturers, and splitting libraries by material source can provide clarity.
Likewise, "Installation" cost mat have several sub-component costs such as Shipment and Labor. In
these cases, There would be an Installation cost for the same Material, Size and Type in two different libraries. Including both of these libraries will use the sum of the two costs in the Objective.

Note: Keep in mind when assigning cost libraries that the automated sizing will consider the sum
of costs from all selected cost libraries. Be careful to include multiple libraries only if every
cost would be incurred. Do not include, for example, two cost libraries comparing costs from two
different suppliers.

Modifying Cost Calculations
Multipliers on a given cost category for a given component can be applied here. These are useful in a variety of situations. A compressor may be in a difficult to access location, driving up its maintenance cost by
some factor. Or, a control valve may only operate a percentage of the time, meaning that less cost is
required for maintenance. A pipe that must be buried would have a higher installation cost. There are
many such examples where a specific pipe or junction in the system has a higher or lower cost than the
value defined in the library.
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Note: Multipliers can also be applied within cost libraries. The multipliers are independent of each
other and stack multiplicatively.
If recurring costs are considered, there will be an additional column in this table titled Service Duration.
By default, recurring costs are considered for the entire System Life. If certain components should only
be considered as incurring cost for part of the System Life, this can be defined here.

Related Topics
Sizing Window
Sizing Objective Panel
Size/Cost Assignments Panel
Candidate Sets Panel
Design Requirement Panel
Sizing Method Panel
Dependent Design Cases Panel
Sizing Summary Panel
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Related Examples
Air Distribution, Creating Libraries - ANS
Air Distribution - ANS
Natural Gas Burner - ANS
Related Blogs
What is the ANS Module Asking For? Introduction to the Sizing window in the ANS Add-on Module

Sizing Method Panel
The Sizing Method panel controls how the automatic sizing will determine the ideal sizes.

Sizing Level
l

Continuous - Allow the sized pipes to be any diameter

l

Discrete - Restrict the sized pipes to diameters directly specified in their Candidate Set.
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Discrete and Continuous Sizing each have their own advantages. Discrete Sizing will present a set of
pipes that are commercially available, as defined by the associated Candidate Sets. Continuous Sizing is
generally much easier computationally, and hence faster.
It is good practice to begin with Continuous Sizing and only proceed to Discrete Sizing when the general
design of the system has been determined.

Search Method
There are many ways to approach the search for a minimum or maximum.
A foolproof way to determine if a system is really the "best" is to compare every single possible combination allowed. Then, it will be guaranteed that the lowest cost option has been found. Unfortunately,
attempting to brute force the problem is only viable with a very small number of variables. Instead, the
solution must be searched for in an intelligent manner, without explicitly checking every possible option.
There are several such methods available in ANS:
l

l

Continuous Methods - These methods use gradients - rates of change of the Objective (total system cost) with respect to one design variable (a pipe diameter). For the most basic system, the
gradient will show an increasing cost with increasing pipe size. However, this quickly becomes
less rigid when considering Design Requirements and the impacts a certain pipe size has on the
system. A smaller pipe size may make the pipe itself cost less, but it may require a larger compressor which costs more, effectively making the gradient show a decreasing cost with increasing
size. Regardless, if the direction of decreasing cost is known, an intelligent choice to search in that
direction can be made. By intelligently running sizing sub-problems, it is possible to find a
discrete solution with continuous methods. The Branch and Bound method searches for a discrete minimum by placing additional requirements on certain variables (branching) and analyzing
the results of the continuous solution to determine if this section of the design space is worth further investigation (bounding).
l

Modified Method of Feasible Directions - Reliable and applicable to most problems.

l

Sequential Quadratic Programming - Frequently the most efficient, but more sensitive to
system definition.

l

Sequential Unconstrained - Sensitive to initial sizes and control parameters, but more capable of handling large numbers of uniquely sized pipes.

Discrete Methods - Some methods are inherently discrete, and can only consider discrete possibilities during the sizing process. These methods are sometimes more adept at finding global
minimums, but are also generally much slower than gradient based methods.
l

Genetic Algorithm - Cross-breeds a random "population" of designs, mimicking biological
evolution. Less likely to become trapped in a local minimum, but very slow compared to
other methods.

l

Particle Swarm - Like Genetic Algorithm, mimics the behavior of biological populations. A
less random, and therefore faster, approach representing the tendency of populations to
collectively search for improved conditions.
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Note: Full understanding of the Search Methods is not required for effective use of ANS. However, it
is important to realize that different methods are better suited to different systems. It is recommended to use multiple Search Methods on any system to ensure the best case sizes are located, and to determine if one method is more efficient than the others.

Related Topics
Sizing Window
Sizing Objective Panel
Size/Cost Assignments Panel
Candidate Sets Panel
Design Requirement Panel
Assign Cost Libraries Panel
Dependent Design Cases Panel
Sizing Summary Panel
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Related Examples
Beginner: Three Tank Steam System - ANS
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Related Blogs
What is the ANS Module Asking For? Introduction to the Sizing window in the ANS Add-on Module

Dependent Design Cases Panel
Dependent Designs are a powerful way of accounting for different operating cases during the sizing process. This panel displays information on how to create a Dependent Design Case, or if one exists, how
the objects are related to their base objects.

Enabling Dependent Design Cases
Dependent Design Cases are enabled by checking the box on the Sizing Objective panel.

Note: Once a Dependent Design Case exists, this option cannot be turned off unless the Dependent
Design Case is completely removed.
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Creating a Dependent Design Case
Once the option above has been enabled, it is possible to create Dependent Design Cases on the Workspace.
This is done simply with Duplicate Special. Select all of the objects to be included in the Dependent
Design and select Duplicate Special from the Edit menu, and selecting the special Make Dependent
Design Case option.

Selecting OK will duplicate all of the objects selected and increment their numbers by the indicated value.
In addition, the new objects will be related to their base objects.

Modifying the Dependent Design
Dependent Design objects represent the same object that they were created from. Logically, the end result must be that the objects are the same in all dependent designs. It does not make logical sense for
pipes to be different lengths, for example. ANS will force a single pipe diameters across all dependent
designs.
However, there are many modifications that are reasonable, and they fall into two categories:
l

Modifying the physical configuration of the model - Environmental changes can affect temperature, changing processes can change the fluid, tank pressure levels can change, compressors may be brought online, valves may change position, and even new pipes may be added
to represent a planned expansion. These are just a few examples of a different operating case
being the result of a physically changed model.

l

Modifying the Design Requirements - The exact same physical system may still have different
requirements under different conditions. A plant may have different demands during day or night,
or it may be desired to account for future production without modifying the piping layout. These are
a couple of examples of changing Design Requirements to create different operating cases.
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Note: The only sizing input that can be changed for a Dependent Design are the Design Requirements. Remember that both the base object and Dependent Design object really represent just
one physical object - it cannot have different cost or be of a different pipe material in different
cases.

Reviewing Dependent Designs
As the model becomes larger and more complex, it may be difficult to tell what objects correspond to others across operating cases. The Dependent Design Cases panel shows a review of how the objects are
connected:

Related Topics
Sizing Window
Sizing Objective Panel
Size/Cost Assignments Panel
Candidate Sets Panel
Design Requirement Panel
Assign Cost Libraries Panel
Sizing Method Panel
Sizing Summary Panel
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Related Examples
Air Distribution, Multiple Design Cases - ANS
Helium Transfer - ANS
Natural Gas Burner - ANS

Sizing Summary Panel
The Sizing Summary panel gives an at-a-glance, but comprehensive, view of how the model has been
configured for sizing.
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All of the sizing input can be grouped into a few relatively simple categories. However, as the model
becomes more complex, the relationships between these inputs can be difficult to visualize. For this
reason, the Sizing Summary is a relational diagram with a handful of parent nodes. Nodes can be turned
on or off with the checkboxes above the diagram.

Each node can be expanded to see the related entries.
Note: The Summary can be manipulated much like the Workspace - use the scrollwheel to zoom in
and out, and pan the view with the scrollbars or by clicking the middle mouse button.

Individual objects can be expanded, showing detailed related information about them.

Clicking on a related category for a specific object will indicate the associated node(s).
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Related Topics
Sizing Window
Sizing Objective Panel
Size/Cost Assignments Panel
Candidate Sets Panel
Design Requirement Panel
Assign Cost Libraries Panel
Sizing Method Panel
Dependent Design Cases Panel
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Related Examples
Air Distribution - ANS
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Solution Progress with ANS
When a model is run with the ANS module enabled, an additional line will be shown in the Solution Progress window to indicate the progress that the ANS module has made towards reaching the specified
goal. There are three fields displayed, as can be seen in Figure 1 below.
The "Best Feasible Cost" and "Current Cost" fields indicate the total cost for the model in the default
units, as indicated in the Solution Progress window. The Current Cost field shows the cost calculated for
the last design iteration, while the Best Feasible Cost field tracks the cost of the best solution so far that
meets all design requirements.
The field on the far right of the Sizing Calls to Solver line tracks the total iterations performed by ANS.
For every ANS iteration, ANS makes a call to the hydraulic solver in Arrow to determine the hydraulic
solution for the current sizing solution. Thus, this value will always be smaller than the flow and head iterations.
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Other Actions
If the solution is paused by clicking the Pause button in the Solution Progress window, there are several
options that can be selected form the Other Actions window to assist with convergence.
Selecting Solution Control allows the Steady Solution Control options to be adjusted before calculations
are resumed. This is not recommended unless you have a good understanding of the parameters in Solution Control, or this has been suggested by AFT Technical Support.
The Sizing Control option provides a file with detailed information on the sizing parameters being used by
the Sizing Engine. This can provide insight for cases where ANS is not converging, or is taking a long
time to converge.
The Accept Sizing option will be available from the Other Actions window if the Genetic Algorithm is selected on the Sizing Method panel. This option allows the user to stop the iterations and accept the design
with the Best Feasible Cost as the solution for the model. Accepting the sizing solution early is helpful for
models which have been running for a long time, without seeing any significant improvement on the Best
Feasible Cost for the model. Rather than spending additional time on find the absolute best design, it
may be desired to accept the design that gives the current Best Feasible Cost instead to save time.

Figure 1: The Solution Progress window has an additional line to show information on the ANS Calls to
Solver when the Arrow model is run with ANS enabled
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Sizing Results
Automatically Selected Pipe Sizes
The pipe sizes corresponding to the best case Objective value are reported in the Output Window.

Cost Report
The Cost Report is displayed in the top section of the Output window. It will display the appropriate variable for the Objective (e.g. kilograms for a Weight sizing). All Cost Libraries that were used in the generation of the report are listed in Library Sources. It is described in detail in Cost Report.

Design Requirement Status
Whether or not a Design Requirement is Active can have important bearing on system design decisions.
Values in yellow are active. Values highlighted in blue are Design Requirements that were active during
Continuous sizing, and may appear inactive after Discrete sizing. Un-highlighted values are inactive.
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Changing Input Sizes to Resulting Pipe Sizes
l

Set Pipes to Resulting Pipe Sizes - The Transfer Results to Initial Guesses takes on additional
functionality when ANS is enabled. After a sizing run, you can use this feature to transfer the resulting pipe sizes to the pipes. For certain Search Methods, this can greatly speed up the solution
process for future sizing runs.

l

Generating a Disconnected Scenario - Generating a disconnected scenario allows the sizing
results to be saved as input in a new scenario. This can be useful to keep track of results from different methods, or to tweak the sized solution if required.

Workspace Integration
Modifying Sizing from the Workspace
Right-clicking anywhere on the Workspace allows the selection of existing Common Size Groups:

Selected pipes can be moved to a new or existing Common Size Group:
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Changes will be previewed before they are applied:

Sizing Level Assignments and Design Requirements can also be applied in this manner.

Viewing Assigned Common Size Groups and Design Requirements
Additionally, each Common Size Group or Design Requirement can have a unique color applied to it by
selecting the appropriate option under the View menu.
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Related Examples
Air Distribution - ANS
Process Steam System - ANS
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Junction Loss Factors
During the sizing process, the size of junctions will implicitly change along with the size of the neighboring pipes.
Junctions which use handbook loss factors will automatically adjust their loss value when the pipe size
changes. For example, a Bend junction defined as a Smooth Bend uses built-in relationships to determine a loss based on pipe area and r/D. As the pipe size changes, this loss value will change automatically.
However, a built-in loss model that updates for different pipe sizes is not always available. Many junctions allow the specification of a Loss Multiplier Table as seen below.

Figure 1: Loss Multiplier Table

With a base loss factor (K-Factor, in Figure 1), ANS can use this table to determine how much to adjust
the loss by when changing the associated pipe diameters.

Improving and Troubleshooting the Sizing Process
Check the Continuous Solution First
For small problems with less than ten independently sized pipes, it should be possible to obtain a Discrete solution in a few minutes or less. Larger problems can take a long time to solve, so it is important to
point the sizing process in a good starting direction.
The Discrete problem is generally much more difficult to solve than the Continuous, and most of the Discrete methods depend on an initial Continuous solution. Therefore, it is important to ensure the Continuous solution is good. There are a few guidelines to consider:
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l

Check the quality of the Continuous Solution before proceeding to the Discrete Solution If the Continuous solution is not ideal, then the methods which use the Continuous solution for a
starting point will have a poor Discrete solution as well.

l

Ensure the Discrete Solution is worse than the Continuous Solution - A Discrete solution
always places further limits on the solution, and should therefore have a negative impact on the
Objective. If the Discrete solution is better than the Continuous, this means that either the Continuous solution is poor, or that there are numerical issues affecting the solution by some small
amount. If the difference is significant, this likely indicates an issue with the sizing process, the
solver, or user input.

l

Check for Consistent Continuous Solutions - Using any of the Continuous methods should
give comparable results. If this is not the case, it may indicate that ANS is finding Local Minimums
with one or more of the methods.

l

Use the best Continuous Solution to Proceed - If one of the methods is finding a better
Continuous Solution than the others, and the results are reasonable, this result should be used as
the basis for the Discrete Solution.

Determine if the solution is a Local Minimum
It is possible for ANS to get stuck in a local minimum and not find the global minimum. If this is happening, there are a few things to try:
l

Change the initial pipe sizes

l

Use a different Sizing Method - Pure Discrete Methods are inherently better suited to finding
global minimums.

l

Temporarily remove some of the Design Requirements - This can help identify Design
Requirements that are actually driving the sizing process. Having too many Design Requirements
can make the system much more difficult to solve with minimal gain.

Use a Different Search Method
The different search methods have different strengths and weaknesses. It is possible that one method
will struggle with a problem that others can easily find a solution for.
It is also a good indicator that the best solution has been found if different methods agree.

Use Logical Design Requirements
l

Design Requirements in Closed Areas of a Model - ANS will attempt to identify Design
Requirements that are irrelevant and ignore them during the sizing process. However, depending
on ANS to do this is not advised, Design Requirements on closed areas should be removed. For
example, it is not meaningful to apply a minimum flow rate requirement on a closed pipe - it is possible that ANS will not find a Feasible solution if such a Design Requirement is left in place.
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l

Conflicting Design Requirements - It is easy to apply requirements that are impossible to meet.
For example, a minimum flow rate greater than an in-line Flow Control Valve setpoint, a maximum
pressure lower than the connected Assigned Pressure, or a maximum speed on a compressor
that has been manually set to a higher speed. With these types of Design Requirements, ANS will
(correctly) conclude that no feasible design exists, and the results may not be meaningful.

Change the Initial Pipe Sizes
The sizing process uses the initial pipe sizes defined by the user as a starting point. It is possible to start
the sizing process in an area that poses difficultly. Increasing or decreasing the initial pipe sizes can help.

Simplify the Problem
It is good practice to solve a simpler problem first, before proceeding to a more complex problem.
l

Be sure the model solves as expected before using ANS - Any issues that are present in the
base hydraulic model will also be present in the sizing process.

l

Find a Continuous Solution before searching for a Discrete solution.

l

Use a small number of Design Requirements, and add them as necessary. For troubleshooting purposes, it can be useful to remove Design Requirements that are necessary in the final
design.

l

Decrease the number of variables - Adding more pipes to Common Size Groups, and limiting
the number of Common Size Groups, can make the problem much easier to solve.

Sizing Components Other Than Pipes
Sizing Compressors/Fans
While compressors are not directly sized by ANS, they are able to be indirectly sized by including an
estimation of their cost. Their actual behavior is a result of the system. The appropriate sizing of a compressor requires a Cost Library and understanding of standard Compressor/Fan Sizing.
At the most basic, compressor sizing is simply selecting a compressor that is capable of meeting pressure and flow requirements. Too often this involves selecting a compressor that is larger than required,
under the assumption that a bigger compressor will provide for operational margin. Unfortunately, oversizing a compressor has negative impacts on reliability and efficiency, both of which incur higher cost.
Over-sizing could also require the installation of ultimately unnecessary valves or restrictions to bring the
flow back down to where it should be.
The ability to appropriately size compressors is built into AFT Arrow. By using the Compressor Sizing
option, AFT Arrow will indicate the amount of pressure required to deliver the specified flow. It is up to the
user to find a compressor that operates at its BEP at the calculated flow and head.
The best size of compressor to use when the pipe sizes are allowed to change as well is harder to
handle, and requires iteration. See Sizing Pipes and Compressors Concurrently.
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Note: Certain compressor configurations require special attention in ANS. See Special Concerns For
Sizing Compressors.

Sizing Control Valves
Control Valve sizing is similar - AFT Arrow already has all of the tools needed to size a Control Valve for a
specific set of pipes. AFT Arrow will report the Cv or K Factor necessary for a Control Valve to attain a
given setpoint. From this value, an appropriate valve could be selected for minimizing cost. It would be
typical to select the smallest Control Valve possible while still remaining in a good control range - typically
20-80% open.
Like compressors, selecting the best Control Valve while pipe sizes are changing is more complex. See
Sizing Pipes and Control Valves Concurrently.

Sizing Other Junctions
Any other junction can be included in the sizing process as long as cost data exists.
For example, a Bend can have costs associated with it via a Table of Costs. From this table, ANS can
determine the cost for a given diameter. ANS will assume that the Bend is of a diameter equal to the
upstream pipe inside diameter, and include the corresponding cost in the Objective. If certain components are very expensive compared to piping, this could affect the selection of pipe sizes.

Sizing Ducts
Duct sizing has special considerations discussed in Sizing Duct Systems.

Related Topics
Special Concerns For Sizing Compressors
Sizing Pipes And Compressors Concurrently
Sizing Pipes and Control Valves Concurrently
Sizing Pipes, Compressors, and Control Valves Concurrently
Sizing Duct Systems
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Special Concerns For Sizing Compressors
There are several special concerns with sizing compressors. For a general overview of the process of sizing compressors see: Sizing Pipes and Compressors Concurrently.
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End of Curve Flow Rate
Centrifugal compressors typically have an end of curve, or runout, flow rate. They cannot operate reliably
past this point. This can be entered in Compressor Configuration, but this will not actually prevent the
model from running the compressor with higher flows. Instead, the curve will be extrapolated past this
point and a warning will be generated.
If it is important to prevent the sizing results from considering flows in this region as valid. A Design
Requirement for maximum flow rate equal to the end of curve value should be placed on the compressor.

Partial Service Duration
Without other input, ANS will assume that any compressor included in the sizing operates constantly.
If this is not the case, then either an appropriate Service Duration or Multiplier should be defined in the
Assign Cost Libraries panel.

Variable Speed Compressors with Partial Control Applicability
ANS can size compressors with a user defined fixed speed other than 100%, or a controlled compressor
that modifies speed to meet a flow or pressure setpoint. However, pressure-type variable speed controlled compressors allow the user to optionally enforce Control only when the actual pressure is above/below a setpoint. This causes an issue with sizing.
If ANS allowed the compressor to change from a fixed 100% speed compressor (non-controlling pressure) to a variable speed compressor (when the setpoint is violated), it would be changing the characteristics of the system. This has a direct impact on the sizing process, so it cannot be allowed - ANS
will always model this type of compressor as fixed 100% speed.
Either an Always Controlling compressor must be specified, or Design Requirements on pressure must
be added to the appropriate pipes.

Unrealistic Sizing Results From Dependent Design Cases
If there are two design cases that have different compressor flow rate requirements, the ideal compressor curve may be unrealistic.
For example, one operating case may require 500 ft3/min, and another may require 750 ft3/min. It is
desired to select the ideal compressor. After running ANS, it is determined that the compressor should
generate 50 psid in the 500 ft3/min case and 70 psid in the 750 ft3/min case. To meet this requirement,
we need a compressor curve that increases from 50 psid to 70 psid with a large increase in flow. This is
an unrealistic demand.
To prevent this, a pressure rise Design Requirement can be added to maintain the high flow pressure at
70-90% of the low flow pressure. This will effectively force the sizing to consider only realistically shaped
compressor curves.
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Sizing Components Other Than Pipes
Sizing Pipes And Compressors Concurrently
Sizing Pipes and Control Valves Concurrently
Sizing Pipes, Compressors, and Control Valves Concurrently
Sizing Duct Systems

596
599
603
606
608
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Sizing Pipes And Compressors Concurrently
The cost of a compressed gas piping system clearly depends on both the cost of the pipes, and the compressor. It is tempting to select compressors and pipes in stages, but this is unlikely to produce the lowest
cost solution. Selecting a smaller compressor may not appear to be viable, but changing the pipe sizes
may make it viable. Like sizing pipes alone, overall costs can often be decreased by increasing the cost
of one or a few components. Attempting to find the lowest cost option manually quickly becomes impractical even with a small number of variables.

Optimal Pumping System Operating Point (OPSOP)
A compressor's BEP is considered the ideal place to run a compressor as the efficiency is highest, and
thus cost is lowest. Similarly, any piping system will have a lowest cost design.
Whether a compressor is running at BEP, however, depends on the piping system, and the lowest cost
piping system depends on the compressors it contains. What may be the lowest cost piping system for a
given compressor, may not me the lowest possible cost option. It is possible that a cheaper compressor
could be selected with the correct piping adjustments while still maintaining all Design Requirements.
The point at which no adjustments to compressor or system will result in lower cost is known as the
Optimal Piping System Operating Point (OPSOP). One way to determine this point is to exhaustively
size the system for different potential sizes of compressors. This is inefficient, but can be used to construct a visual representation of the OPSOP as shown below.
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Figure 1: The OPSOP of a given system. Note that every point is an ideal sizing solution for the given compressor size.

If the sizing process is approached in stages, rather than concurrently, it is easy to get a result that says,
for example, a 60 psid pressure rise compressor is required. The best case system for the 60 psid pressure rise compressor has a minimum cost of about $36,500. However, allowing the compressor to
change as well can result in a system more than 7% cheaper.

Process Outline
1.

Find the Approximate Compressor Size
1.

Model the compressor with the Compressor Sizing option, fixing the flow to the desired
amount. AFT Arrow will determine the required pressure rise.
1.

2.

3.

4.

Include an estimate of Nominal Efficiency.

Add the compressor to an Engineering Library.
1.

Attach a Cost Library to the Engineering Library if one does not already exist.

2.

Create a Power vs. Cost Scale Table for the compressor with estimated cost values.

Select the appropriate options in the Sizing Window.
1.

The cost for the compressor will only be included in the Objective if it is specified to
be included in Size/Cost Assignments.

2.

If there are several compressors that will ultimately be of the same type, they should
be placed into a Maximum Cost Group.

Run ANS.
1.

Investigate the resulting compressor size.

2.

Update the Nominal Efficiency based on the result. Also update the cost information
if necessary. If the compressor accounts for a large portion of the overall cost,
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accurate values here are more important.
3.
2.

Repeat the process as necessary, until reasonable estimates for cost at the resulting operating point are obtained.

Compare Candidate compressors
1.

Locate accurate cost information and compressor curves for the candidates.
1.

2.

Incorporate these values into Engineering and Cost Libraries.

Compare the sizing results for each candidate compressor.

Estimating Compressor Costs
Without knowing specifically what type or size of compressor is going to be included in the system, the
compressor behavior must be approximated. The behavior is approximated with the Compressor Sizing
option, indicated with a design flow. We also need to approximate cost. Because energy cost is often the
largest component of a compressor's overall cost, and this cost is directly related to the compressor's
power, it makes sense to correlate other compressor costs to power as well.

Figure 2 - Total Initial Costs for a series of compressors

Keep in mind that such a comparison is only valid for the selected range of compressors. Different
designs of compressors, or compressors from different manufacturers may follow different relationships.
One manufacturer may offer cheaper low-power compressors, while their competitor offers cheaper
high-power compressors. This cost information is represented in ANS as a Power vs Cost Scale Table.
This requires the creation of a Cost Library including the compressor as a Custom Component.
Because we do not know what specific compressor is going to be used, we also do not know exactly how
much it will cost to run or maintain it.
As part of our sizing process, we must assume that the compressor runs at some Nominal Efficiency.
AFT Arrow will calculate the fluid power required at any given flow and head rise. However, a compressor
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or motor is not perfectly efficient and will therefore require more power than the fluid power. This affects
the compressor selection, and therefore cost, so it is important to include an estimate on efficiency.
Note: It may seem that including a nominal efficiency is not important, as selecting a certain compressor size will minimize the initial compressor cost regardless of this value. However, this
does not consider the cost of power over a long period, which is often a driving factor in sizing.
Also, it is important to get the relative cost of the compressor correct as this can affect the best
sizing. The nominal efficiency will require more power and hence a more expensive compressor
- as this is included in the Objective, it is important to account for.
If maintenance costs are expected to be significant, it is important to include an estimate of these costs.
Again, this could be accounted for with a Power vs Cost Scale Table.

The Approximate Sizing Solution
When the initial model is defined, the sizing configuration complete, and the compressors appropriately
defined with approximate cost information, the automated sizing can take place.
ANS will size the pipes of the system to minimize cost while obeying Design Requirements. It will now
include a power-based cost for the compressor. Without cost information on the compressor, ANS would
tend to select small pipe sizes to reduce cost without any negative consequence. However, smaller pipe
sizes have higher frictional loss, which requires greater pressure rise at the compressor, and hence
higher cost. By including compressor cost information, the balance between compressor costs and piping costs can be found.
However, this is still an estimate because we are not modeling a real compressor. Fixing the flow and
nominal efficiency are good design tools but it is important to represent a real compressor curve not only
to account for real effects, but also to ensure that the desired compressor can actually be acquired.
If the compressor costs are a significant portion of the overall cost, the estimates made for cost
and nominal efficiency should be refined and the system re-sized before proceeding.

Sizing with a Real Compressor
Now that there is a good idea of the size and cost of compressor we are looking for, we can select a real
compressor we may want to use.
It will rarely be clear which compressor is the best choice. First, the exact operating point determined
from the approximate solution is likely unavailable in a commercially available compressor. Second, different compressors have different costs - even if a compressor with the exactly correct specifications is
available, it may be much more expensive than a compressor that is slightly mismatched. This cost difference could mean the cheaper compressor is better overall, despite not appearing to be the ideal
choice.
The best course is to select several candidate compressors, and size the system independently with
each candidate compressor. It is important that accurate compressor curves and cost information be
included for each candidate, as this no longer meant to be an estimation. After testing each candidate
compressor, the system with the lowest overall cost can be selected.
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If the sizing results differ significantly in this stage this could indicate that the compressor is poorly
matched, that there was an error in the process, or that the system is dominated by compressor costs
and therefore very sensitive to the estimations.

Related Topics
Sizing Components Other Than Pipes
Special Concerns For Sizing Compressors
Sizing Pipes and Control Valves Concurrently
Sizing Pipes, Compressors, and Control Valves Concurrently
Sizing Duct Systems

596
597
603
606
608

Sizing Pipes and Control Valves Concurrently
Process Outline
1.

Find the Approximate Control Valve Size
1.

Model the Control Valve with the appropriate settings. AFT Arrow will determine the
required loss.

2.

Add the Control Valve to an Engineering Library.

3.

4.

2.

1.

Attach a Cost Library to the Engineering Library if one does not already exist.

2.

Create a Cv vs. Cost Scale Table for the control valve with estimated cost values.

Select the appropriate options in the Sizing Window.
1.

The cost for the control valve will only be included in the Objective if it is specified to
be included in Size/Cost Assignments.

2.

If there are several control valves that will ultimately be of the same type, they
should be placed into a Maximum Cost Group.

Run ANS.
1.

Investigate the resulting control valve size.

2.

Update the cost information if necessary. If the control valve accounts for a large portion of the overall cost, accurate values here are more important.

3.

Repeat the process as necessary, until reasonable estimates for cost at the resulting operating point are obtained.

Compare Candidate Control Valves
1.

Locate accurate loss and cost information for the candidates.
1.

2.

Incorporate these values into Engineering and Cost Libraries.

Compare the sizing results for each candidate control valve.

Reference Pressure Concerns
It is impossible to generate a unique solution from a system (or part of a system) entirely bounded by
fixed flows. For an in-depth discussion of this issue and common areas where it may occur see Role of
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Pressure Junctions - Detailed Discussion.
Particularly common when sizing a system is the tendency to place a Flow Control Valve immediately
downstream of a Compressor modeled as a fixed flow. This situation has no unique solution, as discussed in the Sizing Compressors or Fans with Flow Control Valves section of the previous topic.
The typical solution to this issue is to temporarily change the Flow Control Valves to Pressure Drop Control Valves where necessary, until a compressor curve is selected and specified. Effectively, this is the
equivalent of specifying that our Flow Control Valve has a pressure drop requirement equal to the Pressure Drop Control Valve setpoint.

Control Valves and Design Requirements
ANS will always attempt to minimize or maximize the value of the Objective. ANS does not know if the
resulting design is realistic and this has no impact on the sizing. It can present results that would
be physically impossible to attain in the field.
AFT Arrow is no different in this regard - it is possible to specify a system that would require physically
unrealistic behavior. For example, with an AFT Standard fluid, the gas temperatures are allowed to drop
below saturation temperature. The system will still be solved as though the fluid is completely superheated gas. When possible, there will be Warnings if this type of behavior is detected, but the solver does
not make any attempt to prevent this situation. To avoid these unrealistic configurations, the user must
inspect the output and determine the changes required on the system to avoid the situation. In other
words, the user must adjust the design of the system to meet desired or realistic behavior - a Design
Requirement.
As an analysis tool, AFT Arrow does not allow the user to directly impose these requirements. ANS, on
the other hand, is a design tool and actively selects inputs to meet certain specifications. It would not be
unusual to specify a minimum temperature Design Requirement to prevent the saturation issue.
How does this relate to Control Valves? Control Valves in AFT Arrow will, by default, force control. This
means that the system will be able to behave unrealistically in order to meet the setpoint specified, which
can be useful in a design stage. As it would not be useful for a Control Valve to be unable to
achieve its setpoint during the sizing process, Always Control (Never Fail) is automatically
enabled for sizing.
Consider a simple case of a Flow Control Valve regulating flow between two reservoirs. It is desired to
size this system for lowest pipe weight.
Because of Always Control (Never Fail), the Flow Control Valve is essentially able to act like a compressor - providing "free" pressure to the system in order to meet the setpoint. As the cost of this "compressor" is not considered, the sizing process is trivial - we can simply select the smallest pipe size
available, as our "compressor" will simply make up for the increase in pressure loss.
Clearly, it is not realistic for a Control Valve to add pressure to a system. So why don't we allow our Flow
Control Valve to not meet its setpoint, as it would in reality? If the Control Valve is allowed to do so, we
are essentially stating that the flow it is attempting to maintain is not actually a requirement. If this is the
case, then again we will find that the "ideal" sizing solution is to select the smallest pipe size available.
The Flow Control Valve will fully open in an attempt to allow more flow, but in the end the flow will be
below the setpoint. However, our pipe weight will certainly be minimized.
What is the solution? We need to add a Design Requirement. It may seem intuitive to add a minimum
flow requirement to our system as we are attempting to control flow. However, this will not solve the prob-
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lem because the Control Valve will still simply add pressure to meet the setpoint. Furthermore, adding
Design Requirements that conflict with the model itself can cause problems.
Instead, a Design Requirement should be added related to the position of the Control Valve. The
position can be represented either directly as an Open Percentage if that data is available, or as a form of
loss. It is typical that a Control Valve is designed to operated within a certain range of positions - often 2080% open. It would not be useful to have a Control Valve designed to operate at 100% open, as a slight
variation in flow could cause it to not meet its setpoint and open fully.
By adding a Design Requirement on minimum dP/dH or maximum Cv/Open Percentage we prevent
unrealistic behavior and return a meaningful sizing result.
Note: It is always required to add this Design Requirement for Control Valves in the sizing model even if the junction is not marked to be Sized in Size/Cost Assignments. Including a Control
Valve in Sizing adds its cost to the Objective which can influence the result, which is not always
a concern. However, the behavior described above is always true and hence always needs a
Design Requirement.

Optimal Control System Operating Point
Just like sizing pipes and compressors concurrently, there is an optimal size of a control valve that minimizes total system cost. Approaching the problem in "stages" rather than concurrently can easily miss
the lowest overall cost solution.
Like the compressor process, we do not know specifically what Control Valve is going to be used in the
early stages of the process so we need to estimate the cost.
For Control Valves, the logical choice is to estimate with a Cost vs Cv relationship. This information will
be represented for the particular component in a Scale Table.
Note: When defining a Cost vs Cv Scale Table, keep in mind that this table is relating the current Cv to
the cost of the device. For example, if the Control Valve has a Design Requirement to be 80%
open, and ANS calculates a corresponding Cv of 120, the cost used from the Scale Table will
be that for a Cv of 120, not the full-open value of the control valve. This is important to keep in
mind when creating the scale table, as manufacturer cost information will often be in the form of
full-open Cv vs cost.

The Approximate Sizing Solution
When the initial model is defined, the sizing configuration complete, and the control valves appropriately
defined with approximate cost information, the automated sizing can take place.
ANS will size the pipes of the system to minimize cost while obeying Design Requirements - including
the Design Requirement on position discussed above. However, this is still an estimate because we are
not modeling a real control valve.
If the control valve costs are a significant portion of the overall cost, the estimates made for
cost should be refined and the system re-sized before proceeding.
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Sizing with a Real Control Valve
Now that there is a good idea of the size and cost of control valve we are looking for, we can select a real
control valve we may want to use.
It will rarely be clear which control valve is the best choice. First, the exact operating point determined
from the approximate solution is likely unavailable commercially. Second, different valves have different
costs - even if a valve with the exactly correct specifications is available, it may be much more expensive
than one that is slightly mismatched. This cost difference could mean the cheaper valve is better overall,
despite not appearing to be the ideal choice.
The best course is to select several candidate valves, and size the system independently with each candidate. It is important that accurate loss and cost information be included for each candidate, as this no
longer meant to be an estimation. After testing each candidate, the system with the lowest overall cost
can be selected.
If the sizing results differ significantly in this stage this could indicate that the control valve is poorly
matched, that there was an error in the process, or that the system is dominated by control valve costs
and therefore very sensitive to the estimations.

Related Topics
Sizing Components Other Than Pipes
Special Concerns For Sizing Compressors
Sizing Pipes And Compressors Concurrently
Sizing Pipes, Compressors, and Control Valves Concurrently
Sizing Duct Systems

596
597
599
606
608

Related Examples
Natural Gas Burner - ANS

932

Sizing Pipes, Compressors, and Control Valves Concurrently
Many systems contain both compressors and control valves, which makes the sizing process somewhat
more complex.
Like sizing pipes and compressors or pipes and control valves concurrently, there are adjustments and
estimations that must be made when sizing all three in parallel. The overall goal and considerations that
must be taken into account are described in detail in those topics and will not be repeated here. Only the
outline of steps will be presented for brevity.
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Process Outline
1.

Find the Approximate Compressor and Control Valve sizes
1.

Model the compressor(s) with the Compressor Sizing option, fixing the flow to the desired
amount.

2.

Model the Control Valve(s) with the appropriate settings.

3.

4.

5.

2.

1.

If the control valve(s) are Flow Controls downstream of the compressor(s) to be
sized, temporarily set them to be Pressure Drop Control Valve with a setpoint equal
to the minimum required pressure drop.

2.

Any non-Pressure Drop control valves will require a Design Requirement of minimum dP/dH or maximum Cv/Open Percentage.

Add the compressor(s) and control valve(s) to one or several Engineering Libraries.
1.

Attach a Cost Library to each Engineering Library if one does not already exist.

2.

Create a Power vs. Cost Scale Table for the compressor with estimated cost values.

3.

Create a Cv vs. Cost Scale Table for the control valve with estimated cost values.

Select the appropriate options in the Sizing Window.
1.

The cost for the compressor(s) and control valve(s) will only be included in the
Objective if it is specified to be included in Size/Cost Assignments.

2.

If there are several compressors or control valves that will ultimately be of the same
type, they should be placed into Maximum Cost Groups.

Run ANS.
1.

Investigate the resulting compressor size.

2.

Update the Nominal Efficiency and NPSHR based on the result. Also update the
cost information if necessary. If the compressor accounts for a large portion of the
overall cost, accurate values here are more important.

3.

Repeat the process as necessary, until reasonable estimates for cost at the resulting operating point are obtained.

Compare Candidate Compressors
1.

Locate accurate cost information and compressor curves for the candidates.
1.

2.
3.

Incorporate these values into Engineering and Cost Libraries.

Compare the sizing results for each candidate compressor.

Select the two or three best candidate compressors and compare candidate Control Valves.
1.

If necessary, change Pressure Drop Control Valves back to Flow Control Valves.
1.

This will require a Design Requirement of minimum dP/dH or maximum Cv/Open
Percentage.

2.

Locate accurate loss and cost information for the candidate control valves.

3.

Compare the sizing results for each candidate control valve, under each candidate compressor.

1.

Incorporate these values into Engineering and Cost Libraries.

Related Topics
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Sizing Components Other Than Pipes
Special Concerns For Sizing Compressors
Sizing Pipes And Compressors Concurrently
Sizing Pipes and Control Valves Concurrently
Sizing Duct Systems

596
597
599
603
608

Related Examples
Air Distribution - ANS

888

Sizing Duct Systems
An Engineering library of all possible rectangular duct sizes is needed, as is the case with Cylindrical
pipe.
If there are no geometric restrictions, the Candidate Set should use all of the duct sizes. Certain areas of
the system may have maximum width or height restrictions. In these areas, a different Candidate Set
should be created from the same Engineering library.
There are two variables for a rectangular duct - height and width, whereas a normal pipe only has one diameter. ANS treats these variables as independent when solving for the ideal size. This means that
duct Candidate Sets must have corresponding widths and heights for every duct dimension.
For example, consider three duct sizes in a Candidate Set: 8x8, 10x10, and 12x12. Because width and
height are considered independent by ANS, it is possible that 8 would be selected for width and 10 for
height. However, 8x10 is not in the Candidate Set. ANS will warn that the Candidate Set is incomplete
when this is detected.

Related Topics
Sizing Components Other Than Pipes
Special Concerns For Sizing Compressors
Sizing Pipes And Compressors Concurrently
Sizing Pipes and Control Valves Concurrently
Sizing Pipes, Compressors, and Control Valves Concurrently

596
597
599
603
606

Search Methods
ANS includes several different Search Methods for finding the best sizing solution. Some methods are
very similar, while others are entirely unique, and each is particularly suited to certain kinds of mathematical problems.
It is impossible to state that one method is always better or worse than another. The quality and speed of
each method depends on the specific system being solved and the sizing input. A method that excels for
one model may not be the best choice for another model.
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Note: All of the methods share a common goal of minimizing (or maximizing) an Objective. The analytical approach driving the sizing (the hydraulic solver) does not vary with the selected method.
This means that the best sizing solution across all of the methods is the best overall solution. It
is good practice to test several of these methods for any model.
l

Genetic Algorithm - Cross-breeds a random "population" of designs, mimicking biological evolution. Less likely to become trapped in a local minimum, but very slow compared to other methods.

l

Modified Method of Feasible Directions - Reliable and applicable to most problems.

l

Sequential Quadratic Programming - Frequently the most efficient, but more sensitive to system
definition.

l

Sequential Unconstrained - Sensitive to initial sizes and control parameters, but more capable of
handling large numbers of uniquely sized pipes.

Related Topics
Modified Method of Feasible Directions
Sequential Quadratic Programming
Sequential Unconstrained
Genetic Algorithm

609
611
614
616

Modified Method of Feasible Directions
A Continuous Search Method available in the Sizing Method panel.
The Modified Method of Feasible Directions (MMFD) finds the best case design by determining a search
direction based on the Objective function and the active Design Requirements. When there are no active Design Requirements, the search direction will simply be in a direction influenced by the current gradient and previous search directions.
When there is an active Design Requirement, following the direction of greatest change may make the
design Infeasible. Instead, the search direction is modified to keep the solution in the feasible region. If a
Design Requirement is Violated, the search direction will attempt to return the solution to the feasible
region as quickly as possible.
This is the most robust method and can handle a wide variety of problems.
Note: Branch and Bound rapidly becomes inefficient with an increase in independent variables. For
discrete optimization with more than ten independently sized pipes, the Sequential Unconstrained, or Genetic Algorithm methods should be considered.

Sizing Control Parameters
l

Finite Difference Gradient Calculation - The most likely parameters to be changed, gradient calculation directly influences the search direction. See a detailed discussion in Estimating the Gradient.
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l

l

Method - Forward or Central, directly affects the quality of the gradient at the cost of
runtime. Central gradients are more accurate but require about twice as many hydraulic
solutions.

l

Step Size - How much to perturb the pipe sizes to determine the gradient. If the Objective
was known exactly, it would make sense to make these values very small. However, as
Arrow itself is an iterative solver, the Objective is only known to within a certain tolerance.
Making the Finite Difference Step Size too small actually introduces uncertainty into the
gradient and can therefore generate poor search directions making the process take
longer, if a solution can be found at all. A Step Size that is too large has a similar effect, so it
is important to select an appropriate value between the two extremes. The best value to
use depends on the system in question - when in doubt, use the default.

Print Text Debug File - Generate a tab-separated file reporting on each call to the hydraulic
solver. Actual pipe sizes are presented along with current Objective value and Design Requirement status.

Caution: The Advanced Control Parameters below should not be changed under normal circumstances without the direction of AFT Support.
l

l

l

Sizing Level Convergence
l

Maximum Iterations - This value is the number of sizing iterations, not the number of
hydraulic solutions allowed. Generally, the hydraulic solution is by far the slowest part of
the process, and as the number of uniquely sized pipes increases, so does the number of
required hydraulic solutions. A problem with 100 independently sized pipes would require,
at minimum, 100 hydraulic solutions just for 1 sizing iteration. That said, it is important to
have an adequate number of sizing iterations regardless of the number of variables - if the
process is stopped prematurely, the ideal sizes have not been found.

l

Consecutive Iterations for Convergence - The sizing process will be repeated at least
this number of times while satisfying the convergence criteria. It is helpful to allow additional iterations because the sizing process can occasionally make little change in one iteration and then significant change in the next.

l

Relative Tolerance - Changes smaller than this relative amount (default of 0.1%) are considered small enough to be converged. Note that the number of iterations requiring a
change in the value of the Objective smaller than this amount can be modified.

l

Absolute Tolerance - The value entered here is multiplied by the initial Objective value.
The resulting value is considered as an absolute tolerance. By default, the Objective is
scaled to 1,000 meaning that the default value of 0.0001 results in an absolute tolerance of
1,000*0.0001 = 0.1. Objective values smaller than 0.1 will use the absolute criterion
instead of the relative.

Sequential Unconstrained Parameters
l

Maximum Number of Independent Pipe Sizes for Branch and Bound - Discrete solutions with this method require the use of Branch and Bound. If the system has more independently sized pipes than this value, the Sequential Unconstrained will automatically be
used.

l

Sequential Unconstrained Parameters - See Sequential Unconstrained.

Design Requirement Tolerances
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l

l

l

Violated - A very small positive value, which allows Design Requirements to be violated. It
is important to allow this small violation for numerical reasons, as attempting to force values to zero is often difficult computationally.

l

Active - This small negative number determines how close to the Design Requirement the
Objective can be before the Design Requirement influences the search direction. This
value is updated automatically during the sizing process.

Scaling Parameters
l

Desired Objective Scaled Value - In some cases it is helpful to scale the value of the
Objective. Very large or very small unscaled Objective values can present numerical
issues, and scaling can help with this.

l

Scale Factor for Design Requirements
l

Common - Design Requirements are always scaled (dividing by the user defined
quantity) for numerical reasons. This factor allows additional scaling.

l

Violated Tolerance - This can be used to reduce the value of Violated Design
Requirement Tolerance. This can be useful if the small violation is unacceptable for
a feasible design.

Print Optimizer Debug File - Generate a debug file detailing the normalized and generalized
optimization process.

Related Topics
Search Methods
Sequential Quadratic Programming
Sequential Unconstrained
Genetic Algorithm

608
611
614
616

Related Examples
Beginner: Three Tank Steam System - ANS
Control Valve - ANS
Air Distribution, Multiple Design Cases - ANS
Helium Transfer - ANS
Natural Gas Burner - ANS
Process Steam System - ANS

853
867
913
922
932
948

Sequential Quadratic Programming
A Continuous Search Method available in the Sizing Method panel.
Sequential Quadratic Programming (SQP) finds the best case design by solving a series of quadratic
approximations to the Objective Function. Each of these "Sub-Problems" is solved with the Modified
Method of Feasible Directions. This method is often the best and most efficient if the problem is numerically well defined. Sizing with this method is always worth checking.

- 611 -

Add-on Modules

Note: Branch and Bound rapidly becomes inefficient with an increase in independent variables. For
discrete optimization with more than 10 independently sized pipes, the Sequential Unconstrained, or Genetic Algorithm methods should be considered.

Sizing Control Parameters
l

l

Finite Difference Gradient Calculation - The most likely parameters to be changed, gradient calculation directly influences the search direction. See a detailed discussion in Estimating the Gradient.
l

Method - Forward or Central, directly affects the quality of the gradient at the cost of
runtime. Central gradients are more accurate but require about twice as many hydraulic
solutions.

l

Step Size - How much to perturb the pipe sizes to determine the gradient. If the Objective
was known exactly, it would make sense to make these values very small. However, as
Arrow itself is an iterative solver, the Objective is only known to within a certain tolerance.
Making the Finite Difference Step Size too small actually introduces uncertainty into the
gradient and can therefore generate poor search directions making the process take
longer, if a solution can be found at all. A Step Size that is too large has a similar effect, so it
is important to select an appropriate value between the two extremes. The best value to
use depends on the system in question - when in doubt, use the default.

Print Text Debug File - Generate a tab-separated file reporting on each call to the hydraulic
solver. Actual pipe sizes are presented along with current Objective value and Design Requirement status.

Caution: The Advanced Control Parameters below should not be changed under normal circumstances without the direction of AFT Support.
l

Sizing Level Convergence
l

Maximum Iterations - This value is the number of sizing iterations, not the number of
hydraulic solutions allowed. Generally, the hydraulic solution is by far the slowest part of
the process, and as the number of uniquely sized pipes increases, so does the number of
required hydraulic solutions. A problem with 100 independently sized pipes would require,
at minimum, 100 hydraulic solutions just for 1 sizing iteration. That said, it is important to
have an adequate number of sizing iterations regardless of the number of variables - if the
process is stopped prematurely, the ideal sizes have not been found.

l

Consecutive Iterations for Convergence - The sizing process will be repeated at least
this number of times while satisfying the convergence criteria. It is helpful to allow additional iterations because the sizing process can occasionally make little change in one iteration and then significant change in the next.

l

Relative Tolerance - Changes smaller than this relative amount (default of 0.1%) are considered small enough to be converged. Note that the number of iterations requiring a
change in the value of the Objective smaller than this amount can be modified.

l

Absolute Tolerance - The value entered here is multiplied by the initial Objective value.
The resulting value is considered as an absolute tolerance. By default, the Objective is
scaled to 1,000 meaning that the default value of 0.0001 results in an absolute tolerance of
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1,000*0.0001 = 0.1. Objective values smaller than 0.1 will use the absolute criterion
instead of the relative.
l

l

l

l

l

Sub-Problem Iterations
l

Maximum - This is the maximum number of approximate problem cycles.

l

Consecutive for Convergence - The approximations will be repeated at least this number
of times while satisfying the Sizing Level Convergence tolerance criteria.

Sequential Unconstrained Parameters
l

Maximum Number of Independent Pipe Sizes for Branch and Bound - Discrete solutions with this method require the use of Branch and Bound. If the system has more independently sized pipes than this value, the Sequential Unconstrained method will
automatically be used.

l

Sequential Unconstrained Parameters - See Sequential Unconstrained.

Design Requirement Tolerances
l

Violated - A very small positive value, which allows Design Requirements to be violated. It
is important to allow this small violation for numerical reasons, as attempting to force values to zero is often difficult computationally.

l

Active - This small negative number determines how close to the Design Requirement the
Objective can be before the Design Requirement influences the search direction. This
value is updated automatically during the sizing process.

Scaling Parameters
l

Desired Objective Scaled Value - In some cases it is helpful to scale the value of the
Objective. Very large or very small unscaled Objective values can present numerical
issues, and scaling can help with this.

l

Scale Factor for Design Requirements
l

Common - Design Requirements are always scaled (dividing by the user defined
quantity) for numerical reasons. This factor allows additional scaling.

l

Violated Tolerance - This can be used to reduce the value of Violated Design
Requirement Tolerance. This can be useful if the small violation is unacceptable for
a feasible design.

Print Optimizer Debug File - Generate a debug file detailing the normalized and generalized
optimization process.

Related Topics
Search Methods
Modified Method of Feasible Directions
Sequential Unconstrained
Genetic Algorithm

608
609
614
616

Related Examples
Air Distribution - ANS

888
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Sequential Unconstrained
A Continuous Search Method available in the Sizing Method panel. This method is unique in that it has
an internal method to generate Discrete solutions as well.
Sequential Unconstrained (SU) finds the best case design by solving a series of unconstrained problems. This simplification is appealing because it is almost always easier to solve an unconstrained problem, making it possible to efficiently solve very large and complex problems. In order to account for the
Design Requirements, the Objective function is artificially increased in Infeasible regions. This has the
effect of driving the unconstrained solution into the feasible region.
Artificially increasing the Objective a large amount on the first cycle creates a numerically ill-conditioned
problem which is difficult to solve. Instead, only a small penalty is added initially. This means it is likely
the solution on the first cycle will be infeasible. The next cycle increases the penalty factor and uses the
results of the previous cycle as a starting point. In this way, the optimum point is moved toward the feasible region in small, numerically stable, steps. Once the result of an unconstrained cycle ends in the feasible region, the process is stopped.

A Hybrid Method
The Modern Penalty Method does not use Branch and Bound for the determination of Discrete sizes.
Instead, it can force the continuous solution into discrete "slots" by creating an artificial set of constraints
after the continuous solution is complete. This prevents the need for searching an exceptionally large
"tree" that would result with Branch and Bound. However, the method is generally only effective at finding
discrete sizes +-1 size away from the continuous solution.

Sizing Control Parameters
l

l

Finite Difference Gradient Calculation - The most likely parameters to be changed, gradient calculation directly influences the search direction. See a detailed discussion in Estimating the Gradient.
l

Method - Forward or Central, directly affects the quality of the gradient at the cost of
runtime. Central gradients are more accurate but require about twice as many hydraulic
solutions.

l

Step Size - How much to perturb the pipe sizes to determine the gradient. If the Objective
was known exactly, it would make sense to make these values very small. However, as
Arrow itself is an iterative solver, the Objective is only known to within a certain tolerance.
Making the Finite Difference Step Size too small actually introduces uncertainty into the
gradient and can therefore generate poor search directions making the process take
longer, if a solution can be found at all. A Step Size that is too large has a similar effect, so it
is important to select an appropriate value between the two extremes. The best value to
use depends on the system in question - when in doubt, use the default.

Print Text Debug File - Generate a tab-separated file reporting on each call to the hydraulic
solver. Actual pipe sizes are presented along with current Objective value and Design Requirement status.
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Caution: The Advanced Control Parameters below should not be changed under normal circumstances without the direction of AFT Support.
l

l

l

Sizing Level Convergence
l

Maximum Iterations - This value is the number of sizing iterations, not the number of
hydraulic solutions allowed. Generally, the hydraulic solution is by far the slowest part of
the process, and as the number of uniquely sized pipes increases, so does the number of
required hydraulic solutions. A problem with 100 independently sized pipes would require,
at minimum, 100 hydraulic solutions just for 1 sizing iteration. That said, it is important to
have an adequate number of sizing iterations regardless of the number of variables - if the
process is stopped prematurely, the ideal sizes have not been found.

l

Consecutive Iterations for Convergence - The sizing process will be repeated at least
this number of times while satisfying the convergence criteria. It is helpful to allow additional iterations because the sizing process can occasionally make little change in one iteration and then significant change in the next.

l

Relative Tolerance - Changes smaller than this relative amount (default of 0.1%) are considered small enough to be converged. Note that the number of iterations requiring a
change in the value of the Objective smaller than this amount can be modified.

l

Absolute Tolerance - The value entered here is multiplied by the initial Objective value.
The resulting value is considered as an absolute tolerance. By default, the Objective is
scaled to 1,000 meaning that the default value of 0.0001 results in an absolute tolerance of
1,000*0.0001 = 0.1. Objective values smaller than 0.1 will use the absolute criterion
instead of the relative.

Sub-Problem Iterations
l

Maximum - This is the maximum number of approximate problem cycles.

l

Consecutive for Convergence - The approximations will be repeated at least this number
of times while satisfying the Sizing Level Convergence tolerance criteria.

Sequential Unconstrained Parameters
l

Maximum Number of Independent Pipe Sizes for Branch and Bound - Not used when
Sequential Unconstrained is directly selected.

l

Number of Discrete Iterations - This number of cycles with the artificial discrete constraints in place will be run. If this value is greater than 1, it is possible that discrete sizes
more than one size away from the continuous solution can be found. However, this does
not force an exhaustive search of all potential discrete sizes in this range.

l

Continuous Penalties

l

l

Initial Multiplier - This is the penalty applied to the Objective in the first continuous
unconstrained cycle.

l

Multiplier on Additional Iterations - The penalty is increased by this amount each
continuous cycle.

Discrete Penalties
l

Initial Multiplier - This is the penalty applied to the Objective in the first discrete
unconstrained cycle.
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l

l

l

l

Multiplier on Additional Iterations - The penalty is increased by this amount each
discrete cycle.

Design Requirement Tolerances
l

Violated - A very small positive value, which allows Design Requirements to be violated. It
is important to allow this small violation for numerical reasons, as attempting to force values to zero is often difficult computationally.

l

Active - This small negative number determines how close to the Design Requirement the
Objective can be before the Design Requirement influences the search direction. This
value is updated automatically during the sizing process.

Scaling Parameters
l

Desired Objective Scaled Value - In some cases it is helpful to scale the value of the
Objective. Very large or very small unscaled Objective values can present numerical
issues, and scaling can help with this.

l

Scale Factor for Design Requirements
l

Common - Design Requirements are always scaled (dividing by the user defined
quantity) for numerical reasons. This factor allows additional scaling.

l

Violated Tolerance - This can be used to reduce the value of Violated Design
Requirement Tolerance. This can be useful if the small violation is unacceptable for
a feasible design.

Print Optimizer Debug File - Generate a debug file detailing the normalized and generalized
optimization process.

Related Topics
Search Methods
Modified Method of Feasible Directions
Sequential Quadratic Programming
Genetic Algorithm
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Genetic Algorithm
A Discrete Search Method available in the Sizing Method panel. This method is fundamentally discrete
and does not use gradients in its search.
The Genetic Algorithm is a type of Evolutionary Algorithm - as the name implies, it selects advantageous
traits by emulating biological evolution. An initial "population" of potential solutions is generated and
gradually improved.
The starting population is an effectively random selection of "individuals". In the context of ANS, an individual is a proposed selection of pipe sizes for the system in question. At the start of the sizing process,
these individuals may have an assortment of good and bad traits. A "bad" trait might be one that violates
a Design Constraint or increases the cost of the system.
To improve the Fitness of the population there are three major operations: Selection, Crossover, and
Mutation.
Selection occurs by determining the "Fitness" of all individuals in the population. Objective value is not
the only concern when determining how acceptable any given individual is, so we need a different
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function to represent this. This function is a Fitness Function. The Fitness of any given individual is measured based on its Objective value and proximity to, or violation of, Design Requirements. Like Darwin's
theory of "Survival of the Fittest" the goal in this process is to maximize the Fitness of the population as a
whole. With the Fitness known for all individuals, a parent population with high Fitness can be selected.
Crossover occurs by "breeding" the parent solutions to generate new solutions. Some of these solutions
will, randomly, have inherited good traits from their parents. Others will have inherited bad traits.
Mutation occurs after crossover, introducing a further element of randomness into the system by changing traits with no regard to the parent traits. This allows the algorithm to consider new solutions that
were not previously part of the "gene pool." If no new traits can be introduced, the flexibility of the method
is limited. If the mutation rate is too high, however, the good traits will not be carried through to new generations as effectively.
The new population is then combined with the parent population, and the process is repeated.
Note: When sizing with a Discrete method, it is possible to start the search with a Continuous Method.
This limits the search space which should reduce the run time. When this option is enabled, the
user has control over both the Continuous and Discrete methods.

Sizing Control Parameters
l

Genetic Algorithm Population Size
l

Number of Discrete Sizes Around Continuous Solution - If Start with Continuous
Method is selected, this option limits the search space of the genetic algorithm by only considering discrete sizes close to the continuous solution. For example, a Candidate Set may
contain 20 unique sizes. Including all of these sizes makes the problem extremely complex,
as indicated in Brute Force Method. It is likely that the best discrete solution is near the best
continuous solution, so only searching 4 unique sizes (+/- 2) around the continuous solution can dramatically reduce runtime.

l

Automatic - Set the User Specified Multiplier to 2 to determine the size of the population to
use.

l

User Specified Multiplier - Every independently sized pipe in the model has a certain
number of possible sizes that it may be, as determined by its particular Candidate Set.
Because every independently sized pipe in the model can have a unique Candidate Set, it
can also have a unique count of possible sizes. This multiplier is based on the sum of all of
these counts across the model. For example, if there are 2 independently sized pipes with
Candidate Sets P1: (4", 6") and P2 (3", 4", 6", 8"), the total count will be 6, and a multiplier
of 3 would give a population size of 18.

l

User Specified Population - The size of the population can also be directly specified. It is
important the population size is not too small as this will artificially limit the capability of finding a good solution. However, population sizes too large will not solve in a reasonable time
frame.

Caution: The Advanced Control Parameters below should not be changed under normal circumstances without the direction of AFT Support.
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l

Genetic Algorithm Seed - This number is used to generate a "random" population. The same
number will always generate the same initial population.

l

Genetic Algorithm Parameters

l

l

Crossover Probability - The average fraction of the population obtained from crossover.
As a probability this does not mean exactly this fraction will be obtained. This value is typically close to 1, meaning that the majority of the population each generation is obtained as
children of the parent generation. It is generally less than 1 to avoid losing very good solutions from the parent generation due to poor crossover.

l

Crossover Distribution Index - This value is inversely proportional to allowed perturbations caused by crossover. That is, a large value will limit the amount of perturbation
generated from crossover, whereas a small value will allow significant perturbation.

l

Mutation Probability - The average fraction of the population subjected to mutation. As a
probability this does not mean exactly this fraction will be obtained. This value is typically
the inverse of the number of independently sized pipes. As the system (and usually, population) gets very large, the need for "additional" randomness decreases. However, for
small systems this randomness is important to introduce to prevent a premature solution.

l

Mutation Distribution Index - This value is inversely proportional to allowed perturbations
caused by mutation. That is, a large value will limit the amount of perturbation generated
from mutation, whereas a small value will allow significant perturbation.

Genetic Algorithm Convergence
l

Consecutive Unimproved Generations - When no improvements in the Objective occur
over this number of generations, the sizing process will be stopped and the results are
presented. It is assumed from the lack of progress that the ideal solution has been found. It
is impossible to tell in advance how many total iterations this condition may require.

l

Fixed Number of Generations - To limit the runtime to a length that can be estimated, the
algorithm can be set to a specific count of generations. This should be used with caution as
it is possible to end before the best solution has been found, or to continue long after the
best solution has been found.

Related Topics
Search Methods
Modified Method of Feasible Directions
Sequential Quadratic Programming
Sequential Unconstrained
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Sizing Theory
Automated Pipe Sizing is a small subset of the mathematical field of Optimization. This is a complex subject that has evolved over many years - the topics here are not attempting to replicate this complexity but
instead provide simplified understanding of the methods so that users of ANS can appropriately size systems and adjust models and parameters as needed.
l

Sizing and Optimization - ANS is designed to simplify the optimization problem as much as possible. Those familiar with optimization may find this topic useful to connect common optimization
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terms to those used in ANS.
l

Boundaries vs. Design Requirements - "Requirements" can be defined in many ways. Boundaries
force a certain flow or pressure, whereas Design Requirements place limits on allowable values.
While similar, the distinction is important in a sizing context.

l

Physical Parameters vs. Monetary Cost - Monetary Cost sizing is often difficult to the amount of
data required. For this reason, minimum cost is often estimated with a physical parameter, such
as pipe weight.

l

Brute Force Method - The most basic way to conclusively find a minimum is to exhaustively test all
possibilities. This is impossible on a realistic time scale for most systems.

l

Gradient Based Methods - The fastest methods for solving a continuous Objective are based on
gradients. Understanding the core of these methods can help in finding better solutions more
quickly.

l

Estimating the Gradient - The gradient is only estimated - not analytically determined. This fact
means the associated parameters may require adjustment in some cases. Understanding the
affect of these adjustments is important.

l

Branch and Bound - Only some methods are inherently suited to discrete sizing. Gradient based
methods usually rely on narrowing the solution space and solving a number of easier problems.

Related Topics
Sizing and Optimization
Boundaries vs. Design Requirements
Physical Parameters vs. Monetary Cost
Brute Force Method
Gradient Based Methods
EstimatingTheGradient.html
Branch and Bound
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Sizing and Optimization
Techniques for minimizing or maximizing certain parameters - optimization - have been used throughout
a variety of industries for many decades. As computers become more prevalent and more powerful, they
are able to handle larger problems with more variables and greater complexity. Optimization problems
can be enormously complex, and techniques for solving them are almost always iterative. Such problems
are generally impractical to solve without a computer.
The selection of pipe sizes to minimize some parameter - often monetary cost - is one specific example
of optimization. For the sake of clarity, the mathematical terminology used when discussing optimization
problems is compared to the terminology used in the ANS module here.
l

Optimization - Modifying a system to minimize or maximize some parameter.
l

l

In ANS - This is represented by the name of the module - Automated Network Sizing. The
sizes of the various network pipes are modified automatically by the application, to achieve
some goal.

Objective - The goal of optimization is referred to as the Objective. Minimizing monetary cost is a
very common Objective. Others may be minimizing the time to complete an action, or maximizing
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the amount of material a machine can process.
l
l

Objective Function - It is required that the Objective can be calculated for any configuration of
the system. This calculation is represented by the Objective Function, much like any other mathematical function. The Objective is to find the global maximum or minimum of this Objective Function.
l

l

In ANS - Is not a user input, and is not visible.

Constraint - Anything that is required by the system regardless of the Objective value. For
example, an Objective might be to minimize the amount of cloth needed to make a blanket. The
smaller the blanket, the less material it needs, but a tiny blanket is not very useful. Instead, the
Optimization might be Constrained such that the blanket must be some minimum area.
l

l

In ANS - The term Objective is retained.

In ANS - These are called Design Requirements.

Design Variable - Anything that is allowed to change in order to modify the Objective value. In the
blanket example, this might be the width, length, and thread count of the blanket. As with any
mathematical problem, the more variables there are, the harder the problem is to solve.
l

In ANS - The variables that are allowed to change are the pipe sizes. There are countless
ways a fluid system could be Optimized, but pipe sizing is one of the most significant that
will impact cost. The total number of design variables in the current analysis is displayed
near the bottom of the Size/Cost Assignments panel as Independently Sized Pipes.

Related Topics
Sizing Theory
Boundaries vs. Design Requirements
Physical Parameters vs. Monetary Cost
Brute Force Method
Gradient Based Methods
EstimatingTheGradient.html
Branch and Bound
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Boundaries vs. Design Requirements
Boundaries
Points in a model that physically force a given parameter.
A piping network can be considered to have three variables - flow, pressure, and the system. For analysis, it is required that the user fully define the system. The system is a collection of components that
affect the flows and pressures - pipes, compressors, valves, etc. Because there are still two variables flow and pressure - the user must specify at least one of them as a boundary somewhere in the system.
Note: Due to the nature of fluid analysis, if there is only one boundary it must be a pressure type
boundary. See Role of Pressure Junctions.
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For a model to be accurate, its entire definition must reflect the system it is representing. This includes
both the system and the boundaries. It is obvious that a 120 foot, 12" diameter pipe should be represented in the model with the same length and diameter. However, ensuring the correct selection of
boundaries is often less intuitive.
Specifying any given boundary as a fixed pressure will result in some calculated flow at that boundary.
Changing this pressure boundary to a flow boundary with the calculated value will not change any of the
pressure or flow results in the model. However, this has important physical implications.
For example, consider a pipe bounded by two pressures. Doubling the pipe size will significantly increase
flow. However, if a boundary was instead a fixed flow, doubling the pipe size will not change the resulting
flow but instead change the pressures at the flow boundary. If the boundary in the real system is a large
fixed pressure tank, it should not be represented as a fixed flow, because changes to the system will
effectively change the pressure required in the tank. In other words, changing the system changes the
physical meaning of the boundary. If the tank is represented as a fixed pressure, as it behaves in the
field, this is not an issue.
This is important in ANS because ANS is changing the system as part of the sizing process. Using the
incorrect type of boundary can present sizing solutions that would not work in the real system.
Note: It is not uncommon or incorrect to use boundaries to represent a requirement in an analysis.
This is a common design tool to determine what is required of a boundary. In the above
example, it may be desired to know the required tank pressure to drive the required flow. What
is important is to recognize whether a junction is representing a requirement or a physical boundary that cannot be changed.

Design Requirements
Design Requirements are limits on allowable behavior.
The distinction is important because Design Requirements are limits rather than imposed values. For
example, a Design Requirement may state that a flow must be at least 100 feet3/min. The design is considered acceptable if the flow ends up as 120 feet3/min. On the other hand, using a boundary of 100
feet3/min forces the model always to maintain 100 feet3/min.
In this manner, Design Requirements are less restrictive than boundary conditions. Generally, the less
restrictive the problem is, the more flexibility is available to obtain a better sizing result.
Even if it is known that there must be some fixed flow into a tank, using an Assigned Flow boundary at
this location may not be the best choice. If the pressure in the tank cannot be changed to the value calculated based on the sizing result, the use of an Assigned Flow here would be incorrect. Instead, it would
be appropriate to use an Assigned Pressure and two Design Requirements on flow - a minimum and a
maximum, to limit the solution to an acceptable range.

Related Topics
Sizing Theory
Sizing and Optimization
Physical Parameters vs. Monetary Cost
Brute Force Method
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Gradient Based Methods
EstimatingTheGradient.html
Branch and Bound
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Physical Parameters vs. Monetary Cost
There are four physical parameters that can be maximized or minimized in addition to monetary cost:
l

Pipe Weight

l

Pipe and Fluid Weight

l

Flow Volume

l

Pipe Inner Surface Area

Actual Objective is to Limit the Physical Parameter
Occasionally, the goal of the sizing is to limit the physical parameter. For example, a system to be placed
on an aircraft likely has greater emphasis on weight than monetary cost. It is important to keep in mind in
such cases that only the pipes are included in the total Objective value. Compressors, valves, or
other junctions that contribute to weight are not accounted for. This may affect the ideal sizing.

Using a Physical Parameter to Estimate Cost
There are advantages and disadvantages of estimating cost with a physical parameter.
It is generally far easier to use a physical parameter as cost libraries are not required. Cost libraries
are difficult to locate information for, and can be time consuming to create and manage. Avoiding this
greatly simplifies the process.
The main disadvantage is that only initial pipe costs can be accounted for. If junctions account for a
significant portion of the initial cost, or if the recurring costs from operating them would affect sizing, then
this may not result in the best sizing solution.
In general, if the goal is to minimize monetary cost of a system, then monetary information should be supplied. If recurring costs must be included, this is the only reasonable option. However, physical parameters often provide a good estimate of the ideal size for initial cost. It makes sense to start the sizing
process with a physical parameter, and proceed to monetary cost as the Objective after larger design
issues have been resolved. This is especially true if the potential savings are large.
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Figure 1: Comparison of Dimensionless Costs for Schedule 40 ANSI Steel water pipe. RS Means monetary
cost closely follows pipe weight in this example.

Related Topics
Sizing Theory
Sizing and Optimization
Boundaries vs. Design Requirements
Brute Force Method
Gradient Based Methods
EstimatingTheGradient.html
Branch and Bound
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Related Examples
Natural Gas Burner - ANS

932

Brute Force Method
The "easiest" way to find the cheapest set of pipe sizes is to test all of the possible combinations exhaustively, and report back the lowest cost option found.
This has the advantage that it is clearly conclusive - there can be no argument that a cheaper alternative
exists if every possible alternative was shown to have higher cost. Unfortunately, this method is
extremely impractical for any reasonably sized problem. The number of required analyses to find the current value of the Objective is related to the number of design variables and how many unique discrete
sizes each variable can have.
In the context of ANS, this is the number of Independently Sized Pipes, and the number of selections in
the Candidate Set, assuming there is one set for the model.
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If we have only 3 independently sized pipes, and can only choose from 3 different pipe sizes, then we
would need to solve 27 unique hydraulic models, which could be manageable by hand.
However, if we have 12 independently sized pipes, and can choose from 6 different pipe sizes, we suddenly have over 2 billion unique models to solve. If we could test 50 models every second, this would
take over a year to complete - and it is still a relatively small system!
Due to the clear impracticality of this method, it is not used in ANS.

Related Topics
Sizing Theory
Sizing and Optimization
Boundaries vs. Design Requirements
Physical Parameters vs. Monetary Cost
Gradient Based Methods
EstimatingTheGradient.html
Branch and Bound
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Gradient Based Methods
Gradient based methods search for the ideal solution using the gradient of the Objective Function. A
gradient is a vector function composed of partial derivatives measuring the change of some function with
respect to each component. Effectively, a gradient is a derivative of a multi-variable function - it indicates the magnitude and direction of greatest change in a multi-variable function.
A gradient of a single variable function is simply the derivative of that function. While most problems
requiring complex optimization techniques have many variables, it is easiest to think about a single-variable function, such as elevation related only to distance along some horizontal line:

Figure 1: One of many possible elevation profiles of a mountain peak. The slope can be calculated at any
point.
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The gradient of a mountain's elevation will indicate the magnitude and direction of the elevation change
at any given latitude and longitude. In other words, given a specific point, the gradient will tell you how
steep the slope is at that point, and which direction it is steepest in. This is very useful for finding the top
of the mountain - without being able to see anything but the local value of the gradient, you can make an
estimate that the peak is probably in the direction of the slope, and that if the slope is very steep you likely
have a long ways to go.
If the entire elevation profile was known ahead of time, finding the peak is trivial. Unfortunately, we do not
normally know the entire profile, but instead can only determine its value where we explicitly test it.
Stated generally, the shape and behavior of an Objective Function is not known ahead of time.
Rather than testing every single horizontal point to find the highest elevation by brute force, we can an
employ an intelligent gradient based search method. Starting at a horizontal distance of zero, we can
measure an elevation and slope:

Figure 2: Starting a gradient based search

With the positive slope from our initial condition, we can make an educated guess that the peak is somewhere in the positive direction. We determine where we want to guess and measure our system again at
that point:

Figure 3: Iteration number 2
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Because our slope is higher, we assume that the peak is farther away and adjust our change in distance
accordingly. Our new guess has a negative slope, so we will reverse our search direction.

Figure 4: Iteration number 3

We changed sign on slope again, so we reverse direction again. We can use information from previous
guesses to narrow down the search range and make a more intelligent guess.

Figure 5: Iteration number 4

As we continue, the adjustments to our guess get smaller and smaller. Once they are small enough, we
can consider the search converged, and the peak found.
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Figure 6: Iteration number 5

In only a few iterations, we have found an excellent approximation of the highest point, without knowing
anything about the elevation or slope outside of our selected guess points.
The search algorithms included in ANS are much more sophisticated than the simple example presented here, but the idea remains the same. Furthermore, the allowable selections are restricted by Design
Requirements, which impacts the ideal search direction.

Related Topics
Sizing Theory
Sizing and Optimization
Boundaries vs. Design Requirements
Physical Parameters vs. Monetary Cost
Brute Force Method
EstimatingTheGradient.html
Branch and Bound
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EstimatingTheGradient.html
Analytically determining the gradient becomes extremely difficult if not impossible for problems with
many variables such as sizing a piping network. Instead, the gradient is estimated with a finite difference. This is a method for numerically estimating the gradient at a given point.
The test points created with a finite difference method each represent a hydraulic model that must be
solved independently. If the model is complex, adding additional variables (unique pipe sizes) or required
runs (from a central difference) can make the process take a significant amount of time.
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Forward Difference
The Forward Difference estimates the gradient by finding the change in the function value by making a
small change in the independent variable.
First, an initial result is found. We want to know the gradient at this point.

Figure 1: An initial test. It is desired to know the gradient at this point.

The independent variable is perturbed some small amount and a new result found. A line can be drawn
through these two points - an estimate of the gradient at the initial point.
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Figure 2: A perturbation. This allows the calculation of an average gradient as an approximation of the gradient at the initial point.

There are two important things to keep in mind:
l

This is an average gradient between the two points, but it is used as an estimate of the gradient
at the initial point. It is not used to represent the behavior between the two points.

l

It is only an estimate. The result depends on the behavior of the Objective Function, and
the selection of the test point.

Figure 3: The actual gradient depends on the function. Many possible functions pass through two test points.
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Central Difference
The central difference is a very similar process, with generally increased accuracy. We still want to know
the gradient at our initial point (Figure 1), but instead of creating one test point, we create two, equidistant
from the initial position. This effectively doubles the number of calculations required.

Figure 4: Central Difference estimate of gradient at the initial point

Relationship to Iterative Tolerance
It may seem that simply making the perturbation in the Inner Diameter smaller will increase the accuracy
of the gradient and help reduce the issue indicated by Figure 3. If the Objective function was known explicitly, this would be a good assumption. However, in ANS, the results are not known explicitly. Instead,
the solution is found via iteration. Iterative methods require some determination of convergence namely, a tolerance on the solution. This means, by definition, that the results found are not the exact,
analytical solution. Further, it is impossible to tell how the results may be biased away from the true solution.
When making test points, as before, there is some band of uncertainty in the Objective Value for the point
related (but not necessarily equivalent) to the iterative tolerance.
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Figure 5: Uncertainty in the Objective Value due to iterative tolerance

We do not know where the "true" Objective Value lands on either of these bands, and we cannot state
that the error is in the same direction or is of the same magnitude for both test points. This means that the
gradient estimations have some variability as well.

Figure 6: Uncertainty in the estimated gradient

In addition to the uncertainty indicated by Figure 3, there is also added uncertainty from the iterative tolerance.
It can be tempting to reduce the step size to increase gradient accuracy, but the iterative error will not be
reduced. This can have dramatic results on the gradient.
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Figure 7: Substantially increased uncertainty in the estimated gradient from decreasing the step size

Now, due to the iterative tolerance, it is possible that the gradient is dramatically affected to the point
where even the sign is uncertain.
Note: Making the step sizes too large impacts the gradient negatively in other ways. The critical thing
to remember is that the step size should be small enough to capture the changing Objective, but
not so small the iterative tolerance impacts the gradient quality.

Related Topics
Sizing Theory
Sizing and Optimization
Boundaries vs. Design Requirements
Physical Parameters vs. Monetary Cost
Brute Force Method
Gradient Based Methods
Branch and Bound
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Branch and Bound
Piping is almost always only available in Discrete sizes. Determining the best case selection of Discrete
sizes requires a different approach than finding the best case Continuous sizes. One such method is
Branch and Bound which is used for Discrete sizing on the basis of one of the Gradient Based
Methods.
Branch and Bound divides the sizing problem into a collection of smaller sizing problems (branches).
Solving these "sub-problems" gives information (bounds) about whether or not a given sub-problem is
worth further investigation.
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This method is well suited to problems with a relatively small number of variables (unique pipe sizes). For
more than 10 variables, the Sequential Unconstrained method is advised. It is difficult to tell in advance
how well any search method will work, and Branch and Bound is no different. It is possible, though
unlikely, that the method can effectively reduce to a Brute Force Search. This makes it effective, but
potentially very slow.

Example
There is a 50 foot pipe followed by a 100 foot pipe, and a 5 psid differential across the pipes. The piping is
available in integer inside diameters between 3 and 17 inches, and the pipe walls thickness is always
10% of the inside diameter. Our goal is to minimize the weight of this system, while maintaining a flow of
at least 2500 gal/min.
Even though there are only two independent pipe sizes to consider, with 15 possible pipe sizes, there are
225 possible permutations, more than we would like to test by brute force.
We start the process by finding the Continuous Optimum. For this example, this best case is (P1 =
8.75 in, P2 = 8.77 in, Weight = 2772 lbm). It is reasonable to assume that the Discrete Optimum will be
near these sizes.

From this first node, we want to divide the solution space on our first variable - the diameter of pipe P1.
The pipe size cannot be 8.75 inches, it can only be a discrete size, in our case an integer value. Therefore, we branch into two sub-problems with pipe P1 restricted to less than 8 or more than 9 inches. We
have also established a bound on the problem - the solution will never have a feasible weight lower than
2772 lbm.
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It is important to note that these additional nodes represent continuous sub-problems. The pipe size is
not forced to be discrete, it only has an additional requirement on it. The resulting pipe size will often be
discrete because that continuous diameter is closest to the overall lowest feasible weight.
We can solve each of these independent problems with the same methods we used to solve the first
node.

Due to the nature of this particular problem, the ideal pipe sizes for pipe P1 in both Node 2 and Node 3
ended up as discrete sizes. This is not required or enforced by the method. Each of our nodes also has
its own bound. This fact is used to determine the location of the next branch. Because Node 3 has a better possible solution (2782 lbm) than Node 2 (2903 lbm), we branch from Node 3. This time, however, we
place a restriction on our second pipe's diameter.
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Both of our branches from Node 3 resulted in discrete size selections. However, Node 4 was not able to
result in a feasible solution. Infeasible nodes are valuable as there is no need to branch from them
- placing further restrictions on a problem will never make it feasible. Node 5 on the other hand is
both fully discrete and feasible. This is our first potential discrete solution. It is only a potential solution
because Node 2 has a lower bound - without branching from Node 2, we do not know if a better discrete
solution may exist under it, so branching from Node 2 is exactly how we proceed.
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One of our nodes is infeasible, and despite the lower weight cannot be considered. Node 7, however, is
feasible but not discrete, despite the requirements on diameter on both pipes. We could branch again
from Node 7, but there is no need - we have already found our ideal solution at Node 5. We know
this is the best possible discrete solution because the Node 7 continuous solution has a higher minimum
weight than Node 5. No matter how we branch from Node 7, we will never get a better solution than Node
5.
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Again, note that the results on Node 5 are a continuous solution. It is only because of the requirements
we have placed on the problem that the sizes have resulted in discrete sizes.
We have managed to find the best possible discrete solution by running seven independent continuous
sub-problems, instead of hydraulically solving hundreds of possible configurations. With more independent pipe sizes, the elimination of certain branches often becomes more common, further reducing
the cases we need to check.

Related Topics
Sizing Theory
Sizing and Optimization
Boundaries vs. Design Requirements
Physical Parameters vs. Monetary Cost
Brute Force Method
Gradient Based Methods
EstimatingTheGradient.html
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XTS - Extended Time Simulation
What is the XTS module?
An optional add-on module to AFT Arrow which allows users to simulate system transient behavior.
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While steady-state modeling answers many design questions, some questions cannot be adequately
answered without considering how systems behave over time. Questions such as how long it will take to
fill a tank require a dynamic system model. The AFT Arrow XTS module answers such questions.
The XTS module allows you to model transient system behavior. Users can specify the time duration of
the simulation, time step size, control system parameters, and how components such as compressors
and valves operate over time. Operations such as valve position changes can occur during a specified
time schedule, or can occur in response to events in the system thereby simulating control system
actions.
Users can also specify tank volume on “finite” tanks, so that tank pressurizing and depressurizing can be
simulated based on system pressures and flowrates.
The XTS module is a powerful tool which extends AFT Arrow’s powerful modeling capabilities into the
dimension of time.
Note: Transient modeling with XTS does not support heat transfer.

How Does the XTS Module Work?
The XTS module can be described as using a lumped or quasi-steady approximation to time simulation.
This means it represents the transient system behavior as a sequence of pseudo-steady-state solutions.
In between each pseudo-steady-state solution it adjusts transient parameters, performs mass balances
on tanks, and changes component operations as specified by the user.
As a thought experiment, consider a system which you want to simulate for ten minutes in one minute
increments. This would require eleven time step solutions (time zero and each minute up to ten). You
could manually do this with standard AFT Arrow by running a steady-state model eleven times, and in
between each run adjusting the input parameters for the next run based on the results of the previous
run. The XTS module automates this manual process.
Besides the automation benefits, the XTS module offers additional benefits such as transient output
data management, consolidation and display, and graphing tools to review the transient results.

Using the XTS Module
The user has the option of activating or not activating the XTS module when AFT Arrow first loads. After
AFT Arrow is loaded, the XTS module can be activated or deactivated for use from the Modules panel in
the Analysis Setup window or the Tools menu. Whether or not XTS is activated impacts the Analysis
menu, Analysis Setup window, Status Bar and multiple other AFT Fathom functions as is discussed in
the Modules panel topic.
If the XTS module is active, the user can still run models in Steady Only mode by selecting this under
Time Simulation on the Analysis menu. Hence there are three possibilities for XTS:
l

XTS is not active

l

XTS is active and operated in Steady Only mode

l

XTS is active and operated in Transient mode
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Types of Transients Modeled
l

l

l

Tanks l

Tanks can be modeled as finite tanks with user specified tank volume and initial conditions.

l

Finite reservoirs with known initial conditions allow AFT Arrow to model how tank pressure,
temperature, and gas mass change over time to simulate tank pressurization and depressurization and its impact on the flow in the system.

Compressor/Fan transients l

Compressors/Fans can be started or stopped based on time or event transients

l

Compressor/Fan speed can be changed with time

l

Controlled setpoints can be changed with time

Valve transients l

l

Control Valve transients l

l

Valves can be closed or opened based on time or event transients
Control valve setpoints can be varied based on time or event transients

Other junction transients l

Spray Discharge junctions can be closed or opened based on time or event transients

l

Assigned Flow junctions can have flow and temperature varied based on time or event transients

l

Assigned Pressure junctions can have pressure and temperature varied based on time or
event transients

l

Tank junctions can have liquid level or surface pressure varied based on time or event transients

l

Heat Exchanger junctions can have a specified heat rate varied based on time or event
transients

Related Topics
Modules Panel
Add-on Modules
GSC - Goal Seek & Control
ANS - Automated Network Sizing
Transient Control Group
Simulation Duration Panel
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Related Blogs
Introducing the New Arrow XTS Module!
What Is Transient Analysis?

Choosing Time Simulation
(XTS Module Only) When using XTS, the option Time Simulation appears in the Analysis Menu. This
drops down to two menu choices: Steady Only and Transient (Figure 1). Users can thus build models
with XTS activated that include steady-state and transient simulations.
The Transient option requires the Transient Control Group to be defined in addition to the other typical
settings. The Steady Only option makes the Transient Control Group settings optional.

Figure 1: Time Simulation option in the Analysis menu

Related Examples
Air Receiver Tank - XTS
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Junction Transient Data
(XTS Module Only) Many junction types can have active transient data specified. The junction types are
listed in Table 1:

Table 1: Junctions that support transient data

Junction Type

Type of Transient

Assigned Flow

Flow rate and temperature

Assigned Pressure

Pressure and temperature
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Control Valve

Setpoint

Compressor/Fan

Speed, flowrate, control setpoint

Tank

Temperature, Pressure, Volume, or Heat
Rate

Spray Discharge

Flow area

Valve

K, Cv, or open percentage

Heat Exchanger

Heat Rate

The active transient data is entered on the Transient tab (Figure 1). The type of data that can be entered
for each junction type is listed in Table 1. If a junction does not have any active transient behavior, there
is no need to enter any data on the Transient tab.
In most cases, transient data can be entered as absolute values or as a percentage of steady-state. The
distinction is made when choosing between Absolute Values and Relative to Steady-State Value. Some
junctions may have additional options, such as the Valve junction (Figure 1).
The first data point always needs to match the steady-state value which is usually entered on the tab at
the far left. If, for example in Figure 1, the steady-state data for Cv of 260 is changed to 200, the transient
data will also need to be changed. However, if in Figure 1 the Relative option is specified, the first data
point would be 100%, and when the Cv is steady-state is changed from 260 to 200 there is no need to
change the transient data since the first data point is still 100%. But it is now relative to a different steadystate value.

Figure 1: Example of junction transient data
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Repeat Transient
If the transient data is periodic, you can enter the data for one cycle of the period and then tick the check
box for Repeat Transient. This will cause the one cycle of transient data to be repeated once it has
reached the end. The repetition will continue until the end of the simulation.

Transient Special Conditions
There may be occasions where, once having entered the transient data, you do not wish the transient to
activate for a particular scenario. One option is to just delete the transient data. A second option is to specify the Transient Special Condition as Ignore Transient Data. In such a case, the data can be left in the
window for future use, but will not activate during the run.
In Figure 1, there is an area called Initiation of Transient, and the selection is Time. This means that the
specified transient is linked to the time of the simulation. Specifically, the valve transient data is activated
as soon as the simulation is started. If the transient data was defined to have a constant Cv for one
second, the valve does not start to close until the simulation time reaches one second.
Transients can also be initiated based on events. For instance, we can change the valve in Figure 1 to
start closing when the pressure at some other system location reaches a certain level. Or maybe when a
tank has reached a given pressure. In such a case, the time zero data in Figure 1 does not refer to the
start of the simulation, but is relative to when the event occurs. If, for instance, the pressure never
reaches the specified value, the valve never closes.

Related Examples
Air Receiver Tank - XTS
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Related Blogs
And, Not, Or - Starting Transient Events with Complex Logic

Initiation of Transients
(XTS Module Only) In general, transients can be initiated according to a certain time or according to certain events that happen in the system. These two categories are referred to as time based and event
based transients. This is defined in the Initiation of Transient area of a junction's transient tab.

Figure 1: Type of transient initiation
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It is helpful to consider the different time scales that are used when referring to the initiation of a transient,
as shown in Figure 2.
Absolute and Simulation Time are often identical. The simulation Start Time is set in Simulation Duration
panel to an Absolute Time of zero seconds by default, but it could be non-zero. In Figure 2, the Simulation Start Time is set to a value of 2 seconds – the entire Simulation Time timeline is shifted forward 2
seconds.
Event Time refers to the time data defined in Transient Data. This could be equal to Simulation Time (and
Absolute Time) depending on how the event is defined. For example, all three time bases will match for a
pump trip event starting at the beginning of a simulation with Start Time equal to zero. However, the
event may not start until a certain system condition is met and zero Event Time could be well into the simulation.

Figure 2: Time basis

Time
Time based transients modify a parameter directly according to Simulation Time.
For example, consider a valve closure transient. The valve starts to close at two seconds into the simulation, and the time it takes for the valve to close is one second. After that, the valve stays closed. To
define this event with the Time option, the Start Time must be set to zero, and the Transient Data must
look something like the data shown in Figure 3.

Figure 3: Defining a valve closure at a specific time
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Single Event
Single Event initiated transients do not begin until a certain condition is met.
To completely define an Event, four parameters are required:
l

Event Type - What parameter is being considered to initiate the transient. See Table 1 below for a
list of the possible Event Types.

l

Condition - The logical relationship between Event Type and Value (e.g. greater than, less than,
etc)

l

Value - The specific magnitude of the Event Type parameter at Location

l

Location - Where in the model the Value should be observed

Given the same valve closure profile described in Figure 3, we can set the valve to close when (or if) the
pressure at the inlet of P101 exceeds 100 psig. Note that the Transient Data is identical - but the initiation
of the event may happen at a very different time.

Figure 4: Event definition

Table 1: Event types

** Multi-Condition **

Pressure Stag. Diff. at Junction

Spray Discharge Outflow

Check Valve State

Pressure Stag. Diff. Between
Pipes

Tank Pressure

Compressor/Fan Speed

Pressure Stagnation at Pipe

Time Absolute

Control Valve State

Pressure Static at Pipe

Time Difference

Cv

Pressure Static Diff. at Junction

Valve Open Percent

Kv

Pressure Static Diff. Between
Pipes

Velocity in Pipe

Mass Flow Rate in Pipe

Relief Valve State

Volumetric Flow Rate in Pipe
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Dual Event Cyclic
The Dual Event options, as the names imply, require the definition of two events. The definition for each
event follows the same structure as a Single Event.
Dual Event Cyclic will continue monitoring both triggering events throughout the simulation and will apply
the corresponding transient data when the conditions are met.
To continue with the valve example, we can define our valve not only to open when a pressure is
exceeded, we can tell it to close when the pressure drops below a certain setting.

Figure 5: Dual Event set up. Note that a Second Event requires additional data for the Second Transient

Dual Event Sequential
Dual Event Sequential is nearly identical to Dual Event Cyclic. In fact, all of the required user input is the
same.
The difference is that the two defined events are only applied once. That is – after the second event is
complete, no more transients will be applied even if the conditions are met.

Junctions With Inherent Event Logic
There are two junction types in AFT Arrow which have built-in, or inherent, event logic. These are the
check valve and relief valve. The user does not need to specify the nature of the events, and in fact is not
allowed to.
The inherent event logic is very similar to the Dual Event Cyclic logic described previously.
l

Check valve - The check valve has two built-in events. The first is that it closes when backflow
starts to occur. The second is that it reopens when sufficient pressure differential occurs. These
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transients are assumed to be instantaneous.
l

Relief valve - The relief valve has two built-in events. The first is that it opens when the set pressure is reached. The second is that it closes again when the pressure falls back below the set pressure. These transients are assumed to be instantaneous unless the Pressure/Pressure
Opening/Closing profile is used.

Related Examples
Air Receiver Tank - XTS
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Related Blogs
And, Not, Or - Starting Transient Events with Complex Logic

Multi-Condition Events
One of the Event Types available in XTS is Multi-Condition. This feature allows starting a transient
based on more than one parameter in the model.
For example, it may be desirable to open a valve when either of two pressures is exceeded.
To define a Multi-Condition Event, first select Multi-Condition as the Event Type from the junction's Transient tab.

Figure 1: Selecting Multi-Condition Event Type
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Event Manager
Clicking Multi-Condition Event opens the Event Manager, where Simple Events and Multi-Condition
Events can be defined.
The Event Manager defines events model-wide. That is, if the active scenario is changed, the same
events will be accessible.

Figure 2: The Event Manager

Simple Events
The Event Manager allows for the definition of Simple Events and Multi-Condition Events.
Simple Events are nearly identical to normal (non Multi-Condition) events defined in a Transient tab.
They require a Parameter, Condition, Value, and Object as well as a unique Name.
Clicking "Create Simple Event..." adds a new Simple Event to the list with default values. These values
should be updated with the desired values and applied with the Update button. Simple Events can be
duplicated to help reduce repeated data entry.
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Multi-Condition Events
Multi-Condition Events are a collection of other Events with a logical condition applied to them. When creating a new Multi-Condition Event, a prompt for a Name appears. After entering a name, an empty MultiCondition is created with a default logical condition of AND. This logical condition can be:
l

AND - All of the Simple Event conditions must be met for the Multi-Condition Event to trigger.

l

NOT - The Multi-Condition Event triggers when none of the conditions evaluate to true.

l

OR - One or more of the Simple Event conditions must be met for the Multi-Condition Event to trigger.

Figure 3: Conditional logic for Multi-Condition Events

Any number of Simple Events can be added to a Multi-Condition Event as Sub-Events:

Figure 4: Multiple Events

Complex Multi-Condition Events
More complex events can be defined by adding one or several Multi-Condition Events as Sub-Events to
another Multi-Condition Event.
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Figure 5: A Multi-Condition Event containing another Multi-Condition Event (trigger if Limit 3 AND (Limit 1 OR
Limit 2))

Using Multi-Condition Events
All Multi-Condition Events are listed in the junction's Initiation of Transient section. Only one Multi-Condition Event can be selected as the Initiating Event for any particular Transient Data.

Figure 6: The selected Multi-Condition Event controls the trigger of the Transient Data. Hovering over the
Multi-Condition events here shows an expanded definition of the event.

Related Blogs
And, Not, Or - Starting Transient Events with Complex Logic
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XTS Special Conditions
(XTS Module Only) Some junctions have Special Conditions that alter the normal state of the junction.
The junctions that have special conditions set are shown using a special symbol before the ID number
(an “X” by default). This symbol can be customized in the User Options window.

Special Conditions with No Transient Data
If a Special Condition is applied to a junction without any transient data, then the transient solution will
retain the Special Condition. For instance, if a Special Condition is set for a valve junction, the steadystate solution will solve with the valve closed. In addition, the transient solution will run the entire simulation with the valve closed as well because there is no transient data entered which implies the valve
state is not intended to change.

Special Conditions with Transient Data
If a Special Condition is applied to a junction that has transient data, then the transient solution will ignore
the Special Condition. It is then incumbent upon the engineer to relate the Special Condition to the initial
transient data.
For instance, assume the user wants to simulate the transient that occurs during a valve opening. The
steady-state solution will have the valve closed, and this is modeled by using a Special Condition for the
valve junction. In such a case, the Cv data entered on the valve junction's Loss Model tab will be ignored.
On the Transient tab, a transient can be entered. The first data in the table should then be Cv = 0, which
corresponds to a closed valve. From there the Cv can be increased above zero as desired to open the
valve.
If the user were to keep the Cv equal to zero, then that would be equivalent to the previous case where
the user set the Special Condition but did not enter any transient data.

Compressor/Fan Special Conditions
Compressor/Fan Special Conditions are slightly more complicated than for valves. In fact, compressor/fan junctions have two types of Special Conditions. The first is to turn the compressor off and
have no flow through it. This is called “Compressor Off No Flow”. The second type of Special Condition
turns the compressor off but allows flow to go through the compressor. This is called “Compressor Off
With Flow Through”.
Why would one want to use one Special Condition rather than the other? The simple answer is that the
first Special Condition is more appropriate for positive displacement type compressors and the second
for centrifugal compressors or fans.
Here's why. When a positive displacement compressor is turned off and has a pressure difference
across it, it will usually act like a closed valve and not allow flow to go through it. Thus the first Special
Condition would be most appropriate. For instance, assume one wants to model the transient that occurs
during the startup of a positive displacement compressor. The best way to do this would be to use the
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first Special Condition with no flow, and then input a flowrate transient in which the first data point is zero
flow.
On the other hand, when a centrifugal compressor or fan is turned off and has a pressure difference
across it, in the absence of other valving which prevents flow the compressor or fan will usually allow flow
to go through it. Thus the Special Condition that allows through flow would be most appropriate. For
example, assume one wants to model the transient during the startup of a centrifugal compressor. One
would use the second Special Condition, and, in conjunction with a compressor curve entered at 100%
speed, input a speed transient with the initial speed as zero.

Transient Special Conditions
Junctions which accept transient data also support Transient Special Conditions. The default for all junctions is None. The other choice is Ignore Transient Data. This allows one to simulation the static junction
without having to delete the transient data.
When a Transient Special Condition is set to Ignore, a # symbol is displayed adjacent to the junction number on the Workspace. This symbol can be customized in the User Options window.

XTS in Model Data
(XTS Module Only) Junction transient data is displayed on the Transient tab in the Junction section of
the Model Data window (Figure 1). This tab is only visible if transient input data exists.

Figure 1: Transient input data is displayed in the Junction section of the Model Data window
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XTS in Output
(XTS Module Only) Transient simulations create more output data than steady-state runs. The transient
output data is displayed in the Output window in two general ways.
First, the pipe and junction output tables now reflect output at a specific point in time. In Figure 1 below
the displayed results are 10 seconds into the simulation. The time step information can be seen at the bottom left of Figure 1. The forward/reverse buttons and the slider at the bottom allow the user to change the
currently displayed time.
Second, the results for all time steps are displayed together in the tables labeled "Transient". Figure 2
shows the same output as Figure 1, except the transient tank and pipe tabs have been selected for display. Here one sees multiple results for each pipe or junction. For example, look at the transient pipe data
in the bottom tables. While the table holds data for all pipes, one can see here only part of the data (up to
3 minutes) for the first pipe,Ppipe 1. In the far left column, the first data is the pipe number (#1) and the
adjacent number in parentheses is the time for that row (in the units defined for the time step interval seconds in this case). The time unit of seconds is displayed in the bottom left, and can be changed in the
Output Control time formatting. The data in Figure 2 shows these changes over each time step. The transient tables are organized with a collapsing/expanding capability for each pipe or junction to facilitate
data viewing.
Notice that each of the junction Summary reports at the top of Figures 1 and 2 (in the General Section,
see Pump, Valve and Reservoir Summary) have a related Transient table that goes with it.

Figure 1: Output window displaying data at 10 minutes
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Figure 2: Output window displaying transient data for entire simulation

Related Topics
XTS Quick Graph

660

Related Examples
Air Receiver Tank - XTS
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XTS in Output File
(XTS Module Only) The transient output is saved to an external file with the extension ".out". The file
name will be the same as the input filename with a number appended. The filename number allows AFT
Fathom to distinguish among output files for different scenarios. If you want to know which specific output
file is used for a scenario, the name is given in the General section of the Output window.
The time duration of the Output file is specified in the Simulation Duration panel in the Analysis Setup window.

XTS in Graph Results
(XTS Module Only) Transient data can graphed in the Graph Results window in two general ways: Profile graphs and transient graphs.
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Profile Graphs
Profile graphs show results where the distance along the pipe is the independent, x parameter (Figure 1).
If the pipes are connected, a sequence of pipes can be graphed in the profile. Profile graphs can only
show data at a particular time or show overall maximum and minimum values for all times (Figure 2).
Profile graphs can be created for one or more pipe sequences. Note that the x-axis on profile plots is
cumulative distance along the pipe sequence.
Multiple profiles can be plotted simultaneously using the Groups on the Edit menu.
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Figure 1: The Graphing panel showing a profile plot for a pipe sequence for maximum and minimum static
pressure is to be generated
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Figure 2: Transient max/min profile plot for pressure as specified in Figure 1

Animation of Output
Another useful feature of profile graphs is that they allow animation of the output results. Animation is
selected in the Quick Access Panel (Figure 1) and, when selected, reveals additional control features on
the Graph Results window. See Animating Transient Results for more information.

Transient Graphs
Transient graphs show how parameters vary with time (see Figures 3 and 4). Here the x-axis is time
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Figure 3: Setting up a Transient graph
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Figure 4: Transient graphs show how parameters vary with time

XTS Animating Results
Figure 1 shows the Graph Results window when using animation. As shown, additional controls become
visible to allow the user to adjust animation. At the left is the Play button, which starts the animation. Next
to it are the Pause and Stop buttons. If the Pause button is pushed, the animation stops at that time step.
One can print the graph or copy the data if desired. The time slider controls (to the right of the Stop button)can also be used to set the time forward or backwards. The Stop button stops the transient and
resets the time to zero.
The current time (in seconds) and time step are shown to the right of the time controls. At the far right are
the speed controls. Slowing the animation involves adding time delays to the data display. Increasing the
speed involves skipping time steps. The default speed, right in the middle, has no delays or skips.
If plotting a single path using the list of pipes in Graph Control (Figure 2), one can cross-plot on the animation design alerts (in Profile Along a Flow Path) or steady-state results (in EGL, HGL and Elevation Profile).
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Figure 1: The animation options display additional controls
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Figure 2: Enabling Animation in Graph Control

XTS Quick Graph
(XTS Module Only) Transient output data displayed in the Output window can be graphed by right-clicking on the data in the table and selecting Quick Graph (see Figures 1 and 2).
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Figure 1: Quick Graph on the Output window is selected by clicking the with the right mouse button in a
column of transient data

Figure 2: Quick Graph window is opened from Output window as shown in Figure 1

Related Topics
XTS in Output
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Quick Graph Formatting Window
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XTS in Visual Report
(XTS Module Only) The Visual Report data will be displayed at a selected time. The slider bar and buttons at the bottom of the Visual Report work the same as the Output window time selection controls.
When the user changes the current time, the displayed values change as well. In addition, color maps
are updated when in use.
As shown in Figure 1, the current time is displayed in the lower left by the time adjustment buttons. The
time can also optionally be displayed next to the model as well. The display on the Visual Report can be
turned on and off on the Visual Report Control window. It is helpful to have the time on the Visual Report
when it is printed.

Figure 1: Visual Report has additional time adjustment controls when in AFT Fathom is in Transient mode
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Critical Warnings, Warnings, and Cautions
A number of warnings may be given in the output when you run AFT Arrow's Solver. These warnings are
intended to alert you about potential problems with the model or solution. Some warnings may prove to
be harmless upon closer inspection, but you should never ignore them.
There are different warning levels depending on the importance of the warning.
1.

CRITICAL WARNING – A critical warning is very important and reflects a high possibility of incorrect results in the output

2.

WARNING – A warning that actually says WARNING offers important information about the converged solution or the model itself. The information should always be reviewed.

3.

CAUTION – A cautionary warning is of less importance than a full warning. The included information may or may not be of interest to the user.

4.

Design Alert Warnings – When a pipe exceeds a user’s design alert a notification is given.

Any of the warning message types above can be double-clicked in the Output window to take you directly
to the pipe/junction referenced in the message.
The following is a complete list of the warnings you may receive, with a brief explanation given of each.
Whenever any warnings occur that are WARNING or CRITICAL WARNING level, the General Results
section of the Output Window will be displayed with the text in red.

Related Topics
Exporting to Excel
GSC in Output
Cost Report
Troubleshooting

387
545
447
676

Critical Warnings
A Critical Warning message in AFT Arrow alerts users to serious issues in the model results. These messages should always be reviewed by the user, and results containing these messages should never be
used for anything other than error resolution.

CRITICAL WARNINGS
l

FCV/PRV/PSV Could Not Control Pressure - Pressure Was Added...

l

Global energy balance disabled by user in Advanced Parameters panel

l

Global mass balance disabled by user in the Advanced Parameters panel

l

Junction X Had Reverse Flow - Compressor/Fan Pressure Could Not Be Predicted

l

Junction X uses normal or standard flow units like Y in a flow path with dynamic gas mixing...

l

Pipe Sequences of zero friction exist, flow rate cannot be calculated
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l

Required flow to supply the pressure control valve at junction X is above sonic flow and cannot be
supplied.

l

Setting relaxation lower than relative pressure/flow tolerance gives unreliable results

l

Specified flow out of junction X is above sonic flow and cannot be supplied. Please review results
and change your model

l

These results do not represent a converged solution. Use only for error resolution purposes

FCV/PRV/PSV Could Not Control Pressure - Pressure Was Added to
Achieve Control Flow/Pressure...
A Critical Warning message in AFT Arrow
Full message is:
FCV/PRV/PSV could not control pressure/flow at Junction X. Pressure was added to achieve control
flow. See Valve Summary for more information.
A flow or pressure control valve could not control pressure or flow and the setting is to Always Control
(Never Fail). In order to achieve the control flow or pressure, the valve must add pressure and act like a
compressor/fan.
The Valve Summary in the Output window gives more information.
This warning is useful for resolving operational problems in your system.

Global energy balance disabled by user in Advanced Parameters
panel
A Critical Warning message in AFT Arrow
The displayed results do not represent a valid converged solution because the Energy Balance option
was disabled by the user in the Advanced Parameters panel of the Analysis Setup window.

Related Topics
Advanced Parameters Panel
Global mass balance disabled by user in Advanced Parameters panel
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Global mass balance disabled by user in Advanced Parameters
panel
A Critical Warning message in AFT Arrow
The displayed results do not represent a valid converged solution because the Mass Balance option was
disabled by the user in the Advanced Parameters panel of the Analysis Setup window.

Related Topics
Advanced Parameters Panel
Global energy balance disabled by user in Advanced Parameters panel

143
664

Junction X Had Reverse Flow - Compressor/Fan Pressure Could Not
Be Predicted
A Critical Warning message in AFT Arrow
This message displays for centrifugal compressor/fans when the flowrate goes backwards through the
compressor/fan. The compressor/fan pressure rise under such conditions is unknown. The zero flow
value is used.

Junction X uses normal or standard flow units like Y in a flow path
with dynamic gas mixing...
A Critical Warning message in AFT Arrow
Full message is:
Junction X uses normal or standard flow units like Y in a flow path with dynamic gas mixing. Flows cannot
be calculated accurately unless GSC module is used.
When standard flowrates (like scfm) or normal flowrates (like Nm3/hr) are used as flow demands and the
model has dynamic gas mixing, the “standard” or “normal” density cannot be obtained because there is
no certain gas mixture at the required flow rate. Without a standard/normal density then the flowrate cannot be converted into a true mass flowrate.
The user should either change the model to use known pressures (like Assigned Pressures or Tanks) or
use the GSC module to obtain the desired flowrate.

Pipe Sequences of zero friction exist, flow rate cannot be calculated
A Critical Warning message in AFT Arrow
This message is displayed if all of the pipes in a flow path are defined as frictionless by using the zerolength connector option, or the "frictionless" friction model.
At least one pipe in every flow path needs to include frictional losses in order to perform flow calculations.
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Required flow to supply the pressure control valve at junction X is
above sonic flow and cannot be supplied.
A Critical Warning message in AFT Arrow
This is preceded by a critical error message. This error message means that you have specified a pressure at a pressure control valve which requires a flow which is physically impossible because of sonic
choking.

Related Topics
Sonic Choking

500

Setting relaxation lower than relative pressure/flow tolerance gives
unreliable results.
A Critical Warning message in AFT Arrow
Because of the nature of relaxation and relative solution tolerance, setting the relaxation to a value close
to or lower than relative tolerance can lead to false convergence and invalid results. AFT Arrow alerts the
user to this when inputting data in the Tolerance panel, and also alerts the user once the solution has
been obtained.

Specified flow through/out of junction X is above sonic flow and cannot be supplied.
A Critical Warning message in AFT Arrow
This is preceded by a critical error message. This error message means that you have specified an outflow which is physically impossible because of sonic choking. All other results in your model except for
the sequence of pipes leading up to the offending Assigned Flow junction will have an acceptable solution.
This message can also occur if you are using Flow Control Valves or Compressor/Fans modeled as a
fixed flowrate.

Related Topics
Sonic Choking

500

These results do not represent a converged solution. Use only for
error resolution purposes
A Critical Warning message in AFT Arrow
This message alerts you to the fact that you chose to have results displayed for an unconverged solution.
You should only use the displayed results for purposes of determining the reasons for nonconvergence.
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Under no circumstances should you actually use any of the results for engineering purposes. See the
Troubleshooting section of the help site, or email your model to AFT Support for assistance.

Related Topics
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point

Warnings
A Warning message in AFT Arrow alerts users to issues in the model that will affect the model results.
These warnings often offer important information about the converged solution or the model itself, and
should always be reviewed before considering the results to be meaningful for the system.

WARNINGS
l

Chempak temperature and/or pressure is out of range for the following

l

Concentration at Junction X may not be balanced (total= Y)

l

Control valve open percentage outside valid range of 0-100% at Junction X

l

Energy may not be balanced at Junction X

l

FCV could not control flow at Junction X

l

Flow may not be balanced at Junction X

l

Fluid is no longer in the vapor phase because the fluid temperature/pressure is...

l

GSC Goal may not be valid. User goal = X. Final goal result = Y

l

Inlet and outlet pipes at Junction X do not have the same stagnation enthalpy.

l

Junction X Compressor/Fan Added Negative Pressure
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l

Junction X Exceeded Runout Flow Rate...

l

Maximum system pressure exceeded enthalpy table's maximum pressure of X. Enthalpy is extrapolated for pressures exceeding this value.

l

Physical flow area is less than the sonic area at junction X...

l

Pipe X temperature is equal to or greater/less than the maximum/minimum temperature limit of...

l

Pipe/Junction X property calculation exceeded maximum local iteration limit. Error value = Y, Tolerance = Z, (Code #XYZ)

l

Pipe/Junction X property calculation failed to continue towards convergence. Error value = Y, Tolerance = Z, (Code #XYZ)

l

PRV could not control pressure at Junction X

l

PSV could not control pressure at Junction X

l

Separator junction X is trying to remove Y but none is entering junction

l

Separator junction X is trying to remove Y of Z but only A is entering junction

l

Temperature at inlet/exit of pipe X is above/below max/min fluid temperature range

l

Unique solution not possible - Relief valve cycles

Chempak temperature and/or pressure is out of range for the following
A Warning message in AFT Arrow
The final solution had temperature and/or pressure conditions in the specified pipes obtained with
Chempak physical property data which were beyond Chempak's range of applicability. The range value
is also displayed. This indicates that the results are probably not valid. It also may indicate an input error
in the model because of the extreme temperature or pressure state.

Concentration at Junction X may not be balanced
A Warning message in AFT Arrow
This warning alerts you to the fact that the converged results may be incorrect. Once a converged solution is obtained, AFT Arrow checks all junctions to ensure a concentration balance exists. It compares
the imbalance to the flow tolerance you specified, and when it appears to exceed the tolerance, it gives
you this warning.
If the magnitude of the concentration out of balance flow is close to the tolerance you specified, then it is
generally safe to ignore this warning, although you may want to reduce your tolerances further and rerun
the model.
If the magnitude of the concentration out of balance is large, then you have a converged solution that is
incorrect. This can occur in rare circumstances. When this happens, then it is usually an indicator that
your model is not realistic.
You should always review each of these warnings in detail, and perform hand calculations on the concentration balance at the affected junctions to verify whether an acceptable solution exists.
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Control valve open percentage outside valid range of 0-100%
A Warning message in AFT Arrow
This is a cautionary notice that a control valve which includes open percentage data is operating outside
the range of 0-100%.

Energy at Junction X may not be balanced
A Warning message in AFT Arrow
This warning alerts you to the fact that the converged energy balance results may be incorrect. Once a
converged solution is obtained, AFT Arrow checks all junctions to ensure an energy balance exists. It
compares the imbalance to the mass flow weighted enthalpy tolerance you specified, and when it
appears to exceed the tolerance, it gives you this warning.
If the magnitude of the out of balance flow is close to the tolerance you specified, then it is generally safe
to ignore this warning, although you may want to reduce your tolerances further and rerun the model.
If the magnitude of the energy out of balance is large, then you have a converged solution that may be
incorrect. This can occur in rare circumstances. When this happens, then it is usually an indicator that
your model is not realistic.
You should always review each of these warnings in detail, and perform hand calculations on the energy
balance at the affected junctions to verify whether an acceptable solution exists.
Note: This warning will usually occur when you assign isothermal boundary conditions to pipes in your
model. If pipes are forced to flow at the isothermal temperature you specify, it is usually not possible to balance energy at the junctions. The warning can be ignored in such circumstances,
because the energy imbalance is a natural result of the isothermal assumption.

FCV at Junction X could not control flow
A Warning message in AFT Arrow
This warning alerts you that the Flow Control Valve at junction X was not able to control the flow, and
backflow may have occurred.

Flow at Junction X may not be balanced
A Warning message in AFT Arrow
This warning alerts you to the fact that the converged results may be incorrect. Once a converged solution is obtained, AFT Arrow checks all junctions to ensure a flow balance exists. It compares the imbalance to the flow tolerance you specified, and when it appears to exceed the tolerance, it gives you this
warning.
If the magnitude of the out of balance flow is close to the tolerance you specified, then it is generally safe
to ignore this warning, although you may want to reduce your tolerances further and rerun the model.
If the magnitude of the flow out of balance is large, then you have a converged solution that is incorrect.
This can occur in rare circumstances. When this happens, then it is usually an indicator that your model
is not realistic.
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You should always review each of these warnings in detail, and perform hand calculations on the flow balance at the affected junctions to verify whether an acceptable solution exists.

Fluid is no longer in the vapor phase because the fluid temperature/pressure is...
A Warning message in AFT Arrow
Full message is:
Fluid is no longer in the vapor phase because the fluid pressure is above the Saturation Pressure for the
following...
The solution indicates that the temperature and pressure conditions at the specified pipe are such that
one or more gas components has reached saturation conditions. Arrow's solution accuracy will be
decreased, as Arrow's calculations always assume that the fluid is a superheated gas.

GSC Goal may not be valid
A Warning message in AFT Arrow
Full message is:
GSC Goal may not be valid. User goal = X. Final goal result = Y
This is a warning message that appears when the GSC module search was not able to meet a goal. See
Goal Seek and Control Troubleshooting.

Inlet and outlet pipes at Junction X do not have the same stagnation
enthalpy.
A Warning message in AFT Arrow
The stagnation enthalpy going into a junction should equal the stagnation enthalpy out if there are no
flow splits or heat input. This warning tells you that the values differ. Something is wrong somewhere and
results are likely incorrect.

Junction X Compressor/Fan Added Negative Pressure
A Warning message in AFT Arrow
Full Message text is:
Junction X Compressor/Fan added negative pressure.

A compressor/fan junction with a fixed flow rate had a pressure loss across the compressor/fan junction.
This warning is meant to alert the user that the compressor/fan is not adding pressure as they might be
expecting.
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Junction X Exceeded Runout Flow Rate…
A Warning message in AFT Arrow
Centrifugal compressor/fan curves typically have a point at which they no longer operate on the curve.
This may be called "end of curve" or "runout". Data defining runout for a particular compressor/fan is
given by the manufacturer. Such data has been defined for this compressor/fan in the configuration window, and the system is operating past the runout flow rate. Thus the results are invalid, because the compressor/fan cannot actually operate at that point.

Maximum system pressure exceeded enthalpy table's maximum
pressure of X
A Warning message in AFT Arrow
Full message is:
Maximum system pressure exceeded enthalpy table's maximum pressure of X. Enthalpy is extrapolated
for pressures exceeding this value.
This warning indicates that the AFT Standard fluid library is being used with the Table Enthalpy model,
and that the maximum pressure exceeded the maximum pressure for the enthalpy data. The Table
enthalpy model uses interpolation based on the current pressure to calculate the enthalpy at a given temperature. If the pressure at a point in the model exceeds the maximum pressure data is available for in
the AFT Standard fluid library, then the enthalpy must be extrapolated, leading to inaccuracy in the results. Extrapolation far above the maximum temperature will lead to increased inaccuracy, and may cause
convergence issues. Consider using an alternate fluid library such as NIST Refprop or Chempak with a
higher maximum pressure.

Physical flow area is less than the sonic area at junction X...
A Warning message in AFT Arrow
Full message is:
Physical flow area is less than the sonic area at junction X. Sonic choking probably exists but was
ignored in this solution because no CdA was specified.
AFT Arrow does not account for sonic choking at a junction unless the CdA for Sonic Choking is specified. For several junctions, a physical area is specified by the user. For example, for an orifice the orifice
area or diameter is specified. However, the real flow area is less than this physical area because of vena
contracta and wall separation effects. In order to perform a proper sonic choking calculation, AFT Arrow
needs to know the CdA.
When this warning is displayed, AFT Arrow has determined that at the specified junction sonic choking
was ignored because no CdA was specified, but that the sonic area was less than the physical area.
Thus sonic choking may exist even though AFT Arrow could not calculate it because the CdA data was
not supplied.
When this warning is displayed it is recommended you obtain the proper CdA for the junction and run the
model again.
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Related Topics
Sonic Choking

500

Pipe X temperature is equal to or greater/less than the max/min temperature limit of Y
A Warning message in AFT Arrow
Full message is:
Pipe X temperature is equal to or greater than the maximum temperature limit of Y set by the user in the
Pressure and Temperature Limits panel of Analysis Setup. Results may be incorrect.
The user has temperature limits in the Pressure and Temperature Limits panel. These are to control the
search space for temperatures while solving. However, the final solution had one or more pipes at the
temperature limit. This means the temperature results are likely incorrect. To resolve this either remove
or change the temperature limit.

Pipe/Junction X property calculation exceeded maximum local iteration limit
A Warning message in AFT Arrow
The final network solution was not within tolerance for a local iteration. The local iteration limit set in the
Iterations panel was exceeded, but the Solver ignored this and continued on. If a network solution is
obtained but this out of tolerance situation exists, AFT Arrow attempts the network solution again up to
five times in a row. If the out of tolerance situation remains, AFT Arrow ceases further attempts and displays the convergence notification, then gives this warning in the output. The property can be any of several solver parameters and depends on the actual subroutine where the problem occurred.
Along with the warning, the Error value and Tolerance are displayed, along with a Code #. For AFT Arrow
to consider this local iteration to be converged, the Error value needs to be less than the displayed Tolerance. This Tolerance is not the tolerance the user can specify in the Tolerance panel, but rather an
internal “hard-wired” tolerance that has been set by the software developers and arrived at through experience.
If the Error value is relatively close to the displayed Tolerance, it is generally safe to ignore this warning. If
it is much larger, the remainder of the output is probably invalid.
In either case, changing the solution method in the Analysis Setup window frequently solves the problem.
The Code # identifies the subroutine where the problem occurred. This information is not of much assistance to the user, but can be of help to AFT technical support staff when troubleshooting models.
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Pipe/Junction X property calculation failed to continue towards convergence
A Warning message in AFT Arrow
The final network solution was not within tolerance for a local iteration. This was determined by AFT
Arrow’s Auto-Detect feature. The Solver ignored this and continued on. If a network solution is obtained
but this out of tolerance situation exists, AFT Arrow attempts the network solution again up to five times in
a row. If the out of tolerance situation remains, AFT Arrow ceases further attempts and displays the convergence notification, then gives this warning in the output. The property can be any of several solver
parameters and depends on the actual subroutine where the problem occurred.
Along with the warning, the Error value and Tolerance are displayed, along with a Code #. For AFT Arrow
to consider this local iteration to be converged, the Error value needs to be less than the displayed Tolerance. This Tolerance is not the tolerance the user can specify in the Tolerance panel, but rather an
internal “hard-wired” tolerance that has been set by the software developers and arrived at through experience.
If the Error value is relatively close to the displayed Tolerance, it is generally safe to ignore this warning. If
it is much larger, the remainder of the output is probably invalid.
In either case, changing the solution method in the Analysis Setup window frequently solves the problem.
The Code # identifies the subroutine where the problem occurred. This information is not of much assistance to the user, but can be of help to AFT technical support staff when troubleshooting models.

PRV at Junction X could not control pressure
A Warning message in AFT Arrow
This warning alerts you that the Pressure Reducing Valve at junction X was not able to control pressure,
and backflow may have occurred.

PSV at Junction X could not control pressure
A Warning message in AFT Arrow
This warning alerts you that the Pressure Sustaining Valve at junction X was not able to control pressure,
and backflow may have occurred.

Separator junction X is trying to remove Y but none is entering junction
A Warning message in AFT Arrow
A Separator junction is specified to remove a certain gas but none is flowing into the junction. The input
data should be reviewed for the model.
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Separator junction X is trying to remove Y of Z but only A is entering junction
A Warning message in AFT Arrow
A Separator junction is specified to remove a certain amount of gas but there is not enough flowing into
the junction. The input data should be reviewed for the model.

Temperature at pipe X inlet/outlet is above/below max/min fluid temperature range
A Warning message in AFT Arrow
This is a courtesy warning regarding the temperature prediction being outside the stated range of fluid
properties.

Unique Solution Not Possible - Relief Valve Cycles
A Warning message in AFT Arrow
The relief valve specified toggles between its open and closed state. When closed, the pressure exceeds
its cracking pressure and causes it to open. When open, the pressure drop resulting from flow causes the
pressure to fall below the cracking pressure and so it closes. This may indicate incorrect or unrealistic
input.

Cautions
A Caution message in AFT Arrow is of less importance than a full warning. While some Caution messages may be left unresolved without affecting model results, they should never be ignored by the user.

CAUTIONS
l

Check Valve closed at Junction X

l

Flow is negative through Junction X. Loss factors may be in error

l

Junction X is downstream of a shock, stagnation/static properties cannot be calculated at junction

l

Note No Scenarios have been set in the Multi-Scenario Output

l

Pipe X length is shorter than the elevation change

Check Valve closed at Junction X
A Caution message in AFT Arrow
This is a cautionary notice that a check valve closed.
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Flow through Junction X is negative. Loss factors may be in error.
A Caution message in AFT Arrow
This caution alerts you to flow in your junctions which is in the opposite direction from the connecting
pipes reference directions. Any loss information you specified for junctions may be in error because it
was defined assuming flow in the other direction.

Junction X is downstream of a choking point
A Warning message in AFT Arrow
Full Message is:
Junction X is downstream of a choking point. Static/stagnation properties cannot be calculated at junction.
Only occurs at pressure type junctions (e.g., Assigned Pressure, Tank, Spray Discharge). When sonic
choking occurs at a junction with a fixed pressure, there is no way to calculate a velocity downstream of
the choke point. This means that it is not possible to determine static conditions if you have specified stagnation at the junction, and vice versa. All other results for the model are valid except for the static/stagnation pressure, temperature, and enthalpy at the junction.

Note No Scenarios have been set in the Multi-Scenario Output display
A Caution message in AFT Arrow
This caution is shown when multi-scenario output has been selected in Output Control but no scenarios
have been selected. As a result, no output can be shown.

Pipe X length is shorter than the elevation change
A Caution message in AFT Arrow
This caution alerts you to a possible inconsistency in your input. When this warning occurs, you have
defined a pipe with a length that is shorter than the elevation change between its connecting junctions.
This inconsistency may be an input error or a result of a component which itself has an elevation change.
AFT Arrow only accepts a single elevation per junction, so if the error is due to the latter possibility, pipe
lengths or junction elevations should be adjusted accordingly.
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This section discusses methods of troubleshooting models that are having difficulty converging. Topics
include discussions of common issues, ideas to simplify overly complex models, and methods for adapting the solution methodology through either tolerance or flow relaxation.
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Related Blogs
Having model convergence problems? Start here!

Diagnostics Window
The Model Diagnostics Window is a feature introduced to AFT Arrow with AFT Arrow 8. It is intended to
help users check on a number of settings that may have been changed during the model-building process and that may affect the model results.
The Model Diagnostics Window can be accessed from the Tools menu.
When the Model Diagnostics Window is opened most input will be checked, and the results will be displayed in a tabular format. Items of note will be highlighted based on the impact each identified item may
have on the results. It should be noted that not all items identified by this window will have a negative impact on results. Rather, the identified items are settings that have frequently been incorrectly
applied by other users. This is not an exhaustive list of troubleshooting items, though most common
issues are included.
Data in the Model Diagnostics Window is organized by the Data Source, which is the window where that
setting/input is defined. Any item that may negatively impact the model will be highlighted based on its
potential to affect the model, as shown in the Potential Impact column. For pipe and junction diagnostic
items, the pipe(s)/junction(s) that were identified will be listed below the diagnostic item. For an example,
see Figure 1 below. The Diagnostic window indicates that the Flow Tolerances and the Environmental
Properties for the model have been modified from the default, which is unusual. Model Diagnostics also
indicates the junction J5 is using the detailed tee loss model, which can prevent convergence in some
cases if not defined properly.

Figure 1: Example of the Model Diagnostics window

Related Topics
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Troubleshooting
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
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Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Related Blogs
AFT Responds to 2020 Customer Survey Feedback

Use the Model Data Window
Besides its usefulness for documentation purposes, the Model Data window is a powerful tool for finding
input errors in your model.
Look at the model in Figure 1. If you suspected an input error in one of the pipes, the task of looking for
the error in each individual pipe input window would be tedious.
Now look at the Model Data window for the pipes in Figure 2. Here it is much easier to scan down
columns of data looking for input errors. In this case, one of the pipe lengths was accidentally entered in
miles rather than feet.
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Figure 1: Workspace layout of a pipe system with an input error in one of the pipes (error not shown)
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Figure 2: Model Data window display for the model in Figure 1. From this perspective it is much easier to see
that one of the pipes (P102) has length data entered in miles rather than feet. This is not automatically an
input error, as AFT Arrow accepts pipe input with mixed engineering units. However, the user often intends
to use consistent units, so this probably is an error.

Related Topics
Troubleshooting
Diagnostics Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
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Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Related Blogs
Having model convergence problems? Start here!

Transfer Results to Initial Guesses
AFT Arrow's iterative Solver takes initial guesses (also called initial conditions) and applies the principles
of mass, momentum and energy balance to improve the guesses. This is called iteration. It continues to
refine the solutions until agreement with the governing equations is obtained.
After a converged answer is obtained, you can choose to take these results and use them as the initial
guesses for a subsequent run. Using the converged results as initial guesses often gives faster convergence in subsequent runs because you are starting the Solver at or very close to the actual solution.
This feature is called Transfer Results to Initial Guess, and it is on the Output window Edit menu and Toolbar.

Related Topics
Optional Input for Junctions
Optional Input for Pipes
Make Initial Flow Rate Guesses for Pipes
Troubleshooting
Diagnostics Window
Use the Model Data Window
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution pur-

- 681 -

213
201
688
676
677
678
682
683
684
685
686
687
689
689
690
691
692
692
693
666

Troubleshooting

poses

Poor Compressor/Fan Curve Fits
The Compressor/Fan Properties window allows curve fits of compressor/fan data up to fourth order.
Depending on the number of data points entered, compressor/fan curve fits that look like the orange
curve in Figure 1 are possible.
AFT Arrow interprets flow rates past the inflection point around 80 as acceptable operating points, which
can lead to unusual results or non-convergence. Users should always ensure that their compressor/fan
curves cross the flow rate axis as shown in the blue curve in Figure 1.
AFT Arrow will attempt to warn the user when a model containing a compressor/fan curve fit as seen in
Figure 1 is run. The user can choose to run the model with this curve fit anyways, but they should take
care that the compressor/fan is not operating to the right of the inflection point.

Figure 1: A good compressor performance curve fit in blue and a poor compressor performance curve fit in
orange. All pump curve fits should include sufficient data such that the curve crosses the zero pressure rise
axis as shown in the blue curve.

Related Topics
Compressors & Fans
Compressor/Fan Configuration
Compressor/Fan Efficiency Data
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Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
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Troubleshooting Resistance Curves
Common issues with resistance curves include curves where losses do not increase with flow, and
curves with a non-zero loss at zero flow. Figure 1 below shows examples of curves with potential issues
compared to a correctly defined curve.

Figure 1: Example resistance curves showing correct and incorrect curve types. The incorrect curves either
have non-zero loss at zero flow, or have losses which do not increase with flow. The correct curve has zero
loss with zero flow and has losses which increase with flow.
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These common issues create two potential problems in a model.
First, if the system sees a constant pressure drop even at low flowrates, AFT Arrow's iterative solver can
encounter difficulty converging on a solution since the system flow and pressure drop are no longer
dependent on each other.
Second, real equipment in a system will typically cause a higher pressure drop at larger flowrates, and
will not provide any loss to the system at zero flow. Users should capture a single known pressure loss
data point by defining a curve which passes through two points: the known pressure drop at the tested
flowrate and zero pressure drop at zero flow. The topic on Resistance Curves gives more information on
defining this type of curve.

Related Topics
Resistance Curve Loss Model
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes

221
676
677
678
681
682
684
685
686
687
688
689
689
690
691
692
692
693
666

Use the Output Window Sort Feature
The Sort feature in the Output Windowcan be used to look for extremes in velocity, pressure drop or
other parameters. An input error (like incorrect diameter) may be easier to see by looking at its effect on
the results.

Related Topics
Output Window
Output Control
Output Parameters

322
327
333
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Applied Standards
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Tee/Wye Junction Complexity
Tee/wye junctions contain powerful and sophisticated models for determining the pressure losses at flow
splits and converging flow streams. This power comes at the cost of additional model complexity. The
complexity can lead to convergence problems in models with numerous tees. Here are a couple of recommendations.
Tee/Wye junctions have two loss options: Simple and Detailed. The Simple loss model ignores losses at
the tee. The Detailed model uses the correlation summarized in the Tee/Wye Loss topic. The potential
convergence problems occur when using the Detailed loss model.
The potential problem is not with the Detailed tee model itself. Rather, it is due to multiple tees coupling
together in such a way that AFT Arrow cannot converge on all of the flow splits.
You can quickly and easily check if a convergence problem is being caused by tees. Using the Global
Junction Edit window, you can change all tees to the Simple loss model and rerun the model. If it now converges, the problem was due to the use of Detailed tee modeling.
Experience has shown that this problem can frequently be resolved by using absolute tolerance criteria
in the Tolerance panel rather than relative tolerance.
You also have the option of just using the Simple (lossless) tee model for all tees. In many systems the
loss due to tees/wyes is negligible, especially for systems which see significant loss from other components that dominate the system.

Related Topics
Tee/Wye

277
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Tee/Wye Loss Model
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Related Blogs
Having model convergence problems? Start here!
Give me some details about Detailed Tees!

Lower the Flow Rate Relaxation
The Iterations panel allows you to change the numerical relaxation parameter for both flow rate and pressure. It is recommended that you use only 0.5 or 1.0 for pressure relaxation. But lower values of flow rate
relaxation can be very helpful.
A good first step is to lower the flow rate relaxation to 0.05 or 0.1. By lowering the flow rate relaxation you
improve AFT Arrow's ability to obtain convergence. The cost is slower run times. In some cases, accepting the slower run times that come with flow rate relaxation is the only means of obtaining convergence.
You can lower the relaxation values as low as you want, but it is recommended it not be lowered below
0.01.

Related Topics
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits

676
677
678
681
682
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Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes

683
684
685
687
688
689
689
690
691
692
692
693
666

Related Blogs
Having model convergence problems? Start here!

Try Absolute Tolerance
Most models converge more reliably with relative tolerances, which is the default in theTolerance panel.
However, some models converge much better with absolute tolerance. What this usually means is that
there is at least one element of the model that is close to the real answer in absolute terms but does not
lock in on a relative (percentage) basis.
If a model will not converge with relative tolerance, you can try changing to absolute tolerance. Even better, try the option to converge on either absolute or relative, which will offer the most flexibility.

Related Topics
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
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Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Related Blogs
Having model convergence problems? Start here!

Make Initial Flow Rate Guesses for Pipes
If you do not provide any initial guesses, AFT Arrow will make its own guesses. On occasion, the AFT
Arrow guesses are far away from reality. For some models, providing a crude initial guess for all the pipe
flow rates in the system can help the model converge.
The crude guesses can be as simple as selecting all the pipes and initializing all of them to 1 lbm/sec,
even though some operate at 0.1 lbm/sec and others at 10 lbm/sec.

Related Topics
Optional Input for Junctions
Optional Input for Pipes
Transfer Results to Initial Guesses
Troubleshooting
Diagnostics Window
Use the Model Data Window
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Review the Iteration History
The Iteration History window can be opened from the Solution Progress window. You can use this to see
which pipes or junctions are farthest out of tolerance, which may direct your troubleshooting efforts
toward these elements.

Related Topics
Solution Progress Window
Iterations Panel
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Change Boundary Conditions
Changing the boundary pressures or flow rates can help give insight into what is giving the model trouble.
If increasing the flowrate in a system resolves a convergence issue, it may indicate the convergence
issues in the original system are due to narrow tolerances around low flowrates. In this case, using an
Absolute Tolerance may be beneficial. If decreasing the flowrate resolves a convergence issue, it may
indicate the original flowrate is above the sonic flowrate. In this case, it may help to determine what the
sonic flowrate is, and compare the desired flowrate against that value to determine if the desired value is
physically realistic.
If increasing or decreasing all boundary pressures by a uniform amount resolves a convergence issue, it
may indicate the convergence issues in the original system are due to difficulties finding valid fluid properties at extreme conditions. In this case, it may help to try using a different fluid property library or Equation of State.
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Related Topics
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Turn Off Parts of the Model
Using the Special Conditions feature, you can turn off elements in your model and, in effect, shut down
entire sections. Then you can focus on getting selected sections to run to convergence.
If the model converges when some sections are closed, this suggests that there is an issue with the
inputs in the closed sections.

Related Topics
Special Conditions
Optional Input for Junctions
Optional Input for Pipes
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation

176
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685
686
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Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Break a Large Model Into Submodels
AFT Arrow provides convenient features for deleting parts of your model and merging parts back in. A
section of your model can be quickly deleted by selecting it on the Workspace and choosing Delete from
the Edit menu. If the section is instead Cut, it can be Pasted into a new model of its own for testing or holding. At a later time the removed sections can be added back into the current model by using the Merge
feature on the File menu.
The advantage of breaking your model into sub-models is that you can investigate the convergence characteristics of each part of your model independently. If you can get each sub-model to converge, you
should be able to get the original model to converge also. If one of your sub-models will not converge, it is
doubtful your original model will converge either.

Related Topics
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Change Solution Method
If a model does not converge, try changing the solution method in the Solution Method panel. You also
might consider changing the number of pipe segments or the Segment Length for the Length March
Increment.

Related Topics
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Try a Different Fluid, Equation of State or Accuracy Option
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Try a Different Fluid, Equation of State or Accuracy Option
Convergence issues can come from Arrow failing to find valid fluid properties at a given pressure and
temperature point. Options to resolve these issues include using a different fluid property library, changing the equation of state, or changing theaccuracy options in the Fluid panel.

Related Topics
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
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683
684
685
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Lower the Flow Rate Relaxation
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Using Lumped Adiabatic as a Starting Point
These results do not represent a converged solution. Use only for error resolution purposes
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Using Lumped Adiabatic as a Starting Point
The Lumped Adiabatic solution method is a more general solution that ignores all heat transfer effects.
The resulting solution is often found quickly, and while it has lower accuracy, it can provide a good set of
initial guesses for the marching solutions.
An option in the Solution Method panel allows users to have AFT Arrow first solve the system using the
Lumped Adiabatic method, and then use those results as the starting point for the marching solution.
Using this option can result in a faster overall runtime, especially for a complex system.

Related Topics
Troubleshooting
Diagnostics Window
Use the Model Data Window
Transfer Results to Initial Guesses
Poor Compressor/Fan Curve Fits
Troubleshooting Resistance Curves
Use the Output Window Sort Feature
Tee/Wye Junction Complexity
Lower the Flow Rate Relaxation
Try Absolute Tolerance
Make Initial Flow Rate Guesses for Pipes
Review the Iteration History
Change Boundary Conditions
Turn Off Parts of the Model
Break a Large Model Into Submodels
Change Solution Method
Try a Different Fluid, Equation of State or Accuracy Option
These results do not represent a converged solution. Use only for error resolution purposes
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Technical Support
This section focuses on the technical support options for AFT Products. Topics include descriptions of
the various support options, contact information for the AFT Support team, and links to external sites to
assist with installation issues related to AFT Arrow.
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698

Converting Models from Earlier Versions

699

Related Blogs
Having model convergence problems? Start here!

Technical Support Options
Support, Upgrade and Maintenance (SUM)
This primary level of support is for assistance with specific features within the software, or resolving
issues with a model such as difficult to converge models. We are limited in our ability to interpret model
results, and cannot recommend specific changes in a system.
One full year of SUM is provided with the purchase of a full license. Leases have SUM coverage during
the period of the lease. Further support after the first year requires SUM renewal.
For technical support questions falling in this category, contact AFT.

Flow Expert Package (FEP)
The FEP is a higher level of consulting assistance for a particular project. This service will assign a qualified AFT engineer to assist in not only modeling your system, but also with providing operational
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suggestions and interpretation of results.
The intention of this service is to provide assistance to active users of AFT software and address questions on the appropriate use of the software for specific system requirements.
Please visit our website at: https://www.aft.com/products/aft-flow-expert-package for more information
on our FEP services.

Flow Modeling Consulting Services
AFT's sister company, Purple Mountain Technology Group (PMTG), provides comprehensive consulting
services utilizing experienced consulting engineers and AFT tools. PMTG offers a solution to a wide variety of system analysis by building and investigating the models and providing direction on system
changes and appropriate operation. Visit PMTG on the web: https://www.pmtechgroup.com/, or call at
(719) 687-9145 for more information.

Related Topics
Technical Support
Contacting AFT
Information on Software Installation
Chempak Database Installation
Special File Control Features
Converting Models from Earlier Versions
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Contacting AFT
l

Telephone - (719) 686-1000

l

Fax - (719) 686-1001

l

Online - https://www.aft.com/ download the latest maintenance releases, find out what is happening at AFT, and get all the latest information.

l

E-mail Support - support@aft.com

l

Mail - 2955 Professional Place (Suite 301), Colorado Springs, CO 80904, USA

Related Topics
Technical Support
Technical Support Options
Information on Software Installation
Chempak Database Installation
Special File Control Features
Converting Models from Earlier Versions
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Information on Software Installation
For information on Local and Server installations of AFT software, please visit our website at
https://www.aft.com/support/installation.

Related Topics
Technical Support
Technical Support Options
Contacting AFT
Chempak Database Installation
Special File Control Features
Converting Models from Earlier Versions
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Chempak Database Installation
AFT Arrow does not include the Chempak Fluid Library by default. The Chempak Database is a separate
product that must be downloaded and installed as an addition to AFT Arrow to access the Chempak Fluid
Library in the software.

Chempak File Location
The Chempak Database is installed in C:\AFT Products\Chempak Data\ by default. If both AFT Arrow
and the Chempak Database are installed to their default locations, no further configuration is necessary.
However, if AFT Arrow or the Chempak Database are not installed in a default location, AFT Arrow will
need to know where to look for the Chempak Database. This location is specified in the control.aft file, located in the same folder as the Arrow.exe. If the files cannot be found the following message is displayed:

Figure 1: AFT Arrow cannot find the Chempak Database

Control.aft can be edited with a text editor, and by default looks like:
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Figure 2: Default control.aft file

If the Chempak Database was installed to a location other than the default, the line "ChempakDataPath =
" will need to be edited to include the directory it was installed to. For example: "ChempakDataPath =
C:\My AFT Files\Chempak Data"

Upgrading Chempak Database Version
When upgrading to a new version of AFT Arrow, you may receive a message that the database is outdated.

Figure 3: Outdated Chempak database

To fix this issue, download the newest version of the Chempak Database from the AFT website. Be sure
to install to the same location as the existing Chempak Database, and double check the control.aft file if
necessary.

Related Topics
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Technical Support Options
Contacting AFT
Information on Software Installation
Special File Control Features
Converting Models from Earlier Versions
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Special File Control Features
What is the Control.aft File?
Control.aft is read as AFT Arrow begins to load and instructs AFT Arrow where certain key files and copy
protection tokens are located. Typically there is little need to change the settings, however this file can be
used to override the internal defaults and customize your working environment.
Control.aft is typically located in the application folder. However, on networks, it may be necessary to locate it in the Windows\System folder of each client. If AFT Arrow finds the file in the Windows\System
folder it will use it and ignore any file in the application folder.
Control.aft can be edited using any text-based editor. Notepad, supplied as part of the Windows installation, is a good choice. Be careful to avoid changing any of the headings or key words. If these are
changed AFT Arrow will not find the important data.

Specifying Where Chempak is Located
Before AFT Arrow can use the Chempak Fluid library it needs to know where the data is located. The
path is specified in the control.aft file.
When Chempak is installed the setup procedure automatically updates any control.aft file specified with
the path to the data.
You can manually edit the file by opening it in Notepad (or any text editor) and adding the following line to
the [SEARCH PATHS] section (replace C:\AFT Products\Chempak Data with the path information based
on your system):
ChempakDataPath = C:\AFT Products\Chempak Data
This will instruct AFT Arrow to look in the C:\AFT Products\Chempak Data directory for the data.
Also see Chempak Data Installation.

Related Topics
Technical Support
Technical Support Options
Contacting AFT
Information on Software Installation
Chempak Database Installation
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Converting Models from Earlier Versions

699

Converting Models from Earlier Versions
Models from earlier versions of AFT Arrow can be used with this version. In most cases, the model file
can be opened in the newer version and automatically converted to the updated format. It is considered
good practice to do a complete check on the model to ensure the conversion process was complete and
accurate. In some cases, especially with older models, the automatic conversion is not successful. If this
occurs, please contact our support team with a copy of the model file.
Other files such as libraries (previously databases) or preference files can also be converted.

Related Topics
Technical Support
Technical Support Options
Contacting AFT
Information on Software Installation
Chempak Database Installation
Special File Control Features
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Examples
Walk-Through Examples
The AFT Arrow Examples Help System is designed to expose users to a range of applications and
improve their understanding of the AFT Arrow software. If you are new to AFT Arrow, start with the Air
Heating System Example, because it has the most in-depth discussion on how to create and run AFT
Arrow models. After this example, choose an example from the table below that most closely matches
your application.

Example

Beginner: Air
Heating System

Flow Through
an Orifice

Control Valve

Complexity

Beginner

Beginner

Beginner

Fluid

Air

Steam

Steam

Pipes

5

2

2
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Fans / Compressors

Description

1

A new AFT Arrow user
should start here. Get indepth instructions of model
building by solving an air
heating system problem.
Learn how to define a fluid
in Analysis Setup, place
pipes and junctions on the
Workspace, define pipes
and junctions, use the
Model Data window, run a
model, use the Output window, generate graphs in
the Graph Results window,
and view results in the
Visual Report window.

0

Learn about the CdA value
for sonic choking in the Orifice Properties window.
See how the effective flow
area affects the flow rates
and pressures in the system.

0

Learn how to define the
Convective Heat Transfer
model on the Heat Transfer
tab of the Pipe Properties
window. See how to use a
control valve junction to
determine pipe size. Learn
how to use the Output Control window to display rel-

Walk-Through Examples

Example

Complexity

Fluid

Pipes

Fans / Compressors

Description
evant heat transfer output
parameters.

Natural Gas
Burner

Compressed
Air System

Process
Steam System

Hydrocarbon
Relief System

Refinery Relief
System

Air Blower Sizing

Beginner

Beginner

Intermediate

Intermediate

Beginner

Intermediate

Methane

Air

Steam

Methane
Hydrogen

Methane
Ethane Propane

Air

16

9

17

4

6

13
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0

Learn how to use the Specified Heat Rate In Constant thermal model in a
Heat Exchanger junction to
obtain a desired outlet temperature in a system. See
how to specify a resistance
curve as the loss model in
a Heat Exchanger junction.

1

Learn how to input a compressor curve into a Compressor/Fan junction. See
how to use the Scenario
Manager to create different
system configurations.
Explore how to use the isometric pipe drawing mode
in the Workspace window.

0

Learn about the Solution
Method panel in Analysis
Setup to see how the
Length March Increment
impacts results.

0

Learn how to create a mixture using the NIST
REFPROP fluid library.
See how and where multiple choking points occur
in the system.

0

Learn how to use the NIST
REFPROP fluid library to
specify multiple pure fluids
in a single system where
dynamic mixing occurs.
See how to use Global
Junction Edit to make rapid
changes to junctions.

1

Learn how blower efficiency affects pressure rise
and discharge temperature. See how using

Walk-Through Examples

Example

Complexity

Fluid

Pipes

Fans / Compressors

Description
heat transfer further
impacts the pressure and
temperature results.

Compressed
Air System Cost

Process
Steam System
- Cost

Beginner

Intermediate

Air

Steam

9

17

1

Learn the basics of cost calculations such as specifying material,
installation, and energy
costs, connecting engineering and cost libraries,
and interpreting the Cost
Report in the Output window.

0

Learn how to create cost libraries for pipe materials
and junctions. See how to
use Scale Tables to allow
costs to scale as pipe diameters change. Learn how
to specify Material costs
versus Installation costs.

Beginner: Air Heating System
Summary
This example is designed to demonstrate the big picture of AFT Arrow’s layout and structure. Some of
the more basic concepts will be used to build a simple air heating system driven by a compressor.

Topics Covered
l

Completing Analysis Setup

l

Drawing the system with Pipes and Junctions

l

Entering Pipe and Junction properties

Required Knowledge
This example assumes the user has not used AFT Arrow previously. It begins with the most basic elements of laying out the pipes and junctions and solving hydraulic methodology.
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Model File
This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Air Heating System.aro

Step 1. Start AFT Arrow
ØTo start AFT Arrow, click Start on the Windows taskbar, choose the AFT Arrow 9 folder, then click
AFT Arrow 9 to launch the application. (This refers to the standard menu items created by setup. You
may have chosen to specify a different menu item during installation.)
After AFT Arrow opens, the Start-Up screen, as shown in Figure 1, appears and provides you with several options before you start building a model. Some of the actions available are:
l

Open a recent model, browse to a model, or browse to an Example

l

Activate an Add-on Module

l

Select AFT Standard Air or a recently used fluid to be the Working Fluid

l

Review or modify Modeling Preferences

l

l

Select a Unit System

l

Filter units to include Common Only or Common Plus Selected Industries

l

Choose a Grid Style

l

Select a default Pipe Material

Access other Resources, such as Quick Start Guides, Help Files, and Video Tutorials

Note: If you are working through the Metric Units version of the Examples, be sure to specify either
Metric Only or Both with Metric Defaults as the unit sets and check the box to Set as my Default.
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Figure 1: AFT Arrow Start-Up window

Click Start Building Model on the Start-Up window, the Workspace window is always the active (large)
window, as seen in Figure 2.The five tabs in the AFT Arrow window represent the five Primary Windows.
Each Primary Window contains its own Toolbar that is displayed directly beneath the Primary Window
tabs.
AFT Arrow supports dual monitor usage. You can click and drag any of the five Primary Window tabs off
of the main AFT Arrow window. Once you drag one of the Primary Windows off of the AFT Arrow window,
you can move it anywhere you like on your screen, including onto a second monitor in a dual monitor configuration. To add the Primary Window back to the main AFT Arrow primary tab window bar, simply click
the X button in the upper right of the Primary Window.
To ensure that your results are the same as those presented in this documentation, this example should
be ran using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
The Workspace Window
The Workspace window is the primary vehicle for building your model. This window has three main
areas: the Toolbox, the Quick Access Panel, and the Workspace itself. The Toolbox is the bundle of tools
on the far left.
The Quick Access Panel is on the far right. It is possible to minimize the Quick Access Panel by clicking
on the thumbtack pin in the upper right corner of the Quick Access Panel in order to allow for greater
Workspace area.
The Workspace takes up the rest of the window.
You will build your pipe flow model on the Workspace using the Toolbox tools. At the top of the Toolbox is
the Pipe Drawing Tool and the Annotation tool. The Pipe Drawing tool, on the upper left corner of the
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Toolbox, is used to draw new pipes on the Workspace. The Annotation tool allows you to create annotations and auxiliary graphics.
Below the two drawing tools are twenty icons that represent the different types of junctions available in
AFT Arrow. Junctions are components that connect pipes and also influence the pressure or flow behavior of the pipe system. The twenty junction icons can be dragged from the Toolbox and dropped onto the
Workspace.
When you hold your mouse pointer over any of the Toolbox tools, a ToolTip identifies the tool's function.

Figure 2: The Workspace window is where the model is built

Step 2. Complete the Analysis Setup
ØNext, click Analysis Setup on the Toolbar that runs across the top of the AFT Arrow window. This
opens Analysis Setup (see Figure 3). Analysis Setup contains seven groups(additional groups will be displayed if the GSC, XTS, or ANS modules are active). Each group needs to be completed before AFT
Arrow allows you to run the Solver.
Analysis Setup can also be accessed by clicking on the Status Light on the Quick Access Panel. Once
Analysis Setup is complete, the Model Status Light then turns from red to green.
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Figure 3: The Analysis Setup tracks the model’s status and allows users to specify required parameters

A. Define the Modules Group
Although Analysis Setup initially opens to the Fluid panel of the Fluid Properties group, the first group,
Modules, always has a green check when you start AFT Arrow because there are no modules activated
by default. No further input is required here.

B. Define the Fluid Properties Group
Next is the Fluid Properties group. This group allows you to choose a fluid, select an Equation of State,
and select an Enthalpy Model. Start by clicking on Fluid to open the Fluid panel (see Figure 4).
You can select a fluid from the standard AFT Arrow fluid library (AFT Standard), select ASME Steam
Tables, or select multiple fluids and/or create mixtures using the Chempak library or NIST REFPROP library. You can also select a custom fluid, which will be shown in the AFT Standard list. Custom fluids are
created by opening the Library Manager from the AFT Arrow Library menu or by clicking the Edit Fluid
List button at the bottom of the Fluid panel and clicking Add New Fluid...
ØSelect AFT Standard, select Air, then click Add to Model (see Figure 4). Leave the Equation of
State model as Redlich-Kwong and the Enthalpy Model as Generalized.
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Figure 4: The Fluid panel lets you select gases for the model and create mixtures

C. Define the Pipes and Junctions Group
In order to fully define this group, there needs to be pipes and junctions on the Workspace. To lay out the
recirculating model, you will place five junctions on the Workspace. Then you will connect the junctions
with pipes.

I. Place the tank
ØTo start, drag a tank junction from the Toolbox and drop it on the Workspace. Figure 5 shows the
Workspace with one tank.
Objects and ID numbers
Items placed on the Workspace are called objects. All objects are derived directly or indirectly from the
Toolbox. AFT Arrow uses three types of objects: pipes, junctions and annotations.
All pipe and junction objects on the Workspace have an associated ID number. For junctions, this number is, by default, placed directly above the junction and prefixed with the letter J. Pipe ID numbers are
prefixed with the letter P. You can optionally choose to display either or both the ID number and the name
of a pipe or junction. You also can drag the ID number/name text to a different location to improve visibility.
The tank you have created on the Workspace will take on the default ID number of 1. You can change
this to any desired number greater than zero and up to 99,999.
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Editing on the Workspace
Once on the Workspace, junction objects can be moved to new locations and edited with the features on
the Edit menu. Duplicating, cutting, copying, and pasting are all supported.

Figure 5: Adding a tank junction to the model

II. Place the other junctions
If the new junction type you want to add already exists on the Workspace, you have the option of duplicating that junction. You do this by selecting the object on the Workspace and then either choosing Duplicate from the Edit menu or pressing Control+D on the keyboard.
Drag a compressor/fan junction from the Toolbox and drop it somewhere to the right of the tank (see Figure 6). Next drag a branch junction and locate it above the compressor, then drag a heat exchanger junction and locate it above the tank. Finally, drag another tank junction and place it above the first tank
junction.
Note: The relative location of objects in AFT Arrow is not important. Distances and heights are defined
through Pipe and Junction Property windows. The relative locations on the Workspace establish
the connectivity of the objects, but have no bearing on the actual length or elevation relationships.
If the icons do not line up exactly, no problems will result. However, your model may have a nicer appearance if the icons line up. You can align the icons by using the align features selected from the Arrange
menu.
Your model should now appear similar to that shown in Figure 6.
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Figure 6: Adding additional junctions to the model

ØBefore continuing, save the work you have done so far. Choose Save As... from the File menu and
enter the file name Air Heating System and AFT Arrow will append the *.aro extension to the file name.

III. Draw a pipe between J1 and J2
Now that you have five junctions, you need to connect them with pipes.
ØTo create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The pointer will change to a cross
hair when you move it over the Workspace. Draw a pipe below the junctions, similar to that shown in Figure 7.
The pipe object on the Workspace has an ID number (P1) shown near the center of the pipe.
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Figure 7: Create a Pipe

ØTo place the pipe between J1 and J2, use the mouse to grab the pipe in the center, drag it so that its
left endpoint falls within the J1 Tank junction, then drop it there (see Figure 8). Next, grab the right endpoint of the pipe and stretch the pipe, dragging it until the endpoint terminates within the J2 Compressor/Fan junction (see Figure 9).

Figure 8: Connecting pipe P1 to the tank J1
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Reference positive flow direction
On each pipe is an arrow that indicates the reference positive flow direction for the pipe. AFT Arrow
assigns a flow direction corresponding to the direction in which the pipe is drawn.
You can reverse the reference positive flow direction by choosing Reverse Direction from the Arrange
menu or selecting the Reverse Pipe Direction button on the Workspace Toolbar.
The reference positive flow direction is used for reference purposes only and need not be the actual flow
direction.
If the reference positive direction is the opposite of that obtained by the Solver, the output will show the
flow rate as a negative number.

Figure 9: Connecting pipe P1 between two junctions

IV. Draw the remaining pipes
A faster way to add a pipe is to draw it directly between the desired junctions.
ØActivate the pipe drawing tool again, position the mouse pointer on the J2 compressor/fan, then
press and hold the left mouse button. Stretch the pipe up to the J3 Branch then release the mouse button. Now draw a third pipe from the J3 Branch to the J4 Heat Exchanger, draw a fourth pipe from the J4
Heat Exchanger to the J5 Tank, and draw a fifth pipe from the J3 Branch to the J5 Tank. Your model
should now look similar to Figure 10.
Tip: Double-click the Pipe Drawing Tool in order to draw multiple pipes at a time, then deactivate the
Pipe Drawing Tool either by pressing the Esc key or single-clicking the Pipe Drawing Tool
again.
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Figure 10: Workspace view after drawing remaining pipes

At this point all the objects in the model are graphically connected. Save the model by selecting Save in
the File menu or by clicking on the diskette button on the Toolbar.
Note: Some users find it desirable to lock objects to the Workspace once they have been placed. This
prevents accidental movement and disruption of the connections. You can lock all the objects
by choosing Select All from the Edit menu, then selecting Lock Object from the Arrange menu.
The lock button on the Workspace Toolbar will appear depressed indicating it is in an enabled
state, and will remain so as long as any selected object is locked. Alternatively, you can use the
grid feature enabled in the User Options window from the Tools menu and specify that the pipes
and junctions snap to grid.

V. Define the pipes and junctions
To fully define the Pipes and Junctions group in Analysis Setup, all pipes and junctions must be connected and have the proper input data.
Object status
Every pipe and junction has an object status. The object status tells you whether the object is defined
according to AFT Arrow's requirements. To see the status of the objects in your model, click the flood
light (Show Object Status) icon on the far right of the Workspace Toolbar (alternatively, you could choose
Show Object Status from the View menu). Each time you click the light, Show Object Status is toggled
on or off.
When Show Object Status is on, the ID numbers for all undefined pipes and junctions are displayed in
red on the Workspace. Objects that are completely defined have their ID numbers displayed in black.
(These colors are configurable through the User Options window from the Tools menu.)
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Because you have not yet defined the pipes and junctions in this example, all the objects' ID numbers will
change to red when you turn on Show Object Status.
Undefined Objects window
The Undefined Objects window lists all undefined pipes and junctions and further displays the items that
are not yet defined.

VI. Define Tank J1
To define the first tank, open the J1 Tank Properties window by double-clicking on the J1 icon. The
table on the Loss Coefficients should show you that Pipe 1 is connected to this tank.
Note: You can also open an object's Properties window by selecting the object (clicking on it) and then
either pressing the Enter key or clicking the Open Pipe/Jct Window icon on the Workspace Toolbar.
ØEnter the Pressure as 0 barG (0 kPa (g)). You can assign any unit of pressure found in the adjacent
drop-down list box of units. Enter the Temperature as 40 deg. C and the Elevation as 0 meters.
Note: You can choose default units for many parameters (such as meters for length) in the User
Options window.
You can give the component a name, if desired, by entering it in the Name field at the top of the window.
By default, the junction’s name indicates the junction type. The name can be displayed on the Workspace, Visual Report or in the Output.
Most junction types can be entered into a custom library allowing the junction to be used multiple times or
shared between users. To select a junction from the custom library, choose the desired junction from the
Library Jct list. The current junction will get the input properties from the library.
The Copy Data From Junction… list will show all the junctions of the same type in the model. This will
copy selected parameters from an existing junction in the model to the current junction.
Using the folder tabs in the Properties windows
The information in the Properties windows is grouped into several categories and are placed on separate
tabs. Click the folder tab to bring its information forward. Figure 11 is an example of a Properties window.
Click the Loss Coefficients tab to show the pipe table. The pipe table allows you to specify entrance and
exit loss factors for each pipe connected to the tank (in this case there is only one). The default selection
is the loss factors specified as zero. To later change the loss factors, click within the pipe table and enter
the loss.
The Optional tab allows you to enter different types of optional data. You can select whether the junction
number, name, or both are displayed on the Workspace. Some junction types also allow you to specify
an initial pressure and temperature as well as other junction-specific data.
Each junction has a folder tab for notes, allowing you to enter text describing the junction or documenting
any assumptions.
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The Highlight feature displays all the required information in the Properties window in blue. The highlight
is on by default. You can toggle the highlight off and on by pressing the F2 key. The highlight feature can
also be turned on or off by selecting it on the User Options window. For the remainder of the examples,
we will keep the highlight feature turned off.
ØClick OK. If Show Object Status is turned on, you should see the J1 ID number turn black again, telling
you that J1 is now completely defined.

Figure 11: Properties window for Tank J1

The Inspection Feature
You can check the input parameters for J1 quickly, in read-only fashion, by using the Inspection feature.
Position the mouse pointer on the J1 tank icon and hold down the right mouse button. An information box
appears, as shown in Figure 12.
Inspecting is a faster way of examining the input in an object rather than opening the Properties window.

- 714 -

Walk-Through Examples

Figure 12: Inspecting from the Workspace with right mouse button

VII. Define The Other Junctions
ØNext, open the properties window for Compressor/Fan J2 (see Figure 13). Six compressor/fan models are provided. You can enter a compressor curve or you can enter a fixed mass flow rate or volumetric
flow rate. A fixed flow rate will force the specified flow through the system and the resulting pressure rise
will be calculated. A fixed pressure or head rise will apply the specified pressure or head at the compressor/fan and the resulting flow rate will then be calculated. A compressor/fan curve will model the
actual performance of the compressor/fan. The pressure rise from a compressor/fan curve can be selected as either static or stagnation. The compression process models how the heat of compression affects
the gas temperature, which is important in compressor applications.
For this example, use Centrifugal Compressor and select Compressor Curve as the Compressor Model.
Click Enter Curve Data and enter the following data into the Compressor Configuration window:
Mass

Pressure

kg/sec

bar

0

0.6

0.45

0.7

0.90

0.5

Click Generate Curve Fit Now and then click OK. Make sure the Added Pressure selection is set to
Stagnation.
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Set the Compression Process to Polytropic with a constant of 1.5. Last, enter an elevation of 0 meters.
Then click OK and the compressor/fan should be completely defined. Figure 13 shows the Compressor/Fan Properties window.

Figure 13: Properties window for Compressor/Fan J2

ØOpen the Branch J3 properties window (see Figure 14). In this window, three connecting pipes
should be displayed in the pipe table area. You can associate loss factors with each pipe by clicking
within the pipe table and entering the data. These will be set to zero for this example.
ØEnter an elevation of 0 meters for the Branch J3 (an elevation must be defined for all junctions). You
could also click the Optional tab and then specify a flow source or sink at the junction. For this example,
we will not use the Flow Source or Sink option in the Optional tab. Click OK and the branch is now
defined.
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Figure 14: Properties window for Branch J3

ØOpen the Heat Exchanger J4 Properties window. The thermal behavior of the heat exchanger is
specified under the Thermal Data tab.
If you know the heat load for the exchanger, you can choose the Specified Heat Rate In thermal model
and enter the heat rate directly. Adding heat to the system fluid is positive (i.e., heat flows out of the junction) while cooling is negative (heat flows into the junction).
You also have the option of choosing among a number of common heat exchanger configurations such
as parallel and counter-flow. When you choose one of the other models, you must enter the secondary
fluid conditions, heat exchanger area and heat transfer coefficient data. The secondary fluid can be
either liquid or gas, although the models used to calculate heat transfer will be more accurate for liquids.
Whichever model is selected, the heat is added to or removed from the heat exchanger in accordance
with the input model. The pressure drop through the heat exchanger is based on the Loss Model that is
selected.
For this example, choose the Counter-Flow heat exchanger model with the following characteristics.
Heat Transfer Area = 1 meter2, Overall Heat Transfer Coefficient = 57 W/m2-K, Secondary Fluid Flow
Rate = 0.25 kg/sec, Secondary Fluid Specific Heat = 4 kJ/kg-K, Secondary Fluid Inlet Temperature = 50
deg C.
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The Thermal Data tab should now look like see Figure 15.
ØGo to the Loss Model tab and specify the K factor at a value of 2. Enter an elevation of 0 meters,
then click OK and the heat exchanger should be completely defined.

Figure 15: Properties window for Heat Exchanger J4

ØOpen Tank J5 and enter a Pressure of 0.5 barG (50 kPa(g)), a Temperature of 40 deg. C and an Elevation of 0 meters.
ØSave the model again before proceeding.

VIII. Define Pipe P1
The next step is to define all the pipes. To open the Pipe Properties window, double-click the pipe object
on the Workspace.
ØFirst open the Pipe Properties window for Pipe P1 (see Figure 16). For Pipe P1 choose Steel ANSI from the Pipe Material drop down menu, 4 inch for Size, STD (schedule 40) for the Type, and a
length of 3 meters.
ØOn the Heat Transfer tab, select the Convective Heat Transfer model and for the Ambient Conditions, set the Temperature to 5 deg. C, the Fluid Velocity to 25 km/hr, and the Fluid to Air (see Figure 17).
Click OK. Pipe P1 is now defined.
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Figure 16: Properties window for Pipe P1

Figure 17: Heat transfer data for Pipe P1

The Pipe Properties window
The Pipe Properties window offers control over all important flow and heat transfer parameters that are
related to pipes.
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The Inspection feature also works within the Pipe Properties window. To Inspect a connected junction,
position the mouse pointer on the connected junction's ID number and hold down the right mouse button.
This is helpful when you want to quickly check the properties of connecting objects. You can also use
this feature in the junction properties windows for checking connected pipe properties.
By double-clicking the connected junction number, you can jump directly to the junction's properties
window. Or you can click Jump to jump to any other part of your model.

IX. Define Other Pipes
ØOpen the Pipe Properties window for pipe P2 and choose pipe P1 from the Copy Data From Pipe
drop-down menu (alternatively you can click the Copy Previous button). Choose all the properties and
click OK. This will copy all pipe P1 input data to pipe P2. Then change the length of pipe P2 to 9 meters.
Open the other three Pipe Property windows and similarly copy all input data from pipe P1. Set the length
of pipe P4 to 1.5 meters. Note that pipes P1, P3, and P5 will all have the same exact input data.
After completing the last pipe, all groups in Analysis Setup should be complete.

X. Check Pipes And Junctions
ØCheck if all the pipes and junctions are defined. If not, turn on the Show Object Status from the
View menu and open each undefined pipe and junction. The Status tab will indicate what information is
missing.

XI. Check Model Data
ØBefore running the model, save it to file one more time. It is also a good idea to review the input
using the Model Data window.
Reviewing input in the Model Data window
The Model Data window is shown in Figure 18. To change to this window, you can select it from the
Primary Window tabs or the Window menu, or by pressing CTRL+M. The Model Data window provides a
tabular format for your model's input property data. Data in the Model Data window can be selected and
then copied and pasted into other Windows programs, saved to a formatted file, printed to an Adobe
PDF, or printed out for review.
Data is displayed in three general areas. The top area is called the General Section, the middle area is
the Pipe Section, and the bottom area is the Junction Section.
The Model Data window allows access to all Properties windows by double-clicking the appropriate ID
number in the far left column of the table. You may want to try this right now.
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Figure 18: The Model Data window shows all input in text form

D. Define the remaining groups in Analysis Setup
Open Analysis Setup once more to confirm that all groups are defined. No inputs or alterations are
required to complete the last three groups: Steady Solution Control, Environmental Properties, Cost Settings, and Miscellaneous. All seven groups should have a green checkmark next to its name. Click OK.

Step 3. Run The Solver
ØChoose Run Model from the Toolbar or Analysis menu. During execution, the Solution Progress window displays (see Figure 19). You can use this window to pause or cancel the Solver's activity. When the
solution is complete, the Output, Visual Report, and Graphs Results windows can be accessed directly
from the Solution Progress window. Click the Output button and the text-based Output window will
appear (see Figure 20). The information in the Output window can be reviewed visually, saved to file,
exported to a spreadsheet-ready format, copied to the clipboard, printed to an Adobe PDF file, and printed out on the printer.
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Figure 19: The Solution Progress window displays the convergence progress
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Figure 20: The Output window displays output in text form

Step 4. Examine the Output
The Output window is similar in structure to the Model Data window. Three areas are shown, and you can
minimize or enlarge each area by clicking the arrow next to the General, Pipes, and Junctions tabs.

A. Specify Output Control
By default, AFT Arrow has a predefined set of Output Control parameters that are specified and the
default units used depend on which unit set was selected when first running AFT Arrow (see Figure 1). A
default title is also assigned in the Output Control.
ØOpen Output Control from the from the Common Toolbar or Tools menu. (Figure 21 shows the Output Control window). Click the General tab, enter a new title (if you like you can title this Air Heating System), then click OK to accept the title and other default data.
In addition, this window allows you to select the specific output parameters you want in your output from
the Display Parameters tab. You also can choose the units for the output.
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Figure 21: The Display Parameters tab allows you to customize which output data is displayed in AFT Arrow

B. Modify The Output Format
If you selected the default AFT Arrow Output Control, the Pipe Results table will show mass flow rate in
the second column with units of kg/sec.
ØSelect Output Control from the Tools menu. On the right side of the Display Parameters tab for
Pipes is the list of selected output parameters that will be displayed in the Output window. The left side
shows parameters that are not in the current output report, but can be added at your option. You can view
the list on the left either alphabetically or by categories by clicking the appropriate tab. On the list on the
right, click Mass Flow Rate and change the units by selecting kg/hr from the drop-down menu.
ØClick OK to display changes to the current results. You should see the mass flow rate results, still
in the second column, in units of kg/hr. Notice the Velocity Inlet (Vel. In) results in the third column.
ØSelect Output Control from the Tools menu one more time. Select the Pipes in the Display Parameters tab. The parameters can be reordered by clicking the Reorder arrows on the right of the list, or by
dragging the Reorder parameter icon on the left of the Output parameter you would like to reorder.
ØSelect the Velocity Inlet parameter and move it up to the top of the parameter list.
ØClick OK to display the changes to the current results. You will see in the Pipe results table that
the first column now contains Vel. In (Velocity Inlet), the second column now contains the pipe name, and
the third column the mass flow rate. The Output Control window allows you to obtain the parameters,
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units, and order you prefer in your output. This flexibility will help you work with AFT Arrow in the way that
is most meaningful to you, reducing the possibility of errors.
ØLastly, double-click the column header for Vel. In in the Output window Pipe Results Table.
This will open a window in which you can change the units once again if you prefer. These changes are
extended to the Output Control parameter data you have previously set.

C. View The Visual Report
ØChange to the Visual Report window by clicking the Visual Report tab or by choosing it from the Windows menu. This window allows you to integrate your text results with the graphic layout of your pipe network.
ØClick the Visual Report Control button on the Toolbar (or Tools menu) and open the Visual Report
Control window, shown in Figure 22. The default list of parameters are filtered such that only the parameters currently displayed with the Output Control are shown. You can also set the Parameter Filter
such that All Available Parameters will be visible. For now, select Velocity Outlet in the Pipe Results list
and Pressure Static Inlet in the Junction Results list. Click the Show button. The Visual Report window
graphic is generated as shown in Figure 23.
It is common for the text in the Visual Report window to overlap when first generated. You can change
this by selecting smaller fonts or by dragging the text to a new area to increase clarity (this has already
been done in Figure 23). This window can be printed or copied to the clipboard for import into other Windows graphics programs, saved to a file, or printed to an Adobe PDF file.
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Figure 22: The Visual Report Control window selects content for the Visual Report window
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Figure 23: The Visual Report window integrates results with model Layout

D. Graph The Results
ØChange to the Graph Results window by clicking the Graph Results tab, choosing it from the Windows menu, or by pressing CTRL+G. The Graph Results window offers full-featured Windows plot preparation.
The Graph Parameters section will automatically be displayed in the Graph Control tab on the Quick
Access Panel on the far right of the Graph Results window. The Graph Parameters section on the Graph
Control tab is where you can specify which graphs you would like to generate. Multiple types of graphs
can be generated such as Profiles, Compressor/Fan vs. System Curves, System Curves, or Solutions.
Select the Profile Graph tab in the Graph Parameters area in the Graph Control on the Quick Access
Panel. Plot Single Path selected by default, select pipes P1 through P4 from the Pipes list. Choose Pressure Static, if not already selected, from the Parameter drop-down menu. Make sure meters as the
Length Units and bar as the Pressure Static Units. Then click Generate. The Show Junction Locations
feature is located on the Graph Results Toolbar and can be enabled or disabled by clicking the icon (see
Figure 24).
A graph appears showing the static pressure along the flow-path defined by pipes P1 through P4 in Figure 25.
You can use the other buttons in the Graph Results window to change the graph appearance and to save
and export data for cross-plotting. The Graph Results window can be printed, saved to file, copied to the
clipboard, or printed to an Adobe PDF file. The graph’s x-y data can be exported to file or copied to the
clipboard.
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Figure 24: The Graph Parameters section of the Graph Control tab on the Quick Access Panel controls the
Graph Results content

Figure 25: The Graph Results window offers full-featured plot generation

You have now used AFT Arrow's five Primary Windows to build a simple model. Review the rest of the
Arrow Help File contents for more detailed information on each of the windows and functions.
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Summary
This example demonstrates a sample calculation to determine the maximum flow through a system
where sonic choking occurs, as well as the sonic pressure and area, and it explores the effect of CdA on
the system flow rate.

Topics Covered
l

Determining the maximum flow through a system

l

Determining sonic (stagnation) pressure

l

Determining sonic area

l

Using scenarios

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model File
This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Orifice Flow.aro

Problem Statement
For this problem, steam flows from one tank to another, through an orifice.
The first pipe from the inlet tank to the orifice is 3 meters long, and the second pipe leading from the orifice to the discharge tank is 6 meters long. Both pipes are 2 inch, STD (schedule 40) pipes, and are well
insulated (adiabatic).
The inlet tank has a pressure of 16 barG (1600 kPa (g)) and a temperature of 260 deg. C. The discharge
tank has a pressure of 0 barG (0 kPa (g)). Set the discharge temperature to 260 deg. C. The discharge
temperature is not important in this case because no fluid is entering the system at the discharge, so the
fluid temperature cannot impact the system temperature. Both tanks are at 0 meters elevation.
The orifice at the end of the first pipe has an area of 20 cm2, and a K Factor of 10.
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Determine the following:
1.

What is the maximum flow through the system?

2.

What is the sonic (stagnation) pressure at the system exit?

3.

At the maximum flow, what is the sonic area at the orifice? At the discharge tank?

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Step 2. Define the Fluid Properties Group
1.

Navigate to the Fluid panel in Analysis Setup

2.

Define the Fluid panel with the following inputs
a.

Fluid Library = AFT Standard

b.

Fluid = Steam

c.

Equation of State = Redlich-Kwong

d.

Enthalpy Model = Generalized

e.

Specific Heat Ratio Source = Library

i.

After selecting, click Add to Model

Step 3. Define the Pipes and Junctions Group
At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as
shown in the figure below.
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Figure 1: Workspace window showing the model layout for Flow Through an Orifice example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and
junction and enter the following properties.

Pipe Properties
1.

Pipe Model tab
a.

Pipe Material = Steel - ANSI

b.

Pipe Geometry = Cylindrical Pipe

c.

Size = 2 inch

d.

Type = STD (schedule 40)

e.

Friction Model Data Set = Standard

f.

Lengths =
Pipe

Length (meters)

1

3

2

6

Junction Properties
1.

J1 Tank
a.

Name = Inlet Tank

b.

Elevation = 0 meters
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2.

3.

c.

Fluid = Steam

d.

Pressure = 16 barG (1600 kPa(g))

e.

Temperature = 260 deg. C

J2 Orifice
a.

Elevation = 0 meters

b.

Orifice Type = User Specified

c.

Subsonic Loss Model = K Factor

d.

Orifice Dimensions = Area

e.

Area = 20 cm2

f.

K = 10

J3 Tank
a.

Name = Discharge Tank

b.

Elevation = 0 meters

c.

Fluid = Steam

d.

Pressure = 0 barG (0 kPa(g))

e.

Temperature = 260 deg. C

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter
the missing data.

Step 4. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 5. Specify the Output Control
Open the Output Control window by selecting Output Control from the Toolbar or Tools menu.
The Output window (Figure 2) contains all the data that is specified in the Output Control window. The
window starts with a default set of outputs, which is normally sufficient. You can also specify the units for
each output parameter from this window. For this example, change the Pressure Stagnation Inlet units to
barG (after making the change, click Same Units below the Output list, then click OK to change all pressure units to barG. Next, click the Junctions button at the top and change the Sonic Flow Area units to
cm2.

Step 6. Examine the Output
Because this system chokes at the discharge tank, the Sonic Choking tab appears in the General section
of the Output window. This tab will appear when sonic choking occurs in the system, and will contain
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messages pertaining to the sonic choking conditions.
Because the flow is choked at the exit, the mass flow rate shown in the Output reflects the maximum flow
rate through the system for the given conditions. The maximum flow rate through this system is 1.966
kg/sec. The stagnation pressure at the exit is 5.617 barG (561.7 kPa(g)). The output in the junction data
portion of the Output window shows the Sonic Area at the orifice is 8.890 cm2, and the Sonic Area at the
discharge tank is 21.647 cm2.

Figure 2: Output window showing results for Flow Through an Orifice Example

Step 7. System Modification
Set the CdA (for Sonic Choking - Optional) in the Orifice Properties window to 20% higher than the sonic
area and then 20% lower than the sonic area, and rerun the model for each scenario. How do the results
change for each case?
Note: This is a situation where a user can create two new scenarios using the Scenario Manager to
examine several what-if situations, without disturbing the basic model.

Step 8. Re-evaluate the Model
Setting the orifice CdA higher than the sonic area has no affect on the model because the system is
already choking at the exit. Setting the CdA 20% lower than the sonic area (7.112 cm2) causes the flow
rate to decrease to 1.594 kg/sec, and the exit discharge stagnation pressure to decrease to 4.360 barG
(436.0 kPa(g)). Also, lowering the CdA has caused the system to choke in two places rather than just
one. This can be seen on the Sonic Choking tab in the General section of the Output window.
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Summary
This example will walk you through a simple calculation to calculate a pipe size for a system with a control valve.

Topics Covered
l

Using flow control valves

l

Entering and changing pipe size data

l

Adding items to the output using Output Control

l

Modifying output using Output Control

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model File
This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Control Valve.aro

Problem Statement
For this problem, steam flows from one tank to another. The pipe between the tanks is horizontal, and
140 meters long. A control valve is used to control the flow. The control valve must have a pressure drop
of at least 1.5 bar (150 kPa) to operate correctly. Assume the control valve is in the middle of the pipe.
The ambient temperature is 15 deg. C. The pipe has an ambient air velocity of 25 km/hr, and no insulation. The inlet stagnation pressure and temperature values are 16 barG (1600 kPa(g)) and 220 deg. C,
and the outlet stagnation pressure and temperature values are 9 barG (900 kPa(g)) and 220 deg. C.
Note that the discharge temperature does not have an impact on calculations unless the discharge
boundary happens to be supplying flow. Therefore, an assumed temperature can be used.
The pipe must be sized correctly to allow 2 kg/sec to flow from one reservoir to the other. Consider only
STD (schedule 40) pipes.
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Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Step 2. Define the Fluid Properties Group
1.

Navigate to the Fluid panel in Analysis Setup

2.

Define the Fluid panel with the following inputs
a.

Fluid Library = AFT Standard

b.

Fluid = Steam
i.

After selecting, click Add to Model

c.

Equation of State = Redlich-Kwong

d.

Enthalpy Model = Generalized

e.

Specific Heat Ratio Source = Library

Step 3. Define the Pipes and Junctions Group
At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as
shown in the figure below.

Figure 1: Workspace window showing the model layout for Control Valve example
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The system is in place but now we need to enter the properties of the objects. Double-click each pipe and
junction and enter the following properties.
For this example, you need to find the correct pipe size but you are limited to STD (schedule 40) pipe
sizes. You need to use your engineering judgment to take an initial guess at the pipe size for 2
kg/sec. Try 2-½ inch pipe. Specify the pipes as follows:

Pipe Properties
1.

2.

Pipe Model tab
a.

Pipe Material = Steel - ANSI

b.

Pipe Geometry = Cylindrical Pipe

c.

Size = 2-1/2 inch

d.

Type = STD (schedule 40)

e.

Friction Model Data Set = Standard

f.

Length = 70 meters

Heat Transfer tab
a.

Heat Transfer Model = Convective Heat Transfer

b.

Temperature = 15 deg. C

c.

Fluid Velocity = 25 km/hr

d.

Fluid = Air

Figure 2: Pipe Heat Transfer Properties window

Junction Properties
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1.

2.

3.

J1 Tank
a.

Elevation = 0 meters

b.

Fluid = Steam

c.

Pressure = 16 barG (1600 kPa(g))

d.

Temperature = 220 deg. C

J2 Control Valve
a.

Elevation = 0 meters

b.

Valve Type = Flow Control (FCV)

c.

Control Setpoint = Mass Flow Rate

d.

Flow Setpoint = 2 kg/sec

e.

Always Control (Never Fail) = Unchecked

J3 Tank
a.

Elevation = 0 meters

b.

Fluid = Steam

c.

Pressure = 9 barG (900 kPa(g))

d.

Temperature = 220 deg. C

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter
the missing data.

Step 4. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 5. Specify the Output Control
Open the Output Control window by selecting Output Control from the Toolbar or Tools menu.
In this example, you want to review the effects of changing the pipe nominal size. To simplify this, add
this parameter to the output.
1.

Click the Pipes button in the Display Parameters tab.

2.

In the list on the left, find the parameter Nominal Size.

3.

Select the Nominal Size parameter and then click the Add button, which adds the parameter to the
list of displayed parameters on the right.

4.

Use the Reorder buttons (in the upper right) to move the Nominal Size up so that it becomes the
second parameter in the list (see Figure 3).

5.

Click OK.
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Figure 3: Output Control window

Step 6. Examine the Output
The Output window contains all the data that was specified in the Output Control window. The output is
shown in Figure 4. In the General section of the Output window, there is a Warnings tab. Select this tab
and you can see that for this case, the flow control valve was not able to achieve the required flow rate of
2 kg/sec. The pressure drop across the valve is higher than the pressure drop required for the system to
balance, so the valve is unable to maintain control for this size of pipe.
In addition warnings are shown that the fluid is above the saturation pressure line. AFT Arrow cannot calculate the actual behavior of the gas when the saturation line is reached. Instead Arrow will extrapolate
the fluid properties assuming that the fluid would remain in the gas phase, and will warn the user that the
saturation line was exceeded as is seen here.
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Figure 4: Output for Control Valve Example

Step 7. Size Piping Insulation
It is necessary to evaluate a new pipe size and to address the condensation warnings. Let's first address
the condensation warnings, the pipe size will be addressed in the next step. We will assume that the
necessary insulation thickness will not vary largely with pipe size because the expected change in pipe
size should be relatively small in the next step.
One way to keep the fluid temperature above saturation and prevent condensation, would be to add insulation to the pipe. Assume there are three sizes of insulation available, 1.0 cm, 1.5 cm, and 2.0 cm thick,
each of which has a thermal conductivity of 0.2 W/m-K. Assuming the same insulation for both pipes,
which insulation size would be necessary to prevent condensation in the line?
Because this 2-1/2 inch model is valuable to refer to, keep this scenario by returning to the Workspace
and then creating a new scenario on the Scenario Manager as a Child scenario by right-clicking on the
Base Scenario and selecting Create Child. Name the child scenario With Insulation. Insulation is added
on the Pipe Properties window's Heat Transfer tab. AFT Arrow allows you to specify up to three layers of
insulation. The insulation can be specified as internal insulation, external insulation, or a combination of
the two. Add the insulation to the pipe by changing the Number of Insulation Layers to 1 External, and
then add the insulation thermal data to the table (see Figure 5). For Conductivity, enter 0.2 W/m-K and for
thickness, enter 1.5 cm as an initial guess. Make these changes to both pipes.
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Figure 5: Insulation data is added on the Heat Transfer tab of the Pipe Properties window

Step 8. Change Pipe Size
Create a child scenario of the With Insulation scenario and name it 3 inch Pipe. From this scenario, select
a new pipe size in the Pipe Properties window for both pipes. By trial and error, you can determine that by
using 3-inch pipe, the minimum 1.5 bar (150 kPa) pressure drop requirement can be satisfied (see Valve
Summary tab in Figure 6). Do the results change if the valve is not in the middle of the pipe?

Figure 6: Output results for 3 inch Nominal Pipe Size modified Control Valve Example

Conclusion
To meet the system requirements, 3-inch pipe should be used. If the valve were not in the middle of the
pipe, the results would change because there is less pressure drop available as the valve is moved
towards the pipe inlet. To prevent condensation in the line, the 1.5 cm thick insulation would have to be
used.
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Summary
This example will walk you through an example to size a heat exchanger to deliver natural gas at a minimum required temperature.

Topics Covered
l

Sizing a Heat Exchanger

l

Entering a loss curve for a Heat Exchanger

l

Specifying heat transfer data for pipes

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model File
This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Natural Gas Burner.aro

Problem Statement
An underground storage reservoir containing natural gas made up mostly of methane supplies gas to five
burners. The gas is at 34.5 barG (3459 kPa (g)), and 10 deg. C. The gas is supplied to each of the burners at 6.9 barG (690 kPa (g)). To ensure that the flow rate to each of the burners is equal, each burner
has a control valve that controls the flow to 2.25 kg/sec. The pipes in the system are uninsulated STD
(schedule 40) steel, with standard roughness. The ambient temperature surrounding the pipes is 24 deg.
C, and the pipes have an ambient air velocity of 25 km/hr.
In order to operate at the best efficiency, the gas should be delivered to the burners at a minimum stagnation temperature of 38 deg. C. In order to achieve this, the gas flows through a heat exchanger, which
has a 0.7 bar (70 kPa) pressure drop at 11 kg/sec.
How much heat must be added to the heat exchanger to ensure that all of the burners will receive gas at
the specified minimum temperature? (Neglect elevation changes)
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Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Step 2. Define the Fluid Properties Group
1.

Open Analysis Setup from the toolbar or from the Analysis menu

2.

Open the Fluid panel then define the fluid:
a.

Fluid Library = AFT Standard

b.

Fluid = Methane
i.

After selecting, click Add to Model

c.

Equation of State = Redlich-Kwong

d.

Enthalpy Model = Generalized

e.

Specific Heat Ratio Source = Library

Step 3. Define the Pipes and Junctions Group
At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as
shown in the figure below.
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Figure 1: Model layout for Natural Gas Burner example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and
junction and enter the following properties.

Pipe Properties
1.

Pipe Model tab
a.

Pipe Material = Steel - ANSI

b.

Pipe Geometry = Cylindrical Pipe

c.

Size = Use table below

d.

Type = STD (schedule 40)

e.

Friction Model Data Set = Standard

f.

Lengths = Use table below
Pipe

Size

Length (meters)

1

4 inch

30

2-6

4 inch

6

7-16

3 inch

1.5
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2.

Heat Transfer tab
a.

Heat Transfer Model = Convective Heat Transfer

b.

Temperature = 24 deg. C

c.

Fluid Velocity = 25 km/hr

d.

Fluid = Air

Figure 2: Pipe Heat Transfer Data window

Junction Properties
1.

2.

3.

All Control Valves
a.

Elevation = 0 meters

b.

Valve Type = Flow Control (FCV)

c.

Control Setpoint = Mass Flow Rate

d.

Flow Set Point = 2.25 kg/sec

J1 Tank
a.

Elevation = 0 meters

b.

Fluid = Methane

c.

Pressure = 34.5 barG (3450 kPa(g))

d.

Temperature = 10 deg. C

J13-J17 Tanks
a.

Elevation = 0 meters

b.

Fluid = Methane
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4.

c.

Pressure = 6.9 barG (690 kPa(g))

d.

Temperature = 260 deg. C

J3-J7 Branches
a.

5.

Elevation = 0 meters

J2 Heat Exchanger
a.

Elevation = 0 meters

b.

Loss Model = Resistance Curve

c.

Enter Curve Data =
Mass

Pressure

kg/sec

bar

0

0

11

0.7

22

2.8

d.

Curve Fit Order = 2

e.

Click Generate Curve Fit Now

To solve this problem, you will have to guess how much heat to add to the heat exchanger, examine the
results, and adjust the heat added until you achieve the desired minimum temperature at the burners. To
do this, select the Heat Transfer tab on the Heat Exchanger Properties window, and for the Thermal
Model, select Specified Heat Rate In Constant. Next, enter a value for Heat Flow Into System. For the
first guess, use 500 kW.
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Figure 3: Heat Exchanger Loss Curve Fit

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter
the missing data.

Step 4. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 5. Examine the Output
Examination of the stagnation temperature at the outlets of the pipes discharging to the burners shows
that the lowest temperature is 16.9 deg. C (see Figure 4). This is well below the required minimum temperature of 38 deg. C. The heat added to the system fluid from the heat exchanger must be increased,
and the model ran again to determine the outlet temperature at the value.
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Figure 4: Output window showing results for Natural Gas Burner Example, based on HX Heat Rate of 500 kW

By trial and error, the correct amount of heat that needs to be added to the system fluid from the heat
exchanger to achieve a minimum stagnation temperature of 38 deg. C at each burner is about 1051.6
kW.

Conclusion
Using AFT Arrow, you were able to determine the amount of heat required by the heat exchange to supply natural gas to the burners at the minimum required temperature.
The goal seeking capabilities in the AFT Arrow GSC Module would allow this problem to be solved directly without manual iteration. The variable would be specified as the heat exchanger heat rate, and the
goal would be the minimum discharge pipe exit temperature.
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Summary
This example will demonstrate how to determine the range of outlet temperatures for a system given the
range values for the system parameters.

Topics Covered
l

Modeling Compressors with curve data

l

Entering heat transfer data for pipes

l

Using Scenarios

l

Using the Copy Data From Jct... editing feature

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model File
This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Compressed Air System.aro

Problem Statement
In this example, four machine tools are supplied air for operations. The machine tools are sensitive to
temperature; therefore, the manufacturer needs to know the delivery temperature extremes the tools will
see.
The air is taken from atmospheric conditions outside the building. Atmospheric pressure will remain constant at 0 barG (0 kPa (g)), and the air temperature outside can vary from -18 to 45 deg. C. The temperature inside the building ranges from 21 to 24 deg. C.
The compressor used to drive the system has the following pressure characteristics:
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l

0.83 bar (83 kPa) at 0 kg/sec

l

0.69 bar (69 kPa) at 0.25 kg/sec

l

0.41 bar (41 kPa) at 0.5 kg/sec

The compressor efficiency is not known for certain, but it is expected to be between 80% and 90%.
The nozzles at the tools have a pressure drop of 0.55 bar (55 kPa) at 0.1 kg/sec. The nozzles discharge
to atmospheric pressure.
The pipes in the system are uninsulated steel with an ambient air velocity that varies from 1.5 to 25
km/hr. The pipe at the compressor inlet is heavily insulated (adiabatic). All of the components in the system are at an elevation of 0 meters.
What are the temperature extremes at the tools that this system could have?

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Step 2. Define the Fluid Properties Group
1.

Open Analysis Setup from the toolbar or from the Analysis menu

2.

Open the Fluid panel then define the fluid:
a.

Fluid Library = AFT Standard

b.

Fluid = Air
i.

After selecting, click Add to Model

c.

Equation of State = Redlich-Kwong

d.

Enthalpy Model = Generalized

e.

Specific Heat Ratio Source = Library

Step 3. Define the Pipes and Junctions Group
At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as
shown in the figure below.
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Figure 1: Model Layout for Compressed Air System Model

For this problem, you are required to determine the temperature extremes at the tools based on the
range of system specifications. To do this, you will use the Scenario Manager to examine the hot and
cold extremes for the system.
The Scenario Manager is a powerful tool for managing variations of a model, referred to as scenarios.
The Scenario Manager allows you to:
l

Create, name, and organize scenarios

l

Select the scenario to appear in the Workspace (the ‘current’ scenario)

l

Delete, clone, and rename scenarios

l

Duplicate scenarios and save them as separate models

l

Review the source of a scenario’s specifications

l

Pass changes from a parent scenario to its child scenarios

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and
junction and enter the following properties. The Base Scenario will contain all of the basic model data for
the system.

Pipe Properties
1.

Pipe Model tab
a.

Pipe Material = Steel - ANSI

b.

Pipe Geometry = Cylindrical Pipe

c.

Size = Use table below

d.

Type = STD (schedule 40)
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e.

Friction Model Data Set = Standard

f.

Lengths = Use table below
Pipe

Size

Length (meters)

1

2 inch

0.3

2-5

2 inch

8

6-9

1 inch

3

Junction Properties
1.

2.

J1 Tank
a.

Elevation = 0 meters

b.

Fluid = Air

c.

Pressure = 0 barG (0 kPa(g))

d.

Temperature = 45 deg. C

J2 Compressor/Fan
a.

Elevation = 0 meters

b.

Model Type = Centrifugal Compressor

c.

Compressor Model = Compressor Curve

d.

Added Pressure = Stagnation

e.

Compression Process Thermodynamics = Determine From Efficiency Data

f.

Enter Curve Data =
Mass

Pressure

Efficiency

kg/sec

kPa

Percent

0

83

80

0.25

69

80

0.5

41

80

g.

Curve Fit Order = 2

h.

Click Generate Curve Fit Now
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Figure 2: Compressor/Fan Configuration window

3.

J3-J6 Branches

4.

J7 Valve

a.

Elevation = 0 meters

a.

Elevation = 0 meters

b.

Valve Data Source = User Specified

c.

Subsonic Loss Model = Resistance Curve

d.

Exit Valve (optional) = Checked

e.

Exit Pressure = 0 barG (0 kPa(g))

f.

Exit Temperature = 21 deg. C

g.

Enter Curve Data =
Mass

Pressure

kg/sec

bar

0.1

0.55
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h.

5.

Click Fill As Quadratic

i.

Curve Fit Order = 2

j.

Click Generate Curve Fit Now

J8-J10 Valves
a.

Open the Valve Property window, and in the Copy Data From Jct drop-down list at the top,
select J7. This will open the Copy Data From Junction window. Click All at the top. This will
cause all of the properties to be set to the same as the properties for J7 (see Figure
3). Click OK. J8 now has all of the same properties as J7.

b.

Repeat this process for J9 and J10.

Figure 3: Copy Data From Junction 7 window for J8

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter
the missing data.

Step 4. Create the Scenarios
Now you will use the Scenario Manager on the Quick Access Panel to create our temperature extreme
scenarios. Note that you can also use the Scenario Manager from the Tools menu if you prefer.
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From the Quick Access Panel, either right click on the Base Scenario and select Create Child, or select
the Create Child icon
. Enter the name Hot Case in the Create Child Scenario window, as shown in
Figure 4. Then click OK.

Figure 4: New scenario named Hot Case in the Create Child Scenario window

Select the Base Scenario in the Quick Access Panel, and then create another child. Enter the name Cold
Case in the Create Child Scenario window and click OK. The Scenario Manager on the Quick Access
Panel should now show two child scenarios below the Base Scenario, as shown in Figure 5.

Figure 5: Scenario Manager with two child scenarios

Step 5. Modify the Hot Case Scenario
Double-click on the Hot Case scenario in the Quick Access Panel to load the Hot Case scenario. Alternatively, you can select the Hot Case scenario from the Quick Access Panel and then click on the Load
Scenario icon

to load the scenario.

In order to simulate the Hot Case such that the tools would experience the highest temperatures, you
must assume the highest inlet and ambient temperatures as well as the worst heat transfer properties of
the piping and lowest compressor efficiency. Make these changes to the following pipes:
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1.

P2-P9 Pipes
a.

The heat transfer properties of the uninsulated pipes should be set to the values as shown
in Figure 6 (the wall thickness for the Pipe Wall will vary, depending on the diameter of the
pipe). Change the Heat Transfer Model to Convective Heat Transfer. Next, enter a Temperature of 24 deg. C and enter a Fluid Velocity of 1.5 km/hr. Doing so will minimize the
heat transfer occurring in the pipe, and result in the highest temperature at the tools. Use
the Global Pipe Edit tool to define the heat transfer information for all pipes at once.

Figure 6: Pipe Heat Transfer Data for Hot Case Scenario

Step 6. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 7. Examine the Output
The Output window contains all the data that was specified in the Output Control window. The output for
the Hot Case Scenario is shown in Figure 7. The valve output window shows the highest static temperature at the tools for the Hot Case is 93.53 deg. C at Tool 1 (T Static In).
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Figure 7: Output window showing the results for Hot Case Scenario

Step 8. Modify the Cold Case Scenario
Open the Scenario Manager again from the Tools menu (or use the Scenario Manager in the Quick
Access Panel). Select the Cold Case scenario in the Scenario Manager, and then click Load As Current
Scenario to open the Cold Case scenario.
In order to simulate the Cold Case such that the tools would experience the lowest temperatures, you
must assume the lowest inlet and ambient temperatures as well as the best heat transfer properties of
the piping and highest compressor efficiency. Make these changes to the following objects:
1.

J1 Tank
a.

2.

J2 Compressor
a.

3.

Temperature = -18 deg. C
The compressor will generate less heat if it is more efficient. Since this is the lower temperature case, you must assume the best feasible efficiency, which is 90%. This data is
entered in the Compressor/Fan Configuration window. Since you used 80% in the table
when you added the compressor information in the Base Scenario (Step 6), change the efficiency in the Raw Data table to 90%, and then click Generate Curve Fit Now to generate a
new compressor curve.

Pipes P2-P9
a.

Set the heat transfer properties of the uninsulated pipes after the compressor to the values
that will result in the lowest gas temperatures at the tools. The appropriate ambient temperature to use is the lowest of 21 deg. C. However, it is not clear which convection coefficient should be used. If the heat of compression at the compressor heats the gas to a
temperature higher than 21 deg. C, we should use the highest ambient air velocity of 25
km/hr. This will permit maximum cooling of the gas in the pipe. On the other hand, if the
compressor discharge temperature is less than 21 deg. C, then the lowest ambient air velocity of 1.5 km/hr should be used. This will yield the least heating of the gas in the pipes, giving the lowest possible temperature at the tools. Here we will use the value of 25 km/hr. As
just discussed, in practice one would need to verify the validity of this assumption.

Step 9. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
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converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 10. Examine the Output
The Output window contains all the data that was specified in the Output Control window. The output for
the Cold Case Scenario is shown in Figure 8. The valve output window shows the lowest static temperature at the tools for the Cool Case is 18.49 deg. C at Tool 4 (Tstatic In).
Note that the compressor discharge stagnation temperature is 26.07 deg. C, and thus the assumption of
25 km/hr for the ambient air velocity was appropriate.

Figure 8: Output window showing results for Cool Case Scenario

Step 11. Use the Isometric Grid
AFT Arrow allows the user to place pipe or junction objects anywhere in the Workspace. Objects are
placed on a 2D grid by default, as was the case with this example. At times it may be convenient to
demonstrate the three-dimensional nature of a system. For example, if you are building a model based
on isometric reference drawings. AFT Arrow includes an Isometric Pipe Drawing Mode for these cases.
The isometric grid has three gridlines that are offset by 60°, representing the x, y, and z axes. Figure 9
shows the compressed air system built on an isometric grid.
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Figure 9: Compressed air system with isometric grid shown

You can enable the isometric grid by going to the Arrange menu. Under Pipe Drawing Mode, there are
three options: 2D Freeform (default), 2D Orthogonal, and Isometric.
Creating the compressed air system on an isometric grid will demonstrate how to use this feature.
1.

Go to the File menu and select New.

2.

From the Arrange menu, Show Grid and choose Isometric under Pipe Drawing Mode.

3.

Place junctions J1-J7 on the Workspace in the positions shown in Figure 9.

4.

You will notice that placing junctions onto the Workspace follows the usual rules, however, the
visual appearance of the icons can be more complex than on a 2D grid. Due to the increased number of axes, the preferred icon and rotation can be selected to obtain visual consistency. Right
click on J7 and select Customize Icon. Click the Rotate button and select the icon shown in Figure
10.

- 758 -

Compressed Air System

Figure 10: Right click on the junction to open the Customize Icon window and select the preferred icon and
rotation

5.

Copy J7 for the tools, J8-J10, to maintain the preferred icon.

6.

Draw P1, as shown in Figure 11

7.

Draw P2 from J2 to J3. A red-dashed preview line will show how the pipe will be drawn on the isometric grid. As you are drawing a pipe, you can change the preview line by clicking any arrow key
on your keyboard or scrolling the scroll wheel on your mouse. Figure 11 shows Pipe 2 being
drawn with the preview line.

Figure 11: A preview line shows when drawing or adjusting pipes

Note: You can hold the ALT key while adjusting a pipe by the endpoint to add an additional segment.
This can be used with the arrow key or mouse scroll wheel to change between different preview
line options.
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8.

Draw pipes P3-P9, as shown in Figure 12.

9.

The grid can be shown or turned off in the Arrange menu.

Figure 12: Compressed air system with isometric grid not shown

Conclusion
By carefully selecting the input parameters from the specified system parameters, you were able to use
AFT Arrow to determine the temperature extremes of the gas being supplied to the tools in the compressed air system. This information can now be sent to the tool manufacturer, who will use it to compensate for the temperature sensitivity of the tools.

- 760 -

Process Steam System
Summary
The objective of this example is to determine the minimum delivery pressure of a process steam supply
system.

Topics Covered
l

Determining the minimum delivery pressure of a steam supply system.

l

Understanding Solution Control sensitivity

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model File
This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Process Steam System.aro

Problem Statement
A process steam supply system has two boilers at 20.7 barG (2070 kPa(g)) and 430 deg. C.
All of the pipes in the system have 5 cm of insulation with a thermal conductivity of 0.03 W/m-K, and an
ambient air velocity of 11 km/hr. The ambient temperature is 24 deg. C. The pipes are all Steel - ANSI
STD (schedule 40). All of the elbows in the system are Smooth, with an r/D of 1.5.
All of the tees in the system should be modeled using the Detailed loss model, with sharp edges.
The system has six users with the following peak flow demands:
1.

18,000 kg/hr

2.

23,000 kg/hr

3.

25,000 kg/hr

4.

25,000 kg/hr
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5.

18,000 kg/hr

6.

27,000 kg/hr

Determine the following:
l

What is the minimum delivery (stagnation) pressure of the system, and at which user?

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Step 2. Define the Fluid Properties Group
1.

Navigate to the Fluid panel in Analysis Setup

2.

Define the Fluid panel with the following inputs
a.

Fluid Library = AFT Standard

b.

Fluid = Steam
i.

After selecting, click Add to Model

c.

Equation of State = Redlich-Kwong

d.

Enthalpy Model = Generalized

e.

Specific Heat Ratio Source = Library

Step 3. Define the Pipes and Junctions Group
At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as
shown in the figure below.

- 762 -

Process Steam System

Figure 1: Model Layout for Process Steam System

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and
junction and enter the following properties.

Pipe Properties
1.

Pipe Model tab
a.

Pipe Material = Steel - ANSI

b.

Pipe Geometry = Cylindrical Pipe

c.

Size = Use table below

d.

Type = Use table below

e.

Friction Model Data Set = Standard

f.

Lengths = Use table below
Pipe

Size (inch)

Type

Length
(meters)

1

12

STD

30

2

12

STD

46
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2.

Pipe

Size (inch)

Type

Length
(meters)

10

12

STD

23

101

8

STD (schedule 40)

122

102-103

8

STD (schedule 40)

229

104

8

STD (schedule 40)

76

105

6

STD (schedule 40)

30

106

6

STD (schedule 40)

15

107

6

STD (schedule 40)

23

201

8

STD (schedule 40)

76

202-204

8

STD (schedule 40)

152

205 & 207

6

STD (schedule 40)

15

206

6

STD (schedule 40)

23

Heat Transfer tab
a.

Heat Transfer Model = Convective Heat Transfer

b.

Number of Insulation Layers = 1 External

c.

Temperature = 24 deg. C

d.

Fluid Velocity = 11 km/hr

e.

Insulation #1 Conductivity = 0.03 W/m-K

f.

Insulation #1 Thickness = 5 cm

Junction Properties
1.

J1 & J2 Tanks
a.

J1 Name = Boiler 1

b.

J2 Name = Boiler 2

c.

Elevation = 0 meters

d.

Pressure = 20.7 barG (2070 kPa(g))

e.

Temperature = 430 deg. C
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2.

3.

4.

All Bends
a.

Elevation = 0 meters

b.

Type = Smooth Bend (flanged or butt-welded)

c.

Angle = 90 Degrees

d.

r/D = 1.5

All Tee/Wye
a.

Elevation = 0 meters

b.

Loss Model = Detailed

c.

Type = Tee (Sharp, straight run)

d.

Initial Pressure = 7 BarG (on Optional tab)

All Assigned Flows
a.

Elevation = 0 meters

b.

Type = Outflow

3.

J106 Flow Rate = 18,000 kg/hr

4.

J107 Flow Rate = 23,000 kg/hr

5.

J108 Flow Rate = 25,000 kg/hr

6.

J206 Flow Rate = 25,000 kg/hr

7.

J207 Flow Rate = 18,000 kg/hr

8.

J208 Flow Rate = 27,000 kg/hr

Note: Sometimes adding initial guesses to pipes or junctions can help difficult solutions converge.
ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter
the missing data.

Step 4. Define the Steady Solution Control Group
There is an option available in Solution Control when using one of the marching methods that can sometimes result in an overall reduction in solution runtime. This option is to first solve the system using the
Lumped Adiabatic method and then use these results as a starting point for the marching solution. Since
the Lumped Adiabatic solution can typically be obtained much faster, this can provide an overall reduction in runtime for the marching method.
The Steady Solution Control Group is already defined using the default inputs. This means that no user
input is required to run the model. However, the Lumped Adiabatic initialization will be used for this
model.
To activate this option, do the following:
1.

Open Analysis Setup

2.

Navigate to the Solution Method panel in the Steady Solution Control group

3.

Click the box to turn on First Use Lumped Adiabatic Method To Obtain Initial Stating Point For
Marching Solution
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The Steady Solution Control Group is now defined for this model.

Step 5. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 6. Examine the Output
The pipes output section, shown in Figure 2, indicates the minimum delivery stagnation pressure is 9.689
bar (968.9 kPa) at J108.

Figure 2: Output window showing results for Process Steam System example

Step 7. Solution Control Sensitivity
Open Analysis Setup and navigate to the Solution Method panel again. Change the Solution Method to
User Specified with an Initial Number of Segments per Pipe as 10 (see Figure 3). Rerun the model, and
compare the results to the previous run.
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Figure 3: The Solution Method panel can be used to adjust the solution sensitivity

Repeat the run again with 20 segments, and 40 segments. What are the results?
l

With 2 segments, the minimum (stagnation) pressure is 9.689 bar (968.9 kPa) at J108.

l

With 10 segments, the minimum (stagnation) pressure is 9.811 bar (981.1 kPa) at J108.

l

With 20 segments, the minimum (stagnation) pressure is 9.815 bar (981.5 kPa) at J108.

l

With 40 segments, the minimum (stagnation) pressure is 9.816 bar (981.6 kPa) at J108.

This example points out the fact that some models are sensitive to the Solution Method used. While with
most systems changing the solution control will not affect the results, in systems such as this were there
are large pressure changes and high Mach numbers, the Solution Control settings can have a strong
affect on the results. This is something that ALL engineers should be aware of, and keep in mind when
creating computer model solutions.
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Summary
This example will demonstrate how to determine the relief capacity of a system, where sonic choking
occurs, and the pressure drop across a shock wave.

Topics Covered
l

Understanding sonic choking

l

Observing pressure drop across shock waves

l

Using fluid mixtures

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model File
This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Hydrocarbon Relief System.aro

Problem Statement
A mixture of 89% methane and 11% hydrogen (by mass) exists at a process facility. There is a plan to
increase the process conditions to 65 barG (6500 kPa(g)) at 40 deg. C. The relief system needs to be reevalutated to determine if it will still be adequate under these conditions. Assume that all of the pipes are
well insulated (i.e. adiabatic).
Determine the following:
l

What is the relief capacity of the system under the new conditions?

l

Where does sonic choking occur in the system, and why?

l

What is the pressure drop across the shock wave(s)?
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Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Step 2. Define the Fluid Properties Group
For this analysis, you will need to create and use a fluid mixture using the NIST REFPROP fluid library.
1.

Open Analysis Setup from the toolbar or from the Analysis menu

2.

Navigate to the Fluid panel

3.

In the Fluids Available in Library section, select NIST REFPROP

4.

Click Create New Mixture and Add to open the Create Mixture window

5.

Enter the name hydrogen/methane in the New Mixture Name field

6.

Select Hydrogen (normal) from the list of Fluids Available In Library

7.

Enter a Mass Fraction of 11% in the Mass Fraction field, then click Add Fluid to Mixture to add
hydrogen to the list components in the mixture

8.

Repeat this process for Methane, with a Mass Fraction of 89%

9.

The Create Mixture window should now appear as shown in Figure 1

10.

Click OK to add the mixture to the Fluids in Current Model on the Fluid panel, as shown in Figure 2

11.

Ensure that Library is selected as the Specific Heat Ratio Source
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Figure 1: The Create Mixture window is used to create mixtures of Refprop fluids

Figure 2: The Fluid panel in Analysis Setup
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Step 3. Define the Pipes and Junctions Group
At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as
shown in the figure below.

Figure 3: Model layout for Hydrocarbon Process Relief System example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and
junction and enter the following properties. Note the following:
l

The Total K Factor listed for the pipes should be entered as the Total K Factor on the Fittings &
Losses tab in the Pipe Properties window.

l

The CdA values given for the valves are required for Sonic Choking calculations.

Pipe Properties
1.

Pipe Model tab
a.

Pipe Material = Steel - ANSI

b.

Pipe Geometry = Cylindrical Pipe

c.

Size = Use table below

d.

Type = Use table below

e.

Friction Model Data Set = Standard

f.

Lengths = Use table below

g.

Total K Factor = Use table below
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Pipe

Size (inch)

Type

Length
(meters)

Total K
Factor

1

6

STD (schedule 40)

7

4.4

2

6

STD (schedule 40)

6

4.2

3

10

STD (schedule 40)

10

2.1

4

16

STD (schedule 30)

80

8.9

Junction Properties
1.

2.

3.

4.

5.

J1 Tank
a.

Name = Process

b.

Elevation = 4 meters

c.

Fluid = hydrogen/methane (mixture)

d.

Pressure = 65 barG (6500 kPa(g))

e.

Temperature = 40 deg. C

J2 Valve
a.

Name = Manual Valve

b.

Elevation = 2 meters

c.

Valve Data Source = User Specified

d.

Subsonic Loss Model = K Factor

e.

K = 10

f.

CdA (for Sonic Choking - optional) = 100 cm2

J3 Branch
a.

Name = Header Connection

b.

Elevation = 4 meters

J4 Valve
a.

Name = Relief Valve (assumed open)

b.

Elevation = 0 meters

c.

Valve Data Source = User Specified

d.

Subsonic Loss Model = K Factor

e.

K = 8.3

f.

CdA (for Sonic Choking - optional) = 300 cm2

J5 Assigned Pressure
a.

Name = Atmosphere

b.

Elevation = 7 meters

c.

Fluid = hydrogen/methane (mixture)
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d.

Pressure = 0 barG (0 kPa(g))

e.

Temperature = 40 deg. C

f.

Pressure Specification = Stagnation

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter
the missing data.

Step 4. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 5. Specify the Output Control
Open the Output Control window by selecting Output Control from the Toolbar or Tools menu.
Set the units for Mass Flow to kg/hr.

Step 6. Examine the Output
The output shows the capacity of the system is 176,038 kg/hr, as shown in Figure 4.
The Sonic Choking tab in the General section of the Output window shows that the system chokes at J3,
the Header Connection, and at J5, the discharge to atmosphere. The system chokes at J3 because of
the expansion from 6-inch (15.4 cm ID) pipe to 10-inch (25.4 cm ID) pipe. The system chokes at J5
because of endpoint choking.
The pressure drop across the choke point is the same as the change in stagnation pressure. This can be
seen in the Junction output section. The pressure drop across the choke point at J3 is 2.503 bar (250.3
kPa), and the pressure drop across the shock wave at J5 is 2.227 bar (222.7 kPa).
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Figure 4: Output window showing results for Hydrocarbon Process Relief System example
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Summary
This example will demonstrate how to evaluate an emergency relief system for relief capacity, and mass
and mole fraction of a discharge mixture for an environmental impact assessment.

Topics Covered
l

Evaluating Relief Valves

l

Using Scenarios

l

Using Global Junction Edit Feature

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model File
This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Refinery Relief System.aro

Problem Statement
A new emergency relief system at an oil refinery is being considered, and the process calculations need
to be evaluated.
The system provides relief to processes for methane, propane, and ethane. Each process is at 13 barG
(1300 kPa(g)) when the relief event occurs.
The relief valve CdA is 100 cm2. Assume K=0 since this system will choke. The elbow is a standard
elbow, and the tees should all be modeled as simple tees. All of the pipes are STD (schedule 40) Steel ANSI pipe, with standard roughness, and the flow can be assumed to be adiabatic.
The process engineer has evaluated the relief capacity at the minimum process temperature of 150 deg.
C. Depending on the properties of the crude oil, all three processes can operate at up to 315 deg. C. The
process engineer did not look at this case due to time constraints, but he thinks the higher temperatures
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will not affect the relief capacity. The process engineer also neglected any elevation changes to simplify
the calculations, even though the relief point is 35 meters above the discharge header.
Determine the following:
l

The relief capacity (i.e. flow rate) of each process.

l

The mass and mole fraction of the discharge mixture for the environmental impact assessment.

l

Determine if neglecting the high temperature case and the elevation effects are acceptable.

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Step 2. Define the Steady Solution Control Group
There is an option available in Solution Control when using one of the marching methods that can sometimes result in an overall reduction in solution runtime. This option is to first solve the system using the
Lumped Adiabatic method and then use these results as a starting point for the marching solution. Since
the Lumped Adiabatic solution can typically be obtained much faster, this can provide an overall reduction in runtime for the marching method.
The Steady Solution Control Group is already defined using the default inputs. This means that no user
input is required to run the model. However, the Lumped Adiabatic initialization will be used for this
model.
To activate this option, do the following:
1.

Open Analysis Setup

2.

Navigate to the Solution Method panel in the Steady Solution Control group

3.

Click the box to turn on First Use Lumped Adiabatic Method To Obtain Initial Stating Point For
Marching Solution

The Steady Solution Control Group is now defined for this model.

Step 3. Define the Fluid Properties Group
1.

Open Analysis Setup from the toolbar or from the Analysis menu

2.

Open the Fluid panel then define the fluid:
a.

Fluid Library = NIST REFPROP

b.

Fluid = Methane

c.

Repeat this to add Ethane and Propane

d.

Specific Heat Ratio Source = Library

i.

After selecting, click Add to Model
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Step 4. Define the Pipes and Junctions Group
At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as
shown in the figure below.

Figure 1: Model layout for Refinery Relief System example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and
junction and enter the following properties.

Pipe Properties
1.

Pipe Model tab
a.

Pipe Material = Steel - ANSI

b.

Pipe Geometry = Cylindrical Pipe

c.

Size = Use table below

d.

Type = STD (schedule 40)

e.

Friction Model Data Set = Standard

f.

Lengths = Use table below
Pipe

Size (inch)

Length (meters)

1-3

3

15
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Pipe

Size (inch)

Length (meters)

4

3

10

5

4

10

6

6

45

Junction Properties
1.

All Tanks
a.

J1 Name = Methane Tank

b.

J2 Name = Ethane Tank

c.

J3 Name = Propane Tank

d.

Elevation = 0 meters

e.

J1 Fluid = Methane

f.

J2 Fluid = Ethane

g.

J3 Fluid = Propane

h.

Pressure = 13 barG (1300 kPa(g))

i.
2.

3.

4.

Temperature = 150 deg. C

J4 Bend
a.

Elevation = 0 meters

b.

Type = Standard Elbow (knee, threaded)

c.

Angle = 90 Degrees

All Tees
a.

Elevation = 0 meters

b.

Loss Model = Simple

J7 Valve
a.

Name = Relief Valve

b.

Elevation = 0 meters

c.

Valve Data Source = User Specified

d.

Subsonic Loss Model = K Factor

e.

K=0

f.

CdA (for Sonic Choking - optional) = 100 cm2

g.

Exit Valve (optional) = Checked

h.

Exit Pressure = 0 barG (0 kPa(g))

i.

Exit Temperature = 21 deg. C

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter
the missing data.
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Step 5. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 6. Specify the Output Control
Open the Output Control window by selecting Output Control from the Toolbar or Tools menu.
With the Pipes button selected at the top, add Concentration Mass Fraction and Concentration Mole Fraction to the pipe output list by highlighting these parameters (holding CTRL will allow you to select both at
the same time) and then clicking the purple Add arrow.

Step 7. Examine the Output
The Composition tab in the pipes output section displays the component mass flow rate through each of
the pipes, as shown in Figure 2).
The output for this model shows:
l

The total relief capacity is 16.236 kg/sec
l

2.930 kg/sec for methane

l

5.382 kg/sec for ethane

l

7.924 kg/sec for propane

l

The mass fraction at discharge (observed from clicking on the Composition tab): 18.05% methane, 33.15% ethane, and 48.81% propane

l

The mole fraction at discharge from the Composition tab: 33.74% methane, 33.06% ethane, and
33.20% propane

Figure 2: Output window showing results for Refinery Relief System example
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Step 8. Create a Child Scenario
In order to determine if the process engineer has made good assumptions by neglecting the higher temperature process and the elevation data, it will be necessary to change the model. This can be done easily using the Scenario Manager on the Quick Access Panel. Note that the Scenario Manager can also be
accessed from the Tools menu.
The Scenario Manager is a powerful tool for managing variations of a model, referred to as scenarios.
The Scenario Manager allows you to:
l

Create, name and organize scenarios

l

Select the scenario to appear in the Workspace (the ‘current’ scenario)

l

Delete, copy and rename scenarios

l

Duplicate scenarios and save them as separate models

l

Review the source of a scenario’s specifications

l

Pass changes from a scenario to its variants

The Scenario Manager should currently appear as shown in Figure 3.

Figure 3: The Scenario Manager window on the Quick Access Panel is used to create and manage model
scenarios

Create a child scenario by either right-clicking on the Base Scenario and then selecting Create Child.
Enter the name High Inlet Temp in the Create Child Scenario window, as shown if Figure 4. Click OK.
The new High Inlet Temp scenario should now appear in the Scenario Manager on the Quick Access
Panel below the Base Scenario as shown in Figure 5.
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Figure 4: Create Child Scenario window

Figure 5: Scenario Manager on the Quick Access Panel with New Child Scenario

Step 9. Modify the Higher Inlet Temp Scenario with Global Junction Editing
Double-click on the High Inlet Temp scenario in the Scenario Manager on the Quick Access Panel to
make it the active scenario if it is not already.
To check the process engineer's assumption about the 315 deg. C process, the inlet temperature for all
of the process tanks must be changed from 150 to 315 deg. C. These changes could be made by opening the Tank Properties window for each of the tanks and changing the inlet temperatures one at a time.
AFT Arrow has a feature that can be used to change the temperature for all of the tanks at the same time.
This feature is called Global Junction Editing.
Open the Global Junction Edit window by selecting Global Junction Edit | Tanks from the Edit
menu. Select all of the tanks in the Junction List by clicking All at the top (see Figure 6).
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Figure 6: Global Junction Edit window

Click the Select Tank Data button. This will open a Tank Properties window. Enter a temperature of 315
deg. C and click OK to close the Tank Properties window. The Global Junction Edit window now contains
a list of all the parameters that can be changed in the selected junctions. The data in the list is grouped
together by the tab on the Properties window on which the data is entered. Any items that are selected in
this list will be applied to all of the junctions selected in the Junction list. Check the box next to Temperature in the list, which now shows a value of 315 deg. C (see Figure 7). Since this is the only item in
the parameter list that is selected, it is the only parameter that will be changed in the selected tank junctions. Click Apply Selections at the bottom then click OK to close the Global Junction Edit window. The
temperatures for all three of the tanks have now been updated to 315 deg. C. Open the Properties window for one of the tanks to verify that the change was made.
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Figure 7: Global Junction Edit window with Temperature Parameter Selected

Step 10. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 11. Examine the Output
See Figure 8 for the output from this scenario. The output for this model shows:
At 315 deg. C, the relief capacity is reduced to 13.519 kg/sec, a 17% reduction, which is significant. The
original assumption and calculation by the process engineer based on this assumption was not conservative, as he assumed.
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Figure 8: Output window showing the results for High Inlet Temp Scenario

Step 12. Create and Run a Child Scenario for Elevation Effects
Create a child scenario to the High Inlet Temp scenario to examine the affect including the elevation
information has on the model.
Change the elevation data for the J7 Valve to 35 meters. Rerun the model, and examine the results.
Adding the 35-meter elevation to the relief valve has a negligible effect on the system solution.
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Summary
The objective of this example is to size a blower for an air distribution system, and evaluate the effect of
different blower efficiencies on the blower size.

Topics Covered
l

Sizing a Blower

l

Changing Compressor Efficiencies

l

Using Design Factors

l

Using Scenario Manager

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model File
This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Air Blower Sizing.aro

Problem Statement
An air distribution system requires a new blower. All of the pipes in the system are STD (schedule 40)
steel, with adiabatic flow. You are to use a design factor of 1.1 on all of the pipe and junction friction
losses. You can neglect elevation changes, and any losses at the branches. All of the pipes leading to
the discharge rooms discharge at atmospheric pressure.
Use Redlich-Kwong for the equation of state model, and Generalized for the enthalpy model.
For the blower, there are three compression process cases to be examined:
l

Adiabatic

l

Efficiency = 80 Percent (set as Nominal Efficiency)
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l

Efficiency = 60 Percent

For these three cases, determine:
l

The size of the blower for both flow and pressure rise to deliver a minimum of 430 sm3/h to each
room.

l

How the different compression process models for the blower affect the blower sizing and the discharge temperatures.

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Step 2. Define the Fluid Properties Group
1.

Open Analysis Setup from the toolbar or from the Analysis menu

2.

Open the Fluid panel then define the fluid:
a.

Fluid Library = AFT Standard

b.

Fluid = Air
i.

After selecting, click Add to Model

c.

Equation of State = Redlich-Kwong

d.

Enthalpy Model = Generalized

e.

Specific Heat Ratio Source = Library

Step 3. Define the Pipes and Junctions Group
At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as
shown in the figure below.
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Figure 1: Model layout for Air Blower Sizing example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and
junction and enter the following properties.

Pipe Properties
1.

Pipe Model tab
a.

Pipe Material = Steel - ANSI

b.

Pipe Geometry = Cylindrical Pipe

c.

Size = Use table below

d.

Type = STD (schedule 40)

e.

Friction Model Data Set = Standard

f.

Lengths = Use table below
Pipe

Size (inch)

Length
(meters)

1

6

12

2

6

30

3-5, 7-8

4

75

6

4

150

9-13

2

30
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2.

Optional tab
a.

Pipe Friction = 1.1

Junction Properties
For this example, we need to determine the correct flow through the compressor. Now we need to use
our engineering judgment to take an initial guess at the flow rate through the compressor. Assume 2150
sm3/h to start:
1.

2.

3.

J1 Tank
a.

Elevation = 0 meters

b.

Fluid = Air

c.

Pressure = 0 barG (0 kPa(g))

d.

Temperature = 21 deg. C

J2 Compressor/Fan
a.

Elevation = 0 meters

b.

Compressor Type = Centrifugal Compressor

c.

Compressor Model = Sizing

d.

Compression Process Thermodynamics = Adiabatic

e.

Compressor Sizing Parameter = Mass Flow Rate

f.

Fixed Flow Rate = 2150 sm3/h

All Assigned Pressures
a.

Elevation = 0 meters

b.

Pressure Model tab

c.

d.

i.

Fluid = Air

ii.

Pressure = 0 barG (0 kPa(g))

iii.

Temperature = 21 deg. C

iv.

Pressure Specification = Stagnation

Loss Coefficient tab
i.

K - Flow into pipe = 1

ii.

K - Flow out of pipe = 1

Optional tab
i.

4.

Junction Friction Loss = 1.1

All Branches
a.

Elevation = 0 meters

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter
the missing data.
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Step 4. Specify the Output Control
Open the Output Control window by selecting Output Control from the Toolbar or Tools menu.
Select the units sm3/h for the Mass Flow Rate parameter for both Pipes and Junctions output.

Step 5. Create Child Scenarios
Using the Scenario manager, create one child scenario named 2150 sm3h then three child scenarios to
that scenario for the air blower evaluation. Name the first Adiabatic, name the second 80% Efficient, and
name the third 60% Efficient. For the compressor in each scenario, open the Compressor/Fan Properties
window, and set the following:
1.

For the Adiabatic case, no changes are necessary. The Compression Process Thermodynamics
for the Compressor is already set to Adiabatic and no Nominal Efficiency is entered.

2.

For the 80% Efficient case, set the Nominal Efficiency to 80 Percent, and set the Compression Process Thermodynamics to Determine From Efficiency Data.

3.

For the 60% Efficient case, set the Nominal Efficiency to 60 Percent, and set the Compression Process Thermodynamics to Determine From Efficiency Data.

Step 6. Run the Models
Load the Adiabatic scenario and click Run Model on the toolbar or from the Analysis menu. This will open
the Solution Progress window. This window allows you to watch as the AFT Arrow solver converges on
the answer. This model runs very quickly. Now view the results by clicking the Output button at the bottom of the Solution Progress window.
Repeat this process for each of the three child scenarios.

Step 7. Examine the Output
The Output window contains all the data that was specified in the Output Control window.
Based upon the initial flow rate guess for the blower of 2150 sm3/h, not all rooms are receiving a minimum flow rate of 430 sm3/h. Therefore, the flow rate at the blower must be increased until each room
receives a minimum flow rate of 430 sm3/h.
Determining the required blower flow rate can be easily accomplished through manual iteration on the
blower flow rate. In order to automate this process of iteration, the AFT Arrow Goal Seek and Control
(GSC) add-on module can assist with this greatly.
Right-click the 1250 scfm scenario and select Clone with Children. Iterate the blower mass flow rate until
the 430 sm3/h is achieved.
The output for each of the scenarios is shown in Figure 2, Figure 3, and Figure 4. This output is based
upon the final required blower flow rate that will deliver a minimum flow rate of 430 sm3/h to each room.
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The results are as follows:
Total Flow

Stagnation
Pressure
Rise

Max Static
Discharge
Temp

sm3/h

bar (kPa)

deg. C

Adiabatic

2300

0.55748
(55.748)

58.43

80% Efficient

2300

0.57339
(57.339)

69.32

60% Efficient

2300

0.60128
(60.128)

88.60

Scenario

Figure 2: Output window showing the results for Adiabatic scenario
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Figure 3: Output window showing the results for 80% Efficient scenario

Figure 4: Output window showing the results for 60% Efficient scenario

Step 8. Evaluate 60% Efficiency with Heat Transfer
The engineers on the project have realized that the pipes are not insulated, and that the adiabatic
assumption may be overly conservative. One engineer has also expressed concern that the discharge
air could be too hot.
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Create a child scenario to the 2300 sm3/h 60% efficient case named With Heat Transfer. Add heat transfer to the model on all the pipes by selecting Convective Heat Transfer as the Heat Transfer Model. For
the Ambient Conditions, enter a Temperature of 26 deg. C, a Fluid Velocity of 11 km/hr, and Air as the
Fluid. See Figure 5 for this input.

Figure 5: Pipe heat transfer window

Run the new scenario and determine the following:
l

Do the compressor size requirements change significantly?

l

How much do the discharge temperatures decrease?

Step 9. Examine the Output for 60% Efficiency with Heat Transfer
The output for this scenario is shown in Figure 6.
The blower stagnation pressure rise decreases from 0.60128 to 0.52391 bar, which is a 13% reduction.
The max discharge temperature decreases to 31.45 deg. C.
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Figure 6: Output window showing the results for 60% Efficiency Scenario with Heat Transfer in Pipes
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Summary
This example demonstrates how to use the cost calculation features in AFT Arrow. All cost calculation
features are included with Arrow.

Topics Covered
l

Estimating simple costs

l

Connecting cost libraries

l

Using Cost Settings

l

Using the Cost Report

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Compressed Air System.aro

l

Metric - Compressed Air System Costs.aro

l

Compressed Air System.dat - engineering library

l

Compressed Air System Costs.cst - cost library for Compressed Air System.dat

l

Steel - ANSI Pipe Costs.cst - cost library for Steel - ANSI

Problem Statement
Use the cost calculation features in AFT Arrow to determine the cost of the compressed air system over a
10-year period for both the hot and cold cases. Include material, installation, and energy costs.
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Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
Important: The GSC module and cost calculations can be used in the same run, but we are not going
to do this here. Before proceeding, make sure to disable GSC by selecting the radio button for
Ignore in the Modules panel in Analysis Setup.

Step 2. Define the Pipes and Junctions Group
Open the Metric - Compressed Air System.aro example file listed above, which is located in the
Examples folder in the AFT Arrow application folder. Save the file to a different folder.
Once the model is opened and saved to a new location, load the Base Scenario. The workspace should
look like Figure 1

Figure 1: Model Layout for Compressed Air System - Cost Example

Step 3. Define the Steady Solution Control Group
There is an option available in Solution Control when using one of the marching methods that can sometimes result in an overall reduction in solution runtime. This option is to first solve the system using the
Lumped Adiabatic method and then use these results as a starting point for the marching solution. Since
the Lumped Adiabatic solution can typically be obtained much faster, this can provide an overall reduction in runtime for the marching method.
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The Steady Solution Control Group is already defined using the default inputs. This means that no user
input is required to run the model. However, the Lumped Adiabatic initialization will be used for this
model.
To activate this option, do the following:
1.

Open Analysis Setup

2.

Navigate to the Solution Method panel in the Steady Solution Control group

3.

Click the box to turn on First Use Lumped Adiabatic Method To Obtain Initial Stating Point For
Marching Solution

The Steady Solution Control Group is now defined for this model.

Step 4. Define the Cost Settings Group
To use the cost calculation feature, navigate to the Cost Settings panel in Analysis Setup.
The Cost Settings panel is where the types of costs to be included in the cost calculations are specified.
The Cost Settings panel is shown in Figure 2.
Energy cost data can be specified through an energy cost library, or by directly entering an energy cost in
the Cost Settings window. Using an energy cost library allows you to specify multiple energy costs, such
as energy costs at both peak and off-peak rates.
For this example, in the Cost Calculation section at the top, select Calculate. Next, in the Energy Cost
section, enter an energy cost of 0.06 U.S. Dollars Per kW-hr, as shown in Figure 2.
The Cost Definitions section allows you to specify the type of costs to be determined. You may select
from actual monetary costs, including Material, Installation, Maintenance, and Operation/Energy costs.
For this example, include Material, Installation, and Operation/Energy costs by selecting them from the
list of available Monetary Costs, as shown in Figure 2.
The system lifetime to be applied for the cost calculations is specified in the Cost Time Period section.
You can also specify interest and inflation rates to be applied to the cost calculations as well.
For this example, enter a System Life of 10 years, as shown in Figure 2, then close the Cost Settings window by clicking OK.
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Figure 2: The cost calculations are enabled on the Cost Settings window

Step 5. Engineering and Cost Libraries
The actual material and installation costs that the cost calculation feature uses are contained in cost libraries. The cost libraries needed for this example already exist, and just need to be accessed.
The Library Manager (opened from the Library menu) shows all of the available and connected libraries.
Libraries can either be engineering libraries or cost libraries. Cost libraries are always associated with an
engineering library, and are thus displayed subordinate to an engineering library in the library lists.
Here we will summarize some key aspects of libraries:
l

Cost information for a pipe system component is accessed from a cost library. Cost library items
are based on corresponding items in an engineering library. (The engineering libraries also
include engineering information such as pipe diameters, hydraulic loss factors, etc.)

l

To access a cost for a particular pipe or junction in a model, that pipe or junction must be based on
items in an engineering library. Moreover, that library must be connected.

l

There can be multiple cost libraries associated with and connected to an engineering library. This
makes it easier to manage costs of items.

Add the Engineering and Cost Libraries
Select Library Manager from the Library menu. Add the Compressed Air System.dat engineering library file to the list of available libraries by clicking Add Existing Library at the bottom. Browse to the engineering library file in the AFT Arrow 9 Examples folder. The engineering library should now appear in the
list of available libraries.
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Now add the cost libraries by clicking Add Existing Cost, and browsing to the Compressed Air System
Costs.cst and the Steel - ANSI Pipe Costs.cst cost library files.
All the added libraries should be connected automatically. If not connected, connect the newly added
engineering libraries by selecting them in the list of available libraries, and clicking the Add to Connections button.
The Library Manager should appear as shown in Figure 3.

Figure 3: The Library Manager window displays all of the available and connected libraries

The engineering libraries associated with these two cost libraries are the Steel - ANSI pipe materials library, and an external library called Compressed Air System. For the cost data in the two cost libraries to
be accessed by pipes and junctions in the model, the pipes and junctions must use these two engineering libraries.
The pipes for this example are already using data from the Steel - ANSI pipe material library, so no modifications need to be made for the pipes.
All of the junctions except the tank junction must be modified to use the component data contained in the
engineering library. Do this by opening the Properties window for each junction, and selecting the component name displayed in the Library Jct list, as shown in Figure 4 for the Compressor/Fan junction.
Note that there are two compressor junctions in the library. One uses an efficiency of 80% for the Hot
Case scenario, and the other uses an efficiency of 90% for the Cool Case scenario. For this case, select
the Metric 80% efficient compressor.
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Figure 4: The components to be included in the cost analysis must be associated with an engineering library

Step 6. Include Cost in Report
The final step before performing a cost analysis is to specify which pipes and junctions you want to be
included in the final cost report. This is done by choosing Include in Cost Report on the Cost tab in the
Properties window for each pipe and junction to be included, as shown for Pipe 1 in Figure 5.
The Global Edit feature may be used to update this information for all of the pipes and junctions.
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Figure 5: The Cost tabs on the pipe and junction Properties windows are used to include the objects in the
Cost Report

Once all the necessary Pipes and Junctions have been set to be included in the Cost Report, load the
Hot Case scenario.

Step 7. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 8. Examine the Output
The Cost Report is displayed in the General section of the Output window. View the Cost Report by
selecting the Cost Report tab. The content of the Cost Report can be controlled from the Output Control
window. Figure 6 shows the Cost Report for this example with the Material, Installation, Operation, and
Total costs displayed.
The Cost Report shows the total system cost, as well as the individual totals for the material, installation,
and energy costs. In addition, the Cost Report displays the detailed cost for each pipe, junction, and fitting that was included in the report. The items are grouped together by type, and a subtotal for each category is listed.
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Figure 6: The Cost Report in the General Output section shows the results of the cost analysis

Step 9. Set up and Run the Cold Case Scenario
Load the Cold Case scenario. Repeat Step 4 through Step 8 but using the Metric - 90% Compressed Air
System Compressor for J2 instead. The results from the Cold Case scenario are shown in Figure 7.
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Figure 7: The Cost Report for the Cold Case scenario

Cost Analysis Summary
The cost analysis for the Hot Case scenario shows that the total system cost over 10 years for the compressed air system is $102,856. Of that cost, $10,156 was for Material costs, $4,494 was for Installation
costs, and $88,207 was energy cost over the life of the system.
By contrast the cost analysis for the Cool Case scenario shows that the total system cost over 10 years
for the compressed air system is $80,283. Of that cost, $10,156 was for Material costs, $4,494 was for
Installation costs, and $65,633 was energy cost over the life of the system.
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Summary
This example demonstrates the fundamental concepts of the cost calculation features of AFT Arrow. The
example illustrates how the cost calculation features can be used to calculate costs for a given system
design.

Topics Covered
l

Creating cost libraries

l

Entering pipe, junction and fitting cost data into libraries

l

Connecting cost libraries

l

Using Cost Settings

l

Using the Cost Report

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition, it is assumed that the user has worked through the Beginner: Compressed Air System - Cost
example and is familiar with the basics of cost analysis.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Process Steam System.aro

l

Metric - Process Steam System Costs.aro

l

Process Steam System.dat - engineering library

l

Process Steam System Costs.cst - completed cost library for Process Steam System.dat

l

Metric - Process Steam System Pipe Costs.cst - completed cost library for Steel - ANSI

Problem Statement
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After designing a process steam plant, it is necessary to calculate the system cost to determine the feasibility of the design. Use the cost calculation features to determine the initial cost of the system. Include
material and installation costs for pipes and fittings.

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
Important: The GSC module and cost calculations can be used in the same run, but we are not going
to do this here. Before proceeding, make sure to disable GSC by selecting the radio button for
Ignore in the Modules panel in Analysis Setup.

Step 2. Define the Pipes and Junctions Group
Open the Metric - Process Steam System.aro example file listed above, which is located in the
Examples folder in the AFT Arrow application folder. Save the file to a different folder.
Once the model is opened and saved to a new location, load the Base Scenario. This is the only scenario
needed for this example, so right-click the Base Scenario and select Delete All Children. The workspace
should look like
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Figure 1: Model layout for Process Steam System Cost example

Step 3. Define the Cost Settings Group
Open Analysis Setup and go to the Cost Settings panel. Turn on Cost Calculation by selecting the Calculate option at the top.
This example does not have any components for which energy costs can be calculated, so operational/energy costs will not be included in the Cost Report. For this example, leave the energy cost
blank.
In the Cost Definitions section, select Material and Installation costs. Additionally, because we are only
accounting for material and installation costs, there is no need to enter a system life period for costing purposes.
The Cost Settings panel should now resemble Figure 2
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Figure 2: The cost calculations are enabled on the Cost Settings window

Step 4. Connect the Engineering Library
For detailed information on using the Library Manager, consult the AFT Arrow Help System.
Select Library Manager from the Library menu. Add the Process Steam System.dat engineering library
file to the list of available libraries by clicking Add Existing Library at the bottom. Browse to the engineering library file in the AFT Arrow Examples folder. The engineering library should now appear in the list
of available libraries.
Make sure the library is connected to the model - indicated by the check mark next to its name.
The Library Manager should appear as shown in Figure 3.
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Figure 3: The engineering library is connected using the Library Manager

Any pipes and junctions for which costs are to be generated must be associated with an engineering library.
The engineering libraries associated with the junctions in this example are the AFT INTERNAL
LIBRARY, and an external library called Process Steam System. The junctions in the model must be
associated with one of these two engineering libraries to be able to access the cost data in the cost libraries we will be creating.
The pipes for this example are already using data from the Steel - ANSI pipe material library, so no modifications need to be made for the pipes.
The Bend and Tee junctions must be modified to use the component data contained in the external engineering library. Do this by opening the Properties window for each junction, and selecting the component
name displayed in the Library Jct list. Make this change for all of the Bend and Tee junctions.

Step 5. Create the Cost Libraries
Refer to the AFT Arrow Help System for detailed information regarding creating and using cost libraries.
In order to calculate the material and installation cost for the pipes and fittings, these costs must be
included. This will be accomplished by creating two new cost libraries. The first library will be associated
with the engineering library that contains the pipe material data, and the second library will be associated
with the engineering library that contains the fitting data.

- 807 -

Process Steam System - Cost

Create a new cost library for the pipe costs
Create a new cost library for the pipe costs by opening the Cost Library window from the Library menu.
Create a new cost library by clicking on the New button. When you click on the New button, you are
prompted to choose the engineering library with which the cost library will be associated.
The piping material data used in the model comes from the default Steel - ANSI library, so the pipe cost
library will be connected to this library. Select Steel - ANSI from the library list shown in the Select Library
window, then click the Select button.
Note: Make this choice carefully, because once you have made the association you cannot change it.
Once the library is created, you must enter a meaningful description and select the cost units. Enter the
following data on the General tab:
1.

Cost Type = Monetary

2.

Monetary Unit = U.S. Dollars

3.

Description = Metric - Process Steam System Pipe Costs

4.

Notes = This library is for the Process Steam System Cost Example File

Save the cost library to a file by clicking the Save button. Name the library Metric - Process Steam System Pipe Costs.cst. When prompted, choose to add the new library to the list of available and connected libraries. The information on the General tab should appear as shown in Figure 4. The selected
library file information, cost type and monetary units, a description of the cost library, and any notes you
have added will be displayed.
Note: The library file pathnames may be different than those shown in Figure 4.
For this example, you will enter Pipe Material costs for the pipes.
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Figure 4: The Edit Cost Library window is used to enter cost data

Enter the pipe material costs
After the pipe cost library has been created, select the Pipe Materials tab in the Cost Library window. This
is where you will enter the material and installation costs for the piping.
The Pipe Materials tab shows all the pipes in the engineering library (Steel - ANSI pipe material library).
Costs can be entered at several levels. You can enter costs at the material level, the nominal size level,
and finally at the type (i.e., schedule) level. Costs entered at the material level apply to all nominal sizes
and types in that material type. Costs entered at the nominal size level apply to all schedules within that
nominal size. Costs entered at the type (schedule) level apply only to that type. For this example, all of
the pipe material costs will be entered at the type (schedule) level.
To enter a new cost, navigate to the material, nominal size and type combination for which you want to
enter a cost. Click the New Cost button to create a new cost item in the table below. The new cost item
will appear as a new column.
Each pipe size in this example has two non-recurring costs associated with it. The costs to be entered
are the material and installation costs. Figure 5 shows the costs entered for 8-inch STD (schedule 40)
Steel. Enter the non-recurring pipe costs for the pipe in this example, as shown below.
All pipes are STD (schedule 40) Steel - ANSI:

- 809 -

Process Steam System - Cost

Cost Type

Material (NR)

Installation
(NR)

Size (inches)

Cost (U.S.
Dollars)

Cost (U.S.
Dollars)

6

28.00

65.50

8

34.50

78.75

12

67.25

169.00

Cost Per

Length

Length

Cost Per
Units

meters

meters

Figure 5: Non-recurring pipe costs, such as material and installation costs, are entered on the Pipe Materials
tab

Create a new cost library for the piping components
To enter cost for a pump, or any other junction type, the junction must first be added to an engineering library. Cost data is then entered in a cost library associated with that engineering library. The piping components (bends and tees) used in this example have been added to an engineering library. Create a new
cost library associated with the Process Steam System.dat engineering library with the following general information:
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1.

Cost Type = Monetary

2.

Monetary Unit = U.S. Dollars

3.

Description = Process Steam System Costs

Save the cost library to a file by clicking the Save button. Name the library Process Steam System Costs.cst. When prompted, choose to add the new library to the list of available and connected libraries.

Create cost scale tables for the bends
The model contains several 90-degree bend junctions. The cost of these bend fittings can be included in
the cost calculation. The costs for these items will be accounted for in scale tables. Scale tables can be
used to vary a cost with a parameter such as diameter (i.e., size). Once created, this scale table can be
applied to the bend items.
The first table you will create is the scale table for the 90-degree bend installation costs. Select the
Tables tab, and click the New Table button.
Enter the following data for the scale table on the New Scale Table window:
1.

Name = Installation Table

2.

Table Type = Diameter

3.

Table Format = Cost

The window should appear as shown in Figure 6. After entering the data, click OK.

Figure 6: Scale tables are created using the New Scale Table window

After the table has been created, enter the cost data for the table. Do this by selecting the table name in
the Table list, then entering the cost values in the table provided. Enter the following installation cost data
into the scale table:
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Diameter (inches) Cost (U.S. Dollars)
4

85

6

125

8

185.5

12

298

18

446

You do not need to enter data in the scale tables for every diameter in the model. If a diameter falls
between two data points in the table, AFT Arrow will use the points on either side to linearly interpolate for
a value. If the cost function is non-linear, you may need to add additional data points to achieve a more
accurate cost value.
Create another scale table for the material costs using the following data:
Name = Material Table
Table Type = Diameter
Table Format = Cost
Diameter (inches) Cost (U.S. Dollars)
4

30

6

45

8

68

12

151.5

18

262.5

After the scale tables have been created, and the cost data entered, the Tables tab should appear as
shown in Figure 7.
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Figure 7: The Tables tab on the Cost Library window is used to create cost scale tables

Add the costs for the bends
With the cost scale tables for the bends defined, the costs for the bends can be added. Select the Junctions tab. A list of all of the available junctions is displayed in Junction Components list.
The bends in the model are called Bend for Process Steam System Cost Example. Select this junction
and add the material cost by clicking the New Cost button, and entering the following data:
1.

Description = Material

2.

Cost Type = Material (NR)

3.

Use Size Table = Table of Costs

4.

Multiplier = 1

5.

Size Scaling Table = Material Table

Now add the installation cost by clicking the New Cost button, and entering the following data:
1.

Description = Installation

2.

Cost Type = Installation (NR)

3.

Use Size Table = Table of Costs

4.

Multiplier = 1

5.

Size Scaling Table = Installation Table
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The actual cost values used for the fittings are the values that were entered in the scale tables on the
Tables tab. The scale table to use for each cost is specified when the cost is defined. After the cost data
is entered, the Junctions tab should appear as shown in Figure 8.

Figure 8: The Junctions tab on the Edit Cost Library window is used to specify costs junction items

Add the costs for the tees
Add the material cost for the tees by clicking the New Cost button, and entering the following data:
1.

Description = Material

2.

Cost Type = Material (NR)

3.

Use Size Table = (None)

4.

Cost (U.S. Dollars) = 150

5.

Cost Per = Item

Now add the installation cost for the tees by clicking the New Cost button, and entering the following
data:
1.

Description = Installation

2.

Cost Type = Installation (NR)

3.

Use Size Table = (None)

4.

Cost (U.S. Dollars) = 225

5.

Cost Per = Item

Save the cost library and click the Close button.
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Connecting the cost libraries
The cost libraries should have been added to the list of available libraries, and been connected to the
example model. If they were not, you can use the Library Manager to connect the cost libraries now (see
Figure 9 and ). Refer to the AFT Arrow Help system for information on how to connect libraries using the
Library Manager.

Figure 9: The Library Manager is used to connect engineering and cost libraries

Step 6. Including Items in the Cost Report
The final step before performing a cost analysis is to specify which pipes and junctions you want to be
included in the final cost report. This is done by choosing Include in Cost Report on the Cost tab in the
Properties window for each pipe and junction to be included, as shown for Pipe 1 in Figure 10.
The Global Edit feature may be used to update this information for all of the pipes and junctions.
For this example, we want to include the costs for all pipes, bends and tees.

- 815 -

Process Steam System - Cost

Figure 10: The Cost tab in the properties window is used to include the objects in the Cost Report

Step 7. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 8. Examine the Output
The Cost Report is displayed in the General section of the Output window. View the cost report by selecting the Cost Report tab. The content of the Cost Report can be controlled from the Output Control window. Figure 11 shows the Cost Report for this example with the Material, Installation, and Total costs
displayed.
The Cost Report shows the total system cost, as well as the individual totals for the material and installation costs. In addition, the Cost Report displays the detailed cost for each pipe, junction, and fitting that
was included in the report. The items are grouped together by type, and a subtotal for each category is listed.
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Figure 11: The Cost Report in the General Output section shows the results of the cost analysis

Cost analysis summary
The Cost analysis for the Process Steam System shows that the total initial system cost for the process
steam system is $172,504. Of that cost, $52,203 was for Material costs and $120,301 was for Installation
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costs
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Module Walk-Through Examples
The examples in the Arrow Module Help System are designed to get new users trained to use the Arrow
modules correctly in the shortest amount of time.
If this is your first time using Arrow, please start with the Walk-Through Examples to learn how to create
and run Arrow models. Start with the Air Heating System, because it provides the most complete, basic
description on how to set up and run an Arrow model. After this example, it is recommended that you
work through the remaining Walk-Through examples.
If you are just learning to work with the Arrow modules, start with the Beginner model for each module,
then choose an example from the tables on the Module pages that most closely matches your application. The examples are arranged in order of increasing complexity.
Arrow GSC Examples
Arrow ANS Examples
Arrow XTS Examples
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The examples below utilize the Goal Seek and Control module.

Arrow GSC Examples
Example

Beginner:
Heat Transfer
in a Pipe

Complexity

Beginner

Fluid

Air

Pipes

Compressors

Description

0

Learn the basics of the
GSC module. See how to
use Analysis Setup to activate and enable the GSC
module and to use the Goal
Seek and Control group to
define variables and goals.
Learn where to find the
GSC Variables and GSC
Goals tabs in the Output
window.

1

Steam Relief
System

Beginner

Steam

6

0

Learn how to use the GSC
module to achieve a
desired mass flow rate by
varying the CdA of a valve.

Natural Gas
Burner

Intermediate

Methane

16

0

Learn how to create groups
and use the Group Max/Min
goal with the GSC module.

1

Learn how to use the GSC
module to specify multiple
unique variables and goals
to achieve a desired system configuration.

0

Learn how to link GSC variables together to apply multiple variables and goals in
a single simulation.

Compressed
Air System

Process
Steam System

Beginner

Intermediate

Air

Steam

9

17

Beginner: Heat Transfer in a Pipe - GSC
Summary
The objective of this example is to demonstrate how goals and variables are used in the GSC module to
achieve an objective.
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Note: This example can only be run if you have a license for the GSC module.

Topics Covered
l

Using the Goal Seek and Control group

l

Setting Variables and Goals

l

Understanding Goal Seek and Control Output

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model File
This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Heat Transfer - GSC.aro

Problem Statement
For this example, we will use the GSC module to determine the flow rate required such that air at the outlet of a 60-meter section of pipe, with heat transfer, reaches a temperature of 38 deg. C. The initial air
temperature is 150 deg. C at a pressure of 3.5 barG (350 kPa(g)), the ambient temperature is 21 deg. C,
and the ambient air velocity is 25 km/hr.

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Step 2. Define the Modules Group
The GSC module is controlled through the Goal Seek and Control group in Analysis Setup. Open Analysis Setup, and navigate to the Modules panel. Check the box next to Activate GSC. The Use option
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should automatically be selected, making GSC enabled for use. Alternatively, GSC can be enabled from
the Analysis menu by going to the Goal Seek & Control option and selecting Use, as shown in Figure 1.

Figure 1: Select Use from the Goal Seek & Control menu item on the Analysis menu to instruct AFT Arrow to
perform goal seeking when it runs

Step 3. Define the Fluid Properties Group
1.

Open Analysis Setup from the toolbar or from the Analysis menu

2.

Open the Fluid panel then define the fluid:
a.

Fluid Library = AFT Standard

b.

Fluid = Air
i.

After selecting, click Add to Model

c.

Equation of State = Redlich-Kwong

d.

Enthalpy Model = Generalized

e.

Specific Heat Ratio Source = Library

Step 4. Define the Pipes and Junctions Group
At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as
shown in the figure below.
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Figure 2: Model layout for GSC Heat Transfer example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and
junction and enter the following properties.

Pipe Properties
1.

2.

Pipe Model tab
a.

Pipe Material = Steel - ANSI

b.

Pipe Geometry = Cylindrical Pipe

c.

Size = 4 inch

d.

Type = STD (schedule 40)

e.

Friction Model Data Set = Standard

f.

Length = 60 meters

Heat Transfer tab
a.

Heat Transfer Model = Convective Heat Transfer

b.

Temperature = 21 deg. C

c.

Fluid Velocity = 25 km/hr

d.

Fluid = Air

Junction Properties
1.

J1 Assigned Pressure
a.

Elevation = 0 meters

b.

Fluid = Air
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2.

c.

Pressure = 3.5 barG (350 kPa(g))

d.

Temperature = 150 deg. C

e.

Pressure Specification = Stagnation

J2 Assigned Flow
a.

Elevation = 0 meters

b.

Type = Outflow

c.

Fluid = Air

d.

Flow Rate = 0.9 kg/sec

Step 5. Define the Goal Seek and Control Group
The GSC module is controlled through the Goal Seek and Control group in Analysis Setup. The Goal
Seek and Control group has three items: Variables, Goals, and Numerical Controls. Use the Variables
panel to define the variables. Use the Goals panel to define the goals. and use the Numerical Controls
panel to specify the convergence and calculation methods. The default inputs in the Numerical Controls
panel will suffice for the vast majority of models using the GSC module.

Variables Panel
In the GSC module, variables are the parameters that Arrow will modify in order to achieve the specified
goals. In order to help maintain unique answers, there should typically be the same number of goals as
there are variables.
Open the Variables panel. The Variables panel allows users to create and modify the system variables.
The object and junction type are selected. Then, the name and number of the object to which the variable
applies and the object parameter that is to be varied are specified on the Variables tab.
Click the New Variable button, and enter the following variable data:
1.

Apply = Selected

2.

Object Type = Junction

3.

Junction Type = Assigned Flow

4.

Junction Number and Name = J2 (Assigned Flow)

5.

Variable Parameter = Flow

6.

Link To = (None)

The Apply column allows users to specify which of the variables that have been defined will be used. This
allows the flexibility of creating multiple variable cases, while only applying selected variables for any
given run.
The Link To column allows users to apply the same variable to multiple objects. This allows users to force
parameters for several objects to be varied identically.
Upper and lower bounds provide logical extremes during the goal search. Leave these blank for this
example/
After entering the data, the Variable tab should appear as shown in Figure 3:
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Figure 3: The Variables panel is used to specify the variables

Goals Panel
Goals are the parameter values set by the user that Arrow adjusts the variables to achieve. Again, there
should be the same number of system goals as there are system variables.
Select the Goals panel in Analysis Setup. The Goals panel allows users to create and modify the system
goals. The goal type, object type, and the goal parameter are selected. A criterion for determining if the
goal has been met is then specified, along with a value and units for the goal parameter. The user then
selects the object to which the goal applies, and, if applicable, the location on the object at which the goal
applies (i.e. the inlet or outlet of a pipe object).
Click the New Goal button, and enter the following goal data:
1.

Apply = Selected

2.

Goal Type = Point

3.

Object Type = Pipe

4.

Goal Parameter = Temperature Stagnation

5.

Criteria = =

6.

Goal Value = 38

7.

Goal Units = deg. C

8.

Object ID = P1 (Pipe)

9.

Object Location = Outlet

After entering the data, the Goals tab should appear as shown in Figure 4:
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Figure 4: GSC Manager Goals tab is used to specify the goals

As variables and goals are added to a model, AFT Arrow will display symbols beside the pipes and junctions that have variables or goals applied to them. The default is a V for variables, and a G for goals. The
goal symbol is not displayed next to objects that are part of a group goal. This is illustrated in Figure 5:

Figure 5: Workspace with Goal and Variable symbols displayed
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Step 6. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 7. Examine the Output
The Output window contains all the data that was specified in the Output Control window. Figure 6 shows
the Output window.

Figure 6: The Output window contains all the data that was specified in the Output Control window

The results of the GSC analysis are shown in the General Output section. The GSC Variables tab
shows the final value for the variable parameter, as shown in Figure 7. The GSC Goals tab shows the
final value achieved for the goal, as shown in Figure 8.

Figure 7: GSC Variable Results are displayed in the General section of the Output window
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Figure 8: GSC Goal Results are displayed in the General section of the Output window

The GSC module analysis determined that a mass flow rate of 0.2240 kg/sec results in a pipe outlet temperature of 38.00 deg. C. In order to achieve the desired temperature, the assigned flow rate was varied
from the initial value of 0.9 kg/sec, to the final value of 0.2240 kg/sec. In addition to the GSC module tabs
in the General Output section, the resulting pipe flow and temperature results can be seen in the Pipes
section of the Output window.
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Summary
The objective of this example is to demonstrate how goals and variables are used in the GSC module to
achieve an objective.
Note: This example can only be run if you have a license for the GSC module.

Topics Covered
l

Defining the Goal Seek and Control group

l

Setting Variables and Goals

l

Understanding Goal Seek and Control output

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition the user should have worked through the Beginner: Heat Transfer in a Pipe - GSC example.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Refinery Relief System.aro

l

Metric - Refinery Relief System - GSC.aro

Problem Statement
For this example, we will use the GSC module to determine the relief valve CdA value required such that
the capacity of a steam relief system is a minimum of 13 kg/sec.

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
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To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
Open the Metric - Refinery Relief System.aro example file listed above, which is located in the
Examples folder in the AFT Arrow application folder. Save the file to a different folder. This is the only
scenario needed for this example, so right-click the Base Scenario and select Delete All Children. The
workspace should look like Figure 1

Figure 1: Model layout for GSC Steam Relief System example

Step 2. Define the Fluid Properties Group
1.

Navigate to the Fluid panel in Analysis Setup

2.

Define the Fluid panel with the following inputs
a.

Fluid Library = AFT Standard

b.

Fluid = Steam
i.

After selecting, click Add to Model

c.

Equation of State = Redlich-Kwong

d.

Enthalpy Model = Generalized

e.

Specific Heat Ratio Source = Library

Step 3. Define the Pipes and Junctions Group
All pipes and junctions should already be defined. However, a few changes need to be made to adapt the
model to this example. Make the following changes:

Junction Properties
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1.

2.

3.

J1 Tank
a.

Name = Steam Process 1

b.

Fluid = Steam

c.

Temperature = 205 deg. C

J2 Tank
a.

Name = Steam Process 2

b.

Fluid = Steam

c.

Temperature = 205 deg. C

J3 Tank
a.

Name = Steam Process 3

b.

Fluid = Steam

c.

Temperature = 205 deg. C

Step 4. Define the Modules Group
Navigate to the Modules panel in Analysis Setup. Check the box next to Activate GSC. The Use option
should automatically be selected, making GSC enabled for use.

Step 5. Define the Goal Seek and Control Group
Specify the variables and goals for the model using the Goal Seek and Control group in Analysis Setup.

Variables Panel
Open the Variables panel, click New Variable, and enter the following variable data:
1.

Apply = Selected

2.

Object Type = Junction

3.

Junction Type = Valve

4.

Junction Number and Name = J7 (Relief Valve)

5.

Variable Parameter = CdA

6.

Link To = (None)

7.

Lower Bound (Optional) = 0

8.

Upper Bound (Optional) = 180

Note: The units used for the Lower and Upper Bound are the same as what is specified in the junction
properties window: cm2 in this case.

Goals Panel
Open the Goals panel, click New Goal, and enter the following goal data:
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1.

Apply = Selected

2.

Goal Type = Point

3.

Object Type = Pipe

4.

Goal Parameter = Mass Flow Rate

5.

Criteria = =

6.

Goal Value = 13

7.

Goal Units = kg/sec

8.

Object ID = P6 (Pipe)

9.

Object Location = NA

Step 6. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 7. Examine the Output
The results of the GSC analysis are shown in the General section of the Output window. The GSC Variables tab shows the final value for the variable parameter, as shown in Figure 2. The GSC Goals tab
shows the final value achieved for the goal, as shown in Figure 3.
The GSC module analysis determined that a relief valve CdA value of 142.9 cm2 will result in a relief
capacity of 13.00 kg/sec.

Figure 2: GSC Variable results are displayed in the General section of the Output window

Figure 3: GSC Goal results are displayed in the General section of the Output window
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Summary
The objective of this example is to demonstrate how multiple goals and variables are used in the GSC
module to achieve an objective.
Note: This example can only be run if you have a license for the GSC module.

Topics Covered
l

Defining the Goal Seek and Control group

l

Setting Variables and Goals

l

Using Group Max/Min Goals

l

Understanding Goal Seek and Control output

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition the user should have worked through the Beginner: Heat Transfer in a Pipe - GSC example.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Natural Gas Burner.aro

l

Metric - Natural Gas Burner - GSC.aro

Problem Statement
An underground storage reservoir containing natural gas made up mostly of methane supplies gas to five
burners. The gas is at 34.5 barG (3450 kPa(g)), and 10 deg. C. The gas is supplied to each of the burners
at 6.9 barG (690 kPa(g)). To assure that the flow to each of the burners is equal, each burner has a control valve that controls the flow to 2.25 kg/sec. The pipes in the system are uninsulated STD (schedule
40) Steel - ANSI, with standard roughness. The ambient temperature surrounding the pipes is 24 deg. C,
and the pipes have an ambient air velocity of 25 km/hr.
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In order to operate at the best efficiency, the gas should be delivered to the burners at a minimum stagnation temperature of 38 deg. C. In order to achieve this, the gas flows through a heat exchanger, which
has a 0.70 bar (70 kPa) pressure drop at 11 kg/sec.
How much heat must be added to the heat exchanger to ensure that all of the burners will receive gas at
the specified minimum temperature? (Neglect elevation changes)
Use GSC to size the heat exchanger.

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
Open the Metric - Natural Gas Burner.aro example file listed above, which is located in the Examples
folder in the AFT Arrow application folder. Save the file to a different folder. This is the only scenario
needed for this example, so right-click the Base Scenario and select Delete All Children. The workspace
should look like

Figure 1: Model layout for GSC Natural Gas Burner example

Step 2. Define the Steady Solution Control Group
There is an option available in Solution Control when using one of the marching methods that can sometimes result in an overall reduction in solution runtime. This option is to first solve the system using the
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Lumped Adiabatic method and then use these results as a starting point for the marching solution. Since
the Lumped Adiabatic solution can typically be obtained much faster, this can provide an overall reduction in runtime for the marching method.
The Steady Solution Control Group is already defined using the default inputs. This means that no user
input is required to run the model. However, the Lumped Adiabatic initialization will be used for this
model.
To activate this option, do the following:
1.

Open Analysis Setup

2.

Navigate to the Solution Method panel in the Steady Solution Control group

3.

Click the box to turn on First Use Lumped Adiabatic Method To Obtain Initial Stating Point For
Marching Solution

The Steady Solution Control Group is now defined for this model.

Step 3. Create a Group
In order to use the Group Max/Min goal type, the junctions or pipes included in the goal must be added to
a group. To create a group, select the pipes and/or junctions for the desired group, then select the
Groups | Create option from the Edit menu. In this case, only the pipes that are directly connected to the
burners will be selected (i.e., Pipes P12-P16).
When prompted, give the new group the name Burner Discharge Pipes, and click OK. After naming the
new group, the Group Manager will be displayed. Select the new group name from the list, and confirm
all of the burner discharge pipes from the pipe list are selected, as shown in Figure 2. Click OK to return
to the Workspace.
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Figure 2: Groups are displayed in the Group Manager window

Step 4. Define the Modules Group
Navigate to the Modules panel in Analysis Setup. Check the box next to Activate GSC. The Use option
should automatically be selected, making GSC enabled for use.

Step 5. Define the Goal Seek and Control Group
Specify the variables and goals for the model using the Goal Seek and Control group in Analysis Setup.

Variables Panel
Open the Variables panel, click New Variable, and enter the following variable data (Figure 3):
1.

Apply = Selected

2.

Object Type = Junction

3.

Junction Type = Heat Exchanger

4.

Junction Number and Name = J2 (Heat Exchanger)

5.

Variable Parameter = Heat Rate

6.

Link To = (None)
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7.

Lower Bound (Optional) = 0

8.

Upper Bound (Optional) = 2000

Note: The units used for the Lower and Upper Bound are the same as what is specified in the junction
properties window: kW in this case.

Figure 3: Variables are set on the Variables panel in Analysis Setup

Goals Panel
For this example, we will be using a Group Max/Min goal. This type of goal allows a single goal to be
applied to a group of objects. Arrow applies a Group Max/Min goal by ensuring the final goal value is
either greater than or equal to (Min) or less then or equal to (Max) the specified value. For our example, a
Group Max/Min goal will be applied to ensure the minimum gas discharge temperature out of all of the
burner discharge pipes is at least 38 deg. C.
Open the Goals panel, click New Goal, and enter the following goal data:
1.

Apply = Selected

2.

Goal Type = Group

3.

Object Type = Group Max/Min

4.

Goal Parameter = Temperature Stagnation

5.

Criteria = >=

6.

Goal Value = 38

7.

Goal Units = deg. C

8.

Object ID = Burner Discharge Pipes

9.

Object Location = Outlet

- 837 -

Natural Gas Burner - GSC

Step 6. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 7. Examine the Output
The results of the GSC analysis are shown in the General section of the Output window. The GSC Variables tab shows the final value for the variable parameter, as shown in Figure 4. The GSC Goals tab
shows the final value achieved for the goal, as shown in Figure 5.
The GSC module analysis determined the required heat rate to ensure a minimum gas delivery temperature of 38 deg. C is 1052 kW. This is the same result that was obtained in the Natural Gas Burner
example where the iterations to determine the heat rate were performed manually.

Figure 4: GSC Variable Results are displayed in the General section of the Output window

Figure 5: GSC Goal Results are displayed in the General section of the Output window
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Summary
The objective of this example is to demonstrate how multiple goals and variables are used in the GSC
module to achieve an objective.
Note: This example can only be run if you have a license for the GSC module.

Topics Covered
l

Defining the Goal Seek and Control group

l

Setting Variables and Goals

l

Applying multiple Variables and Goals

l

Interpreting Goal Seek and Control Output

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition the user should have worked through the Beginner: Heat Transfer in a Pipe - GSC example.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Compressed Air System.aro

l

Metric - Compressed Air System - GSC.aro

Problem Statement
For this example, we will use the GSC module to determine the valve K-factors required to achieve a specified flow of 55 gram/sec to all four tools.
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Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
Open the Metric - Compressed Air System.aro example file listed above, which is located in the
Examples folder in the AFT Arrow application folder. Save the file to a different folder. This is the only
scenario needed for this example, so right-click the Base Scenario and select Delete All Children. The
workspace should look like Figure 1

Figure 1: Model Layout for GSC Compressed Air System Example

Step 2. Define the Steady Solution Control Group
There is an option available in Solution Control when using one of the marching methods that can sometimes result in an overall reduction in solution runtime. This option is to first solve the system using the
Lumped Adiabatic method and then use these results as a starting point for the marching solution. Since
the Lumped Adiabatic solution can typically be obtained much faster, this can provide an overall reduction in runtime for the marching method.
The Steady Solution Control Group is already defined using the default inputs. This means that no user
input is required to run the model. However, the Lumped Adiabatic initialization will be used for this
model.
To activate this option, do the following:
1.

Open Analysis Setup

2.

Navigate to the Solution Method panel in the Steady Solution Control group
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3.

Click the box to turn on First Use Lumped Adiabatic Method To Obtain Initial Stating Point For
Marching Solution

The Steady Solution Control Group is now defined for this model.

Step 3. Define the Pipes and Junctions Group
Make the following changes to these junctions:
1.

J7-J10 Valves
1.

Subsonic Loss Model = K Factor

2.

K = 10

Step 4. Define the Modules Group
Navigate to the Modules panel in Analysis Setup. Check the box next to Activate GSC. The Use option
should automatically be selected, making GSC enabled for use.

Step 5. Define the Goal Seek and Control Group
Specify the variables and goals for the model using the Goal Seek and Control group in Analysis Setup.

Variables Panel
Open the Variables panel, click New Variable, and enter the following variable data:
1.

2.

J7 Valve
a.

Apply = Selected

b.

Object Type = Junction

c.

Junction Type = Valve

d.

Junction Number and Name = J7 (Valve)

e.

Variable Parameter = Loss Value

f.

Link To = (None)

g.

Lower Bound = 0

h.

Upper Bound = Leave blank

J8 Valve
a.

Apply = Selected

b.

Object Type = Junction

c.

Junction Type = Valve

d.

Junction Number and Name = J8 (Valve)
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3.

4.

e.

Variable Parameter = Loss Value

f.

Link To = (None)

g.

Lower Bound = 0

h.

Upper Bound = Leave blank

J9 Valve
a.

Apply = Selected

b.

Object Type = Junction

c.

Junction Type = Valve

d.

Junction Number and Name = J9 (Valve)

e.

Variable Parameter = Loss Value

f.

Link To = (None)

g.

Lower Bound = 0

h.

Upper Bound = Leave blank

J10 Valve
a.

Apply = Selected

b.

Object Type = Junction

c.

Junction Type = Valve

d.

Junction Number and Name = J10 (Valve)

e.

Variable Parameter = Loss Value

f.

Link To = (None)

g.

Lower Bound = 0

h.

Upper Bound = Leave blank

After entering the data, the Variables tab should appear as shown in Figure 2.

Figure 2: Goal Seek and Control group, Variables panel is used to specify the variables
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Goals Panel
Open the Goals panel, click New Goal, and enter the following goal data:
1.

2.

3.

4.

Pipe P6
a.

Apply = Selected

b.

Goal Type = Point

c.

Object Type = Pipe

d.

Goal Parameter = Mass Flow Rate

e.

Criteria = =

f.

Goal Value = 55

g.

Goal Units = gram/sec

h.

Object ID = P6 (Pipe)

i.

Object Location = NA

Pipe P7
a.

Apply = Selected

b.

Goal Type = Point

c.

Object Type = Pipe

d.

Goal Parameter = Mass Flow Rate

e.

Criteria = =

f.

Goal Value = 55

g.

Goal Units = gram/sec

h.

Object ID = P7 (Pipe)

i.

Object Location = NA

Pipe P8
a.

Apply = Selected

b.

Goal Type = Point

c.

Object Type = Pipe

d.

Goal Parameter = Mass Flow Rate

e.

Criteria = =

f.

Goal Value = 55

g.

Goal Units = gram/sec

h.

Object ID = P8 (Pipe)

i.

Object Location = NA

Pipe P9
a.

Apply = Selected

b.

Goal Type = Point

c.

Object Type = Pipe

d.

Goal Parameter = Mass Flow Rate

e.

Criteria = =

f.

Goal Value = 55
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g.

Goal Units = gram/sec

h.

Object ID = P9 (Pipe)

i.

Object Location = NA

After entering the data, the Goals tab should appear as shown in Figure 3.

Figure 3: Use the Goals panel is used to specify the goals

Step 6. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 7. Examine the Output
The results of the GSC analysis are shown in the General Output section. The GSC Variables tab
shows the final value for the variable parameter, as shown in Figure 4. The GSC Goals tab shows the
final value achieved for the goal, as shown in Figure 5.
The GSC module analysis determined the following valve K-factors would result in the desired flow of 55
gram/sec to each valve:
Object

Value

J7

13.98

J8

11.48
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Object

Value

J9

10.38

J10

10.08

Figure 4: GSC Variable Results are displayed in the General section of the Output window

Figure 5: GSC Goal Results are displayed in the General section of the Output window
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Summary
The objective of this example is to demonstrate how multiple goals and variables are used in the GSC
module to achieve an objective.
Note: This example can only be run if you have a license for the GSC module.

Topics Covered
l

Defining the Goal Seek and Control group

l

Setting Variables and Goals

l

Using Group Max/Min Goals

l

Linking Variables

l

Interpreting Goal Seek and Control output

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition the user should have worked through the Beginner: Heat Transfer in a Pipe - GSC example.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Process Steam System.aro

l

Metric - Process Steam System - GSC.aro

Problem Statement
For this example, we will use the GSC module to determine the supply pressure necessary to meet a
minimum delivery pressure of 7 barG (700 kPa(g)) at each discharge location for the specified flows.
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Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
Open the Metric - Process Steam System.aro example file listed above, which is located in the
Examples folder in the AFT Arrow application folder. Save the file to a different folder. This is the only
scenario needed for this example, so right-click the Base Scenario and select Delete All Children. The
workspace should look like Figure 1:

Figure 1: Model layout for GSC Process Steam System example

Step 2. Create a Group
In order to use the Group Max/Min goal type, the junctions or pipes included in the goal must be added to
a group. To create a group, select the Groups | Create option from the Edit menu. When prompted, give
the new group the name Users and click OK. After naming the new group, the Group Manager will be displayed. Select the new group name from the list, and then select all of the assigned flow junctions from
the junction list, as shown in Figure 2. After choosing the assigned flow junctions, click OK on the Group
Manager window.
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Figure 2: Groups are created using the Group Manager window

Step 3. Define the Modules Group
Navigate to the Modules panel in Analysis Setup. Check the box next to Activate GSC. The Use option
should automatically be selected, making GSC enabled for use.

Step 4. Define the Goal Seek and Control Group
Specify the variables and goals for the model using the Goal Seek and Control group in Analysis Setup.

Variables Panel
For this example, we want to find the supply pressures that will give us a specific minimum discharge
pressure. We will define the delivery pressures as a single Group Max/Min goal. But that gives us only
one goal for two variables. To solve this issue, we will use variable linking. Variable linking allows you to
tie multiple variables together, forcing them to be the same. To accomplish this, we will add a constraint
to the problem that both of the boiler supply pressures must be the same.
To implement variable linking, add both tank junctions pressures as variables. Then link them together by
specifying Boiler 1 (J1) in the Link To column of the Boiler 2 (J2) variable. Enter the data as shown below.
Open the Variables panel, click New Variable, and enter the following variable data:
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1.

2.

J1 Boiler 1
a.

Apply = Selected

b.

Object Type = Junction

c.

Junction Type = Tank

d.

Junction Number and Name = J1 (Boiler 1)

e.

Variable Parameter = Pressure

f.

Link To: (None)

g.

Lower Bound: Leave blank

h.

Upper Bound: Leave blank

Boiler 2 (J2)
a.

Apply = Selected

b.

Object Type = Junction

c.

Junction Type = Tank

d.

Junction Number and Name = J2 (Boiler 2)

e.

Variable Parameter = Pressure

f.

Link To = J1 (Boiler 1)

g.

Lower Bound: Leave blank

h.

Upper Bound: Leave blank

After entering the variable data, the Variables tab in the Goal Seek and Control manager should appear
as shown in Figure 3.

Figure 3: Variable solutions can be linked together using the Link To option

Goals Panel
For this example, we will be using a Group Max/Min goal. This type of goal allows a single goal to be
applied to a group of objects. Arrow applies a Group Max/Min goal by ensuring the final goal value is
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either greater than or equal to (Min) or less then or equal to (Max) the specified value. For our example, a
Group Max/Min goal will be applied to ensure the minimum discharge pressure at all of the assigned flow
junctions is at least 7 barG (700 kPa(g)).
Open the Goals panel, click New Goal, and enter the following goal data:
1.

Apply = Selected

2.

Goal Type = Group

3.

Object Type = Group Max/Min

4.

Goal Parameter = Pressure Stagnation

5.

Criteria = >=

6.

Goal Value = 7

7.

Goal Units = barG

8.

Object ID = Users

9.

Object Location = NA

As variables and goals are added to a model, AFT Arrow will display symbols beside the pipes and junctions that have variables or goals applied to them. The default is a V for variables, and a G for goals. The
goal symbol is not displayed next to objects that are part of a group goal, so you will see only the V displayed on the Workspace for this example.

Step 5. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 6. Examine the Output
The results of the GSC analysis are shown in the General section of the Output window. The GSC Variables tab shows the final value for the variable parameter, as shown in Figure 4. The GSC Goals tab
shows the final value achieved for the goal, as shown in .
The GSC module analysis determined the supply pressure required to ensure a minimum delivery pressure of 7 barG (700 kPa(g)) at the users is 20.06 barG (2006 kPa(g)).

Figure 4: GSC Variable Results are displayed in the General section of the Output window
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Figure 5: GSC Goal Results are displayed in the General section of the Output window
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The examples below utilize the Automated Network Sizing module.

Arrow ANS Examples
Example
Beginner:
Three Tank
Steam System

Control Valve

Air Distribution,
Creating
Libraries

Air Distribution

Complexity

Beginner

Beginner

Intermediate

Intermediate

Fluid

Steam

Steam

Air

Air

Pipes

3

2

18

18

Compressors

Description

0

Learn the basics of the ANS
module such as defining all
panels in the Sizing window
to achieve a minimum pipe
weight objective

0

Learn how to use the ANS
module and how Common
Size Groups work to minimize the pipe weight of a
system.

1

Learn how to build cost libraries and engineering libraries for use with the ANS
module. See how to use
Scale Tables for defining
compressor costs, how to
specify material versus
installation costs, and how
to define costs for pipes.

1

Learn how to use the ANS
module to minimize monetary cost based on initial
cost and recurring costs.
See how to use the Assign
Cost Libraries panel and the
Sizing Summary panel.
Explore how the system life
and the sizing objective
impacts the optimal pipe
sizes.

Air Distribution, Multiple Design
Cases

Intermediate

Air

18

1

Learn how to use the ANS
module to minimize monetary cost using a Dependent Design Case.

Helium Transfer

Beginner

Helium

3

0

Learn how to use the ANS
module to minimize the pipe
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Example

Complexity

Fluid

Pipes

Compressors

Description
weight of a system based on
a dependent design configuration, called a Dependent Design Case.

Natural Gas
Burner

Intermediate

Methane

16

0

Learn how to use the ANS
module to minimize the monetary cost using a Dependent Design Case then
comparing the results to the
same system but with an
objective to minimize pipe
weight.

Process
Steam System

Intermediate

Steam

17

0

Learn how to use the ANS
module and how the Search
Method impacts results

Beginner: Three Tank Steam System - ANS
Summary
The objective of this example is to familiarize the user with the components of the ANS module. We will
apply automated sizing to determine the ideal pipe sizes from our previously built three-reservoir model
to reduce costs while meeting certain requirements.
Note: This example can only be run if you have a license for the ANS module.

Topics Covered
l

Minimizing the pipe weight to minimize cost

l

Defining Pipe Design Requirements

l

Choosing Candidate Sets

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model Files

- 853 -

Automatic Network Sizing (ANS) Examples

This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Three Tank System - ANS Initial.aro

l

Metric - Three Tank System - ANS Final.aro

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
Open the Metric - Three Tank System - ANS Initial.aro example file listed above, which is located in
the Examples folder in the AFT Arrow application folder. Save the file to a different folder. This is the only
scenario needed for this example, so right-click the Base Scenario and select Delete All Children. The
workspace should look like Figure 1:

Figure 1: Layout of Three Tank System model in Workspace

Step 2. Define the Modules Group
The ANS module is controlled through the Sizing window which is activated and enabled through Analysis Setup. Open Analysis Setup, and navigate to the Modules panel. Check the box next to Activate
ANS. The Network option should automatically be selected, making ANS enabled for use. Alternatively,
ANS can be enabled from the Analysis menu by going to the Automated Sizing option and selecting Network, as shown in Figure 2.
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Figure 2: Activating Network Sizing from the Analysis menu

Step 3. Define the Automatic Sizing Group
Here we will pursue a brief introduction to some of the sizing capabilities in the ANS module. A more
complete discussion is given in the AFT Arrow Help file.
The Sizing window is comprised of multiple panels which can be accessed using the buttons on the Sizing Navigation Panel along the bottom of the window, as shown in Figure 3. The sizing panels can be
accessed in any order, though it is easiest to enter the information by navigating the panels from left to
right, since the input on panels such as the Sizing Objective and Sizing Assignments panels will affect
the options available on later panels. Depending on the type of sizing being done, some panels may be
disabled or unused.
Similar to Analysis Setup, each panel button contains either a green checkmark or red circle which
denotes the completion status of that panel. If the minimum required information is present to run the
model, the symbol will be green, whereas the red symbol represents incomplete input. The amount of
information required will vary based on whether the Sizing Level Status is set to Perform Sizing, Calculate Costs, or Do Not Size. A detailed summary of the items which have been completed and the items
which are still incomplete can be seen in the Sizing Status panel, opened from the Sizing Toolbar.
Note that some panels will always be shown as complete since the model can be run without any additional information entered on them, such as with the Design Requirements panel. However, in order to
find the best system design it will often be necessary to enter more than the minimum information
required by the solver.
The Lock Panel toggle located on the Sizing Toolbar prevents changes to the current panel when it is
enabled. This is primarily useful to prevent editing once a scenario has been run, since any changes that
are made to a scenario which has output will cause all output to be erased. By default, the ANS module
will lock all panels after a sizing run is completed, requiring panels to be unlocked before any changes
can be made. This setting can be changed on the Sizing Objective panel. All panels can be locked or
unlocked simultaneously by using the Lock/Unlock All Panels buttons on the Sizing Toolbar. This setting
can be changed on the Sizing Objective panel, as can be seen in Figure 3.
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Figure 3: Sizing Window showing common sizing panel features

A. Sizing Objective
The Sizing Objective panel is used to set the type of calculation that will be performed, and to select an
Objective which will be used in the sizing process.
For the Sizing Option, Perform Sizing should generally be selected, since this is the primary function of
the ANS module. However, the other two options may be used for troubleshooting or informational purposes. For example, the Calculate Cost, Do Not Size option may be useful to calculate an initial cost for
the system, or to verify your cost libraries. The Do Not Size option allows the model to be run normally in
AFT Arrow without requiring any cost or sizing information. This is useful to preserve the information
already entered in the Sizing window while running the model normally.
ØSelect Perform Sizing to begin configuring the sizing settings.
Note: The Sizing Level Status, which shows the type of calculation being performed, can always be
seen on the box on the left of the Sizing Navigation panel. Clicking this box will bring you to the
Sizing Objective panel, where this status can be changed.
The next step is to set a Sizing Objective, which can be monetary cost, or a non-monetary cost such as
pipe weight or flow volume. It is easier to perform a non-monetary sizing, since all of the geometry and
material information necessary to calculate the pipe weight/volume is already contained in the pipe material libraries. A monetary cost objective would require cost information to be obtained and entered into
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cost libraries. For many systems, sizing the system using one of the simpler non-monetary objective
options provides a sufficient approximation for minimized cost. In this case, we will be performing a minimization for pipe weight.
ØFor the Objective, choose Pipe Weight, and select the Minimize option from the drop-down list if not
already selected, as shown in Figure 3 above.
The other option available in the Sizing Objective panel is to configure the Sizing Lock Options as mentioned previously. This option will be left as the default.

B. Sizing Assignments
On the Sizing Navigation panel at the bottom of the window select the Sizing Assignments button. The
Sizing Assignments panel allows the user to define what objects will be sized in the model, and what will
be included in the cost calculation without being sized. Common Size Groups for pipes, or Maximum
Cost Groups for compressors/control valves can be created on this panel as well when appropriate.
Let's consider the Sizing Assignments for the pipes, which should be displayed by default when we open
this panel. In this case since the Sizing Objective is Pipe Weight we will discuss all costs in terms of
weight.
In the Sizing and Weight Options table there are several options under the categories to Automatically
Size, or Do Not Size the pipe.
If an Automatically Size option is selected, the ANS module will treat the pipe diameter as a variable and
vary it according to certain criteria that will be discussed shortly.
For a new system, typically all pipes will be desired to be sized and included in the weight calculation by
choosing Always Include in Weight. If you are instead analyzing the possible replacement of existing
pipes, it may be better to size the pipes, but only include the weight if the size changes from that which
exists by choosing Include in Weight if Size Changes.
If Do not Size is selected, the pipe will retain the settings currently set in the Workspace. Why would one
choose to not size a pipe? There could be a number of reasons, but one good reason is that the pipe represents a pipe in an existing system and the design does not allow the replacement of that pipe with a
new one. Therefore its diameter is fixed, and sizing the pipe would be unrealistic.
Another reason may be if a certain size is necessary for the design due to certain requirements, in which
case the pipe weight can be included without sizing the pipe by choosing Include in Weight.
This model is a new system, so all pipes will be sized and included in the weight calculation.
ØSelect Always Include in Weight under Automatically Size for all three pipes (Figure 4).
Since we want to size the pipes independently in this model, we do not need to make any changes to the
Pipe Grouping section of the table, so this panel is complete.

- 857 -

Automatic Network Sizing (ANS) Examples

Note: For models which have junctions that can be sized, a Junctions button at the top of this panel
will be available to set the Junctions Sizing Assignments. In this case we have chosen to analyze pipe weight. While this value can easily be calculated for the pipes, Arrow does not have
enough information to calculate a weight for the branch or the reservoirs, which means that they
cannot be sized using this method, and the Junctions tab is unavailable. This same limitation
exists when using other non-monetary objectives as well, such as flow volume. If the size of a
junction will have a large impact on the system cost, such as a compressor, Monetary Cost
should be used as the Objective.

Figure 4: Sizing Assignments panel for Three Tank model

C. Candidate Sets
Click on the Candidate Sets button to open the Candidate Sets panel.
Since commercial piping is limited to certain sizes, the ANS module needs a list of possible sizes from
which to choose. This list is called a Candidate Set.
So as not to limit the sizing unnecessarily, the candidate sets should include both smaller and larger
pipes than your anticipated final size. If you make the candidate set too small, you may limit the ability of
the ANS module to find the best sizing. It is better to make the candidate set too large than too small.
Experience applying the ANS module to actual systems will help you choose appropriate candidate sets.
If after obtaining a solution you find that one or more of the sized pipes is at the extreme of the candidate
set, a warning will appear, and it is recommended to expand the defined candidate set.
To create a Candidate Set, do the following:
1.

Under Define Candidate Sets, click New.

2.

Give the set the name STD Steel and click OK.

3.

From the drop down list choose Steel - ANSI.

4.

In the bottom of the Select Pipe Sizes window, click the Sort option Type, Schedule, Class if it is
not already selected.
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5.

In the Available Material Sizes and Types list on the left, select STD so that the schedule name is
now highlighted.

6.

Click the Add button to add all STD pipe sizes to the list on the right (Figure 5).

7.

In the Select Pipe Sizes window, click the OK button.

The STD Steel set will now appear in the Define Candidate Sets section.
We will apply the STD Steel set shortly. First, let’s take a moment to understand what we have just done.
We have created a Candidate Set that includes all pipe sizes in the library that are STD Steel - ANSI. At
the low end this includes 1/8th inch pipe, and at the high end 48 inch pipe. This Candidate Set contains
pipe sizes from a library of Steel-ANSI pipe, and not just specific pipes from the model. After we apply
this candidate set to a specific pipe in the model and the sizing is run, the ANS module will select the
best pipe size from this set of pipe sizes to achieve the objective.
We now need to define which pipes will use this Candidate Set during the sizing calculation. Each pipe
that is being sized must have a Candidate Set assigned to it. Under Assign Candidate Sets to Pipes, set
each pipe in the model to use STD Steel by selecting the radio button under this Candidate Set for each
of the pipes. The Candidate Sets should now be fully defined and assigned to the appropriate pipes, as
can be seen in Figure 6.

Figure 5: Select Pipe Sizes window for defining a new Candidate Set
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Figure 6: Candidate Sets window fully defined for the Three Tank model

D. Design Requirements
Select the Design Requirements button. If we do not define any design requirements for this model, the
ANS module will choose the smallest pipe size in the Candidate Set, since it has the smallest pipe
weight. Along with the smallest pipes we may get unacceptably low flowrates, or unacceptably high velocities and pressure drops. To maintain acceptable system operating conditions, we need to set Design
Requirements.
We are going to define one Design Requirement for this case. Before adding any requirements, let’s look
more closely at the results of the model we are starting with. Pipe 1 is 14 inch, and the other two are 12
inch. The results show that the steam flows from tank J1 to tanks J2 and J3. The mass flow rate out of J1
is 68.30 kg/sec, and the mass flow rates to J2 and J3 are 21.82 and 46.49 kg/sec, respectively. Let's
assume that there is a requirement to deliver at least 13 kg/hr to each J2 and J3.
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We need to create a Design Requirement that represents the flow requirement. To do this:
1.

Make sure that the Pipes button is selected.

2.

Click New under Define Design Requirements.

3.

Enter the name Min Flow.

4.

A new row will appear in the Pipe Design Requirements table. In this row, select Mass Flow Rate
as the Parameter.

5.

Choose Minimum for Max/Min, and enter 13 kg/sec

We now need to apply this Design Requirement to the pipes. In the Assign Design Requirements to
Pipes section select the check box for Min Flow next to pipes P2 and P3. This will set the minimum flow
rate going into Tanks J2 and J3 as described above. The fully defined and assigned Design Requirements are shown in Figure 7.

Figure 7: Design Requirements window with the minimum flow requirements defined

E. Assign Cost Libraries
When the Sizing Objective has been defined as Monetary Cost, it is necessary to create and assign cost
libraries for the automated sizing, which can be done in the Assign Cost Library panel. Since we have
defined the objective as Pipe Weight, we will not need to assign any cost libraries, and this button is
grayed out.
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F. Sizing Method
Select the Sizing Method button to go to the Sizing Method Panel.
The Sizing Method Panel is used to set up the calculation methods for sizing the system. The User has
the option to select whether discrete or continuous sizing will be used, and which method will be applied.
If Continuous Sizing is selected, the ANS module will use the maximum and minimum pipe sizes from
the Candidate Sets as bounds, and report the ideal hydraulic diameter for the pipes between those
bounds. This would result in pipe sizes which would not match any of the possible chosen commercial
sizes. While this is not useful as a final solution, this can be helpful as a baseline to check the final discrete sizing solution. Discrete Sizing will typically perform a continuous sizing calculation as a basis, after
which multiple discrete sizes above and below this solution will be evaluated to find the ideal sizing based
on the provided Candidate Set.
ØFor this model, select Discrete Sizing if it is not already selected.
For the Search Method, the ideal method will often change based on the number of independent pipe
sizes (shown in the Sizing Assignments panel on the bottom right), number of Design Requirements, and
feasibility of the initial system design. The Help file provides more information on the strengths and weaknesses of each method. It is generally recommended to run the sizing with more than one method, as it is
often not obvious which method will be most effective for each system. The Suggest Best Method button
can be used as a guide for which method to start with.
For a simple model such as this one, the MMFD or SQP method should be appropriate since there are
only two Design Requirements (the minimum flow at the two delivery pipes), and only three pipe sizes
are being varied.
ØChoose the default Modified Method of Feasible Directions (MMFD) (Figure 8).
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Figure 8: Sizing Method panel defined for Three Tank model

Step 4. Run the Model
Select Run from the Toolbar or Analysis menu. While the model is running, the Solution Progress window
shows the Sizing Calls to Solver. This is how many times a complete hydraulic analysis was run.
The solver also displays the Current Cost and Best Feasible Cost, which will display the last calculated
value for the cost, as well as the Best Feasible Cost which has been found so far (Figure 9). The solver
will continue to iterate using the defined method until it finds the ideal sizing. For the selected method, the
solver will first perform a continuous sizing to find a starting point, then test discrete solutions close to this
continuous solution to find the final, discrete solution.
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Figure 9: Solution Progress Window showing the progress of the sizing calculation

Step 5. Examine the Output
Click the View Output button to see the results. The General section shows the Cost Report, which indicates the volumes for the final solution. As shown in Figure 10, the minimum total pipe weight identified by
the ANS module was 16,853 kg. In the Pipes section of the output on the Sizing tab, the final pipe sizes
of 12, 8, and 6 inches are shown (Figure 10).
Now switch to the Pipe Design Requirements tab in the Pipe section (Figure 11). We can confirm that the
calculated design is feasible, since all of the Design Requirements were met. That is, the flow from J1 (as
shown in pipe P1) exceeded 600 m3/hr, and the flows to J2 and J3 exceeded 150 m3/hr. Notice that
some of the Design Requirements are highlighted, indicating that they were active. An active design
requirement is defined as a requirement that had an impact on the solution. If an active design requirement were disabled, a different solution would be found. Yellow highlights indicate that the design
requirement was active in the final solution, while blue highlights indicate that the requirement was active
when the continuous sizing was performed, but the difference between the discrete and continuous solutions was outside of a pre-defined tolerance.
You can also display the adjusted pipe sizes and resulting flow rates in the Visual Report. Options are
available in the Visual Report Control which would allow the user to compare parameters such as the
final pipe sizes to the original pipe sizes.
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Figure 10: Output window with Cost Report and Pipe Sizes for Three Tank Model

Figure 11: Design Requirements results for Three Tank Model

Transferring Sized Results
When performing sizing, the Transfer Results to Initial Guesses feature on the Output window Edit menu
takes on new meaning. When used in a non-sizing context, this feature takes the solved hydraulic results
(i.e., pressures, flows rates, etc.) and assigns them to the initial guess values for the pipes and junctions.
When you select Transfer Results to Initial Guesses after automated sizing, you will see a dialog window
appear like that shown in Figure 12. The ANS module allows you to transfer the hydraulic results, the
sized pipe diameters, or both. If you transfer the sized pipe diameters, each pipe's input diameter (back
on the Workspace) will become the sized diameter.
This feature allows the sizing results to be saved to the model for use in further analysis as needed.
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Figure 12: After sizing, the Transfer Results to Initial Guesses feature transfers both the hydraulic results and
sized pipe size results

Conclusion
You have now used performed a network sizing to minimize pipe weight with the ANS module.
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Summary
This example will show how to use AFT Arrow ANS module to size a system based on pipe weight. For
many systems the necessary cost data is not available to directly minimize cost, so minimizing system
parameters such as weight or flow volume is useful. By minimizing parameters such as these we minimize pipe diameter, which directly correlates to minimizing pipe costs.
We will create a system that feeds water from an elevated reservoir to a lower reservoir at a specified
flow rate. A control valve will be used to control the flow rate and can be placed anywhere within the line.
We will need to determine what size of piping to use in order to achieve a minimum pressure drop of 140
kPa across the control valve.
Note: This example can only be run if you have a license for the ANS module.

Topics Covered
l

Sizing using pipe weight

l

Creating a Common Size Group

l

Defining Control Valve Design Requirements

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition, it is assumed that the user has worked through the Beginner: Three Tank Steam System ANS example, and is familiar with the basics of ANS analysis.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Control Valve.aro

l

Metric - Control Valve - ANS.aro
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Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
Open the Metric - Control Valve.aro example file listed above, which is located in the Examples folder
in the AFT Arrow application folder. Save the file to a different folder.
Make sure the "With Insulation" scenario is the active scenario by double clicking on that scenario in the
Scenario Manager. The workspace should look like Figure 1

Figure 1: Control Valve System Layout

Step 2. Define the Modules Group
Navigate to the Modules panel in Analysis Setup. Check the box next to Activate ANS. The Network
option should automatically be selected, making ANS enabled for use.

Step 3. Define the Automatic Sizing Group
In this model we are going to perform sizing to minimize the pipe weight (therefore minimizing cost), while
maintaining a minimum pressure drop of 140 kPa across the control valve.
To do this, first go to the Sizing window by clicking on the Sizing tab, or from the Windows menu.

A. Sizing Objective
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The Sizing Objective panel should be selected by default from the Sizing Navigation Panel along the bottom of the window.
Set the Sizing Option as Perform Sizing.
For the Objective, choose Pipe Weight, and select the Minimize option from the drop-down list if it is not
already selected.

B. Sizing Assignments
On the toolbar at the bottom of the window select the Sizing Assignments button.
In this case we are sizing a new pipeline, so we want to size all pipes in the model.
ØUnder Automatically Size select Always Include in Weight next to each of the pipes.
For this system it is required that both pipes be the same size. We will need to add both pipes to a Common Size Group to specify this. To do this:
1.

Click New above Pipe Grouping, and give it new Common Size Group the name Main Pipes

2.

A new section will now appear with the Main Pipes group listed under Common Size Groups. Add
both pipes to this group by clicking the corresponding radio buttons (Figure 2).

Note that as many Common Size Groups as necessary can be created. Selection tools are available at
the bottom of the window to help assign multiple pipes to a Common Size Group for larger models. Additionally, pipes can only be assigned to a group once they are set to be included in sizing.

Figure 2: Pipes P1 and P2 settings in the Sizing Assignments window

C. Candidate Sets
Click on the Candidate Sets button to open the Candidate Sets panel.
To select a discrete pipe size, ANS needs a list of candidates from which to choose. This list is called a
Candidate Set. To create a Candidate Set, do the following:
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1.

Under Define Candidate Sets, click the New button.

2.

Give the set the name STD Pipes and click OK.

3.

From the drop down list choose Steel - ANSI.

4.

In the Available Material Sizes and Types on the left, expand the STD pipe sizes list.

5.

Double-click each of the sizes from 1 to 10 inches to add them to the list on the right.

6.

In the Select Pipe Sizes window, click the OK button.

The STD Pipes set will now appear, and will be automatically defined as a Discrete set.
We now need to define which pipes will use this Candidate Set during the sizing calculation.
ØUnder Assign Candidate Sets to Pipes, set the Main Pipes Common Size Group to use the STD
Pipes Candidate Set. The Candidate Sets are now fully defined and assigned to the appropriate pipes,
as can be seen in Figure 3.

Figure 3: Candidate Sets panel fully defined for the Control Valve model

D. Design Requirements
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Select the Design Requirements button.
For this model we only have one Design Requirement, which is for the minimum pressure drop across
the Control Valve. To define this requirement:
1.

Select the Control Valves button at the top of the window.

2.

Click the New button under Define Control Valve Design Requirements.

3.

Enter the name Min Pressure Drop.

4.

For the Parameter, select Pressure Drop Static.

5.

For the Max/Min, select Minimum

6.

For the Value and Units, select 140 kPa.

Now we need to apply the defined Design Requirement to the Junction.
ØCheck the box next to the Control Valve Junction J2 in the Assign Design Requirements to Control Valves section.
Note: It is strongly recommended that flow control valves have a Design Requirement specified for the
minimum pressure drop/head, or the maximum Cv/percent open at the valve. If no Design
Requirements are applied, the ANS module will allow the control valve to control to any pressure required to meet the control setpoint, even if this requires the control valve to add pressure
to the system for design purposes. To avoid this behavior in the final solution, a Design Requirement should be applied.

E. Assign Cost Libraries
When the Sizing Objective has been defined as monetary cost, it is necessary to create and assign cost
libraries for the automated sizing, which can be done in the Assign Cost Library panel. Since we have
defined the objective as Pipe Weight, we will not need to assign any cost libraries, and this button is disabled.

F. Sizing Method
Select the Sizing Method button to go to the corresponding panel.
Select Discrete Sizing, since we are sizing based on commercial pipe sizes.
For the Search Method in a simple model such as this one, the MMFD or SQP method should be appropriate since there is only one Design Requirement, and only one pipe size is being varied. Choose the
default Modified Method of Feasible Directions (MMFD).

Step 4. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.
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Step 5. Examine the Output
The output is shown below in Figure 4. We have shown all three sections of the output window with the
General, Pipes, and Junctions sections. In the General Section, we have selected the Cost Report tab
that shows the variable that was sized for this run. The pipe weight in each pipe was minimized.
In the pipe section, we have selected the Sizing tab that shows the final pipe sizes chosen. We can see
that the ideal pipe size was found to be 3 inch pipe. In the Junction section, we have selected the CV
Design Requirements tab that shows how we have satisfied the Design Requirement set on the control
valve. The only Design Requirement was on pressure drop and we are above the minimum pressure
drop of 140 kPa.

Figure 4: Output for the Control Valve model showing the Cost Report, final pipe sizes and Design Requirement for the Control Valve

Conclusion
This example has demonstrated how simple it is to perform an automated sizing to design a system for a
set of requirements. Pipe weight may not be directly proportional to pipe cost but it can be implemented
very quickly when cost data is not available.
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Summary
This example focuses on creating Engineering and Cost Libraries for a system, then connecting the libraries to the model in order to obtain accurate results based on the cost data.
Note: This sizing for this example can only be completed if you have a license for the ANS module.
However, the libraries can be built without access to ANS.

Topics Covered
l

Using external libraries

l

Building engineering and cost libraries

l

Using Scale Tables for cost

l

Connecting and using existing engineering and cost libraries

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition, it is assumed that the user has worked through the Beginner: Three Tank Steam System ANS example, and is familiar with the basics of ANS analysis.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Air Distribution - ANS Initial.aro

l

Metric - Air Distribution - ANS Final.aro

l

Air Distribution.dat - engineering library

l

Air Distribution Costs.cst - cost library for Air Distribution.dat

l

Steel - ANSI Pipe Cost.cst - cost library for Steel - ANSI pipes
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Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
Open the Metric - Air Distribution - ANS Initial.aro example file listed above, which is located in the
Examples folder in the AFT Arrow application folder. Save the file to a different folder.

Step 2. Create an Engineering Library
If it is desired to size any of the junctions in the system, such as the Compressors/Fans, the first step is to
create an Engineering Library containing information for each of the components that will be sized. This
engineering library can later be used to attach a cost library for the components. Engineering libraries
can also be connected to future models to reuse any of the components in future systems.
To add a defined compressor to an engineering library:
1.

Define the Compressor/Fan junction in the workspace.
1.

For this example, the junction is already defined in the initial model.

2.

Select the Compressor/Fan, go to the Library menu, and choose Add Junction to Library.

3.

Give the Compressor/Fan a meaningful name such as Fixed Flow 2125 sm3/h and add it to the
desired library by selecting it from the list, in this case the LOCAL USER LIBRARY.

If we had multiple Compressor/Fan models, valve types, etc. then we might need to add multiple Compressors/Fans, valves, etc.
The local user library is the default location where user defaults are placed for the local machine. If the
junctions are stored in the local user library, it is possible to run all the calculations, and attach a cost library for the junctions. However, this restricts the use of the saved data, as the local user library cannot be
shared with other users or be moved to different machines. Therefore, it is often preferred to place the
components into an external library. Follow the steps below to move the components:
1.

Open the Library Manager from the Library menu.

2.

Click Create New Library at the bottom of the window.

3.

Give it a unique filename, such as Air Distribution.dat. It is important to use a descriptive name
to avoid confusion later if the library needs to be reconnected or sent to someone else.

4.

Enter a Library Description. This is the name that will be displayed within the Library Manager
itself and may be different from the file name. It is helpful to make the description the same name
as the filename to avoid confusion. We will use the name Air Distribution for this library.

5.

For the compressor that we added earlier, right-click the name, then click Move Content to move
the junction from the LOCAL USER LIBRARY to the Air Distribution library. The Fixed Flow 2125
sm3/h compressor should now be visible in the Junctions section below the Air Distribution library
name, as is shown in Figure 1.

6.

Select Close to complete the process. If you open the folder where the library was created in step
3, the library file should now be available.
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Note: The Copy option is also available if you want to preserve the items within the original library.
We are now ready to enter the cost data for the junctions in the model.

Figure 1: Library Manager showing the components moved to the new external library from the local user library

Step 3. Create a Cost Library for Junctions
Use the Library menu to select Cost Library and open the Edit Cost Library window, which is used to create and view cost libraries. In this case we need to enter new cost data that we have obtained, so click
New.
The list of Available Libraries should now be displayed as shown in Figure 2. Every cost library must be
built of an existing engineering or pipe material library in order to link the cost information with the appropriate components in the model. Select to the newly created library, Air Distribution. You may need to use
the Browse button to find it if the library is not shown in the list. Then click Select.
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Figure 2: The Available Engineering Libraries list which can be used to build a cost library

From here we will be brought to the General tab of the Edit Cost Library window. The description field is
used as the name displayed within the Library Manager, similar with the engineering library.
The Notes field can be used to provide information on sources for the data, or other details which may be
useful for tracking purposes and can be seen when reviewing the library contents in the Library Manager.
The other item of note is the Multipliers table. This can be useful to apply multipliers to account for inflation or uncertainty, without needing to calculate the costs directly. Note that multipliers can also be
applied within the Assign Cost Libraries panel, so be cautious to avoid duplicate multipliers.
Ø In the Description field enter Air Distribution Costs, as seen in Figure 3. Now let’s move on to entering cost data. Click the Junctions tab to view the Junctions overview.
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Figure 3: The General tab within the Cost Library window

Within the Junctions tab each individual library item can be viewed under each Junction type. First
expand the Compressor/Fan section by clicking the + icon and select the Fixed Flow 2125 sm3/h component that was added earlier.
Note: The Show Engineering Data button can be used to view the properties window for the selected
component in the engineering library.
ØClick the New Cost button to add an item to the table. By default, a cost item will be added that is configured for cost entry per item. Costs can be categorized as Material, Installation or Maintenance Cost
Type. This categorization becomes useful if it is desired to exclude certain costs from the calculation or
the sizing, but otherwise does not impact how the costs are calculated.
In the file explorer open the excel spreadsheet titled Air Distribution Costs - ANS.xlsx found in the
Examples folder, and go to the Metric - Junction Costs tab. The cost data for the compressor can be
seen here, categorized by cost type.
In this case we are sizing the compressor, so rather than having a cost for a specific compressor model,
we have a range of costs specified based on the power requirement for the compressor. We will need to
enter this data into the Tables tab first before we can define the cost item on the Junctions tab, so click on
the Tables tab at the top of the window.
Ø Click the New Table button to begin defining the data table, and name it Compressor Material. Multiple Table Types are offered as the dependent variables for the table, which can either be plotted against
a set of multipliers which will be applied to a specific data point, or directly against cost, as can be seen in
Figure 4.
The data we have available is the cost for the compressor over a range of different power requirements,
so choose Power and Cost as shown below, then click OK.
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The new table name will now appear in the Tables list, and an entry section for Power vs Cost will
become available. Copy the data in the excel spreadsheet for compressor material, then click the Edit
Table button and choose Paste. Make sure that the table Units have been set to kW. Repeat this process
for the compressor installation costs using the data from the spreadsheet as shown in Figure 5.

Figure 4: Table type and formatting options when creating a cost library

Figure 5: Complete tables list with material and installation cost tables for each of the junctions being analyzed
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Now that the data tables have been created, we must assign them to the Compressor/Fan junction in the
Junctions tab. Click on the Junctions tab and make sure that the Fixed Flow 2125 sm3/h compressor
model has been selected, then enter the cost information as follows:
1.

For Cost #1 in the Description row, enter the name Material. This row is optional, but can be useful
to provide clarification on the source of the entered cost.

2.

The Cost Type should be specified as Material (NR), which is the default option. Note that NR
denotes a non-recurring cost type, while R denotes a recurring cost type.

3.

We want to use the Compressor Material table specified earlier, so next to Use Size Table select
Table of Costs.

4.

Select the Compressors Material table as the Size Scaling Table. Cost #1 is now complete.

5.

Click New Cost to create a second cost item for the Compressor, and name it Installation.

6.

Choose Installation as the cost type.

7.

Specify Table of Costs for Use Size Table, then set the Size Scaling Table to the Compressor
Installation table. The window should now appear as shown in Figure 6.

Click Save and give the cost library a name. We will use Air Distribution Costs.cst in this case. It is
often useful to give the cost library a similar name to the engineering library to make transferring and
reconnecting the library faster. Once you have finished saving the library, click Close.

Figure 6: Compressor Material and Installation costs assigned using cost tables

Step 4. Create a Cost Library for Pipes
We now have costs for the equipment, but we still need costs for the pipes. Cost data for Steel-ANSI pipe
from 1 to 20 inches are provided in the Excel spreadsheet opened earlier.
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1.

Open to the Edit Cost Library window again from the Library menu.

2.

Click New

3.

From the Available Engineering Libraries list, click Steel – ANSI.

4.

Click Select to choose this library. You should now be on the General tab of the Cost Library window.

5.

In Description, give the new pipe cost library a descriptive but unique name to differentiate it from
the original library created for this model, such as Steel - ANSI Pipe Costs.

6.

Go to the Pipe Materials tab. In the list section, we will be able to view all the sizes and types for
the Steel - ANSI material. Under Sort choose Material, Type or Schedule, Nominal Size so that
they will be sorted by type rather than size.

7.

Expand the Steel - ANSI list, then expand the STD list (Figure 7).

Figure 7: Pipe Materials tab in the Cost Library window showing the properties for the currently selected pipe

If a size from the list is selected, the hydraulic diameter can be viewed, along with a summary of the
material, size and type. The New Cost button will also become active (Figure 7). There are a few methods available when adding the pipe costs. We could individually add the Material and Installation costs
for each pipe size by selecting each size from the pipe materials list, then using the New Cost button to
add these costs to the table individually. Alternatively, the pipe costs can be entered into a template in
excel, then imported to the Cost Library all at once.
In this case, we have the Pipe costs available in a spreadsheet, so we will use the excel import/export
option. To do this we will first export a template for the desired pipe sizes, then we will enter the cost
information in the template and import the updated file as detailed below.
1.

Make sure that the STD pipe material type is highlighted in the list, then click the button labeled
Export to Excel on the right side of the window. The Excel Export window should be shown as in
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Figure 8, with all Steel - ANSI STD pipe sizes displayed.
2.

Click Export, name the sheet, and save it to an easy to find location. The name does not matter,
but we will need to be able to find this spreadsheet later to import back into the cost library.

3.

When Arrow has finished the export, a message will be displayed notifying the user of a successful transfer. Click OK, then browse to the exported worksheet and open it. The exported worksheet should contain a list of the selected pipe sizes, with empty columns where the cost per unit
length can be entered for each cost type, as shown in Figure 9.

4.

Open the Air Distribution Costs - ANS.xlsx spreadsheet with the costs for this example.
Browse to the Pipe Costs tab and copy the Material and Installation costs for the 1 inch to 20 inch
pipe sizes into the worksheet that we just exported. Ensure that data is entered for material and
installation for each of the sizes from 1 to 20 inch, and that the length units are listed as feet in the
worksheet, since these were the length units used by the manufacturer for their pricing. When this
information is added back into the model where lengths are in meters, Arrow ANS will convert the
cost/length information appropriately.

5.

Save and close the worksheet.

Note: The length units used for the spreadsheet are taken from the default model units, which can be
changed from User Options in the Tools menu.

Figure 8: Excel Export window showing pipe items that will be included in the excel sheet
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Figure 9: Initial excel sheet after exporting template for the Steel - ANSI Pipe Costs

Back in AFT Arrow in the Edit Cost Library window, click the Import from Excel button, then browse to the
worksheet we just updated and open it. When the Import has finished click OK on the notification from
Arrow, then click the 1 inch pipe size under the Steel ANSI STD pipe type. The Material and Installation
costs should now be filled in, as shown in Figure 10. Click Save to save the cost library with a unique file
name (i.e. Steel - ANSI Pipe Costs.cst), select Yes to make the library connected, then close the window.
Note: When using the Export/Import features for the cost library, it is not required to enter information
for every size that was exported in order to import the worksheet. It is important to not delete any
headings or descriptive information for the pipe data that was included in the template. Worksheets can be exported /imported as many times as desired, but whatever data is in the spreadsheet will overwrite anything existing in the library, meaning that if the costs are left blank for a
size, any cost information will be deleted for that pipe size in the library. Due to this fact it is
recommended to export the current information in the library first before importing any change
information so that an accidental overwrite does not occur.
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Figure 10: The Pipe Materials tab in the Cost Library window, showing the data recently imported

Step 5. Connect the Libraries
Open the Library Manager from the Library menu. Currently, the engineering library and two cost libraries
should have automatically connected to the current model. In case they are not, we will now need to connect the libraries so that the junctions in the model will be linked to the costs and junctions in the engineering and cost libraries.
If the Air Distribution engineering library, Air Distribution Costs library, and Steel - ANSI Pipe Costs library
are not connected to the model, follow the steps below to connect them.
ØChoose Add Existing Library at the bottom of the Library Manager window, then browse to Air Distribution.dat. Next choose Add Existing Cost Library and browse to Air Distribution Costs.cst then
Steel - ANSI Pipe Costs.cst. This should make the libraries available, and automatically connect them,
as shown in Figure 11.
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Figure 11: The Library Manager with the new cooling system engineering library and its associated equipment costs

Step 6. Define the Automatic Sizing Group
To make use of the newly creating engineering and cost libraries, a few inputs are required in the Sizing
window. Go to this window now.

A. Sizing Objective
Go to the Sizing Objective panel. For the Objective, select Monetary Cost then select Calculate Cost, Do
Not Size.
In the Options to Minimize Monetary Cost section, select the radio button to include Energy in Cost
Report Only. The System Life and Energy Cost sections should now become available. Enter a System
Life of 5 years and an Energy Cost of 0.11 U.S. Dollars Per kW-hr.

B. Size/Cost Assignments
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On the Size/Cost Assignments panel, make sure the Pipes button is selected at the top. Click All on the
bottom left then click Always Include in Cost at the top to add all pipes to the Include in Cost list.
Click the Comp./Fans button at the top to go to the Compressors/Fans size/cost assignments page.
Select the radio button for J2 to Include in Cost Report Only.

C. Assign Cost Libraries
Go to the Assign Cost Libraries panel. All 18 pipes should be assigned to the Steel - ANSI Pipe Costs library. Go to the Comp/Fans page next and select Air Distribution Costs, as shown in Figure 12

Figure 12: Applying the newly built cost library for the compressor on the Assign Cost Libraries panel

Note: Before running the model, be aware that there are no design requirements set for the control
valves. When the solver begins to run, a Model Diagnostics window will appear to inform you
that this may result in control valves adding pressure in order to achieve the setpoint. As you will
see, the control valves will not add pressure, so this message is safe to ignore.

Step 7. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 8. Examine the Output
On the Cost Report, the total cost should be $178,719 as shown in Figure 13. In the Library Sources tab
in the Junction section, the Compressor/Fan should list the Air Distribution Costs library as the cost
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source as shown in Figure 14. The Library Sources in the Pipes section should similarly show the new
pipe cost library for Material and Installation.

Figure 13: Output tab showing the Cost Report
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Figure 14: Output tab showing the current Library Sources used in the model calculations
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Summary
This example focuses on a closed loop cooling system that demonstrates some key features in using
ANS to size a piping system. An existing model is used to investigate four potential sizing cases:
1.

Size system for initial cost with a 5-year operating period

2.

Size system for life cycle cost with a 5-year operating period

3.

Size system for life cycle cost with an initial cost limit for a 5-year operating period

Note: This example can only be run if you have a license for the ANS module.

Topics Covered
l

Connecting and using existing engineering and cost libraries

l

Sizing for Initial or Life Cycle Cost and using Initial Cost Limits

l

Sizing a compressor and sizing piping for the chosen compressor

l

Interpreting Cost Reports

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition, it is assumed that the user has worked through the Beginner: Three Tank Steam System ANS example, and is familiar with the basics of ANS analysis.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Air Distribution - ANS Initial.aro

l

Metric - Air Distribution - ANS Final.aro

l

Air Distribution.dat - engineering library

l

Air Distribution Costs.cst - cost library for Air Distribution.dat

l

Steel - ANSI Pipe Cost.cst - cost library for Steel - ANSI pipes
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Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
Open the Metric - Air Distribution - ANS Initial.aro example file listed above, which is located in the
Examples folder in the AFT Arrow application folder. Save the file to a different folder.

Step 2. Define the Pipes and Junctions Group
The Workspace should appear as shown in the figure below.

Figure 1: Workspace for Air Distribution model

Overview of Sizing Systems with Compressors
A centrifugal compressor can be modeled with either the Compressor Curve or as a fixed flow rate or
pressure/head as the Sizing option. Generally, if a specific compressor has been identified, the Compressor Curve type would be chosen, whereas the Sizing option is useful during the selection stage in
order to identify the compressor requirements for the system. In some cases, even though the specific
compressor has not been chosen, several candidate compressors are available. For this third case it
would be best to model each candidate compressor with a compressor curve using separate scenarios
for each compressor.
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Sizing a Compressor
The compressor in our air distribution case is set as Sizing with a fixed flows of 2125 sm3/h. In order to
allow the compressor to be defined as fixed flow the flow control valve at J12 has been defined at a fixed
pressure drop. This model thus represents a first cut model where, based on the first cut results, the compressor will become an actual compressor with a compressor curve, and control valve J12 will become a
flow control valve controlling to 425 sm3/h, similar to the other control valves.
As already stated, when a compressor is modeled as a fixed flow, it is not a specific compressor from a
specific manufacturer. Thus, the costs for the compressor can only be approximated. To a first approximation, it should be possible to estimate the non-recurring cost (i.e., material and installation cost) for
the pump as a function of power requirements. For instance, a typical ten horsepower compressor (of
specific configuration and materials of construction for a given flowrate) may cost $2700, and a forty
horsepower may cost $8250. Other typical costs for different power requirements can be approximated.
The actual cost for the compressor will, of course, highly depend on the application. These costs are
entered into a cost library and are accessed by the Solver. As AFT Arrow evaluates different combinations of pipe sizes, each combination will require a certain power from the compressor. With a cost
assigned to this power, the ANS module can obtain a cost to enter into the objective which it sizes. Later
in this chapter, we will look at the costs for the compressor in our example air distribution network.
In addition to non-recurring costs, recurring costs can also be estimated. Specifically, the cost of the
power used by the compressor over a period of time (which the ANS module calls the System Life) can
be determined. All AFT Arrow needs is an overall compressor efficiency to determine the actual power
from the ideal power. Again, since we do not have a specific compressor selected yet, the efficiency can
only be approximated. The ANS module calls this the Nominal Efficiency.
Therefore, it is recognized that at this first cut phase the values for nominal efficiency are imprecise and
users may need to go through a few iterations to arrive at satisfactory results.
A step-by-step method of compressor selection proceeds in two phases. The steps are outlined in the
Help System.
For this example, we will be completing the compressor selection process considering the objective of
minimizing initial cost, then minimizing life cycle cost.

Step 3. Define the Automatic Sizing Group
The model is already defined for a regular AFT Arrow run, but we need to complete the sizing settings
before running the analysis. Go to the Sizing window by clicking the Sizing tab.

A. Sizing Objective
The Sizing Objective window should be selected by default from the Sizing Navigation panel along the
bottom. For this analysis, we are interested in sizing the system considering the monetary cost for the initial costs only.
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1.

Select Perform Sizing for this calculation.

2.

For the Objective, choose Monetary Cost and select the Minimize option from the drop-down list if
these options are not already selected.

3.

Under Options to Minimize Monetary Cost, choose Size for Initial Cost, Show Energy Costs. This
will update the cost table to include both initial costs in the sizing calculation, and moves the
Energy costs to be included in the Cost Report so that we can later compare the costs in this scenario to one where the Energy costs are included for the sizing. We do not have any information on
Maintenance cost, so we will leave this cost in Ignore Cost.

4.

Set the System Life to 5 years with 0% interest and inflation rates.

5.

For the Energy Cost area choose Use this Energy Cost Information, with a cost of 0.11 U.S. Dollars Per kW-hr. Note this assumes the pump will run all day, every day, for the entire 5 years.
Alternatively, we could have created an Energy Cost Library, which would be connected in the
Assign Cost Libraries section. An Energy Cost Library allows variable energy costs to be used to
account for varying prices during different times of day, different seasons, etc. For now, we are
simplifying the input by using a fixed cost.

The Sizing Objective window should now appear as shown in Figure 2.
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Figure 2: Sizing Objective panel setup for the initial cost analysis

B. Size/Cost Assignments
On the Sizing Navigation panel select the Size/Cost Assignments button. For this example we are sizing
both the pipes and compressors for a new system, so we will need to calculate and minimize cost for all
related components in the model.
ØClick All under the table to select all of the pipes, then click the Always Include in Cost button next to
Move to. This will move all of the pipe selections to the corresponding column to be sized.

- 892 -

Air Distribution - ANS

To decrease the run time and reduce complexity, as well as to enforce some design uniformity, it is useful
to create Common Size Groups to link the pipes in different sections of the model.
For example, if all the 18 pipes are selected to be Not In Group, then 18 separate pipe sizes will be selected by the automatic sizing engine. That could potentially mean, for example, different pipe diameters in
pipes P9 and P14. If one wanted pipes P9 and P14 to be sized to the same diameter, one would group
them into a Common Size Group. To see how this works, in this model all discharge room piping will be
put into a Common Size Group. What this means is that there will be a single diameter chosen for this
group of pipes, rather than potentially six different diameters.
For this system we will define four groups to be sized in this model. To set the groups, it is standard to
select pipes which must have the same size due to their placement relative to other pipes and junctions,
such as pipes at the entrance and exit of valves. In Figure 3 we have identified these four groups.

Figure 3: Workspace with Common Size Groups shown in different colors

First create a Compressor size group for pipes P1 and P2, which are highlighted in red.
ØClick New above the Pipe Grouping section to create the group, and name it Compressor. Select
the radio buttons under the Compressor heading next to P1 and P2 to add them to the group. Alternatively, the pipes can be selected in the Workspace, then moved to a group by right-clicking the Workspace and selecting the corresponding option from the menu.
Repeat this process for the header piping. We will assume the header will have the same size, so therefore these pipes will have a common size. Like before, create a new group called Header A, and add the
two header pipes on the right side of the system to the new group (pipes P4 and P5).
The headers supplying each room are one physical pipe in the field, represented as multiple pipes in AFT
Arrow by necessity. Create two more groups and add the pipes as listed below and shown in Figure 4.
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1.

Header B = P6 - P8

2.

Discharge = P9 - P18

The completed pipe Size/Cost Assignments can be seen in Figure 4. Note that pipe P3 should be the
only pipe not in a group.
Note: Pipes in the Size/Cost Assignments table can be sorted by Common Size Group instead of sorting by number by clicking on the Pipe Grouping header. Clicking on the header for a particular
group will sort the pipes in that specific group to the top of the window.

Figure 4: Size/Cost Assignments panel with Common Size Groups defined as outlined above

ØClick the Comp./Fans button to switch to the Compressor/Fan Size/Cost Assignments. Select the
option to Include in Cost Report and Sizing for the compressor J2 as shown in Figure 5. The compressor
will now be sized concurrently with the pipes.
Similar to the Common Size Groups for pipes, compressors can be placed into Maximum Cost Groups
based on monetary cost. If compressor costs are added to a Maximum Cost Group, the ANS module will
determine the compressor in the group with the maximum costs, and set all compressors in the group to
use the largest cost. In this case there is only one compressor, so this option is not available.
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Figure 5: Size/Cost Assignments panel defined for the compressor

Now go to the Workspace window. It is possible to inspect the Common Size Groups in the model by coloring the pipes. From the View menu, select All under Color Size Groups. The model should appear as
shown in Figure 3, though the colors may be different.

C. Candidate Sets
Click on the Candidate Sets button to open the Candidate Sets panel.
Create a new Candidate Set for all Steel - ANSI pipes between 2" and 10" in diameter. Click the New button, and name the Candidate Set STD Steel 2" - 10". Choose Steel - ANSI as the pipe material library,
STD as the Material Type, and add all pipes from 2" to 10" in size.
In the bottom section of the window, check that each of the Common Size Groups and pipe P3 have been
assigned to use the existing Candidate Set. The window should appear as shown in Figure 6.

- 895 -

Air Distribution - ANS

Figure 6: Candidate Sets panel fully defined for the model

D. Design Requirements
Select the Design Requirements button from the Navigation Panel.
For this model we have multiple requirements for the system:
l

All pipes have a maximum velocity of 45 meters/sec

l

All control valves must have a minimum pressure drop of 14 kPa

l

All discharges must receive a minimum flow of 425 sm3/h

Define and assign the first requirement listed above as a Pipe Design Requirement as shown in Figure 7,
and apply it to each of the pipes.
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Notice that we have accounted for the minimum flow requirement in this system by using flow control
valves in each discharge line. By using assigned flow compressor and flow control valves we have incorporated the necessary flow rate as a boundary condition, so we do not need to apply a Design Requirement to account for the second item.
For flow control valves J10, J11, J13, and J14, define and apply the minimum pressure drop requirement
in the Control Valves section as shown in Figure 8. Note that for compressor sizing purposes as discussed earlier control valve J12 has been defined as a Constant Pressure Drop valve, so the pressure
drop Design Requirement does not need to be applied to this valve.

Figure 7: Design Requirements panel for pipes
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Figure 8: Design Requirements panel defined for the control valves

E. Assign Cost Libraries
Select the Assign Cost Libraries button. For this model the engineering and cost libraries have already
been created, but we will need to connect and apply them.
Note: The Creating Libraries for Sizing a System example provides instructions on how to build the libraries for the first part of this example, and may be completed later for practice with creating libraries. The provided pre-built libraries will be needed to obtain the compressor curve data for
Step 10 of this example.
ØOpen the Library Manager by clicking the Library Manager button to see which libraries are connected. The AFT INTERNAL LIBRARY, LOCAL USER LIBRARY, and Pipe Material libraries should be
available and connected by default. Available libraries will be shown based on libraries that Arrow has
identified on your machine. The default connected libraries will be visible here, and additional libraries
may be visible from other example files, or from libraries previously built and used on your machine.
This example uses one user-defined engineering library, Air Distribution.dat, which contains the data
for the compressor. There are also two cost libraries, Air Distribution Costs.cst and Steel - ANSI Pipe
Costs.cst, which contain the cost data for the junctions and the pipe materials, respectively. Air
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Distribution Costs.cst was built off of the engineering library Air Distribution.dat, and Steel - ANSI
Pipe Costs.cst was built off of the Steel - ANSI Pipe Material library. To connect these libraries, do the
following:
1.

Click the button to Add Existing Library.

2.

Browse to the AFT Arrow 9 Examples folder (located by default in C:\AFT Products\AFT Arrow
9\Examples\), and open the file titled Air Distribution.dat.

3.

Repeat the above steps, but choose Add Existing Cost Library to browse for Air Distribution
Costs.cst, then Steel - ANSI Pipe Costs.cst.

Note that it may be possible that the model file already has the cooling system libraries connected, in
which case you will be notified that the library you are trying to add is already available. If the libraries are
available, you will simply need to connect them by checking the box next to the library name for each of
the three libraries.
Once these steps have been completed, you should now see that the new libraries have been added to
the Available Libraries list, and have been automatically connected to the model, as shown in Figure 9 for
the junction libraries. The junction libraries appear with the names Air Distribution, Air Distribution Costs,
and Steel - ANSI Pipe Costs.
Note: When a library is selected in the Library Manager, the filename and location can be viewed in
the Selected Library Information. Library names can be different from the given filename.
Once you have confirmed that the necessary libraries are connected, click Close to exit the Library Manager.
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Figure 9: Library Manager with Air Distribution libraries connected

Since we are connecting a pre-built library, we will need to take an additional step to make sure that the
compressor in the Workspace is linked to the Air Distribution engineering library that we added.
1.

Go to the Workspace, and open the compressor (junction J2)

2.

From the Library Jct list, select Fixed Flow 2125 sm3/h. None of the input should change, as this
library item is identical to the existing pump. However, AFT Arrow will now recognize that this junction is connected to the engineering and cost library for this compressor.

We have now re-connected the junctions that will be considered for the Cost Report and sizing calculations to the engineering library. This is important, since a junction must be connected to an engineering library before cost information can be assigned to it. Let's now return to the Sizing window.
Back in the Assign Cost Libraries panel for the Pipes, the Steel - ANSI Pipe Costs library should be the
only visible cost library, since it is the only connected library for the pipe sizes in the Candidate Set. Make
sure that the library is checked to be applied for the model as shown in Figure 10.
ØClick on the Comp./Fans button to view the cost library assignments for the compressor. The only
visible library should be the Air Distribution Costs library, as this was the only cost library connected for
the associated engineering library. Make sure that the checkboxes are selected under the library name
so that the cost data will be applied for the compressor (Figure 11).
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Figure 10: Assign Cost Libraries panel for pipes

Figure 11: Assign Cost Libraries panel for compressors

F. Sizing Method
Select the Sizing Method button to go to the Sizing Method panel.
Ø Choose Discrete Sizing, if not already selected, since it is desired to select discrete sizes for each of
the pipes in the model.
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For this model we have five independent pipe sizes as noted on the Size/Cost Assignments panel (four
groups and pipe P3), and two design requirements (one pipe design requirement applied to all of the
pipes, and a minimum pressure drop applied to four control valves). Due to the small number of independent sizes, it would be recommended to try the MMFD or SQP search method. Though it is not shown
here, if both methods are run for this scenario the same solution will be obtained, though the Sequential
Quadratic Programming (SQP) Method is slightly faster.
ØSelect Sequential Quadratic Programming (SQP) for the sizing method.

G. Sizing Summary
From the Sizing Navigation Panel select the Sizing Summary button.
The Sizing Summary panel allows the user to view all of the sizing input for the model in a tree view layout, which is shown in Figure 12. Items can be organized by sizing parameters (Design Requirements,
Candidate Sets, etc.), or information can be viewed based off an individual pipe. For clarity these categories can be shown/hidden using the check boxes at the top of the panel.
Each tree node can be expanded/collapsed individually by using the ‘+’ and ‘-‘ buttons on the node.
Alternatively, the buttons on the bottom of the panel can be used to collapse/expand all items. Right-clicking on the nodes provides additional options to collapse/expand items, view related nodes, or to copy
information to the clipboard. The Sizing Summary panel can be printed from the printer button at the bottom of the panel.
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Figure 12: Sizing Summary panel layout with the Size/Cost Assignments expanded. The number of children
nodes for each item can be seen in parentheses.

Step 4. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 5. Examine the Output
The Cost Report is shown in the General Section of the Output window (see Figure 13). The ANS module shows all costs in the Cost Report, including those that were not used in the automated sizing. The
total cost for this system is $198,056. This includes all costs over five years. The initial cost, which was
the basis for the automated sizing, was the total of the material and installation ($69,555). This total is listed as the total for the Items in Sizing line, since it was specified to only include the Initial Cost for material
and installation on the Sizing Objective section. Individual items that were included in the automated sizing have their costs highlighted in green.
Other costs that are displayed in the Cost Report are Items Not in Sizing. These are items that have costs
associated with them, but were not included in the automated sizing.
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Note that the Items Not in Sizing total to $128,501. Looking across at the subtotal one can see that all of
this cost is in energy (i.e., compressor power costs). The total cost is the sum of the two. For the next
scenario this cost will be included in the automated sizing as a comparison.

Figure 13: The Cost Report in the Output window shows the total and individual costs (in thousands of U.S.
Dollars) for the sized system

In the Pipes section of the Output window the final pipe sizes from the automated sizing can be seen,
along with the Design Requirements status. For this model, the final system used pipe sizes varying from
2-1/2 to 6 inches, as seen in Figure 14. The information for the compressors can be seen in the Compressor/Fan Summary tab in the General Section, which is also shown in Figure 14.
When a monetary cost objective is selected, additional tabs are available that display the Library Sources
used for the Cost Report for each of the pipes/junctions. In this case both the Pipe Material and Pipe
Installation costs for all of the pipes came from the Steel - ANSI Pipe Costs library which was connected
earlier. Information for the compressor came from the Air Distribution Costs library. If multiple cost libraries are used for a category they will all be listed separated by commas. The Library Sources for the
Pipes can be seen in Figure 15.
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Figure 14: Compressor and Pipe Sizes after automated sizing is performed
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Figure 15: Library Sources for the pipes and compressor in the Cost Report

On the General tab of the Output window at the bottom of the report, the initial cost of the items included
in the sizing can be seen, which was $110,156 for this design, showing that the initial costs were reduced
by about 37% from the initial design. We can also see that the initial design was feasible, meaning all of
the design requirements were met (Figure 16).
Though not shown here, if the model is run using the objective to Calculate Costs, Do Not Size, it can be
seen that the total cost for the system before sizing was $178,719, which is actually less than the system
that has been sized for initial costs. This is due to the fact that the larger pipe sizes in the initial system
allowed for lower energy costs over the 5 year system life. This system is weighted towards energy costs,
so any change in the energy costs will have a larger impact on the overall life cycle cost than the material
and installation costs.
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Figure 16: General section of Output window showing initial status of Items in Sizing

Step 6. Size the System for Life Cycle Cost over Five Years
From the Scenario Manager in the Quick Access Panel, we will create two children scenarios. With the
base scenario selected, right click and choose Create Child. Name the new scenario Initial Cost. This
scenario will store the initial cost sizing results we just obtained. Repeat this process to create a second
child scenario, and name it Life Cycle Cost. For this scenario the only change that will need to be made is
to update the Sizing Objective.
Go to the Sizing window, and make sure that the Sizing Objective button is selected. Under Options to
Minimize Monetary Cost, choose Size for Initial and Recurring Costs. This will move the Energy costs
selection to Include in Sizing Objective. The scenario is now complete.
ØClick Run from the Analysis menu to run the automated sizing. When the calculations have finished,
click Output to view the results.

Step 7. Examine the Output
After viewing the Cost Report, it can be seen that the overall cost is now $166,343. The Items Not in Sizing line now has a value of zero, and the Energy columns are highlighted green, reflecting the changes
made to include these costs in the objective to minimize monetary cost. The Cost Report is shown in Figure 17.
Taken on its own, this new cost represents a savings of about $32,000 over the Initial cost scenario
which was sized based on Initial Cost only. This represents a 14% cost reduction. In the initial cost scenario, the non-recurring cost was $69,555, while the overall cost was $198,056. Now the non-recurring
cost is $92,464 while the overall cost is $166,343. The initial cost thus increased by about $23,000 in
order to reduce the operating cost from $128,501 to $73,879 (a reduction of about $55,000). The source
of the operating cost is the cost of power for the compressors. To reduce compressor power usage, it
makes sense to increase the pipe size and thus reduce frictional losses. The larger pipe sizes can be
reviewed by looking at the Sizing tab in the Pipe Output section, as shown in Figure 18.
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Considering this cost breakdown between the scenarios highlights the importance of choosing to include
the energy costs in the initial cost scenario. If they were not in the Cost Report of the initial cost scenario,
the total cost would be $69,555. Since the life cycle cost scenario total cost is 2.5 times larger, it would
appear (at first glance) to be a significant cost increase. However, this would be misleading, since the
energy costs still exist in both scenarios, though they are only being minimized in one case. To get a
clear comparison between designing for initial cost and life cycle cost one needs to make an apples-toapples comparison, including all relevant costs in each case, as is done for this example.
By performing both analyses the designer has quantitative data on the impact of initial cost design on
operational costs of the system, and can make an informed design choice.

Figure 17: Cost Report for the network after sizing for life cycle cost
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Figure 18: Compressor and Pipe Sizes after automated sizing is performed for life cycle cost

Step 8. Size the System for Life Cycle Cost with Initial Cost Limit
While the energy cost savings from life cycle cost sizing are desirable, the budget for the project may not
support the higher initial cost that is required. In that case, we can apply an initial cost limit to the life cycle
cost sizing.
Clone the Life Cycle Cost scenario. Name the scenario Initial Cost Limit.
ØReturn to the Sizing Objective panel and select the option for Initial Cost Limit. We will set the limit
as $82,500 which is approximately an initial cost reduction of 25% from the original (un-sized) design.
Run the model and go to the Output tab.
A summary of the results with the initial cost limit compared to each of the initial and life cycle cost sizing
scenarios for a five year life cycle can be seen in Table 1. Notice that while the material and installation
costs were similar to the costs from the initial cost scenario, the energy costs were decreased by about
$10,000. These energy costs were achieved by increasing the compressor pipe sizes, while decreasing
the header pipe sizes to achieve a better efficiency in the compressor. Table 2 shows a comparison of
the pipe sizes throughout the system for the original design, and each of the sizing scenarios.
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Table 1: Cost Summary of Sizing Runs for the Air Distribution System

Scenario

Material

Installation

Non-Recurring Sub
Total

Energy

Total

Not Sized

67,223

42,933

110,156

68,563

178,719

Initial Cost

42,256

27,298

69,555

128,501

198,056

-20,000

Life Cycle
Cost

57,248

35,216

92,464

73,879

166,343

12,400

Initial Cost
Limit

44,929

27,849

72,778

118,285

191,063

-12,300

Reduction

Table 2: Summary of final pipe sizes for Common Size Groups in the Air Distribution System

Scenario

Compressor

Header A

Header B

Discharge

Pipe P3

Not Sized

6 inch

6 inch

6 inch

3 inch

6 inch

Initial Cost

6 inch

4 inch

4 inch

2-1/2 inch

4 inch

Life Cycle
Cost

8 inch

5 inch

5 inch

4 inch

5 inch

Initial Cost
Limit

8 inch

4 inch

4 inch

3-1/2 inch

4 inch

Step 9. Automated Sizing with Compressor Curve Data
As discussed in the previous section summarizing the compressor selection process, once the compressor is sized then actual compressors can be modeled. The actual compressor should closely match
the sizing results in the following areas: generated pressure at the design flow, efficiency at the design
flow, and cost. Let's apply actual compressor data for the case that was sized for life cycle cost with an initial cost limit to complete phase two of the compressor selection process above.
Reviewing the results for the life cycle cost with initial cost limit scenario one can see that the sized system calls for a compressor of about 25 kW that generates about 36.7 kPa of pressure at 2125 sm3/h. The
nominal efficiency used in the sizing part of the analysis was 80%. The material cost for such a compressor was about $4,800, and the installation cost was about $2,400. Note that if no actual compressor
can be found that reflects these requirements, then the phase 1 of the compressor selection process
described above should be repeated with better performance and/or cost data for the compressor.
Based on the sizing analysis, we will choose a compressor from the (fictitious) PowerFlow Compressor
Company. Its model JW120 is a close match for the requirements of a 5-year life cycle design. The model
JW120 has the following characteristics: at 2125 sm3/h its pressure is 38.6 kPa and efficiency is 80%. Its
material cost is $5,800 and installation cost is $2,400. To setup a new scenario for the system with the
candidate compressor data:
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In the Scenario Manager clone the Initial Cost Limit child scenario and name it Actual Compressor Curve.
In the new scenario, open the properties window for compressor J2 select PowerFlow Compressor
JW120 from the Library Jct list to import the compressor data from the library as shown in Figure 19, then
click OK.
In the Flow Control Valve Property window for J12, change the Valve Type to Flow Control (FCV), and
enter a Flow Setpoint of 425 sm3/h. Now that we have changed the control valve model, we will need to
apply a Design Requirement in order to account for the minimum pressure drop.
Go to the Sizing window, then navigate to the Design Requirements panel. Select the Control Valves button at the top of the window.
Apply the Min Pressure Drop design requirement to Control Valve J12.

Figure 19: Compressor Properties window with the Rocky Mtn Compressor Co 100XLC library item selected

The necessary changes are now complete to size the system with the updated compressor and flow control valve data.
ØSelect Run from the Analysis menu to perform the automated sizing. When the solver has finished,
click Output to review the results, as can be seen in Figure 20.
The Cost Report shows a total sized cost of $196,889. Comparing the final pipe sizes to the Initial Cost
Limit scenario shows the pipe sizes and compressor operating point are similar.
Now we have sized the system for use with an actual compressor.
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Figure 20: Cost Report for system with actual compressor and FCV data sized for five year life cycle cost
with initial cost limit
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Summary
Some system designs have multiple operating conditions to satisfy. For instance, the air distribution system discussed in the previous example may have a requirement that it operate with one of the discharge
valves closed. This can be modeled in the ANS module by taking advantage of its ability to model multiple systems concurrently.
Note: This example can only be run if you have a license for the ANS module.

Topics Covered
l

Using Dependent Design Cases

l

Using Duplicate Special to create Dependent Designs

l

Understanding fractional compressor costs with Dependent Design Cases

l

Specifying Multiple Dependent Design Cases

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition, it is assumed that the user has worked through the Beginner: Three Tank Steam System ANS example, and is familiar with the basics of ANS analysis.
This example is an addendum to the Concurrently Sizing a Compressor and System - ANS example, but
can be worked separately from the example.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Air Distribution - ANS Initial.aro

l

Metric - Air Distribution - ANS Final.aro

l

Air Distribution.dat - engineering library

l

Air Distribution Costs.cst - cost library for Air Distribution.dat

l

Steel - ANSI Pipe Cost.cst - cost library for Steel - ANSI pipes
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Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
Open the Metric - Air Distribution - ANS Initial.aro example file listed above, which is located in the
Examples folder in the AFT Arrow application folder. Save the file to a different folder. Complete the
steps in the example Concurrently Sizing a Compressor and System - ANS until the Life Cycle Cost
scenario is completed. Clone this scenario and name it Dependent Design Case.
Alternatively, open the Metric - Air Distribution - ANS Final.aro example file. Right-click the Life Cycle
Cost scenario and select Save Scenario to File Without Children. Save the scenario to a new location
then open this new model file. Create a child from the base scenario and name it Dependent Design
Case.

Step 2. Define the Pipes and Junctions Group
The Workspace should appear as shown in the figure below.

Figure 1: Workspace for Air Distribution model
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Step 3. Enable Dependent Design
When modeling multiple design cases, the different cases need to be broken up into a primary design
case, of which there is one, and dependent design cases, of which there can be any number.
The primary design case can be any of the design cases that are being addressed in your model. Typically, it will represent the primary operating condition of the pipe system. The dependent design cases
represent the same physical operating system but are used to represent differing operating conditions. If
it is not clear which case should be the primary case, just pick any of the cases and call that the primary
one. Design cases other than the primary case are referred to as dependent design cases. The reason
why we choose a primary case and refer to the other cases as dependent cases will become clearer as
we progress through this topic.
For this example, the primary design case is the system running with all discharge valves open. We want
to also consider the case where one discharge is closed. The one discharge closed case will be created
as a dependent design case.
To start creating the dependent design case, we will first need to enable the Dependent Design Case
modeling:
ØGo to the Sizing Objective panel and select the Enable Dependent Design Cases option. A new button will now be available for the Dependent Design Cases panel in the Sizing Navigation Panel, as can
be seen in Figure 2.
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Figure 2: Dependent Design Cases are enabled from the Sizing Objective panel

Step 4. Set up the Dependent Design Case

A. Use Duplicate Special
The easiest way to set up a dependent design case is to use Duplicate Special, which will allow us to
make an exact duplicate of the model in order to set up the additional operating cases. Note that you
should fully define the model and all of the sizing settings for the primary case before creating the dependent cases, as has been done in this model.
To create the dependent design case:
1.

Make sure that the scenario where the dependent cases will be created is loaded. In this case,
you should have the Dependent Design Case scenario loaded.

2.

Go to the Workspace window.
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3.

Choose Select All from the Edit menu, or use CTRL+A.

4.

Choose Duplicate Special from the Edit menu (see Figure 3).

5.

Choose an increment for the pipe and junction numbers. The number should be large enough to
avoid conflicts with numbers used for other pipes and junctions in this and all other scenarios. In
this case use 100.

6.

Select the Make Dependent Design Case check box.

7.

Click OK and move the duplicated version of the primary design case to an open area in the Workspace. The model should now appear similar to Figure 4.

Note that Duplicate Special also allows you to do the following:
l

Create a group for the dependent design case. This can simplify managing the pipe and junction
objects in the design case.

l

Hide the pipe and junction in the output. You may want to do this for reasons to be discussed later
in this topic.

l

Keep Common Size Groups. This feature is useful when using Duplicate Special for reasons other
than dependent case creation, and can't be used when making a dependent design case.

l

Clear the Design Requirements. For reasons to be discussed, frequently dependent design cases
will employ different design requirements than the primary design case. This option allows you to
clear all the current requirements, so new ones can be assigned.

Figure 3: Duplicate Special simplifies creation of dependent design cases
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Figure 4: Workspace with the Dependent Design Case created for the Air Distribution model

B. Apply the Dependent Design Requirements
The dependent design case capability takes advantage of the ANS module's ability to run multiple models in the same Workspace. The pipes and junctions in Figure 4 that are numbered greater than 100 (i.e.,
the dependent design case) represent the same pipes and junctions as those numbered less than 100
(i.e., the primary design case). It is therefore critically important that only certain data in the dependent
case is changed.
Frequently the Design Requirements or Special Conditions on the pipes or junctions will be changed.
However, data such as a pipe's length or compressor's performance should never change. The reason is
that once this kind of data is changed, the pipe or junction is no longer the same pipe or junction, and
thus the purpose of the dependent link is invalidated. The ANS module does not prevent changing data
that should not be changed, but when the model is run it will check to make sure all data that should be
the same actually is the same.
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In this example we are analyzing the case where one Discharge Room in the system is shut off, so we
will use Special Conditions on the discharge valve to that room.
Select Control Valve J110 in the dependent case, and use the Special Conditions button
on the Edit
menu to set the junction to Closed. The dependent case should now appear as shown in Figure 5.

Figure 5: Flow off for Discharge Room A1 in the Dependent Design Case

With one valve shutoff we will need to distribute the Fixed Mass Flow Rate of the compressor for the four
Discharge Rooms remaining. That means the new Mass Flow Rate for every Control Valve will be 531.25
sm3/h. The flow requirements for the Control Valves J111, J113 and J114 need to be changed from 425
sm3/h to 531.25 sm3/h. Note that Control Valve J112 will not need to be changed since it is set to a fixed
pressure drop for sizing purposes, and still has the same pressure drop requirement.
ØOpen the Control Valve Properties window for control valve J111 and change the flow setpoint to
531.25 sm3/h, then repeat this for junctions J113 and J114 as discussed above.
Since we have closed control valve J110 it is necessary to remove the minimum pressure drop requirement from this valve so that the results will not be skewed.
ØGo to the Design Requirements panel in the Sizing window and select the Control Valves button.
Un-check the box for the pressure drop requirement next to J110 to remove it from the closed valve as
shown in Figure 6.
For this scenario we also want to change the Sizing Method, since the Modified Method of Feasible Directions was determined to be the most efficient for this model.
ØClick the Sizing Method panel button in the Sizing Navigation panel, then select the Modified
Method of Feasible Directions (MMFD) from the Search Method list.
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The Dependent Design case is now complete, since it has inherited the rest of its sizing settings from the
primary case. Select Run from the Analysis menu and got to the Output window to view the results once
the run is complete.

Figure 6: Control Valve Design Requirements adjusted for the Dependent Design Case

Summary
The following summary Table 1 was compiled for the two scenarios. It can be observed that when the
dependent design case is included in the sizing, the cost increases by approximately 3%. With one
exception, it is not possible for a model that includes a dependent design case to yield a better design
than the primary case alone. At best, it can yield the same design, such as in this scenario. This is due to
the fact that the dependent design case imposes additional restrictions on the solution by adding additional design requirements. If the design for the primary design case is not sufficient for the dependent
design case, then the design must be changed, which will increase cost in some manner. In this case the
pipe sizes needed to be increased to account for the additional load when one discharge valve is closed.
The pipe sizes for the Dependent Design Case scenario can be seen in Figure 7.
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Table 1: Summary of Sizing Runs for Air Distribution system

Scenario

Life Cycle
Cost

Dependent
Design Case

Meets all
Requirements

Yes

Yes

Material

$57,248

$60,988

Installation

$35,216

$37,635

Operation

$73,879

$73,879

Total

$166,343

$172,501

Figure 7: Pipe size results for the system with the dependent design case included
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Summary
This example will show how to use the ANS module to size a system based on pipe weight to deliver a
minimum flow of helium for variable inlet temperature.
Note: This example can only be run if you have a license for the ANS module.

Topics Covered
l

Sizing using pipe weight

l

Creating Common Size Groups

l

Using dependent design cases to satisfy two different operating modes for a system

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition, it is assumed that the user has worked through the Beginner: Three Tank Steam System ANS example, and is familiar with the basics of ANS analysis.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Helium Transfer - ANS Initial.aro

l

Metric - Helium Transfer - ANS Final.aro

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
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Open the Metric - Helium Transfer - ANS Initial.aro example file listed above, which is located in the
Examples folder in the AFT Arrow application folder. Save the file to a different folder. The Workspace
should look like Figure 1 below.
In this system, Helium flows from one tank to two other delivery tanks. Throughout the year its inlet temperature varies from 0 to 38 deg. C. There is a minimum flowrate required to each tank of 1.1 kg/sec.
Since the supply temperature can vary we will analyze two different design cases, one for the maximum
temperature (Hot Case), and one for the minimum temperature (Cold Case). We are using the Hot Case
as our primary design, so the model inputs currently reflect the Hot Case. We will need to first define the
sizing settings for the primary case, then set up the secondary case using the cold temperatures.

Figure 1: Model layout for normal system operation

Step 2. Define the Modules Group
Navigate to the Modules panel in Analysis Setup. Check the box next to Activate ANS. The Network
option should automatically be selected, making ANS enabled for use.

Step 3. Define the Automatic Sizing Group
To define the Automatic Sizing group, go to the Sizing window by clicking on the Sizing tab.

A. Sizing Objective
Go to the Sizing window by selecting the Sizing tab. The Sizing Objective window should be selected by
default from the Sizing Navigation panel along the bottom. For this analysis, we are interested in sizing
the system considering the monetary cost for the initial costs only.
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1.

Select Perform Sizing for this calculation.

2.

For the Objective, choose Pipe Weight, and select the Minimize option from the drop-down list if it
is not already selected.

The Sizing Objective window should now appear as shown in Figure 2.

Figure 2: Sizing Objective panel setup to minimize pipe weight

B. Sizing Assignments
On the Sizing Navigation panel select the Sizing Assignments button.
For this system we will be sizing all of the pipes since it is a new system.
ØMove each of the pipes to Always Include in Weight.
The piping to each of the discharge tanks in the system will be identical, so a Common Size Group will
need to be created to link the sizes in the two pipes.
Above the Pipe Grouping table select New, then give the group the name Discharge Pipes. Select the
radio buttons to place pipes P2 and P3 in the Common Size Group.
The completed pipe Sizing Assignments can be seen in Figure 3.
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Figure 3: Sizing Assignments fully defined for the model

C. Candidate Sets
Click on the Candidate Sets button to open the Candidate Sets panel.
For this system it is desired to use STD Steel - ANSI. To create a Candidate Set, do the following:
1.

Under Define Candidate Sets, click New.

2.

Give the set the name STD Pipes and click OK.

3.

From the drop down list choose Steel - ANSI.

4.

In the Available Material Sizes and Types on the left, expand the STD pipe sizes list.

5.

Double-click each of the sizes from 1 to 10 inches to add them to the list on the right.

6.

In the Select Pipe Sizes window, click OK.

We now need to define which pipes will use this Candidate Set during the sizing calculation. Select the
radio buttons next to pipe P1 and the Common Size Group to assign the Candidate Set to each of the
pipes, as shown in Figure 4.
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Figure 4: Candidate Sets panel fully defined for the model

D. Design Requirements
Select the Design Requirements button from the Navigation Panel.
For this system there is only one Design Requirement, which is the requirement to maintain a minimum
flow of 1.1 kg/sec into each of the discharge tanks. To define this requirement:
1.

Click New under Define Pipe Design Requirements.

2.

Enter the name Minimum Flow.

3.

Select Mass Flow Rate as the Parameter.

4.

Choose Minimum for Max/Min, and enter 1.1 kg/sec.

Now we need to apply the defined Design Requirement to the discharge pipes.
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ØCheck the box next to Discharge Pipes in the Assign Design Requirements to Pipes section. The
Design Requirements panel should now appear as shown in Figure 5.

Figure 5: Design Requirements panel for pipes

E. Assign Cost Libraries
When the Sizing Objective has been defined as monetary cost, it is necessary to create and assign cost
libraries for the automated sizing, which can be done in the Assign Cost Libraries panel. Since we have
defined the objective as Pipe Weight, we will not need to assign any cost libraries, and this button is disabled.

F. Sizing Method
Select the Sizing Method button to go to the Sizing Method panel.
Ø Choose Discrete Sizing, if not already selected since it is desired to select discrete sizes for each of
the pipes in the model.
This model is relatively simple, so the default, Modified Method of Feasible Directions (MMFD), should
be sufficient. Ensure that this method is selected from the list of Search Methods.

G. Dependent Design Cases
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We have now set up the system to be sized for the primary design case, but we will also need to account
for the cold case where the system is operating at the minimum inlet temperature. To do this we will create a dependent design case by completing the following steps:
1.

Go to the Sizing Objective panel and select the Enable Dependent Design Cases option. A new
button will now be available for the Dependent Design Cases panel in the Sizing Navigation panel.

2.

Navigate to the Dependent Design Case panel. You should now see instructions displayed to create Dependent Design Cases, along with a summary table of dependent design settings. We will
now need to use the Duplicate Special feature to create the dependent design cases.

3.

Go to the Workspace and choose Select All from the Edit menu.

4.

Open Duplicate Special (from the Edit menu), enter an increment of 10 and select Make Dependent Design Case (Figure 6). Click OK.

5.

Move the duplicated pipes and junctions to distinguish them from the original ones from the
Primary Design Case. The Workspace should now appear as shown in Figure 7.

6.

In the Cold Case inlet tank J11, open the Tank Properties window and change the temperature to
0 deg. C.

Return to the Dependent Design Cases panel.
When Duplicate Special was performed with Dependent Design Case selected, each of the duplicated
pipes was created with a special type of grouping. For example, pipe P11 is grouped with pipe P1 as a
DDC pipe (see Figure 8). This type of assignment allows the dependent design pipes to be sized, but to
not be counted in the cost so that the cost will not be duplicated.
It should also be noted that the dependent design grouping causes each of the dependent pipes to inherit
their Common Size Groups, Candidate Sets, and Cost Library settings (if applicable) from the pipes in
the primary case. The dependent design case pipes are therefore hidden on all sizing panels except for
the Design Requirements and Dependent Design Cases panels.

Figure 6: Duplicate Special settings to create a dependent design case
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Figure 7: Workspace with dependent design case after duplication

Figure 8: Pipes in Dependent Design Cases have a special grouping relationship with pipes in the primary
case
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Step 4. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 5. Examine the Output
After the run finishes, examine the final pipe sizes calculated by the ANS module. The results for pipe
size and overall cost are shown in Figure 9. It can be seen that the 5 inch and 3 inch pipe sizes were
chosen for the header and discharge pipes, respectively. The overall weight of the system is 10,062 kg.

Figure 9: Final pipe sizes and Cost Report for the Helium Transfer system considering the hot and cold cases

Conclusion
By creating a dependent design case both the hot and cold temperature operating cases were able to be
taken into account in the automated sizing for this simple system. In more complex systems additional
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dependent cases could be created to consider various system configurations as well as further operating
conditions.
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Summary
This example will size the pipes for a natural gas supply system to five burners. It is desired to analyze
two separate design cases using monetary cost automated sizing.
Note: This example can only be run if you have a license for the ANS module.

Topics Covered
l

Sizing using monetary cost

l

Using dependent design cases to satisfy two different operating modes for a system

l

Understanding the effect of monetary vs. non-monetary sizing objectives

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition, it is assumed that the user has worked through the Beginner: Three Tank Steam System ANS example, and is familiar with the basics of ANS analysis.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Natural Gas Burner - ANS Initial.aro

l

Metric - Natural Gas Burner - ANS Final.aro

l

Steel - ANSI Pipe Costs.cst - cost library for Steel - ANSI pipes

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
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Open the Metric - Natural Gas Burner - ANS Initial.aro example file listed above, which is located in
the Examples folder in the AFT Arrow application folder. Save the file to a different folder. The Workspace should look like Figure 1 below.

Figure 1: Natural Gas Burner model layout in Workspace

Step 2. Define the Modules Group
Navigate to the Modules panel in Analysis Setup. Check the box next to Activate ANS. The Network
option should automatically be selected, making ANS enabled for use.

Step 3. Define the Automatic Sizing Group
For this system we will be sizing the natural gas system for two different operating cases, one with all
burners running and one with the third burner closed. When modeling multiple design cases, the different
cases need to be broken up into a primary design case, of which there is one, and dependent design
cases, of which there can be any number.
The primary design case can be any of the design cases that are being addressed in your model. Typically, it will represent the primary operating condition of the pipe system. If it is not clear which case
should be the primary case, just pick any of the cases and call that the primary one. Design cases other
than the primary case are referred to as dependent design cases. This naming convention is used since
the dependent design cases are built and defined by duplicating the primary design case, as will be discussed later. The case with all burners on will be used as the primary design case.
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To start we will set up the sizing settings for the primary design case, after which we will set up the
dependent design case.

A. Sizing Objective
The Sizing Objective panel should be selected by default. For this analysis, we are interested in sizing
considering the monetary cost for the initial costs only.
1.

Set the Sizing Option to Perform Sizing.

2.

For the Objective, choose Monetary Cost, and select the Minimize option from the drop-down list.

3.

Under Options to Minimize Monetary Cost, choose Size for Initial Cost. This will update the cost
table to include both initial costs in the sizing calculation while ignoring the recurring costs.

The Sizing Objective window should now appear as shown in Figure 2.
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Figure 2: Sizing Objective window setup for an Initial Cost analysis

B. Size/Cost Assignments
On the toolbar at the bottom of the window select the Size/Cost Assignments button.
For the supply lines P1 and P2, the pipe size is fixed to 6 inches and will not be sized. However, we will
still need to purchase these pipes, so we will consider their cost. The rest of the pipes in the system will
need to be sized for the design.
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The 4 header pipes (P3, P4, P5, P6) represent a single header in the physical system, so it will be necessary to add them to a Common Size Group. A second Common Size Group should be created to contain
all of the discharge piping (P7 - P16), as each of the branches to the burners should be identical. To set
up the Size/Cost Assignments as described, do the following:
1.

Move pipes P1 & P2 to Do Not Size – Include in Cost in the table. This will calculate their cost
while keeping their size fixed.

2.

Select pipes P3 - P16 in the table by holding SHIFT to select multiple rows, then click the Always
Include in Cost button to move them to the appropriate column to be sized.

3.

Now that the pipes have been set to be sized, the Common Size Groups need to be created.
Select New above the Pipe Grouping table to create two new groups and give them the names
Headers and Distribution.

4.

Add pipes P3 - P6 to the Headers group using the radio buttons. Alternatively, they can be added
by selecting the pipes in the Workspace then right-clicking and choosing the appropriate option to
add them to the group.

5.

Add pipes P7 - P16 to the Distribution group either by using the radio buttons in the table, or from
the Workspace.

The Size/Cost Assignments table should now appear as shown in Figure 3.

Figure 3: Size/Cost Assignments window with Common Size Groups defined as outlined above

C. Candidate Sets
Click on the Candidate Sets button to open the Candidate Sets window. In this case we will be considering schedule 40 steel pipe within the range of 1" - 12".
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1.

Select New, and name the Candidate set Steel Sch 40.

2.

Choose Steel - ANSI from the material list.

3.

Expand the STD type, then double click each of the sizes from 1 inch to 12 inch to add them to the
Candidate Set.

4.

Click OK to accept the defined set.

In the bottom section of the window make sure that the Common Size Groups are assigned to use the
new Steel Sch 40 Candidate Set. The window should appear as shown in Figure 4.

Figure 4: Candidate Sets window fully defined for the model

D. Design Requirements
Select the Design Requirements button.
In the primary design case the following requirements need to be met:
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1.

The flow to the burners must remain below the maximum velocity requirement of 60 meters/sec.

2.

All control valves must have a minimum pressure drop of 1.7 bar.

Make sure that the Pipes button is selected, then create a new Design Requirement named Max Velocity
specifying the Velocity Outlet Maximum of the pipe is 60 meters/sec. In the bottom section of the window,
make sure that the velocity design requirement is applied to each of the discharge lines to the burners
(P12 - P16). The Pipe Design Requirements should now appear as shown in Figure 5.
Next select the Control Valves button at the top of the window and create a new control valve Design
Requirement. Name the Design Requirement Min Pressure Drop, and specify the Pressure Drop Static
as a Minimum of 1.7 bar. In the bottom section apply the Design Requirement to each of the control
valves in the model (Figure 6).

Figure 5: Pipe Design Requirements defined for the primary design case
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Figure 6: Control Valve Design Requirements defined for the primary design case

E. Assign Cost Libraries
Select the Assign Cost Libraries button. For this model the pipe cost library has already been created, but
we will need to connect and apply it.
ØOpen the Library Manager by clicking the Library Manager button to see which libraries are connected.
This example uses a pre-built cost library for the pipes containing the Steel material costs. To connect
the library do the following:
1.

Click the button Add Existing Cost Library.

2.

Browse to the AFT Arrow 9 Examples folder (located by default in C:\AFT Products\AFT Arrow
9\Examples\), and select the file titled Steel - ANSI Pipe Costs.cst.

The new library should now be visible in the Available Libraries list, be automatically connected to the
model, as shown in Figure 7. The cost library for the pipes should appear with the name Steel - ANSI
Pipe Costs and be indented under the Steel - ANSI library within the standard pipe material libraries list.
Once you have confirmed that the library is connected, click Close to exit the Library Manager.
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Back in the Assign Cost Libraries panel for the Pipes the Steel - ANSI Pipe Costs library should be the
only available cost library, and should be selected to show that it is being applied to the candidate sets
and to each of the supply lines as shown in Figure 8.

Figure 7: Library Manager with pipe material cost library connected
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Figure 8: Assign Cost Libraries panel with the Steel - ANSI Pipe Costs library connected and applied to the
pipes in the model

F. Sizing Method
Select the Sizing Method button to go to the Sizing Method panel.
Ensure that Discrete Sizing is chosen with the Modified Method of Feasible Directions (MMFD) for the
Search Method.

G. Dependent Design Cases
We have now set up the system to be sized for the primary design case, but we will also need to account
for the case where the third burner is shut off. There are a few changes that will need to be made for this
additional case:
1.

The flow rate at the control valves increases to 3 kg/sec to maintain the overall system flowrate.

2.

Control Valve J110 is closed and the minimum design requirement is removed because it is shut
off.

To make the dependent design case where the third burner is shut off complete the following:
1.

Go to the Sizing Objective panel and select the Enable Dependent Design Cases option. A new
button will now be available for the Dependent Design Cases panel in the Sizing Navigation panel.
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2.

Navigate to the Dependent Design Case panel. You should now see instructions displayed to create Dependent Design Cases, along with a summary table of dependent design settings. We will
now need to use the Duplicate Special feature to create the dependent design case.

3.

Go to the Workspace and choose Select All from the Edit menu.

4.

Open Duplicate Special (from the Edit menu), enter an increment of 100 and select Make Dependent Design Case (Figure 9). Click OK.

5.

Move the duplicated pipes and junctions to distinguish them from the original ones in the Primary
Design Case.

6.

Close Control Valve J110 in the DDC by selecting the junction in the Workspace and clicking the
Special Conditions button

on the Toolbar and selecting Closed.

7.

Use Global Junction Edit (from the Edit menu) to change all of the control valve setpoints in the
DDC from 2.4 kg/sec to 3 kg/sec (see Figure 10).

8.

In the Sizing window navigate to the Design Requirements panel. On the Control Valves page
remove the pressure drop requirement from J110, since this valve is closed for the DDC.

Return to the Dependent Design Cases panel.
When Duplicate Special was performed with Dependent Design Case selected, each of the duplicated
pipes was created with a special type of grouping. For example, pipe 101 is grouped with pipe 1 as a
DDC pipe (see Figure 11). This type of assignment allows the dependent design pipes to be sized, but to
not be counted in the cost so that the cost will not be duplicated.
It should also be noted that the dependent design grouping causes each of the dependent pipes to inherit
their Common Size Groups, Candidate Sets, and Cost Library settings from the pipes in the primary
case. The dependent design case pipes are therefore hidden on all sizing panels except for the Design
Requirements and Dependent Design Cases panels.

Figure 9: Duplicate Special settings to create a dependent design case
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Figure 10: Global Junction Edit is used to change the flows in the homes for the dependent cases
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Figure 11: Pipes in Dependent Design Cases have a special grouping relationship with pipes in the primary
case

Step 4. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 5. Examine the Output
After the run finishes, examine the final pipe sizes calculated by the ANS module. The results for pipe
size and overall cost are shown in Figure 12 and Figure 13. One can see that the resultant size is 4-inch
pipe for the header, with larger 5-inch piping for the distribution lines.
The total cost for the pipes is $46,557. This includes the $8,120 cost for the supply line pipes which were
not sized, as well as the $38,437 cost for the pipes in the model which were sized, including the header
and distribution piping. The pipes that were sized will be distinguished in the Cost Report by having a
green background color.
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Figure 12: Cost Report for the automated sizing
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Figure 13: Sizing Report for the automated pipe sizing

Step 6. Compare Results With Non-Monetary Sizing
This sizing could be performed by using weight as the objective instead of monetary cost to simplify the
setup. Using a non-monetary objective can produce less accurate sizing results in cases where the
energy costs or costs of equipment such as compressors need to be accounted for. However, only the
pipe sizes are being considered for the sizing calculations in this example. Set up the model to perform a
non-monetary sizing by doing the following:
1.

In the Scenario Manager create a child of the Base Scenario by right-clicking the scenario name
and choosing Create Child.

2.

Give the new child scenario the name Pipe Weight Sizing.

3.

Go to the Sizing Objective panel and change the Objective from Monetary Cost to Pipe Weight.

The model should now be configured to run the model. Click Run Model, then go to the Output window
once the run is finished. The final pipe sizes should now appear as shown in Figure 14.
It can be seen that changing the objective to pipe weight produces identical sizing results as the run
using a monetary cost objective. For more complex systems this will not always be the case.
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Figure 14: Final pipe sizes for the model using a non-monetary cost objective
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Summary
This example sizes a process steam system by minimizing the pipe weight. Common Size Groups allow
for the system to be simplified while still effectively sizing the system.
Note: This example can only be run if you have a license for the ANS module.

Topics Covered
l

Defining Common Size Groups

l

Viewing Common Size Groups using color in the Workspace

l

Choosing a Search Method

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.
In addition, it is assumed that the user has worked through the Beginner: Three Tank Steam System ANS example, and is familiar with the basics of ANS analysis.

Model Files
This example uses the following files, which are installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric - Process Steam System.aro

l

Metric - Process Steam System - ANS.aro

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.
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Open the Metric - Process Steam System.aro example file and save it to a new location. Open the
newly saved model file, right-click on the Base Scenario and select Delete All Children. The Workspace
should look like Figure 1 below.

Figure 1: Model layout for normal system operation

Step 2. Define the Pipes and Junctions Group
Before running this model with ANS, change all Tee/Wye junctions to use the Simple (no loss) Loss
Model rather than the Detailed Loss Model. This is significantly reduce the complexity of the model and
allow the solver to converge much faster. Use Global Junction Edit to make this change.

Step 3. Define the Modules Group
Navigate to the Modules panel in Analysis Setup. Check the box next to Activate ANS. The Network
option should automatically be selected, making ANS enabled for use.
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Step 4. Define the Automatic Sizing Group
The model is already defined for a regular AFT Arrow run, but we need to complete the sizing settings
before running the analysis. Go to the Sizing window by clicking the Sizing tab.

A. Sizing Objective
Go to the Sizing window by selecting the Sizing tab. The Sizing Objective window should be selected by
default from the Sizing Navigation panel along the bottom. For this analysis, we are interested in sizing
the system considering the monetary cost for the initial costs only.
1.

Select Perform Sizing for this calculation.

2.

For the Objective, choose Pipe Weight, and select the Minimize option from the drop-down list.

The Sizing Objective window is now complete.

B. Sizing Assignments
On the Sizing Navigation panel select the Sizing Assignments button.
For this system, we will be sizing all of the pipes since it is a new system.
ØMove all of the pipes to Always include in Weight.
To more efficiently size the system, it would be beneficial to create common size groups. In this system
there are several sections of piping which would likely be grouped together. Create Common Size
Groups as described below and indicated by the colors in Figure 2.
1.

The boilers in the model are identical, so it would be logical to use equivalent pipe sizes for pipes
P1 and P2 connected to the boilers. Create a Boilers Common Size Group and add pipes P1 and
P2 to the group.

2.

Using a common pipe size for the headers would be desirable in this system to reduce installation
costs and reduce losses. However, grouping the headers downstream of users 1 and 4 separately
could allow us to use a smaller size for those pipes and save costs. Create two groups, Mains and
Headers as shown in yellow and green respectively in Figure 2.

3.

In this system the users have varying flow demands, so it is not desirable to use a common pipe
size for all of the users. However, several of the users do have identical flows, so the pipes connected to those users should be grouped. Create a Low Flow Users group for pipes P105 and
P206 and a High Flow Users group for pipes P107 and P207.

The completed pipe Sizing Assignments can be seen in Figure 3.
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Figure 2: Process Steam model Workspace with the Common Size Groups indicated by color

Figure 3: Sizing Assignments fully defined for the model

C. Candidate Sets
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Click on the Candidate Sets button to open the Candidate Sets panel.
For this system it is desired to use STD Steel - ANSI. To create a Candidate Set, do the following:
1.

Under Define Candidate Sets, click New.

2.

Give the set the name Schedule 40 Pipes and click OK.

3.

From the drop down list choose Steel - ANSI.

4.

In the Available Material Sizes and Types on the left, expand the schedule 40 pipe sizes list.

5.

Double-click each of the sizes from 1 to 12 inches to add them to the list on the right.

6.

In the Select Pipe Sizes window, click OK.

We now need to define which pipes will use this Candidate Set during the sizing calculation. Check the
boxes next to each of the pipes and Common Size Groups to assign the Candidate Set to each of the
pipes, as shown in Figure 4.
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Figure 4: Candidate Sets panel fully defined for the model

D. Design Requirements
Select the Design Requirements button from the Navigation Panel.
For this system there is a requirement to maintain a minimum discharge pressure of 10 barG to each of
the customers. Design Requirements can not be applied on the assigned flow junctions directly, so we
will define this requirement at the outlet of each of the pipes connected to the Assigned Flow junctions.
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1.

Click the New button under Define Pipe Design Requirements.

2.

Enter the name Min Discharge Press.

3.

Select Pressure Static as the Parameter.

4.

Set the Location as Outlet.

5.

Choose Minimum for Max/Min, and enter 10 barG.

Now we need to apply the defined Design Requirement to the discharge pipes.
ØCheck the box next to each of the discharge pipes in the Assign Design Requirements to Pipes
section. This can be done quickly by checking the boxes next to the two Common Size Groups and the
Not in Group header to select all of the pipes under those classifications. The Design Requirements
panel should now appear as shown in Figure 5.

Figure 5: Design Requirements panel for pipes

E. Assign Cost Library
When the Sizing Objective has been defined as monetary cost, it is necessary to create and assign cost
libraries for the automated sizing, which can be done in the Assign Cost Library panel. Since we have
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defined the objective as Pipe Weight, we will not need to assign any cost libraries, and this button is disabled.

F. Sizing Method
Select the Sizing Method button to go to the Sizing Method panel.
ØChoose Discrete Sizing, since it is desired to select discrete sizes for each of the pipes in the model.
For the search method, the ANS module suggests using the Modified Method of Feasible Directions, so
select that option from the Search Methods list. Note that the suggested method will be displayed if the
Suggest Best Method button is selected under the Search methods list.

Step 5. Run the Model
Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window.
This window allows you to watch as the AFT Arrow solver converges on the answer. Once the solver has
converged, view the results by clicking the Output button at the bottom of the Solution Progress window.

Step 6. Examine the Output
After the run finishes, examine the final pipe sizes calculated by the ANS module. The results for pipe
size and overall cost are shown in Figure 6. The resultant pipe sizes range from 4 to 10 inches throughout the system.
With the Modified Method of Feasible Directions the total pipe weight in the system is minimized to
66,687 kg.
For this system it is possible to further minimize the weight in the system by using the Genetic Algorithm
(GA) method. With Genetic Algorithm a further reduction of about 1,500 kg can be obtained, though the
run time is much longer. Note that it is possible to pause the solver and accept the current sizing solution
before the Genetic Algorithm has fully completed by clicking Pause, then selecting Accept Sizing from
the Other Actions menu and clicking Continue to finish the current iteration. This will provide a valid system design, though it may not be the best solution that could possibly be found.
For more complex models this additional run time may be much longer, but could potentially provide a larger amount of savings. The main product Help file provides more information on setting up the model to
use the Genetic Algorithm Search Method.
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Figure 6: Cost Report and pipe sizes for the sized process steam model

Extended Time Simulation (XTS) Examples
The examples below utilize the Extended Time Simulation module.
Example
Air Receiver
Tank

Complexity

Beginner

Fluid

Air

Pipes

Compressors

Description

1

Learn the basics of the XTS
module such as defining a transient junction and specifying

4
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Example

Complexity

Fluid

Pipes

Compressors

Description
the Transient Control group in
Analysis Setup. See how to
generate a Quick Graph from
the Output window to see how
a tank fills up over time.
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Summary
The objective of this example is to introduce the user to the Extended Time Simulation (XTS) module by
modeling the pressurizing of an air receiver tank. A positive displacement compressor is used to charge
the tank and is shut off once the required pressure is reached for a compressed air process.
Note: This example can only be run if you have a license for the XTS module.

Topics Covered
l

Specifying the Transient Control group

l

Understanding Transient Output

Required Knowledge
This example assumes the user has already worked through the Beginner: Air Heating System example,
or has a level of knowledge consistent with that topic. You can also watch the AFT Arrow Quick Start
Video (Metric Units) on the AFT website, as it covers the majority of the topics discussed in the Beginner:
Air Heating System example.

Model File
This example uses the following file, which is installed in the Examples folder as part of the AFT Arrow
installation:
l

Metric – Air Receiver Tank - XTS.aro

Step 1. Start AFT Arrow
From the Start Menu choose the AFT Arrow 9 folder and select AFT Arrow 9.
To ensure that your results are the same as those presented in this documentation, this example should
be run using all default AFT Arrow settings, unless you are specifically instructed to do otherwise.

Step 2. Define the Modules Panel
Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this
example, check the box next to Activate XTS and select Transient to enable the XTS module for use.
Note that XTS can also be enabled from the Analysis menu by going to the Time Simulation option and
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selecting Transient, as shown in Figure 1. When XTS is activated a new group will appear in Analysis
Setup titled Transient Control.

Figure 1: Activating the XTS module and setting it to be enabled in the Modules panel

Step 3. Define the Fluid Properties Group
1.

Open Analysis Setup from the toolbar or from the Analysis menu

2.

Open the Fluid panel then define the fluid:
a.

Fluid Library = AFT Standard

b.

Fluid = Air
i.

After selecting, click Add to Model

c.

Equation of State = Redlich-Kwong

d.

Enthalpy Model = Generalized

e.

Specific Heat Ratio Source = Library

Step 4. Define the Pipes and Junctions Group
At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as
shown in the figure below.
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Figure 2: Workspace for XTS Air Receiver Tank example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and
junction and enter the following properties.

Pipe Properties
1.

2.

Pipe P1
a.

Pipe Material = Steel - ANSI

b.

Pipe Geometry = Cylindrical Pipe

c.

Size = 3 inch

d.

Type = STD (schedule 40)

e.

Friction Model = Standard

f.

Length = 6 meters

Pipes P2 - P4
a.

Pipe Material = Steel - ANSI

b.

Pipe Geometry = Cylindrical Pipe

c.

Size = 3 inch

d.

Type = STD (schedule 40)

e.

Friction Model = Standard

f.

Length = 3 meters

Junction Properties
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1.

2.

J1 Assigned Pressure
a.

Elevation = 0 meters

b.

Fluid = Air

c.

Stagnation Pressure = 0 barG

d.

Stagnation Temperature = 21 deg. C

J2 Compressor
a.

Elevation = 0 meters

b.

Compressor Model = Positive Displacement Compressor

c.

Compression Process Thermodynamics = Polytropic

d.

Polytropic Constant = 1.2

e.

Compressor Sizing Parameter = Mass Flow Rate

f.

Fixed Flow Rate = 170 sm3/h

Note: The polytropic constant entered for the compressor is intended to represent an active cooling
element in the compressor.
3.

J3 Heat Exchanger
a.

Elevation = 0 meters

b.

On the Loss Model Data tab

c.

4.

5.

i.

Select the Loss Model as Resistance Curve, and then click the Enter Curve Data button

ii.

Select the Flow Parameter as Mass with units of sm3/h

iii.

Enter 170 sm3/h and 20 kPa in the Raw Data table

iv.

Click Fill as Quadratic to create data for a square loss curve

v.

Click Generate Curve Fit Now to create a quadratic curve fit

On the Thermal Data tab:
i.

Thermal Model = Controlled Downstream Temperature

ii.

Controlled Outlet Temperature = 30 deg. C

J4 Valve
a.

Elevation = 0 meters

b.

Loss Model = User Specified

c.

Subsonic Loss Model = Cv (ANSI/ISA)

d.

Loss Source = Fixed Cv

e.

Cv = 50

f.

Xt = 0.7

J5 Tank
a.

Tank Model = Finite

b.

Initial Conditions

c.

i.

Pressure = 0 barG

ii.

Temperature = 21 deg. C

Finite Tank Conditions
i.

Fixed Volume = 1900 liters
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ii.

Initial Conditions = Known

iii.

Thermodynamic Process = Isothermal

Figure 3: Tank Properties window defined with Finite Tank option

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter
the missing data.

Step 5. Define the Transient Control Group
XTS module transient simulations are controlled through the Simulation Duration panel. You can access
the Simulation Duration panel by selecting Transient Control from the Analysis Menu, navigating to the
Simulation Duration item in Analysis Setup, or by clicking the Simulation Duration shortcut on the Common Toolbar. When the time simulation mode is set to Steady-Only AFT Arrow will ignore the input in the
Simulation Duration panel. When AFT Arrow is set to perform a transient analysis, the Transient Control
group becomes a required item before the model can run. Use the Simulation Duration panel to specify
transient start and stop times, set time steps, specify the number of output points that are saved to the
transient output file (allows XTS to do transient calculations with a small time step while limiting the size
of the transient data output file), and adjust solution parameters for finite tank liquid level calculations.
Specify start times, stop times, and time steps in any units from seconds to years.
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Set the Start Time to 0 seconds and the Stop Time as 375 seconds, with a time step of 1 second. The output will be saved to the output file for every time step. The Simulation Duration panel should appear as
shown in Figure 4.

Figure 4: The Simulation Duration panel is used to control transient simulations

Step 6. Set Up the Compressor Transient
In the XTS module, you can define transients for junctions. These transients include events such as
valves opening and closing and compressors starting and shutting down. Transients for junctions are
defined as either time-based or event-based transients. A time-based transient starts at a specified absolute time. Event based transients initiate when a defined criteria, such as a specified pressure in a particular pipe is reached. There are three types of event transients for junctions: single event, dual event
cyclic, and dual event sequential. Single event transients are events that occur only once in a simulation.
Dual cyclic events are two transient events that repeat one after the other as many times as the event trigger occur during a simulation (such as a valve closing then reopening). Dual sequential transient events
are two transient events which occur one after the other, without repeating.
For this example, set a single event-based transient on the compressor so the compressor will shut off
over 30 seconds when the pressure at the tank inlet reaches 8.5 barG.
Open the Compressor Properties window for compressor J2 and navigate to the Transient tab. Under Initiation of Transient, select Single Event and enter the Transient data as shown below in Figure 5.
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Figure 5: Compressor junction transient tab with flow transient defined

Step 7. Run the Model
After defining all of the pipes and junctions transient data and transient control items, the transient model
can run. Click Run Model from the Common Toolbar or Analysis menu.
When using the XTS module, the Solution Progress window displays the progress through the transient
analysis. This information is displayed below the solution tolerance data, as shown in Figure 6.
After the run finishes, view the results by clicking the Output button.
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Figure 6: Solution Progress Window shows the convergence progress, as well as the transient solution progress when running transient cases

Step 8. Examine the Transient Results
AFT Arrow displays transient output for all Pipes and Junctions in the Output Window, as shown in Figure
7.
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Figure 7: Transient output is displayed in the Output Window

Each of the summary tables in the General Output section has a companion transient summary tab
which displays the summary data at each time step in the transient run. Each junction included in the
summary is included in the transient summary. The transient summary data for each junction may be
expanded or collapsed by clicking the + or – sign in beside the junction data list. The entire list may be
expanded or collapsed by clicking the button in the top left-hand corner of the transient summary window.
Figure 8 shows the Tank Transient summary tab, with all of the data sets collapsed. Figure 9 shows the
Tank Transient summary tab, with the data for the J5 Tank expanded.

Figure 8: Transient Summaries are displayed in the General Output section
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Figure 9: Transient Summary data can be expanded to show the junction data for every Time Step

The Event Messages tabs in the General Section (Figure 10) can be used to see when events are
triggered during the transient. For this example the Event Messages By Jct tab shows that the flow transient at the compressor was triggered at 333 seconds into the transient, meaning it took 333 seconds to
pressurize the tank to the required pressure.

Figure 10: Event Messages tab in the General section of the Output window

The Quick Graph feature can be used to plot transient data for rapid examination. To use the Quick
Graph feature, place the mouse cursor over the column of data you wish to examine. Then, right click
with the mouse, and select Quick Graph from the list. Figure 11 illustrates how to generate a Quick Graph
for J5 Tank Pressure vs. Time. The graph illustrates how the pressure in the tank rises over time and
steadies out at about 9.9 bar once the compressor fully shuts off (Figure 12). The Graph Results window
may also be used to create a full range of graphs related to the XTS module transient output.

Figure 11: Use Quick Graph to easily plot J5 Tank pressure
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Figure 12: Quick Graph Plot of J5 Tank pressure

Similar to the summary transient data, the transient tabs in the Pipe and Junctions sections of the Output
Window (shown in Figure 7) are used to display the transient data for each pipe and junction at every
time step. This transient data can be expanded or collapsed in the same manner as in the General Output transient summaries.
Figure 13 shows the output data for the pipes and junctions, found on the Pipes and All Junctions tabs, at
the initial time step, Time = 0 seconds. The output for all of the pipes and junctions can be displayed at
any time step by using the slider bar located at the bottom of the Output window. Figure 14 shows the
pipe and junction data at Time = 60 seconds.
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Figure 13: Pipe and Junction transient data at Time = 0 minutes

Figure 14: Pipe and Junction transient data at Time = 60 seconds
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Verification
AFT Arrow Verification Overview
There are a number of aspects to the verification process employed by Applied Flow Technology to
ensure that AFT Arrow provides accurate solutions to compressible pipe flow systems. These are discussed in Verification Methodology. A listing of all of the verified models is given in Summary of Verification Models. The verification models are taken from numerous References.
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Verification Methodology
The AFT Arrow software is a compressible pipe flow analysis product intended to be used by trained
engineers. As a technical software package, issues of quality and reliability of the technical data generated by the software are important. The following description summarizes the steps taken by Applied
Flow Technology to ensure high quality in the technical data.

1. Comparisons with open literature examples
Open literature examples for compressible flow in pipe networks are very hard to find. However,
examples for single pipe systems are more common. AFT Arrow has been compared against a number
of single pipe examples with good agreement.

2. Software checks results to ensure mass and energy balance
AFT Arrow’s network solution method is based on a popular iterative method to solve pipe network systems. The method is known as the Newton/Raphson method. The methods that are used in AFT Arrow
iterate on the governing equations to obtain a balanced mass and energy in the system. After a solution
is obtained, a final check is made by the software whereby the mass flow and energy flow into each node
is checked for balance. If a balance is not found, the user is warned in the output. This ensures that the
results generated by the software agree with the applicable fundamental equations.
See the AFT Arrow Help site for more information.

3. Hand/spreadsheet checks of the solutions confirm agreement with fundamental equations
AFT Arrow uses a marching method to solve the fundamental equations of compressible flow for each
pipe. The results can be exported from AFT Arrow and checked by hand calculations or spreadsheet to
evaluate agreement with the original equations. This has been performed by AFT and agreement has
been demonstrated repeatedly.
See the AFT Arrow Help site for more information.

4. AFT Arrow offers three independent solution methods which can be crosschecked
AFT Arrow offers three independent solution methods. Each is optimized for a particular application, but
in many cases all three methods can be used to solve the same system. In such cases, agreement
between the three methods gives confidence that accurate solutions have been obtained.
See the AFT Arrow Help site for more information.
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5. AFT Arrow predictions agree with AFT Fathom predictions for incompressible flow
For incompressible and moderately compressible gas systems, AFT Arrow results can be compared
against those generated by AFT Fathom. In such cases agreement between AFT Arrow and AFT
Fathom has been demonstrated repeatedly.

6. Software has been used in industry since September, 1995 demonstrating
repeated agreement with other methods and data
AFT Arrow became available in September, 1995, and is currently being used by companies in the following industries: chemical, petrochemical, power generation, architectural, ship construction,
aerospace, and pharmaceutical. Since its release, AFT Arrow has been applied to numerous gas systems with various working fluids and has repeatedly demonstrated agreement with data and other analysis methods. In addition, Applied Flow Technology issues maintenance releases of the software
periodically to improve performance and correct any problems that may have been discovered.
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Summary of Verification Models
All published compressible flow calculations of which AFT is aware are for single pipes. Because of the
simplicity of the single pipe verification models, no views of the models are included in this
documentation. Comparison of AFT Arrow predictions to the published calculation results is included
herein for twenty-one cases from 8 sources. Below is a summary of the cases.

Case

Fluid

Reference

Sonic

Case 1

Air

Anderson

No

Case 2

Methane

Saad

Yes

Case 3

Steam

Crane

No

Case 4

Air

Crane

No

Case 5

Natural Gas

Crane

No

Case 6

Steam

Crane

Yes

Case 7

Air

Crane

No

Case 8

Air

Fox and McDonald Yes

Case 9

Unspecified (γ = 1.4) Lindeburg

No

Case 10 Methane

Lindeburg

No

Case 11 Air

Saad

No

Case 12 Air

Saad

Yes

Case 13 Natural Gas

Saad

Yes/No

Case 14 Air

Tilton

Yes

Case 15 Air

Janna

No

Case 16 Air

Nayyar

Yes

Case 17 Air

Nayyar

Yes

Case 18 Air

Nayyar

Yes

Case 19 Air

Nayyar

Yes

Case 20 Air

Nayyar

Yes

Case 21 Air

Nayyar

No

Verification Case 1
Problem Statement
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Summary of Verification Models

PRODUCT: AFT Arrow
MODEL FILE: AroVerify1.ARO
REFERENCE: John D. Anderson, Modern Compressible Flow, 1982, McGraw-Hill, page 76, example
3.4
GAS: Air
ASSUMPTIONS: 1) Adiabatic, 2) Perfect gas
RESULTS:

Parameter

Anderson

AFT Arrow

M2 – Mach number at exit

0.475

0.473

P2– Static pressure at exit (atm)

0.624

0.624

T2– Static temperature at exit (deg. K) 265.8

265.9

Po2– Stagnation pressure at exit (atm)

0.728

0.728

DISCUSSION:
As specified, inlet conditions are known and outlet conditions need to be determined. With the known
inlet conditions, an implied mass flow rate exists. To pose the problem in AFT Arrow terms, a few simple
calculations are needed to obtain the mass flow rate. Once obtained, it is applied as a flow demand at the
exit.
The problem states that the inlet Mach number is 0.3, P1 = 1 atm, T1 = 273 K. From the ideal gas law,
density, sonic speed and mass flow rate are:

Note that the friction factor in Anderson is the Fanning friction factor. To obtain the Darcy-Weisbach friction factor used in AFT Arrow, multiply the Fanning friction factor by 4.
List of All Verification Models
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Summary of Verification Models

Verification Case 1 Problem Statement
Verification Case 1
John D. Anderson, Modern Compressible Flow, 1982, McGraw-Hill, page 76, example 3.4
Anderson Title Page
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Verification Case 2
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify2.ARO
REFERENCE: Michel A. Saad, Compressible Fluid Flow, 2nd Edition, Prentice-Hall, Englewood Cliffs,
NJ, 1993, Page 215, example 5.3
GAS: Methane
ASSUMPTIONS: 1) Adiabatic, 2) Perfect gas
RESULTS:

Parameter

Saad

AFT Arrow

Maximum pipe length (m)

4,024

4,031

P2– Static pressure at exit (kPa)

48.2

48.3

V2– Velocity at exit (m/s)

433.17

431.82

T2– Static temperature at exit (deg. K) 278.43

278.15

DISCUSSION:
As specified, inlet conditions are known and the outlet conditions are sonic. The pipe length that yields
sonic flow is the objective. With the known inlet conditions, an implied mass flow rate exists. To pose the
problem in AFT Arrow terms, a few simple calculations are needed to obtain the mass flow rate. Once
obtained, it is applied as a flow demand at the exit.
The problem states that the inlet velocity V1 is 30 m/s, P1 = 0.8 MPa, T1 = 320 K. From the ideal gas law,
density, sonic speed and mass flow rate are:

AFT Arrow does not solve for pipe length. To obtain the maximum pipe length, different lengths must be
guessed with lengths that exceed sonic flow discarded.
Note that the friction factor in Saad is the Fanning friction factor. To obtain the Darcy-Weisbach friction
factor used in AFT Arrow, multiply the Fanning friction factor by 4.
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Verification Case 2

It should also be noted that, from time to time, AFT finds it is necessary to modify the Solver used by
Arrow to improve application performance, or for other reasons. These modifications to the Solver may
cause slight changes to the appropriate pipe lengths determined by Arrow.
List of All Verification Models
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Verification Case 2 Problem Statement
Verification Case 2
Michel A. Saad, Compressible Fluid Flow, 2nd Edition, Prentice-Hall, Englewood Cliffs, NJ, 1993, Page
215, example 5.3
Saad Title Page
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Verification Case 2 Problem Statement
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Verification Case 3
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify3.ARO
REFERENCE: Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410,
Crane Co., Joliet, IL, 1988, Page 4-6, example 4-10
GAS: Steam
ASSUMPTIONS: Example does not specify the heat transfer conditions, so it was assumed adiabatic in
this model.
RESULTS:

Parameter

Crane

AFT Arrow

Static pressure drop (psi)

40.1

41.6

DISCUSSION:
Crane does not make a distinction between static and stagnation pressure, and it appears that static pressure is usually assumed. Therefore, the inlet pressure of 600 psig was assumed to be static pressure.
To make a one-to-one comparison, the K factors and friction factor used in Crane were used directly in
AFT Arrow. The K factors were modeled as fitting and loss values, which evenly spreads the effect of resistance across the entire pipe. In practice, the velocity changes in the pipe can yield different answers for
fitting pressure losses depending on where they are actually located.
The AFT Arrow model uses the Redlich-Kwong real gas equation of state for steam. Note that the Crane
formula underpredicts the pressure drop (by about 4%), which in most applications is not conservative.
List of All Verification Models
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Verification Case 3 Problem Statement
Verification Case 3
Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410, Crane Co.,
Joliet, IL, 1988, Page 4-6, example 4-10
Crane Title Page
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Verification Case 4
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify4.ARO
REFERENCE: Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410,
Crane Co., Joliet, IL, 1988, Page 4-9, example 4-16
GAS: Air
ASSUMPTIONS: Example does not specify the heat transfer conditions, so it was assumed isothermal in
this model.
RESULTS:

Parameter

Crane

AFT Arrow

Static pressure drop (psi)

2.61

2.68

Volumetric flow rate at inlet (ft3/min)

20.2

20.2

Volumetric flow rate at outlet (ft3/min) 20.9

20.9

Velocity inlet (ft/min)

3367

3368

Velocity outlet (ft/min)

3483

3485

DISCUSSION:
Crane does not make a distinction between static and stagnation pressure, and it appears that static pressure is usually assumed. Therefore, the inlet pressure of 65 psig was assumed to be static pressure.
Note that the Crane formula underpredicts the pressure drop (by about 3%), which in most applications is
not conservative.
List of All Verification Models
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Verification Case 4 Problem Statement
Verification Case 4
Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410, Crane Co.,
Joliet, IL, 1988, Page 4-9, example 4-16
Crane Title Page
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Verification Case 5
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify5.ARO
REFERENCE: Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410,
Crane Co., Joliet, IL, 1988, Page 4-11, example 4-18
GAS: Natural Gas (mole fractions: 75% methane, 21% ethane, and 4% propane)
ASSUMPTIONS: Isothermal flow at 40 degrees F
RESULTS:

Parameter

Crane

AFT Arrow

Mass flow rate using standard friction (MMscfd) † 107.8

125.0

Mass flow rate using Weymouth (MMscfd)

105

121.8*

Mass flow rate using Panhandle (MMscfd)

134

120.4*

† Crane’s calculation uses the “Simplified Compressible Flow Formula”
* Crane uses the actual Weymouth and Panhandle equations. AFT Arrow does have these equations,
but instead solves the governing mass and momentum equations over pipe sections. The AFT Arrow
Weymouth and Panhandle solutions above were obtained using the Weymouth and Panhandle friction
factor correlation options in AFT Arrow rather than the standard Darcy-Weisbach friction factor (as used
in the first case above).
DISCUSSION:
The mixture properties for this example offer an opportunity to use the Chempak mixture capabilities.
The problem statement does not say whether the fractions are on a mass or mole basis, but it does say in
Crane that the mixture molecular weight is 20.1. This is consistent with mole fraction. AFT Arrow’s output
indicates the molecular weight of the mixture is 20.11.
As noted above (*), AFT Arrow has optional friction factor models for Weymouth and Panhandle (see
Crane, page 1-8 or AFT Arrow documentation). These were used for the second and third cases above.
However, regardless of what friction factor model is used, AFT Arrow differs from any of the three methods above in that it directly solves the governing equations and it does so over pipe segments. In this
model, the pipe was broken into 100 segments.
Since it can be easily demonstrated that AFT Arrow’s solution satisfies the mass and momentum equations for this pipe, and the solution differs from the Crane solutions, the Crane solutions do not offer a
mass and/or momentum balance.
List of All Verification Models
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Verification Case 5 Problem Statement
Verification Case 5
Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410, Crane Co.,
Joliet, IL, 1988, Page 4-11, example 4-18
Crane Title Page
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Verification Case 6
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify6.ARO
REFERENCE: Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410,
Crane Co., Joliet, IL, 1988, Page 4-13, example 4-20
GAS: Steam
ASSUMPTIONS:
Example does not specify the heat transfer conditions, but it appears from the calculation procedure that
adiabatic flow is assumed. The AFT Arrow model assumes adiabatic.
RESULTS:

Parameter

Crane Modified Darcy For- Crane Sonic Velocity For- AFT
mula
mula
Arrow

Mass flow rate (lbm/hr) †

11,780

11,180

11,158

Exit Static Enthalpy
(Btu/lbm)

N/A

1,196

1,149

Exit Temperature (deg F)

N/A

317

243

DISCUSSION:
Crane does not make a distinction between static and stagnation pressure, and it appears that static pressure is usually assumed. However, the problem statement is that the source steam comes from a
header, where conditions are more likely stagnation. Therefore, stagnation pressure was assumed in the
AFT Arrow model.
The Crane Sonic Velocity Formula yields a flow rate prediction that agrees well with the AFT Arrow prediction. The Crane Modified Darcy Formula appears to yield flow rates that are too high. If the inlet conditions in the AFT Arrow model are changed to static, the AFT Arrow flow rate prediction increases
slightly to 11,498.4 (lbm/hr). AFT Arrow uses real gas properties for the steam as specified in the Fluid
Panel.
The Crane sonic calculation assumes an isenthalpic process, which is why the exit static enthalpy is
assumed to be constant at 1,196 Btu/lbm. With this assumption, the exit temperature is 317 deg. F.
However, an isenthalpic assumption turns out to be poor when the Energy Equation is applied. From the
First Law,

If the process is adiabatic, the heat transfer is zero and therefore,
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Verification Case 6

Thus, the static enthalpy will drop because of the velocity increase. When this is accounted for, the exit
static enthalpy decreases to 1149. This yields an exit static temperature of 243.0 deg. F, which is 74
degrees cooler.
List of All Verification Models

- 996 -

Verification Case 6 Problem Statement
Verification Case 6
Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410, Crane Co.,
Joliet, IL, 1988, Page 4-13, example 4-20
Crane Title Page
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Verification Case 7
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify7.ARO
REFERENCE: Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410,
Crane Co., Joliet, IL, 1988, Page 4-14, example 4-22
GAS: Air
ASSUMPTIONS: Example does not specify the heat transfer conditions. The AFT Arrow model assumes
adiabatic.
RESULTS:

Parameter

Crane

Mass flow rate(scfm) 62.7

AFT Arrow
63.5

DISCUSSION:
Crane does not make a distinction between static and stagnation pressure, and it appears that static pressure is usually assumed. From the problem description, the static pressure is clearly appropriate.
The predicted flow rates agree very closely.
The Crane prediction indicates that this pipe will have subsonic velocity at the exit and hence will not
choke. However, a more proper formulation of this problem shows a different mass flow will occur. This is
a good example of the limitations of simplified methods such as Crane. The discrepancy comes from how
to handle the exit loss of the air as it discharges to atmosphere. The Crane solution takes the appropriate
K factor, equal to 1, and lumps it together with the pipe friction to obtain an overall K factor of 7.04.
However, if the K factor is applied at the discharge tank and not averaged along the pipe, the mass flow
differs from that calculated by Crane. The predicted flow rate using this method is 64.4 scfm. This is not
drastically different from Crane’s prediction, and well within typical engineering uncertainty. But the difference, which is small here, could be larger in other applications.
List of All Verification Models
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Verification Case 7 Problem Statement
Verification Case 7
Crane Co., Flow of Fluids Through Valves, Fittings, and Pipe, Technical Paper No. 410, Crane Co.,
Joliet, IL, 1988, Page 4-14, example 4-22
Crane Title Page
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Verification Case 8
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify8.ARO
REFERENCE: Robert W. Fox and Alan T. McDonald, Introduction to Fluid Mechanics, Third Edition,
John Wiley & Sons, 1985, Pages 632-633, example 12.8
GAS: Air
ASSUMPTIONS: 1) Adiabatic flow, 2) Perfect gas.
RESULTS:

Parameter

Fox & McDonald AFT Arrow

L1-3 – length to choking (meters)

4.99

4.99

V1– Velocity at point 1 (m/s)

65.3

65.2

T1– Temperature at point 1 (deg. K)

294

294

M1– Mach number at point 1

0.19

0.19

M2 – Mach number at point 2

0.4

0.4

P2– Pressure at point 1 (mm Hg gage)

-18.9

-18.9

L1-2 – length to measured pressure (meters) 4.29

4.29*

* AFT Arrow does not have the ability to solve for pipe length, so the length was input. With this known
length, the AFT Arrow Mach number at M2 should agree with Fox & McDonald’s, and it does. The resulting mass flow rate is then used as input for AFT Arrow pipe #2.
DISCUSSION:
The predictions agree very closely.
The two pipes in the AFT Arrow model represent the solutions to stations 2 and 3.
Note that the friction factor in Fox & McDonald is the Fanning friction factor. To obtain the Darcy-Weisbach friction factor used in AFT Arrow, multiply the Fanning friction factor by 4.
It should also be noted that, from time to time, AFT finds it is necessary to modify the Solver used by
Arrow to improve application performance, or for other reasons. These modifications to the Solver may
cause slight changes to the appropriate pipe lengths determined by Arrow.
List of All Verification Models
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Verification Case 8 Problem Statement
Verification Case 8
Robert W. Fox and Alan T. McDonald, Introduction to Fluid Mechanics, Third Edition, John Wiley & Sons,
1985, Pages 632-633, example 12.8
Fox and McDonald Title Page

- 1001 -

Verification Case 8 Problem Statement
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Verification Case 9
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify9.ARO
REFERENCE: Michael R. Lindeburg, P.E., Mechanical Engineering Review Manual, Seventh Edition,
Professional Publications, Belmont, CA, 1984, Pages 8-11, 8-12, example 8.12
GAS: Unspecified except that the k value (i.e., γ) is 1.4
ASSUMPTIONS: 1) Adiabatic flow, 2) Perfect gas, 3) The gas is air, but for purposes of the example it
only matters that the gas has k = 1.4, 4) No temperature was specified, so assume 70 deg. F
RESULTS:

Parameter

Lindeburg

AFT Arrow

M2 – Mach number at exit 0.35

0.36

P2– Pressure at exit (psia)

10.09

10.26

DISCUSSION:
As specified, inlet conditions are known and outlet conditions need to be determined. With the known
inlet conditions, an implied mass flow rate exists. To pose the problem in AFT Arrow terms, a few simple
calculations are needed to obtain the mass flow rate. Once obtained, it is applied as a flow demand at the
exit.
The problem states that the inlet Mach number is 0.3, P1 = 12 psia, T1 = 70 F (assumed). From the ideal
gas law, density, sonic speed and mass flow rate are:

With this flow rate at the exit, the predictions agree very closely.
Note that the friction factor in Lindeburg is the Fanning friction factor. To obtain the Darcy-Weisbach friction factor used in AFT Arrow, multiply the Fanning friction factor by 4.
List of All Verification Models
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Verification Case 9 Problem Statement
Verification Case 9
Michael R. Lindeburg, P.E., Mechanical Engineering Review Manual, Seventh Edition, Professional
Publications, Belmont, CA, 1984, Pages 8-11, 8-12, example 8.12
Lindeburg Title Page
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Verification Case 9 Problem Statement
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Verification Case 10
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify10.ARO
REFERENCE: Michael R. Lindeburg, P.E., Mechanical Engineering Review Manual, Seventh Edition,
Professional Publications, Belmont, CA, 1984, Pages 8-12, 8-13, example 8.13b
GAS: Methane
ASSUMPTIONS: 1) Isothermal flow, 2) Perfect gas
RESULTS:

Parameter

Lindeburg

Mass flow rate (lbm/s) 456

AFT Arrow
457

DISCUSSION:
The predictions agree closely. Part "a" makes a comparison to the Bernoulli equation, which Arrow does
not solve. So part “a” was skipped.
Note that the friction factor in Lindeburg is the Fanning friction factor. To obtain the Darcy-Weisbach friction factor used in AFT Arrow, multiply the Fanning friction factor by 4.
List of All Verification Models
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Verification Case 10 Problem Statement
Verification Case 10
Michael R. Lindeburg, P.E., Mechanical Engineering Review Manual, Seventh Edition, Professional
Publications, Belmont, CA, 1984, Pages 8-12, 8-13, example 8.13b
Lindeburg Title Page
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Verification Case 10 Problem Statement
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Verification Case 11
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify11.ARO
REFERENCE: Michel A. Saad, Compressible Fluid Flow, 2nd Edition, Prentice-Hall, Englewood Cliffs,
NJ, 1993, Pages 213-215, example 5.2
GAS: Air
ASSUMPTIONS: 1) Adiabatic, 2) Perfect gas
RESULTS:

Parameter

Saad

AFT Arrow

M2 – Mach number at exit

0.685

0.686

M1 – Mach number at inlet

0.347

0.346

P1– Static pressure at inlet (kPa)

306

308

T1– Static temperature at inlet (deg. K) 312.76

312.9

DISCUSSION:
As specified, exit conditions are known and inlet conditions need to be determined for specified volume
flow at exit. With the known exit conditions, an implied mass flow rate exists. To pose the problem in AFT
Arrow terms, a few simple calculations are needed to obtain the mass flow rate. Once obtained, it is
applied as a flow demand at the inlet.
The problem states that the exit volume flow rate, Q2, is 1000 m3/min, P2 = 150 kPa, T2 = 293 K. From
the ideal gas law, density, and mass flow rate are:

In AFT Arrow, the discharge pressure can be specified. The temperature can be specified at the exit junction, but the actual discharge is what is displayed for the pipe exit. The pipe exit temperature depends on
the inlet temperature and the thermodynamic process in the pipe, which is adiabatic. Therefore, to solve
this problem the inlet static temperature at J1 must be guessed until the pipe delivers 293 K at the exit.
This results in the 312.9 K displayed in the above table.
All results agree closely.
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Verification Case 11

Note that the friction factor in Saad is the Fanning friction factor. To obtain the Darcy-Weisbach friction
factor used in AFT Arrow, multiply the Fanning friction factor by 4.
List of All Verification Models
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Verification Case 11 Problem Statement
Verification Case 11
Michel A. Saad, Compressible Fluid Flow, 2nd Edition, Prentice-Hall, Englewood Cliffs, NJ, 1993, Pages
213-215, example 5.2
Saad Title Page
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Verification Case 11 Problem Statement
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Verification Case 11 Problem Statement
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Verification Case 12
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify12.ARO
REFERENCE: Michel A. Saad, Compressible Fluid Flow, 2nd Edition, Prentice-Hall, Englewood Cliffs,
NJ, 1993, Pages 226-227, example 5.5
GAS: Air
ASSUMPTIONS: 1) Adiabatic, 2) Perfect gas
RESULTS:

Parameter

Saad

AFT Arrow

Mass flow rate when choked (kg/s)

2.11

2.10

M1 – Mach number at inlet

0.603

0.603

P1– Static pressure at inlet (MPa)

2.106

2.114

T1– Static temperature at inlet (deg. K)

427.8

429.5

P2,choke– Static back pressure for choking (MPa) 1.203

1.220

DISCUSSION:
All results agree closely. The AFT Arrow static pressure below which choking occurs is the pipe exit static
pressure.
Note that the friction factor in Saad is the Fanning friction factor. To obtain the Darcy-Weisbach friction
factor used in AFT Arrow, multiply the Fanning friction factor by 4.
List of All Verification Models
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Verification Case 12 Problem Statement
Verification Case 12
Michel A. Saad, Compressible Fluid Flow, 2nd Edition, Prentice-Hall, Englewood Cliffs, NJ, 1993, Pages
226-227, example 5.5
Saad Title Page
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Verification Case 12 Problem Statement
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Verification Case 13
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify13.ARO
REFERENCE: Michel A. Saad, Compressible Fluid Flow, 2nd Edition, Prentice-Hall, Englewood Cliffs,
NJ, 1993, Page 270, example 6.5
GAS: Natural Gas
ASSUMPTIONS: 1) Isothermal, 2) Perfect gas, 3) Natural gas can be represented with methane
RESULTS:

Parameter

Saad

AFT Arrow

P2– Static back pressure at exit (kPa)

263.16

262.0

M2 – Mach number at exit

0.38

0.38

L1-2 – length to reach 500 kPa (m)

544.79

558.6

LT – length to reach sonic choke point (m)

710.0

709.8

PT– Static pressure choke point (kPa)

114.46

115.7

MT – Mach number at isothermal choke point 0.874

0.865

DISCUSSION:
As specified, inlet conditions are known and outlet conditions need to be determined. With the known
inlet conditions, an implied mass flow rate exists. To pose the problem in AFT Arrow terms, a few simple
calculations are needed to obtain the mass flow rate. Once obtained, it is applied as a flow demand at the
exit.
The problem states that the inlet Mach number is 0.1, P1 = 1 MPa, T1 = 293 K. From the ideal gas law,
density, sonic speed and mass flow rate are:
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Verification Case 13

The first pipe represents the pipe from point 1 to 2. The second pipe represents the pipe from point 1 to
the choking point. AFT Arrow does not solve for pipe length. To obtain the maximum pipe length, different
lengths must be guessed with lengths that exceed sonic flow discarded.
The results for part b) were obtained by interpolating the Internal Pipe Results for the first pipe.
All results agree closely. The AFT Arrow static pressure below which choking occurs is the pipe exit static
pressure.
Note that the friction factor in Saad is the Fanning friction factor. To obtain the Darcy-Weisbach friction
factor used in AFT Arrow, multiply the Fanning friction factor by 4.
It should also be noted that, from time to time, AFT finds it is necessary to modify the Solver used by
Arrow to improve application performance, or for other reasons. These modifications to the Solver may
cause slight changes to the appropriate pipe lengths determined by Arrow.
List of All Verification Models

- 1018 -

Verification Case 13 Problem Statement
Verification Case 13
Michel A. Saad, Compressible Fluid Flow, 2nd Edition, Prentice-Hall, Englewood Cliffs, NJ, 1993, Page
270, example 6.5
Saad Title Page
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Verification Case 14
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify14.ARO
REFERENCE: Robert H. Perry and Don W. Green Editors, Author James. N. Tilton, Perry's Chemical
Engineer's Handbook, Seventh Edition, Page 6-25, example 8
GAS: Air
ASSUMPTIONS: 1) Adiabatic, 2) Perfect gas
RESULTS:

Parameter

Tilton

Mass flow rate (kg/s) 2.7

AFT Arrow
2.7

DISCUSSION:
The objective is to solve for the choked flow rate. The results agree closely.
List of All Verification Models
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Verification Case 14 Problem Statement
Verification Case 14
Robert H. Perry and Don W. Green Editors, Author James. N. Tilton, Perry's Chemical Engineer's Handbook, Seventh Edition, Page 6-25, example 8
Perry's Title Page
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Verification Case 15
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify15.ARO
REFERENCE: William S. Janna, Introduction to Fluid Mechanics, PWS Publishers, Belmont, CA 1983,
Pages 317-319, example 8.8
GAS: Air
ASSUMPTIONS: 1) Adiabatic flow, 2) Perfect gas
RESULTS:

Parameter

Janna

AFT Arrow

M2– Mach number at exit

0.14

0.14

P2– Pressure at exit (psia)

9.63

9.84

T2– Temperature at exit (deg. R) 528.8

528.9

DISCUSSION:
As specified, inlet conditions are known and outlet conditions need to be determined. With the known
inlet conditions, an implied mass flow rate exists. To pose the problem in AFT Arrow terms, a few simple
calculations are needed to obtain the mass flow rate. Once obtained, it is applied as a flow demand at the
exit.
The problem states that the inlet velocity is 100 ft/s, P1 = 15 psia, T1 = 530 R. From the ideal gas law,
density, and mass flow rate are:

With this flow rate at the exit, the predictions agree very closely.
List of All Verification Models
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Verification Case 15 Problem Statement
Verification Case 15
William S. Janna, Introduction to Fluid Mechanics, PWS Publishers, Belmont, CA 1983, Pages 317-319,
example 8.8
Janna Title Page
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Verification Case 15 Problem Statement
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Verification Case 15 Problem Statement
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Verification Case 16
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify16.ARO
REFERENCE: Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000,
Page B.394, B.397, B.398, Example B8.2
GAS: Air
ASSUMPTIONS: 1) Adiabatic flow, 2) Perfect gas
RESULTS:

Parameter

Nayar

AFT Arrow

M1– Mach number at valve 0.317

0.317

P1– Pressure at valve (psia) 128.46

128.58

DISCUSSION:
The problem assumes an unusual inlet boundary condition where the flow rate is known and the stagnation temperature. AFT Arrow uses the static temperature at the inlet because it is typically associated
with a flow rate. To match the 120 F stagnation temperature, the inlet static temperature was iterated a
few times.
The conditions result in sonic choking at the discharge.
The predictions agree very closely.
List of All Verification Models
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Verification Case 16 Problem Statement
Verification Case 16
Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000, Page B.394,
B.397, B.398, Example B8.2
Nayyar Title Page
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Verification Case 16 Problem Statement
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Verification Case 16 Problem Statement
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Verification Case 17
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify17.ARO
REFERENCE: Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000,
Page B.398, Example B8.3
GAS: Air
ASSUMPTIONS: 1) Adiabatic flow, 2) Perfect gas
RESULTS:

Parameter

Nayar

AFT Arrow

M1– Mach number at valve 0.317

0.317

P1– Pressure at valve (psia) 256.93

257.15

DISCUSSION:
The problem assumes an unusual inlet boundary condition where the flow rate is known and the stagnation temperature. AFT Arrow uses the static temperature at the inlet because it is typically associated
with a flow rate. To match the 120 F stagnation temperature, the inlet static temperature was iterated a
few times.
The conditions result in sonic choking at the discharge.
The predictions agree very closely.
List of All Verification Models
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Verification Case 17 Problem Statement
Verification Case 17
Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000, Page B.398,
Example B8.3
Nayyar Title Page
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Verification Case 18
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify18.ARO
REFERENCE: Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000,
Page B.398, Example B8.4
GAS: Air
ASSUMPTIONS: 1) Adiabatic flow, 2) Perfect gas
RESULTS:

Parameter

Nayar

AFT Arrow

M1– Mach number at valve 0.243

0.243

P1– Pressure at valve (psia) 168.52

168.61

DISCUSSION:
The problem assumes an unusual inlet boundary condition where the flow rate and the stagnation temperature are known. AFT Arrow uses the static temperature at the inlet because it is typically associated
with a flow rate. To match the 120 F stagnation temperature, the inlet static temperature was iterated a
few times.
The conditions result in sonic choking at the discharge.
The predictions agree very closely.
List of All Verification Models
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Verification Case 18 Problem Statement
Verification Case 18
Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000, Page B.398,
Example B8.4
Nayyar Title Page
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Verification Case 19
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify19.ARO
REFERENCE: Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000,
Page B.398, Example B8.5
GAS: Air
ASSUMPTIONS: 1) Adiabatic flow, 2) Perfect gas
RESULTS:

Parameter

Nayar

P1– Pressure at valve (psia) 165.29

AFT Arrow
165.60

DISCUSSION:
The problem assumes an unusual inlet boundary condition where the flow rate is known and the stagnation temperature. AFT Arrow uses the static temperature at the inlet because it is typically associated
with a flow rate. To match the 500 F stagnation temperature, the inlet static temperature was iterated a
few times.
The conditions result in sonic choking at the discharge.
The predictions agree very closely.
List of All Verification Models
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Verification Case 19 Problem Statement
Verification Case 19
Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000, Page B.398,
Example B8.5
Nayyar Title Page
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Verification Case 20
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify20.ARO
REFERENCE: Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000,
Page B.399, Example B8.6
GAS: Air
ASSUMPTIONS: 1) Adiabatic flow, 2) Perfect gas
RESULTS:

Parameter

Nayar

AFT Arrow

M1– Mach number at valve 0.235

0.235

P1– Pressure at valve (psia) 661.96

662.27

DISCUSSION:
The problem assumes an unusual inlet boundary condition where the flow rate is known and the stagnation temperature. AFT Arrow uses the static temperature at the inlet because it is typically associated
with a flow rate. To match the 120 F stagnation temperature, the inlet static temperature was iterated a
few times.
The conditions result in sonic choking at the discharge.
The predictions agree very closely.
List of All Verification Models
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Verification Case 20 Problem Statement
Verification Case 20
Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000, Page B.399,
Example B8.6
Nayyar Title Page
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Verification Case 21
Problem Statement
PRODUCT: AFT Arrow
MODEL FILE: AroVerify21.ARO
REFERENCE: Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000,
Page B.399-400, Example B8.7
GAS: Air
ASSUMPTIONS: 1) Adiabatic flow, 2) Perfect gas
RESULTS:

Parameter

Nayar

AFT Arrow

M1– Mach number at valve 0.4096

0.413

P1– Pressure at valve (psia) 25.15

24.94

DISCUSSION:
The problem assumes an unusual inlet boundary condition where the flow rate is known and the stagnation temperature. AFT Arrow uses the static temperature at the inlet because it is typically associated
with a flow rate. To match the 120 F stagnation temperature, the inlet static temperature was iterated a
few times.
The result is sub-sonic conditions at the discharge.
The predictions agree very closely.
List of All Verification Models
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Verification Case 21 Problem Statement
Verification Case 21
Mohinder L. Nayyar, Piping Handbook, Seventh Edition, McGraw-Hill, New York, 2000, Page B.399-400,
Example B8.7
Nayyar Title Page
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A
Add Component to Library 292
AFT Arrow 2.0 38
AFT Standard Fluid Library 456
Analysis Setup 67
Area Change
Specifications window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
Arrow Modules Overview 819
Assigned Flow
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283
B
Basic Graph Tutuorial 344
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Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
Blowers 236
Branch
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
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Index

C
Checklist 169
Checklist 169
Defining Pipes and Junctions 169
Chempak 698
Compressed Air System - CST 794
Compressible Flow Theory 494, 498-500
Network Solutions 498
Review of Compressible Flow Theory (Long) 477
Sonic Choking 217, 501, 507
Compressor/Fan
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
Compressor/Fans 237, 242
Heat of Compression 239
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
Control Valve
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
Control.aft 696, 698
Conventions 54, 215
Convergence Problems 678, 684-692
Creating an Enterprise-Wide Network Library System 468
Creating and Managing Saved Groups 149
curve fit 245
Custom Libraries 455-457, 467
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Index

D
Dead End
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
Design Factors 201
desuperheater 231
F
FCV 233
Fittings & Losses 292
Flow Control Valve 233
Fluid Library 292
Frictional Losses 203, 218
G
Gas Mixtures 497
General Component
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
Getting Started with AFT Arrow 4.0 19
Goals 547
GSC Goals 547
H
Heat Exchanger
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
hydraulically smooth 204
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Index

I
Installation 698
Insulation 186
Insulation Library 292
J
Junction library 292
Junction Window Formats 209
Junctions 207, 222, 225, 227, 231-232, 236, 259-261, 265, 269, 272, 277, 280, 283
Check Valve Specifications Window 231
Compressor/Fan Specifications Window 236
K
Keenan 268
M
Mixtures 497
Model Data Window 298, 319
Modeling Losses 55, 181, 214, 218, 501
N
Natrural Gas Burner - GSC 833
Negative added pressure by pump at Junction X 670
Network Installation 698
Network Libraries 466
O
Objects 166
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Index

OLD Heat Transfer
In Marching Solution 115
Orifice
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
Output Window 681
P
Panhandle equation 204
PDCV 233
Pipe Material Library 292
Pipe/Junction property calculation exceeded maximum local iteration limit 672
Pipes 159, 177
Pressure Drop in Pipes (Darcy-Weisbach Method) 203
Pressure Drop 55, 181, 214, 218, 492, 501
Pressure Drop Control Valve 233
Pressure Reducing Valve 233
Pressure Sustaining Valve 233
PRV 233
PSV 233
R
Raw Data Changes 316
S
Scale Tables 432
Screen
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
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Index

Solution Progress with ANS 589
Stagnation Properties 64
Static Properties 64
Steady Solution Control group 100
T
Tank
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
Tee/Wye
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
Toolbox 162
Transient 638
Troubleshooting Models 678, 682-692
Turbomachinery 19, 137
V
Valve
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
variable frequency drive 236
Venturi
Specifications Window 222, 225-227, 231-232, 236, 259-260, 265, 272, 276-277, 280,
283
Verification of Solutions 499
VFD 237
Visual Report Window 358
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W
Warnings in Output 663
Workspace 161
Toolbox 162
Workspace Window 148, 161
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